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DIVISION DE EDUCACION CONTINUA 
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CENTRO DE INFORMACION Y'DOCUMENTACION 

"ING. BRUNO MASCANZONI" 

E1 Centro de Información y Documentación lng. Bruno Mascanzoni tiene por 

objetivo~ satisfacer las necesidades de actualización y proporcionar una 

adecuada información que permita a los ingenieros, profesores y alumnos estar 

al tanto del estado actual del conocimiento sobre . temas específicos, 

enfatizando las investigaciones de vanguardia de los campos de la ingeniería, 

tanto nacionales como extranjeras. 

~ Es por ello que se pone a disposición de los asistentes a los cursos de la DECFI, 

así como del público en general los siguientes servicios: 

. {: .. 

• Préstamo interno. 

• Préstamo externo. 

* Préstamo interbibliotecario. 

* Servicio de fotocopiado. 

* Consulta a los bancos de datos: librunam, seriunam en cd·rom. 

Los materiales a disposición son: 

* Libros. 

• Tesis de posgrado. 

* Noticias técnicas. 

• Publi.caciones ,periódicas. 

* Publicaciones de la Academia Mexicana de Ingeniería. 
. . 

* Notas de los cursos que se' han impartido de 1980 a la fecha. 

~En las áreas de ingeniería industrial, civil, electrónica_!. ciencias de la tierra, 
.:,; 

,computación y, mecánica y eléctrica. 

',",j 

El CID 'se· encuentra ~bicado en el mezzanh'le del Palacio· de Minería, lado 
'-; : •• ~.· • ,1. • : 1 

oriente. 

El horario de servicio es de 10:00 a 19:30 horas de lunes a viernes. 
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FACUL TAO DE INGENIERIA U.N.A.M. 
DIVISION DE EDUCACION CONTiNUA 

A LOS ASISTENTES A LOS CURSOS 

Las autoridades de la Facultad de Ingeniería, por conducto del jefe de la 

División de Educación Continua, otorgan una constancia de asistencia a 

quienes cumplan con los requisitos establecidos para cada curso. 

El control de asistencia se llevará a cabo a través de la persona que le entregó 

las notas. Las inasistencias serán computadas por las autoridades de la 

División, con el fin de entregarle constancia solamente a los alumnos 'que 

tengan un mínimo de 80% de asistencias. 

Con el objeto de mejorar los servicios que la División de Educación Continua 

ofrece, al final del curso "deberán entregar la evaluación a través de un 

cuestionario diseiíado para emitir juicios anónimos. 

Se recomienda llenar dicha evaluación conforme los profesores impartan sus 

clases, a efecto de no llenar en la última sesión las evaluaciones y con esto 

sean más fehacientes sus apreciaciones. 

Palacio de Mineria Calle de Tacuba 5 
T elefonos: 512-8955 

Atentamente 
División de Educación Continua. 

Primer piso Deleg. Cuauhtemoc 06000 Mexico, D.F. APDO. Postal M-2285 
512-5121 521-7335 521-1987 Fax 510-0573 521-4020 AL 26 
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INTRODUCCIÓN 

Multimedia es la combinación de medios. Es la combinación de texto, gráficas, sonido y video 
para presentar información, No basta únicamente con combinar medios electrónicos, la 
Multimedia se crea cuando logramos conjuntar varios medios, entre ellos: 

• El sonido (de un león que aparece en el monitor de la computadora) 
• La imagen en movimiento (de un avión que rápidamente se desplaza por el aire) 
• Las gráficas (con animación que muestran el rendimiento y la productividad de una 

empresa) · 

El sonido, el vídeo, el texto y las animaciones son objetos empacados en archivos de datos que 
son controlados por algún programa o manejador de objetos y son presentados en secuencia o 
con un orden dictado por el usuario. Cuando un sistema Multimedia da control al usuario 
utilizando algún medio interactivo éste puede estimular sus ojos, oídos y mente para poder sentir 
la transformación de los objetos presentados en pantalla o en algún otro dispositivo de salida. 

Las sensaciones que se inducen en el usuario provienen en su mayoría de el audio y el video que 
se le presenten, y a la vez son un ejemplo claro de que se puede llamar multimedia y lo que no, 
cuando una aplicación presenta conjuntamente imágenes y sonidos, coordinados y coherentes, 
podemos decír que es una apliación multimedia, si presentara independientemente, y sin 
congruencia el audio, las imágnes y el video, podríamos hablar de manejo electrónico de medios, 
no de multimedia. 

Existen dos tipos de sistemas multimedia: 
• Multimedia Interactiva: Cuando se le permite a un usuario final controlar ciertos elementos y 

cuando deben presentarse. .· 
• Hipermedia: Cuando el sistema proporciona una estructura de elementos ligados a través·. de 

Jos cuales el usuario puede navegar por el sistema (Dado que aún exíste ambigüedad en los 
términos, aún es posible confundir el término Hipermedia con Macromedia). 

Macromedia e Hipermedia pueden ser idénticos en todo, exepto que Macromedia se refiere a una 
transmisión de los medios a un nivel global (como intemet), mientras que Hipermedia puede 
hacerlo a un solo usuario en una sola máquina. 

EQUIPO HUMANO QUE DESARROLLA MULTIMEDIA 

Actualmente existen muchas especificaciones para el personal que labora en el campo de la 
Multimedia, pero, una encuesta realizada en la Universidad de San Francisco define las 
actividades y responsabilidades de un equipo de producción y desarrollo Multimedia: 

• Gerente de Proyecto. 
• Diseñador de Multimedia. 
• Escritor. 
• Especialistas en Vídeo. 
• Especialistas en Audio. 
• Programador de Multimedia. 



Estas divisiones no limitan que un escritor no conozca y realice el trabajo del programador de 
Multimedia, o que un diseñador de Multimedia evite crear pistas de vídeo para un pr¡>yecto. 
Generalmente las responsabilidades son compartidas y . se toma la experiencia de todos los 
miembros del proyecto. (ver anexo A). 

Todas las personas que desarrollen alguna de estas actividades son muy importantes en la 
realización de un proyecto multimedia, sín embargo, la textura, la comodidad y en general, la 
presentación que se dará al usuario final dependerá únicamente de los Especialistas en Audio y 
Video. Es. por ello, que vale la pena hacer el esfuerzo por tener las mejores herramientas para el 
desarrollo de estas aplicaciones, que mercadológimamente, son el punto central de las 
aplicaciones. 

·' 



EDICIÓN DE AUDIO DIGITAL (la fisica del sonido) 

ANTECEDENTES 

La primer trujeta de sonido en el mercado de computadoras apareció justo en el momento 
en que la bocina del sistema 8086 u 8088 era aburrida y monótona. Está trujeta de sonido la 
ADLIB, permitía escuchar verdadera música en la computadora, interactuar con juegos, 
reproducir señales de error sin escuchar el famoso "beep" del sistema, etc. Poco después apareció 
en el mercado una trujeta que superaba las capacidades de reproducción de la ADLIB, la sound 
blaster. De entonces a la fecha, varias compañías de computo han lanzad_o al mercado sus 
productos cuyas funciones principales se describen a continuación : 

La tarea más importante de una truj eta de sonido consiste en capturar con calidad 
aceptable las señales procedentes del exterior, ya sea a través de un micrófono o de cualquier 
dispositivo capaz de generar una señal de onda, como un equipo de música o similar. Además de 
capturarlos, debe ser capaz de reproducirlos, es decir, generar una señal muy parecida a la 

Una trujeta de sonido es una trujeta de expansión que se instala dentro de la computadora. 
Si solo se utiliza la bocina de la computadora y se administra con el controlador de Windows, 
todas las operaciones de la computadora quedan suspendidas mientras se reproduce el sonido. 
Este tipo de controladores hacen que la CPU inspeccione la generación de sonido, mientras que 
una trujeta de sonido hace este trabajo y esto libera a la CPU para que realice otras operaciones. 
La instalación de una trujeta de sonido se realiza en las ranuras de expansión de la computadora. 

La mayoría de las trujetas de sonido permiten la entrada para puertos estero, micrófono 
MIDI, etc. los puertos de· entrada de estéreo y micrófono, permiten que la trujeta de sonido grabe 
voz y música. Como se muestra a continuación, se puede conectar a la trujeta de sonido un 
estéreo, una televisión o un micrófono externo. La entrada MIDI de la trujeta de sonido permite 
que se pueda digitalizar y almacenar sonido de algún instrumento MIDI. 



Como se analizará más adelante, una forma de onda debe ser convertida a un formato 
digital para ser utilizada en la PC. Para ejecutar estas conversiones, la trujeta de sonido contiene 

. un convertidor analógico digital. Igualmente, para enviar sonido de salida a las bocinas o a otros 
aparatos, la taJjeta de sonido debe convertir la representación del sonido digital de la 
computadora otra vez al formato analógico utilizando un convertidor digital analógico. 

El IRQ es una abreviación para petición de interrupción (Interrupt ReQuest). Algunos 
dispositivos en la computadora como unidades de disco, o la misma taJjeta de sonido, son 

capaces de ejecutar tareas sin la · estos dispositivos deben 
interrumpir a la CPU y pedirles que ejecuten algún proceso para ellos. Para interrumpir a la CPU, 
estos dispositivos les envían señales mediante los cables llamados líneas de petición de 
interrupción. Cada dispositivo utiliza su propia línea. Cuando se instala una taJjeta de sonido, se 
debe seleccionar una línea de petición de interrupción que no sea utilizada por otro dispositivo. 
Si dos dispositivos utilizan la misma línea, el sistema se bloqueará. 

Noy hay una IRQ fija o establecida para estos dispositivos, la IRQ recomendada para la 
taJjeta de sonido es la que se instale por default con el sistema de instalación automática o alguna 
de las que se tenga la seguridad de que no esta siendo utilizada por otro dispositivo. 



Para enviar grandes cantidades de datos a los dispositivos de alta velocidad, la 
computadora tiene dos opciones: La primera, la CPU puede inspeccionar la transferencia 
moviendo los datos desde la memoria al dispositivo. Desafortunadamente, mientras la CPU está 
moviendo los datos, no puede ejecutar otros trabajos útiles, y el desempeño del sistema 
disminuye. 

La otra es emplear un (acceso directo a memoria) para 
ejecutar la transferencia de datos. Debido a que varios dispositivos pueden necesitar transferirlos 
simultáneamente, la computadora proporciona muchos caminos para datos (llamados canales 
DMA) sobre los cuales el chip DMA puede transferir los datos. Un canal DMA, por lo tanto, es 
una vía de alta velocidad para transferir datos a o desde un dispositivo. Como era el caso con las 
IRQ, debe ser sei_eccionado un canal DMA p¡¡ra la trujeta de sonido. Este canal puede ser 
compartido por varios dispositivos, pero se tiene que tener la certeza que solo será utilizado por 
un dispositivo al mismo tiempo. 

Otra función de una trujeta de sonido es la de soportar la reproducción y comprender las 
partituras MIDI, cuyos sistemas son: 

• Generación por F.M. 
• Síntesis por tabla de onda 

La trujeta Sound Blaster podía reproducir cualquier tipo de sonido con calidad superior a 
la ADLIB. Poco a poco fue ganándose a los usuarios de multimedia y se convirtió entonces en el 
estándar de las trujetas de sonido. 

Estas trujetas de sonido utilizaban la tecnología de generación de sonidos, una técnica 
denominada modulación de frecuencia . Dicha técnica consiste en la modificación de una señal 



fija sobre otra que varia su frecuencia según determinados parámetros contenidos en una tabla de 
datos interna. Dependiendo de la tecnología empleada, era posible la utilización de un número de 
voces o canales determinados. 

La nueva tecnología se llama tabla de ondas. Este sistema consiste en la previa 
digitalización de una nota de los instrumentos musicales, que son almacenados en un formato. 
deseado y determinado por el fabricante de la taijeta. · 
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Dependiendo de la calidad de la señal digitalizada y la potencia del circuito reproductor, 
se pueden obtener señales de 16 bits y 44.1 KHz. o superiores. 

Desde las 8088 ya era posible la captura y reproducción de sonidos en la computadora, 
pero la calidad dejaba mucho que desear. El oido humano tiene un espectro de frecuencias que 
va desde los 20 Hz hasta los 20 KHz aproximadamente, y la frecuencia de muestreo debe tener 
un valor mínimo del doble de ancho que la del oído. Teniendo en cuenta estos aspectos, es fácil 
calcular que una digitalización debe realizarse a una frecuencia de 44.1 KHz_o_superior_para ____ _ 

--'-----rp""oaer ootener eltoíaCdel espectro de la banda de ·audio. 

Desde entonces muchos fabricantes luchan por ganarse más y más usuanos 
evolucionando las capacidades de las trujetas pero manteniendo en el mismo nivel la 
estandarización de los equipos. 

El tamaño de Jos archivos que contienen los sonidos digitalizados está en proporción con 
la calidad de la captura de sonido: a mayor frecuencia de digitalización mayor consumo de 
espacio de almacenamiento. Para reducir el tamaño de estos archivos se emplean distintas 
técnicas, algunas de hardware y otras de software: 

• Las trujetas suelen incluir uno o varios circuitos denominados DSP (procesador 
digital de señal), que se encargan de comprimir la información antes de ser grabada en el 
disco. 

• Adaptative delta pulse code modulation (adpcm). Se basa en almacenar unicamente 
la diferencia existente entre cada muestra y su predecesora. 

• A-law es un sistema que, aprovechando que la mayor parte de la información es de 
carácter bajo, utilizando una resolución de 13 bits la almacena en 8 bits. 

• M-law, sistema igual que el anterior no lineal. Resolución de 14 bits y 
almacenamiento en 8 bits. 

Como cualquier otra taijeta necesita unos parámetros para su configuración. Dichos 
parámetros son: 

• Dirección de funcionamiento. 



• IRQ de control. 
• DMA para transferencias. 
• Un slot Übre en función de la capacidad de muestreo ( 8 ó 16 bits). 
• Espacio en el disco duro para la instalación de software. 

Una onda de sonido se produce cuando se habla, se enciende la radio o se habla por 
teléfono. Como se muestra en la siguiente figura, está onda entra por el oído y causa que el 
tímpano vibre. 

Cuando hablamos por teléfono una onda de sonido es transmitida por Jos cables del 
teléfono. Ya hace algún tiempo, el medio más común para almacenar formas de onda es por 
señales magnéticas. La información representada por una onda continua es llamada datos 
analógicos. La siguiente figura ilustra los 3 componentes principales de una forma de onda: Para 
ser de utilidad una señal analógica debe ser medible o de otra manera su contenido no tendria 
sentido. 

La línea base de una señal proporciona un punto para medir el sonido. Observe en la 
figura, que la línea base corta el sonido exactamente a la mitad. El período de la señal es la 
cantidad de tiempo que t:anscurre entre dos picos sucesivos de la onda de sonido. 

Normalmente, una onda de sonido tiene miles de picos por segundo. El número de picos 
define la frecuencia de la señal. Está frecuencia se mide en hertz (Hz), lo que representa evento 
por segundo o kilohertz (KHz), el cual representa miles de eventos por segundo. Por ejemplo; si 
una señal tiene 5000 picos por segundo, la señal tiene 5000 Hz ó 5 Khz. 

La amplitud de la señal es la distancia de la línea base de la señal· a un pico dado. La 
amplitud determina el volumen de la señal. A mayor amplitud, mayor volúmen. 

más sonoro 

La señal de audio como se conoce cotidianamente, viaja como una onda analógica (o 
continua). Su computadora, sin embargo, utiliza señales digitales cuyos valores pueden ser O ó 1 
como se muestra a continuaCión: 

Antes de que la computadora pueda trabajar con los sonidos, o reproducirlos, la onda 
analógica debe ser convertida a un formato digital utilizando un proceso conocido como 
conversión analógica-a-digital. Para convertir la señal analógica, debe tomar muestras de onda a 
intervalos de tiempo fijos para medir la amplitud de la señal. 

f• ;; 
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El número de muestras tomadas por segundo se conoce como frecuencia de muestreo. La 
siguiente tabla contiene las tres frecuencias más comunes para conversión de sonido. A medida 
en que aumenta la tasa de muestreo, mejora la calidad del sonido: 

RAZON DE MUESTRAS POR CALIDAD DE 
MUESTREO SEGUNDO SONIDO 

11.025 KHz. 11025 BAJA 
22.05 KHz. 22050 MEDIA 
44.1 KHz. 44100 ALTA 

Cada vez que se toma una muestra de onda de sonido, se almacena un valor que 
representa la amplitud de sonido. Dependiendo de la técnica de grabación que utilice, se graba un 
valor de 8 a 16 bits. El tamaño de cada valor afecta la calidad de sonido. Si está utilizando un 
valor de 8 bits, la medición de la muestra de sonido está en el rango de O a 255. 

Aquí podemos dar un valor de O que corresponde a una señal en la línea base y un valor 
de 255 que corresponde a una señal al volumen máximo. Otros valores corresponden a 
amplitudes en otros puntos entre la linea base y el valor pico. 

Un valor de 16 bits, sin embargo, puede representar una amplitud de señal utilizando 
valores en el rango de O a 65535. 

Nuevamente se da que el valor O corresponde a la señal en la línea base y el valor 65535 
corresponde al volumen máximo. 

CONSIDERACIONES DE ALMACENAMIENTO 

Para la producción de proyectos multimedia, es necesaria la optimización de todos los 
recursos del sistema ya que cada objeto en ejecución necesita de una cantidad de memoria para 
su operación, esto sin considerar la cantidad de espacio que en disco duro está ocupando. 



La muestra de una señal analógica requerida para generar una representación. digital 
produce un byte ( 8 bits) ó 2 bytes (16 bits) de datos por cada muestra. Por ejemplo un minuto de 
sonido digital llena todo un disquete y una hora de sonido digital de alta calidad ocupa 300 MB. 
la siguiente tabla contiene la cantidad de espacio en disco consumido por minuto en función de 
diferentes rangos de muestreo y tamaños de muestra. 

RAZON DE MUESTREO TAMANO DE LA BYTES POR MINUTO 
MUESTRA 

11.025 K.Hz 8 bits 0.66MB 
22.05 K.Hz 8 bits 1.32MB 
44.1 K.Hz 8 bits 2.64MB 
11.025 K.Hz 16 bits 1.32MB 
22.05 K.Hz 16 bits 2.64MB 
44.1 K.Hz 16 bits 5.29MB 

Los canales de grabación que intervienen en la digitalización de una señal de sonido, 
afectan directamente la calidad, la nitidez y la limpieza de la señal. Generalmente un canal es 
simplemente un cable capaz de conducir una señal. Cuando se graba sonido, se pueden colocar 
varios micrófonos en distintas localizaciones, esto permite que se grabe el sonido desqe distintas 
direcciones. Cuando se repróduce el sonido después, se pueden combinar los canales p!lfa 
producir un sonido estereofónico. pero eso si, entre mayor sea el número de canales de una 
grabación de sonido, mayor será el costo final de la grabación. 

Debemos considerar que debido a la enorme cantidad de información que genera un 
archivo de sonido ·digital, el disco compacto se -convierte en su medio de almacenamiento casi 
obligatorio. A menudo en el CD-ROM podemos encontrar los términos COMPACT DISC 
DIGITAL AUDIO (CD-CA) o RED BOOK AUDIO (libro rojo de audio). Estos términos 
describen la calidad del sonido que fue almacenado, generalmente a 16 bits con una razón de 
muestreo de 44.1 K.Hz. 

Para una buena optimización de los recursos, no debemos emplear sonidos creados con . 
muestras de 16 bits con una razón de muestreo de 44.1 K.Hz, ya que ocupan una enorme cantidad 
de disco duro. Tampoco debemos utilizar sonido digital creado con muestras de 8 bits con una 
razón de muestreo de 11.025 K.Hz, debido a que la calidad podría compararse con la de una 
estación de radio A.M. mal sintonizada. La mayoría de los productores multimedia según lo 
permitan los alcances del proyecto, utilizan muestreos de 16 bits con razón de muestreo en 22.05 
K.Hz, porque la calidad que se produce es aceptable y el consumo de almacenamiento logra 
reducirse considerablemente. 

HERRAMIENTAS DE EDICIÓN DE AUDIO 

LA GRABADORA DE WINDOWS 

***Ver anexo ""D" 
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COOL-EDIT 

Para empezar Jo primero que debemos saber es que el sonido digital, tanto el que podemos 
encontrar en Internet como en las computadoras en general, es una colección de unos y ceros 
( 1,0) almacenados en un depósito. 

Si se quiere grabar directamente en CoolEdit desde el CD de la computadora hay que abrir el 
programa e ir a File, New para crear un nuevo archivo o pista de sonido. Cuando aparezca una 
ventana de opciones hay que hacer lo siguiente en cada una de ellas: en Sample rate seleccionar 
la opción para grabar a 44.1Hz por segundo, y en Channel hacer un clic para que. la resolución 
elija 8 bits. 

Con la primera opción que escogió se determina la calidad del sonido que se grabará (en este 
caso 44.1 equivalente a la calidad que tienen Jos CD de sonido). Si se desea reproducir un 
archivo de sonido desde la computadora, ésta es la calidad adecuada, pero si lo que se quiere es 
colocar el sonido en una página personal en el Web, conviene la opción de 11,025. Observe la 
siguiente tabla para saber a qué corresponde cada una de las calidades de grabación: 

8,000HZ 
11,025HZ 
22,050HZ 
32,075HZ 
44,100HZ 
48,000HZ 

Teléfono 
RadioAM 
RadioFM 
Mucho mejor que la calidad de FM 
CD de sonido 
DAT (Digital Audio Tape) 

Para la segunda opción elegimos mono, por Jo que nuestra información de sonido estará 
contenida en un sÓlo canal, a diferencia del formato estéreo que tiene dos canales (derecho e 
izquierdo) para distribuir la información. 

A fin de generar sonido para el Web, la opción mono es la más adecuada ya que requiere de 
menos espacio para su almacenamiento y será mucho más fácil de transferir por la Red. 

Pero si piensa generar un archivo para alguna presentación, la opción de sonido estéreo 
funcionará mucho mejor, ya que la computadora tomará el archivo directamente de su disco 
duro. 

La tercera y última opción, resolución, determina los niveles de sonido que tendrá nuestro 
archivo. Con 8 bits de resolución nuestro archivo tendrá 256 niveles de volúmen, lo cual es muy 
superior a lo que la bocina de la computadora puede reproducir (es decir 16 niveles de volúmen, 
ya que sólo trabaja a 4 bits). Pero si se posee una tarjeta de sonido y bocinas, hay que considerar 
que se pueden reproducir sonidos de hasta 16 bits. Los CD de sonido tienen esta resolución. 

Para grabar una muestra de sonido desde el CD, se debe abrir el panel de reproductor de CD 
incluido en el CoolEdit:View : CD Player. Además, en la parte inferior del programa se agregará 
una barra con Jos botones básicos de cualquier reproductor de discos compactos. Primero oprima 
el botón de Record (grabar) del Cool Edit y después el botón de Play del CD Player, con el fin de 
dar un poco de tiempo y no empezar a grabar cuando la pista de sonido ya haya comenzado. 

En el momento de detener la grabación, con el botón de Stop, una representación gráfica de las 
ondas de sonido que usted grabó aparecerá en el área de trabajo del programa. Si se observa bien 



se puede apreciar que tiene una partes más altas que otras, las cuales se llaman picos y 
representan a Jos sonidos altos. Las partes más bajas, llamadas valles, representan Jos sonidos 
más bajos. 

Si oprime el botón de Play, además de escuchar en las bocinas lo que ha grabado verá un gran 
cursor recorrer todo Jo largo de nuestra muestra de sonido. El movimiento de este cursor indica 
cuál es la parte gráfica correspondiente al sonido que se está reproduciendo. en ese momento, si 
lo sigue con la mirada identificará qué picos corresponden a qué sonidos, así como los valles. Al 
ir a la Opción : Loop ,Mode notará como el botón de Play cambia a Loop. Al oprimirlo, la 
muestra de sonido que ha grabado se repetirá infinitamente hasta que oprima el botón de Stop o 
regrese al modo de play. 

Tambien puede lograr que sólo una parte de lo grabado sea reproducida, para hacerlo, seleccione 
con el m o use a parte de su interés y oprima el botón de Play. 

Ahora oprima el botón Zoom y verá comola forma aumenta de tamaño. Oprima el botón cuantas 
veces sea necesario hasta llegar a una simple línea dentada, si intenta oprimir el botón de Play, Jo 
único que escuchará será ruido. Dado que nos hemos acercado mucho a la onda de sonido, es 
imposible que se reproduzca algo armonioso, pero si oprime el botón de Zoom out verá cómo se 
aleja de la forma de sonido. Seleccione alguna parte de su sonido y juegue con estos botones para 
ver como son representados con exactitud ciertos sonidos. 

Primero seleccione el fragmento que más le guste, procure ser exacto en la selcción, para lo cual 
nos servirán las herramientas de Zoom in y Zoom out. Cuando tenga seleccionado su fragmento, 
cópielo y péguelo en una nueva ventana CoolEdit, para abrirla diríjase a File New Instance. 

Ya realizado esto, es tiempo de hacer Jos efectos, Jos más simples son dos: fade in y fade out, que 
se refieren al fenómeno de amplificar el sonido ya sea incrementándolo (fade irí) o 
reproduciéndolo (fade out). Ahora haremos un fade-in al principio de nuestro archivo de sonido 
y un fade out al final. Seleccione una pequeña parte al principio del archivo (procure que no sea 

·tan pequeña, ya que el efecto no se escuchará correctamente) y vaya a Transform : Amplify 

*** Ver el anexo "C" para consultar el manual de este paquete y todas las opciones 



EDICIÓN DE VIDEO DIGITAL 

La pantalla de la computadora está hecha de pequeños puntos llamados pixeles o 
elementos de una imagen. El número de pixeles en una imagen define su resolución. Mientras 
más pixeles tenga la pantalla, mayor será su resolución y más definida la imagen. 

Para generar imágenes en la pantalla, el monitor ilumina diferentes pixeles. Cada pixel no 
es solamente un punto, sino que son tres pequeños puntos fosforescentes que cuando encienden 

· iluminan en rojo verde azul. 

El monitor utiliza tres cañones electrónicos, uno para iluminar cada color. Cuando ya está 
iluminado un punto fosforescente debe ser reactivado periódicamente para que permanezca 
encendido. Los cañones electrónicos del monitor deben reactivar frecuentemente cada renglón de 
pixeles de izquierda a derecha como se muestra a continuación: 

Cuando los cañones alcanzan la parte inferior de la pantalla regresan a la parte superior 
de la pantalla. Para eliminar el parpadeo, los monitores EGA y VGA reactivan la pantalla de 60 a 
70 veces por segundo. 

La computadora despliega una imagen que en realidad reside en una región de memoria 
de video. Los programas de aplicación colocan la información en la memoria de video, a su vez 
la ta.Ijeta de video envía esa información al monitor para que se despliegue. Para cambiar la 
1magen que aparece en la pantalla, los programas simplemente cambian el contenido de la 
memoria de video. 

Cuando observamos la televisión, un nuevo cuadro se exhibe 30 ·veces por segundo. 
Exhibiendo 30 cÚadros por segundo, la televisión elimina el parpadeo y ·los movimientos 
bruscos. Suponga por ejemplo que quiere desplegar video en movimiento (30 ·cuadros por 
segundo ), utilizando un monitor VGA de 640 x 480 que soporta 256 colores. Cada cuadro de 
video requiere más de 300 mil bytes. Puesto que deben desplegarse 30 cuadros por segundo la 

· computadora tendria que procesar 9 MB por segundo. 

Recordemos que antes de que el monitor pueda desplegar una imagen, los valores de los 
pixel es, que en su conjunto forman una imagen, deben residir en memoria de la tmjeta de video. 
Para desplegar video eri movimiento, la cantidad de información que debe transferirse a la ta.Ijeta 
de video seria cercana a los 600MB por minuto. 

Debido a que las caracteristicas técnicas de un CD-ROM no permiten transferir toda esa 
información, está es reducida en compactaciones de bytes. Después de que la tá¡jeta de video 
reciba esa información se tendria que descompactar. Actualmente· las taJjetas de video que 
realizan está función son muy escasas e irracionalmente costosas. · 

La mayoría de las computadoras Multimedia puede, sin embargo, desplegar video 
utilizando una resolución de 320 x 200 a una velocidad de 18 cuadros por segundo. En la 
mayoría de los casos 

estos videos se ven muy bien cuando se despliegan en una ventana pequeña. no obstante, 
cuando se reproduce el video en una ventana más grande, el video se ve más "espasmódico". 

En nuestros días, el video en movimiento es el elemento de Multimedia que puede hacer 
que una multitud emocionada contenga la respiración en una exposición cómercial, o que un 



estudiante mantenga vivo el interés en un próyecto de enseñanza por computadora. El video 
digital, es un buen medio de la' Multimedia para aquellos usuarios que están acostu!ÍJ.brados a la 
televisión. Si se utilizan elementos de video digital, se pueden presentar mensajes en forma 
efectiva y reforzar el proyecto. 

Los estándares y formatos para texto digital, imágenes y sonido están establecidos con 
claridad y son de uso común, pero el video es el elemento más nuevo que se ha integrado a la 
Multimedia. Las nuevas tecnologias y novedosos sistemas de software obliga a moverse 
rápidamente a los científicos de la computación y vendedores de las dinámicas compañías 
nuevas por el carril de alta velocidad del video, truj etas de superimposición de video, esquemas 
de compresión y programas de interfoliado. 

De los elementos de Multimedia, el video exige mayores requenm1entos de la 
computadora y memoria. No debemos olvidar que una imagen de pantalla completa en la 
computadora, puede abarcar hasta 1 MB de memoria, si multiplicamos esto por 30 (que son el 
número de cuadros que se requieren para 1 segundo y poder dar la sensación de movimiento), 
necesitará 30 MB por segundo para reproducir video, 1.8 gigabytes por minuto ó 108 gigabytes 
por hora. Por eso casi todos los avances en la tecnología de Multimedia, centran sus nuevos 
desarrollos en aceleradores de video y en la compresión de las imágenes digitales de video para 
llevarlas a dimensiones más manejables. Un sistema sofisticado de Multimedia, puede incluir 
instrucciones para que el video se almacene en RAM para una reproducción rápida. 

·HARDWARE 

TARJETAS DE CAPTURA DE VIDEO 

Es común que las trujetas de superimposición de video puedan capturar y digitalizar 
cuadros de video, así como reproducirlos a partir de las fuentes de video analógicas; se utilizan 
con frecuencia para hacer películas QuickTime y A VI. Muchas trujetas. de sonido también 
incorporan facilidades para captura de audio y administración de sonido, de modo que la parte de 
audio de una secuencia de video pueda interfoliarse digitalmente y sincronizarse con las 
imágenes durante la digitalización. Sin embargo, se debe estar consciente que algunas trujetas 
sólo muestrean a 8 bits a 22 KHz, lo cual no es de calidad CD, pero en la actualidad es la más 
común para Multimedia que se distribuye en un CD-ROM. 

Algunas trujetas de superimposición de video ofrecen compresión por hardware. Hasta en 
las computadoras más rápidas se pierden algunos cuadros de digitalización porque la 
computadora está demasiado ocupada administrando la información del video que entra. 
Algunos sistemas de digitalización utilizan chips especializádos para la digitalización de video y 
esto permite que sea capturada exitosamente una pantalla completa de video en movimiento a 
tiempo real a 60 cuadros por segundo. Sin embargo, la única desventaja de estos sistemas es que 
para la reproducción del video digital, se necesitan chips del mismo tipo en la máquina que 
ejecuta el archivo. 

Algunas truj etas de superimposición de video también proporcionan salida de video para 
NTSC para que pueda grabar en cinta de video lo que aparece en su monitor. 

Como productor o desarrollador de Multimedia necesita convertir su material de video 
original de su forma analógica común a la forma digital que pueda manejar la computadora del 



usuario final. Para manipular la información digital, se emplean programas como el Video para 
Windows. 

DIFERENCIAS ENTRE VIDEO DE TELEVISION Y DE COMPUTADORA 

A pesar de que la mayoría de los monitores de computadora tienen la misma relación 4:3 
que la pantalla de televisión, aquella sólo proporciona un barrido de 480 líneas de resolución 
horizontal de arriba a abajo (para el caso de un monitor VGA), no las 525 o 625 líneas del 
formato NTSC o PAL. Además, el monitor de una computadora barre cada línea 
progresivamente, sin entrelazado; el barrido se hace para todo un cuadro a una velocidad típica 
de 66.67 Hz o mayor, que difiere de los 60Hz de un cuadro completo de televisión. 

La reproducción y despliegue de color se realiza en forma diferente en el televisor que en 
·el monitor de la computadora. Puesto que estas utilizan el video con componentes RGB (que 
separan los colores rojo, verde y azul), sus colores son más puros y exactos que los de la 
televisión. Por consiguiente, los colores que se utilizan en una imagen generada en video en 
computadora, serán distintos al desplegarse en una imagen transformada en video de televisión 
NTSC. 

Cuando se produce un proyecto Multimedia, debe considerarse si se reproduce en un 
monitor RGB o en una televisión convencional. En general, se debe especificar el tipo, las 
características, y los estándares para el cual debe funcionar adecuadamente la resolución. Para 
incluir video de pantalla completa a una velocidad de tiempo real en un proyecto de Multimedia, 
se necesita invertir en equipo y programas especializados. 

COMPRESIÓN DE VIDEO 

La digitalización y el almacenamiento en su computadora de una secuencia de diez 
segundos de video con movimiento a tiempo real requiere de la transferencia de una cantidad 
enorme de datos en un periodo corto. La tecnología actual no permite que los datos sean 
transportados a tan grandes velocidades. Por ejemplo un disco duro típico transfiere datos a solo 
1 MB por segundo, y un reproductor CD-ROM a la ridícula velocidad de 150 K por segundo. 
Este cuello de botella tecnológico se está superando en la actualidad con las técnicas de 
compresión de imágenes. Los algoritmos de compresión de imágenes de video a tiempo real, 
·como el JPEG, MPEG, P*64, DVI y C-Cube, se encuentran disponibles para comprimir 
información digital en relaciones que van de 50:1 a 200: l. Los esquemas de compresión 
mencionados utilizan la transformada discreta del coseno, un algoritmo que cuantifica la 
habilidad del ojo humano para detectar las distorsiones de color e imagen. 

JPEG 

El JPEG es el más popular de los estándares de compresión que se ha desarrollado para 
imágenes fijas. Comprime en relación cercana a 20:1 antes de que ocurra alguna degradación 
visible en la imagen. 

Cuando se aplica una relación 30:1 a un cuadro de video a color, los requerimientos de 
espacio de almacenamiento se reducen de 1000 K a 33 K y la velocidad de transferencia se 



reduce a cerca de 1 Mb por segundo, aún dentro de las capacidades de la mayoría de los 
dispositivos de almacenamiento. 

MPEG 

Otro estandar muy conocido en los sistemas de video digital, es el MPEG el cual fue 
desarrollado por Moving Picture Experts Group, se utiliza para codificar imágenes en 
movimiento. Su esquema permite comprimir audio; sus velocidades de compresión son mayores 
y la descompresión se hace en tiempo real. El MPEG comprime a relaciones de 50:1 antes de que · 
se degraden las imágenes. El MPEG como el JPEG, utilizan el sistema simétrico, lo que significa 
que comprime y descomprime a la misma velocidad. 

DVI 

Este sistema es una tecnología programable de compresión y descompresión propietaria 
que se basa en el conjunto de chips i750 de intel. DVI brinda dos niveles de compresión: video 
de producción y video de tiempo real, los algoritmos DVI pueden comprimir imágenes de video 
con relaciones entre 80:1 y 160: l. El DVI reproduce video en el tamaño original de cuadro y a 
todo color a velocidades de 30 cuadros por segundo, mientras el. JPEG sólo proporciona una 
imagen aceptable en una ventana pequeña en la pantalla de la computadora. Cuando se incorpora 
a una macrocomputadora, la reproducción del DVI se apróxima a la calidad de las estaciones de 
televisión 

INTERFACES DE SISTEMAS PARA COMPUTADORAS PEQUEÑAS SCSI 

SCSI es la interface de sistemas para computadoras pequeñas ( Small Computers System 
Interface, SCSI). Este sistema permite conectar hasta siete dispositivos periféricos externos como 
discos duros, unidades de CD-ROM, impresoras, digitalizadores, unidades de cartucho 
recargables y unidades magneto-ópticas. 

Dicha interface permite conectar más dispositivos rápidos y eficientes aún cuando las 
capacidades de espacio del sistema sean limitadas. Cuando un dispositivo SCSI se conecta a la 
truj eta de interface en una PC, se integra al sistema como otra letra de unidad. De está forma se 
tendría para las unidades de disco A: y B:, para el disco duro C:, para las trujetas SCSI D:, E:, 
F:, etc. 

El disco duro puede conectarse también a una trujeta SCSI, y ·esto beneficiará el 
rendimiento total del sistema. 

INTERFACE DE CONTROL DE MEDIOS (MCI) 

Para el ambiente Windows, se diseño el MCI que es un mecanismo de software capaz de 
manejar y administrar dispositivos periféricos de Multimedia. Utilizando los controladores 
apropiados (que casi siempre son suministrados por el fabricante) se pueden manejar el 
dispositivo con cadenas simples o códigos enviados al MCI. 

.. ~· 



La MCI fue producida para Windows 3.1 pero para los usuarios del sistema 3.0 se puede 
adquirir este producto por separado. El MDK (kit desarrollador de Multimedia), también incluye 
la interface de alto nivel del MCI y está versión se utiliza para programadores de Multimedia, es 
decir, gente que programa Multimedia en lenguajes de alto nivel como Pascal, C, etc. 

La siguiente tabla indica los dispositivos soportados por el MCI de Wlndows 3.1 : 

AVI AUDIO VIDEO INTERFOLIADO 
CDAUDIO UNIDAD CD-AUDIO 
DAT UNIDAD DE CINTA DIGITAL DE AUDIO 
DIGITAL VIDEO VIDEO DIGITAL EN UNA VENTANA 
MMMOVIE UNIDAD DE CINE MULTIMEDIA 
OTHER CUALQUIER DISP. NO IDENTIFICADO MCI 
OVERLAY DISP. DE VIDEO DE SUPERPOSICION 
SCANNER DIGITALIZADOR DE IMAGENES 
SEQUENCER SECUENCIADOR MIDI 
VCR VIDEOCASETERA 
VIDEODISC UNIDAD DE VIDEODISCO 
WAVEAUDIO DISP. DE FORMA DE ONDA. 

Los controladores de cd-audio, sequencer, waveaudio se venden con el producto 
Windows 3.1. El controlador mmmovie para animaciones en Director, y el controlador de 
videodisco PIONNER LD-V4200, están disponibles en el MDK. 

Todos estos dispositivos y controladores son administrados por el archivo de Windows 
System.INI , en las secciones [ MCI ] y [DRIVERS] respectivamente. Cada vez que Windows 
inicia, el System.INI verifica que dispositivos están conectados al sistema. Siempre que 
instalamos un programa Multimedia y este maneja diferentes DRIVERS, el archivo System.INI 
se actualiza automáticamente. 

SOFTWARE 
A) Asimetrix Digital Video Producer 
B) Adobe Premier 
C) Video Edit 
D) Video For Windows 

** ** Para los incisos C) y D) ver anexo "D" 

ASIMETRIX DIGITAL VIDEO PRODUCER 

La edición de video con Asimetrix DVP 4.0 es de los más sencillo, la pantalla que presenta el 
programa es altamente intuitiva, y de fácil manejo. 

En este curso vamos a seguir el ejemplo paso-a-paso que se incluye en el programa, en caso de 
que no aparezca, basta· seleccionar en el menú la opción "help", y posteriormente "startup 
asistan!". 

Este programa cuenta con un programa especializado de captura de video, al igual que el 
programa principal, este otro cuenta con una interfaz altamente intuitiva y de uso muy sencillo, 
que presenta la siguiente barra: 



Los primeros dos botones son para salvar archivos, el tercero activa el cuadró azul que aparecerá 
abajo, y en donde se verá, como en una camara de TV, la imagen que se está enviando a la t¡¡¡jeta 
digitalizadora. 

Los botones quinto, sexto y séptimo son para grabar, respectivamente un solo cuadro, vanos 
cuadros aislados, o un "clip" o secuencia de video. 

Una vez que se tiene un archivo salvado conteniendo el clip deseado, se puede pasar al programa 
"Video Producer", en el cuál se pude cambiar la pista de audio, hacer algunos efectos con los 
videos y realizar varias mezclas como veremos al seguir el tutorial paso-a-paso. 

Un programa utilizado muy frecuentemente en la edición de video, es el "Adobe Premeiere", que 
veremos a continuación. · 

l. 
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Using Adobe Premiere 

Basics 

Key Terms: Clip, Movie, Project, Project Window, Construction Window 

The purpose of using Adobe Premiere is to create a Movie which is a unit 
of viewable digital video. Every Adobe Premiere movie ·starts as a 
Project--a collection of Clips, the items which may be used in the 
production of a movie, organized along a timeline. A new Project is 
created by choosing File 1 New 1 Project from the menu bar. 

The following windows are used as a Project is turned into an Adobe 
Premiere movie: 

The Project window is analogous to the Cast in Director and the Layers 
window in Photoshop. It contains the Clips to be used in producing the 
movie. Clips may be movies (such as .avi files), still images (such as .psd 
and .jpg files), and audio tracks (such as .wav files) to name a few. 

The Construction window is analogous to the Score in Director. It is the 
area where one can lay out the clips to be included in the movie and 
manipulate when each will be played. It is also the place where most 
editing effects (such as titles, transitions, etc.) are created. 

The Construction window consists of several tracks. Adobe Premiere 
plays all the clips in the Construction window in order from left to right. 
In order to be included in the project, clips must be copied or dragged 
from the Project window to the Construction window and placed on a 
track. The simplest arrangement for a movie is to assemble the clips end 
to endona single video track so that the out point of one clip butts 
against the in point of the next clip. To create a movie with less abrupt 
transitions between clips, you can place clips on the A and B video tracks 
so that they overlap and use the T track for transitions. You use the S 
tracks for movie clips, still-image clips, or titles you want to superimpose. 
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To Capture Video and Make a Simple Movie 

(Note: This assumes the video to be captured is cued in the VCR and 
ready to be played) 

l. Choose File 1 New 1 Project. The default dimension setting you will be 
prompted for, "Presentation- 160x120", is usually your best choice. 

2. Choose File 1 Capture 1 Movie Capture. A window with a Record button 
at the top will appear. 

3. Press Play on the VCR (if it's not already playing). 

4. You should see the video that is playing on the VCR monitor in the 
Record window. Press the Record button to begin recording. Note: When 
you hit Pldy on the VCR, the word "Play" is superimposed on the picture on 
the monitor for a few seconds. The word "Play" WILL be recorded a long 
with the video while it is displayed. Therefore you may wish to cue the 
video several seconds earlier from the point where you wish to record 
before playing. 

5. After capturing, save the clip you have just captured by choosing File 1 

Save. 

6. Drag the clip onto the Construction window. This will automatically add 
the clip to the Project window as well. 

7. Pull the orange triangular handles on the Work Area Bar, the yellow bar 
at the top of the Construction window, such that the length of the bar is 
the same as the length of the clip. What is contained within the bar is 
what will be saved as a movie. 

8. Choose Make 1 Movie from the menu. The result is a saved video movie 
that .is now playable. 

You can preview your projects in the construction window either by 
choosing Project 1 Preview or by holding the mouse over the time grid at 
the top of the Construction window, clicking, and dragging in the direction 
you wish the movie to play. In this manner, you control how fast and which 
parts of the movie are previewed. 
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However: To preserve your sanity and avoid the destruction of expensive 
machinery, it is critica! to note that projects often crash during preview 
if the clips in the project are not already compiled movies. For example, if 
you try to drag raw captured clips (that have not been made into movies) 
to the Construction window and then preview the project, Premiere will 
crash. And you will get upset. This can be tricky business because saved 
raw clips and those compiled as movies have the same default extension 
(.avi) and look identical in the Project window, so it may be difficult to tell 
the difference between them. So if you want to use the preview tools in 
the Construction window, YC!U may have toa) draga captured clip to the 
Construction window, b) make it into a movie e) import the movie you just 
made back into the project, and d) replace the raw clip in the 
construction window with the compiled movie. 

Maneuvering Within the Construction Window: 

The time ruler at the top of the Construction window reflects the 
selected time unit. It displays the current position of the pointer and any 
place markers that have been set in the Construction window. From the 
time ruler, you can also determine the starting and ending positions of 
each clip and the duration of the entire movie. The large tick marks on 
the time ruler represent the current time unit; the small tick marks 
represent frames or seconds, depending on the current time unit. As you 
move the cursor in the window, a hairline marker moves in the time ruler 
to indicate the current cursor position. You can scroll in the Construction 
window to move toa location on the time ruler. 

The razor tool in the Construction window cuts a clip into two or more 
distinct clips. To split a clip into two clips: 

Select the razor tool in the Construction window, and click anywhere on 
the clip. The clip splits into two separate clips, and a new clip is added to 
the Project window. Each clip reflects its individual duration, with new 
settings for the in point or out point. To split the clips on all unlocked 
tracks, Alt+click the razor tool. For more precision when splitting a clip, 
you can change the time unit in the Construction window to display more 
frames, or you can use the zoom tool to zoom in on the area. 

Note: Double-click the razor tool (or press Shift+R) to use the tool for 
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Trimming 

In the Construction Window 

You can trim clips in the Construction window severa! ways. You can use 
the in and out point tools or the ripple edit and rolling ·edit tools, or you 
can simply drag the edges of the clip. For better trimming precision, 
choose a low time unit in the Construction window. You can also use edge 
viewing to view the frames in the Preview window as you drag the edges 
of the clip. When you change the duration of a clip in the Construction 
window, the Info, Project, and Clip windows are automatically updated 
with the new clip duration. To trim a clip using the in point and out point 
tools: 

1. Select the in point or out point tool in the Construction window by , 
clicking the tool icon or pressing I or O on the keyboard. . .. 

Note: If you click the in or out point tool once, the tool reverts to the .-. 
selection tool after one use. Double-click the in or out'point tool to use it 
repeatedly. -

2. Click the in point tool on the left edge of the first frame you want 
displayed in the movie. 

3. Click the out point tool on the right edge of the last frame you want 
displayed in the movie. 

To trim a clip by dragging: 

1. Position the selection tool on the edge of the clip to be shortened or 
lengthened. The selection tool turns into a stretch pointer. 

2. Drag to shorten or lengthen the clip, and release the mouse button 
when the clip reaches the desired length. 

In the Trimming Window 

. .. 
··' .~ 

•, 

·.• 
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It you want to be as precise as possible when trimming clips, use the 
Trimniing window. The Trimming window lets you add or subtract trames 
trom clips at edit points along the timeline. While making adjustments, 
you can see the exact trame that appears on each side ot the edit point. 
When trimming a clip this way, the durations ot all other clips on the 
track remain the same. This is an example ot a ripple edit. 

To pertorm a ripple edit in the Trimming window: 

l. Choose Trimming trom the Windows menu. The Trimming window 
appears. 

2 . Click the Next or Previous button to move the edit line to the point 
you want to adjust. The trames on both sides ot the edit point are 
displayed in the Trimming window. It you position the edit line on a 
transition, the last trame ot the clip on track A and the tirst trame ot 
the clip on track B are displayed. 

3 . To add or subtract a specific number ot trames trom the clip on the 
lett side ot the edit point, click either the + or- button on the ldt side 
ot the window. To add or subtract trames trom the clip on the right side 
ot the edit point, click either the + or- button on the right side ot the 
window. 

4. To add or subtract a larger number ot trames, drag the Jog control on 
either side ot the window. The edit line moves in the direction and 
distance you drag. Alternately, you can add or subtract trames by clicking 
one ot the time displays and typing a new time value. 

5. To preview the new edit, click the Play button. 

In the Project Window 

A clip opens in the Clip window at the trame corresponding to the current 
in point. The duration counter shows the duration ot the clip trom the 
current in point to the current out point. 

Note: You can use the Clip window to set in and out poi-nts tora clip 
betore importing it into a project. This is usetul tor importing various 
sections ot a single clip as separate clips. For intormation on importing 
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clips, see Importing and Opening Clips. 

To change the in and out points in the Clip window: 

1. Find the place where you want to set the in point for the clip using one 
of the methods described in the Viewing and Playing Clips In the Clip 
Window. 

2 . Click the In button or press Shift+I to set the in point. 

For movie clips, the in point indicator appears in the upper left corner of 
the Clip window. For audio clips, the in point indicator appears at the 
corresponding point along the waveform. 

3. Find the place where you want to set the out point for the clip, and 
click the Out button or press Shift+O. 

For movie clips, Adobe Premiere places the out point indicator in the 
upper right corner of the window. For audio clips, the out point indicator 
is placed at the corresponding point along the waveform. The duration 
counter at the bottom of the window shows the new duration of the clip. 

Note: Changing the in and out points of a movie clip that is linked toan 
audio clip will affect both the movie and audio portions of the linked clip. 
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Motion 

Premiere allows you to define a path along which a clip·can move in the 
movie trame. You can define a motion path for any movie or still image 
clip. 

Superimpose How to put a clip in motion 
Transitions 
Filters 
Speed 
Screen View 

l. Selecta clip in the construction window. 
2. Choose motion from the dip menu. 
3. Set points on the motion path by: 

0 Moving the Start and Finish points. 
0 Positioning the pointer anywhere on the motion path. The 

pointer turns into a pointing finger. Click to add a point to the 
path, and drag to adjust its position on the path. When you 
release the mouse, the point is selected and you can add 
options to the selected point. 

° Clicking above the timeline 

Changing the Speed of Motion 

Points that have been added to the motion path are represented on the 
timeline below the path. The length of the timeline represents the 
duration of the clip. The relative speed of motion between path points is 
determined by the distance between points along the timeline: Adjust the 
speed by dragging points closer together or farther apart along the 
timeline. 

Motion Options 

You can specify the movement options along a clip's motion path. An image 
can be rotated, distorted, and zoomed in or out along the path. 
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Titles 

Title clips are created in the Title window. Title clips can contain text, 
lines and geometric shapes. Titles can be opaque or transparent. A title 
clip has a file extension of .ptl. 

Superimpose How to create a title 
Transitions 
Filters 
Speed 
Screen View 

l. Go to the File menu, choose New then choose Title. This opens the 
Title window and the Title menu .. 

· 2. Use the tool from the toolbox to create the type and graphics you 
want in the title. 

3. Go to the File menu and choose Save. 
4. Hold down the CTRL key and drag the clip from the Title window 

directly into the Construction window. You can also import title clips 
into the Project window by going to the File menu and choosing 
Import. 

Title Window Toolbox Options 

L1l Selection Tool- selects an object or block of text. Hold down shift 
key in order to select multiple items. 

¿1 Eyedopper Tool-can be used to assign color, transparency and 
gradient fill attributes to the object color swatch. Option click an object 
or shadow to assign its attributes to the shadow color swatch. 

__Ij · Type Tool-creates and edits text: 

Line Tool-draws straight line segments. 

[]11 Rectangle Tool-draws rectangular shapes. Clicking on the left side 
of rectangle icon draws framed rectangles, clicking on·the right side of 
rectangle icon draws filled rectangles. 
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lllll Polygon Tool-draws polygons. Clicking on the left side of polygon 
creates framed polygons, clicking on the right side creates filled 
polygons. Draw the polygon one side at a time, clicking to define the end 
points of each line segment. Double click when you are done to complete 
the polygon. 

(]) Rounded Rectangle Tool-draws rectangles with rounded corners. 
Click the left side of the icon to draw a framed rounded rectangle, click 
the right side of the icon to draw a filled rounded rectangle. 

<1> 1 Oval Tool-draws oval shapes. Click the left side of the icon to draw 
a framed oval, click the right side of the icen to draw a filled oval. 

o Draft Draft Check Box-select this box if you want work without 
previewing the color and opacity gradients. This speeds up the redraw 
time of type and objects in the Title Window. Does NOT affect the 
quality of the actual title clip. 

····-~ 1 Line Weight Slider-allows you to adjust the line weight of a 
framed object. 

~ .. 
_3 Color Swatches: 

• object color swatch (upper left square) shows the color of the 
currently selected object. 

• shadow color swatch (lower right square) shows the color of the 
selected object's shadow 

~lOO• 100 

•o 
~ ............... ··-· Gradient Controls-allows you to create color and opacity 

gradients across objects and shadows. 

Using the Clip Frame for Title Positioning 

1. Set marker O to the frame of the clip you want to display the title 
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you are going to create. 
2. Drag the clip trom the Clip or Project window into the Title window. 

The marked trame is displayed in the Title window. 
3. Remove the trame trom the Title window by choosing Remove 

Background Clip trom the Title menu. 
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· Superimpositions 

Superimposing clips involves placing one clip over another. The top clip, or 
the superimposed clip, is made transparent to allow the bottom clip, or 
the background clip, to show through. The superimposed clip goes on the 
S track while the background clip goes on either the A or B track. 

Transitions Superimpose options 
Filters 
Speed • None- no part of the superimposed clip is transparent. 
Screen View 

• Chroma-allows you to select a color or range of colors in the clip to 
be transparent. 

• RGB Difference-like Chroma, it allows you to select a range of colors 
in the clip that will be transparent. But the Chroma key allows you to 
adjust the colors and the gray values of the superimposed pixels 

~ separately. 

• Luminance-allows you to remove gray values while retaining the color 
values. 

• Alpha Channel-an alpha channel is an invisible gray scale channel 
assigned toan image. This technique allows you to superimpose an 
image by removing the block oreas of an image's alpha channel and 
making the white oreas of the alpha channel opaque. 

• Block Alpha Matte-allows you to superimpose an image that contains 
an alpha channel but has been created on a block background. 

• White Alpha Matte-allows you to superimpose an image that has no 
alpha channel and was created on a white background. 

• Image Matte-allows you to play a movie through a still image placed 
on top of the clip on the S track. 
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• Difference Matte-keys out the identical areas of two clips and 
retains the difference. 

• Blue Screen and Green ScreEm-used with images with true chroma 
green and true chroma blue backgrounds. 

• Multiply-keys out the areas of the superimposed image that are 
lighter than the underlying image. 

• · Screen- lightens the areas of the underlying image that are lighter 
than the superimposed image. 

• Track Matte-uses the clip on the S track of the Construction 
window as a matte. A track matte can be created from a moving or 
still image. 

• Not Red-for use with images that have green or blue backgrounds. 
Similar to Blue or Green Screen but Not Red allows you to create 
semitransparent objects and helps reduce fringing around the edges 
of nontransparent objects. 
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Transitions 

HOW TO USE TRANSITIONS: 

Transitions sirnply link one visual idea to the next. Sometimes these links 
can be smooth and subtle: fade from a setting sun to the bright face of a 
buttercup, white clouds that very slowly reveal within them the features 
of a woman (Sophie 's Choice). Sometimes these links can be abrupt: a 
dancing figure that "becomes" a charging rhinoceros (Jacob 's Ladder), 
"blur ins" from reality to fantasy as in the series Dream On. As the 
editor it is up to you to decide what you want each transition to soy about 
your material. The only way to get to where you want to eventually go with 
transitions is practice, trial and error. Not always smooth going, but 
hopefully fun just the same. This is intended as a guide to getting 
started. How far you go is ultimately up to you. As with Photoshop, 
experimentation and talking to others is the best way to learn, but do not 
discount the manual just because it seems technical. It is very useful for 
explaining some of the quirks of the program that might be the unknown 
cause of problems you may be .having. 

l. Place within the Construction Window either two clips you wish to join 
with a transition, or one clip that you then razor apart. Going from left to 
right, the first clip should be in the A row and the second should be in 
the B row with the first frame of the B row clip immediately below the 
last frame of the A row clip. 

2. Select Windows > Transitions and the Transitions dialog box will open. 

3. Scroll through the 70 different options. Choose one that interests you 
and place the cursor over the A/B cube. Click and drag the block to the T 
row of the Construction Window carefully placing it directly under the 
last frame of the A row and directly above the first frame of the B row. 
Your transition is now ready to manipulate. 

4. Double click on the transition cube. Its dialog box will open. You can 
manipulate the settings in this box andyou can view what the transition 
will look like by clicking the Show Actual Sources box and sliding the 
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sliders located·beneath the boxes. Play with the other toggles in this box. 
You will notice that you can change the Track selector (whether the video 
runs from track A to B or vice-versa), the Forward/Reverse selector and 
the Anti-aliasing selector (see a brief discussion of this in Filters). 

5. If you decide you don't like this transition simply highlight and cut it. 
Look for another transition. 

POSSIBLE TRANSITIONS AND THEIR EFFECTS: 

Center Split: Image A splits into four parts and slides to the corners to 
reveal image B. This lends either a graceful glide from one scene toa 
similar scene or it gives the sense of the subsequent scene being the 
"result" of the previous scene. 

Channel Map: Selected channels from images A and B are mapped to the 
output. What this means is that you can select elements, colors, lines to 
emphasize from both A and B and have them appear joined during the 
transitions. 

CheckerBoard: Two sets of alternating boxes wipe to reveal image B 
under image A. This is a cute effect and has an upbeat feel to it. Good 
for hard-to-manage transitions that don't have many visual connections. 
ie. in terms of line, colors, shape, etc. ' 

Cross Dissolve: Image A fades into image B--very elegant. Lends itself to 
filters and other kinds of additional cinematographic tinkering. 

Cross Zoom: Image A zooms in, image B zooms out--very dramatic. Could 
be hilarious if used with noses, stunning if used with action scenes. 

Dither Dissolve: Image A fades into image B--subtle and easy on the 
eyes. This effect really lets you play with light/dark as well as color 
effects. 

Image Mask: You, the editor, select an image and use it to mask image B 
onto image A--high degree of control allowed and calls for creativity plus 
patience to achieve the results you want. 

Iris Star: A star-shaped iris opens to reveal image A under image B. 

,, 
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Definately a statement on the editor' s part, best used on people qr 
animals not things. 

Motion: Image B moves over image A on a user-defined path--control and 
potential for fun with regards to the image used to move along that path. 

Page Peel vs. Page Turn: Essentially these are the same thing, except 
page peel, by emphasizing the underside of the top layer, acce.ntuates the 
effect of pages one atop the other. 

Slash Slide: Image A slides over image B in many independent sections--a 
cool way to reveal the next segment provided the colors in each clip are 
compatible. 

Stretch In: Image A fades as image B is stretched into view--allows 
transitions from clips to clips that are not good meshes, especially if 
obscuring filters are applied to the ends of clip A. 

Texturize: Image A is mapped onto image B--this is another filter that 
allows a great deal of user control. With filters in place this transition 
can create a very artistic sort of effect. 
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Filters 

Applying filters to your video gives you, the erector of the audience's 
viewing experience, a measure of subtle control that is equivalent to the 
difference between watching a movie with or without its musical score. A 
guy sitting in a chair with his hair flying behind him to the tune of 
Wagner's De Valkyrie is very different toa guy sitting silently in a chair 
having abad hair doy. Use filters to correct, enhance, mute the raw video 
you hove. Filters are your opportunity to guide the audience's viewing and 
to leed them to an understanding of your point of view without them even 
knowing that you, the editor, were ever there. 

HOW TO USE FIL TERS: 

This is int.ended as a guide to getting started. How far you go is 
ultimately up to you. As with Photoshop, experimentation and talking ,to 
others is the best way to learn, but do not discount the manual just 
because it seems technical. It is very useful for explaining sorne of the 
quirks of the program that might be the unknown cause of problems you 
may be having. 

l. Hove the clip in the Construction Window. 

2. Click on the segment to which you want to apply a filter. Remember: if 
you don't want to apply a filter to the entire clip (recommended) then use 
the razor to cut the clip (the video will still play through these parts 
smoothly unless you move them). 

3. Go to Clip > Filters: The Filters dialog box appears: choose the 
filter/effect you want from the lefthand, "Available" box, click on the 
Add button to apply it. It will move to the "Current" box which means it is 
now applied to your clip. 

4. Some filters will automatically give you a Settings dialog box in which 
you can further adjust what the filter does and preview what will happen 
to your image. (To correct mistakes continue reading.) 
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5. Click OK. You will now see a green bar over the clip you worked on. This· 
indicates that a filter or filters are present. If you are not happy with 
the effect you may simply go back to Clip > Filters and remove the 
effect you don't want by highlighting it in the righthand "Current" box 
and clicking on Remove. 

POSSIBLE EFFECTS AND REASONS FOR APPLYING FIL TERS 

Anti-alias: creates a compromise between the stronger hues in the image 
and essentially blends them down to something much less distinct. The 
difference between this and the Blur filter is akin to the effect of rain 
on a pastel drawing versus pulling a lens out of focus. Anti-alias might be a 
good start toa fade out, oras a way to mute nudity. 

Bend: stretches your center image horizonatally and vertically while 
creating a wavering border on the outer edges of the frame. You will be 
allowed to select the intensity and shape of the waver. This effect is 
similar to the image reflected from a mirror ball on a windy day. 

Black & White: enhances the lines and luminance of your image. An 
elegant way to accentuate the"simple beauty of an image or add drama to 
a human face. It is less effective for crowd scenes. 

Brightness & Contrast: lends you control over how much light is allowed 
into your video, and how intense the difference between light and dark 
can be. This is an essential part of video editing and the wise editor 
becomes familiar with this filter FIRST. Note that a very little goes a 
long way here and be cautious in applying it universally, being sure that 
each scene is evaluated as a separate entity and then being sure that it 
can mesh with the scene that follows. 

Color balance: yields less control over color than in Photoshop but is 
useful in gently highlighting existing colors or applying a cast over the 
image. Use caution with this filter as it may make transitions difficult to 
mesh later on. Once the change to a clip is made the controls go back to 
the neutral setting so even if you've changed your boss' coloring to that 
of the Incredible Hui k and you want to change it back to normal the 
controls will not show you how far along the scale you went in changing the 
color, leaving you to decide what is normal for the image, or in this case, 
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Crystalize, Spherize, Swirl, Tiles, etc.: break your image apart or down 
and can be a great deal of fun. Also. these changes are so radical that you 
can easily discern where you are and how to get back from there should 
you wish to bring the image back to its original state. Useful for adding 
emphasis to your video in the same why that a welcoming dog adds 
emphasis to the return of its owner. People really enjoy this stuff when 
judiciously applied. 

Ghosting: overlays previous frames of a clip with other transparent 
frames. Effects similar to time lapse photography or the blur of someone 
suddenly moving in front of a camera on a slow speed setting. A good way 
to initialize transformation-style transitions. 

Image Pan: allows you to take a clip and zoom or pan across the image. 
You can also use this to create rolling credits and similar effects. This is 
one of the more challenging filters and you must allow yourself plenty of 
time to become accustomed to the various controls and requirements· 
involving borders, screen size/view, etc. Sometimes it is often better to 
shoot the effect you want than to try to create it in this way. 

.. 
>'· 

-< 
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Hollywood ever does is purify images to a point that it no longer looks like 
the same world we live in? Well, this effect allows you to blenda clear, 
still photograph with the noisy (meaning not perfectly sharp) video you 
are editing. You might wish to use Video Noise with something like this: 
Open-- scene of your grandmother at her birthday party, she blows out 
the candles, sits back and smiles and then the photograph of her on her 
prom night is blended in, add video noise, blend, remove video noise, still 
shot clear and bright-- close scene. Well okay, so I grew up on Hallmark 
movies, but you get the idea! 

Wind: destroys the image slowly by blowing its pixels away as if in a large 
windstorm. Your image has to lend itself to this. ·An image under black and 
white filter with wind applied can be really dramatic. . 

Remember, there are many more filters. explore them soonl 
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Speed 

Controlling the speed of your video is essential to maintaining your 
Basics audience's interest as well asto get your point across about your subject. 
Trimming Imagine the clqsing minutes of Princess Bride where she jumps out of the 
Motion castle window into the waiting giant's arms. If she had fallen like a human 
Titles body actually does she would hove been a frightening blur, his catching 
Superimpose her would hove been entirely unconvincing and the audience would 
Transitions instantly hove dropped their happily suspended disbelief. Instead, clips 
Filters are shot of the apex of her bouncing on a trampoline and then the speed 
Speed · of her falls are slowed drastically to make it look like she is as gossamer 
Screen View light as the gown she wears. Result: we believe that a woman can jump 

from a high window and virtually float into the arms of a waiting person 
below without sustaining and inflicted serious injury. Or what about those 
long shots of children riding their bicycles into bushes as seen on 
"America's Funniest Home Videos?" So much funnier when faster (we 
won't go into the psychology of this here). 

HOW TO WORK WITH SPEED: 

Work is right, especially where motion is concerned! Remember: this is 
intended as a guide to getting started. How far you go is ultimately up to 
you. As with Photoshop, experimentation and talking to others is the best 
way to learn, but do not discount the manual just beca1,1se it seems 
technical. It is very useful for explaining some of the quirks of the 
program that might be the unknown cause of problems you may be having. 
In the case of Speed settings, the manual and practice may be all the help 
you will be able to find, 

The default setting for movie and audio clips is 100 percent. You can 
change the speed from -10,000 to 10,000. Obviously, the minus numbers 
will so slow·your clip that it plays backwards, and the higher the number 
the faster the clip. It is good to know that changing the play speed will 
basically reduce or multiply the number of frames that comprise your clip, 
similar to what happens when you enlarge or reduce an image in 
Photoshop. 
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1. Go to either the Project Window or the Construction 
Window--wherever is eosier to work with at the time. 

2. Go to the Clip menu, choose Speed. 

3. Choose arate between -10,000 and 10,000. 

4. Click OK. 

5. You can do this with as many clips as you like. They will each appear 
with their different times in the Project Window. 

POSSIBLE SPEED APPLICATIONS: 

Freeze Frame: You will have to set the clip's speed toO and you would do 
this when you tri m the clip you wish to freeze. It might be good to use a 
transition of some kind to "restart" your frozen video: 

Blending frames: Sometimes in the process of capturing your video the 
capture rate will be slower than the video. This causes a jittery effect. 
To correct this you might wish to blend frames. 

l. Select the clip in the Construction Window. 

2. From the Clip menu choose Frame Hold. 

3. In the Frame Hold dialog box make your adjustments to rate by typing 
in a rate in the text box. 

4. Select Frame Blending. 

5. Click on OK. 

Separating/Rejoining: To get the very professional effect of separating 
your video and audio consider manipulating the links between them in 
Premiere: 

When you capture a video, you capture both its audio and video. At this 
point the video and audio are hard linked You can manipulate the audio 
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but once you do, the hard link will forever be broken. This won't ":~atter 
since you can establish a soft link. Just remember, once you break the 
hard link you cannot count on the audio and video to play perfectly as 
recorded without you controlling them. Note that audio clips follow their 
video counterparts during cutting and pasting and the hard link is 
unaffected. 

To Break a Hard ora Soft Link: 
In the Construction Window select your clip and go to·the Edit menu and 
choose Break Link. Manipulate the clips as you would video clips, using the 
alignment markers to guide you. 

To Create a Soft Link: 
First realize that you cannot do this to a hard link without first breaking 
the hard link. Then, in the Construction Window select the audio or video 
clip you want to work-with, click the soft link tool from the lower 
lefthand corner -- it looks like one page overlapping another but with no 
dotted line around it. With the soft link tool active lick the clip you wish . 
to link. 
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_ Advanced Editing Techniques 

Using Adobe Premiere 

By Philip Ruthstrom 

These pages are designed to serve as a review of the class session of April 
14, 1998. 

Tapies covered in this lecture review are: 

1: Info, Clip, and Trimming Windows 

2: Setting In and Out Po.ints 

3: Setting and Using Markers 

4: Clip and Project Trimming prior to final assembly 

The Info window displays information about a selected clip, transition or 
space. 

The Clip Window displays the chosen clip. 
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The Trimming Window displays both clips on either side of a chosen edit 
point. 

IN and OUT points allow you to set insertion points of both a source clip and 
a destination in the project. 

MARKERS allow for precise syncronization of all combinations of video and 
audio clips. 

CLIP TRIMMING sets the size or the selected clip in the project. 

PROJECT TRIMMING sets the finished project size and removes 
unnecessary frames and clips from the project. 

Return 

The Info Window 

The Info window displays information about a selected clip, transition or 
space. The information varies according to where you make your selection: 

If you sel.ect a clip in the Construction Window, the Info Window displays 
the name of the clip, the type of clip, the speed of the clip, the duration of 
the clip, the size of the clip, the fade control settings of selected points, 

..· 
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the starting and ending times and the current Jocation of the pointer. 

If you seclect a clip in the Project Window, the Info window displays the 
clip's name, type, duration, size, starting and ending points and the current 
location of the pointer. 

If yo u select a transition in the Construction window, the Info window 
displays the transition's name, duration, starting and ending points, and "the 
current location of the pointer. 

If a Title window is active, the Info window displays information about a 
selected object, including its size and position in the window. 

If yo u select an empty space, the Info window displays the space' s duration 
and starting and ending times. 

To display the Info window, choose Info from the Windows Menu or press 
Ctrl+8. 

Using the info window allows you to position clips precisely by dragging with 
the cursor or by using the arrow keys to move the selection one fra111e at a 
time. You can also use this window to precisely position a selected object a a 
desired location or time. 

Return 
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· The Clip Window 

The Clip window is the most used of the assembly windows. This window is 
where the clip is viewed, marked and edited. It can be opened from the 
Windows Menu, or double clicking on the clip thumbnails in the Construction, 
Trimming, or Project windows. 

1 r..,...r..,,,~,..,.,lll I'JJI'["J 
• 

Here you may view the clip in various ways. Play the clip by clicking the Play 
button. Scrub through the clip using the slider bar. Move frame by frame by 
clicking the frame advance buttons, set In and Out points and Markers, and 
jump to specified locations using the control functions. 

Return 

The Trimming Window 

The Trimming window allows for the most precise editting in Adobe 
Premiere. Video clips can be edited with ease down to a single frame and 

. audio clips down to 1/600 second. 

The uniqueness of this window is that it is actually two windows in one. The 
window displays both clips on either side of a selected edifpoint. 
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You can also elect to display additional frames up to five before and after 
the edit point. In this Screen shot you will see both clips set this way. 

In this window you are viewing both clips. The larger view in the middle of 
each window shows the clip at the edit point. The others show the frames 
immediately before and áfter the edit point, and the fifth frame befo~e and 
after as well. You change the settings by either selecting the Windows -Menu 
and choosing Trimming Window Options, or right clicking on the Trimming 
Window and selecting Window Options in the Pop-Up Window. If you . 
encounter a Page Peel icen in any windo.w, it represents the first or last 
frame of the source clip. 

Here the icon is in the upper left cerner of the. right clip. This indicates that 
the frame at the edit point is the first frame of the source clip. You will 
notice that the window does not display any frames before the selected 
frame. (the blank frames above) The window does show the additional frames 
to the other side of the edit point. 

Return 
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Setting IN and OUT Points 

In traditional editing, the metaphor goes back to manual film editing. 
Originally after the individual scenes were shot and developed, the editor 
would cut the filmstrips at selected points. Any portion of the film that 
would not be used in the final product would literally "hit the cutting room 
floor." The editor's job was to decide where to make the cut; cut the film, 
and tape the segments back together in the desired order .. When video come 
along, the process was virtually the same. The analogue tape was actually cut 
at the desired location and spliced back together. Later, when the 
technology come available, video editors would play one tape begining at a 
specified point and ending at a specified point. This signal was re-recorded 
on another tape. This alllowed the tape to be edited without actually cutting 
and splicing the source tape. 

Adobe Premiere uses the cuttting and splicing metaphor, but preserves the 
original sources.-In reality, Premiere does not alter the sources at all. It only 
assigns electronic tags to use during final assembly. The final assembly 
process is MakeMovie. It is at this command that Premiere.searches the 
database an retrieves the desired selections and composites them as a 
finished project. There are two types of IN and OUT points to consider. IN 
and Out of the source and IN and Out of the target (construction). 

The In and Out points of the source clip are assigned in the Clip window. To 
set the IN or Out point for the clip, align the clip at the desired frame then 
select either IN or OUT as appropriate. 

Premiere will display an IN or OUT button to identify the point. This screen 
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shot shows the IN point with the button in the upper left corner. After the 
IN and OUT points are selected, the clip will insert at the desired points. 
The footage before and after the IN or OUT points is not "removed. 
Premiere uses these tags to compile the final product. the complete footage 
remains in the project until it is removed. Later, we will include the 
techniques for removing excess footage from the final project. 

Setting the IN and OUT points in the target can be done in multiple ways. 
First, you can establish IN and OUT points in the Construction window by 
selecting the appropriate flag from the tool bar at the bottom of the 
Construction window. 

•• 
After you select the desired flag, align it with the desired point in the 
Construction window using the Timeline indicator at the top of the window. 

Here an IN flag is selected. You may also select the clip in the Clip window or 
the Project window. After selection, got to Edit >Copy to Construction > 
Insert at Edit Line from the menu bar. This will Ripple Edit all clips to the 
right of the Edit line. The other two choices are Overlay which replacesthe 
existing clips whit the new clip for the duration of hte new clip. And Replace 
Work Area which replaces the area under the Work Area Bar (yellow bar at 
top of window). 

•' 
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Return 

Setting and Using Markers 

Markers are tags that Premiere uses to identify locations in the clips. You 
may us up to 1000 markers but only 10 (0-9) may be named. You assign a 
marker just as you assign IN and OUT points. In reality IN and OUT points 
are just special markers. After you set the clip to the desired location, 
simply select the marker number you w.ish to use from the box in the clip 
window. 

After you have assigned a number toa marker, the GOTO function allows you 
to jump to that location. Simply select GOTO and the marker you wish. 

Markers are very useful when aligning points or synchronizing tracks. 
Markers can be snapp aligned by selecting one and snap it to another marker 
using the Snap To Edges function in the construction window. Also You may 
need to use a marker to re-establish a link that has been broken. 
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Occasionally, linked tracks are puposely separated for editing. Premiere 
automatically assigns an unnumbered marker at the midpoint of every track 
whose link has been broken. To re-establish this link, simply snap the 
appropriate markers together. 

Return 

Project Trimming 

Project trimming involves two steps. First, you should remove all unused clips. 
Todo this, select either the Project window or the Construction window. 
Then from the Menu bar select Project > Remove Unused. This wilt remove all 
clips not actually in the construction from the Project and Project window. 

·, 

Second, you should remove all footage from the clips that is before the IN 
points and after the OUT points. This requires a little additional thought. 
After the project is trimmed, this function cannot be undone. From the 
Menu bar, select Tools > Project Trimmer. 

'. i ,, 
•• J ~-
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This will pull up another dialogue box in which you decide on th amount of 
extra footage to keep. These extra frames befare the IN points and after 
the OUT points are called handles. 

¡;¡- Croalelned )!alch ht 

r J:oPl' birrvned """"" lile: 

C.eate Proje<t 1 Cancel 

They will allow you to make small adjustments after the project is finished. 
in this screen shot, the default of 1 frame (handle) is shown. This is the 
minimum. Remember, the more you decide to keep, the larger the file size 
will be. 

Return 
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Breve descripción del personal que colabora en un proyecto multimedia 



GERENTE DE PROYECTO 

' Un gerente de proyecto está en el centro de la acción. Es el responsable del desarrollo total y de 
la implementación de un proyecto, y además, de las operaciones de ca~a día. Maneja los 
presupuestos, horarios, sesiones creativas, programación de tareas, enfermedades, facturas, 
dinámicas de equipo, etc. 

El gerente de proyecto tiene dos áreas de responsabilidad, el diseño y la administración. El 
diseño consiste en proponer la concepción del producto y evaluar toda su funcionalidad con el 
equipo de diseño, y entonces definir las especificaciones de funcionalidad y adaptarlas según se 
requiera a través del desarrollo del producto. La parte administrativa consiste en programar y 
asignar tareas, dirigir reuniones, administrar la consecución de metas, esencialmente supervisar 
todos los aspectos de la producción, desde el inicio hasta su conclusión. 

DISEÑADOR DE MULTIMEDIA 

Un buen proyecto de Multimedia debe tener una apariencia y forma de manejo que sea 
agradable, y que mantengan el interés del usuario. Las pantallas presentan una mezcla atractiva 
de colores, figuras y tipos de letra. El· proyecto mantiene su congruencia visual utilizando solo 
los elementos que refuerzan el mensaje global del programa. Las indicaciones para la navegación 
son claras y congruentes, los iconos son explícitos y los elementos de las pantallas son simples y 
directos. Para poder integrar estos elementos, diseñadores gráficos, ilustradores, animadores, y 
los que manejan imágenes digitales, se encargan de estructurar la "cara" de la presentación 
Multimedia. 

Los diseñadores de interfaces integran las rutas de navegación y el mapa de contenido en cada 
proyecto. Los diseftadores de información, dan éstructura al contenido, determinan las rutas del 
usuario y su retroalimentación, y seleccionan los medios de presentación y la manera en la que 
estos deben ser presentados. 

El diseñador de Multimedia prepara la descripción escrita del proyecto global: su contenido, 
medios e interacción. 

Un proyecto Multimedia necesita ser realmente interactivo, esto es, que se debe saber que 
esta haciendo el usuario cuando se ejecuta el sistema y como se alterara este en función 
de cada variable que recibe. Un tutorial inteligente es un sistema adaptable que permite 
entradas y se modifica en función de estos nuevos parámetros. 

Un diseñador de Multimedia necesita ser experto en diferentes tipos de medios, y ser capaz de 
crear una visión global del proyecto. Debe entender las capacidades de sus recursos, humanos y 
tecnológicos. 

DISEÑADOR DE INTERFACE 

Una interface permite que el usuario tenga el control de la presentación. Una interface no 
debe distraer al usuario solo es el medio por el cual el usuario navega con el sistema. 
Proporciona el acceso a los medios Multimedia, como son : texto, gráficos, animación, 
audio y vídeo. 



Algunas de las funciones y tareas que realiza el diseñador de interface son: encontrar los 
mecanismos con los cuales el usuario se puede mover dentro de un proyecto, el uso efectivo de 
ventanas, fondos, iconos y paneles de control. El trabajo de un diseñador de interface por lo tanto 
es el diseño de información, diseño interactivo, y diseño de medios. Una habilidad capital es 
estar familiarizado con muchas interfaces de Multimedia para ser capaz de visualizar las ideas 
mientras se exponen. También es conveniente que el diseñador de interface cuente con 
habilidades básicas de dibujo, porque así podría describir con papel y lápiZ cómo se veria una 
pantalla. 

ESCRITOR 

Los escritores de Multimedia crean personajes, acciones, y puntos de vista, además de crear 
interactividad entre· escenas. Escriben propuestas, narraciones explicativas, diálogos de actores, 
pantallas de texto para dar mensajes y desarrollan los personajes de un ambiente interactivo. 

Los escritores de pantallas de texto se conocen como escritores de contenido porque buscan y 
seleccionan información para sintetizarla y presentarla clara y concisa, los guionistas escriben 
diálogos, narraciones y explicaciones. 

En una película o vídeo se desarrolla una historia como lo haría un novelista o un dramaturgo. En 
Multimedia podría ser más dificil, aún piensas más dramáticamente, pero en pequeño, en 
unidades más discretas que tienen que interrelacionarse en un esquema general. ~ 

Cuando se trabaja en .. guiones dramáticos se tiene que hacer que los personajes y la trama 
funcionen antes de diseñar los diagramas de flujo. 

ESPECIALISTAS EN VIDEO 

·En un proyecto de Multimedia un especialista de esta área debe ser un profesional experimentado 
con habilidades administrativas en todas las fases de la producción, desde la concepción hasta la 
edición final. La producción de vídeo en equipo es muy cara pero actualmente es muy necesaria 
para la producción de proyectos de buena calidad. Los especialistas en vídeo deben de estar 
familiarizados con las herramientas de edición digital. 

Un especialista en vídeo debe entender el potencial y las limitaciones de los medios, cómo estás 
afectan la producción del vídeo en sí mismas. Deben entender la interactividad y cómo afectará 
el vídeo. Para algunos proyectos que requieran más trabajo, un especialista en vídeo debe ser el 
responsable de un equipo completo de graficadores de vídeo, técnicos de sonido, diseñadores de 
iluminación, diseñadores de escenografía, supervisores de guión, cargadores, asistentes de 
producción, cargadores y actores. 

ESPECIALISTAS EN AUDIO 

Un trabajo verdaderamente importante para un sistema Multimedia es su audio. Los especialistas 
en audio son los magos que hacen que un programa de Multimedia cobre vida, diseñando y 
produciendo música, narraciones explicativas y efectos de sonido. Un especialista de audio 
trabaja seleccionando .música adecuada, programando sesiones de grabación, digitalizando y 
grabando en los archivos de las computadoras. En audio digital una preocupación preponderante 

• 
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es el espacio de almacenamiento disponible en disco y hacer los cálculos necesarios para 
optimizar la velocidad de muestreo a la cual son digitalizados los sonidos. Un especialista en 
audio necesita ser m·ás creativo y talentoso que un ingeniero o· un artista tradicional de sonido. 
Emplear técnicas robustas para el diseño y producción de audio interativo. 

PROGRAMADOR DE MULTIMEDIA 

Un programador de Multimedia o ingeniero de software, integra todos los elementos de un 
proyecto en un conjunto congruente, utilizando algún secuenciador o manejador de objetos. Es 
responsabilidad del programador la codificación de pantallas sencillas de elementos de 
Multimedia, hasta el control de equipos periféricos, como unidades de disco láser y manejo de 
programación compleja, transiciones y registro de datos. 

Un programador de Multimedia se encarga de ejecutar varias tareas, desde organizar el código de 
los asistentes de producción más efectivamente, hasta mejorar las herramientas de producción y 
reproducción. Algunas veces un productor querrá hacer algo más allá de las capacidades 
integradas de las herramientas y el programador construirá extensiones para el conjunto de 
herramientas de desarrollo y presentación a fin de agregar la capacidad o efecto deseado. 



GERENTE DE PROYECTO 

Un gerente de proyecto está en el centro de la acción. Es el responsable del desarrollo total y de 
la implementación de un proyecto, y además, de las operaciones de cada día. Maneja los 
presupuestos, horarios, sesiones creativas, programación de tareas, enfermedades, facturas, 
dinámicas de equipo, etc. 

El gerente de proyecto tiene dos áreas de responsabilidad, el diseño y la administración. El 
diseño consiste en proponer la concepción del producto y evaluar toda su funcionalidad con el 
equipo de diseño, y entonces definir las especificaciones de funcionalidad y adaptarlas según se 
requiera a través del desarrollo del producto. La parte administrativa consiste en programar y 
asignar tareas, dirigir reuniones, administrar la consecución de metas, esencialmente supervisar 
todos los aspectos de la producción, desde el inicio hasta su conclusión. 

DISEÑADOR DE MULTIMEDIA 

Un buen proyecto de Multimedia debe tener una apariencia y forma de manejo que sea 
agradable, y que mantengan el interés del usuario. Las pantallas presentan una mezcla atractiva 
de colores, figuras y tipds de letra. El proyecto mantiene su congruencia visual utilizando solo 
los elementos que refuerzan el mensaje global del programa. Las indicaciones para la navegación 
son claras y congruentes, los iconos son explícitos y los elementos de las pantallas son simples y 
directos. Para poder integrar estos elementos, diseñadores gráficos, ilustradores, animadores, y 
los que manejan imágenes digitales, se encargan de estructurar la "cara" de la presentación 
Multimedia. 

Los diseñadores de interfaces integran las rutas de navegación y el mapa de contenido en cada 
proyecto. Los diseftadores de información, dan estructura al contenido, determinan las rutas:del 
usuario y su retroalimentación, y seleccionan los medios de presentación y la manera en la que 
estos deben ser presentados. 

El diseñador de Multimedia prepara la descripción escrita del proyecto global: su contenido, 
medios e interacción. 

Un proyecto Multimedia necesita ser realmente interactivo, esto es, que se debe saber que 
esta haciendo el usuario cuando se ejecuta el sistema y como se alterara este en función 
de cada variable que recibe. Un tutorial inteligente es un sistema adaptable que permite 
entradas y se modifica en función de estos nuevos parámetros. 

Un diseñador de Multimedia necesita ser experto en diferentes tipos de medios, y ser capaz de 
crear una visión global del proyecto. Debe entender las capacidades de sus recursos, humanos y 
tecnológicos. 

DISEÑADOR DE INTERFACE 

Una interface permite que el usuario tenga el control de la presentación. Una interface no 
debe distraer al usuario solo es el medio por el cual el usuario navega con el sistema. 
Proporciona el acceso a los medios Multimedia, como son : texto, gráficos, animación, 
audio y vídeo. 



Algunas de las funciones y tareas que realiza el diseñador de interface son: encontrar los 
mecanismos con los cuales el usuario se puede mover dentro de un proyecto, el uso efectivo de 
ventanas, fondos, iconos y paneles de control. El trabajo de un diseñador de interface por lo tanto 
es el diseño de información, diseño interactivo, y diseño de medios. Una habilidad capital es 
estar familiarizado con muchas interfaces de Multimedia para ser capaz de visualizar las ideas 
mientras se exponen. También es conveniente que el diseñador de interface cuente con 
habilidades básicas de dibujo, porque así podría describir con papel y lápiz cómo se vería una 
pantalla. 

ESCRITOR 

Los escritores de Multimedia crean personajes, acciones, y puntos de vista, además de crear 
interactividad entré escenas. Escriben propuestas, narraciones explicativas, diálogos de actores, 
pantallas de texto para dar mensajes y desarrollan los personajes de un ambiente interactivo. 

Los escritores de pantallas de texto se conocen corno escritores de contenido porque buscan y 
seleccionan información para sintetizarla y presentarla clara y concisa, los guionistas escriben 
diálogos, narraciones y explicaciones. 

En una película o vídeo se desarrolla una historia corno lo haria un novelista o un drarnaturgo. En 
Multimedia podría ser más dificil, aún piensas más dramáticamente, pero en pequeño, en 
unidades más discretas que tienen que interrelacionarse en un esquema general. 

Cuando se trabaja en guiones dramáticos se tiene que hacer que los personajes y la trama 
funcionen antes de diseñar los diagramas de flujo. 

ESPECIALISTAS EN VIDEO 

· En un proyecto de Multimedia un especialista de esta área debe ser un profesional experimentado 
con habilidades administrativas en todas las fases de la producción, desde la concepción hasta la 
edición final. La producción de vídeo en equipo es muy cara pero actualmente es muy necesaria 
para la producción de proyectos de buena calidad. Los especialistas en vídeo deben de estar 
familiarizados con las herramientas de edición digital. 

· Un especialista en vídeo debe entender el potencial y las limitaciones de los medios, cómo estás 
afectan la producción del vídeo en sí mismas. Deben entender la interactividad y cómo afectará 
el vídeo. Para algunos proyectos que requieran más trabajo, un especialista en vídeo debe ser el 
responsable de un equipo completo de graficadores de vídeo, técnicos de sonido, diseñadores de 
iluminación, diseñadores de escenografia, supervisores de guión, cargadores, asistentes de 
producción, cargadores y actores. 

ESPECIALISTAS EN AUDIO 

Un trabajo verdaderamente importante para un sistema Multimedia es su audio. Los especialistas 
en audio son los magos que hacen que un programa de Multimedia cobre vida, diseñando y 
produciendo música, narraciones explicativas y efectos de sonido. Un especialista de audio 
trabaja seleccionando música adecuada, programando sesiones de grabación, digitalizando y 
grabando en los archivos de las computadoras. En audio digital una preocupación preponderante 



es el espacio de almacenamiento disponible en disco y hacer los cálculos necesarios para 
optimizar la velocidad de muestreo a la cual son digitalizados los sonidos. Un especialista en 
audio necesita ser más creativo y talentoso que un ingeniero o· un artista tradicional de sonido. 
Emplear técnicas robustas para el diseño y producción de audio interativo. 

PROGRAMADOR DE MULTIMEDIA 

Un programador de Multimedia o ingeniero de software, integra todos los elementos de un 
proyecto en un conjunto congruente, utilizando algún secuenciador o manejador de objetos. Es 
responsabilidad del programador la codificación de pantallas sencillas de elementos de 
Multimedia, hasta el control de equipos periféricos, como unidades de disco láser y manejo de 
programación compleja, transiciones y registro de datos. 

Un programador de Multimedia se encarga de ejecutar varias tareas, desde organizar el código de 
los asistentes de producción más efectivamente, hasta mejorar las herramientas de producción y 
reproducción. Algunas veces un productor querrá hacer algo más allá de las capacidades 
integradas de las herramientas y el programador construirá extensiones para el conjunto de 
herramientas de desarrollo y presentación a fin de agregar la capacidad o efecto deseado. 
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Anexo B) 

Manual de operación de "Sound Forge" 



Using the Mouse 
Although using the mouse in Sound Forge is not required, it will make your editing sessions easier. Once 
you beco me familiar with Sound Forge you will probably want to use sorne of the built in shortcuts 
provided by the mouse and the keyboard. The following list of terms will help you when reading the 
manual. 

Pointing 

Clicking 

Double-Ciicking 

Triple-clicking 

Toggle-clicking 

Shift Clicking 

Control Clicking 

Dragging 

Slow-dragging 

Dropping 

Moving the mouse pointer over an item is called pointing. 

Pointing toan item and quickly pressing and releasing the left or right mouse button 
is called clicking. The manual willlet you know whether you need to right-click or 
left-click on an item to execute a specific function. When there is no specification as 
to left or right you can assume we mean left-clicking. Right-clicking is otten used to 
reach Shortcut Menus. 

Double-clicking is the same as clicking except instead of pressing and releasing the 
mouse button once you do it twice in quick succession. Double-clicking always 
indicates clicking twice with the left mouse button. 

Triple-clicking is the same as clicking except instead of pressing and releasing the 
mouse button once you do it three times in quick succession. Triple~clicking always 
indicates clicking three times with the left mouse button. In Sound Forge, a 
triple-click in the data window selects all data. 

Toggle-clicking involves clicking the right mouse button while holding the left mouse 
button to toggle through various options. This is a great shortcut for procedures 
such as drag and drop and changing the Magnify Too/ mode of operation. 

Shift-clicking is holding down the Shift key on the keyboard while clicking the 
mouse. Shift clicking is used mainly to skip dialogs so that you can quickly repeat 
operations. 

Control -clicking is holding down the Control key on the keyboard while clicking the 
mouse. Control-clicking is used to modify the operation of a normal click. 

Holding down the mouse button while you move the mouse pointer is known as 
dragging. Dragging is used to quickly move sections of data between separate 
windows and to move trackbars, scrollbars, faders. 

Holding down both the right and left mouse buttons while moving trackbars, and 
faders increases the resolution of the movement. This is especially useful when 
making fractional adjustments to parameters in a dialog box. 

After dragging an item, releasing the mouse button on top of another area is known 
as dropping. Dragging and dropping is used to speed up operations like mixing or 
moving regions within the Playlist. 



The Main Screen 

When you start Sound Forge, you see the main screen, or work space, where you will do all your 
editing. When you first open Sound Forge, no Data Windows are open and you will need to 
either open an existing sound file or create a new one. There are a variety of ways to do this, all 
of which are explained la ter in the manual. The following list briefly describes each part of the 
ser e en. 

Program Title Bar 
Shows the program name and the name ofthe currently active data window (ifthe data window 
is maximized within the workspace ). 

Data Window 
Each opened sound file has its own data window. Data windows can be arranged, resized, or 
minim1zed. 

Menu Bar 
Shows the menu headings for the available functions. When no data windows are open, the 
Process, Effects, and Tools menus are not listed because these contain functions which require an 
open data window. 

Status Bar 
On the left, help and processing information is displayed. The fields on the right show the 
playback sample rate, sample size, mono/stereo, totallength ofthe active data window, and the 
total free storage space. These fields can be edited by double-clicking or right-clicking on them 
(except for the free storage space, of course). When no data windows are open, the fields are 
blank. 

Sound Forge Workspace 
This is the background area behind the data windows. Y ou can drag sections here to crea te new 
data windows. 

TOOLBARS 

The first time you run Sound Forge, two toolbars also appear on the screen: the Standard 
and Transport toolbars. The toolbars contain buttons which are used to quickly execute 
commands. 

Standard 
Provides quick access to many commonly used Sound Forge File and Edit menu options. 

Transport 
Provides the audio transport buttons: Record, Play All, Play Normal, Pause, Stop, Go to 
Start, Rewind, Forward, and Go to End. 
These toolbars, like any other toolbar in Sound Forge, can be dragged and dropped to 
anywhere on the screen. Toolbars are also resizable and removable. When a toolbar is 
dragged to any side ofthe main window, it docks, or attaches to the side. Ifyou draga 
toolbar away from a side, it becomes a floating toolbar. To hide a floating toolbar, just 
click on its Close button. 
A list of available toolbars can be displayed by selecting the Preferences comrnand under 
the Options m en u and looking in the Toolbars folder ( or Toolbars in the View menu). To 
show a toolbar, just check the box next to the toolbar you wish to use and then select O K. 
The number of open toolbars and their position on the screen is entirely up to you. 



The Data Window 
Data Windows are the windows which contain sound data files. These windows contain a number of sub 
windows and controls which you will use in editing and viewing your sound data. Many parts of the Data 
Window lead to Shortcut Menus, dialogs, and other operations. 

The following list briefly describes each part and possible mouse operations: 

Title Bar 

Level Ruler 

Time Ruler 

RulerTags 

Edil Tool Selector 

Playbar 

Shows the file name or, if present, the tille stored in the Summary information 
of .WAV files. Double-click to maximiza and restare the window. 

Shows the amplitude of the waveform. Right-click to reach the Leve/ Ruler 
shortcut menu. Drag lo shift the view up or down when zoomed in vertically. 

Shows the curren! location in the data window as well as ruler tags. Right-click 
to reach the Time Ruler shortcut menu. Drag to scroll the data window. 

Used to indicate the position of region end points, loop end points, and 
markers. Right-click lo reach the Ruler Tag shortcut menu. Drag to change 
their locations. Double-click anywhere in the region to select. 

Use this button lo toggle between the Edit, Magnify, and Pencil Tools. Note: 
The Pencil Too/ requires that the zoom ratio be between 1:1 and 1:16. 

o'n the left side of the playbar are the following audio transport buttons:cGo to 
Start, Go to End, Stop, Play Normal, Play Looped, and Play as Sample. To the 
right are the playba~s selection status fields. 

Selection Status Fields Show the beginning, end, and length of a selection. lf no selection has been 
made, only the cursor position (also known as the insertion point) is displayed. 
Double-click on the left-most field to reach the Go To dialog. Double-click on 
either of the other two fields to reach the Set Selection dialog. Right-click to 
reach the Status Fonnat shortcut menu. 

Waveform Display Shows a graphical representation of the sound file. The horizontal axis 
represents time (marked in the Time Ruler) and the vertical axis represents 
amplitude (marked in the Leve/ Ru/er). Right-click anywhere on the waveform 
display to reach the Wavefonn Display shortcut menu. 

Position Scroll Bar Use this to scroll the sound file forward and backward in time to see parts of 
the file not currently visible in the waveform display. 

Overview Allows for quick navigation and playback of any part of the file. Overview also 
shows the fraction of the waveform being shown on the waveform display, as 
well as the selected region. Left-click to move the cursor. Double-click to 
center the cursor in the waveform display. Right-click to start playback or 
pause. Left-click and drag to actívate the Audio Event Locator. 

Time Zoom Resolution (Also called Zoom Ratio) Specifies the number of samples of data representad 
by each point on the screen horizontally. This determines the length of time 
which is shown in the waveform display. With a small resolution value (1 :1, 
1:2, 1:4, ... ),a shorter length of time is displayed. 

Time Zoom In/Out Use this to change the zoom resolution lar the time axis. Between these 
buttons is a spinner that allows you to continuously change the time zoom 
resolution. 

Leve! Zoom In/Out Use this to change the zoom resolution for the level (vertical) axis. Between 
these buttons is a spinner that allows you to continuously change the level 
zoom resolution. 

·.• 



Maximiza Width 

OLE Drag Source 

Pressing this button stretches the width of the data window lo fit within !he 
Sound Forge workspace. 

Drag from this section of the data window into another application such as 
Microsoft Word, lo link the sound file lo other documents. 



Using the Transport versus the Data Window Playbar 

There are a number of ways to play your sound files within Sound Forge. The most common method is to 
use one of the Play buttons located either on the Transport toolbar or the playbar in the data window. Let' 
s take a look at both of them. 

On the left-side of the playbar at tlie bottom of every data window are six buttons. These buttons allow 
you to play the sound data in a variety of ways. The first two buttons allow you to set the cursor to the 
start or end of the curren! file. These are the Go to Start and Go to End buttons. The next button is the 
Stop button which you can use at any time to stop playback. 

The last three buttons play the sound in three different ways and also set the default play mode at the 
same time. The first button is the Play Normal button. This button plays the currently selected section of 
data. lf there is no selection, pressing the Play Normal button plays from the curren! cursor position to the 
end of the file. 

The final button is the Play as Sample button. This button is used to play a sound file as if it was present 
in a sampler. This means the file will play from the start until it reaches the sustaining loop defined for the 
file and then willloop in the sustaining loop for the number of loops defined. lf there are no·loops defined 
the file plays straight through. This is known as a one shot sample. 

Whenever you play a file from the playbar, you will notice a smallline that appears underneath the play 
arrow in the corresponding Play button. This is the curren! play mode which will be used whenever you 
select the Play button in the Transport toolbar (or hit the Spacebar). Play Normal is the curren! play mode 
in the playbar graphic shown above. 

To change the curren! play mode, press the corresponding playbar button or use Controi+Spacebar. 

The Transport Toolbar 
The Transport toolbar has seven buttons. 

described below from left to right: 

RecordBrings up the Record dialog which allows you to record to either a new or existing window. 
Shortcut: Controi+R 

Play AIIPiays the entire sound file from beginning to end. This allows you to hear the entire sound even if 
you have a selection or the cursor positioned somewhere other than the 
start ·of the data. Shortcut: Shift+Spacebar 

PlayPiays the file using the curren! play mode. To set the play mode select one of the three play buttons 
on the playbar as described above. The last button used becomes the 
active play mode. Shortcut: Spacebar 

PauseWorks like the Stop button in that it stops play of the curren! file. However when selecting Pause 
the cursor is placed at the curren! play position rather than back to 
where it was when play was selected. Shortcut: Enterduring playback 

StopStops play and positions the cursor back to where it was prior to selecting play. Shortcut: Spacebar 



during playback 

Go to Start Places the cursor at the beginning of !he sound file. 
Shortcut: Controi+Homfl 

Rewind Shuttles !he cursor backward in !he sound file. 
Shortcut: Controi+Left Arrow 

Forward Shuttles !he cursor forward in the sound file. 
Shortcut: Controi+Right Arrow 

Go to End Places !he cursor al !he end of !he sound file. 
Shortcut: Contro/+End 



Creating a New Window 

To create a new Data Window do the following: 

l.Select the New command from the File menu. Sound Forge displays the New Window dialog. 
2.Select the new data forma! in the dialog. 

Since we are already working with the TUTOR! file let's create a new window that has the same 
data forma! as TUTOR!. 
In the New Window dialog set the Sample size to 16-bit, the Channels to Mono, and the Sample 
rate to 44,100. When you click the OK button a new window will appear titled Sound2. This is 
an empty data window into which we are going to place data from TUTOR!. 

When you have Ínultiple windows on the screen, only one window is considered the active 
window. This is the window on which you are currently work:ing. Any operations you perform 
will only affect this window. 

To make a window the active window click anywhere on the window with the left mouse button. 
The window's title bar will change to the color you have defined as the active window color in 
Control Panel in Windows. 

Copying Data to a New File 

Make Wow, sound edJting ... the active wmdow by clicking on its title bar. Ifyou don't still have 
the word Wow selected, select it again as we did above. From the Edit menu, selectthe Copy 
command. This will copy the sound data for Wow onto the clipboard. 

Now make Sound2 the active window by clicking on its title bar (ifthe title bar is covered by 
another window, you can always use the Window menu to activate a data window). Select the 
Paste command from the Edit menu and the Wow data will appear in the Sound2 window. If you 
press the Play button, you can hear how our new file sounds with just the word Wow. 

There are faster ways to copy data from one window to another, or from an existirig window toa 
new window;but we will cover those in a later section. 

Saving a File 

To save a data window, you first need to make it the active window. Make sure the 
Sound2 window is active.· 

l.Select the Save command from the File menu. Since the Sound2 window is a new file, 
Sound Forge displays the Save As dialog. Ifthe file had been opened or previously saved 
by Sound F orge the file would be saved immediately. 

2.Type a file name into the File name field in the Save As dialog and select the OK 
button. Let's save the new sound file, Sound2, as MYFIRST Sound Forge will add the 
file extension, .WAV, autorríatically. 

The Save As dialog also allows you to change file types, data format, and set summary 
information fields. This is covered in a later section. · 
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Common Edit Operations 

The edit operations used most often include cut, copy, paste, delete, mix, and trim/crop. 
Most ofthese make use ofthe Clipboard, which is a temporary storage area which can 
also be used to move data from one window to another. The following list provides a 
brief description of each operation: 
Cut 
Deletes a selected portion of data and copies it on to the Clipboard. 
Copy 
Copies a selected portion of data on to the Clipboard. 
Clear 
Deletes a selected portion of data but doesn't copy it on to the Clip board. 
Trim/Crop 
Deletes all data in a window except the selected section. 
Paste 
Inserts the contents of the Clip board into a Data Window at the curren! cursor position. 
Mix 
Mixes the contents ofthe Clipboard with the current data in a window starting at the 
curren! cursor position. 
Crossfade 
Crossfades the contents ofthe clipboard with the curren! data in a window starting at the 
curren! cursor position. 
To show how these operations are used, we will once again be using the TUTORI.WAV 
file. If it is not curren ti y open please open the file now as described in the previous 
sections. 

Copy, Paste, Cut, Undo, and Redo 

Copying Data on to the Clipboard 

Once you ha ve a selection, you can use the Copy command from the Edit menu. This will copy 
the selected data onto the clipboard. You will see no change since the Copy command does not 
change the data, it only copies it to the clipboard. 

Pasting Data from the Clipboard 

Now m ove the cursor to the beginning of the file by selecting the Go to Start button on the 
play bar. To insert the contents of the clipboard into the file, use the Paste command from the 
Edit menu. You should now see the data for the word "Wow" appear at the beginning ofthe 
wmdow. Press the Play buttonjust to make sure. You should hear Wow Wow Sound editingjust 
gets easier and easier. 

You have just made your first edit in Sound Forge! There are much quicker ways todo what we 
ha ve just done with Sound Forge, but we'll get to that in the Advanced Editing section. 



Pasting Data to Another Window 

Data on the clipboard remains there until it is replaced by another operation which places data 
onto the clipboard. Therefore, you can continue pasting the data anywhere you want. 

To demonstrate this, create a new window as described in the previous section by selecting the 
New option from the File menu. Now, select the Paste command from the Edit menu once more. 
Y ou should now ha ve a new data window with the data for the word Wow. Yo u can al so do this 
by selecting the Paste to New function in the Paste Special item of the Edit menu. This crea tes a 
new window and fills it with the clipboard contents in one easy step. 

Cuttmg Data 

To cut data, first you need to selecta section of data you want to cut. Select one ofthe Wow 
words (you should ha ve two ifyou have been following the examples) from TIITORI. 

Now select the Cut command from the Edit menu. This will remove the selected data and place it 
on to the clipboard. 

Undoing an Edit Opera'tion 

After any edit operation you·can cancel it by selecting the Undo command from the Edit menu. 

Let's undo the cut we just made. Select Undo Cut from the Edit menu and you will see the 
original two Wow words in the TUTOR 1 window. 

Redoing an Edit Operation 

Ifyou change your mind again and decide you really liked an edit you undid, simply select Redo 
from the Edit menu. Doing this re-performs the edit operation you las! undid. In this case 
selecting Redo would re-cut the second Wow from the TIITORI window. 

Let's redo the cut. Select Redo Cut from the Edit menu and you will see the second Wow has 
been cut from the file again. 

The Undo/Redo History window (View menu) also allows you to restore your sound file to 
previous states byundoing or redoing operations. For more information, see the Reference 
section. 

··~· 
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Trimming edges (crop) 

Trim (also called Crop) allows you to single out a section of data and cut everything else out of 
the window except that section. This is a handy feature since you can keep using the Play button 
to hear selections until you ha ve just the right amount and then get rid of everything el se with the 
Trim/Crop command in the Edit menu. · 

By now you should be getting used to selecting data on the screen, so select the "Wow, sound 
editing just gets easier" section in the TIJTORI window, but don't select the second easier. 
Remember yo u can use the Play button to hear how the selection sounds at any time. 

Once you ha ve the selection, select the Trim/Crop item found in the Edit menu. After cropping 
you will have only "Wow, sound editingjust gets easier" left in the window. 

At this point let's el ose the Wow, sound editing ... window. Either click on the el ose box of the 
TUTORI window, or select the Close command from the File menu. You will be asked whether 
you want to save the changes you have made to TIJTORI. Select the No button since we don't 
want to keep the changes we made to TIJTORI. 

Also close any other windows you may have open, like MYFIRST.W AV. 

Mixing 

M1xing is a powerful and useful edit operation which you will use often. Mixing allows you to 
combine two sounds together into one window so you can create complex sound effects. 

This t1me we are going to open two files, TIJTOR!.WAV and TIJTOR2.WAV. Open them now 
as we've shown you in the previous sections. 

TUTOR2 is a file which contains the sound of a snare drum and crash cymbal. We are going to 
mix this sound with TUTOR!; the "Wow, sound·editing ... " window, 

Before we begin mixing, let's make sure the Status Format is set to Time to make finding the 
m1xing points a httle easier. Todo this select the item Time from Status Formal under the 
Opt10ns menu. You will need todo this for both data windows since Sound Forge keeps track of 
the formal type for each individual window. 

To make the windows easierto view during the mix operations you may want to maxim1ze 
Sound Forge by pushing the Maximize Window button in the upper right-hand comer and 
selecting the Tile Vertically item from the Window menu. This will arrange the windows 
vertically fully utilizing the Sound Forge workspace and make things easier to see. 

Ifyou activate each ofthe TUTOR windows you will notice that the length ofTUTORI is 5.0 
seconds long and TIJTOR2 is 3.0 seconds long. For this example, we want the drum hit to occur 
JUSt before the "Wow." We couldjust copy the drum hit sound on to the clipboard and then paste 
it before the "Wow", but this would increase the length ofTIJTORl to 8.0 seconds. So instead 
we'll use the Mix command. 

Select all the data in Drum Hit by making it the active window and then double-clicking in the 
waveform d1splay with your left mouse button (you could also use the Select All command under 
the Edit menu). Now copy the data onto the clipboard by selecting the Copy 
command from the Edit menu. 

Make TUTOR 1 the active window and then select the Go to Start button on the playbar. This 
WJII put the cursor at the beginning of TUTOR l. Select the Mix command from the Paste Special 
opt10n in the Edit menu. 



The Mix dialog now appears. Keep both levels at O dB and select OK. 

You will see that !he drum hit sound has been mixed into the TIJTORI window and the length of 
TIJTOR 1 is still 5 .O seconds. Press the Play button to hear the results. 

Select the Undo Mix command from !he Edit menu to put TIJTORI back to its original state. 

Now let's mix the drum hit sound closer to the Wow portion of11JTORI. The Wow occurs at 
about 0.8 seconds into TIITORI, so move your cursor in the TIJTORI window to approximately 
0.8 seconds. You do this by clicking with the left mouse button in the data window ofTUTORI 
and watching the cursor position status field on the status bar (!he left most field). You don't 
have to be exact. Once you've positioned !he cursor, select the Mix comrnand again and then hit 
Play for the result. Notice how the drum hit sound and the Wow sound overlap each other. 

Status Formats 

By right-clicking on the Time Ruler and selection status fields on the playbar, files can be set to 
different formats. You can coordinate sound files with other events, or edit toa timing base you 
feel most comfortable using. 

Lengths and positions can be displayed in a variety of formats including Samples, Time, 
Seconds, Frames, Measures and Beats, and SMPTE. 

Selecting a Status Formal 

To selecta format choose the Status Formal item from the Options menu. This shows the ten 
different formats available. Choosing one of these options sets the status formal for the curren! 
data window. 

The available formats are: 

Samples. Number of samples 

Time. Hours, minutes, seconds and milliseconds 

Seconds. Seconds and fractions there of 

Time & Frames Hours, minutes, seconds and frames as defined by the Edit Frame Rate (Special 
Menu )comrnand 

Absolute Frames Frames and fractions there of 

Measures & Beats Measures, beats and l/4's of a beat 

SMPTE Non-Drop SMPTE at 30 or 29.97 frames per second (fps) non-drop 

SMPTE Drop SMPTE at 30 fps with drop frames 

SMPTE EBU SMPTE at 25 fps 

SMPTE Film Sync SMPTE at 24 fps 

Using the curren! file, TIITORI, let's take a look at how the status formats affect values in the 
status display fields. First, select the Samples formal from the Status Formal menu under the 
Options menu. 

Now select all ofthe data in the TIITORI window. Todo this choose the Select All ophon from 

" ' 
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the Edit menu. This will select all data in the window. You can also select all ofthe data in a 
window by triple-clicking the left mouse button anywhere in the waveform display of the data 
window. 

In the selection status fields on the playbar (at the lower right hand side ofthe data window) you 
should see the values ofO, 240,006, and 240,007. This means that the first selected sample 
(Selection Left) is sample O, the last selected sample (Selection Right) is 240,006, and the total 
number of samples in the selection (Selection Length) is 240,007. 

Now select the Time option from Status Formal under the Options menu. You will see that all 
these val u es change to values specified in hours, minutes, and seconds rather than samples. Yo u 
can see that a sound containing 240,007 samples with a sample rate of 44, 100 Hz will play for 
5.000 seconds. Y ou can experiment with each of the status formats to see how each format IS 
displayed. 

Configuring Frames and Measures & Beats 

When setting the status format to Frames or Measures & Beats, there is additional information 
you can provide to Sound Forge to customize how these values are displayed. The Edit Frame 
Rate dialog in the Special menu allows you to change the frames per second. In the Edit Tempo 
dialog, also in the Special menu, you can specify the Beats per minute and Beats per measure 
values used to calculate measures and beats. The default values for Frames and Beats are set on 
the Status page in the Preferences folder (Options menu). 



Selecting with the keyboard 

The keyboard selection controls allow you lo quickly select data or update a selection accurately. For 
example, say you want lo extend !he selection end by a small amount. First make sure that the cursor is 
al !he end of !he selection. You can move !he cursor from one end of !he selection lo another by pressing 
!he Home (moves lo !he start) and End (moves lo the end) keys. Use !he C key lo center !he cursor in 
!he waveform display. You can lhen use !he Shift+Right arrow and Shift+Left arrow combinations lo 
extend the selection end point by small increments. 

The following list shows the available keyboard commands for selecting data. 

Press 

Shift+Right arrow 

Shift+Left arrow 

Shift+End 

Shift+Home 

Press 

Shift+Page Up 

Shift+Page Down 

Shift+Contro/+Right arrow 

Shift+Controi+Left Arrow 

Shift+Numpad + 

Shift+Numpad -

Shift+Controi+Numpad + 

Shift+Controi+Numpad-

To select from cursor to •.• 

the next screen pixel. 

!he previous screen pixel. 

!he las! sample visible in !he waveform display. 

!he first sample visible in the waveform display. 

To select ... 

10% of the curren! view past !he cursor position. 

10% of the curren! view previous to the cursor position. 

2% of !he curren! view past the cursor position (see below). 

2% of the curren! view previous to the cursor position (see below). 

the next sample. 

the previous sample. 

1 O samples past !he curren! pos ilion. 

10 samples previous to the curren! position. 

~--lnWíndows 95, ShlffNiimjJiiCJ + w1ll no! work unless !he Numlock 1nd1cator on t!ief 
¡ keyboard is lit. i 

Also, if there are regions, markers, or loops present in the data window: 

Press 

Shift+Contro/+Right arrow 

Shift+Controi+Left arrow 

To select from cursor to ..• 

!he next region start/end or marker. 

the last region start/end or marker. 

As you can see from the above lisis. Sound Forge has extensive keyboard support for selecting data. 
You will find that almos! any operation has an equivalen! keyboard shortcut which advanced users find 
invaluable. For a complete listing see Appendix A. 

Let's take a quick look at how to use sorne of these keys. Open the file TUTOR1_.WAV as we've done in 
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previous sections. First, make sure that you're using !he Edil Too/ by selecting it in Too/ under !he Edil 
menu. Now make a selection that encompasses !he word Wow with a generous amount of space on 
each side of !he word. Pressing !he Play button you should hear a little bit of silence, Wow, and a little 
more silence. 

Choose the Zoom Selection command from either Zoom Leve/ or Zoom Time in .the View menu. This will 
fit !he selection on the screen with !he bes! possible resolution. Now let's adjust !he right side of !he 
selection. 

Grab !he end of !he selection with !he mouse and drag lo !he right. Adjust !he selection lo be close lo the 
end of !he word Wow and le! up on the mouse button. Now let's do !he same thing with !he keyboard. 
Hold down !he Shift key and press !he right arrow key. The selection will extend lo the right by one 
screen pixel. lf you hold down !he Shift key and press !he /eft arrow key, !he selection will decrease by 
one pixel. One screen pixel is equal lo the number of samples shown in the Zoom Ratio field. You can 
m ove the end of !he selection in this manor until you've gol !he selection jusi right. 

Now let's adjust !he start of !he selection. Since the cursor is at !he end of the selection, any keys we 
press for selecting will adjust the end. So we need to put !he cursor at !he front of the selection. To do 
this, press the Home key. You will see the cursor jump to the start point of the selection. Now, use the 
selection keys to adjust the start ot the selection. 

A selection can also be updated on a per sample basis ratherthan a pixel basis. lf you look in the above 
lis! you will see that the Shift + Numpad + (plus) and - (minus) keys are used for these operations. This 
allows you to get the exact selection you need without having to change !he Zoom Ratio. 



The Overview 
While making selections and navigating through a sound file, you probably noticed the overview (the thin 
bar directly underneath the title bar) change. The overvie.w represents the length of the entire sound file, 
as if you were zoomed out all the way. From the overview, you can determine what section of the en tire 
sound file is being displayed, the selection made, and the cursor location. 

Getting the Whole Picture 
Zoom out all the way on the TUTOR1 window (Zoom Out Fu// in the Data Window shortcut menu) and 
make a selection over the word Wow. Notice that the entire overview has brackets above and below it, 
since the en tire sound file is being displayed. Also notice how the selection and the cursor are displayed 
on the overview. 

Now press the Zoom In button a few times (the large magnifying glass in the lower right-hand cerner of 
the data window) and notice how the brackets become smaller. This corresponds to the smaller fraction 
of the en tire sound file which you can see when you zoom in on the waveform display. The selection size, 
however, remains the same and does not move. Even when you can'! see them on the waveform display, 
you always know where the cursor and the selection are in the sound file by referring to the overview. 

You can also change the cursor position by left-clicking anywhere on the overview. As always, when you 
change the cursor, you lose your selection. Remember you can use Toggle Se/ection if you want to 
restare it. -·,, 

Fast Navigation añd Playback ,, '· 
When you left-click outside the bracketed region in the overview, you will not be able to see the cursor on 
the waveform display. However, double-clicking anywhere on the overview will move the cursor and 
center the waveform display to the selected position in the sound file. 

You can also play back the sound file starting from the curren! cursor position by right-clicking anywhere ·: 
on the overview. Right-clicking again pauses playback. Left-clicking in the overview also moves the 
cursor position. Also note that left-clicking on the overview during playback moves the cursor to the point 
where you clicked and continuas playback at that point. These navigation tools make it very easy to find 
sections in large files. 

Asan example, say you wanted to move the cursor to the beginning of a phrase in a speech. You can 
right-click on the overview bar to begin playback and then left-click at different positions withrn the 
overview until you find the right start point. Once you find the start point, you can press the Stop button to 
stop playback. The cursor should now be positioned at the last spot on which you left-clicked in the 
overview; select Center Cursor from the Special menu and you are ready to edil. 

Audio Event Locator 
Holding down the left mouse button and dragging it in the overview bar will begin playback of small 
looped portions of audio around the cursor position. While this is not technically a scrub function, it serves 
a similar purpose i.e., it allows the user to hear brief segments of audio material in arder to quickly sean 
or locate events within the sound file. The length of the Audio Event Locator loop segment can be 
adjusted in the Preferences dialog. 



Advanced Editing and Navigation 

Making a selection using the Set Selection dialog 

If you need to select data at specific points, the Set Selection dialog allows yo u to type in 
selection points or choose a selection from a list of regions. To reach the Set Selection dialog, 
choose the Selection!Set command from the Edit menu. 

In the Set Selection dialog, you can modify the Start, End, Length, and Channel of the selection. 
Pre-determined regions can also be chosen from the Selection drop-down list. 

Also, in this dialog yo u will find Snap Zero and Snap Time buttons. Pressing one of these 
buttons will force the curren! start and end selection points to their nearest zero-crossings or time 
increments, accórdingly. A more thorough explanation ofthese functions can be found in the 
Reference chapter under Selection in the Edit menu section. 

Many commonly used functions in Sound Forge can be performed in a number of different ways. 
For example, you can reach the Set Selection dialog by double-clicking on the playbar field to 
the left of OLE, or yo u can pick the Selection item from the Waveform Display shortcut m en u. 
Sound Forge has been designed to allow you to choose how you want to work. lt doesn't force 
you to work in a certain way. To avoid confusion in our demonstrations, we won't always te11 
you about every method of accomplishing the same task. Refer to the Sound Forge Reference 
chapter and the Appendix section on shortcut keys for more information on each feature .. 

Extending a Selection the Mouse 

After selecting a section of sound data, you will sometimes find that the start or end points are 
not exactly where you want them to be. You couldjustre-select the data, but it is often difficult 
to get the start or end points just right. 

Sound Forge allows you to update the selection by grabbing a selection edge and moving it. 
Once you ha ve established a selection, place the mouse over the selection start or end pomt. Y ou 
will notice that the cursor changes toa bi-directional arrow. Once this arrow appears, you can 
press the left mouse button and move the selection to a new position. The new position will be 
updated once you Jet up on the mouse button. 

Snappmg a Selectwn to Zero-crossings 

If after making a selection, the end points jump somewhere else automatically, its probably 
because you ha ve Auto Snap to Zero on. You may want to enable Auto Snap to Zero (under the 
Options menu) so that any drag selections start and end points will always reside on a zero­
crossing. 

To make a curren! selection snap to zero-crossings, select Edit!Selection!Snap to Zero (or press Z 
on the keyboard). 

lfyou'd like Auto Snap to Zero disabled only when zoomed in (1:1 or 2:1), select the Disable 
auto-snapping below 1:4 zoom ratios option in the Editing page in the Preferences folder. 

Using the Go To dialog 

To quickly move the cursor to a specific point and center it in the waveform display, use the Go 
To command. You can reach the Go To dialog in a number of different ways: 

Use the Go To item in the Edit menu 
Right-click on the waveform display and select Cursor!Go To from the shortcut menu 



Double-click on the left-most selection status field 
Press Control+G 

The Go To dialog is much Jike the Set Selection dialog described below. You can type in the 
location where you want to go or use one ofthe predetermined locations from the Jist. To create 
your own location marker, press the M key at any cursor position. Yo u can also drop a marker at 
any time during playback and recording by pressing M. Refer to the Regions List and Playlist 
sections for more information on using markers. 

Using Views 

If you wish to save the selection póints you've set, the zoom ratio, or the position of the 
waveform display, you can do so with Views. Sound Forge has the ability to store up to eight 
views for each data window. Each view stores the selection, cursor position, magnification, and 
position scroll bar placement. A saved view can later be instantly restored. ' 

You can store and recall up to eight different views (1-8) in this manner. There is also a Views 
toolbar you can use (look in the Toolbars folder ofthe Preferences dialog) to set and restore 
views. When using the Views toolbar, all stored views are indicated by an underscore in each 
View button. 

Follow these steps that demonstrate how to use views: 

l. Open the file TUTORI.WAV and select Wow. 

2. To store the curren! view, press Control+ l. 

3. Now, zoom in and make a different selection anywhere yo u wish. Store this new view by 
pressing Control+2 .. 

4. To retum to the first view you stored, press l. Notice that the selection and zoom factor are 
restored. 

5. To go to the second view you created, press 2. 



Drag And Drop Operations 
You can perform a mix, paste, or crossfade by dragging a selection from one data window and dropping it 
on another. 

To drag and drop: 

1. Open two sound files and select Tite Vertical/y from the Window menu just to make them easier to 
work with. One will be called the source window and the other, the destination window. 

2. Press and hold the left mouse button in the selected area of the source data window. While holding 
the mouse button down, move the cursor until it changes toan arrow dragging a little box. 

3. Drag the cursor onto the destination window. You will see a shaded block that represents the range 
of the source material. You will also see that the little box accompanying the cursor now contains 
an M(Mix), C (Crossfade), or P (Paste). Position the block at the place in the destination w~ndow 
where you would like the mix, paste, or crossfade to occur. 

4. Let go of the left mouse button. This will bring up the Mix dialog. To perform a crossfade instead of 
a mix, hold the Control key down while letting go of the mouse button. Holding down the A/t key 
when dropping performs a paste. 

Tip: An easier way to select whether you will perform a mix, paste, or crossfade. is to simply drag the 
block to the destination window and then while holding the left mouse button, click the right mouse button 
to toggle between the Mix, Paste, or Crossfade functions. You will see the block change according to the 
method; a mix willlook like a salid block, a crossfade will look like an X (or perhaps, a butterfiy), and a 
paste will be represented by a segmented vertical line rather than a block. 

As we did in the previous section on mixing, open the two files, TUTOR1.WAV and TUTOR2.WAV. For 
this example, TUTOR1.WAV will be the destination window and TUTOR2.WAV the source window. 

To make the windows easier to view while doing the mix operation you may want to select the Tite 
Vertical/y option from the Window menu. 

Highlight all the data in TUTOR2 by making it the active window and triple-clicking in the waveform 
display. Now drag the selected section by pressing and holding the left mouse button in the data window 
of the TUTOR2 window. Notice that the cursor changes to a pointer with a small box when you begin 
dragging. Drag the block to the beginning TUTOR1 data window and let go of the mouse button to drop 
the section. 

When you let go of the mouse in the TUTOR1 window, you will see a dialog which shows the 
TUTOR2.WAV window as the source and TUTOR1.WAV as the destination. Leave the levels atO dB, 
and select OK. You will see that again the drum hit sound has been mixed into the TUTOR1 window. 
Press the Play button to hear the results. 

Drag and Drop Crossfading 
Undo the last operation. Now select all of TUTOR2 and drag it toward the end of TUTOR1. Press and 
hold the Control key, yo u will see the crossfade block and by moving the block back and forth horizontally 
across the end of TUTOR1, you can adjust the crossfade time and see the crossfade expand and 
contrae! over the end of the destination file. Once you have determined where you would like the 
crossfade to begin, let go of the mouse button. This takes you to the Crossfade dialog. Select the Normal 
crossfade preset from the preset list at the top of the dialog and press OK. You should hear the end of 
TUTOR1 fade out as the beginning of TUTOR2 fades in. 

Drag and Drop Pasting 
Again, undo the last operation. Select all of TUTOR2 and drag it over to TUTOR1. Hold the Alt key down 
while you position the paste point at the beginning of TUTOR1. Now, let go of the mouse button. lf 



everything was done correctly, you should have pasted the data from TUTOR2 at the insert position in 
TUTOR1. . 

Creating a New Window with Drag and Drop 
A very useful feature of drag and drop is the ability to quickly create a new window from a selection. 
Make a selection in a data window and drop it on an empty area of the Sound Forge workspace. A new 
data window is automatically created containing the data from the selection. 

Snap to Event in Drag and Drop Operations 
Another useful feature of drag and drop is the ability to snap to markers, regions, time increments and 
other events in the destination window. All of the drag and drop operations mentioned above will snap (or 
gravitate) to points in the destination file depending on what events have been established in the file. 

The following list shows possible Snap to points in the destination file. 

Cursor 

Selection 

Start 

End 

Markers 

Start of block snaps to cursor position 

Start of block snaps to start or end points of a selection 

Start of block snaps to start of file 

Start of block snaps to end of file 

Start of block snaps to marker 

Regions Start and End Markers Start of block snaps to region start or end 

Time, Measures, Etc. Start of block snaps to labeled divisions on Time Ruler 

Video Frames Start of block snaps to the start of video trames appearing in the video strip 



Advanced Mixing options 

In the Mix dialog, there are severa! options you can use to perform complex mixes. For example, 
when mixing vocals over music, you can have the music fade out and then fade back in when the 
vocal part is mixed. This is sometimes referred to as ducking. Follow these steps to perform 
voice-over ducking: · 

l. Open the file TIJTORl.WAV and select the word Wow. 

2. Drag the Wow selection toan open area in the Sound Forge workspace to create a new data 
window. 

3. In the Summary dialog within Properties (File menu), name this sound file Wow in the T1tle 
field and press OK. 

4. Now, open the file TUTMUSIC.WAV. This file contains a short music clip to which we will 
mix the Wow sound. 

5. Place the cursor in TUTMUSIC at about two seconds from the start ofthe file. 

6. Select all ofWow and drag and drop it to the TUTMUSIC window. 

7. In the Mix dialog, select the Slow duck preset. No ti ce that the Destination Volume is set to -6 
dB and the times in the Pre/Post-fade destination edges are set to 0.5 seconds. This means that 
before and after the mix, the music will be faded to -6 over 0.5 seconds. Press OK. 

8. Listen to the file, then undo the operation. 

9. Once agam, drag Wow to TUTMUSIC and sel"éct the Slow duck preset. This time, set the 
Destination Volume to -20 dB and press OK. The music will now fade out even lower. Both the 
so urce and destination volumes can be used to get the right mix of voice and music. The 
Pre/Post-fade destination edges control how fast the destination sound is faded out and back in. 



Editing Stereo Files 
When editing stereo files you have two channels of data on which to work. The upper channel is the left 
channel and the lower channel is the right channel. We will refer to them in both ways left (upper), and 
right (lower). 

Selecting Data in Stereo Files 
When selecting data in stereo files, Sound Forge allows you to select either the left channel, right channel 
or both channels for playing, editing, and effects processing. 

When editing a stereo file, the waveform display showing the two channels is split into three logical 
sections for selection with the mouse. The upper quarter of the wavefonm display is the left channel hit 
section, the lower quarter is the right channel hit section, and the middle hall selects both channels. 
When selecting data with the mouse, the cursor location detenmines what channel(s) will be selected. 

Open the file TUTOR1.WAV and convert it to stereo by editing the Formal under Properties in the File 
menu or by right-clicking on the Channels playbar field and selecting Stereo. Set the Channels to Stereo 
and press OK. Select f!oth Channels for the destination in the Mono to Stereo dialog. You should now 
have a stereo version of TUTOR1.WAV. 

Move the mouse pointer near the top of the left channel and select the word "Wow." Notice the change to 
the left channel selection cursor, and that only the left channel of the data becomes highlighted. Now do 
the same thing but in.the middle hall of the window near the top of the right channel and the bottorñ of the 
left channel. This time you should see both channels being selected. Do this one more time near the 
bottom of the waveform display and you should see only the right channel being selected. 

I Cursor whén selecting both channels of a sfereo file or when in a mono file. 
,, 

Cursor when selecting the left channel of a stereo file. 

IR Cursor when selecting the right channel of a stereo file. 

+-+ Cursor when extending a selection. 

Toggling Channel Selections 
Once you have made a selection in a stereo file you can switch between channel selections by pressing 
the Tab key. The Tab key will cycle between selections of Left Channel, Right Channel, and 8oth 
Channels. You can also set the channel selection by using the Channel drop-down list in the Set Selection 
dialog. 

Previewing Channels 
Selecting a single channel allows you to hear a preview of a single channel in the stereo file. For example 
double-click (triple-click if it contains regions or markers) in the TUTOR1 window to select all the data (or 
use Select Allfrom the Edit menu). Press the Play button and listen to the clip. Next press the Tab key to 
toggle the channel selection into a Single channel and press the Play button again. Do this one more time 
to hear the other channel. 

Single Channel Editing 
Stereo data files are tied together by the nature of their fonmat. In other words, they always play together. 
This means that there are sorne edit operations, such as Cut and Paste, which you can't use on a single 
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channel. lt would leave one channel shorter or longer !han !he other. This is usually not a problem in real 
world editing situations. To shift a single channel in time by small amounts, you can use the De/ay/Echo 
function. 

You can copy a selection from a single channel to the clipboard by selecting the data in either !he left or 
right channel and using the Copy command. This will place a mono clip on the clipboard. You can then 
paste the mono clip to a mono file, both channels of a stereo file, or you can mix it into a single channel or 
both channels of a stereo file. When mixing mono clipboard data to a stereo file you will be asked with a 
dialog whether you wish to mixto a single channel or both channels. 



Opening an .A VI File 

To open an .A VI file, choose Open from the File menu and select Video for Wmdows (*.a vi) 
from the Files of type list. Then, double-click on the file you wish to open. If the .A VI file being 
opened in Sound Forge contains exactly one video stream and one audio stream, it will open 
these streams automatically. However, ifno audio is presentan audio stream will be created 
containing only silence for the entire length ofthe video. 

Handling Multiple Streams 

.A VI files can contain more than one video or audio stream. A stream is not the same as a track 
in a multi-track video or audio editor. Multiple streams are most commonly used to contain 
different versions of a video or audio track. For example, you could have an .A VI file with one 
video stream and multiple audio streams in different languages. An .A VI player, such as 
Microsoft's Media Player, can detect which language version ofWindows your computer is 
usmg and automatically play the corree! audio stream for that language. 

If more than one stream exists you ha ve the option of choosing which one will be opened in 
Sound Forge. This is done in the Video Stream dialog. In this dialog, you must selecta video and 
aud10 stream to open by using the Stream Selectors (black diamonds) to the left of each stream. 
Once you've selected one of each, press OK. 

Attaching a Video to a Sound File 

To attach a video toan opened sound file, select Properties from the File Menu and go to the 
Video folder. Pressing the Attach button will take you to the Attach Video dialog, where you can 
select an .A VI file to attach a video from. Press OK after selecting an .A VI with a video stream. 

The Video Properties will now display the audio and video streams in the .A VI. An .A VI file can 
contain multiple streams, but in most cases you'll have one audio stream and one video stream. 

The square checkbox to the left of each stream indicates which streams will be stored when yo u 
go to save your file. The black diamond next to it is the Stream Selector, which indicates which 
streams are currently being used in Sound Forge. 

Press OK again and you should now see the video strip above !he waveform display. Once you're 
done editing, yo u must save the file as an .A VI if you want to store the video. 

Saving an .A VI file 

To save an opened file in the .A VI file forma!, follow these steps: 

l. In the Save or Save As dialog, select Video for Windows (.avi). After naming the file, etc .. , 
press Save. 

2. The Video Save Options dialog appears next. In here, you can select which streams to store in 
the .A VI file by checking the square checkbox to the left of each stream. In this dialog, it is also 
possible to edit the ti !les of the streams. 

3. Pressing OK will take you to the Compression Options dialog. Here, you can select a 
compression scheme for each audio and video stream. To change the options for a stream, select 
it and press !he Options button. By checking the Interleave every _ Frames opt10n, you can 
specifY how frequently the audio chunks are interwoven with the video. 

4. If yo u pressed the Options button, yet another dialog, Video Compression, let's yo u se lec! 
from different compression algorithms, and even go to another dialog to set specific compression 



configuration parameters. For more information on compression, see the next section. Selecting 
No Recompression saves the stream in its original formal, which is the Sound Forge default. 

5. Once you're done setting compression options, hitting OK severa! times will complete the 
process. Ifthe video is long and/or the compression scheme selected is slow, saving the file 
might take a while. However, if you didn't change any video compression formats, the save will 
be much faster, since no recompression takes place . 

. A VI Video Compression 

lf you thought audio files chewed up your hard-disk space quickly, wait until you start using 
video! CD quality audio takes up about 1OMB ofhard-drive space per minute: 
(60 seconds x 44,100 samples per second x 2 tracks for stereo x 2 bytes per 16-bit sample). On 

the other hand, a typical video for multimedia use will easi1y contain about 200MB per minute, 
and this for a small window ofvideo: 
(60 seconds x 15 frames per second x 320 x 240 x 3 bytes for 24 bit pixels). 
Using uncompressed video as a final distribution formal is out of the question for most practica! 
purposes. Video compression is a necessary evil. 



Mono to Stereo and Stereo to Mono Conversions 
For demonstration purposes, open the file TUTOR1.WAV located in the directory where Sound Forge 4.0 
was installed (in most cases this will be C:\Forge40). To convert the file from mono to stereo, right-click 
on· the status field which has the word Mono and select Stereo from the shortcut menu. 

When you do conversions from mono to stereo, you will be presented with a dialog which asks you where 
you want to put the data. Your choices are as follows: 

Left Channel 

Right Channel · 

Both Channels 

The mono data is placed in the left channel. The right channel is set to silence. 

The mono data is placed in the right channel. The left channel is set to silence. 

The mono data is copied into both channels. 

When performing stereo to mono conversions, the following options are available: 

Left Channel 

Right Channel 

Mix Channels 

Mono data is taken only from the left channel of the stereo file. 

Mono data is taken only from the right channel of the stereo file. 

Mono data is created by mixing both channels of the stereo file. 

For now let's put the data in the left channel so we can get a feel for how the function works. Click the 
radio button next to Left Channel and select the OK button. 

You will now have data in the upper half of the data window (the left channel) and silence in the right 
channel. Press the Play button and you will hear 'Wow, sound editing just gets easier and easier" in only 
the left channel. 

lf your card supports only mono data you w1ll sbll be able lo play slereo files if you set 
your playback device to Sound Mapper in the Wave section of Preferences in the 

Options menu. · 

For now let's go back toa mono sound file, but we'll do it in a different manner. Select the option 
Properties in the shortcut menu that appears when you right-click on the waveform display. In the 
Properties dialog select the Format tab. This page allows you to change all the parameters at once. Set 
the radio button for Channels to Mono and select the OK button. Select the Lefl Channel for the source 
channel in the Stereo to Mono dialog and we're back where we started. 

ltle above steps were used for demonstrabon purposes. S1mply us1ng U nao woula· have ¡ 
1 been much more efficient. 1 

Channel Converter 
The Channel Con verter (Process menu) is also u sed to convert between mono and stereo formats. lt 
allows independent leve! settings for each channel and can be used to inter-mix the left and right 
channels of a stereo file to create interesting pan effects. For simple conversions, use the included 
presets. See Channel Converter later in this manual in the Process menu section of the Reference 
chapter for more detailed infonmation. 



Converting 16-bit samples to S-bit samples 

To save storage space, 16-bit sound files are often converted to 8-bit files. However, when you 
represen! a sound file with only 8-bits, an audible distortion referred to as quantization error 
becomes very prominent. To minimize quantization error, there are severa! things you can doto 
the 16-bit sound file before converting it to 8-bit. You can: 

Apply a Noise Gate (Effects menu) to completely mute out the silent parts in a sound file. Often, 
a low leve! signa! in a 16-bit sound file will become noise after the 16- to 8-bit conversion, so it's 
best to have complete silence between the sound parts. 
Apply dynamics compression (select DynamicsiMulti-Band in the Effects menu) to the sound 
file. A small amount of compression (2: 1 or less the presets are usually sufficient) willlower the 
dynamic range of a sound, making it easier to represen! using 8-bit samples. 

Normalize (Process menu) the sound toO dB (peak). This ensures that the entire dynamic range 
available in 8-bit samples is used and lowers the signa! to noise ratio. 

You can apply both dynamic compression and normalization at once by using the Normahze 
function with theAverage RMS power option. Set Apply dynamic compression in the If clipping 
occurs drop-down list. 

Once you ha ve performed the above operations, you should use Convert to 8-Bit in the Process 
menu to do the 16 to 8-bit conversion. Sound Forge provides three different 16 to 8-bit 
conversion options; Truncate, Round, and Dither. Truncate simply removes the lower 8 bits and 
they are lost forever. Round is similar to Truncate, only sorne attempt is made to represent·the 
highest of the low bits by rounding up if possible. Dithering is ·used to mask the quantization 
noise with less obtrusive noise. In the Convert to 8-Bit dialog, set the Dither bit depth to a low 
value (like 0.1) and increase the value slowly until you reach an acceptable sound. 

Remember, an 8-bit sound file will always sound noisier than a 16-bit sound file, so whenever 
possible, stick with 16-bit. When trying to save space, it is possible to get better results from 
lowenng the sample rate (see Resample under the Process menu covered in the Reference 
chapter) instead of using 8-bit samples. 

Converting Files 

When producmg audio files you may find that you need to provide the file to a client in a variety 
of formats. This could be . W A V files with data formats such as 8-bit mono, 16-bit stereo, or · 
even ADPCM. You may need the files converted to Raw data, .VOC, or sorne other PC format. 
You may even need to convert toa different platform like Macintosh .AIF files or Amiga .SVX. 

We ha ve seen in the previous sections that you can quickly convert between mono/stereo, 8/16-
bit, and change the sample rate in Sound Forge. You can then use the Save As command to save 
the file.to a new name, or you can save in a new format within the Save As dialog. 

Ifyou don't have TUTORI.WAV open, open it up now. Select the Save As command from the 
File menu and the dialog for saving will be displayed. 

When the Save As dialog is displayed, there are three controls that are used for file conversion; 
the S ave as type, Format, and Attributes. The Save as type is the list of all available output file 
types. The Format field sets the format of the data which is saved in the file. The Attributes field 
controls sample size, sample rate, and the number of channels. 

When you bring up the Save As dialog, the Save as type will be set to the type from which the 
file was opened. The default for new files is Microsoft Wave (.W AV). You can change to the 
type of file yo u want to save by selecting the new type from the Save as type list. Notice that the 
extension ofthe file name will be changed to reflect the type offile you are saving. 



The Formal drop-down list shows the formal ofthe data which will be saved in the file. Usually 
this will be PCM which is the standard for most file types. PCM (Pulse Code Modulation) is a 
standard format for normal uncompressed audio. If you are saving a file to a file type which 
supports other formats, they are displayed in the drop-down list. Other formats are typically used 
when saving audio data in a compressed form. 

The Attributes drop-down list shows the sample size, channels, and sample rate which will be 
stored when saving this file. Examples include: 11,025 Hz, 8-bit Mono or 44,100 Hz 16-bit 
stereo. You can quickly change the attributes ofthe data by selecting one ofthe options available 
in the drop-down list. When you change from a mono file to a stereo file using !he Attributes 
field, that data is copied to both channels. Ifyou change a stereo file toa mono file, the data is 
m1xed to one channel. 

When you change the Save as type you may notice that the Format and Attributes fields will also 
change. This is beca use not all file types support the same types of sound data. For example the 
Dialogic .VOX formal only supports 16-bit mono Dialogic ADPCM files. This means you can't 
store stereo 8-bit data in this file. Don't worry, in most cases Sound Forge automatically converts 
any file you save to an acceptable fonnat. 

Microsoft .WAV and .A VI files allow you to store over 30 text fields including: Creation Date, 
Copyright, Keywords, and a variety of other informational text data. Sound F orge supports 
viewing and editing any of these fields. 

Summary Information 

When editing . W A V and .A VI files, the Summary tab is available in the Properties section of the: 
File menu. This allows you to view and/or change basic summary information currently stored in·. 
~~- . . 

Extended Summary Information 

The Extended Summary dialog consists of a list of available fields, each of which may or may ,, 
not have attached text. The Fields list shows the abbreviation ofthe field type, a short 
description, and ifthe field is currently empty, the word (Empty) appears after the short 
description. Below the list of fields is the Contents which shows the contents of that field. At the 
bottom of the dialog is a longer descnption of the curren! fiel d. 

To the left of each field in the list is a check box which is used to enable or disable fields ofthis 
type when saving .W AV and .A VI files. The field is enabled or disabled by clicking on the check 
box. If a field is empty, i.e. has no text associated, enabhng the check box has no effect on a 
saved file. Field information is only saved if text informat10n exists for that field. 

The S ave Summary Infonnation m . W A V /.A VI files check box in the S ave As dialog is used to 
quickly enable/disable saving of all summary fields toa file during a Save As operation. This 
allows you to quickly strip all summary informatwn from a file. 

For a description of the fields available refer to the Properties within the File menu section in the 
Reference chapter later in the manual. 

Default 

If the Default button is selected, the text in the summary fields is saved with the defaults fields 
that are automatically filled when creating a new .W AV file. The Creation date field (ICRD) is 
always filled with the curren! date for new files. Saving a custom default setup is handy for 
saving copyright and engineer information for new files created at your site. 

Open the file TUTORI.WAV and select the Summary tab from Properties in the File menu. This 
will show you the Summary dialog. Press the Extended button and notice that the default for 
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saving sumrnary in:formation is to have all fields enabled. The fields which have already been 
filled in for TUTOR!. W A V are Comments, Copyright, Creation Date, Engineer, Keywords, 
Nameffitle, Product, Subject, Software, and Source. Scroll to and select each field. You will see 
the embedded text for each of these fields. 

Additional Embedded Information 

The Microsoft .W AV and .A VI file formats allows non-text data to be embedded in the sound 
file. If yo u open and edit a file which has additional information created by other software, 
Sound Forge will keep track ofthis data and place it back in the file when you save to the 
original format. 

Ifyou wish to add or remove additional data (such as embedded bitrnaps, metafiles, etc.), you 
can use the Save As item from the File menu. When you save data using the Save As option, 
Sound Forge will ask you ifyou wish to copy the additional non-audio information to the new 
file. At this pomt you can answer either Y es to place the additional information in the new file or 
No to save only audio data and any additional data types you have selected. 

Sound F orge will only prompt you to save if such data exists. 



Recording basics Video tutorial 

To start a record session you can either select Transport then Record from the Special menu or press the 
Record button on the Transport toolbar. The Record button is the first button on the Transport toolbar 
with the red circle on it. 

After pressing the Record button or selecting TransportiRecord from the Special menu, you will be 
presentad with the Record dialog. Nolice that the window into which you will be recording has its tille 
displayed in the dialog tille. 

¡warn;ñQ:The Recoid and Recoid Remate dralogs are always destruclrve and contain no 1 
1 Undo capabilities. J 

To preven! accidentally recording over sound data, record into a new or scratch data window and paste 
the takes you want to keep into the desired sound data window. For extra safety Sound Forge 
automatically defaults to record in a new window when the curren! sound file is opened in direct edil 
mode. 

In the upper left corner of the dialogare the Recording attributes. These are the record sample rate, 
sample size, and number of channels which will be used when recording. These attributes are applied to 
the data window into which you will be recording. lf you want to change these attributes, exit the Record 
dialog and change them in the data window, record lo a new window, or record to another window. 

Recording to a -New Window 
lf you want lo record toa new window rather !han the currenlly selected record window, select the New 
button found at the upper right of the Record dialog. This brings up the New Window dialog where you 
can specify the Samp/e rate, Samp/e size, and Channels for the new data window. These attributes will 
be applied while recording. 

Selecting an Alternate Record Window 
lf you wish to record toa window other than the one currently displayed in the Record dialog tille, you can 
do so by selecting the Window button. Pick the window you want to record to from the drop-down list in 
the Record Window dialog and select OK. The tille of the window you select will now appear in the Record 
dialog tille. 
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Recording Modes 

Sound Forge has four different modes ofrecording. These are Automatic Retake, Multiple Takes 
with Regions, Multiple Takes (no Regions) and Punch In. Each mode is described below. 

Automatic Retake 

The Automatic Retake mode is the easiest method ofrecording. Recording starts at the position 
shown in the Start field when you select the Record button and continues until you select the 
Stop button. Any data whtch is currently after the position in the Start field will be replaced. 
When recording is stopped, the start position is reset to the beginning ofthe take allowing an 
immediate review and retake if desired. 

Automatic Retake is the default mode when recording into an empty Data Window or when you 
select the record button with no data selected in the curren! Data Window. 

Multiple Takes with Regions 

The Multiple Takes with Regions mode allows multiple takes to be recorded and each take with 
automatically have a Region defined in the Regions List. Recording starts at the position shown 
in the Start field when you select the Record button and continues until you select the Stop 
button. Any data which is currently after the position in the Start field will be replaced. When 
recording is stopped, the start position remains at the end of the next take allowing the take to be 
recorded immediately. 

Multiple Takes (no Regions) 

The Multiple Takes (no Regwns) mode allows multiple takes to be recorded, but no Regions are 
defined in the Regions List. Recordmg starts at the position shown in the Start field when you 
select the Record button and continues until you select the Stop button. Any data which is 
currently after the position in the Start field will be replaced. When recording is stopped, the start 
position remains at the end of the take allowing the next take to be recorded tmmediately. 

Punch In 

Punch In mode is used when you want to record o ver a region of data in an existing Data 
Window. Recording starts at the position shown in the Start field when you select the Record 
button and continues until you select the Stop button, or the length ofthe data recorded is equal 
to the length in the Length field. This makes 11 easy to record over a section of audio without 
effecting the rest ofthe file. You can use the Play button to hear the selected Punch In region at 
any time. 

You may adjust the Punch In region by changing the values in the Start, End, or Length edit 
fields. You mayal so adjust the formal of these fields to a vanety of different display status 
formats by selecting a formal from the Input formal drop down lis! box. 

Punch In mode is the default mode when you select the Record option while you have a region of 
data selected in the curren! Data Window. 

Using Pre/Post-Roll with Punch In Mode 

At the bottom of the Record dialog are two edil fields whtch contain the Pre-Roll and Post-Roll 
times. These can be used when listening toa region in Punch In mode. These times define the 
amount of audio you will hear prior to (Pre-Roll), and after (Post-Roll), the selected region when 
using the Play button. This allows you to hear !he transitwns between the Punch In region and 
sound before and after the region. If yo u wish to use the Pre/Post-Roll option you mus! check the 
Review check box at !he bottom of the dialog. To disable Pre/Post-Roll uncheck this box. 



Using the Prepare Button 

The Prepare button is used when you need Sound Forge to begin recording as soon as possible 
after selecting the Record button. The Prepare button opens the wave device and loads all 
recording buffers in order to minimize the time between selecting the Record button and sound 
actually beginning to be recorded. 

The Prepare button is optional. It is not necessary to select this button prior to recording, 
however it does allow for more accurate takes in the Punch In mode. 

Recording Status 

While you are re.cording, the amount oftime recorded will increase and the Time left on drive 
will decrease. Make sure and keep an eye on your Time left on drive if your available record 
time is limited. It's never fun running out of recording time! 

Available Recording Time 

Near the bottom of the dialog you will see the Time recorded and Time left on drive fields. 
These two boxes show how much time you have recorded and how much time is available on 
your hard drive for additional recording. lf your Time left on drive field is displaying a limited 
amount of available time you may want to free up sorne space on your hard drive or pick an 
altemate drive where Sound Forge stores its temporary files. You can get more information on 
temporary file usage by referring to the Reference chapter on Temporary Storage. 

Finishing Recording 

When you ha ve finished recording select the Close button to exit the Record dialog and retum to 
normal editing mode. 

Previewing Recorded Sounds 

After recording your material, you can listen to what you have recorded by selecting the Play 
button. You can also listen to the section over which you planto record in Punch In mode. To 
stop playing select the Stop button at any time. 

Record Meters 

Like the Sound Forge Play Meters, the Record Meters can be scaled to view differing dynamic 
ranges by right-clicking on the meters and selecting the appropriate range from the shortcut 
menu. For most recording situations it is probably best to select -42 -toO dB, as this is the most 
practica! range to view a good record signa!. To view very low levels, select -90 toO dB. This is 
a good way to measure the amount of noise yo u ha ve in your system due to noisy sound sources 
and/or poor equipment (such asan inexpensive sound card). 

Also in this shortcut menu, you can set the meters to Hold Peaks and Hold Valleys. It is 
recommended that Hold Peaks be checked, as this is a good way to view the peak levels while 
setting the record leve! (see below). To reset the curren! peak, single-click on the meter's text 
output (just above the meters). 

For Windows 95 and NT 4.0 keyboard shortcut lovers, the Play Meter shortcut menu can be 
reached by thekeyboard shortcut Alt+Spacebar. 

Checking Record Levels 

Sound Forge allows yo u to check the leve! of your input so urce before recording begins. To view 
your levels engage the Monitor check box. The meters willlight up in relation to the leve! of the 
incoming signa!. For best results, the leve! should be somewhere in the yellow range with an 



occasional red. Once your levels are checked you can imrnediately begin recording by selecting 
the Record button. If you do not see the meters light up, you may ha ve your mixer levels or input 
source set incorrectly. You can refer to the Troubleshooting chapter for more information on 
these problems. 

Adjustmg Levels Using the Peak 

The peak values displayed above the leve] meters are useful for maximizing your input leve] 
without clipping. Wben recording you generally want your input signa] to be as hot as possible 
without clipping. By this we mean you want your input levels to be as high as possible without 
exceeding the range ofvalues which can be stored digitally when recording. When you clip, the 
peaks of your waveform become clipped off resulting in distortion. The peak values show you 
(in decibels) the highest peak that you have reached since hitting the Monitor button. 

To adjust your levels, select the Monitor check box so that Sound Forge begins to listen to your 
recording· device. This is just like recording except that Sound Forge doesn't store any ofthe data 
it receives. Apply an input signa! by speaking into your microphone, playing your CD, or 
whatever it is you're trying to record. lfthe peak value stays ata low value, increase the levels of 
sound you are supplying so that the peak value is somewhere in the -6 dB range. If the peak 
reaches O dB then you have clipped and will see the word Clip above each meter. Once you 
lower your input levels, right-click on the meters and select Reset Clip to clear the current peak 
value. Sound Forge always keeps the maximum peak displayed above the meters or via Hold 
Peaks. 

Once you have adjusted your levels you can imrnediately begin recording by selecting the . 
Record button or end monitoring the levels by un-checking Monitor below the meters. 

lt is particular! y importan! to record sounds with the hottest levels possible when you planto 
later convert 16-bitdata to 8-bit. This assures that you will use the greatest dynamic range · 
possible m an 8-bit file (which uses fewervalues to represen! the waveform). 
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Applying Simple Processes and Effects 

To apply an effect, frrst selecta section of data on which you wish to operate. To select the entire 
file, double-click (triple-click ifregions or markers are present) on the waveform display. 

Ifyou don'! have a selection when you perform an effect which requires one, Sound Forge will 
apply the effect to theentire file. 

To show how effects are used we will once again be using the TUTORI.W AV file. If it's not 
currently open, please open the file now. 

Select the Reverse item from the Process menu. The Reverse operation reverses the data 
selection, making it sound like it's playing backwards. Once the operation has finished, press the 
Play button to hear how TUTOR! sounds when played backwards. 

Applying an Effcct to a Section of the Sound File 

Select the Un do Reverse item from the Edit menu to put TUTOR 1 back to its original state. Now 
select only the word "Wow" in the window and again select the Reverse item iri the Process 
menu. Play the file again and notice how only the word "Wow" is played backwards. After you 
have listened to the effect, undo the reverse again so we can try another effect. 

Again, let's select only the word "Wow" in the TUTOR! window. This time after selecting the 
data, select the Volume item in the Process menu. Use the scale factor fader to set the scaling to-
6 dB (50%). Clicking on the.fader and using the up/down arrows will give you more precision. 
Now select OK. Ifyou press Play you will notice that the volume is now at 1/2 ofits original 
volume. You can undo the last operation by selecting Undo from the Edit menu. 

The previous two examples show you how easy it is to apply effects to files. Sound Forge has a 
large number of different processes and effects, rangmg from simple volume changes to complex 
multi-tap reverb/delays. To leam about a particular effect, please refer to thé Effects, Process, or 
Tools menus wlrich are covered in the Sound Forge Reference chapter. 

Applying Effects to Stereo Files 

In a stereo file, only the selected region in the channel wh1ch you've selected is processed. Most 
functwns can be applied to the left, right, or both channels. The only fimctions which cannot be 
applied to separa te left and right channels are fimctwns which affect the length of the data, sin ce 
each track in a stereo file must be of the same length. These include Insert Silence, Resample, 
Time Compress/Expand, Gapper/Snipper, Pitch Bend, and Pitch Shift (without preserving 
duration). 

Ifyou need to runa process like lnsert Silence in only one channel, you should divide the stereo 
file into two mono files first, insert the silence, and then jo in them back together into a stereo 
file. Separating stereo files into two mono files is a good id~a ifyou are going to be changing the 
duration of each trae k by cuttmg or inserting space to synchronize different events. 

Applying a Function to a Single Channel in a Stereo File 

Prevwusly, we reversed TUTOR! so that we could hear how the data sounded when played 
backwards. Now let's try this on a single channel ofa stereo file. First convert TUTOR! to stereo 
by right-clicking on the status field which has the word Mono and select Stereo from the shortcut 
menu as we did in a previous section. Make sure to select the Both Channels option in the dialog 
so we ha ve data in both channels of the new stereo file. 

Select the entire left channel by triple-clicking with the mouse in the upper 1/4 ofthe TUTOR! 
waveform display. If yo u se!ect both channels, just use the Tab key to toggle the selection to 
only one channel. Now select the Reverse item from the Process menu. You will notice that only 
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the left channel data is reversed. Press the Go to Start button on the playbar to clear the selection 
and place the cursor at the start of the file. Press the Play button and you will hear "Wow, Sound 
editing is easy" backwards in the left channel and forward in the right channel. If yo u only hear 
one channel then you are in single channel preview mode. To hear both channels use the Tab key 
to toggle the cursor or selection to encompass both channels and again press the Play button. 

Ifyou want more information on how to use a function, press the Fl function key while selecting 
the function title inthe menus. Also, you can press the Fl function key or the Help button in all 
function dialog. 

Envelope Graph 

Envelope graphs are used to draw the shape of a frequency or amplitude envelope that will be 
applied. The horizontal axis represents time, with the left-most point specifying the start of the 
selection and the right-most point specifying the end of the selection. The vertical axis represents 
either amplitude or frequency, 

· To create a new knob on the graph, left-click anywhere on the line connecting the envelope 
points and drag the knob in any direction, sor! of like pulling a rubber band. 

· You can delete a knob by double-clicking or right-clicking within it. 

· To reset the graph (delete all knobs) click on the Reset button. 

Moving Multiple Envelope Points 

It's possible to select and move more than one envelope point at once. Just try: 

l. Clicking on an unused section of the Envelope Graph. 

2. While holding the mouse button down, drag the mouse. A dotted-line selection square will 
appear. 

3. Move the mouse to surround the needed points with the selection square. 

4. Release the mouse button. The selected points will now be colored red. 

5. To m ove all of the selected points, drag any one of the points. 

You can also select all points by pressing Control+ A when the Envelope Graph is active. 

Displaying the Waveform on an Envelope Graph 

Sorne envelope graphs (such as in the FadeiGraphic or the PitchiBend dialogs) allow you to view 
the waveform ofthe selected data region on the graph. Ifthe selection is small, the waveform is 
automatically displayed. Otherwise, you must press the Show wave check box. Ifyou have a 
stereo file, you can choose between displaying the Left channel only, Right channel only, or Mix 
channels in the drop-down list. 

... 



Vertical Fader and Horizontal Trackbars 
In the FM Synthesis dialog, the Amplitude is controlled by a fader and the Feedback is controlled by a 
trackbar. 

,,,,.1 ''~""" 
There is nothing complicated about these controls. To change the parameter values, jusi left-click and 
hold on top of the trackbar thumb and drag left and right or up and down. 

1 Yo u can fine tune a control's val u e by hold1ng down bolh !he lefl and nght mouse bullons' 
¡ al the same time (or holding down Control on the keyboard) 1 

There are many keyboard shortcuts when using faders and trackbars. You can use the Up, Down, Left 
and Right arrow keys lo change the value in small increments or the Page Up and Page Down keys lo 
change the value in larger increments. The Home and End keys change the parameter value lo its 
maximum or minimum. 

lf you double-click on a fader or trackbar thumb, it returns lo its reset value (usually 0%, 50%, or 1 00%). 
Left-clicking on the hash marks in a fader also changes the value by very small increments. 

.-
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Edit Box Spinner Control 

~ 
~ Synthesis dialog the Total output waveform length and Frequency parameters are modified 
with edil box spinner controls. The edil box is the box containing text, while the spinner is the small 
control to the right. With this type of control, you have several options for changing a parameter value. 
You can: 

Type in the number by left-clicking on the edil box and then typing. in the value. 

lncrement the value by clicking on the two small up/dowri buttons. 

Use the spinner to change the value. This is done by left-clicking on the center button (between the two 
up/down buttons) and dragging the mouse up or down. Again, holding down both the left and right 
mouse buttons at the same time will cause the values to increment in finer steps. You can also use the 
Up/Down arrows and Page Up!Page Down keys to alter the value. 

Adjust the spinner while holding down both mouse buttons to see the finer increment resolution (or hold 
down the Control key). 



Simple Delay 

Simple Delay!Echo creates copies of the original sound which are then mixed with the sound file 
to create simple echo effects. · 

Open TUTORI.WAV and select Simple from Delay!Echo in the Effects menu. Choose the Slap­
back echo preset and select Preview. A single copy ofthe sound is heard 0.4 seconds after the 
original. Changing the Delay time determines the time between the original and echoed sound. 

Now, select the Grand Canyon preset. Notice that the Multiple delays/echoes check box is 
marked. This means that instead ofjust one echo, you will hear multiple decaying echoes ofthe 
original sound. The Decay time determines how long it takes for these echoes to fade out. 

The Pre-delay/echo function creates echoes heard before the original sound. Use this effect while 
the spaceship in your next sci-fi flick travels back in time by means of a wormhole. 

Multi-Tap Delay 

The Multi-Tap Delay function allows you to specify up to eight delay-taps spaced anywhere 
within 2.5 seconds (0.5 seconds in 16-bit Sound Forge) ofthe original sound. 

Open the file TUTORI.W AV and select Multi-Tap from Delay/Echo in the Effects menu. 

Now, select Tapped delay, stereo pan from the end ofthe preset list. To hear the effect, select 
Prev1ew. Selecting Bypass allows you to listen to the unprocessed file. Listen to how echoes 
bounce between left and right channels. · 

This preset uses all eight delay taps. To switch between taps, use the Curren! Tap function. There 
is a delay time and an amplitude associated with each delay tap which determine when and how 
loud the delay tap is heard after the original sound. In stereo files, each tap can also be panned 
left or right, to simulate sound coming from all directions. 

The selected tap is represented as a red verticalline on the echogram. The echogram represents 
an approximation of the impulse response of the current settings and can be used to estima te the 
decay time. Blue lines correspond to other active taps and black lines are feedback echoes. 

The horizontal axis ofthe echogram is time, with the right-most point equal to the Graph 
resolution scale setting. The vertical axis represents the amplitude ofthe echo. You can change 
the scale factor between 500; 1,000, or 5,000 milliseconds for viewing the impulse response over 
different time ranges. 

By changing the Feedback, you can change the decay time ofthe delay. 

If you set the Feedback too high, the echoes keep adding up until they are clipped (use the 5000 
ms Graphresolution setting). Too much feedback also crea tes unnatural ringing of sorne 
frequencies. 

Select the Default all parameters preset. Here, there is only one tap active, with no feedback. 
This corresponds toa simple delay. Set the Dry out to zero and tum on the Low-pass start 
frequency. Low-pass filtering removes high frequencies, in the same way that many building 
materials absorb high-frequency sounds. Adding modulation creates slight pitch changes, which 
can make a delay sound fuller. 

Now, switch to the Chorus-reverse verb l. Here, the delay taps increase in magnitude over time, 
thereby creating a swelling effect. Many other sound effects are possible ifyou experimenta 
httle with tap arrangements. 

Noise Gate 



When recording a sound, there is often an audible noise !loor during silent breaks. Noise is 
generated by many different things, including electrical equipment, machinery, and traffic 
outside your window. When your sound source is much louder than this background noise, it is 
simple to remove the noise during silent breaks, where the noise is most noticeable, with a noise 
gate. 

For example, open TIITORI.WAV. Move the cursor toa location between Wow and Sound and 
select Insert Silence (Process menu). Specify 1 second of silence to be inserted at the cursor. 
Next, create a new file. In the new file, use Synthesis!Simple (Tools menu) to generate four 
seconds of noise at -60 dB amplitude (keep the frequency around 2,000 Hz). Next, copy all of the 
noise on to the clipboard and mix it to the beginning ofTIITORI. Use 100% for the noise 
(Source) and 100% for the voice (Destination). You should now ha ve a file with voice and a 
re1ative1y 1ow hissing sound in the background. 

To remove the noise during silent breaks, first you should analyze the amplitude ofthe noise. In 
TIITOR1, selecta region with only noise (no voice), and run the Statistics function under the 
Tools menu. Take note ofthe Maximurn samp1e value percentage. Ifyou followed the preceding 
steps, it should be close to -60 dB. 

Next, select Noise Gate from the Effects menu. 

In the Noise Gate dialog, select the Noise gate 1 preset. Slide the threshold leve! to a btt over the 
Maximum sample value (in percentage). A value of -50 dB should be high enough to 
differentiate the noise from the vocals. Press OK. Notice that the noise during the silent regions 
should ha ve disappeared (total attenuation). lf it didn't, try raising the Threshold leve! until it 
does. 

The other two parameters in the Noise Gate determine how fas! the gate will open and close. 
Thts will affect how the beginning and end of the sound will fade in and out. If the Attack time ts 
too slow, the beginning ofthe vocals might get cut off. Likewise, ifthe Release time 
is too fast, the end of the vocals will be cut. Experiment with these times until you can remo ve 

as much noise as possible without removing any of the voice. 

Compression and Limiting 

Compressing and limiting are terms used to indica te effects that lower the dynamic range of a 
so un d. When yo u compress a sound, you lower the volume of loud sections and then raise the 
overall volume to compensate. This is done tó keep the vo1ume' leve! from fluctuating too much 
over time. Limiting works exact1y like compression, but to a higher degree. 

Compression and Normalization can be used together to increase the apparent 1oudness of a file. 
This is current1ya popular mastering technique. 

Open the file TUTMUSIC.WAV. Make a copy ofit by selecting the whole region and dragging 
it to an open space in the Sound Forge workspace. Now, with the new file active, select 
Dynamics from the Effects menu and choose Graphic. 

The Graphic Dynamics dialog allows yo u to precisely tailor the gain at all input levels of a 
signa!. The Input vs. Output leve! graph shows you the gain that will be applied to the input 
signa!, depending on its leve! over time. The diagonalline, referred to as the No Gam line, 
indicates where the input and output levels are equal. When an envelope point is below the line, 
gain reduction occurs. 

If yo u understand the principie of the graph, yo u can edit its points directly to crea te your own 
compression, expansion, limiting, or noise gating curves (see the Reference chapter for more 
details). However, you don't need to use the graph at all. Using presets and the threshold and 
ratio trackbars ts sufficient for most cases. 



Choose the 2:1 Compression starting at -18 dB preset, tum Auto gain compensate off, and select 
O K. If you can see both files at once and are zoomed out, you'll be able to notice how the levels 
of the new file are more constan! !han the original. Listening should reveal the same thing .. 

In this preset, sounds above the Threshold (-18 dB) are attenuated atan input to output ratio of 
2: l. Sounds below the Threshold are not affected by the compressor. The Auto Gain Compensa te 
check box raises the total volume of the file after processing to bring the overall output leve! 
back to an acceptable leve!. Turn it on once and you'll see how the overall leve! is much higher 
now. This can also be done manually with the Output gain fader. 

Undo the previous operation and select Dynamics again. Now, increase the Ratio to 7:1 and 
select OK. The sound will be even more compressed, meaning that more attenuation and 
boosting will be applied to compressed signals. 

Too much compression starting at too low of a threshold leve! will usually lead toa distorted 
sound. 

Again, undo the operation and select the Limit levels to -6 dB (hard limiter) preset. Now, signals 
above the Threshold (-6 dB) will still be attenuated, and with a huge ratio oflnfinity:l. 
Essentially, after processing, there will be no levels abo ve -6 dB included. 

Ltmiting is often used io keep signals from going above a certain leve!, but can also be applied to 
crea te heavily-compressed effects. Limtting should only be done on peaks; if the Threshold leve! 
is set too low, heavy distortions will occur. 

Expansion 

Dynamic expansion_is the opposite of compression and limiting. Any signa! below the threshold 
will be attenuated by a certain ratio. The most common effect of expansion is to attenuate low­
level noise, such as a noise gate. However, you can also use expansion to add more dynamic 
range to a sound. 

With the TUTOR l. W A V file open, select DynamicsiGraphic from the Effects menu. Choose the 
Soft noise gate below -36 dB preset and select OK. Notice how very low-level sounds ha ve been · 
attenuated. This is useful for removing noise from silent regions in a similar fashion as a noise 
gate. 

Multi-Band Dynamics 

The other type of dynamics processing that Sound Forge allows for is Multi-Band Dynamics. 
Essentially this is a compressor that only affects certain frequency bands. The possibilities with 
this type of compressor are endless, but the most common use is for de-essing and de-popping. 

You can also use this function as an advanced EQ for such things as tightening up a bass line or 
drums. 

Open the file SIBIPLOS.WAV. Thts file contains both loud sibilants (S's) and plosives (P's). 
Let's first remo ve the sibilants. Double-click on the region named ... and sibilants to select it. 
Next, select DynamicsiMulti-Band from the Effects menu and choose the Reduce loud sibilants 
(de-esser) preset. This preset acts upon frequencies around 5,000 Hz. Previewing the effect 
should make the S sounds less painful. 

Next, make a selection on the region named plosives. This can be done by pressing the Selectwn 
button and choosing Region: ... and sibilants. In the Multi-Band Dynamics dialog, choose the 
Reduce loud plosives and hit Prevtew. The loud P becomes less obtrusive and unlike EQ, this 
reduction doesn't affect the entire sound file. It only acts upon the plosives. 
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There is also a Multi-Band preset called Reduce plosives and sibilants which you can use to 
remove both S's and P'sat once. This is basically the same effect as running one frrst and then the 
other. 

When applying these presets to your own files, you will most likely need to change the 
Threshold setting until only the unwanted sounds are affected. Ifthe Threshold is too low, too 
much filtering will occur. Setting the filter to -Inf. forces filtering of all the data. Also, you can 
also boost a band after compression by using the Gain control to compensate for any loss during 
processmg. 

Changing Pitch and Time Duration 

You are probably familiar with how changing the playback rate of a recording affects its pitch. 
For example, playing a 33 113 RPM vinyl record at 78 RPM makes the Beatles sound like the 
Chipmunks. Likewise, playing a 78 RPM record at 33 113 makes a trurnpet sound like a tuba. 
This concept is used by most sampler units to make a single sound file achieve different pitches. 

Open the file SAXRIFF.WAV. Under the Effects menu, select PitchiShift. 

Next, select the Fifth up preset and select OK. Notice that the length ofthe file is less than its 
original size. Listen to the sound to hear both a higher pitch anda faster rate. 

Undo the last operation and return to the Pitch Shift dialog. Now, select Fifth down and select 
OK. The file is now larger, slower, and lower in pitch. 

Altering Pitch Without Changing the Duration ofthe Sound 

Undo the last operat!On and return to the P1tch Shift dialog. In the last two examples, the 
Preserve duration check box was left unchecked. When you check this box, a completely 
d1fferent algorithm is used to change the pitch of the sound. 

Select the Third <lown preset and check the Preserve duration check box. Next, you must select a 
mode. Different algorithms are included for different kinds of sounds. These modes are only 
suggestions, sin ce many will work with different types of sound. Jt's best to just try a few 
different ones and choose the one that sounds best to you. For this saxophone riff, the mode 
named A 13. Solo instruments 4 does an excellent job. 

Now, preview the sound. The sound file wiil now have a higher pitch, but it will not sound as if 
it's being played back faster. 

Changing Time Duration Without Changing the Pitch of a Sound 

Another Sound Forge process unique to digital processing is the ability lo stretch or compress the 
time duration of a sound without altering the pitch. This is useful for lengthening or shortening 
sounds to meet a specific time length. 

Open SAXRIFF. W A V and select Time Compress/Expand from the Process menu. 

This process is very simple to use. In the dialog, you have the ability to speci:ty the final duration 
of a sound, from 50% to 500% of the originallength. Like in the Pitch Shift dialog, yo u must 
choose a mode from a list depending on the type ofmaterial you're processing. The mode named 
Al3. Solo instruments 4 (less echo) does a goodjob with this sound file. Change the Finallength 
from 2.5 to 2.0 seconds (80% of original) and select OK. Press the Play button and you should 
hear the riff played at a faster tempo. 

The A and B modes used in both Time Compression/Expand and Pitch Shift without change of 
duration work in a similar fashion. Modes labeled C are from Sound Forge 3.0. Basically, the 
reason why there are so many opt10ns is that compromises must always be made between having 



excellent time localization (no echoes) and accurate frequency reproduction (no low-frequency 
distortion or flanging). 

If you ha ve sounds that ha ve few loud, sustaining low-bass frequencies, you can use modes that 
will result in no echoes. These include the Drum modes and sorne of the Solo lnstrument modes. 
For complex music, you must sacrifice sorne time localization for the ability to reproduce long 
bass notes. 

Since classifying sounds into strict categories is not possible, different settings are included for 
each sound type. For example, ifyou have a drum recording with bass drum, snare, and cymbals, 
you find the Al7. Drums, unpitched (minimum echo) does an impeccable job. However, once 
you start adding ringing low toms and congas, the Al8. Drums (better for toms) preset will work 
better. Again, experimentation is the key. 

Small and Accurate Changes in Time Duration 

If you have a sound file that is one minute and three seconds long, but you need it to be exactly 
one minute, there are two ways to go about it. lf a very small change in pitch is acceptable, you 
might try using the Pitch Shift with no Preserve duration. Keep the Semitones atO and adjust the 
Cents until the required Finallength is reached. lt is sometimes possible for this method to give 
better sounding results than when using the Time Compression algorithm. 

Synthesis 

Simple Synthesis 

The Simple Synthesis too! can be used to genera te a simple waveform of a given _shape, pitch, 
and length. More complex waveforms can be generated with the FM Synthesis too!. 

Create a new window by selecting the New item from the File menu and set the data formal for 
the window to be 16-bit, 22,050 Hz, Mono. Next select SynthesisiSimple from the Tools menu. 

Select the Middle C Reference (3 seconds) preset and press OK to generate a sine wave in the 
window that is 3 seconds long and has a pitch of 261.52 Hz (Middle C). Press the Play button to' 
hear your reference tone. 

FM Synthesis 

Sound Forge's FM Synthesis tool allows you to use frequency modulation (FM) and additive 
synthesis to create complex sounds from simple waveforms. 

In frequency modulatJOn, the frequency of a waveform (the carrier) IS modulated by the output of 
another waveform (the modulator) to create a new waveform. Ifthe frequency ofthe modulator 
is low, the carrier will be slowly de-tuned over time. However, ifthe frequency ofthe modulator 
is high, the carrier will be modulated so fast that many additional frequencies, or sidebands, are 
created. 

Sound Forge allows up to four waveforms (operators) to be generated in a variety of 
configurations. Depending on the configuration, an operator can be a carrier, a modulator, ora 
simple unmodulated waveform. Waveforms can also be added together (additive synthesis) to 
add more complexity to the sound. 

The best way to become familiar with this module is to start with a single operator configuration 
and try out all the different waveforms by themselves. Experiment using Feedback on each 
waveform to hear the different effects of self-modulation. Feedback adds overtones to the sound 
by modulating the sound w1th itself. Zero feedback indicates simple synthesis. 

In the second configuration, two unmodulated operators are mixed together (horizontal 
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connection) and heard simultaneously (additive synthesis). 

Now change the Configuration to two stacked operators (vertical connection) and again 
experiment using different waveforms and frequencies on the carrier (bottom operator) and the 
modulator (top.operator). With the modulator Frequency set low (1-5Hz), lower the modulator 
Amplitude to crea te slight de-tuning. Raising it crea tes big pitch bends. If the modulator 
Frequency is set high, many unusual FM sounds can be achieved. Make sure that the modulator 
Amplitude is not too high, otherwise the result will be harsh, noise-like sounds .. 

Setting the modulator Frequency to 0.00 allows absolute control ofthe carrier's pitch by using 
the modulator's envelope, which you can use for de-tuning over time. 

Adding more operators increases the complexity ofthe waveform. When both FM and additive 
· synthesis are combined, an almos! endless variety of sounds can be generated. 

DTMF Synthesis 

The DTMF Synthesis too! is used to generate the dial tones used by telephone companies. These 
dial tones correspond to the numbers m a telephone unit, along with other special codes. 

For example, select the Sanie Foundry, Inc. preset. The dial string shows Sonic Foundry's phone 
number. The Amplitud~ control determines how loud the tones will be. Press OK to generate the 
tones. Now when you play back the sound file, you'll hear the tones which when played over a 
phone line would trigger a call to Sanie Foundry. 

Filteriilg lntro 

What can you do when you have a sound that is not quite perfect, but not bad enough to throw 
away? Sometimes, judicious use of filtering can keep a favorite sound bite from losing favor. 
Filtering is nota cure-all for bad sound, but slight alterations of a sound can bring it back to life. 

Sounds are composed of varying amounts of one m more frequencies. For example, a sound with 
a rich timbre will contain many different frequencies. A sme wave sound has only one frequency 
in it, like 60 or 440 Hz. 

Filters allow the tailoring of the frequency spectrum of a sound. A spectrum is nothing more than 
a representation ofhow much of each frequency componen! (from 20 Hz up to one-half the 
sample rate) is present in a signa!. Less of any given componen! means that the given frequency 
componen! is notas prevalen! aurally as another componen!. Filters pass or reduce (attenuate) 
frequency components. 

Many factors such as the frequency response characteristJc ofyour speakers and sound card can 
al so affect which frequencies are more prominent during the playback of a sound. In general, the 
goal is to make a recording sound as clase to the original as possible. However, filtering is also 
commonly used to remove unwanted sounds such as noise, or make individual instruments in a 
recording sound louder. 

Paragraphic EQ 

The Paragraphic EQ is a set of six very flexible parametric filters. Four independent band filters 
allow you to boost or attenuate specific frequency ranges. Also, two shelving filters Jet you 
control the amount of low and high frequencies in your recordings. A Gain vs. Frequency graph 
shows the overall effect of the combined filters, making 11 easier to visualize the final sound. 

Open TUTMUSIC.W A V and select EQIParagraphic from the Process menu. Next, select the 15 
dB notch centered at 1000 Hz preset. Notice how the graph goes below the centerline at 1000 Hz. 

Hit Preview and listen to the very strange, hollow sound caused by the missing mid-range 
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frequencies. Moving the Gain fader ofthe third filter further down from -15 dB to -25 dB will 
increase the effect. Next, move the fader - 25 dB to +9 dB and listen to the drastic tone 
difference. 

Double-clicking on a band's Gain fader resets its value toO dB, which di sables the band. To 
disable all bands,right-click on an unused portian of the dialog and select Reset All from the 
shortcut menu. 

Each of the four bands has a Center frequency, Gain, and Width control. The Width control 
determines how may octaves above and below the center frequency will be affected by the 
filtering. For the most part, try to keep the width around one octave. Ifthe width is small, fewer 
frequencies will be affected. 

Select the Boost bass frequencies below 250 Hz by 4 dB preset and hit Preview, Here, the low­
shelffilter is used to make low frequencies louder. Change the gain from +4 to -15 dB and check 
out how most of the bass has been drastically reduced, as if being played through a small radio. 

Open the file CREEK.W AV. This file contains a recording of a small stream. Ifyou loo k at the 
waveform, you'll notice that there are sorne very high leve!, low frequency waves in this 
recording, probably caused by the wind. They are inaudible, yet if you loo k at your speaker's 
woofers during playback, you'll see them bouncing up and down. This large excursion can 
damage sorne speakers and forces both the amplifier and woofer to work overtime. Woof! 

To remove these frequencies, go to the EQIParagraphic dialog and select the preset titled 
Remove very low and inaudible frequencies below 20Hz. Now hit Preview. Turning the Bypass 
check box on and off, you should notice no audible difference. Hit OK. Notice how the large 
waves are gane and your woofers are no longer crying for help. 

Removing very low and inaudible frequencies after recording is a very good idea. For one, your 
waveform will lookmore natural and the leve! meters more accurate. Also, edits and effects will 
behave more predictably, giving youextra headroom. 

Parametric EQ 

Sound Forge has four basic types ofparametric Filter styles: High-pass, Low-pass, Band-pass 
(peak), and Band-reject (notch). A low-pass filter alters frequencies above a certain value, anda 
high-pass filter alters frequencies below a certain value. A band-pass filter alters frequenc1es 
oulside of a specified range. A band-rejecl (or notch filler) alters frequencies inside a specified 
range. Generally, each filler attenuales frequencies in its slopband range(s) and leaves 
frequencies in ils passband range alone. 

.... 

The rale al which lhe passband transitions inlo lhe stopband is lhe transition band (or rolloff). 
When you specify lhe characlerislics of a filler in Sound Forge, you will no doubt be lempled lo 
specify thal a low-pass filler will start lo transition al, say, 1,000 Hz and finish transitioning by 
1,001 Hz. The problem with doing sois thal lhere are malhematicallimitations to creating such a 
filter. When you specify a sharp transition band, the software will try to design a filter that will 
take a long time to apply and will unnecessarily filter the signa! to overly exacting requirements. 
Razor-sharp filtering can often create unwanted side-effects. The more subtly you filter a signa!, 
the more natural it sounds. 

When specifying the attenuation amount for your filter, you are selecting how much to de­
emphasize lhe frequency componenls that you do not want to hear. Numbers that are more 
negalive suppress the frequency components more heavily. In other words, -6 d.B of stopband 
rejeclion is going to let more unwanted frequencies through than -15 dB will. 

So, let's say yo u just recorded a great hamster sneeze, but there is something not quite right about 
it when you play it back later. What can you doto restare the hamster sneeze to its rightful place 
as your favonte sound in your Windows env1ronment? 

... 

... --!.t 
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Maybe you used a microphone preámp with bad common-mode rejection characteristics, or you 
set the hamster right next toa lamp when you recorded the sneeze? Well, don'! panic, because 
Sound Forge can flx that sound. Try applying a 60Hz notch f1lter to the sound. A notch f1lter 
will notch-out the frequencies in a range about 60 Hz so that they are not as readily heard 
relative to other frequencies. 

Maybe the hamster sneeze has too much hiss in it? Try applying a low-pass f1lter and see ifthat 
makes it better. Remember, a small amount offiltering goes a long way. 

Open TUTMUSIC.WAV and select EQIParametric from the Process menu. 

Select the Phone-line effect preset and press OK to run the f1lter. Press the Play button to hear 
how the music is much thinner sounding, quite like hearing it over the phone. The Band-pass 
fllter has attenuated frequencies below 250 and above 7000 Hz. 



Anexo C) 

Manual de operación de "Cool Edit" 
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Cool Edit Quick Reference 

Navigating the Main Screen 

Keyboard and Mouse Shortcuts 

File Functions 
Editing Functions 
Transforrnation (Effects) Functions 
Audio Generation Functions 
Options Menu 

Updated features 

.. 
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Navigating Cool Edit 

Commonly used functions are represented as icons in the Toolbar. 
Just holding the mouse over any of these icons will bring up a Quick Help message describing the 
function in more detail. 

Waveforms are displayed in green. 
Any portien may be selected by clicking on the waveform, and dragging left or right. 
Holding the SHIFT key while doing so will increase the currently selected portien. 
Double-Ciicking on the waveform will select the entire visible wave. 

Choose Zoom In to expand the selected portien to full width. Zoom Out will give a larger view of the 
waveform, while Full View will display the entire waveform in the workspace. 

The Play button will play the portien of the wave that is currently being viewed, or the portien that is 
highlighted. 
The Pause button will temporarily pause the playback or recording of audio. The button turns into a 
Continue button when audio is paused. lf recording, the red record bar turns yellow to indicate a paused 
state. 
The Record button will start recording at the curren! insertion point. Any waveform data after that will be 
recorded over. 
Use the Stop button to end waveform playback or recording. 

The Record Leve! Meter below the Play/Record buttons will display in real-time the curren! peak 
amplitude of the audio being monitored, recorded, or played. · 

Double-Ciicking on the Record Level Meter will start and stop monitoring. 
Right-C]icking the display will bring up tl)e Level Meter configuration menu. 

The View lndicator depicts which portien of the entire waveform is being viewed in the workspace below. 
Sliding the green bar (when present) left or right scrolls various parts of the waveform below into 
view accordingly. 
Clicking to the left or right of the green bar will scroll the audio to the left or right one screen when 
zoomed. 
Double-Ciicking on the View lndicator will bring up a Quick View screen to allow direct entry of 
starting and ending samples for the viewing range. 

The Yellow Arrows indicate the point of insertion. Clicking anywhere in the workspace will move the 
point of insertion to the mouse. 

The Red Arrows, when present, represen! the Cue Lis! entries for a cue marker. 
The Blue Brackets, when present, represen! the Cue List entries for a selection range. 

The Time Display windows show the curren! Starting and Ending points of the curren! selection, or 
portien being viewed. 
Double-Ciicking on these windows will toggle the display between time in seconds, and in samples. 

The Wave Formal window displays the formal of the wave in Channels, Sample Rate, and Bits Per 
Sample. 
Double-Ciicking on this window will bring up the Adjust Sample Rate dialog to change the 
waveform's characteristics. 

The waveform Ruler shows the time at any point in the waveform. 
Double-Ciicking on the ruler will change the displayed time formal. 
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When a wave is being played via the Play bullen, or automatically via a keypress (see Cue Lis!) a vertical 
bar shows the curren! playing position. 

lf a valid audio CD is in the CD-ROM drive, and the [MCI] CD Audio extensions are loaded, pressing the 
CD icen will display the CD Player Controls at the bottom of the window. 



The View lndicator is the green bar above the wavefonn being viewed which chánges size depending on 
the leve! of Zoom. 
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Se despliega en la pantalla la última parte del archivo y el cursor se coloca al principiÓ de la última 
línea. 

%vi +n nombre_archivo 
El cursor se coloca al principio de la línea n del archivo, dónde n es un número entero no mayor al 
número total de líneas del archivo. - · --

Modos de trabajo del editor vi 

El editor vi tiene dos modos de trabajo: el modo de comandos y el modo de inserción. Al comenzar 
una sesión, vi se encuentra por omisión en el modo de comandos, esto es, en espera de la ejecución 
de algún comando. Para conmutar entre ambos modos se usa la tecla <ESC>. 

Órdenes básicas 

Inserción de texto 

a Insertar texto a la derecha del cursor 
Insertar texto a la izquierda del cursor 

1 Insertar texto al principio de la línea 
A Insertar texto al final de la línea 
o Inserta una línea abajo de la línea actual 
O Inserta una línea arriba de la línea actual 

Movimiento en el texto 

j 
k 
h 

<CTRL><F> 
<CTRL><B> 
lG 
G ó :$<ENTER> 
:n<ENTER> 
w 
e 
b 
M 
<SIDFf>j 

Mueve el cursor una línea abajo 
Mueve el cursor una línea arriba 
Mueve el cursor un caracter a la izquierda 
Mueve el cursor un caracter a la derecha 
Mueve el texto una página hacia adelante 
Mueve el texto una página hacia atrás 
Mueve el cursor al inicio de la primera línea del archivo 
Mueve el cursor al inicio de la última línea del archivo 
Mueve el cursor al inicio de la línea n 
Va a la siguiente palabra 
Va al final de la siguiente palabra 
Va a 1 inicio de la siguiente palabra 
Va a la mitad de la pantalla 
Une la línea actual con la línea de abajo 

Búsqueda y reemplazo de caracteres y cadenas 

/cadena_ buscada<ENTER> 
:!cadena buscada<ENTER> 
?cadena buscada<ENTER> 
:?cadena buscada<ENTER> 
:si cadena _actual/nueva_ cadena/g 

Busca la cadena hacia adelante 
Busca la cadena hacia adelante 
Busca la cadena hacia atrás 
Busca la cadena hacia atrás 
Reemplaza cadena_ actual por cadena_ nueva sólo en la 



Viewing Range 

Selecting Edlt-> Viewing Range or double-clicking on the greenlblack samples portian bar will bring up 
the viewing range window. 

Enter the leftmost and rightmost samples that you wish to have displayed. Use this function to. highlight a 
specific number of samples by double-clicking in the wave editing area after selecting the viewing range 
to "select <lll". Remember, Select All only selects the viewing range, not the entire waveform. 
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Cue List 

A cue lis! is a lis! of time offsets into !he wave file. A cue can be either a point, specifying a cursor 
position, ora range, specifying a selection. You can easily jump lo a cue position in a wave by 
double-clicking on the position in the lis!, or selecting !he cue position, and pressing Gato. Cue ranges 
can later be arranged in a play lis! lo be played back in any arder, with a specific number ol loops il 
desired. A maximum of 96 cues may be enterad. 

<-Add 
Add the currently highlighted selection, or cursor position lo the cue lis!. lter.ns.will be displayed in 
temporal arder, with the earliest cue position al !he top of !he lis!. Pressing'F8 when editing a wavelorrn 
will add the curren! range or cursor location lo !he cue lis!. '- .· 

Re m ove 
Remove the selected cue position lrom !he lis!. 

Label 
Short text label describing !he selection. 

Description 
A'textual description ol the wave data il necessary. Also can be used as a comment. 

Goto 
Goto the selected cue position, or highlight the selected range. Double clicking a cue item acts as il Goto 
were pressed lor that item. 

The cue list is s_aved in the .WAV file formal in !hE)_ 'cyLchunk. ;Additional infol!!)a_tjon about the cue 
position, like label, description, and length ol sample, are placad in the 'adtl' list in the 'labl',_'note:~and __ _ 
'ltxt' chunks.. ·----· -----
Merge 
Merge will create a cue range that spans the two cue items selected (whether they are ranges or markers 
themselves). To select more !han one cue item in the list, hold down on the CTRL key when selecting, or 
cilck and drag over more !han one cue item. The name used lor the new merged item will be the same 
as the earliest item chosen in time (the highest item in the list). The inlorrnation typed into the Name and 
Description fields lor the second item being merged will be los!. ---- · · --

Markers 
The cue list can be used anytime to mark your curren! selection so you can return lo it later. 11 you would 
like Cool Edil to remember your highlighted selection, or just your curren! cursor point, click Add in the 
cue list, and quickly type a name lor your selection. In the futura, il you want to return the cursor to that 
point, or re-highlight that selection, double-click the name or choose the name and click Goto. One great 
use lor markers is to highlight a wave lrom the zero crossings. Go lo the start ol wave portian you wish 
to highlight, and zoom in as lar as needed to position !he cursor exactly on the zero-crossing point. Add 
that position lo !he cue lis!. Now zoom out, go lo the end ol the wave portian, and once again zoom in lo 
find the ending zero crossing. Now, double-click on marker name in the cue list, hold down on the Shift 
key to extend the selection, and click on the ending zero crossing. Voila! You can choose "Zoom In" now 
to see your wave portian il you like ... il is now selected. 

Visual Representations 
Cue markers will be displayed in the main wavelorm as red arrows above and below the wave. Cue 
ranges will be displayed as blue brackets above and below the wavelorrn. 
Assigning Cue Ranges To Keys 

.. 
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lf you wish to assign any cue range you hava added to a kay on tha kayboard, giva tha cue ranga a label 
of tha form KEY N, whara N is any key on tha keyboard (capltallattars only). Whan you go back to 
editing the waveform, pressing tha key will play tha cua ranga you salected. You can assign any portion 
of tha waveform to any kay on the kayboard. lf you have any problems wtían playing audio by pressing 
the assigned keys, try incraasing the STACKS line in CONFIG.SYS to raad STACKS=12,512. 
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Shortcuts 

KEYBOARD 
Delete 
CTRL+C 
CTRL +lnsert 
CTRL+X 
SHIFT+Delete 
CTRL+V 
SHIFT +lnsert 
CTRL+T 
ALT+Bksp 
CTRL+A 
CTRL+S 
ESC 
CTRL+l 
CTRL+R 
CTRL+B 
ALT+P 
ALT+S 
S PACE 
F2 
F3 
F4 
FB 
ALT+I 

Delete 
Copy 
Copy 
Cut 
Cut 
Paste 
Paste 
Trim 
Undo 
Select Entire Wave 
Select currently viewed portian 
Cancel selection 
Edil left channel 
Edil right channel 
Edil both channels 
Play waveform 
Stop play 
Play waveforrn/Stop waveforrn 
Repeat las! command (show dialog if command has one) 
Repeat las! command now (using last used settings) 
Zero cross adjust 
Add the curren! cursor location or highlighted selection to the cue list 
Waveforrn lnfo 

ALT+Z __ Frequency Analysis Window 

MOUSE 
Left Click and Drag on waveforrn to highlight and select a range of samples 
Click and drag near !he top or bottom of a stereo wavforrn to select a single channel 
Right Click (and drag) on waveforrn to extend selection 
Shift+Left Click (and drag) on waveforrn also to extend selection 
Double-Ciick on view indicator (green bar) to enter viewing range directly in samples 
Click to the left or right of the view indicator to page one screen left or right 
Double-Ciick on Levels Meter (black bar beneath play buttons) to startistop monitoring 
Click on the Clip lndicator (to !he right of the level meter) to clear it 
Right Click on the level meter to bring up its configuration menu 
Double-Ciick on Sample type display to change sample type interpretation 
Double-Ciick on the waveforrn ruler to change the ruler formal. 
Double-CIIck on time windows to change time formal 
Double-CI1ck on tille bar to Maximize/Restore 
Res! mouse over toolbar button to gel explanation of button's function 

. ! • 
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File menu 

The file menu displays file handling options. 

File Menu Options: 
New 
New lnstance 
Open 
OpenAs ... 
Open Append ... 
Re-Open 
Close 
S ave 
SaveAs 
Save Selection 
Exit 
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Level Meters 

Level Meters from !he Options menu will start monitoring the recording source, which is useful for 
setting the recording levels befare recording. To stop monitoring;press !he Stop console button. The 
meter may also be started and stopped by double-clicking on the meter display area. lf your audio 
system software crashes when doing lhis, try increasing the STACKS in CONFIG.SYS to 
STACKS=12,512, or the equivalen! for Windows 95. 

The levels displayed represen! the peak amplitude in decibels, where a level of OdB is the absolute 
maximum befare clipping occurs. lf clipping does occur, the clip indicator to to the right of the meter will 
light up. Jusi click on !he clipping indicator to clear it at any time. When displaying stereo audio, the to 
meter represents the left channel, and the bottom !he right. Yellow peak indicators will stick for 1-1/2 
seconds to easily read the peak amplitude. lf the option to Adjust for OC offset is enabled, false clip 
reading may occur sin ce the baseline is being adjusted. Oisable the OC offset adjustment to have the 
clip indicators only light up when absolute clipping occurs. 

Clicking the Right Mouse Button on the leve! meter display will bring up a configuration· menu. From the 
configurat1on menu, y~u may do the following: 

Start/Stop Meter 
Start or Stop monitoring of !he input source. When monitoring is active, the meters will respond directly 
to the audio 1nput. 

Clear Clip tndicators 
The box{es) at the right willlight up red if audio is clipping. Click on the box or choose this option to reset 
the indicator. lt is best to record audio as loud as possible without clipping. 1t is sometimes easier to 
keep the loudes_t point somewhere between -2dB"and OdB when setting the recording levels on your -· 
sound board's mixer. Note: The clip indicators will always light if clipping occurs, but if Adjust for OC is 
enabled, the indicators may light up when the audio has a OC offset. 

Adjust for DC 
Many sound boards record audio with a slight OC offset, which means that the center of the waveform 
being recorded is not at the exact center of the wavelorm display, but a little above or below it. This can 
dramatically throw the leve! meters off since the amount the waveform is displaced could be interepreted 
as a constan! sound that loud. To compensate, make sure this menu item is checked. The recording 
meters will dynamically adjust to the OC offset, and display the true amplitude of the signa! in decibels. 

Show Valleys 
Just as the yellow indicators show peak levels, if Show Valleys is chosen, valley levels {mínimum 
amplitudes) will be marked as well. This gives a good indicat1on of the dynamic range of the audio. lf the 
valley indicators are close to the peak indicators, the dynamic range is low. lf they are spread lar apart, 
the dynamic range is high {the difference between the quietes! sounds and laudes! sounds is greater). 

90dB Range to 30dB Ranga 
This is the range that the meter covers. When recording 8-bit audio, there is no need for anything greater 
than a 45dB range, since 8-bit audio can not really record anything below a volume leve! of -45dB. Use a 
lower range to see the loud portions more clearly. Use a h1ger range to see the quieter portions for very 
high dynamic range audio. Note: Yo u m ay find that when you think your sound .board is recording pure 
silence, you will see the meters fluctualing between points around -87dB up to -60dB instead al going all 
the way down. This is because ol noise in the sound board. Sorne sound boards have h1gher 
signal-to-noise ratios than others. Generally, the higher quality the sound board, the lower the meters will 
go down during pure silence. To quickly see how no1sy your own sound card is, choose File->New and 
create a new 44.1 Khz 16-blt file. Then start the leve! meters, and choose the 90dB Range. This test only 



works for 16-bit sound cards, since 8-bit sound cards have a maximum dynamic ranga of around 45dB. 

Dynamic 1 Statlc Peaks 
Choosing Dynamic Peaks will cause the yellow peak level indicators to reset to a new peak level after 
1-1/2 seconds. In Static mode, !he peaks never reset. Use Dynamic modelo easily see visually !he 
peak amplitude right now. As audio gets quieter, the peak indicators will start backing off as well. Use 
Static mode to retain !he maximum amplitud e of !he signa! since monitoring, playing, or rei:ording bagan. 
The peak can still be reset manually al any time by clearing the clip indicators (clicking on the clip 
indicator at !he right). Static mode is great for finding out how loud a song will gel before recording il. 
Jusi start the meters and start playing the song. When the song is over, the peak indicators will show 
how loud the loudest part of !he song was. 
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RIFF lnfo 

Extra information can be included in your .WAV files using !he RIFF LIST INFO and OISP type 1 formats. 
This information should (depending on future wave editors) stay with your sound through its lifetime. 
Other wave editors should preserve sorne of !he fields you see here. 11 !he "Fill " Fields Automatically" 
box is checked, then !he Software Package and Creation Date fields will be automatically filled by Cool 
Edil. 11 you do no! want this extra information lo be tagged with your wave files, uncheck this box. Be 
sure to pul proper information in its place! 

Display Title 
This should describe !he sound, or text (if there are words in !he wave). This field should be as short as 
possible,.since it will be displayed in OLE objects and !he like. 

Icen 
Any DIB or BMP file can be inserted, bu! preferable a 32 X 32 16-color would be bes!. The Media 
browser uses this size lo display a picture representing !he sound. Other OLE compatible applications 
can use the above display tille, and/or the bitmap lo represen! your waveform. 

Original Artist 
The ene who created the sound initially. Examples are: Bealles, Pat Sejek, Fred Flintstone 

N ame 
The tille of the wave. This is your chance lo pul a name with your audio "artwork". Examples are: 
Thunderstorm Al Night, Forest Stream 

Gen re 
The Genre of !he original work. With audio, let's .t!Y things like musical classifications. etc. Examples 
are: Carteen Voice, New Age, lnstrument 

KeyWords 
In the tuture, sounds may be searched for by key words. Please separate key words by a semicolon 
followed by a space. For Example: Violin; Hayden; Johann Strauss 

Digitization Source 
Where was !he sound digitized from. A tape deck, CD, or maybe direclly from a microphone? Maybe 
describe the board used here too, like Sound Blaster Pro, or MediaVision. For Example: DDD CD to 
MediaVision Pro 16 

Original Medium 
Where did the sound come from originally. Examples: Live Band, Flute, Moog, Voice 

Engineers 
Store the name(s) of the engineer(s) who worked on !he file, or edited the file. Please separate names by 
a semicolon and a space. When a new person edits the file, they can add their name lo the lis!. For 
example: John Crav1tz; Fred Millstone 

Digitizer 
Who is the technician that did !he actual digit1zing? They should pul their name nght here. 

Comments 
This is ter making any comments you wish. Feel free to iriclude any special effects or enhancements· you 
made to any preexisting waves so that the editing history can be tracked. Please do not use any fine 
returns. End each sentence with a penad. For Example: 1t took 12 hours lo gel th1s recording right. 
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John added echoing effects using Cool EdH. 

Subject 
This Describes the content of the file. Feel free to include a description of the instruments used, where 
someone can find the song recorded, etc. Line retums are OK, and are created by pressing Ctrt+J. 
Sometimes copyright information is placed here as well. For Example: The shakuhachi of 
Japan.<Ctri+J><Ctrt+J>Tiie shakuhachi was developed in the 15th century from a Chinese end-blown 
flute, called the chiba. 

Source Supplier 
The name of the.person, or organization who supplied the original source material. let's use this field for 
the names of record companies, or whoever supplied you with the source. Examples: MCA Records, 
Ann Wilson (if recordad live) 

Copyright 
Any copyright information for this file should go here. Example: (c)1992 G. Willikers Corporation. All 
rights reserved. 

Software Package 
The software used to digitize and edil this file. 

Creation Date 
The date that the subject matter was created. The date should be in !he formal yyyy-mm-dd, using 'O' as 
a place holder in single digit values. For example, if !he date !he original recording was made was July 
30, 1988 then it would be written as: 1988-06-30 



Frequency Analysis 

This will bring up an analysis dialog, containing a graph of !he frequencies present at the insertion point 
(yellow arrow cursor), or at !he center of a selection. A 2048 point Fast-Fourier-Transforrn is perforrned 
to determine !he frequencies present. Also, the most prominent frequency is interpolated, and displayed 
below. By moving !he mouse over !he graph area, !he frequency, and amplitude of that frequency are 
displayed. 

Clicking Sean will sean the highlighted selection, and show all frequencies present in that selection. 

The information in this dialog is like ene "si ice" or line in !he Spectral View of the waveforrn. For an 
animated view of the display, click on the main waveforrn window, then hold down on the Right Arrow 
key. As the cursor scrolls across the display, the spectral inforrnation will be displayed in the analysis 
window. 

To gain higher resolution and see more detail in the lower frequencies, use Convert Sample Type to 
downsample the waveform lo a lower sample rate. The highest frequency value displayed will be ene 
hall the new sample ra,te. 

lf stereo data is being viewed, the left channel will be shown in Cyan while the right will show in Magenta. 

Check the Line View box lo connect the dots at each frequency. 
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Cue List 

A cue lis! is a lis! of time offsets into the wave file. A cue can be either a point, specifying a cursor 
position, ora range, specifying a selection. You can easiiy jump toa cue position in a wave by 
double-clicking on the position in !he list. or selecting !he cue position, and pressing Goto. Cue ranges 
can later be arranged in a play lis! lo be played back in any order, with a specific number of loops if 
desired. A maximum of 96 cues may be entered. 

<-Add 
Add the currently highlighted selection. or cursor position lo !he cue lis!. ltems will be displayed in 
temporal order, with !he eartiest cue position at !he top of !he lis!. Pressing F8 when editing a waveform 
will add !he curren! range or cursor location lo !he cue lis!. 

Re m ove 
Remove !he selected cue position from the lis!. 

Label 
Short text label describ!ng !he selection. 

Description 
A textual description of !he wave data if necessary. Also can be used as a comment. 

Goto 
Goto !he selected cue position, or highlight !he selected range. Double clicking a cue item acts as if Gato 
were pressed for that item. 

The cue list is s.aved in the .WAV file formal in lh!;! 'cue 'chunk. Additional information about the cue 
position. like label, description. and length of sample, are placed in the 'adtl' lis! in the 'labl', 'note', and 
'ltxt' chunks. 

Merge 
Merge will create a cue range that spans the two cue items selected (whether they are ranges or markers 
themselves). To select more !han one cue item in !he lis!, hold down on the CTRL key when selecting. or 
click and drag over more than one cue item. The name used for the new merged item will be !he same 
as the earliest item chosen in time (!he highest item in the lis!). The inforrnation typed into the Name and 
Description fields for the second item being merged will be los!. 

Markers 
The cue list can be used anytime to mark your curren! selection so you can retum to it later. lf you would 
like Cool Edil to remember your highlighted selectron. or JUSI your curren! cursor point, cl1ck Add in the 
cue list, and QUICkly type a name for your selection. In the future, if you want to return the cursor to that 
point, or re-highlight that selection, double-click the name or choose the name and click Gato. One great 
use for markers is to highllght a wave from the zero crossmgs. Go to the start of wave portien you wish 
to highllght, and zoom in as lar as needed to position the cursor exactly on the zero-crossing point. Add 
that position to the cue lis!. Now zoom out. go to the end of the wave portien, and once again zoom in to 
find the ending zero crossing. Now, double-click on marker name in !he cue lis!, hold down on the Shift 
key to extend the selecllon·, and cllck on the ending zero crossing. Voila! You can choose "Zoom In" now 
to see your wave portien if you like ... it is now selected. 

Visual Representations 
Cue markers will be displayed in the ma1n waveform as red arrows above and below the wave. Cue 
ranges will be displayed as blue brackets above and below the waveform. 
Assigning Cue Ranges To Keys 
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lf you wish to assign any cue range you have added to a key on !he keyboard, give the cue range a label 
of !he fonn KEY N, where N is any key on !he keyboard (capitalletters only). When you go back to 
editing the wavefonn, pressing !he key will play !he cue range you selected. You can assign any portion 
of the wavefonn to any key on !he keyboard. lf you have any problems when playing audio by pressing 
!he assigned keys, try increasing the STACKSiine in CONFIG.SYS toread STACK5=12,512. 
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Play List 

The play list is a listing of cue ranges that can be played In any arder, and looped a specified number of 
times. The play list is used in conjunction with !he cue lis!. Maximum size of a play lis! is 64 entries. 

<- Add Befare 
Add the currently highlighted selection from the cue lis! to the play lis!. The selection is inserted befare 
the currently highlighted play list item, or at the end if nothing is selected. 

Remove 
Remove the selected play lis! item from the lis!. 

Loops 
The number of loops lo loop !he selected cue range in the play lis!. 

Play 
Play the cue ranges in !he arder listed, looping selections if necessary. Play begins at the currently 
highlighted item in !he play lis!, or !he entire lis! is played if (end) is selected, or there is no selection. 

Auto e u e 
Play the currently highlighted item in the play lis! (or the first item if nothing is highlighted), looping if 
necessary, and stop on !he next item in !he play lis!. Thus, every time Autocue is pressed. the next item 
in !he play lis! is played. 

The play lis! is saved in !he .WAV file forma! in !he 'plst' chunk 
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Cool Scripts 

Scripts are similar to Macros. Your exact mouse moves, and tweaking of parameters is not stored, only 
the final result when you click "OK". Undoing something is recordad into the script, since you may have 
copied something, then undid it, which can be a very useful technique. 

Multiple scripts can be kept in one script file, and identified by name. At any time, you Can edil the script 
file directly to take out steps, rename scripts, remove unwanted scripts, etc. 

There are various types of scripts, which depend on when you initiated the recording: 
- Scripts that start with File->New, and always start with a blank, empty waveform. 
- Scripts that start when a waveform is opened, and work at the curren! sample rate, etc. Actions begin 
at the insertion point in the waveform, and may affect any part of the en tire wave if present. 
- Scripts that start with a highlighted waveform portien. All actions in the script pertain only to the portien 
that is highlighted, leaving the rest of the waveform untouched. 

Scripts that run during all of the above conditions will be displayed, but only the ones recorded under the 
same circumstances will be allowed to run. In other words, if a script recording started when a portron of 
a wave was liighlighted, then you will only be able to run that Script when something is highlighted. 

Scnpts are very useful for remembering how you generated a particular sound effect. Use the script to 
reproduce the sound effect without hiwing to save the entire waveform. This is especially useful when · 
generating large brainwave "theta" files, which can take monstrous amounts of space. By generating the 
file once, with the scripting tumed on (record), you can generate the file again at any time in the future. 
and save all that hard drive space. You can also pass along scripts to your friends across email or BBS 
systems, since they take nearly no memory to store. 

When running a script, you can either stop at each dialog box, or have the script automatically run 
through completion by using the "Stop at Dialogs" checkbox. Stopping at each dialog box is handy if you 
wish to 'tweak' the parameters while the script is running. 

After recording a script, you may enter a description at the bottom of the dialog to go with the script you 
just recorded. This description will appear when the user of the script highlights the script to run. Note: 
the only time you can edil the description is after recording, not before, and not after it has been added to 
a script collection file. But, you can still edil the description at any time by pressing the Edil button to edil 
the text file directly. 

A single script can be run on a batch of files by pressing the Batch Run button. For more information, 
see Batch Processing. 

Pause at Dialogs - At each dialog, the script will stop to allow you to modify the values to the function. 
Pressing Cancel at this point will stop the script, pressing OK will continue it. 
Alert when complete- When the scrrpt is finished, a dialog box will signa/ !he completion of the script if 
this option is checked. · 
Execute Relative to Cursor - When running a script that was recorded when a waveform was loaded 
but there was no highlight, it can be run by playing back all the operations relative to the beginning of the 
file orto the beginning of the cursor. For example, the Sound Effects scripts require you open a 
waveform (it can be blank) first. Checking this option will insert the effect at the cursor, otherwise the 
effect will be inserted at the start of the file. 

Importan! Note: Other buttons and functions are not disabled while the script is running. Therefore, do 
not use the other functions until the script has stopped playing. 
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FXNS2.SCP Sample Collection 
Description These are five sample functions. Cross Fading is useful if you are going to loop the 
sample. The las! portian ol the sample is over1apped with the first portian, and the amount ol overfap is 
difieren! lor each Cross Fade script. Full cross fading fades the las! hall ol !he sample with the first hall. 
Soft cross fading lades the las! 5% with the first 5%, and hard cross fading fades the first 0.4% with the 
las! 0.4%. Make Piano Keys will take the highlighted sample and stretch and compress them to vary the 
pitch, making 13 copies of the original, each ata different pitch. Each pitch is assignedto a key on the 
keyboard through the cue lis!. This tums your keyboard into a simple sample player. Reverse Echo is 
just that- the echo function, but the echoes go in reverse. 
How To Use These sample functions work on a highlighted selection. Open a waveform. and highlight 
the portian you wish to operate on, then run the script. 

SNDEFX2.SCP Sample Collection 
Description Here are sorne nifty sound effects, and a small song (very small}. lf you run the Cool Song 
script, you can then go to the Music function, and entera name for !he song to save it under. This script 
generales a short note, and then uses the Music function to build the song. The other tour effects are 
just weird effects using the tones or noise functions with other transformations. lf you've watched "Dr. 
Who", you may recognize the Cool Lasers sound effect. 
How To Use These sound effects work in a currently opened waveform. Open a New (blank) waveform 
in any sample rate setting you desire for the quality you would like, 'and run a script. These sound effects 
can also be inserted into an existing waveform, and will be inserted jusi as if the Paste command were 
used. ·. 

MINDSNC2.SCP Sample Collection 
Description lncluded are tour "Tones" synchronization scripts, which have a binaural beat pattern (two 
differing tones •n each ear) overlaid with the corresponding "Waved" pink noise. Choose Loop Play and 
listen to the audio as long as you like. Each Tone script stimulates a different brainwave frequency, from 
Delta to Theta to Alpha, and an "Earth" tone of 7 .83Hz. The "Music" scripts have "Waved" music overlaid ··' 
with the pink noise for a relaxing effect. The Creativity Theta Session is similar to the sample theta 
session described with the Wave function, and lasts 1/2 hour. The session starts at Alpha, goes down to 
Theta, and stays there with a few bursts into Alpha and back. 

How To Use Open a new blank waveform of any Stereo sample setting you wish. We suggest using at 
minimum 22 KHz 16·bit stereo, but the synchronization effects will still work at lower sample rates and 
8-bit. Once you have a blank waveform to work w1th, run one of the scripts. 
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Select Wave Device 

lf you have multiple sound cards, or multiple output devices (such as a sound card and the PC speaker), 
choose the input and output devices you wish lo use. 

lf your system is equipped with MIDI devices, you may also choose the MIDI in, and MIDI out sources. 

The capabilities of the recording and playback devices are displayed in the given tables. 

The seltings are remembered in the [cool edil] section of your WIN.INI, which means if you install a new 
sound driver or card, Cool will not access it until you choose it from this dialog. 
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Customizable Toolbar 

The toolbar can be arranged in any arder by changing button ordering in the listing shown in the dialog 
box. More than one item may be highlighted at a time and moved up or down the.list. ltems at the top of 
the list will appear at thé left of the toolbar. Press the Zap button (looks like a lightening bolt) to move the 
highlighted button(s) to the end of the list. Pul all your most used functions near the top, and zap all the 
functions that you never use! 

Check Enable Toolbar Help to have the help balloons appear when you hold the mouse over a toolbar 
button. 

The File Save icon can be interpretad as a Save As or a Save Now (without any dialog asking tor a 
filename if the file is already named) by making the appropriate choice after File Save. 

Interna! to the COOLINI file, the toolbar formal is slightly different than with previous versions of Cool 
Edil. Your previous settings should have been retained as closely as possible, but because the older 
vers1on assigned priorities lo the buttons (so buttons in the middle did not display until the window was 
w1de enough). new buttons might appear. Jusi zap the buttons you do not use. 



Settings 

GENERAL 

Disk lcon lnterpretation 
The Diskicon can be interpretad as: 
- Save Now (saves what you are working on under !he same filename seen in the tille bar wilhout asking 
if you wish to overwrite the original) or 
- Save As (Aiways brings up !he Save As dialog box to enter !he tille to save the file as) 

Enable Toolbar Help 
When the mouse is over a toolbar bullan for more !han a few hundred milliseconds, a small help box 
appears to describe the button's function. Anyway, if it is annoying for you, you can turn it off here. 

Viewing Mode . 
When zoomed in closely toa wave, individual samples can appear as dots, oras a continuous line. 

Highlight After Paste 
After doing any Paste operation (this in'cludes Paste Special), you can have the inserted selection 
automatically highlighted, or just have the cursor at the end ofthe pasted selection. Not highlighting after 
pa'sting makes it easier todo multiple pastes one after !he other. 

Use old style file open/save dialogs 
lf checked, the File Open and File Save dialogs will be similar lo !hose for 16-bit Windows applications, 
instead of the new Explorer style. You may want lo use these dialogs if you are used to them and don'! 
need !he ex1ra features of Explorer dialogs such as New Folder, Delete, Move, List View with file sizes 
and dates, etc. One advantage to the older style ls that directorias are listed separate from files. 

Maximum Display on Load 
This is the maximum number of seconds of audio lo display when a file is first loaded. When working 
with large files, you may wish lo limit the initial display area lo 1 O or 20 seconds so you don't have to wait 
for the entire waveform lo draw. Setting this value lo zero means there is no limit on the initial display 
SIZe. 

Custom Time Code Display 
Double-clicking on the t1me boxes or waveform ruler will change their display formal. When in !he custom 
Hours:Minutes:Seconds:Frames forma!, you can customize the number of trames per second that will be 
d1splayed. Some common settmgs are 30 (for SMPTE non-drop), 25 and 50 for PAL, and 75 for 
CD-ROM mastering. 

SYSTEM 

Total Buffer Size 
The number of seconds lo reserve memory for recording and playback. lncreasing this will allow more 
multitasking while audio is being played, but it takes more memory. 11 lhis value is too small, there may 
be too much choppiness in your recordings and playbacks. 11 your recordings are getting all "chopped 
up", or you cannot Stop after you've started recording, increase the buffer size, or switch toa !aster hard 
drive (Use a non-compressed hard drive for example). 

Number of Buffers Using 
The number of buffers may affect recording quality in that some audio dnvers may not be able to handle a 
large number of buffers accurately. 11 you experience any stuttering or missing (chopped out) audio, try 
reduc1ng the number of buffers. Also experiment with the total buffer s1ze, as reducing the number of 
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buffers will increase the size of each buffer, since the total of all buffers will be roughly equaly to the time 
specified by the Total Buffer Size setting. 

Temp Directory 
This is the location that Cool Edil will use to save all of the temporary files, which includes the disk image 
of the file currently being edited. lt is best to choose a large, fast hard drive for this. lf you know for 
certain that the drive is not compressed, then do not check the Compressed box, otherwise check this 
box. lf you have trouble recording high quality audio for more than a minute (or even less), then make 
sure the Compressed Orive box is not checked. When checked, DOSis asked for the number of bytes 
remaining on the hard drive since this value does not change linear1y with time on compressed drives. 

Undo Direclory 
This is the location that Cool Edil will use lo save all the Undo files. Any number of undo levels can also 
be chosen. This directory can be different that that of the Temp Directory. lt makes no difference 
whether the drive use for Undo is compressed or not- but a non-compressed drive will be faster. 

Enable Undo 
11 this is checked, the undo tunction is enabled and running. Alter making a change, you can choose Edil 
-> Undo to back up one step. You may want to disable the undo feature if you know you are not going to 
undo something. For example, if you are running a tunction on a 5 minute file, you m ay not want to wait. 
while the undo informatron is saved. 

Play 16·bit files as 8-bit 
11 your sound board is only capable of S-bit audio, you can still create and edil 16-bit audio files. When 
you choose Play, the audio data will be converted toS-bit befare being sent to the sound board. 

Smooth 16-bit to 8-bit Conversions 
11 checked, when-16-bit audio is pasted into an S-bit waveforrn, or 16-bit audio is Opened As S-bit, the ,, 
16-bit audio is dithered down toS-bit to retain more of the orrginal signal. Dithering can keep sorne of the 
audro audible that is below the threshold for S-bit audio. When doing this, you may notice a brt more 
noise rn the background, but the norse is constan!, and you can hear sorne of the 16-bit audio in the noise 
that was otherwise inaudible. 11 this dithering is not done, you will notice strange artifacts m quiet audio. 
Most prefer to have a constan! background norse rather than have strange sounding artifacts in the 
background. Distortion sounds "crackly" if no dithering rs used, or else the sounds have a constan! hiss if 
dithering is used. 

Play from cursor 
When no selectron is highlighted. audio can be either played from the curren! cursor locatron to the end of 
the view, or always from the left edge of the vrew to the end of the vrew. 

COLORS 

Waveform Color and Background Color 
The waveform and background colors can be chosen to customize the color of the green waveforrn 
display. 

Spectral High Energy and Spectral Low Energy 
These settrngs are used rn the spectral view. The hrgh energy color is used tor the loudest sounds, and 
low energy for the quietes!. The colors will span the color cube from the highest down to the lowest in 
pretty much a straight lrne 

Reverse Spectral Color Direction 
To have the colors follow a path that wraps around the cube (instead of going in the strarght fine) check 
this box. This grves a very high degree of control over the spectral plots. 



Default Colors 
When all the colors are in too much disarray, press Oefault Colors to gel back to the regular Cool Edil 
color settings. 

SPECTRAL 

Spectrum Analyzer Resolution 
This is the number of bits of accuracy to display the spectral anatysis when Edit->Spectral View is 
chosen. Each bit will take approx1matety twice as long to draw, but !he resolution will be more precise. 
The number of data points displayed is equal to 1/2 of two to the vatue given. In other words, a value of 7 
will display 64 points along the y axis, a value of 8 will display 128, 9 for 256, 10 for 512 and so on. On 
most displays, a value of 10 is as high as you will ever need to go. 

Spectral View Window Function 
This is the function that will be used to window !he data before being displayed. In general, just keep this 
at Blackmann or Blackmann-Harris. The windows are listed in order trom !hose ·with the narrówest 
frequency band bu! most noise, to !hose with !he widest frequency band, bu! leas! extra noise. 

Energy Plot 
Choose Logarithmic to see every nuance of !he audio. The color chosen will be based on the decibel 
amplitude of the energy present at the particular time and frequency. The quietes! signals will be 
displayed in sorne color. Choose Linear to color the display based on absolute amplitude percentage. 
Linear is sometimes useful to see the general overview of a signa! without getting bogged down by detail 
at much quieter levels. 
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Version History 

95 
Cool Edil has switched to using the 32-bit APis, and compiled for 32-bit Windows to run on Windows 95 
or later and NT 3.51 or later. Most functions have increased in speed by 50% to over 3 times as fast by 
going to 32-bit and doing more optimizing. 
Added the new Explorer style dialogs for most File Open and Save dialogs. The Explorer dialog style 
allows one to copy, rename, delete, and move files as well as simply open or save them. 
Added option to use old style file cipen dialogs tor !hose of you who do not wish to use the new Explorer 
style dialogs. · 
Many minor bug fixes that have increased the quality and stability of Cool Edil. 
Auto-play in the File Open dialog will now play all formats recognized by Cool Edil, not jusi .WAV files. 
Fixed bug in saving and recalling Quick Filler presets. 
Hitting Cancel on "Not enough memory for undo" inadvertently disabled all previous undos. 
Added custom toolbar configuration dialog under Options. AJso added sorne new toolbar items for other 
common operations. 
Added Display Time Formal menu under Edil. 
Save Selection works while saving a portian of one channel of a stereo waveform. 
Revised Settings dialog, and added special settings for color selection and spectral view. 
Spent an extra couple weeks updating Cool Edit's copy protection to keep the program from being · 
cracked' and hacked into. · 

1.52 
Sample rate conversion quality has improved even more. 
Users of the Lite version of Cool Edil now have access to the new high quality sample rate conversion. 
Added Amiga IFF file formal. 
Sorne glitches in. working with scripts have been eliminated. 
CD tilles are automatically read from the Windows 95 COPLA YER.INI file. 
File Open and File Save As dialog boxes remember nonstandard filename extensions, and remember 
last used Options settings for each formal. 
lf no selection is made before performing a Transform operation, the curren! view is used. 
A new ruler has been added to the waveform display. 
Frequency Analysis display has been improved with decibel calibration and sol id line view for 'more 
accuracy. 
Spectral View has been improved by increasing the dynamic range of the display. E ven the faintest 
signals are now plotted. 
Waves play automatically if loaded from the command line. 
Left and Right channels can be chosen individually by clicking near the top or bottom of the waveform 
display. 
When loop playing, the looping will change to match the portian being selected. 
Added optJon to control the number of play/record buffers for fine tuning recording quality. 
Batch file processing now handles about 5,000 files per batch (up from a previous limit of about 200). 
Faster sample rate conversion. 
Faster Filler function in "locked" mode when not dynamically changing filler over time. 
Faster Echo Chamber function by 5 to 20 times or more depending on room configurations. 

1.51 
Added A-Law, mu-Law, byte-reversed, and unsigned formats to the PCM raw data formal. Also added 
oplional header (.DAT) files for specifying formal information for raw data. 
Added support for Microsoft ACM (Audio Compression Manager) file formats. 
Added a 5-bit IMA ADPCM compression for a higher quality ADPCM taking only 25% more space. 
Rebuilt level meters: Display is logarithmic (and labeled) in decibels (dB); Right-mouse-button 
configuration menu; Clipping indicators; Peak meters easier to see; Meter displays while Playing and 
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Recording as well; Meter spans the enüre width of the window for arbitrary precision. 
Added user defined undo levels (maximum is 321evels of undo). 
Fixed 'memory hog' characteristic of Reverb function. 
Quick Help no longer disables the Alt key. 
Undo Music was corrupt, it's fixed now. 
Drive letter only (e.g. "D:\") undo directory now works fine- it was causing a 'not enough memory for 
undo' message erroneously. Also fixed problem when temporary directory specified for a non-existen! 
drive. 
Space bar starVstop playing disabled when monitoring audio. 
Destination directory always set properly in batch processing, even if the directory is directly typed in 
instead of using the browse button. 
Added Zero Crossing function to adjust cursor position or highlight to zero crossings. Use F4 to quickly 
snap to zero crossing. 
Functions will work on entire waveforrn if no highlight is made. 
Moved location of 'fact' chunk in .WAV files to before the data instead of after to be compatible with other 
wave programs that do not expect this chunk to come after the data. 
New password generator being used that is case and 'space' insensitive in the user name field -
previously the user name had to be typed in exactly. 

1.50 
Applrcation startup time sped up for owners of CD-ROM drives "by not querying the CD-ROM every time 
the app is started. · 
Clicking on the 'black' area of the green slider bar will page the display left or right. 
Cue items may be added to the cue list while audio is playing (FB will also add the curren! cursor location 
or highlight to the cue list). 
Cue list markers and ranges are displayed as blue brackets. or red arrows respectively indicating their 
locations within the wave . 
. Curren! play time is displayed as a wave is played now. ··· 
New 'Merge' button added to cue list to merge any two cues into a range (hold down on CTRL to select 
more than one cue entry). 
Added Open Append, and opening of multiple files simultaneously. 
Add 'Hand' icon to Graphs to more easily move graph points. 
Fixed bug in 8-bit 'dither' conversion from 16-bit that occurred only with clipped audio. 
Made separate Undo temporary directory so the undo buffer can be on a separata hard drrve if necessary. 
Added multi-level undo. instead of just one level of undo. 
Convert Sample Type is now undoable. 
Added a maxrmum display srze when loading. so the initial display can be limited to a few seconds when 
a large (several minute) file is loaded. 
Added opbon to keep Cool Edit from writing extra RIFF .WAV information in Options->lnfci. 
Fixed bug in srngle channel (of a stereo wave) Filterrng and Noise Reduction. 
Enhanced Noise Reductron functron by allowing more FFT sizes. 
Fixed bug in Noise Reduction that ca u sed it to stop processing when 99% complete. 
Added 6000Hz VOX file formal. 
Added new Reverb function. 
Added Length setting to Stretch function. 

1.34b 
Fixed EQ presets for Echo functron, and Stretch presets. 
VOX file formal will proinpt "Convert to 8000Hz ... ?" instead of auto-converting. 
Fixed bug that causad GP Fault when cursor was out of view and Play was pressed in Play From Cursor 
mode. 

1.34a 
Adjusted play bar speed for SBPro cards to be (hopefully) the right speed now for certain wave formats. 



Fixed 8-bit stretch function (it was truncating all waves to only !he lower half). 
Fixed stretching of waves near clipping so distortion does not occur. 
Fixed AU file filler so it works properly for saving 8-bit audio, and so it will save properly instead of just 
writing out the header at times. 
Fixed Stretch so choosing an overlap of zero percent will not gel errors. 
Fixed Quick Filler volume locking and presets (presets were saving as !he inverse of what was displayed). 
Fixed possible problems with Undo using multiple instances where Undo in one instance would corrupt 
another instance's undo buffer. 
Fixed playing on Sound Blaster cards to preven! "Divide By Zero• errors. 

1.34 
Custom effects modules (the ".XFM files). See Effects Modules API to build your own! 
Last used settings for practically every dialog is now remembered between program runs in the [Profile] 
section of COOL.INI. 
Repeat Last Command function by using F2 (with dialog) and F3 (immediate with previous settings). 
Added variable quality samole type conversion. 
Added a pause button to pause during playing or recording. 
Added a fully configurable distortion effect for getting grunge and blown speaker sounds. 
Added a three dimensional echo/reverb effect lo simulate acoustics in rooms of any size. 
Added a Generate DTMF tones function for making telephone signals. 
Added a batch processor to the scripts for running a script on multiple files. 
Aaded new file forrnats for Next/Sun (.AU), Raw 8-bit signed (.SAM), SampleVision (.SMP). ASCII Text 
(.TXT), Dialog ADPCM for voice (.VOX), and A-Law/mu-Law for Waves (.WAV) 
Auto-play and file formal info features added lo File-Open dialogs to play sounds through installed sound 
drivers for preview and view the file formal before opening. 
Moved file filler options selection to Save As dialog instead of always displaying options when saving. 
S1ngle channel editing possible for most functions (that do not change size of waveform). 
lmproved noise ceduction speed for stereo waveforms and added more options. Also displays a noise 
profile for v1sual inspection. 
Sped up display times in most areas. 
Sped up Normalize. Amplify and Envelope on slower machines by integerizing routines. 
Added Pause button to progress meter so you can free your system in an emergency without losing your 
edits. 
Broke out Normalize and lnvert into separate functional units. Norrnalize can be used in a script now. 
Added decibel scales and log·arithmlc fades to Amplify. 
Modified brainwave synchronizer to have separate high and low settings for intensity and centering. 
Generate Tones now has separate initial and final modulation parameters and independently adjustable 
frequency multipliers that can also vary over time. 
lmproved reliability of Monitor Source. 
New settings options for temporary drive. 
Play may begln from cursor or from left edge of screen. 
Frequency analysis window displays inforrnat1on in stereo with lett=Cyan and right=Magenta. 
CD Player controls improved, now you can lnsert as well as Eject. Also handles over 10,000 CD tilles 
and song lists. That should be enough for anybody! Also, the lOs used are compatible with the 
MUSICBOX.INI file, and any CD tilles in MUSICBOX.INI will be displayed by Cool Edil. 
Added auto zoom button to cue list so double-clicking on cue item opens view to just that cue range, or 
zooms.1nto the cue point. 
Zoom In without any selection zooms in at cursor now, and highlight does.not go away when zooming in. 
Wave files may be up to 1 Gig in size, which should be sufficient for most applications. 
Open and Save As can be recorded into a script for creating more complex scripts that use temporary 
files. 
Curren! file size and number of samples updated while recording. 
Time accuracy increased to 3 dec1mal d1gits, and new Frames formal added (use Settings to change 
number of trames per second). 



Uses fewer resources per instance, so more instances may be open al once. 
Right click extends selection (a shortcut lo using shift+lefl click). 
lmproved stretch function (preserving lempo or preserving none) by using a better interpolation method. 
Added new Fractionallnterval Overlap elongation method lo stretch (preserving lempo or preserving 
pitch). 
Notes are tumed off now when you are not listening lo a Music preview. 
Filtering has been improvedlfixed lo be more accurate with less distortion. 
Fixed bug in finding proper file formal of a waveform (that was a tricky one!). 
Fixed bug where Cool Edil craShed when loading in NT while a CD was in the drive. 
Progress bar updates ETA time more often, at shorter intervals. 
File types added to Extensions section so programs like File Manager have Cool Edil associated with all 
formats Cool Edil understands (unless formal was otherwise associated with a different program). 
Progress meter updates ETA time more often for a more accurate result. 
Lots and lots of other little tweaks, enhancements, and elbow grease went into this verston as well. 

1.33 
Fixed bug in Filler Transition from initial to final settings ... Final frequencies were off. 
Frequency analysis calculates fundamental frequency much more accurately. 
Added Compressor function to compress/expand dynamic range. 
All graphs have double-clickable points to edil the graphical input point directly. 
Clicking on any of the graph points displays the potnt's values below, instead of jusi displaying the mouse 
position. 
Rtng Modulation possible by using "Mcidulate over Source" checkbox. lnstead of generating sine waves. · 
the source is modulated by a the sine wave (or any waveform you choose). 
Any type of Modulation possible by ustng Paste Special's Modulate option. 
Noise reduction function added. 
Sped up some stereo operations for Filler, Spectral View, and Noise Reduction. 
Added smoothe~ 16-bit to 8-bit conversions when.copying 16-bit files into an 8-bit waveform. ,, 

1.32 
Filler has adjustable size (previously u sed 1024, now smoother filtering can be done by ustng sizes of 
2048 or 4096). 

1.31f 
References added to the Brainwave Synchronization help. 
Cue lis! and Play lis! remember their positions better when cutting and pasting shifts their positions. 

1.31c-1.31e 
Larger files list display. 
FFT filler much smoother now (previously had sorne htgh frequency noise when dotng extremely narrow 
sharp filters). 
Adjustable spatial separation for Generate Noise. 
New "smooth" option added to Wave brainwave synchronizer for an alternativa "feel" to the sounds. Also 
the "gamma" range (frequencies above 200 Hz) has been noted. 
New independentleft and right meters for Monitor Source, as well as peak indicators. 
Clicking on the Cool window in the waveform area will not move cursor location if Cool Edil is not the 
active application. 
New display for stereo waveforms. plus a more precise and consisten! display for all waveforms. 
Toolbar buttons draw a little qUtcker now. 
Flange and Special EFX have been combined into a new more powerful Flanger, with a Spectal Efx 
option. 

1.31b 
Space bar will actas a 'play' button. 

/ . 



Warning issued when loading a file takes up All available temporary drive space. 
Pasting low sample rate waves into high sample rate waves works property now. 

1.31a 
Fixed Stretching to less than 50% for preservation modes. 
Fixed displaying of waves more than 15 megs in size. 
Sped up music generation by using temporary files for each note. Long music files can be.generated up 
lo 10 times faster, or even more! 
Added Open As to open waveforms into any formal desired. 
Added Select Entire Wave to quickly select the entire waveform, even if the view is zoomed in. 
The Paste and Paste Special functions now have a progress bar like the rest. 

1.31 
Added the Scripts feature, which allows Cool lo remember everything you do, and will let you replay it. 
One script file can contain many individual scripts. 
Wasn't loading from command line properly befare. 
Fixed memory hog/crashing bug in Generate Tones. 
Added customizable Toolbar by modifying cool.ini file. 
Added play bar to see V>'hat part of the wave is currently being played 
Added Autocue button lo Play List to play a single play list item ata time. 
Trim is now undoable. Please tum off the Undo feature whenever you are doing really really large 
operations if you want Cool to run !aster, since it will not have to save Undo information. 
Added S ave Selection to save the currently highlighted portian of the wave to disk. 
lmproved method for stretching while preserving pitch or lempo for cleaner sounding waves called 
lnterval Overlap. See Stretch. 
lmproved 'time left' reporting when recording. 
lncreased maximum file size from 248 megs to 536 megs. 

1.30b 
There weren't supposed to be any more bugs. But we found sorne: 
Using FFT functions sometimes crashed (like FFT, Frequency Analysis, Spectral View, or Music). That 
has been fixed! 
Undo paste when Hilight Alter Paste was no! checked didn't work. 1t does now. 
File filters have been modified to allow any formal to be broken up into multiple files. For example, the 
WAV file formal can have several file filters for different compression schemes. 
IMAIDVI ADPCM compression filler added to package (dvi.flt), which allows compressing of 16-bit audio 
down to 4, 3, and even 2-bit (with noticeable loss in quality at 2-bit). 

1.30a 
Found more bugs: fixed Undo for Paste (speclallloop/regular), and Undo Delete. 
Fixed Re-Open on PCM files (would hang). 
Added Undo for Music. 
Added presets for Envelope and Filter. 
Added initiallfinal settings for overtones in Generate Tones. 
Revised Mus1c dialog by adding Constan! Durallon checkbox lo replace Adjust Duration. 

1.30 
F1nd Frequency is now a graph of the frequency spectrum. 
Fixed the remaining known bugs, and completed spec for building custom file filters. 

1.29b 
Custom file filters (WAV, VOC. PCM. and AIFF currently). See File Filters API to build your own! 

1.29a 
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Selectable wave de vices (handles multiple sound cards ). 

1.29 
Edil Left/Edil Righl for cutting, pasling, and copying only one channel of a slereo wave. 
Adjusl sample rale added .. 

1.2Bc 
Equalizer changed lo Quick Filler, since FFT Filler does true, precise fillering. 
Graphs have more flexibility wilh poinls. 

'' 

Cue ranges can be associaled wilh keyboard keys, so waves can be played from !he keyboard. 

1.28a 
Spectral View and FFT filtering added. 

1.28 
File -> Clase added. 
Customizable presets added toa variety of wave funclions. 

1.27 
Oouble-clicking on slider bar allows eriiry of starting and ending samples. 
Pre-compute trig tables added to Settings. 
Lindo function added. 

Versions 1.03 to 1.26 
Cool Edil is sizeable. You can make your window big or little or whatever. 
Wave files may be Oropped into the editor from !he File Manager, or other applications supporting Orag 
and Orop. 
New lnstance added to File Menu .. , 
Added automatic conversion of 16-bit audio to 8-bit while playing for boards that do not support 16-bit 
audio. 
Fixed a majar bug having todo with !he progress meter. You can now go on todo other things while 
Coa! works in !he background on long operations. 

· Fixed an annoying bug when working with large files that caused !he green slider to work rnappropriately. 
When opening multiple instances of !he same wave, different names are given to each instance. 
New and lmproved Pink noise source. (Ideal for use with the Wave function). 
Cue lis! and Play lis! supported for looping and custom play arder. 
New Setting for viewing mode of Oots (original) or Lines (dots of sample are connected by fines). 
Oigrtal Oelay transformation added to easily spatrally !acate sounds to the left or right, or for special 
effects. 
New settings option for Save/Save As interpretation of !he diskette icon. 
Are You Sure? Oialog box added to Silence button. 
New waves can be made at any val id sampling rate, by use of !he new Custom option. 
OC Bias Filler added to Amplify to adjust waves skewed by a voltage. 
CO Player has been added to play CO's for recording. Song tilles may also be entered and restored 
automatically on future playbacks. 
Brainwave frequency (Wave) function has adjustable graph for easier input of multiple frequencies over 
time. 
Sound Blaster VOC file compatibility was added. No! FULL capability yet, because it does no! support 
loops (it only loads !he loop once), and ASCII text. lt does however support Sound Blaster Pro formats 
for 44.1 KHz-mono and 22 KHz-stereo. lt will al so load non-standard sample rates if !he VOC file was 
recorded at one. 
Echo Equalizer added to Echo function lo have each successive echo equalized for truer echo effects, or 
just snazzy special effects. 
The Listen optron was added to the music dialog so that !he notes could be ptayed through your MIO! 



setup as a preview. You can record from the music played as well {if your board supports recording from 
the on-board synth.) 
Envelope option was added to have more control over amplifying waves by using an amplification 
envelope. 
A few new tone flavors have been added for making more natural sounding instrument sounds, which 
can be used with the Music option. 
New options in settings dialog for play/record buffer size, and highlighting after pasting .. 

Color DIBs can be added lo the .WAV file formal. 
Equalizer settings changed lo decibels instead of percentages, making it easier lo equalize, since the 
logarithmic scale is more natural. 
Monitor Source meter is in much better real time since it now does not depend on the selected buffer size. 

Versions 0.5 lo 1.02 
New algorithm implementad for raisingnowering pitches, and speeding up/slowing down waves. 
Preset buttons added lo Stretch dialog. 
H1ghhghting is faster for slower video cards. 
You can use the Shifi+Mouse Button lo extend the highlighted selection. 
Music option was added lo pul your favorite samples lo music (as if you were playing them on a 
keyboard) us1ng a very easy lo use music editor. Only short riffs are supported right now. 
Stretching is cleaner sounding. 
The Transpose function has been added lo the Stretch option lo musically raise or lower pitches of 
selected samples. 
A linked l1st approach has been taken for working with !he temporary disk file when editing. Now lnserts 
and Deletes are almos! instantaneous when working with very large files.(Fixed cuVpaste bu¡¡ from 1.01) 
The RAW file formal was added for saving only !he wave data without any headers. 
Edil keys Delete (Delete Wave Selection), Ctrl+lnsert (lnsert), Shift+lnsert (Copy) and Shifi+Delete 
(Paste) were added. . .. 
Toolbar was added for quicker access to functions. 
The previous Save menu item was changed to Save As, and a new Save was added to save the wave 
currently being worked on without being asked for !he file name. 
The Silence option was added to !he Transform menu to quickly silence the selection portion. 
Extra RIFF information embedded in the .WAV file is now remembered between saves, and can be edited 
using the lnfo dialog. 
MS ADPCM Compression is supported for load1ng and saving compressed files now. 
A slight bug in overlapping was fixed. Overlap past1ng past the end of a wave that used to be longer 
would revive data past !he end of file. 
The Stretch transformation was added to allow stretching and compressing of waves. adjusting pitches. 
or adjusting tempos. 
Viewing mode of the Beg1nning and Ending samples, as well as the time window (which d1splays how 
long the viewed portion of the sample is. or how long the selection is) can be changed between samples 
and time by double clicking on the display. 
Generating silence in 8-bit mode works properly now, centering the silence line at value 128. 
You may now associate the COOL95.EXE program with .WAV files in the file manager. 
Command line loading .works. File will automatJcally play once loaded if another file is not already playing. 
Little Yellow Arrows work on files larger than 30.000,000 samples. 

Gliding waves from one frequency to another "overshot" before. For example, gliding from 12Hz down lo 
7Hz would actually glide down twice !he frequency, (instead of -5Hz, -10Hz) resulting in a glide from 
12Hz down to 2Hz instead. lt's fixed now. 
Multiple COOL's can be opened at once (which reduced !he executable as well) for working with multiple 
waves at once. lt's very easy to copy and paste between waves, even of different formats. 
Also, waveform display 1s instantaneous once loaded in (for example, restoring a m1mmized long 
waveform dJsplays instantly ~nstead of recalculatJng). This allows such effects as the sound level meter 
running while zooming in and out of a waveform. 
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'. 
Displaying long wavefonns now "multitasks" with Windows, so other things can be done while it is loading. 
The progress meter was fixed slightly to allow multitasking with other applications without crashing 
Windows. 
When saving a file, the extension .WAV is assumed if no extension is typed. 
8-bit stereo pasting (with Overlap) works properly now (slight bug caused screeching problems). Also, 
overlap pasting past end of file works properly too. 
A "Musical Source" checkbox was added to the brainwave transfonnation to eliminate cl_icks heard when 
waving musical files. 
A Recording level meter was added. Source input can be monitored through the Opbons menu for 
setting recording levels. 
Lifting up on button alter dragging a selection (and leaving the main window) will now act properly, and 
disengage the selection process 
Recording to Sound Blaster Pro works properly. lt no longer gives errors and chops up recording. In 
fact, usrng COOL to record does a much nicer job !han !he recorder program provided with most sound 
cards, and there are no 'clicks" or other distractions to contend with. 
Using "Large Fonts" on sorne monitors correctly displays main console, as well as progress meter now. 

Thanks go out to: 
Bob Ellison, Doug Coulter, Becky Allen, Sara Allen, Bill Wolford, Staffan Berger, Curtís Palmer. Dan 
Black, Darrell Plan k, David Norris, Duane Young, Geoffrey Tilga: Gordon Currie. Harry C Koons, James 
Blackwell, Jarrad Beckman, Mike Rozak, Neil St. Laurent, Randy Omel, Richard Peprn, Ron McCabe, 
Ronald Mendoza, Stan Eker, Ted Tatman, Todd Frye and Will Urban. 
Other Cool Fans who made suggestions and found bugs here and there. 

Other Acknowledgments 
All formal types have been reproduced from publicly available documentation. Syntrillium Software 
makes no claims. that they are in any way correct,.so they may not be compatible with other ... 
interpretations of the same fonnat. lt is up to you to first test to make su re that when saving audio files in 
a particular formal, the file generated is compatible with other systems that read the same formal. 

What Does the Future Hold? 
We plan to keep on upgrading Cool Edil, making it more easy to use and useful to more people. We 
have definite plans for a retail version and we are sure you'lllike it! Expect multiple track mixing, real time 
effects prevrews, and tons of new coo/ effects and sound generation modules. As always, suggestions 
are welcome. 
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NewWave 

When creating a new wavefonn, you must specify the.wavefonn properties. Using higher sampling rates. 
stereo, or higher bit resolutions will result in higher quality sounds at the expense of requiring more 
memory. 

Sample Rate 
The sample rate describes how many times per second to take a snapshot of the audio. The human ear 
can perceive sounds up to about 17,000 cycles per second, or 17Khz. When choosing a sample rate, 
frequencies of up to 1/2 the sample rate can be produced effectively. Soto reproduce frequencies up to 
1OKhz, a sample rate of at leas! 20Khz must be chosen. Any sample rate may be entered in d1rectly, or a 
common sample rate can be eh osen from the list. 

8,000 Hz 
11,025 Hz 
16,000 Hz 
22.050 Hz 
32,075 Hz 
44,100 Hz 
48,000 Hz 

Channels 

Telephone Quality 
Poor AM Rad1o Quality 
Reasonable compromise between 11 KHz and 22 KHz 
Near FM Radio Quality 
Better than FM Radio Quality (Sorne boards support 32,000 instead} 
CD Quality 
DAT Quality 

Mono waveforms support one channel of audio infonnation. Stereo files take twice the space because 
there are two channels of information representad, a left and a right channel. 

Resolution 
This describes tl}e number of bits to use for each l;ample on each channel. ChoOSifl9 8-b1t resolution will 
provide 256 unique "volumes". The PC-Speaker, for example, provides only 4-bits of resolution because 
it can support 16 unique volume levels. Choosing 16-bit resolution will provide 65,536 unique "volumes", 
for a 96 dB signal-to-noise ratio. Much quieter sounds can be reproduced at 16-bit resolut1on than at 8-bit 
resolution, which only has a 48 dB signal-to-noise ratio. Compact disk players have a 16-bit resolution. 

Note: Certa1n combinations of sample rate, channels, and resolution may not be available on your 
system. To see the maximum capabilities of your system, look at the status window when start1ng the 
program. you may create and edil files that cannot be played on your system, you just may not be able 
to play them properly. 

-· 



New lnstance 
... Or "Give me anolher window" 

Selecting New lnstance will open another Cool Edil window as if you opened anolher instance from the 
Program Manager. This may be handy when you need a secondary window todo some editing in, and 
don't want to disturb the original wave. Mixing between waveforms in different windows is supported, jusi 
use Copy, and Paste to insert or Paste Special to overlap and mix. 

" ( , ·' 



Opening a Waveform As Any Format 

This works jusi like Open except that !he sample formal can be specified befare opening. lf the sample 
formal selected is different !han !he nativa formal of !he wave being opened, then it will be converted, 
using the "quick-and-dirty" conversion method. This means that if the target sample rate is different. the 
conversion will not try lo pre-filter or post-filler the samples. This function works great for opening files as 
different bit rates and number of channels, but for differing sample rates, open !he file normally, then use 
Convert Samole Type --·· ... 

'-

After choosing !he filename, choose !he new sample type. The waveform will be opened, and converted 
as it is opening. 

-· 
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Appending a Waveform 

You can append any wavefonn to the end of the curren! wavefonn. lf the wavefonn being appended is of 
a different type, it will be quickly converted as it is being copied. lt is advised that you only append 
wavefonns of the same sample rate for best results, since no interpolation is done when resampling 
wavefonns of differing sample rates. See .QQlm for more infonnation on the Auto Play and Show lnfo 
options. 

Each wave type supported is embodied in a filler (•.FL T) file. See Wave Fonnats for descriptions of the 
various fonnats. 
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Re-Opening a Waveform 

This will reload the previously loaded wavefonn, replacing any changes that were made to the waveform 
being edited. Be aware you willlose any changes you have made since the last time the wave was 
saved. 

..· 



Saving a Waveform 

Wavefonns can be saved in many formats. Having many fonnat options gives you the chance to save 
!he wavefonn in the smallest amount of space while still retaining a high level of quality. PCM fonnats 
are !he only kind that save !he entire wave completely with no data loss. ADPCM fonnats lose some of 
!he original wavefonn infonnation and !he waves sound a little distorted. Mu-Law and A-Law formats also 
lose some of !he information, but it may no! be as noticeable as ADPCM, but it depends on the type of 
audio that is being saved. 

Some file fonnats support various options that can be modified by pressing Options. 

See Wave Formats for a lis! of supported fonnats. 

) ·-; ., 
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Edit menu 

The file menu displays all the waveform editing options. 

Edit Menu Options: 
Un do 
Repeat Last Command 
~ 
Cut 
Paste 
Paste Special 
Select Entire Wave 
Edit Left 
Edit Right 
Delete Selection 
Tri m 
Display Time Format 
Viewing Range ... 
Adjust Sample Rate ... 
Bvte Swap ... 
Spectral View 1 Waveform View 
Convert Sample Type 

/ l. 



Tri m 

Trim is the exact opposite of delete, which means everything·is deleted except·the portian that is· 
selected. Only the selected portian is kept. This is handy to quickly pick out the part of a recording you 
want to keep. 

Use CTRL + T to quickly trim the selected portian of the wave. 

,. 
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Display Time Format 

Selecting Edil -> Display Time Formal and choosing either Decimal, Frames, or Samples will change 
the formal of !he Begin, End, and Time windows. Doublli-clicking on !he waveform ruler, or !he Begin 
time window will change the formal of !he ruler. 

-· 
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Viewing Range 

Selecting Edit -> Viewing Range or double-clicking on !he greenlblack samples portion bar will bring up 
!he viewing r¡mge window. 

Enter !he leftmost and rightmost samples that you wish to have displayed. Use this function to highlight a 
specific number of samples by double-clicking in !he wave editing area after selecting the viewing range 
to "select all". Remember, Select All only selects !he viewing range, not the entire waveform. 

i.:-:: 



Byte Swapping 

You can change how Cool Edil interprets !he actual waveform data by swapping high and low order bytes 
in 16-bit mode, or by adjusting !he signed/unsigned interpretation of bytes in 8-bit mode. Swapping the 
byte ordering comes in very handy when loading in waveforms of unknown type (raw PCM). You can try 
swapping .the bytes if !he waveform does no! sound corree!. 
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Spectral Viewing 

Choosing Spectral View will display waveforms by the by their frequency components. This is a handy 
function for analyzing your audio data, lo see which frequencies are most prevalen! throughout your data. 

The more abundan! a frequency is, the brighter the color displayed will be. Colors range from dark blue 
(next lo no frequencies in this range exist) to bright yellow (frequencies in this range are very strong). On 
256 or higher color displays, there will be more gradations between the colors. See the Settrngs tapie 
form information on various settings for spectral view. The frequency resolution, window type, colors, 
and energy plot can all be fine tuned. 

Lower frequencies are displayed near the bottom of the display, while higher frequencies are displayed 
near the middle on to the top. The display is linear. White lines on the left and right divrde the display 
rnto 1/2, 1/4, 1/8, and so on. To top of the display represents frequencies at just below the Nyquist 
frequency, or 1/2 the sample rate. So if a bright spot appears near the top of the display for a signal 
sampled at 22 KHz, the frequency being representad is near 11 KHz. 

To gain higher resolution and see more detail in the lower frequencies, use Convert Sample Type to 
downsample the waveform lo a lower sample rate. The higest frequency val u e displayed will be ene hall 
the new sample rate. 

Choose Waveform View to return to origrnal waveform view mode. 

-· -· 
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Convert Sample Type 

This function converts lhe sample type "in place" by directly converting lhe types of the samples in lhe 
temporary file lhat represents lhe curren! waveforrn. Various levels of quality can be chosen, as well as 
general volume levels when converting between mono and stereo forrnats. Higher quality settings take 
longer lo process, bul atlhe highest setting the resultan! waveforrn is identicalto having sampled the 
material at the new rate to begin with. 

High quality settings should be used for greater downsampling ratios. When upsampling, the Low quality 
setting sounds nearly the same as the high quality setting. The difference lies in a larger phase shift in 
the higher frequencies, but since the phase shift is completely linear, it is very difficult to notice. 
Downsampling at even the lowest quality setting will not have any undesired noisy artifacts. lnstead, it 
may just sound a little more muffled because of more high end filtering. 

When converting from Mono to Stereo, you can choose lhe amplification levels for both channels 
independently, with 100% for both channels being the default. You can choose a value of -100% for one 
of the channels to gel an "in verse mono" effect, where the left channel is the in verse of the right. When 
converting trom Stereo to Mono, you can.choose the amplification values for each channel befare they 
are combined. Values of 50% for both channels is the default, meaning that the resultan! mono 
waveform has {l+r)/2 signa!, or the average of the two channeJs, You can even choose a negat1ve value 
for one of the channels to perform a vocal cut effect on some audio. 

When converting from 16-bit resolution to 8-bit, you can optionally add some dither in the aud1o to make 
sounds still audible that are quieter than the limit that 8-bit audio proVIdes-.--To do th1s. a small amount of 
noise is added to the signa!, but quieter audio can be heard in the noise. lf dither is not checked, quiet 
audio will jusi fade in and out, with a more disruptive choppiness sound that resembles rain falling, or 
static. Whethei pr not dithering is used depends 9n the audio being converted, and your preferences. 



Transform menu 

The Transform menu displays all the waveform transformation options. Waveform transforms are 
encapsulated in the .XFM files. 

Transfonn Menu Options: 
Reverse 
Silence 
lnvert 
Music 

The following are embodied in XFM files, and may change at any time. lfthe function you need is not 
listed, go to the function directly and view fts help information 

Quick Filter .. 
Amplify 
Channel Mixer 
Compressor .. 
Delay .. 
Distort .. 
Echo .. 
Echo Chamber .. 
Envelope .. 
Filler .. 
Flange .. 
Noise Reduction .. 
Normalize 
Reverb .. 
Stretch 
Wave 

.. Function not available in Lite version. 



Musical lncantations 

Now you can pul your clippings to music, or jusi harmonize a wave using a particular chord. To choose a 
clipping for your sample, select the range you wish to use as a quarter note. lf no range is selected, the 
clipboard data will be used. Note that the clipboard data will be filled with your sample automatically once 
music is generated, thus selecting music a second time will automatically use your las! sample. 

Thrs function is by no means a complete MIDI authoring studio. 11 is jusi mean! as a quick and srmple 
way to pul a sample to music. The only MIDI support is in the preview playback when the Listen button is 
pressed. 

How to build a song 
Simply drag the notes and rests you desire to the music bar above. To sharpen or flatten a note, drag 
the sharp (#) or flat(b) symbol on top ol the note you wish to transpose. You can move notes up or down 
alter they have been placed. or pick them up to insert in a new position. To remove a note, prck it up and 
drop it off away from the bar. 

Use the scroll bar to work on individual portions ol the song ata time. You can scrott to write a piece as 
long as 256 notes. . 

Tempo 
The te.mpo is given in quarter notes {beats) per minute. Your sample's length is the length ola quarter 
note. 11 your note is longer !han the period determined by the lempo, then the notes will overlap. 

Key 
You may choose to have your music interpreted in any ol the standard key signatures. The key ol C is 
the standard (w_hite keys). 

Constan! Duration 
11 chosen, att notes will be the same length as the original sample, regardless ol pitch. The operation that 
does thrs takes longer to calculate, but hrgh pitched notes will be the same length as lower prtched notes. 
The lnterval Overlap method is used with an overlap ol 80% andan interval ol 30Hz. 11 not·checked, the 
note rs created by directly stretching or compressrng !he orrginal sample, resulting in higher pitches being 
shorter than lower pitches. 

Exact Tune 
Choose Exact Tune to tune your sample so that when played atA {above middle C), the lrequency ol 
your sample rs at 440Hz 11 thrs rs not checked, your sample's original frequency will be played atA 
(above middle C). 

Chords 
The trrplets ol numbers to the rrght is the chord selectron box. You can choose lo make a chord out ol 2, 
3, or 4 notes, then choose the chord lrom the list. Finatty, pick up a chord object {!he 3 notes on top ol 
each other) and drop it on a note above. The note you drop it on will be the starting note ol the chord, 
and the other notes will automatrcatty appear above it in the right ratios. 

Clearing Chords, Sharps, or Flats 
11 you want to clear a sharp. flat, or chord lrom a note, use the laded lookrng quarter-note ob¡ect, and 
drop it on the note you wrsh to bring back to normal 

Saving Your Songs 
11 you make a cool song you want to keep, grve it a name rn the Song Tille box. In the luture, you can 
choose your song lrom the trst ol song triles that you created. The actual song data rs saved in the file 

. .. : 
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SONGS.INI in your Windows directory. 

Listen 
lf you have MI DI play capabilities, you can listen lo a preview of your song before actually creating it. 
Play begins al !he leftmost note visible on !he staff, which means play begins al !he position you are 
scrolled lo, and continuas on lo the end of the song. The music is played through channels 1 and 13 for 
Extended and Base leve! compatibility. The instrument can be chosen by typing its instrument number lo 
the left. You can record music played by the listen preview bullen. Simply hit the record button first, then 
go into the music dialog and press Listen. When the song is done, hit Cancel, and then Stop te stop the 
recorder. 

Pink 
What the heck is this button for? Well, it automatically plays the chosen instrument through the MIDI. 
using pink noise as the source ter randomness. Maybe once out of 1 million tnes, it may actually wrlte a 
cool song? Tempo, Octave, and Key all affect !he play of "pink" m u sic. The only purpose for th1s button 
we have found so far is lo open !he Play Lis! first, then open !he music dialog. While listening te a 
relaxing soundscape from !he play list, you can listen to relaxing random music at the same time.(?) (1) 

-· 



Quick Filter 

The 8-band quick filler allows one to customize lo suit most filtering needs. The •equalizer" works pretty 
much the same as a standard audio equalizer does. Except that the bands are not the same as you 
would expect. The highest frequency band wi/1 increase or decrease the high end, but it will also in crease 
frequencies all the way down to the lowest as well, but it will increase the high frequencies, more than the 
low ones. The effect is close toan equalizer, but not quite. Basically, this is a handy function for 
changing the tone of your sample (such as noise) lo make it more pleasing lo the ears. 

Equalizer Bars . 
Adjusting these increases or decreases the frequency componen! specified beneath the bar. 

Volume Bars 
The final volume after equalizing may be adjusted lo suit your needs. Checking the Lock Vol checkbox 
willlock the left and right scroll bars. 

Flat 
This simply places all equahzation values plus volume adjust at 100% 

Lock lnitiai/Final 
When locked, the entire selected range is equalized with the setting shown. lf unchecked, tne 1nitial and 
final equalization settings may be adjusted, so the selection can smoothly glide from the in1tial 
equalization setting to the final setting over the range selected. 

View lnitial 
When lnitial/Final is not locked, choose this lo select the initial equalization settings. 

.View Final 
When lmtial/Final is not locked, choose this to select the final equalization settings. 

This function supports Presets. 

To produce a semi low-pass filler, set the higher frequency scroll bars lo zero to cut out higher 
frequencies. A high pass filler can be done in the reverse fashion, by zeroing out the lower frequencies. 

Very interesting effects can be made by selecting w1dely vary1ng initial and final equalization settings. 

Note: Setllng the lower bands to very high values can, and most times will, result in chpp1ng if the volume 
adjustment JS not turned down. 

For serious filtering, see Filler. 
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Amplify 

Amplify will in crease or decrease the volume of the selected sample. 

lnitial Amplification 
This is the amplification that will affect the beginning of the selection. Choose a separate final 
amplification for fading up/down effects. An amplification value of 100 will keep the sighal unchanged. 

Final Amplification 
This is the amplification that will affect the ending of the selection. Setting both the initial and final 
amplifications to the same value will amplify the entire selection the same amount. 

Lock Left/Right 
Left and Right channels may be amplified at separate values. lf the Lock is checked, then the scroll bars 
for the left and right channels are locked to the same value. Effects such as panning from left to right can 
be achieved by choosing separate values for the left and right channels. 

Logarithmic Fades 
Also known as Power fades. When checked, the power of the signal fades ata constan! rate. When not 
checked, the sample values fade linearly. As seen on screen, linear fades look like a flat slope, while 
power fades usually look like a hill that starts steep and gets less steep as time goes on (or the opposite 
depending on whether you are fadJng in or out). 

dB Scale 
When checked, amplification values are entered in decibels, otherwise they are entered as a·percent of 
!he original waveform. 

DC Bias Adjusí 
Adjust the waveform so it is centered on the center line (O %). lf samples are recorded with a DC Bias, 
they will appear to be above or below the center line. They must.be centered befare doing other 
waveform transformations, and choosrng this will center the wave properly. To skew the entrre selected 
waveform above the center line, enter the percentage to move the waveform up in the adjustment box. 
For example, 50% will move the entrre waveform up half way, anda -50% will move rt down half way. 

Normalize 
Pressing the Normalize button will calculate the greatest amplification for the sample that will not result in 
clipping when set to 100%. lf the left and right scroll bars are not locked, separate left and right values 
will be computed, potentially amplitying one channel more than the other. To normalize to less than the 
maximum range, enter the percentage of maximum to normalrze to. For example, choosing 50% will 
compute values needed to amplily the file no more than 50% of maximum, resulting in a 3dB attenuation 
from maximum output. lf two sounds normalized to 50% are overlapped, the resultan! wave is 
guaranteed not to exceed the boundarres, and will not clip. AH this button does is recalculate the 
amplification values for you based on how much normahzation is needed. To normalize in ene step, use 
the Normalize function. · 

To achieve a fading in effect. choose an Jnitial amplificatron of O, anda final amplificatron of 100. For fade 
outs, do the opposrte by setting the rnitral to 100 and the final to O. 

Note: Thrs Normalrze button only calcula tes the values needed for the desired normalizatron. lf you are 
recording a scrrpt, only the final values will be remembered. lf you want to add normahzation toa scrrpt, 
use the Normalrze functron rnstead 

Thrs function supports Presets 



Fade In Presel 
lnitial amplificalion is sello zero, and final is sel lo 1 00 for a fading in effect. 

Fade Out Presel 
lnilial amplificalion is sel lo 100, and final is set to zero for a fading out effect. 

Pan L->R, Pan R->L Preset 
lnitial and final values are set so that the sound starts at one channel and pans to the other. 



Channel Mixer 

On stereo waveforms, the channel mixer allows one lo have total control over the left and right channels. 
The default values willleave the wave unchanged. For mono waveforms, !he wave is inverted (that is, 
crests become valleys, and valleys become crests). 

New Left Channel 
The slide bars give the percentage of each channel, left and right, that will go into the final wave after 
mixing. Choosing an L of O, andan R of 100 will make !he left channel equal to the right channel. 

New Right Channel 
These two slide bars do !he same, bu! for !he right channel. 

lnvert 
Choos1ng invert for either channel will invert the channel. Peaks become valleys, and valleys become 
peaks. By inverting both channels, there will be no perceived difference in sound when listened to. But, 
invert1ng only one channel will greatly change !he sound when listened to. 

This function supports Presets. 

Vocal Cut Preset 
This will sum the left channel with the inverse of the right, and place the result into both channels. On 
music where the vocals are heard equally loud on both channels, the vocals will disappear. or come clase 
to disappearing. 

By playing with the combinations, effects of swapping channels, creating a mono sounding wave that is 
equal to the left, right, or a mixture of both channe!s. and creating waves whose left channel is the inverse 
of the nght can be done. - · 
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Function Presets 

Many of the functions have presets available for easily recalling your favorita settings. New presets can 
be added at any time. All preset information is saved in the cool.ini, usually in your Windows directory. 

Double-Ciicking on any preset will instantly set all controls in the dialog box to that preset. 

Whenever you have settings you would like to keep, you may enter name for your settings, and press the 
Add button. Be careful though, since there is no rule against you adding two presets with the same 
name. This can,get confusing if the presets are different. 

To remove a preset from the list, choose the preset, and press Del. 

Te modify an existing preset, double-click en the preset name, make your modifications, then press Del 
immediately followed by Add. This will delete the old preset and add your curren! settmgs in under the 
same name. 

lf all presets are removed, the defautt presets will automatically be reloaded. 

lf you are finding that your presets are not being saved the next time you use the function, check te see 
that the cool.ini file 1S not more than 64K in size. This should never happen, but it may be possible if you 
have hundreds and hundreds of presets. 

lf yo u obtained a new version of Cool Edil, and find that your presets have disappeared or double-clicking 
on them brings up something mysterious and not the settings you wanted, then we apolog1ze. In making 
new vers1ons it is sometimes necessary to change the order of entries in the INI file to make room for 
new items, etc. Just remove all your presets to get the Cool Edil defaults and start from there. Again, 
our apologies ifthis happened to you. .. · 
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Compressor/Expander/Limiter/Noise Gate 

The compressor function varies !he output level based on !he input level. This aUows one to expand or 
compress !he dynamic range of a sample, limit !he dynamic range so aU audio is at roughly the same 
level, or create a noise gate where aU audio below a certain level is clipped to zero. This is all 
accomplished by use of a transfer function !hat is drawn using the graph. The graph depicts input level 
along the x-axis (left and right) and the new output level along the y-axis (up and down). A line from 
lower-left to upper-right (default) leaves the signal unchanged, since every input value goes to lhe exacl 
matching output value. Other weird transfer functions can be drawn as well, for example, boosting all 
input that has a le.vel of around -20dB, and leaving everything else unchanged. Or, drawing an inverse 
line (a line from upper-left to lower-right) will dramaticaUy boost low amplitudes while dramatically 
suppressing high amplitudes, that is, all quiet sounds are loud, and allloud sounds are quiet. 

lnvert 
The invert button will change the graph to one that will functi.on as the exact opposite. For example, if a 
transfer function with a compressor characteristic is being displayed, pressing lnvert wiU change the 
graph to one with the corresponding expander characteristic. For a graph to be invertable, it must have 
points in the two comers (-100,-100 and 0,0) and it must be always increasing in output (i.e. you cannot 
go down in output volume as you go from left to right). AU segments must be sloping upwards from left 
to right. 

Attack Time 
Attack time determines the hme it takes for the new output signa! to reach the proper output volume. 11 
there is suddenly a quiet portian that drops 30dB, it will take this much time befare the output actually 
drops to its corresponding volume level. 11 the sum of Attack and Release times is too short (less than 
about 20 ms total), audible effects can be heard, such as a "vibrating" sound at a frequency of 
1 000/<time>. So if !he Attack and Release times are each se! to 5 ms (making 1 O ms total), then a 

. vibrating sound át 1OOHz can be heard. Thus, a iotal val u e of about 30 ms is abou·t the lowest you can 
go without getting these effects. 

Release Time 
This is the time it takes the end of a previous output level to reach the proper output volume. For 
example, where the Attack is the time it takes the start of a pulse to reach the desired output volume, the 
Release is the time it takes for the end of the pulse to reach the desired level. 

Samples/Group 
The number of audio samples to group together into one volume level change. A value of 1 is the best, 
so each sample gets its own volume change. Larger values will change that many samples together ata 
time. You can go larger without noticeable changes in quality. The only reason for using larger values 
would be for speed. as larger values calculate much !aster. Use larger values for pre-viewing how a 
compressor rs going to sound, then Undo, and use a value of 1 when the compressor is set JUSI the way 
you want it. 

Joint Channels 
In Stereo, each channel can compress independently, sometimes causing !he surrounding background 
noise to get louder on one channel al a time, which may sound strange. For example, a loud drum beat 
in the left channel will make the background norse sound louder in the right than in the left. 11 Joint 
Channels is checked, both channels are used to find a single input dB value, and both channels are 
amplified the same amount, together. For example, a loud drum beat on !he left channel will cause the 
right channel to go quieter as well if compressing. 

Compressors are used for the compression of the dynamic range of an audio signal. lt is generally an 
amplifier wrth two gain levels: !he gain rs unity for input signallevels below a certarn threshold, and less 

..... 
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!han unity for signals with levels above !he threshold. Compressors can be used to eliminate !he 
variations in !he peaks of an electric bass output signal by clamping them to a constan! level, thus 
providing an even solid bass line. To maintain the original character of !he instrument it is necessary to 
use a compressor with a long A/R time compared to !he n~ral decay rate of !he electric bass. 
Compressors can also be useful to compensate for the wide variations in !he signallevel produced by a 
singer who moves frequently, changing !he distance from !he microphone. Limiters are compressors 
with a compression ratio of 10:1 or greater because their output levels are essentially clamped to the 
threshold level. A limiter can be used to clamp all audio toa prescribed output level, or just all audio 
above a certain threshold. 

Expanders are used to expand lhe dynamic range of an audio signal, opposite of the compressor. lt can 
also be considerad an amplifier with two ga1n levels: the gain is unity for input signal levels above a 
certain threshold, and less than unity for signals with levels below the threshold. The expander is used to 
expand the dynamic range of an audio signal by boosting the high-level signals and attenuating the 
low-level signals. 

Noise Gates are a special type of expander that can be used to reduce noise below a threshold level. 1t 
attenuates heavily signals with levels below the threshold. lt is used to totally cut off the signal level 
during a musical pause ,so as not to pass the background noise present. lt can also be u sed to silence 
the pauses in speech. 

RMS m.ode 
This is a new graph interpretation method that more closely matches the way people hear volume This 
will cause the output to be exactly the RMS amplitude specified in the graph. For example, a limiter (flat 
horizontall!ne) at -10dB will cause the RMS amplitude of the result to average -10dB (where OdB is a 
maximum amplitude sine wave without clipping). 

Peak mode -
Th1s is the method that has been used 1n prev1ous versions of Cool Edil. This method is a little more 
difficult to use, but it equates to the RMS value times two. That is, if the RMS value was -20dB, then the 
equivalen! peak value would be -40dB. This occurs because the RMS value calculated was mapped toa 
peak sample value for outpul This method 1s basically here for backward compatibility with previous 
vers1ons of Cool Edil. 

J ~ o 
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Digital Delay 

Delay either channel up to 50 milliseconds with the option to mix in the original signa! wnh the delayed 
signal. Great for effects such as spatially locating a previously mono wave source to the left or lo the 
right, so that the sound will appear to emanate from that direction when listened lo with stereo 
headphones. Delays of longer than 50 ms may be entered for creating a single echo. 

Delay (ms) 
The actual amount of time to delay the channel in question. 

Mixing 
You may choose to have the resultan! wave the delayed signal, keep it the original signal, or mix the two. 
A value of 50 will mix the two evenly. 

lnvert 
The delayed signal may be an inverse of the original if this is checked. More spec1al effects! 

This function supports Presets. 

Tunnel Preset 
The Tunnel preset can be used with mono as well as slereo waveforms. The settings provided g1ve a 
nice lunnelltubular effect. 

Spatial Left Preset 
lf a mono wave source was converted lo stereo (so lhal lhe left and right channels are lhe saine), lhen 
choosing lhis will make lhe sound appear as if il is coming from the left, since the right channel is delayed 
jusi enough so your brain inlerprels lhe sound as coming from the left. You musl use headphones lo 
hear the effect. ' ·· · 

Spatial Right Preset 
The same as Spalial Left, bul il locales lhe sound lo appear as if il is coming from the right. 

.> / 
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Distortion 

Use this function to map any sample value to any new sample value. Effects such as blown car speaker, 
muffled microphone, overdriven amp, cranked car stereo and many more can be created. 

The horizontal axis represents the input sample value in dB, while the vertical axis represents lhe output 
sample value in dB. 

Have fun making your audio sound really really BAO! (Of course. it's great for adding fuzz to guitar licks 
to gel that heavy metal sound). 
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Echo ... echo ... o ... 

This function creates continuous echoing and reverb effects. Each successive echo decays in amplitude 
by !he falloff ratio. To create !he effect of a single echo, use !he Delay f1Jnction instead. · 

Falloff Ratio 
Each successive echo will be a certain percentage less !han the previous one. Choosing a falloff ratio of 
zero would result in no echo al all, while choosing a ratio of 100 would produce an echo which never gets 
quieter. 

Delay 
This is the number of milliseconds to place between each echo. A delay of 100 milliseconds is equivalen! 
toa 1/1 Oth of a second pause between echoes. Choosing very small values of delay produces quite 
interesting effects. 

lnitial echo volume 
This is the volume at which the echoes will be mixed with the· original sample. Choosing smaller 
percentages (30% or so) is nice if the effects of the echoing at 1 00% make the sound incomprehensible. 

Continue beyond selection 
Choosing to continue beyond selection will echo the highlighted selection over the rest of the 
unhighlighted area, stopping at the right-hand edge of the wave that can be seen in the window. lf the 
window is zoomed in, the echoing will stop befare the end of the file, since it will stop at the right hand 
side of the portian on screen. By using this option a single word, for example, can be highlighted and 
echoed over other audio, without echoing the other audio as well. 

Echo Left to Ri1,1ht . . 
Select1ng this option will make the echoes travel back and forth between the left and right channels. 

lf yo u wish to echo the right channel only, select an initial echo vol u me of 100% for the right, and O% for 
the left. 

Equalizer 
The echo "quick filter" lets you choose approximately which frequencies get removed from the echo 
frrst. A setting of zero willleave the frequency band unchanged. You can choose the frequencies that 
are "absorbed" as the echo progresses. The echoed sample is re-filtered through the quick filter on each 
successive echo. Setting all values to zero turns off the equalization, since no frequencies are to be 
absorbed. 

Th1s function supports Presets. 
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30 Echo Chamber 

This tunction will calculate the actual echoes as if the source audio (highlighted selection) and 
microphones (destination channels for echoed wave) were in a room of any given size and with walls of 
any given dampening factors. The number of echoes to calculate is adjustable, up to about 25,000 
echoes. The more echoes there are to calculate, the longer it will take the function to complete. 
Practically any "ambiance" setting can be created using this function. 

One great use for this function is to convert Mono audio lo Stereo with all the right ambiance. Choosing a 
"left" microphon~ that is one to two feet away from the "right" microphone will simulate the ears of a 
listener, and will give the effect of "being there" when listened to with stereo headphones. Be sure to 
copy the mono audio into a stereo formal before performing the echo so you can choose two separate 
microphone locations. A spatial stereo expansion effect can be created by placing the two microphone 
locatrons lar apart, further apart in the settings than you will be playing them through speakers rn real lile. 
For example, if your stereo speakers are 6 feet apart, try placing the left and right microphones 20 or 30 
feet apart in the settings. 

To give more control over the environment, dampening factors can be applied to any of the 4 walls, floor, 
and ceiling. 11 a wall has a dampening factor of 1.0, it is totally reflective (like cement). 11 a wall has a 
very low dampening factor, like 0.05, it will absorb most of the sound (like carpeting or sound proofing 
panels). You can also lower the dampening factor of sorne of the walls to simulate the fact that other 
objects in the room are absorbing sorne of the audio. 

Always place the microphone(s) sufficiently lar from the source. lf the microphone and source are too 
close together, you will jusi hear the source and no echoes since it is analogous to placing your ear right 
next to the sound source where you hear the sound only (which is very loud) and nothing else. 

Room Size 
The length, width, and height of the room can be entered in units of feet (sonry, no metrics this time ... 
There are approximately 0.3 meters per foot for those who need to convert). When entering source and 
microphone locations, they must lie between zero and the room's width for the "Distance from Left" 
parameter. and zero and length for the "Distance from Back" parameter. Room sizes can be as large as 
memory will allow. 

lntensity 
The volume of the echoes is determined by the volume of the first (direct) audio. The drrect sound that 
reaches the microphone from the source will be at the same amplitude as the original audio being 
echoed. Thus. in a room of any size. if all 6 dampening factors are set to zero, there will be no change 
when echoing. Every echo adds to the amplitude of the finished audio, so the intensity should be set to 
less than 100%. In fact, the more echoes there are, the lower this value should be set to preven! 
clrpping. In general, use about 30% for 100 echoes, 5% for 1000 echoes, etc. 

Echo es 
This rs the number of actual echoes to produce. To gel a nice reverb and ambiance effect, at least 300 
echoes should be generated. The more echoes that are generated, the tnuer the result will sound. You 
must sacrifice the quality you desire with the time you are willrng to wait for the final product. Generate 
about 1 00 echoes or so to test the chamber size and general room sound, then increase that dramatrcally 
for the final productron. Up to 25.000 echoes can be generated, perhaps even more dependrng on the 
srze of the room and size of memory. 

Damping Factors 
Use the damprng factors to set the type of room rn which the audio rs being played. The factors can 
simulate wall coverings, floor coverings, and other objects in the room that absorb sound. Granted, in 



real lite, various objects absorb different frequencies of audio. In lhis simulation; all frequencies are 
reflectad equally. The effects of speaker placement enhancing or canceling certaln frequencies, lhough, 
is still accurate. The fact that cement reflects high frequencies better !han low ones is not accounted for. 
but great effects can still be achieved, and these effects are much more realistic !han the basic Echo 
tunction. A damping factor of 1.0 is the greatest, simulating total reflectivity. A factor of 0.0 is the lowest, 
for total sound absorption by the reflecting surface. 

Source Signal Placement 
The source (highlighted audio befare running this function) can be placad anywhere in the room. The 
audio is simulated as a point source of audio, not directional. This means the audio will radiata outwards 
in all directions fr.om the source, and not more in one direction than another. The distance the source is 
placed to any of the walls will affect the frequencies that are enhanced. In other words, source signa! 
placement is crucial to the ambiance effect that is gained with this function. With stereo source, each 
channel can be placed independent of each other. 

Microphone Placement 
There can be up to two virtual microphones. Each microphone represents a destination audio track. The 
audio placed back into the wavefomn (the result of the echoing) is exactly what the microphone would 
hear if it were in the room at the location specified. Stereo signals have two pick up microphones while 
mono signals have only one, since thére is only one channel in which to place the result. Placing the 
microphones in a stereo setting one foot apart will simulate the ears, and when listened to with stereo 
headphones, will sound as if you were actually in the room (if enough echoes are generated). The brain 
will be able to pick out the directions of each echo, as well as the fact that the delays of the echoes will · 
g1ve the brain cues asto the size of !he room. Placing the microphones very lar apart and listening with 
headphones will give a very large "aural" or "Spacy" feeling to the audio, like it is all around you and 
inside you. Don't place the microphones too close to the source, otherwise the relativa volume of the 
echoes will be so low that they will not be able to be heard. 

Mix Left and Right into Single Source 
When working with stereo audio, there are actually two source signals, one for each channel that can be 
placed independently. This takes twice as many calculations as a single audio source, so this option 
allows you to mix the left and right into a single point source for !aster calculations. 

Experiment with various settings to get the reverb you desire. Some presets are available, bu! a big part 
depends on the type of source audio that is being echoed. 
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Envelope 

By using an envelope, you have great control over which parts of your wave are amplified, and by how 
much. A point at the top of the graph is 100% (normal) arilplification, and at the bottom is no amplification 
(silence). This function is handy when modifying Tones generated with this program to create more 
realistic sounding instruments and effects. 

Amplification 
Adjust this value to amplify more than 100%. This value changes the values representad by the graph. 

Click in the graph area to add control points. You can drag control points up and down. Drag a control 
point off the graph area to remove it. 

This function supports Presets. 

Note: This function relies on the AMPLIFY.XFM module for doing the actual amplification. 

'· 
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FFT Filtering 

You may filler out undesired frequencies, or jusi keep certain desired frequencies by using the Passive 
mode. 

Use the Logarithmic mode lo boost or dampen frequency components. 

When the Lock is no! se!, you can choose bolh an lnitial and a Final filler. Filtering will gradually go 
from the initial state lo !he final depending on !he Transition settings. 

Graph Values in dB or percentage (depending on logarithmic or passive mode) can be entered lo !he 
right of the graph. These values are independent of the shape of !he graph, which means that loading a 
preset wi/1 not change these two values. 

The Precision Factor determines how accurate you want the filtering over time when separate initial and 
final settings are used. A low factor, means the filler settings will change roughly, or in chunks, from the 
initial to the final settings. With higher factors, the filter's transitions are much smoother. In any case, the 
higher the precision factor, the longer it will take to filler your selection, but !he nicer it may sound. The 
FFT (Fast Fourier Transform) function takes a large group of samples, and filters them all at once. The 
prec1sion factor determines how many samples from the entire group are actually saved in the final 
product. A factor of two means that half the samples are saved back. A factor of 1 O means that 1/1 O of 
the sam"ples are saved back. S1nce there can be only one filter set11ng for the entire group of samples, 
you will want smaller groups of samples if the settings are varying widely over short periods ol t1me. 

The Points parameter specifies the size ol the FFT to use. For cleaner sounding filters, use higher 
values. The maximum value currently 1s 8192, and the value must be a power ol two. Recommend 
values are 1024, 2048,4096, and 8192. 

Windowing Function 
This is the wmdowing method used when filtering. Different windowing methods give different frequency 
responses. The Hamming and Blackman windows give great overall results. The window1ng method 
determines the amount ol trans1tion width and ripple cancellation, and are in arder lrom smallest width 
and greatest ripples to widest width and least ripples. The filters with the least ripples are also those that 
more precisely lollow the drawn graph, and have the steepest slopes, even though they are wider, and 
pass more lrequencies in a band-pass operation. Try different Windows il you are not gettmg the effect 
you desire. 

11 Morph is checked. the trans1t1on lrom the 1nit1al filter sett1ngs to the final filler settings will actually 
"morph" lrom one to the other 11 th1s is not checked, the settings simply change linearly over time, which 
means il you have a spike at 10K lar the init1al filler, anda spike at 1K lor the final filler, the spike at 10K 
will gradually decrease, and the sp1ke al 1 K will gradually 1ncrease over t1me. 11 morphing is on, then the 
spike will "ooze" from 1 OK down lo 1 K. passing many of the trequenc1es in between. 

Really nice effects can be heard by simply choosing the Passive mode, and having an initial setting with 
first hall ol the filler at 1 00%, and the second hall al zero lor the initial filler, and the right 1/1 Oth or so at 
100% with the rest at zero lor lhe final filler. This selects high frequencies lor the initial configuraban, and 
low lrequencies lor the final configuration. To get a nice blending from high to low, choose morph to 
blend the two together by includ1ng all lhe lrequency comb1nat1ons between the two filters. To see 
exactly what is happemng as the filtering changes lrom the imtial configuration to the final. choose 
Transition to view the actual sett1ngs that will be used over the durat1on ol your selection. 

The noise leve! ol the filler 1s lower lhan thal ol 16-bit samples, so there should effectively be no extra 
noise 1nduced by using th1s filler depend1ng on lhe Window be1ng used. A Blackman window. lor 
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example, will have the stop band noise below lhe -96dB mark. 

This function supports Presets. 

For besl resulls, filler using 16-blt samples. lf your so urce ls 8-bll, Cool Edil wlll aulomallcally 
convert lo 16-bll lo do lhe flllering, and convert back lo 8-bll. But lf you are doing multiple edits, 
you should use Edlt->Convert Sample Type to convert to the 16-bit formal. You can convert back 
lo B·bit when you are all done processing. 

--
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Flanger 

What is flanging you ask? Jusi try it out and see! The term is coined from !he flanging mechanism on the 
old style tape recorders which, when fiddled wilh, would slow down !he playing of !he tape, and speed it 
back up again when desired. That is how lhey gol !hose funky psychedelic sounding recordings in !he 
60's. Here's how you can do it today. 

Original - Delayed slide 
This slide decides al what proportions lo mix the original and flanged signa!. lf !he Original is at 100%, no 
fianging is heard. lf !he Delayed is at 100%, a cute wavering (like abad tape player) sound is heard. 
Portions of both signals need lo be present for there lo be canceling out, and reinforcing of wave patterns 
between !he two signals. 

lnitial Delay 
Flanging will start with the delayed signa! this many milliseconds behind !he original. 

Final Delay 
Flanging will end with the delayed signa! this many milliseconds behind !he original. lf the delays are the 
same, !he effect disappears, since !he delayed signa! will not change. 

Stereo Phasing 
The right channel can be ata separate delay !han the left channel. A phasing of 180 will pul the nght 
channel at the initial delay value when the left channel is at the final delay value, and vica versa. 

Rate settings 
The Frequency, Period, and Cycles settings are all interrelated, and refer to !he rate at which the delay 
cycles between the initial delay and the final del ay_. The fianging will cycle frequency times per second, or 
period seconds per complete cycle, ora total of cycles complete cycles over !he entire selection. Various 
effects can be heard by using different settings. For example, if 0.5 cycles is chosen, !he selection wiÍI 
start with the initial delay, and end with the final delay. lf a frequency of 4 is chosen, the fianging will 
cycle trom the initial delay to the final delay and back again 4 times per second. 

lnvert 
lnvert the delayed signa! when fianging, which causes the waves lo cancel out periodically, instead of 
reinforcing. lf the m1xing is at 50150 then whenever the delay is at zero, !he waves will cancel out to 
silence. 

Special EFX 
A m1xture of both normal and inverted flanging, with the delayed signa! summed, and a future s1gnal 
subtracted out. So th1s option will mix not only a delayed signa!, but a future one as well. 

Sinusoidal 
lf checked, the transition from initial delay to final delay and back will follow a sine curve. Otherwise, the 
transition is linear, and delays from the initial setting to the final setting ata constan! rate. With sinusoidal 
checked. !he signa! is at the initial and final delays more often !han it is al delay in-between. 

By trying different combinations of lnvert, Special EFX, and Sinusoidal, you should be able lo create jusi 
the effect you want. These three opt1ons give a lot of control over the flang1ng effect, so experiment with 
them alll 

This function supports Presets. 
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Noise Reduction 

Background noise and general bread band noise can be dramalically reduced wilh minimal reduction in 
signal quality. The amounl of noise reduction depends upon the type of background noise, and the 
allowable loss in lhe quality of the signal lhal is lo be kept. In general, increases in Signal lo Noise ralios 
of 5dB lo 20dB can be achieved (noise is reduced 21dB and signal1dB for example). 

Two sleps are required lo remove noise. Firsl, the noise level musl be sel so lhe filler knows what type 
of "noise" to remove. Todo lhis, highlight a section of the waveform lhat has no importan! signal in it, and 
only has background noise, then press Set Noise Level. The statistical information about the 
background noise is then gathered, and you are set to remove all noise of lhis type from your waveform. 

Once the statistical data is gathered, the second step is to highlight !he section you want to remove the 
no1se from, and choose the level of reduction you desire. A level of zero will remove !he least amount of 
noise, and nearly no signalloss will occur. Typically the noise will be reduced about 3dB at this level. A 
level of 100 will remove the maximum amount of noise, lowering !he noise level by about 20dB. lf the 
s1gnal you are trying to keep gets too distorted at this level, use lower values until a balance is reached 
between noise reduction and allowable signal distortion. Values any higher !han 100 will guarantee loss 
of the signal that you want to retain, but this may be desired if reducing noise is more importan! than 
retaining original signal. 

Distortion effects may manifest themselves a "hollow" or "underwater/burbley" sounding s1gnal. dull 
sounding impacts, "rolly" high end, ora "computerish" mechanical sound. These effects, if heard at all, 
will fall off if the noise reduction level is reduced. The amount and type distortion depends on the type of 
noise that is being filtered. 

Besides reducing the noise level, !he type of noise that is present after reduction is.entirely different !han •· 
the type of no1se beforehand. For example, if you are trying to get rid some "tape hiss" from a waveform, 
the tape hiss sound will completely disappear, and in its place about 15dB quieter will be completely 
d1fferent type of noise. This noise will contam all frequencies in different combinations. thus it cannot be 
reduced much further without noticeable signalloss. The new noise has a "burbley" or "bubbly" quality to 
it, and if amplified, sounds very harmonic-like !hose 1960's computers in old science fiction films. Since 
th1s is so much quieter than the onginal noise though, it JS very acceptable. 

Great effects can be generated by setting the noise level to sorne valid signal componen! in the 
waveform. and not the background noise. Whatever frequencies are present in the highlighted selection 
when Set Noise Level is chosen will be removed when the reduction level is set to 1 OO. 

Use this function to remove tape hiss, microphone background no1se, 60 cycle hum, or any noise that is 
constan! throughout the duration of your waveform. You can even reduce !he noise incurred by the 
sound board's circuitry during recordJng--just record a second of silence befare whatever you want to 
record and tell !he noise reducer to remove !he sound of that silence for another 1 OdB dynam1c range. 

Save Profile 
Once the noise level is set, you can save the noise profile in a • .fft file. This file will contain 1nformation 
on sample type, FFT size, and three sets of FFT coefficJents, one for !he lowest amount of noise found, 
one for the highest amount, and one for the power average. 

Load Profile 
Loads any previously saved noise profile. You can load any *.fft file that Cool Edil has saved. Eventually 
the spectrum analyzer and Filler functions will support *.fft files. A noise profile is only compatible if it is 
be1ng used on a sample of the same type when the profile was saved. In other words, a 44K stereo 8-bit · 
sample is not compatible with a 22KHz mono 16-bit profile. Also, since noise profiles are so specific to 
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the recording environment of waveforrn in question, even lf the sample types are compatible, a profile for 
one type of noise will not work on another type. E ven lf the audio samples were recorded with the same 
microphone, lf the recording environment is different, the type of background noise could be different. 

FFT and STATISTICAL SAMPLING settings 
These settings will affect the noise reduction quality, and lhe type of distortion heard when reducing the 
noise. Try different settings lo gel the best noise reduction while keeping the intended signal in tact. The 
FFT Size parameter causes the most drastic changes in quality. Good settings for the size range from 
4096 te 12000. The FFT Precision Factor affects distortions in amplitude. With values of 3 or less, the 
FFT is performed in giant blocks that are not very continuous between the blocks. This means after each 
block is processed, there can be a drop or spike in volume at the intervai between blocks. Values of 5 
and up work best. On past about 1 O, there is no noticeable change in quality - just the time it takes te 
compute. We suggest using 5 or 7 (odd numbers are best for symmetric properties). The Number of 
Samples can be chosen for the gathering of statistical data. This number describes how many 
snapshots of noise to take in the highlighted interval when Set Noise Level is pressed. The larger this 
number, the more accurate the statistical data is. A value of 64 is plenty. You will notice that using very· 
small numbers of statistical samples will greatly affect the quality of the various noise reduction levels. 
With more samples, a noise reduction level of 100 will most likely cut out more noise, but also cut out 
more original srgnal too .. But, with more samples, a low noise reduction level will also cut out more noise, 
but most likely not disrupt the intended signal. lf the selection used for learning the noise level is too 
small, then the Set Noise Level button will not activate. 1t is possible te make a larger section of norse by 
using Copy and Paste for reasonable results with very short noise samplings. 

Special Notes . 
Neis e reduction works best en 16-bit samples, although it will work perfectly en 8-bit samples. Beca use 
of the nature of 8-bit audro, it is impossible te get the noise level lo less than about -45dB if even that. 
Noise at -45dB is very audible, as owners of 8-bit sound cards can attest. Converting te 16-bit first, then 
reducing the noise will produce a sample with much less norse !han can be done in 8-bit alone. 

The noise reduction works best if the original signal is centered. Te center a signal, highlight it and 
choose "Center Wave" from the Amplify function. Centerrng ttie wave adjusts the DC offset te zero. lf 
the wave is not centered, audible clicking may be heard in really quiet situations. Since centerrng takes 
out all frequencies below about 16Hz. it is completely sale te do without any ill side effects. 
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Normalize 

Normaliza will amplify lhe highlighled seleclion so il is th.e desired percentage of maximum. Optionally, a 
DC Bias can be set. Setting a DC Bias lo zero will ensure thal the waveform is cenlered on the zero 
vollage line. 

Use lhis normaliza funclion if you are recording a script in which you wanl lo normaliza a wavaform lo a 
specific parcenlage of maximum. Afiar normalizing toa spacifiad level, pressing lhe F3 key will 
automatically run Normaliza again on anolher waveform for vary fasl normalizalion of waves. 
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Reverb 

This function creates high quality reverberation effects. Use this function when you are looking lo 
reproduce !he effects of a certain environment - everything from your coat closet to a grand 
amphitheatre. Unlike echo, which generales specific echoes al specific times, the reverb function creates 
a very much spread out, random phase trailing of !he original audio and no specific echoes can be heard 
at any particular time. The effect is very warm and natural. To simulate specific rooms that have echoes 
and reverb, use the Echo function first lo gel the 'size' of !he room sound, then use Reverb to make it 
sound more natural. This function is ideal for converting Mono audio lo sound as if it is Stereo. 
Converting a Mono sample lo stereo where both !he left and right channels are identical should be used 
as the source, then by adding some reverb, even as little as 300ms, will open up the sound so it is 
perceived of as being in true stereo. 

Total Reverb Length 
This is the totallength of the reverberation. The signal will trail off and finally cut out al about -96dB afler 
this amount of time. Values below 400 produce a small room environment. Values between 400 and 800 
simulate medium sized rooms, and values above 800 simulate concert hails up lo giant amphitheatres at 
delays around 3000 ms. 

Attack Time 
The amount of time it takes for the reverb to gain full strength is known as the attack time. For smaller 
reverb lengths, the attack time should be smaller. In general, a val u e of about 10% the total reverb length 
works well. But interesting effects can be gained by using longer attack times with shorter reverb lengths 
for very subtle reverb. Or, very short attack times can be coupled with long reverb lengths fnr other 
special effects. 

High Frequency Absorption Time " _, 
In natural environments, higher frequencies are attenuated more than lower frequencies. Usrng this . 
parameter, the exact time it takes for the highest frequencies to be completely cut out can be chosen. 
Faster Absorption times simulate rooms that are occupied and have fumiture and carpeting like night 
clubs or theatres. Slower times (especially over 1000ms) simulate more empty rooms, like gymnasrums 
and empty auditoriums, where higher frequency reflectrons can be heard. 

Perception 1 Timbre 
This is another parameter to help grve subtle qualities to the environment making it sound more realistic. 
lt can be thought of as changing the wrdth of the room and adjusting other room irregularities. With lower 
values. the reverb is smoother without as many disllnct 'echoes'. Higher val u es cause more vana !ion in 
the reverb amplitudes and add more spaciousness to the reverb by creating distinct reflections over time. 
In general, hrgher values (up lo 60%) can be used for simulating large rooms, and lower values (down to 
0%) for small rooms. But these are only suggestions. lnteresllng canyon effects can be created by 
setting this value to 100, and using a total reverb length of 2000 or more. 

Mixing -Original Signal 
This is the amount to mrx the original signal into the final resuit. lf you are trying to achieve some specral 
effects with reverb, you may want to reduce the volume of the original signal. Or, if the reverb is so great 
that audio begins to clip, reduce both the original signal and the reverb mixing strength. In general, the 
more reverb you add, the lower the ongrnal signal volume should be. In most cases, a value of 90% or 
so should be fine. 

Mixing - Reverb 
This is the amount to mix the reverberated srgnal into the final result. A value of 100% rs most hatural, 
but yo u m ay wish to decrease this for a reverb that exists more in the background, or increase to simulate 
being lar away from the audio source where only the reverb can be heard in greater strength than the 



original audio. 

Combinel&R 
In general, this should be checked for more realistic reverb, and faster calculation times. When checked, 
the lefl and right channels in a stereo source are combinad befare reverb is performed. This should 
especially be checked if you know that both channels are identical, otherwise ~ is jusi a waste of 
computar time. When Combine L&R is not checked, separata stereo reverb is calculaled for each 
channel individually. The original signa! will remain in the respective channels, but the reverb will carry 
through lo both channels equally. With stereo audio where there is different information ín the lefl and 

_ right channels, this box should not be checked. The stereo audio will be dramatically enhanced by the 
reverb, and sound fuller and more rich in most instances. Also, when this box is not checked. 
calculations take exactly twice as long lo compute, since separate reverb is being calculated for the left 
and right channels befare being recombined lo the final stereo output. 

We have built a few presets to gel you started. Bu! for bes! results, experiment with the different 
parameters and you'll find just the reverb you are looking for. The "Large Occupied Hall" gives a very 
nice live theatre atmosphere. The "Concert Hall Lighl" setting gives a nice professional performance 
reverb, enhancmg a non-reverberated vocal singing track quite nicely. 

Th1s function supports Presets. 
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Stretch 

You can choose !he initial stretching percent (less !han 100% will compress !he wave), and the final 
stretching percent. By having two separate values for start and end, !he wave can be stretched linearly 
from one ratio to another. This gives !he effect of slowing down and speeding up, or raising and lowering 
pitch. 

Preserve Pitch 
Lower percentages will slow down !he lempo, while higher ones will increase the lempo. The pitch 
remains the same throughout. 

Preserve Tempo 
The lempo or speed of play will remain the same. The only thing affected will be !he pitch. Higher 
percentages will lower the pitch, and lower percentages will increase the pitch. Try using diffenng initial 
and final percentages te raise and lower the pitch.without affecting !he lempo. First the select1on is 
adjusted, preserving the pitch, then the selection is squeezed or expanded, with no preservation. 

Preserve None 
The lempo will slow, while at !he same time the pitch will lower if percentages above 100 are u sed. For 
lower percentages, !he tempo will speed up and the pitch will increase. 

Ratio, Length 
The desired Ratio or final Length can be enterad. Entering one automatically changas the other. lf the 
initial and final lengths are different, then the actual finallength will be exactly ( initial + final ) ~ 2 when in 
Preserve Pitch mode. 

· Transpose -· 
When the number of desired keys up or down are chosen, !he numerical values for transpos1ng mus1cally 
are enterad into !he stretch shders. For example, to make your sound as if it were the next key higher (if 
played on a keyboard, and black keys included) choose 1# for 1 sharp. The 'b' values will flatten or lower 
your sound. 

lnterval Overlap 
When preserving pitch or lempo, the waveform must be elongated or truncated smoothly and preserve as 
much of the original information without adding noticeable distortion. This is ene of two methods that can 
be used te achieve this. The amount of distortion introduced is not dependen! on the type of sample (e.g. 
music or speech). When stretching or compressing, the appropriate chunk from the original wave is 
output to the transformad wave, and overlapped with the previously transformad chunk. · 

The interval rate determ1nes the size of a 'chunk' of audio data. lnterval rates will become an audible 
hollow sound when large rates (above 50Hz) are used. lf the rate is too low, echoing will be very 
noticeable when raising pitch, or slowing down tempo, or chopped syllables will be noticeable when 
lowenng pitch, or speeding up lempo. Values of 20Hz te 40Hz_ usually produce good results. 

The overlapping determines how much of the previous chunk is overlapped with the curren! chunk. The 
overlapping can produce a chorus effect. To reduce !he chorus effect, lower the overlapping 
percentage. When the overlapping is reduced, a choppiness to the sound may appear. AdJuSt the 
overlapping to your laste to strike a balance between choppiness and chorusing. Overlapping can be as 
h1gh as about 400%, but only use this for really high speed increases (like 200% or more). 

Fractionallnterval Overlap 
This second method of preserving pitch or lempo uses a more straightf01ward algorithm which 
guarantees the tim1ng to be as clase as the _interval rate allows. This usually causes more of a 
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reverb/echo effect with !he audio, but in cases where stretching is being done at rates lower !han 60 
percent, or higher !han 175 percent, this method can produce more desirable results .. 

The interval rate determines !he size of !he chunk of audio data in !he final stretched wave. ·rt there are 
any artifacts, they will be heard al this frequency. For example, an interval rate of 60Hz will cause a 
60Hz distortion artifact. Values of 15 down to 7 or so seem lo work best. The higher the value, the more 
precise the placement of stretched audio over time, but also !he artifacts are more noticeable as rates go 
u p. 

The overlapping determines how much the curren! chunk overtaps with the previous and next chunks. 
The maximum overtapping allowed can be as great as 1000%, in which up to 1 O sections of the wave are 
overlapped together. 

lf using either of the lnterval Overtap methods, you can improve the quality of the stretched audio of 
mono tonal (pure tone) samples by choosing an lnterval Rate that is evenly divisible into the frequency of 
the sample. Use the Frequency Analysis window lo find the sample's base frequency, then divide by an 
integer to get the lnterval Rate. For example, if the tone was reported to be 438Hz, dividing by 20 g1ves 
21.9Hz, so using 21.9Hz for the lnterval Rate will greatly improve the quality by reducing the phasing 
artifacts. For very non-tonal or noisy samples, the lnterval Rate does not matter as much. 

Zero Splicing 
This is the th1rd method of preserving prtch or lempo. Less distortion is noticed when using samples that 
were derived from one source, and contain a relatively low number of fundamental frequencies. For 
example, a single instrument, or speech will work OK, while an orchestra or music will not work as well. 
When stretching or compressing, the wave is broken up into chunks that begin and end when the 
waveform crosses zero, or the midpoint. Chunks are repeated, or thrown out depending on the 
compression ratio and the cutoff frequency. Chunks smaller than the cutoff frequency will not be thrown 
out or repeated. -Try cutoff frequencies between 50Hz and 300Hz for best results usmg th1s method. 

This function supports Presets. 

Raise Pitch Preset 
Th1s will adjust the settings so that the pitch of the sample will be raised by 1/4 octave. 

Lower Pitch Preset 
This will adjust the settings so that the pitch will be lowered by 1/4 octave. 

Speed Up Preset 
This will speed up the sample, so talkmg will be faster, but the pitch will be unaffected. 

Slow Down Preset 
Slows down the sample. 

Note: An alternativa method of stretching while preserving pitch or lempo is lo do an FFT, and modify the 
amplitudes and phases of each frequency in the frequency domain, and then do the inverse FFT to 
translate back. This methOd would be very complex, and be very very much slower than the methods 
currently being used. lf you want to experiment sorne, try the li Shift option in the Filler function does this 
1n a very crude way, by just shifting the frequencies up without regard to their phase. 
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Wave (Brainwave Synchronizer) 

Audio may be Waved to produce files, that when listened to with stereo headphones, will pul the listener 
into any desired state of awareness. For example, by listening lo waved files, you can easily achieve 
states such as deep sleep, theta meditation, or alpha relaxation. Because of !he nature of this function, it 
only works on Stereo waveform data, and lo be effective, mus! be listened to with stereo headphones. 
The Wave function spatially locales the audio left and right, in a circular pattem over time. In order to 
spatially encode the signa!, either the left or right channel is delayed so that the sounds wiu·appear al 
each ear al different times, tricking the brain into thinking they are coming from either side. When th1s is 
done al frequencies of 3Hz and above, the brain will start synchronizing al the same frequency, 
increasing its output of Delta, Theta, Alpha, or Beta frequencies. 

LOW SETTINGS 
These sett1ngs all correspond lo the lower part of the graph. lf points are dragged to near the bottom of 
the graph, these settings will be active. 

HIGH SETTINGS 
And these settings correspond to points near the top of the graph. 

Frequency Graph 
Time is represented along the horizontal, so as you go to !he right of the graph, you are setllng the 
frequency characteristics of the highlighted sample later and later in time. The settings chosen will vary · 
between the low settings and high settings depending on where the graph dictates the signals should be. 

Click on the graph to add new control points. Draga control point up or down, or off the screen to 
remove. Choose the highest and lowest frequencies that are representad on the graph with the scroll 
bars. Gliding ab0ut 4 to 5 Hz over 2 mnutes worils nicely. lf large variations are done in short time ""' 
spans, the effects are notas pronounced. For example, after 5 minutes of Theta waves. if 30 seconds of 
alpha waves are generated, and retumed lo theta, the listener will become slightly awake, and aware of 
his surroundings for that brief moment. The effect is like all of the sud den changing gears, and you stop 
thinking about whatever it was you were thinking about, and become aware that you were th1nking about 
it, but aren't any more. 

Frequency 
Th1s is the brainwave frequency that will be encoded. Different brainwave frequenc1es will st1mulate the 
bra1n lo sync te differing levels of consciousness (e.g. sleep, meditation, awakeness, etc.). See the 
bottom of this art1cle for more information on specific frequenc1es. 

lntensity 
Th1s is the mtensity of the bramwave encoding. Higher intensities work well with lower brainwave 
frequencies. Beta waves should have intensities below 25 or so, while Delta waves work better with 
intensities above 60. 

Centering 
You may choose lo have your brain think the synchromzation frequencies are coming from the left or 
right. Th1s may affect the left or right hemispheres more intensely, but that's only a guess. Mixing a file 
that has been waved te the left with ene that has been waved te the right (in the same frequency range 
within 2 Hz) has interesting effects. 

Musical Source 
lf the selection being waved is musical, check1ng this will caiculate the wave patterns in such a way as te 
eliminate clicks and pops. lf the source is noisy (waterfall, ocean, nature recordings, etc.) do NOT check 
this. lf you do, it will actually add interference. Since noise is based en "randomness", the clicks and 
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pops are inaudible. 

SmoothWave 
When checked, the actual audio appearing al !he left and right channels is smoothed out, but the spatial 
encoding is identical. The left and right channels will delay and un-delay following a smooth curve such 
that the delay difference between the left and right channels follows a sine wave, and the brain will hear 
the audio traveling around the head in a circle. When Smooth Wave is not checked, the net delays are 
the same, but are achieved by holding one channel constan! (al no delay) while the other channel is 
delayed following half a sine wave. Then the other channel is delayed while the first is held constan!. 
The boundary between holding constan! and delaying is discontinuous in that the dD/dt (difference 1n 
delay over time) jumps from zero toa positive delay value without hitting any values in-between. When 
Smooth Wave is checked, the dD/dt is always continuous. This will also cause less noticeable distortion 
in either channel when heard independently. 

For spec1al spatial panning effects, choose wave frequencies of 1Hz or less. A mono so urce (left and 
right the same) will appear to move from left to right and back at period of 1/frequency. For example, a 
frequency of 0.1 Hz will pan the audio in a "full circle" over the period of 10 seconds. 

Please read on for more information about Brainwave Synchronization Files 
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The major brainwave pattems are: 
Beta > 13 hz Normal state of alertness, stress and anxiety. 
Alpha 8-12hz Light relaxation, •superteaming•, positiva lhinking. 
Theta 4-7 hz Deep relaxation, meditation, increased memory and focus. 
Delta 1-3 hz Deep sleep, lucid dreaming, increased immune functions. 
Gamma200+ hzNot sure exactly what lhese do ... 
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About Brainwave Files 
The wave option works like many meditation tapes and light/sound devices on !he market, which range in 
price from $200 to $500. There's even a board available with plug in glasses (which have blinking lights) 
for your PC for $495. The files created using !he Wave' transfonnation are even more powerful, and are 
definitely more pleasing to !he ears. Most other devices and tapes have a "humming" sound or some 
other tones lo induce !he right brainwave frequencies. This program allows you lo use ANY sound lo 
encode the frequencies with. The most effective we have found are by using the noise generator, which 
creates pleasing waterfalllike sounds. This function only works on stereo waveforms, and the effects 
work if only if listened lo with stereo headphones. 

There are four majar (perhaps more) Brainwave Pattems ranging trom deep sleep lo acule awareness. 
Listening to sounds that have been waved for periods of 5 minutes or more will produce the desired state 
of awareness 1n the listener. Sessions of 25 minutes or so work really well! 

Many Uses 

About Carrier Waves 
Encoding Brainwave lnformation 
Authoring Brainwave Files 
Step-By-5tep Theta File 
How to Use Brainwave Synchronization Files 

Articles on Theta meditation 
References 

DISCLAIMER •• 
By usi~g this I)I".Qg"cal]1,_you.agree that Syntrillium So~are.Corporation and-the author of the program will·not·be-----­

. --responsible for any damage as a result, director indirect, of using this program. 

WARNING 
Sounds generated by the wave function are not suitable for epileptics or persons undergoing psych1atric treatment 
s1nce rt does alter one's state of consciousness. 



Noise Generator 

This function generales random noise in a.variety of colors. Each color has its own characteristics. One 
use for generating noise is lo create a waterfall-like sound which is ideal for Waving. 11 is also great for 
making weird effects by flanqinq and egualizing:· 

Color 
Noise can be a variety of colors, which describe ils spectral composition. 

Brown noise has a spectral frequency of 111•2. Which means, in English, that there is much 
more low-end, low-frequency components lo !he noise, which results in thunder and waterfall like 
sounds. Brown noise is called lhat because, when viewed, !he wave follows a Brownian motion 
curve. That is, the next sample in !he waveform is equal lo !he previous sample. plus a small 
random amount. This gives the appearance of a mountain range when graphed. The wave 
pattem is very predictable. 

Pink noise has a spectral frequency of 1/f and is found mostly in nature. 11 is the most natural 
sound1ng of the noises. By equalizing, rainfall, waterfalls, wind, rushing river, and other natural 
sounds can be generated. Pink noise is exactly between brown and white noise (which is why 
so me people used lo call it tan· noise, but pink was more appealing). 1t is neither random, nor 
predictable. 11 has a fractallike nature when viewed. When zoomed in. the pattern looks identical 
to when zoomed out, except al a lower amplitude. 

White noise has a spectral frequency of 1. In other words. equal proportions of all frequencies 
are present. Because the human ear is more susceptible to high frequencies. it sounds very 
"hissy". White noise is generated by choosing random values for each sample. 

Style , ., 
Noise can be generated in a variety of styles for your listening pleasure. 

Spatial Stereo noise is noise generated by using 3 unique noise sources, and spatially encoding 
them to appear as if one is coming from the left. the other from the center, and the last from the 
right. When listened to with stereo headphones, !he mind perceives sound coming from all 
around, not jusi in the center. To choose !he distance from center of the left and right noise 
sources. you can enter a del ay value in microseconds. About 900 to 1000 microseconds 
corresponds to the maximum delay perceivable, and a delay of zero is identical to Mono noise 
{left and right channels are the same). 

lndependent Channels noise is generated by using 2 unique noise sources. one for each 
channel. The left channel's noise is completely independent of the right channel's noise. 

Mono noise is generated by using 1 noise source, with the left and nght channels set equal to the 
same noise source. 

lnverse noise is generated by using 1 noise source as well, but this time with the left channel's 
no1se exactly 1nverse of the right channel's noise. When listened lo with stereo headphones. the 
effect is that of !he sound coming from !he center of the listener's head instead of out in space 
.somewhere. 

lntensity 
With higher ¡ntensities. the noise becomes more erratic. and sounds harsher and louder. 

Duration 
This is the number of seconds of no1se to generate. 11 long periods of noise are desired, it JS !aster lo 
generate a short period of noise (about 10 lo 20 seconds), delete excess noise al the beginn1ng and 



ending of the noise so that the waves are starting and ending al the midpoint, ~. then loop paste as 
many times as needed. 

lf a setection range is highlighted, il is not reptaced by the noise generated. Noise gets inserted al the 
insertion point representad by the yellow arrows. · 
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Many Uses 1 Effects of Using 
lmmediate Relaxation and Stress Rellef 
Choose between 5hz and 1 O hz for different levels of relaxation. 
Meditation 
Choose between 4hz and 7hz, either cycle between a few, or stay al a particular frequency for different 
results. 
lmproved Sleeping Pattems 
Any of the Alpha and Theta frequencies (8Hz to 4Hz) for 30-45 minute sessions. 
Treatment of lnsomnia 
Choose between 4hz and 6hz for starters (112 hour), then go into trequencies below 3.5hz (112 hour), 
settling on about 1.5hz to 2.5hz for sleep. 
lmproved and Lasting Sense of Well Being 
Try Theta (4Hz lo 7Hz) for 45 minutes, daily. 
Creative Visualization 
About 6hz for a while, then up to 1Ohz works well. 
Alleviation of Migraines and Headaches 
Experiment with Alpha and Theta combinations. 
Reduction of Depression Symptoms 
Again, Alpha and Theta combinations, ·mostly theta(?) 
Self Hypnosis 
Choose about 8hz to 10hz while playing any self-hypnosis tape, or guided meditation. 
Super Learning 
Choose about 7hz to 9hz while playing any leaming tapes, like foreign language tapes. etc. te increase 
comprehension. 
Subliminal Programming 
Choose 5hz to 7hz while playing your favorita subliminal tapes, or make your own by recording some 
affirmations, and_mix paste them from the clipboa~d al barely audible volumes. 
lmprove ESP 1 lntuition 
Theta frequencies help in this area, 4hz lo 7hz. 
Reaching Higher States of Consciousness 
Theta again, with daily hall hour sessions. 
·Quick Refresher on long days 
Low Alpha 8hz to 1Ohz for about 15 minutes works well. 
lncreased lmmune System 
Relaxing to Alpha and Theta combinations daily. 

Using Alpha Synchronizat1on (8Hz to 12Hz), expect similar increases in neuro-chem,callevels: 
11% 1ncrease in Norepinephrin levels 
21% increase in Serotonin levels 
25% increase in Beta-Endorph1n levels 

.- .. , .. 
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A carrier wave is needed lo transport lhe brainwave frequencies. Because lhe carrier wave is nol whal 
you hear lhrough lhe headphones directly, you do nol need lo buy super high-end headphones 
(5Hz-25KHz) lo reproduce lhe effects. In olher words, your headphones do nol need lo be able lo 
reproduce a 5Hz signa! if you are generaling a 5Hz lhela-frequency brainwave file. The brain does 
however respond better lo lhe lower frequencies, so the better the headphones you buy, the more 
dramatic the results will be. The bes! headphones are the kind lhat cover !he entire ear, so outside noise 
does no! get in. Plus. these headphones have much higher response to low frequencies. 

Carrier waves mus! have sorne correlation between the left and right channels, no matter how slight. So 
mono (total correlation), inversa (total negativa correlation), and spatial (natural recordings that have 
sorne of !he same sounds coming in both channels) will work great. 

The bes! sounds to use as carriers are sounds that are spread across the entire frequency range, or at 
leas! most of the lower frequency range. Good examples are ocean. waterfall (most any recordings from 
nature). and noise generated by this program. Experiment with mono (both left and right channels the 
same). inverted (like mono. bu! !he left channel is !he inverse of the right, obtained by using !he Channel 
Mixer), and spatial stereo (spatially encoded sounds in nature, recorded with microphones about 9 inches 
apart to simulate separation between the ears). But don11et this stop you from digitizing your favorite 
music,_and using itas a carrier, or converting your favorite toa mono or inverted wave. 

To generate a carrier wave. you can do three things: 

Record a sample Once recorded, use the Channel Mixer to create a mono, or inversed wave. Or jusi 
leave it the way it was recordad. You may find changes in effectiveness of !he brainwave files depend1ng 
on how you use)he Channel Mixer. Keep in minc;l that this function only operates on stereo waves. so 

_ when :mono:_is mentioned, it means that the exact same signa! is present on·both channels--the·left -- · 
channel and right channel are the same. 

Generate Tones You may use the Generate Tones function to find a pleasing, relaxing tone for !he 
background (but we find "noise" sounds more relaxing). The way tones work the best is if the left 
channel's tone frequency is 5-6 Hz different from the right channel's tone. This creates a beat pattern 
equal to the frequency difference, which the brain responds to somewhat (this is !he property that many 
theta-inducers rely on). Todo th1s, generate one tone with left volume at 40, and right volume at zero. 
Then generate the second tone with the left and right volumes reversed. Finally, Paste Special (with 
overlap) one tone on top of the other. Use low frequency tones, like 50Hz to 120Hz for best results. 
These tones, by themselves, will help coerce the mind into the state associated with !he difference 
between the frequencies. For example, for a theta state of 6Hz, use a 70Hz and a 76Hz tone. 
Comb1ning this tones sample with an ex1s!lng brainwave file, by overlap pasting al a quiet volume (20%) 
is even more effective. 

Generate Noise Use the Generate Noise function (pink and brown work bes!) in any of the modes: 
mono, inverse, or spatial stereo (independent channels noise will not work as a carrier for brainwave 
frequencies at all, since there is no correlation between the left and right channels). We find that using 
pink noise 1n spat1al stereo. and running it through !he Ouick Filler to gel rid off sorne of the "edge" if any 
works the best. We have also found lnverse lo work quite well too, but the brainwave "effect" is more 
pronounced. and can be d1stracting, and sorne sound boards have trouble reproducing sound that is 
inversed between channels. 

Once you have found a pleas1ng sound, aboul 10 seconds or so of a monotonous sound (tones, river, 
waterfall, noise ... ) you're ready to start. lf a monotonous sound is used, more d1sk space can be saved 
because we will use the play list lo repeat portions. lf a music sample were used, it is quite noticeable 
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that the same 1 0-second piece is being played over and over and over again. 

JI you're curious you can also spatially Jocate a mono sound to the lefl or riqht?. Do this if you wish to 
have the illusion that a particular sound is coming from one side or the other. The function works by 
pasting a mono sound sample into a stereo wavetorm, and using the Digital Delay function. Having a 
quiet "ping" (generated by using the sine wave tone generator with the bell curve envelope) play spatially . 
on the left, then on the right al about 5 second intervals is very relaxing. 
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Spatial Location 

Spatially locating a mono sound makes !he sound appear as if it is coming from !he left or !he right when 
listened to with stereo headphones, even though !he actual volume levels for left and right of !he wave 
are identical. What happens is one channel is delayed a few milliseconds. When a sound reaches one 
ear a few milliseconds before reaching !he other ear, !he brain interprets !he delay as hearing !he sound 
coming from the direction of !he non-delayed signa!. 

There are two functions that can do this: Delay and Wave. Use Delay to place a sound anywhere from 
left to right, and Wave if you wish to have the sound source oscillate between left and right. 

First make sure !he signa! to be delayed is mono in stereo forma!. That is, both left and right 
channels are identical. With a mono source, copy !he wave, create a new stereo wave, and paste. 
With a stereo source, use the channel mixer so that both channels gel mixed at 50% for each 
channel. 
Highllght !he entire selection you wish to spatially locate. Choose Transfonn -> Delay or click the 
stopwatch icon. Choose a delay of up to 2 ms. Delaying one channel will make the sound appear as 
if it is coming from !he other channel. You can use !he preset for Spatial Left or Spatial Right as well. 
lf you want !he so urce to move left to right, choose !he Transfonn -> Wave funct1on. Enter the 
cycles per second (e.g. 0.1 = left to right and back in 1 O seconds) in the initial and final boxes (!he 
same value for both boxes). Choose the center position (in the center, left, or right) using the 
Centenng control. Choose an intensity of about 50 or so, greater intensities mean the sound goes 
further left or right off of center. Al so check the Musical Source box if your sound is no! noise related. 

--- -------------------------------------- --~-~---·- -~-
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Encoding Brainwave lnformation 

There are two types of brainwave files lhat you can create: A flat fila, anda cued fila. The ftat file takes 
more memory, and plays straight lhrough from beginning lo end, while lhe cued file is actually contains 
pieces of lhe entire audio program, that when played in lhe proper order become the brainwave file. The 
cued file takes less memory, and can very quickly be modified at any time by re-arranging the audio 
pieces. The average length of a cued file is about 3-4 minutes for a program that can last as long as 
desired. The flat file is a standard wave file, which means lo create a long program, you must have 
enough space for it. The only advantage lo using a ftat file is if you are waving music, sin ce m u sic cannot 
be split into pieces and re-arranged, otherwise it would sound discontinuous. Creating brainwave files 
using the fiat file method will be discussed first, since it is more straightforward 

Ftat Brainwava File Generation Create a file the length you wish to make your relaxation program 
using the carrier wave(s) ol your choice. Either record music, or use the pink noise generator and copy 
and paste (or Paste Special) to the desired lengtt). lf you are using a monotonous sound, you would be 
better off using !he cued file method. Lengths of good relaxation programs vary from 15 to 30 minutes, 
and beyond. This means you must have enough hard drive ·space for the entire file. Since the temporary 
file takes up hard drive space as well, the maximum size ol file you can crea te, and be able to save, will 
be one that takes up hall ol the initial free hard drive space. 

Use the Wave lunction to encode the brainwave pattems into the carrier wave by highlightmg a section ol 
the wave, or !he whole thing, and choosing Translorrn:Wave, or click the wave icen. With the wave 
translormation, you have complete control over the brainwave frequency being encoded, the strength ol 
the signa!, and the positioning ol the signalleft or right. Over the setection highlighted, the intensity, and 
posit1on remain constan!, but the frequency can be varied using the graphical input control. See the 
sect1on on Authoring Brainwave Files to leam what settings lo use lor the Wave function. and how to 
build effective fil_!ls. _, 

Once the entire file has been waved to your satislaction, you can save !he file il you wish, and play it 
using the Play button. An interesting side effect is that different sounds are heard il you listen to one 
channel, listen to both channels with one ear. or listen to each channet with each ear. 

Cued Brainwave File Generation These files contain many short snippets ol brainwave encodings at 
different lrequencies. Each snippet is cued using !he Cue List, and a Play Lis! is generated by adding 
entries lrom the Cue List, and looping them il necessary. To listen toa cued brainwave file, you must use 
the Play button in the Play List dialog box. 

First you mus! figure out how you want to divide up the brainwave program (your 20-30 minute 
masterpiece) into components. For example, you may want to have pattems al 5Hz. 7Hz. and 9Hz at 
different points in the program. In this case, you will need at least three pieces lor your creation. The 
actual file will just be 1 O seconds ol carrier wave at 5Hz. lollowed by 1 O seconds at 7hz. lollowed by 1 O 
seconds at 9Hz. All the pieces are placed in the cue list by highlighting the piece, and choosing Add. lt 
is best to add the piece to the cue lis! once it is created. or pasted at the end ol the current wavelorrn. To 
create the final program. the pieces are added to the Play Lis! in the order you wish to listen to them. 
Each piece can be looped il needed. So a 20 minute program can be generated from 3 1 0-second 
pieces by adding the cuesto the play hst and looping. 

F1rst yo u need to crea te 1 Oto 20 seconds ol carrier wave. and save in a special file in case you need the 
carrier wave again later. Highlight the wave, and Edit:Copy. When you need another copy al the initial 
carner wave, you need only to Paste it. 

Add the first carrier wave sn1ppet to the Cue List by pressing the Add button in the Cue List d1atog. Give 
the cue lar this snippet a name that reflects the wavelorrn translormation you will be using, lor example, 



"6Hz to 5Hz drop". 

Choose the Transfonn:Wave function to encode the proper pattems into the carrier wave. Look at the 
section on Authoring Brainwave Files to leam what settings to choose. 

Click past the end of the wave file (make sure the rightmost part of the file is in view), and choose Paste 
to insert another copy of the carrier wave. Once you do this, you can add the newty insertad selection to 
the cue lis!, and give it a name. Repeat the step above for creating a brainwave encoding over the 
carrier wave you jusi insertad. Do this as many times as needed until you have all the pieces you need 
lo build the final brainwave file. 

Once all the pieces have been generated, add lhem in the order you like to the play list. To make pieces 
last longer (if the beginning and ending of the piece are al the same brainwave frequency), increase the 
number of loops for lhat entry in the play list. 

When Played from the playnst. the pieces will be played in the order shown, and looped if necessary. 

To gel familiar with the cue list, and play list, open one of your favorita wave files, and highlight sections 
then add them to the cue list. Afler you have a few selections in the cue list, add them lo the play list. and 
choose a loop count of greater than one for sorne of them. Choose Play from the play list; and listen lo 
what you've jusi created. 

.. 



Authoring Brainwave Files 

After leaming about carrier waves, and encoding procedures, all you need lo know is what frequencies to 
use, and when lo use them during !he course of !he listening session. Once you know what frequencies 
to use, and al what intensity, you can generala !he completed file using eilher of !he methods above. 

Effective brainwave files have some sort of encoding going on !he entire length of the session. For the 
first 3 minutes or so of the session, the listener will not be in a "relaxed" state, and will nor respond greatly 
to !he frequencies being presented. During this warm-up period, gradually decreasing from about 12Hz 
down to 8Hz works nicely. After about 4 minutes, !he listener's brainwave pattems will start to 
synchronize with the pattems in the headphones, and !he serious brainwave programming can begin. 

Frequencies of 8-1OHz correspond toan alpha state- light relaxation, like a quick aftemoon siesta. 
Frequencies of 6-7Hz correspond toa theta state- meditation. 4-5Hz correspond to deep relaxation. 
You can create a session that is constan!, in one of these states, or create a session that dynamically . 
flows from one lo the other. When going down in frequency, give the listener about ene minute to "catch 
up", and stay in sync w~h the wave. Going up in frequency does no! require the lis tener to catch u p. In 
other words, if you go from 6Hz down to 4Hz over a 20 second time span, and hold al 4Hz. the listener 
may not be al 4Hz for another minute: When going from 4Hz lo 8Hz in 20 seconds, the listener will be al 
8Hz at the end of the 20 seconds. 1t appears to take extra time when going down in frequency, but no 
e:Xtra time when going up. This basically holds true for !he first 20-30 minutes of a session. After that, 
the opposite tends to occur. 1t is easier to go lower than go higher. This means that to bring a listener 
from 4Hz (where she has been for the last 30 minutes) up to 12Hz, it should be done over a 5 minute 
period or so. One nice "trick" te do is to keep the listener al around 4-5 Hz for a while, then about once 
every 2 minutes, go up to 8Hz and back over a 20 second span. This will a/ert the listener slightly, and 
make them aware for a few seconds of what they are thinking. This is great for getting creativa insights 
and the like. lt ~cts as a sort of window to !he sugconscious, allowing one to remember what is going on. 
lt's kind of like remembering dreams: you do it better if you are awaken in the middle of ene. 

Another effective method of producing relaxation files is to overlap them. That is, have portions that are 
one frequency, and slightly spatially located to ene side overlapped with a slightly differing frequency 

· spatially located shghtly to the other side. This gives the listener the chance to decide which frequency te 
be at, and gives them more freedom over the experience. For example, a session could go from 8Hz to 
4Hz over 1 O minutes overlapped with 7Hz lo 5Hz over the same 1 O minutes. 

For nice super-re/axing effects, generate panning waves (frequencies of 0.05 to 0.2) over your session 
after encoding the 1nitial brainwave pattems. For example, if you are generating a brainwave file out of 
20-second pieces, after generating the main brainwave frequency over the 20 second period, generate a 
panning wave of 0.05 or 0.1 (which means a period of 20 or 1 O seconds) with an intensity of about 50 or 
so. This will make the sound appear to shift left and right te the listener over a 20 or 10 second period. 
Now, overlapping a 24-second piece panned at 0.125 (8 second period) at 5Hz with a 0.167 (6 second 
period) at 6Hz will combine the practicas of multiple frequencies with panning for an extremely 
super-natural effect! 

Once you gel started creating a few files, and see what the different frequency ranges do, you will 
become familiar with the different effects and how te generate jusi the effects you want. 

Gamma frequencies of 200Hz or more seem to help in relaxation. This is an area you can experiment 
with. When generat1ng frequencies above 40Hz or so, it is best te keep the intensity very low, like 7 or 8. 
The higher the frequency, the lower the intensity has te be, otherwise the encoding will overwrite itself. 
and the signa! will be test. 



, ... 

Sample Theta File - Step-by-Step 

1 Create a new blank file with Flle:New. Choose a Stereo file, either 8 or 16 bit and a 11 025, 22050, 
or 441 00 sampling rate. The final file size will be one of the following sizes listad below depending on 
your choice: 

8-bit 
16-bit 

11025 
2.6M 
5.2M 

22050 
5.2M 
10.5M 

44100 
10.5M 
21.2M 

You mus! make sure you have enough memory for a file of this size, plus an additional meg for 
working space. lf you plan on saving !he file when you are done, you mus! have al leas! twice this 
amount of hard drive space available, since a temporary file is used instead of memory while working 
on !he wave. 

2 Choose Generate:Noise. Choose Pink Spatial Stereo for 15 seconds al an intensity of 3. This is 
usually the longest portiOn of !he generation of brainwave files. Because of this, it is advised that you 
save lh1s piece of noise so that in generating future files, you can just load in this pre-calculated noise 
as a starting point.' 

3 Choose Edit:Copy. From now on, we will paste the noise in when we need it! 

4 Make sure the noise is highlighted. lf it is not, select all by double-clicking on the waveform until it is 
highllghted. 

5 Choose Add in the Cue lis t. and give the entry a Label of 1OHz to 8Hz, and a Description of 
Wanm-Up. _ 

6 Choose Transfonm:Wave to bring up the brainwave dialog box. Enter 10 for the Highest Frequency 
• and 8 for the Lowest Frequency, and an lntensity of 35. On the graph above, click the leftmost 
dot, and drag it to the top of the graph. Click the nghtmost dot, and drag rt lo the bottom of the 
graph. This will product a frequency encoded at 10Hz at the beginning, and glide down to 8Hz by the 
end. Choose OK to generate the encoding. This shouldn't take nearty as long as it did to generate 
the n01se. 

7 Click the mouse at the rightmost port1on of the wave Uust beyond !he black waveform display area). 
When you do this, the yellow cursor arrows should be all the way lo the right of the wave. You must 
always add new pattern blocks at the end of the curren! waveform. 

8 Choose Edil: Paste to 1nsert another copy of the original noise that we had copied originally. 

9 Create the following pattem blocks as befare (following the steps 5 lo 8) ; except with !he following 
values for the cue list and waveforrn transforrnation: 

Label Description Hi Freq. Lo Freq. lntensity 
a Hz Alpha 8 8 37 
8 to 6Hz Glide·Down 8 6 38 
6Hz High Theta 6 6 40 
6 to 5Hz Deeper Theta 6 5 45 
5Hz Theta 5 5 50 
5-8-5 Spike 8 5 50 

(Graph should /ook like an upside-down "V") 
5 to 12Hz Awake 12 5 40 

.. ~ 



(Graph should go from left=lowest to right=highest) 

1 O Once all the blocks are generated, and in the cue lis!, Add the pieces !o the play lis! by selecting the 
wave portian in the cue lis! and clicking Add in the play lis!. Select !he pieces listed below in the order 
given. Alter doing so, select each ~em in the play list, and change the Loops for each so the final 
play list looks like this: 

(1) 10 lo 8Hz 
(3) 8Hz 
(1) 8 to 6Hz 
(7) 6Hz 
(1) 6 to 5Hz 
(1 B) 5Hz 
(1) 5-8-5 
(12) 5Hz 
(1) 5-B-5 
(12) 5Hz 
( 1) 5-8-5 
(12) 5Hz 
( 1) 5-8-5 
(12) 5Hz 
( 1) 5to12Hz 

When you choose -Play- from the play list, the sequence will be played in the arder given, looping the 
number of times specified. This list gives a 21 minute theta session, with bursts into alpha al tour 
points. 

11 lf you wish to save this piece, and have enough hard drive space, you can do it now. The wave is 
complete. Enjoy. 
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HowTo Use 

Once you have created your brainwave file (15 minute files on up work best), loop play them for a longer 
listening time. Sessions of 15 minutes or more work best. lt is best to listen to the sessions lying down in 
a quiet place where you will not be disturbad. lf there is no place like this near your PC, it may be a good 
idea to record the session on tape and listen to it where you can be comfortable and relaxed. When 
you're fully comfortable, start the session, clase your eyes, and Jet the magical sounds from Cool Edil do 
the work. Remember, this only works if you listen to the sounds with stereo headphones, 

You may notice helicopter, or "washing" type noises moving around in your head. These sounds are 
actually created inside your head, and are not coming directly out of either channel from the sound 
board. 1t is this noise that is doing the work of helping your brainwaves get synchronized to the patterns 
you have chosen. When we have mixed two different (but similar in frequency ranges) brainwave files 
together, we have noticed a jet airplane noise moving slowly from left to right in the background. Sorne 
people don't hear these artifacts at all, while others hear them extremely well. 

Another si de effect is that of a wandering mind. When you use frequencies under 8hz, yo u may find 
yourself thinking of the strangest things. You may find that you are not thinking of anything in particular, 
and your thoughts become very interesting. The feeling is also "warm" and "happy" for sorne people. 
Others start recalling their favorita memorias as a child, even sorne they thought they had forgotten 
forever! 

After a session of 15 minutes or more, you may feel quite refreshed, light, airy, clear-headed, etc. Sorne 
claim that doing this for 30 minutes a day can result in subtle but great changas in your life .. ESP 
experiences increase, and you may be able te reach new levels of awareness in your everyday life. 

... 
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Noise Generator 

This function generales random noise in a variety of colors. Each color has its own characteristics. One 
use for generating noise is lo create a waterfall-like sound which is ideal for Waving. lt is also.great for 
making weird effects by flanqing and equalizing. 

Color 
Noise can be a variety of colors. which describe ils spectral composition. 

Brown noise has a spectral frequency of 11f"2. Which means, in English. that there is much 
more low-end, Jow-frequency components lo the noise, which results in thunder and waterfall like 
sounds. Brown noise is called that because, when viewed, the wave follows a Brownian motion 
curve. That is, the next sample in the waveform is equal lo the previous sample, plus a small 
random amount. This gives the appearance of a mountain range when graphed. The wave 
pattem is very predictable. 

Pink noise has a spectral frequency of 1/f and is found mostly in nature. JI is the most natural 
sounding of the noises. By equalizing, rainfall, waterfalls, wind, rushing river, and other natural 
sounds can be generated. Pink noise is exactly between brown and white noise (which is why 
some people used to call it tan noise, but pink was more appealing). JI is neither random. nor 
predictable. lt has a fractal Jike nature when viewed. When zoomed in, the pattern looks identical 
to when zoomed out, except at a Jower amplitude. 

White noise has a spectral frequency of 1. In other words, equal proportions of all frequencies 
are present. Because the human ear is more susceptible to high frequencies, it souods very 
"hissy•. White noise is generated by choosing random values for each sample. 

Style ~ _, 
Noise can be generated in a variety of styles for your listening pleasure. 

Spatial Stereo noise is noise generated by using 3 unique noise sources, and spat1ally encoding 
them to appear as if one is coming from the left, the other from the center, and the last from the 
right. When listened to with stereo headphones, the mind perceives sound coming from all 
around, not just in the center. To choose the distan ce from center of the left and right noise 
sources, you can entera delay value in microseconds. About 900 lo 1000 microseconds 
corresponds to the max1mum delay perceivable, and a delay of zero is identical to Mono noise 
(left and right channels are the same ). 

lndependent Channels noise is generated by using 2 unique noise sources. one for each 
channel. The left channel's no1se is completely independent of the right channel's noise. 

Mono noise is generated by using 1 noise source, with the left and right channels set equal to the 
same noise source. 

Inversa. noise is generated by using 1 noise source as well, but this time with the Jeft channel's . · 
noise exactly inverse of the right channel's noise. When listened to with stereo headphones, the 
effect is that of the sound coming from the center of the listener's head instead of out in space 

. somewhere. 

Jntensity 
With higher intensities. the noise becomes more erratic, and sounds harsher and louder. 

Duration 
This 1s the number of seconds of noise to generate. lf long periods of noise are desired. it is faster to 
generate a short period of noise (about 10 to 20 seconds), delete excess noise at the beginn1ng and 

) 4 ., 
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ending of the noise so that the waves are starting and ending al the midpoint, QQ!rl, then loop paste as 
many times as needed. 

lf a selection range is highlighted, it is not replaced by the noise generated. Noise gets inserted at the 
insertion point representad by the yellow arrows. 

,, 
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Generate DTMF Signals 

This function generales Dual Tone Multi-Frequency (DTMF) signals used for dialing telephone numbers 
over !he PSTN. These signals are recommended intemationally by !he lntemational Telegraph and 
Telephone Consultave Committee (CCITT) as the signals for push-button telephones. The DTMF signals 
generated by telephone push-button keypads are different from !he Multi-Frequency (MF) tones 
generated by !he telephone network to transmit information. 

Dial String 
En ter the phone number you wish to generate !he tones for in this box. Other character5 may be entered 
such as !he'*' and !he '#' symbols, as well as extra digits 'a', 'b', 'e', and 'd'. Entering !he pause character 
(defined below) will inserta pause of !he length defined. 

Tone Time 
All tones willlast the milliseconds entered. The standard time for DTMF tones is 100ms. 

Break Time 
Th1s is the number of milliseconds between successive tones. 

Pause Time 
This is the number of milliseconds to use for a pause (when !he pause character is used in the string). 

Pause Character 
When this character is typed in the Dial String, it will be interpretad as a pause, and silence will be 
insertad for the duration of the Pause Time. · 

DTMF Signals , , 
DTMF (normal push-button telephone type) signals will be generated using combinations of the 
frequencies 697Hz, 770Hz, 852Hz, 941Hz and 1209Hz, 1336Hz, 1477Hz, 1633Hz. 

MF Signals (CCITT R1) 
MF (1ntemal to telephone networks) signals will be generated using paired combinations of the 
frequencies 700Hz, 900Hz, 1100Hz, 1300Hz, 1500Hz, and 1700Hz. 

Amplitude 
The volume level of the tones being generated, with 100% being maximum volume without clipping. 

The presets in this function save everything, including the dial string. To see how effectivé these tones 
are. try typmg in your favorite phone number to generate the tones for it. Then hold the receiver of your 
phone next to the speaker and play the wave. lt will dial the number you had entered! 



Options menu 

The Options menu displays various additional options. 

Options Menu Options: 
Loop 1 Play Toggle 
Monitor VU Leve! 

Freguency Analysis ... 
CD Player 
Cue List 
Play List 
Cool Scripts ... 
Select Wave Device 
Custom Toolbar Settings ... 
Settings ... 

•• 
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Anexo D) -·-· 

Herramientas de edición de audio y video incluídas en Windows 
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Actualmente en el mercado ~xisten varias herramientas de desarrollo para la grabación, edición, y 
. reproducción de audio digitaL Las más conocidas son : Sound Blaster, Media Visión, Audio Shop, Aud 
Track, etc. 

Nosotros desarrollaremos la grabación de una señal digital de audio por medio de la grabadora de sonidos de 
Windows. Windows 3.1 proporciona el programa Sound Recorder que se utiliza para grabar sonidos por 
medio de los puertos de la tarjeta de sonido. Para empezar haga doble ckick sobr~ la ventana de accesorios 
mostrada a continuación: 

Haga doble click sobre el icono de Sound Recorder. La siguiente figura muestra el panel de operación de la 
ventana Sound Recorder : 

La s1guiente tabla descnbe Jos botones que aparecen dentro de la ventana Sound Recorder: 

BOTÓN DE GRABACIÓN FUNCIÓN 

-
« Regresa el arch1vo de sonido al micio 

- -
» Adelanta un somdo 

> Reproduce el archtvo de sonido acrual 

[] · Denene la grabación o reproducción del arch¡vo 

MICRÓFONO Emp1eza a grabar 

El pequeño cuadro obscuro le permite ver la onda de sonido. La linea verde que aparece a la m1t.ad de la caja es la linea base de la onda El cuadro POSICIÓN que 
se utiliza cuando se ed1tan o mezclan aretnvos de somdo,le md1ca la postc1ón actua .. dentro del archivo. El cuadro LENGTH mdica cuanta m formación tlene 

grabada 

GRABACIÓN DE UN ARCHIVO DE SONIDO DIGITAL 

Para empezar debe encender su micrófono y hacer doble che k en el botón record. Los conladores empiezan a mcremenlarse, y el cuadro deshzable emp1eza a 
moverse de IZqUierda a derecha en la barra de desplazamiento Conforme habla al micrófono. las ondas de sonido se despliegan dentro de la ventana como se 

muestra a conunuac10n. 

Para tennmar es1.a g:rabac1ón. haga cllck sobre el botón STOP 

•• •• !-...--.. -
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Para reproducir su grabación, haga click sobre el botón REWIND. Observe la posición del archivo del contador POSICIÓN, así como la locahzación del cuadro 
de despJ..aza.-niento en la barra de desplazamiento borizontal. Ahora haga click sobre el botón Play. Mientras se reproduce la grabación, se pueden observar las 

ondas sonor3S asociadas a este sonido. Para finalizar ésta reproducc:ión. haga click en el bo~n STOP. 

ELIMINAR UN ARCHIVO DE SONIDO DIGITAL 

Cuando deseamos eliminar una grabación, ya sea porque está no reúne los requisitos indispensables o porque fue errónea, podemos grabar sobre ella stmplemente 

regresándonos a la posición inicial de la grabación, o terminando esa sesión y no grabando los cambios hechos al archivo. 

un cuadro de diálogo como el siguiente : 

Cuando te pregunta si qu1ere grabar o ehminar la grabación, stmplemente seleccione la opción NO para elimmar la grabac1ótl. 

GUARDANDO LA GRABACIÓN EN UJ'o; ARCHIVO•.WAV 

Después de haber hecho la grabación habrá que guardarla en un archivo con el formato WA V. Una vez guardado este archivo. se podr.i. uUI1zar en díferentes 

prese?tac1ones mulnmed1a que cuenten con la capacidad de reproductr archivos WA V. 

Para guardar el arch1vo. selecctone el menú FILE y ehJa la opción SA VE AS Sound Recorder desplegará el s1gu1ente cuadro de dtálogo 

f- ·o._a el nombre del nuevo archi\'O No olvide espec1ficar la ruta aprop1ada para el almacenam1e~to. Selecc1one la opc1ón OK 

-· 
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EFECTOS DE SONIDO ESPECIALES 

Algunas taljetas de sonido, incluyen todo el software necesario para realizar la edición y la manipulación de los archivos de sonido. 

Utilizaremos la grabadora de sonidos de Windows para conocer algunos de los efectos de sonido para an::bivo dtgitalizados. Primero seleccione un archivo por 
medto del menú FILE y con la opctón OPEN. Para ello usted debe tener en su lista de archivos un archivo de música de fondo y un archivo de voz que usted 

previamente ya grabó y digitahzó. Escriba el nombre del archivo de voz y elija OK 

Cuando se despliegue el panel de control de la grabadora de sonidos de Wmdows, reproduzca este archivo utilizando el botón PLAY. 

Antenonnente se explicó que la amphtud de la onda de sonido determina su volumen. Sound Recorder penrute controlar el volumen del archtvo de somdo 

SelecciOne el menU EFECTOS de Sound Recorder y elija si sube el volumen con la opción SUBIR VOLUMEN o st lo baja con la opc1ón BAJAR VOLUMEN. 

Para camb1ar la velocidad del archivo d1g1tal, seleccione el menU EFECTOS y elija aumentar la veloc_idad con la opc1ón AUMENTAR VELOCIDAD o d1smmu1r 

la velocidad con la opc1ón DISMINUIR VELOCIDAD. 

Para agregarle eco al archivo digitahzado, selecc10ne el menú EFECTOS y la opción AGREGAR ECO. el archtvo camb1ará considerablemente agregando una 

sensac1on de profundidad y esto hace que el sonado parezca proyectado desde una tllPntafta o una cueva. 

Para reproduc1r un sonido al revés, selecc10ne el menú EFECTOS y la opctón INVERSO. El sonido será reproducido por la grabadora de somdo de manera 

m versa 

REALIZANDO UNA MEZCLA DE DOS ARCHIVOS DE SONIDO 

keahzar una mezcla de somdo es simplemente hacer que dos arch1vos de somdo d1gnal sean reproducidos al mismo uempo St se esta creando un arch1vo de 
!l.llfiH.lo dJgnal para una presentacion. con un micrófono se podrá realizar está grabac10n y postenonnente se podrá combmar con un archtvo preYtamente 

grabado 

Para mezclar dos archl\'OS de somd.o con la grabadora de somdos. de Wmdows, cargue un archtvo de sonido dtgttal. Seleccione el menú EDIT y con la opc1ón de 

. .. 



· Para mezclar dos archivos de sonido con la grabadcna de sonidos de Windows. cargue un archivo de sonido digital. Seleccione el menú EDIT y con la opción de 

El archivo 'C:\SB16\VOClJTJUTOT.\LM1Í' ho 
cambuula. I.IJeoea quardsr loo cambioo1 

----MEZCLAR DOS ARCHIVOS DE SONIDO se desplegará el siguiente cuadro de diálogo 

Elija el archivo de música de fondo y asigne OK. Después de contar con los dos archivos a mezclar, haga click en play y escuche el resultado. Deberá escuchar en 

el primer plano la mústca de fondo y en el segundo plano la voz digitalizada. 

EDICIÓN DE UN ARCHIVO DE SONIDO 

51 es grabado un somdo utilizando un micrófono, lo más probable es que se experimente un periodo de tiempo antes de que sea escuchado, para ello la grabadora 
de sorudo de Wmdows proporciOna un método de ed1ción. Para ehmmar las partes no deseadas de la grabación, reproduzca el sonido para la pOSiCIÓn deseada o 

utilice la caJa de desplazamiento. Después, seleccione las opciones del menú EDIT etiquetadas como ELIMINAR ANTES DE LA POSlCJON INICIAL ó 
ELIMINANDO DES PUES DE LA POSICION ACTUAL, para ehrmnar ese de sonido. Utihzando estas dos o~ctones, puede reducir su arch1vo de 

sonido a solamente las secc,ones que contiene el sonido deseado. HERRAMIENTAS DE VIDEO DIGITAL (Video para Windows) 

Para 1¡¡ edición y presentación de video digital en una computadora personal se emplean diversos software's 
entre ellos quizá el más destacado en nuestros días es el Video para. Windows. 

Video para Windows es utilizado para correr secuencias de video en movimiento en una computadora persona 
y no requiere de algún hardware especializado para su uso. Si usted utiliza Video para Windows, podrá crear 
diversas animaciones, secuencias de video, e incrustar estas en una presentación Multimedia: 

D-.......... ,, -·-~· ~, .. , 
,.__ _____ ... 

• 

............... - .. -!. .... 

JI 1-·-·---·· 1 

• 
S1 usted nene en su sistema mstalados una lar:Jeta VGA, un momtor VGA o algUn otro superior, podFá hacer uso de v1deo para Wmdows. Las caractcrisncas y 
\t:OtaJaS mas 1mponantes que actualmente brinda Video para Wmdows son: 

• 
• 
• 
• 
• 

Pennne reproduc1r correctamente secuencias de video que han s1do almacenadas en CD-ROM 
Una efic1encla excelente cuando se reproduce video digital en computadoras con memona hmitada . 
Carp rap1da para aphcaciones de v1deo d1gnal 
Penmte comprimir vtdeo en diferentes formatos y capacidades 
Permne reproducir el aud1o y el ..-¡deo en ~uadros mterfohados 



La esttuctura de un archivo de video digitaJ es como la mostrada a continuación: 

1::1 1 .,,..,,hrr," rr.n ~~ ~•· hr.··• 1 
"-,.... •. ,.,...._ -IZS e:--...-. 
dtJCJJ ....... lO: o:\ 

~ 
... , ..... :o ..... ·-·- "'_.. 1•6111_ .. ....... 
Mnt·~ ..._,k' a· -UIIU{'".-.'1'{ 1 , .... _ ...... r: !1 

A este tlpo de arch1vos se les llama • .A VI (audio video mterleaving), lo cual indica que será reproducido un cuadro de video con un "trozo" de aud1o Para ello 

ex¡sten vanas configuraciOnes que pemuten vanar el número de tmágenes a intercalar entre cuadros. 

Como Jo anahzamos en la sección fisica de video,los diferentes fonnatos de compresión utilizan técmcas de abono para la proyección y desphegue de Imágenes 

repet1t1vas 

Video para Windows t1ene una característica muy tmponante. pennite el uso de la opción slate rate que es variar el número de cuadros que aparecen en una 

secuenc1a de ndeo en movimiento. A continuación se presentan dos de las hemmienw más populares para la manipulación de v¡deos digitales 

VIDEOCAP 

\'¡deo \'1deoCa~ es la herramienta de_captura de_video que incluye-Video para-Wmdows: 

( tln \'1deoCap podemos capturar datos d1gnales y crear archivos d1g1tales con el formato • AVI además podemos d1gitahzar secuenc1as de cuadros, o cuadros 

IIJu~ en \ano~ formatos de los que desLacan los SigUientes TGA. BMP. DIB. PCX. etc 

En la f¡gura antenor podemos observar que la pantalla pnnc1pal del Y1deoCap esl.á formada por S panes 

• 
• 
• 
• 

Por la Barra del T1rulo. que es donde se mforma al usuario con que arch1vo se está trabaJando . 
Barra de MenU. donde se puede dar acceso a las diferentes opciOnes de los menús 
Barra de Herramientas. donde se encuentran los 1conos más 1mponames para la operación del programa. 
:\re a d~ Desphegue. donde se desplegará el cuadro de la imagen a d1g1tahzar 

.. 



. -• ,AJ<a de Despliegue, donde se desplegad el cuadro de la imagen a digillllizar. . . . · 
· Barra de Eslado, donde se despliega IDda la información a<:en:a de los proceSos que se es1án llevando a cabo . 

arel VideoCap es como manejar cualquier otro programa en el ambiente Windows. A continuación presentamos las diversas opciones que ofrecen los 
.ates menUs del VideoCap. 

MENU FILE 

En este menO. se especifican las características más comunes para el manejo de archivos como , abrir, salvar, etc. Además se mcluyen opciOnes especificas para 
salvar un cuadro de video en alguno de Jos fonnatos antes mencionados o incluir un cuadro o una secuencia de video proveniente de otro archivo de video 

Load Palette 

Jmpona secuenc1as de color con un máximo de 256 colores predefinidos. VideoCap permite imponar imágenes con VJdeo secuencias de 8 b1LS 

Set Captura File 

1~ .ca y crea el archivo por default para la secuencia de capturas. 

Sa"·e Captura Video As 

Cop1a el contemdo de la captura realizada en el arch1vo y la ruta que se especifique. 

Sa\'e Palettr 

Salva la paleta de color del actual arch1vo de v1deo captur.il.do 

SaH Single Frame 

Salva una 1magen md1v!dual.en el archivo y la ruta especificada 

[dil Cap~ure Video 

t ~ _ .• He \'lsuahzar en el V 1deoEdn el archi\'O capturado para ver como es que el archivo puede correguse, o mejor.il.rse. 

_, 
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··EDITMENÚ 

Este menú permite copiar una secuencia a1 Oipboard. pegir una secuencia, y definir algunos paráme1:ros de presentación: 

Copy 

Copia una imagen individual al clipboard. 

Paste 

Pega una imagen mdividual proveruente del Clipboard. 

Preferences 

Define parámetros de presentación del VideoCap 

OPTIONS ME:'I"Ú 

En este menú se definen los panirnetros rruis imponantes para la captura de la secuencia de video 

.;.i 

Audio Formal 

Define las características del somdo, bits de muesueo, canales de grabación, frecuencia final 

\'ideo Format 

Define las características de la grabación digital. el tamai'lo de la pantalla 

\'ideo Source 

Permue definir de donde vendrá la sei\al de video, del formato ongmal, s1 es una seflal de video compuesto o S-VHS. 

Pre\ ie\\ Video 

Permite vtsuahzar la precaptura del video, osea ver la 1magen en nempo real de la sei\al de entrada. 
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, CAPTURE MENU 

·En este menú se pueden especificar algunas de las caracteristicas más fundamentales para definir la paleoa de capiUra, imágenes individuales, UN GRUPO DE 

IMÁGENES. ETC. 

( 

Single Frame 

Pennite la caprura de un solo cuadro de video. 

Frames 

Permite la captura de vanos cuadros a la vez para posterionnente salvar la caprura como una secuencia de fotogramas. 

Y ideo 

Imcia la caprura del video d1g1tal. 

Palette 

Pennne definir el nUmero de colores que senin capturados por cuadros, por secuencia de cuadros, o por video digital. 

( 

HELP MENU 

Este menu p~porcmna la ayuda en línea para el maneJO y la manipulactón de estos archivos Su maneJO es común a todas las ayudas en linea de los programas 

Wmdows 

-. 

REALIZANDO LA CAPTURA DE UN ARCHIVO DE VIDEO DIGITAL o 

Lo primero que se tiene que hacer para una captura de video, es definir a dónde se va a ir el archivo capturado 
,. esto lo definimos en el menú FILE con la opción SET CAPTURA FILE, cuyo cuadro de diálogo es el 
definido a continuación: · 

• 
C3~Ctf3 .. 

' 
"N ~ A.N 

. ' 
~ ~ • ce .......... 1!1 

IOICI'1lZJér ' ' ; 

( ,., ,,¡, 
'"' 

Postenonnente defimmos las caracteristJcas de audio a capturar en función del proyecto -y la cahdad de audiO que sean las requeridas. Para vanar las características 

de aud 1o a caprurar por medto del menú OPTIONS seleccmnamos la opctón AUDIO FORMAT y las opciones son las mostradas a contmuactón 

-. 



Ahora como en el Punto anterior, selecCiOna~os la opción COMPRESSION OPTIONS y se despliega la ventana antcrio~: ( 

En este cuadro se muestra el dcstmo del archiVO de video, el método de compresión utilizado, los detalles de la compresión, el mvcl de intcrfoliado de cu:~dros, un 

prcvious para la compresión, etc. Es recomendable comprimir el archivo por el método de Cinepak Codee by Supcnnatch 

Después de dcfimr los parámetros, cerramos este cuadro y por medio del menú FILE seleccionamos la opción SA VE AS y renombramos este archivo 

Cuando se termine este proceso podemos abnr la opción de STATISTICS y observar el nivel de compresión del archivo. ( 

----Al termmar todo-este proccso~cstc nuevo archivo de video compreso ya·es un nuevo objeto que p~edc se utilizado por alguna aplicación Multimedia:----------:-
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lNTRODUCTION 

e!come to the Adobe Premiere'" program-software that brings the world of -

digital movie-making to the desktop. Adobe Premiere works with Microsoft·' 

Video for \'\lindows and QuickTime'" for vVindows softwart\ and lets yo u record, 

crea te, and play movies from video, sound, animations, photographs, drawings, text, and 

othcr material using your 113lvl·" or IBM-compatible personal computer. 

Microsoft Video for Windows and QuickTime for Windows are system utilities that lct yo u 

integra te audio and video in Windows applications. You can play movies creatcd in Adobe 

Premiere in any application that supports thcse formats, or output movics to videotape. 

BEFORE YOU BEGIN 

Befare beginning to use Adobe Premiere, you should have a working knowledge of 

/vlicrosoft .. \'\'indowS'" and the PC. Yo u should know how to use thc m o use and standard 

\Vindows menus and commands. Yo u should also know how to opcn, savc, andel ose files. 
' For information on basic Microsoft Windows features, see your Microsoft Windows 

documentation. ~ 

Befare using this manual, you need to insta!! thc program by following thc instructions 

given in the Adobe Prcnzicrc Gctting Stnrtcd booklet accompanying this guide. This booklet 

also provides information on new fcaturcs in Adobe Premiere 4.0, and on allocating 

memorv, working cfficiently, improving performance, and using thc Adobe Type lvlan­

ager"' with Adobe Premiere. For a complete list of keyboard shortcuts to use with Adobe 

Premien~, see the Quick l~efercncc C.ml. 

ABOUT THIS MANUAL 

The Adobe Prcmicrc Uscr Cuide providcs dctailed information about thc Adobe Prcmiere 

tools and commands. lt is designcd to he uscd as a rcfcrcncc too] in your cveryday work 

with Adobe Prcminc. This uscr guidc is organizcd as follows: 

• Chaptcr 1 contains a short tutori.d clcsigncd to familiarizc you with thc basic concepts 

of making movies with the Adobe Premie re program. 

• Chapter 2 discusses how to start an1\dobe l'rcmiere proicct and how to work with the 

Projcct and Construction windows to asscmhlc a movie. lt also introduces some tools to 

help you kcep your clips and cditing scssions organizcd. 
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• Chapter 3 covers the basic techniques used to edit clips arid construct a movie in Adobe 

Premiere. It also describes how to generate an Edit Decision List (EDL) from the 
' Construction window for onlinc editing of source videotape in a post-production studio. 

• Chapter 4 discusses how to preview a project without compiling the entire contents of 

the Construction window, and how to set preview options. 

• Chapter 5 describes how yo u use thc more than 70 transitions included in Adobe 

Prcmiere to create eye-catching transitions bctwcen movie or still-imagc clips. 

• Chaptcr 6 describes how to apply video and audio filters to clips to distort, bluL sharpcn, 

smooth, texture, and color imagcs, and to create special effects. Thc chapter also shows 

you how to create motion effects in movic and still-image clips. 

• Chapler 7 explains how to superimpose movie and still-image clips, and how to use the 

Adobe Premiere Title window to create tilles and graphics for a movic. 

• Chapter 8 describes how to compile and videotape movics including selccting output 

options. It also discusses considcrations for digital video compression and using Adobe 

Premiere movies in other applications including Adobe Photoshop·-. 

• Chapter 9 offers general considerations for digitizing hardware and includcs guidclines 

for capturing video including batch-c.apturing video, sclccting rccording options, and 

capturing with timccode. 

• Chaptcr 10 includcs tips 'tnd ll'chniqucs for using thc program 'tnd illustr,llcs diiTcrcnt 
eiTects\·ou ctn ,¡c·hie.ve usi11g the m'tn~· k.t\tlll'S. in ;\dohc· l'remierc. 

• i\ppendix A, "Video 1\,tsics," discusses tite fundamenta!, of video and ,nidio. 

• Appcndix B. "Expressions for Crcating Transitions <ll1d Filtcrs," covcrs thc mathcmatical 

cxpressions used to crcate custom transitions and filters. 

An indcx concludes thc book. 
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CHAPTER 1: BAsic CoNCEPTS 

~-'='#l his chapter contains a short tutorial designed to familiarize you with the basic 
·~':"' ~~~ 
flii~ ~~ concepts of making movies with the Adobe Premiere program. Adobe Premien: 
~~- . . .. . . . 
b'.t~ .. ~ !S powerful v1deo- and audJo-cciitJng software des1gned to be a uscful too! for thc 

professional and novice alike. Adobe Premierc provides a comfortable ancl familiar work­

ing cnvironment for thosc with both film and video expericncc. Those with no video expe­

rience will flnd thc software to be a thorough introduction to the world of desktop video. 

Video and multimedia professionals will find Adobe Premiere a valuablc too! for tasks 

such as video editing (both online and off-line) or creating Video for Windows or Quick­

Time movies for presentations and CD-ROiV!s. /vlanv of the program's features were prc­

viously available only on high-end profcssional vidco-editing systcms. 

In mam· instances, vou will cncountcr tc¡·minolo~\; and interface designs drawn from 
1 j '-'' '-' 

traditional video production ami post-production. For information on thc fundamcntals 

of video and <ludio, scc Appendix A, "Video Basics." 

Note: In this lllllll111ll, commands in s11lmzcn11s ore iwlzwtcd by a prcceding grcntcr-'t!um s 
(>). For exaiiJple, thc instruction "Cizoosc lmport > Projcct from tlzc File IIICII11" mcans tlzat 
you slzo11ld clzoose lnzportfi·om tlzc File IIIC/111 ond Projcct fronz thc s11bmc1111. 

CREATING DESKTOP VIDEO WITH ADOBE PREMIERE 

Adobe Premien: lcts yo u combine so urce material, or clips, to makc a movie, and then view 

and pLn· thc mm·ic using <lll)" <lpplication that supports thc Video for Vhndows or Quick­

Timc movic forma t. Your tina! r\dobc Premien: movic is a file vou crea te aftcr assemblin" 
' b 

and editing clips. 

Clips can includc thc following: 

• Digitizcd video capturcd from cameras, VCI~s, or tape decks 

• Video for Windows or QuickTimc movics mad-c using Adobe Prcmiere or other sourccs 

• Scanncd imagcs or slidcs 

• Digit<li aud1o rccordings ami s1·nthcsizcd music and sound 

• :\clobc l'hotoshop tllcs 

.• 



• Animation files 

• Filmstrip format files created in Adobe Premiere and edited in Adobe Photoshop 

• Titles 

You can create your own video and audio clips by-rccording material to your computer's 

hard disk using a variety of hardware products. For more information on recording to 

your hard disk, see Chapter 9, "Capturing Video." 

CREATING AN ADOBE PREMIERE MOVIE: A TUTORIAL 

Evcry Adobe Prcmicrc movic slarts as a projcct-a collection of clips organizcd along a 

timclinc. This section providcs stcp-by-stcp instructions for building a simple Adobe 

Premierc movic using clips supplicd on your program disks. 

Cre<lting an Adobe Prcrniere movie inmlvcs thc following basic tasks: 

• Crcating a ncw projcct and importing clips 

• Asscmbling clips in the Construction window 

• Viewing and editing clips in thc Clip window 

• Applying transitions ancl filters to thc asscmblcd clips 

• Adding a supcrimposccl ti tic to thc movic 

• Prcvicwino thc movie 
" 

• Compiling thc <fsscmblccl clips into <1 movic <lncl plaring it 

Note: Tlzc stcps(or nzaki ng 11 11101' ic vary dcpcllil i ng on t lzc in tended use of tlzc med ium. Ifyou r 
goal is to makc 11 videotape ll'itlz fuii-Jiwnc inzages, }"Oillllllst undcrstand t!zc capaúilitics and 
limitations ofyour hardware. For injánnation 011 lumilvarc rcr¡uircmcnts, sec Clwpter S, 
"Compiling and \'idcotaping lv!rwics," nnd Clwpter 9, "Copturing Video." 



Create a new project and import clips 

Befare yo u start this tutorial, make sure that yo u have installed the sample clips when yo u 
installed the Adobe Prcmicrc program. If yo u eh ose thc default location during installa­
tion, the samplcs are in thc Slllnplcs dircctory in thc prc111icrc dircctory. Scc Adobe Prc111icn· 
Gctting Startcd for inst1:uctions on installing the program. 

1 In the Adobe group of thc Program Manager, doublc-clickthc Adobe Premicre program 
icon to start the program. Thc l\'cw Projcct Presets dialog box appcars. 

Available ,Erelets 

CD-nOM -Authoung 
CD-ROM - Mastcring 
Offline Video T apc- NTSC 
Offlinc Vrdco T apc- PAL 
Online Video T apc · NTSC 
Onlrne V1deo T aQ_e - PAL 

1;.14fJ,.f,,,,.,W!Brhf;r 
1 P1esentation - 240x180 
Presentatmn - 320x240 
Re·m1x Audm 
Timebase- 24fps ·Film 
Timebase - 25fps - PAL 
Timebase- 30fps- NTSC 

Prcset Description 

·u~e tJ,¡; pre~et Jor gent:-rol purpose. 
'.'IO:•rl . .;,t 1 t.0.-.1 ::"(1 ~·•:-.ds 

Conrp1esso1 \/1d~-o 1 
Fr.sme S1::e. 160-:120 

:f¡ame Rete 15/p':> 

Note: tf unsUic. choosc: 
'"Prescnlation · 160x120" 

OK Jj Caneé! 

Evcrr ncw Adobe Prcmicrc projccl must be assignccl a prcsct. A prcsct spccifics thc projcct 
time base, the movicfr;li11L" r;llc. ;1nd options for comprcssion, prcvicwing, and oulpul. 
l'rojcct prcscts ;lrL· dcscr-ihcd i11 dL·i;Jil in Ch;lJ'lLT 2. 

2 Choosc Prcscntation ( !60 x !20) from thc ,\vailablc Prcscts list ancl click OK. Five 
windows Jppcar: 

• Projcct ,,·inclow, for importing ancl storing clips 

• Construction windm1·, for asscmbling clips 

• lnfo window, for displaying dctailcd information about clips 

• Transitions windm,·, for sckcting spL·cial L"ffccts lransitions bctwccn clips 

• Prc1·icw window, fo1· prL·,·icwing thc mcH"ic as you asscmblc it in thc 
Const ruct ion wi ndow 
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When the program opens, the Project \vindow is the active window. You use the Project 

window to stockpile clips for your movie. 
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3 Choosc Import >File from thc File mcnu (Ctri+J) or doubk-click thc bottom area of 

thc l'rojcct Ívindmv hclow 1 he Llst el ip: Thc !m port d i:llo¡; :1 ppc:u's. 

4 In thc prc111icn· dircctory, loc:llc thc samplc movic clips supplicd with thc program. 

5 Sekct thc spotlitc.nvi movic clip. A prcvicw of thc movic appcars in thc Import 

dialog box. 

frie ~ame Q_rrectorws: OK J 
j spothle av1 e \premrere\:s:amp\1:S: 

flymg.bmp 1+ L:::: e:\ 
Cancel 1 

llymgu.bm.., i-' t:=:- p!l!mrere 
hands.avr ~·~ Network. ... 
overspin.avr :!:¿ (:7_ :s:amples 

rín~s.bmp , .. 
sphls itVI <:;. 

lwul av1 + 

List f•lcs of l_ypc Drl'~cs 

IA11 r Olffidt 1 ypes 1~1 lec 1 ~1 '~potlit.:-100 0::1 

6 To pb)· thc movic clip, click thc 1'1:1)" buttun bcncath thc prc\·icw. 



7 Click OK to import the clip. The clip namc anda thumbnail appear in the Projcct win­
dow. For a movie clip, a t!wmlmnil is an approximation of a framc in the clip. 

8 To import additional clips, choosc lmport >File from the File mcnu (Ctrl+F). Thc 
Import clialog box appears. In the prc111icrc directory, loca te thc sample movie clips 
supplied with thc program. 

9 Hold clown Ctrl and selcct thcvidco clips twirl.nvi and ovcrspin.nvi, the titlc clip 
cirws.ptl, and the audio clip cirws.IV<II'. Click OK to import thc files. 

Assemble clips in the Construction window 

You use thc· Cunstruction ,,·inclow to ;¡ssemhlc clips into a movie. Thc Construction 

window contains multiplc tracks for placins video and <ludio clips. The 1·idco tracks 
includc thc lll<lin video tracks 1\ and B, thc T track for transitions, and thc S tracks for 
supcrimposcd 1·idco clips. Thc lowe1· sct of t¡·acks is for ;llldio clips. Tracks are idcntificd 

in thc vertical har al thc ri'-\ht of thc· windoll'. 

1\l thc topo( thc· C:onstructionwindo\\' is ;1 tune mlcr that indicatcs cl.lpscd time in thc 

mm·ic. Thc· tick lll<lrks on thc· rulcr can represen! ;\lll'thins from a sinslc framc to <1 
2-minutc intcn·;¡J, clcpcnclins onthc· time· unit sclcctcd. You can use thc slidcr at thc 



bottom of the Construction window to change the time unit, thereby changing the 

leve! of detail displayed in the window; a smaller time unit causes more frames in the 

clip to be displayed. 
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1 Position thc pointcr over thc thumbnail of thc .<potlitc.!lvi clip in the Projcct window. 

Thc pointcr changcs toa hand. 

2 I-lold down thc mousc.button, and drag thc clip onto thc top track (track A) ofthc Con­

struction window. Thc track turns dar k gr;1y to show whcrc thc clip will be placed. 



3 Drag to align the left edge of the clip with the left edge of the Construction window. 

Release the mouse button to place the clip. 

\·Vhcn yo u place a clip in thc Construction ll'indow, it is displayed as a series of thumbnails 

th;l\ represen\ framcs of thc clip. Thc ll'idth of thc strip of thumbnails rcprcscnts thc dura­

tion of thc clip. Yo u cm movc clips in thc Construction window by dr.1gging thcm. 

4 Dr<1g thc ~1virl clip from thc Projcct window onto track A so th<jl its lcft cdgc butts up 

against thc right cdgc of thc Spot!itc clip. 

Positioning thc two clips likc this crea tes .1 cut, m transition, from thc Spot!itc clip to thc 
T11·¡r/ clip. 

Preview the movie 

Yo u can prc1·icll" thc mm·ic at <llll" time to vicll' thc rcsLÍits of your work in thc Construction 
\1"1ndo11·. 

) 



1 Place the pointer in the time ruler at the top of the Construction window. The pointer 

changes toa downwardcpointing arrow. 

Cursor position 
in the time ruler 

2 Hold clown the mouse button. The Preview window displays the movic frame that 

corresponds to the current location in the time rulcr. 

~ .. 

Note: !f thc pointcr is 1101 positioncd corrcctly. thc Controller window 11111)' nppcn.r whcn 
yo u hold duwn thc 1110IISC llll/1011. Iftlli:: lwppcns, sirnpl)' closc thc Controllcr 1vindow nnd 
tri' non in. 

' " 
3 To play a prcvicw of thc movic in the Prc\·icw window, drag to the right whilc holding 
down thc mousc button. Note that whcn thc t1rst clip cncls, thc second clip bcgins playing. 

Change the duration of a clip 

i\ftcr prcvicwing, HlU mav dc·c1dc· th.rt mu don't nccd to include an en tire clip in your 
movic. You cm use thc Clip \\'Índow to vicw ~r clip and choosc which framcs you want to 
includc in the Construction \\'Índow. Thc framcs that are íncluded are dcfined by thc clip's 

in ¡){)illt ( thc position of thc starting framc) ami 011/ point (position of thc cnding rr:1me). 
Thc proccss uf changing thc·sc points is crllcd triunnin¡; the clip. Ch,mgcs madc toa clip in 
thc Clip window ~m: automaticalh· applicd tu thc clip in the Construction window. 

// 
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1 Double-click a thumbnail of the Twirl clip in the Construction window. 

The Clip window opens with the starting frame of the Twirl clip. Notice that an in-point 
indicator appcars in thc uppcr-lcft corncr of thc window. 

ln-pomt 
indicator 

Stop button 

-- loop button 

Clip dur,lllon 

Controls for vicwing and playing the clip are locatcd in thc lowcr portian of thc' window. 
The frame indicator in thc centcr displays thc addrcss of thc currcnt framc in thc 
Societ1· of ivlotion Picturc and Televisicm Engincers (SMPTE) timecode format 

' e 

(Hours:ivl in\Jtcs:Seconds:Framcs ). Bclow thl· frame indicator, thc duration of the clip 
is displayccl using thc samc formal. (For more information on timccoclc, scc "SMPTE 

Timccodc" on pagc 20·1.) 

2 Click the Plav button to pby thc clip in thc Clip window. You can also clrag the slider 
control or the )og control to vic1,· thc clip as it plavs in thc forward or rcvcrsc dircction. 

3 Drag thc slickr bar (locatcd to thc lci"t of thc Play button) hack to rcwind thc clip 
until OO:Oil:02: 17 ;1ppc.1rs 111 thc fr.1n1c imlicllllr. l'or more prccision in loc1ting thc framc, 
drag thc )og contrlll ;d)()n· thc siidcr h<lr, use thc Framc Forwarcl <lnd Fr<llllC Backwarcl 
buttons, or use thc Lcft and IZight :\rrow kc~·s. Thc displaycd framc will be thc ncw out 
point for thc clip. 

- S!idcr bar 
•- Clip durJtiOn 

·• 



1 ~ 1 1 

4 Set the new out point by clicking thc Out button in the lower-right corner of 

the window. 

An out-point marker appears in thc uppcr-right corner of the window. Thc clip is 
shortencd in the Construction winclow accordinglv. 

Note: !'!m ctm nlso dmg tlzc cdgcs o/ o clip in tite Construction window to c/wngc its in 
nll(/ out points. For Jnorc inj(nnwtiun 011 sctting in n/1(1 out points, scc "Trinnning Clips'' 
on pngc 76. 

5 To kccp th<; scree11 from bccoming too cluttcrccl, clase the Clip wi11clow whc11 yqu ha\'e 
finishcd ;1djusti11g thc clip duratio11. . . .. 

Trim clips at the cut point 

Thc most accuratc wav to changc thc in points a11d out points of clips whilc gctti11g instant 
feedback on thc c!Tcct in thc Construction wi11dow is to use thc Trimmi11g wi11dow. The 
Tri mm i 11g wi ndow lcts vou si mul t;tncousl y e ha 11gc the i 11 poi 11 ts a 11d out poi nts of the clips 
011 both sidcs of a cut. 



1 Click the right arrow under the Construction window's Play button to m ove the edit !me 
to the cut between the Spotlite clip and the 7il'irl clip. 

C------------·J-l-f--11- Ed1t hnc 

· 2 Choosc Trimming from thc Windows mcnu. 

The Trimming window appcars, clisplaying thc framcs on the lcft and righ t si des of thc cut: 
the out point of thc Spotlitc clip and thc in point of thc Twirl clip, rcspcctivcly.' 

~ EdJt lmc lelt 
and R1ght buttons 

j~ Page pecl 1cons 

·- Add and ~ubtrMt 
fr<Jmc~ 

In this case, thc out point ofthc Spotlitc clip is <liso thc last framc ofthc sourcc clip, as indi­
catcd h1· thc red pagc pcclrcon in thc cornc-r of thc clip. Likcwisc, thc in point of thc Twirl 
clip.is also thc lirst framc of that sourcc clip. 

3 Click thc· -1 hutton undn thc· kCt clip (Sfl<>tlu,·) thrcc times to subtract thrcc framcs 

from thc out ¡'oint of th.1t cli¡'. 



Notice that the edit line moves to the left in the Construction window as thc out point 

changes, and the clip to the right of the edit point ( Twírl) shifts left. The total number of 

frames subtracted from the out point appear at the bottom of the.Trimming window. 

L Total number of frames subtracted 

\'\'hcn you trim clips in the Trimming window, clips and transitiom on other tracks shift 

right or left to maintain thcir positions relativc to thc clip being trimmed. You canlock 

individual tracks to kccp thcir contcnts from shifting during editing. For informalion on 

track locking, see "Locking Tracks in lhc Construction \Vindow" on page 94. 

4 Click thc -S button undcr the right clip ( Tw¡r/) to subtract five framcs from the j_n point 

of.that clip. Nolicc lhat thc 7\vir/ clip shortcns in the Conslruction window. Now click th~ ,_ 
+ 1 bulton to add back onc framc to lhc in point. 

5, Click thc Plny button lo prcvicw thc cdils in thc Trimming window. Thc ,,·indow plays 

thc fivc scconds of lhc clip th<ll surround thc cdit point. (You can scl ,1 differcnl I1umber 

of óCConds lo includc in thc l'rcvicw ,1s 011c of thc Trimming window options.) 

6 Closc lhc Trimming winclow. 
' 

Add transitions 

You can crea le gr.1dual transilions bctwccn clips. Howcvcr, clips must be loc.1tcd on the 

separa le video tracks ¡\ ancl B tu apph- <1 tr,111sition bctwcen thcm. 

1 ivlakc thc Construction windol\' acti,·c b,· clicking in lhc window or by choosing 

Construction from thc \Vincluws m en u. 

.. 1Z 
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2 Drag the Twirl clip from track A to track B and position it so that the clip overlaps the 
Spotlite clip on track A by approximately l inch (slightly less than l sccond on thc time 

ruler). The amount of overlap determines the length of the transition. 

00 000 

3 ln thc Transitions winclow, scrollto thc Cross Dissolvc transition. (Yo u can a !so typc thc 
firsl lcttcr ora transition lo scrollto th.ll transition.) 

4 Click and drag thc transition onto thc T tr.Jck bctwcen thc two movic clips. As yo u dra, 
thc transition onto thc spacc whcrc thc two movic clips ovcrlap, the-program automati­

olly adjusts thc lcngth of thc transition to lit thc ovcrlapping scction. 

1 -1 Construction Window 

1~ '~ 1 

5 l'rc,·ic"· \'Our mo,·ic· o1gain h,· ho 1ding do\\'n thc mousc button and clragging thc arrow 

through thc time rulcr. 1\:cllJcc he"'· thc Sf'otluc clip gradually !"a des out whilc thc "11t'irl clip 
L1dc;; in. 

\:cxt, vou \\'ii!.Jdcl.llwthcr clip oJJld tr:1nsition. 

/o 



6 Drag the Ovcrspin clip from the Project window onto track A and posirion it so that it 

overlaps the clip on track B by approximately 1 second on the time ruler. 

7 In the Transitions window, scroll to the Iris Round transition. 

8 Drag thc transition onto thc T track bctwecn the Twirl clip on !rack B and the Ovcrspin 
clip on track A. 

•. 

In most situations, Adobe l'rcminc ,;utom.ltic.llh- scts thc corrcct dircction of a transition 

whcn it is pl.lccd bctwccn clips in thc Construction window. In this case, a circular wipc 

should rcvcal thc imagc on track A as it rcplaccs thc im~1gc on track B. 

/ 
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9 To check the direction of the Iris Round transition, double-click the transition in the 

Construction window. The Iris Round Scttings dialog box appears. 

Start = 0% Finish = 1 00% 

B A 
,. 

Bordcr Color 

~ 
O ~how Actual Sowces 

·oK 1 Cancel 

Thc animatcd display in thc lowcr-right corncr oC the dialog box should indica te that 

imagc A is wiping over imagc B. Ifthis is not the case, click thc bluc arrow to thc lcft ofthc 

display so that the arrow is pointing upward. 

10 Click OK. 

Change the time unit in the Construction window 

At this point, vour mm·ic is a;'proxim;ltch· S scconds long. Dcpcnding on thc sizc of thc 

Construction window on vour monitor, thc en tire mm·ic ma;· not be visible. To scc more 

framcs ofvou¡·movic in thc Constnlction11·indo11·, changc thc time unit. Thc· time unit is 

currcntlv sct to 1 sccond, which mc;Jns that thc Construction window displays 1 thumb­

n;Jil for cach sccond of a clip. 

/.::;,' 



1 Drag the slider at the bottom of thc Construction window to the right one notch. The 
time unit changes to 2 scconds, which means that the Construction window shows two 
thumbnails for every 2 seconds of <1 clip. Conscquently, yo u can see more of the movie in 

the Construction window. 

T1me umt selector 

2 To quickly sec thc en tire movic in thc Construction window, no mattcr how long the 
movic is, prcss the backslash kcv (\) while thc Construction window is active. Thc time . . 
unit selector adiusts accordingl:·. 

Apply a filter toa clip 

You can apply 111ters to clips to changc their appcarancc or sound. Adobe Prcmiere 
inclucks more than 70 movic ancl still-im<lge filtcrs and 5 audio filters. 

1 Click thc -¡¡,.¡,.¡clip on tr<lck B to sclcct it. :\ dashccllinc <lppcars arouncl the borcler of 
thc clip. 

2 Clwosc Filtcrs from thc Clip mcnu (Ctri+F). Thc Filtcrs clialog box appcars. 

You <.:<111 also position thc pointcr ovcr thc sclcctc~l-::lif' in thc Construction window ami 
click thc right mousc hutton to dispLn· <1 pop-up llll"llllllf commonly-uscd commands for 
clips. To choosc a filtcr from thc pop-up mcnu, click thc lcft mousc button on Filtcrs. 

,, 



3 Scroll through the Available list and selcct the Hue & Saturation filter. 

lmage Pan 
lnverl 
Leos Fl<ue .. 
levels 
Miuor 
Pmch ... 
Pointillize ... 
Polar Comdinales .. 

:·Itero: 

Cu11cnt 

DK 

Cancel 1 O lt~rí.:· 

4 Click Add. Thc J-lue & Saturaticin Scttings dialog box appcars. 

Min Max 

Huc t==::CJ---~ ·108' 

Soturation ~ 100:.; 

lightncss r===·:,- 118~; 

5 Drag thc Hu e sliclcr to changc thc color of thc clip. 

6 Drag thc Lio;htncss slidcr to lightcn thc clip. 

7 Click OK ,,·hcn you IL\I'L' linishcd adjusting thc scttings. 

Apply another filter to the same clip 

You can .1dd multipk liltcrs to ;¡clip. :\dohc Prcmicrc ;lpplics thc liltcrs in thc ordcr that 

you list thcm in thc Currcnt list in ti1L' FiltL'I'S dialoo; box. 

Whcn you pial' thc 7i\'/l'/ clip in thc Clip wrndllll', you c.1n scc a dark bordcr ;dong thc 
bottom and lcft cdgcs of thc clip. llordLTS .rrc frL·qucntly causcd by video noisc during 
thc captllrc proccss. You can rcmm·c thc hordcr h;· cropping thc cdgcs of thc clip with thc 

Crop liltcr. 



1 Select the Crop filter from the Available list; then click Add. The Cropping Settings 

dialog box appcars. 

· . .. . .. Cropping Scttings. '·._ .. ;;;;.; '-~';:·;,· 

Lefl: O 

Units:: 
@ Pixe·l~: 

O Percenl 01( 

Aight: O 

e 

j Cancel 

The dialog box contains a previcw image from the clip and slider controls for trimming 

unwantccl pixels from the edges of the clip. Note that the preview of the clip shows the 

effccts of the Hu e & Saturation filter. · 

2 Selcct the Pixels option, ancl then cirag thc Bottom slidcr to the right until it rea0s 2 

(pixels). Do thc samc with thc Lcft slidcr. This crops thc imagc by 2 pixels on thc bottom 

and left sidcs. (Adobe Prcmiere rcsizcs thc croppcd clip to its original frame sizc.) 

3, Click OK to_ clase thc Cropping Scttings dialog box; thcn click OK to el ose the Filters 
· di;dog box. · 

Thc program adds a bluc line at the top of the clip in thc Construction window to indica te 

that onc or more filtcrs havc bccn applicd. 

Use the Preview command to preview the transitions and filter effects 

Thc Prcvicw command provides a more ;¡ccurate way to previcw than dragging through 

the time ruler. You spccifv which p;nt of thc Construction window is pre\·icwcd by posi­

tioning thc vellow h;¡r ;¡( thc to¡' of thc· window . .-\11 clips, tr;msitions, ;md filtn cffects 

locatecl hencath thc ;·cllow work are;¡ har Me pt-c\·iewcd whcn you choose thc Previcw 

command. 

1 Savc thc pro_iect b;· choosing Sa\·c from thc File mcnu (Ctri+S) and tvping a name for 

the proiect. Yo u cannot prc\·icw an uns;wed proicct. 

~-



2 Posirion the pointer o ver the red trianglc at the right edge of the yellow bar. 

Work area bar 

3 Click and drao to thc rioht until thc rioht cd<>c of thc vcllow bar ;dions with thc rioht 0 b b b ¡ b o 

edgc of thc Ovcrspin clip on trae k A. 

4 Choosc l'rcvicll' (rom thc Projcct mcnu, m prc·ss l~cturn. 

AdobL· Premien: dispb1·s thc Building i'rL'I'iCII' dialog box allCI givcs a time cstimatc for 
compiling thc prc1·ic\\·. :\ftcr a t~c\\· momcnts, thc prcvicw plays in thc l'rcvicll' window, 
shm,·ing thc Spot/l{c clip, thc ·¡¡,·ir/ clip with thc liltcrs applicd, and thc two transitions. 

5 Prcss Rcturn to scc thc pt-c,·ic"· ag.tin. This time, vou don't havc to wait for thc prcvicw 

to hc hui! t. 

Add a superimposed title to the S 1 track 

:\dobc Prcmil'l'c trL·ats titlcs .Is clips. Thc;· ,J!'L' usu,dl;· addcd toa supcrimposc (S) tr.Ick so 

that thL'I' can be supl'l'imposcd, or k<')'<'ti, m-cr ;¡ mm·ic clip. You can changc thc duration 
of a tille clip!)\· chooslllg Duration fmm thc Clip mcnu or bv dragging thc cdgcs of thc 

clip in thL' Constructton 1\'indt>\\·. 

21 
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1 Drag the Circus.pt! clip from the Project window onto track S l so that the left edge of 

the clip aligns with the beginning of the track. 

2 Position the pointer over the right edge of the Cirws.ptl clip. The pointer changes into 

a stretch pointer. 

Stretch pointer 

3 Drag thc edgc of thc clip until it aligns with the left edge of thc Tlvirl clip on track B. This 

cxtcnds thc duration of thc ti tic clip ro approximatcly 2 scconcls. 

4 With thc Circus.ptl clip sckctcd in thl· Construction winclo\1', choosc Transp.1rcncv from 
thc Clip mcnu. Thc Transp:ncncy Scttings cktlog box ;1ppcars. 

You can also position thL· pointcr m·cr thc clip and click the right mousc button to display 
thc Construction \\·indt>\,. po¡'-lll' mcnu. Chnosc Transparcnc:' from thc pop-up mcnu. 



5 To key the title against the background imagc of the Spotlité clip, choose White Alpha 

lvlatte from the Key Type drop-down list. Adobe Premiere uses the title's existing alpha 

channel to crea te a mask for superimposition. For more information on working with 

superimpositions, see "Superimposing Clips" on page 175. 

··· ·· ··· Matte · ··· · ··· --- ·-·Color · -

¡· _GhooJ;C ... J 

DD 
,Kcy lype· \1/hrte Alpha Matte 

Non e 
Chroma 

"·" AGB Diflcrence 
luminance 

........... ·····-· Alpha Channel 
Rlack Alpha Malle 

Jmage Matle 
· Difference Malle 

Blue S creen 
Green Screen 

IMultrply 
~S creen 

J T rack M a !te 
·INot Red 

·· ·· -· Sample · 

RINGS! 

O !lef<!rse K e}' 

O [~rop ~;h,uiow 
O _!:.!.n~ Ooly 

~moothing !~lnnc l±j 

OK Cancel 

6 To »ce a prc\·icw of thc titk ovu thc actual b.1ckground imagc, click thc pagc pccl icon 

unclcr thc Samplc hox. 

~ 

1 

1 
1 

1 . ¡;¡¡j[J~ 
1 !.-

·- Pí!gc pcclrcon 

7 Click OK. 

Note: "Jhc Circus.¡,tl cli¡> 11"11.< ,.,.crucd ,,.¡¡/¡ tf¡,· :\doh· l'rclllicrc Titlcr. For 111jimnution 011 

u~iuy, ihc Tn!cr, 5cc ''Crl'ttlill::!, Ii1!t'/' on ,no,~!_L 18CJ. 

2 
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Add sound to the movie 

Yo u a del sound toa movie by dragging audio clips onto the audio tracks in thc Construc­

tion window. 

1 Drag the thumbnail of the Cirws. wav clip from the Project window onto audio track A 

in the lower half of the Construction window. 

2 Align the lcft edgc of the audio clip with thc left cdgc of the Construction window. . . 

3 To prcview your movie with sound, <ldjust thc yellow work area bar to sclcct the part-of 

thc movic you want to previcw, and prcss Rcturn. 

Compile and play the final movie 

\Vhcn you have finishcd assembling clips in thc Construction window and are satisfice! 

., 

with thc previcwcd results, :·ou are rcady for thc program to crea te; or compile, thc final ·•:. 

movic file. You can compile a movic into thc Video for Windows file format (.m·i) or in the 

QuickTimc f01: Windol\'s file form<lt (.11101'). 

1 Save thc changcs ro u ha ve m a de to the project by choosing Savc from thc File menu 

(Ctrl+S). It's all\'ays a good idea to S<lVe your project oticn as )'OLI work. 



2 Choose Make Movie from the Make menu (Alt+K). The Make Movie dialog box 

appears. 

File ~ame: Qnectmies: 

IGl!l um nz. e: \premiere \projecl 

clo.:;eup <l'fl 

crosspos . .Jvl 
/o!lfwd.<WI 
/m,¡J!Jow aT·i 
~wnds av1 
UYP!Sp!O <IYI 

splil ~.avi 
snnll1!t: '"': 

+ 

Make: \1/orlr. Area as AVI Movie 
Video 160 x 120 @ 15/ps 

Be:\ 
~ premiere 

~ project 

DJiv~:s: 

f i2l e: 

Compression· 'M¡crosolt Video 1' @ 757. 
Audio: 22Khz · 8 b1t -Mono 

Qutput Options ... 

li.l 

· Compression ... 

Networ¡¿ __ _ 

3 Click Output Options. Thc Project Output Options dialog box appears. 

.Q.utput. /Work. Area 

· ··· ·- -------··®~ideo 

.l_ypc IFull S1ze Frame 

O _!iecp when lmJShed 

[J Upr.n rmishcd Movie 

i±¡ 

@ ,1udru 

flatc j 22 k Hz 

[mmal ~Mono 

T fl>C. ] Uncompressed 

1~ 

tntc..:dcave·jl Sccond =w 
'OK Cancel 

This dialog bo;; kts 1·ou changc ch:1r:1ctnistics of thc final mm·ic, including sizc, framc 

ratc, compression t)-pc, and (urmat. Scc C:haptl':· 0, "Compiling ami Vidcotaping Mm·ics," 

for a complete dcsuiption of output oplions. 

4 ,\·lakc surc lholl lhc· O¡'l'll l'inishcd i'vlm·ic· llJ'lion al lhc hottom of lhc dialog bo;; is 

sckclcd. This n¡1lion lclls thc pro~r,1111 lo npcn lhc nwvic whcn it has linishcd compiling 

ancl s:11·in~ thc nwvic. 

5 Lc',l\T thc· othcr oplions at lhcir currcnl scltings (lhcsc wcrc scl 1\'hcn I'OU chosc a projcct 

prcsct), ami click OK. 

6 !';ame thc· nwvic in thc :\lakc i'vlovic clialog hm, ami click OK. :\ prosrcss har appcars 

whilc :\dobc l'rcmicrc compiles lhc n~cwic. 
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When the. movie has been compiled and saved, Adobe Premiere opens the movie in a 

Clip window. 

7 To play the movie, press the Play button in the Clip window. 

- Play button 

Play the movie using Print to Video 

You can use the Print to Video command to pby a movie in thc center ofyour screen, with 

thc rest of thc screen blacked out. Print to Video is also used to output a ímished movie to 

videotape. For information on making videotapes with Adobe Premiere, sce Chapter S, 

"Compiling and Videotaping Movies." 

1 Click the Clip window to makc sure that it is the active window. 
< ..,-·· 

2 Choose Export > Print to Video from the File mcnu (Ctrl+i'vl). The Print to Video dialog. 

box a ppe;¡ rs. 

3 Lea ve thc options as thev an:, ;¡nd click OK. Thc scrccn gocs blank for l sccond, and then 
. - . 

the movic plavs in thc ccntcr of thc SCITC!l. 

Thc Adobe Prcmierc·fHOgram disks indude a samplc projcct and its clips, which you can 

opcn and makc into a movic. You should look through this guide to familiarize yourself 

with Adobe Premiere's features; then examine thc sample project and make a movie to 

learn more about how Adobe Premierc handles clips, transitions, and superimposed 

1111agcs. 

If yo u ha ve thc Adobe Prcmicre ckluxc CD-ROl'vl anda CD-ROJ'vl drivc, vou can also 

explore thc sample movies and tl:c cxpcrt tips and techniques that are included on the 

CD-ROI'vl. For more inform,ltion about the dcluxe CD-ROM, see Ado!JC Premicre 
Gctting St11rtcd. 

- ) _., ' 
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CHAPTER 2: AssEMBLING AN ADOBE 

PREMIERE MoviE 

~J:C¡¡·,-\,~ his chapter describes how to start an Adobe Prcmicre project and how to work 
W"~ ~·· 
¡;;~~ ~¡;¡ with the Project and the Construction windows to assemble a movie. It also 

~;:7,';0~ introduces some tools to hclp kcep your clips and cditing session organizcd. 

The basic approach to asscmbling a movic consists of importing clips into thc Projcct . 

window and asscmbling them in lhc Construclion window. As yo u work in thc Construc­

tion window, you can previcw hm,· the movic will play. Depending on thc typc of movie 

you want to create, you can perform simple or advanccd editing operations. 

As you rcad this ch~wter ancl thc following chaplcrs on prcvicwing, crcating transitions, 

spccial effects, and supcrimpositions, kecp in mind that thcre is no absolutc ordcr in 

which tasks must be pcrformcd. Once you are L1miliar with thc various Adobe Premiere 

windows, you will be ablc to decid,· ;tl which poinl vou want to pcrform a given task. 

PLANNING THE MOVIE 

1: 

Befo re crcating, a movie with Adobe l'rcmiere, 1·oumav want to write o:tsimple description .. 

of the sequcncc of major actions, or 5hots, in thc móvic. Yo u m ay al so want to crea te a series 

of sketchcs, calkd a storybonrd, that outlincs thc beginning, transitions, spccial cffccts, 

sound, ami ending of thc movic. 

Ncxl, decide whal sourcc liks, or chrs, vou wanl lo include in your movie. For examplc, 

an Adobe l'rcmicrc moYic·m1ghl includc ;¡ portion o( ;tmovic (a 11/0t'ic clip),;¡ samplcd 

rcClnding (;mnudio clrp), allll an1\dobc l'holoslwp or ;! bilmappcd imagc. 

Fin;t]!l·, decide how :·our mo1·ic will he· ;'Lt:·ccl. i'm cxamplc. you ctn oulpu! !he movie lo 

Yidcol;tpc for plavh;tck 011 !;tpL· ckcb, compik !he 1110\'ic as;¡ Video f(¡r \·Vindows or 

QuickTimc 1110\'IL' for pLtdJ;tck (rum ;! Cl) or di1·cclly on a dcsklop compulcr, or use lhc 

movie to gcncr.nc an Edit Dcc!Sion L1st for onlin,· cditing of source videotape in a post­

production studio. 1--:nm,·ins hm,· mur ncovic 1dl he playcd back will hclp you decide 

what comprcssion scttings .me! prc,·icw options tn use whilc vou are cditing your movie. 

HOW ADOBE PREMIERE WORKS W!TH FILES 

Whcn vnu impon a .:lq1 into ;l!l :\dohc l'rcmicrc prujcct, thc sourcc file does 1101 bccomc 

p;1rt of yo m .-\do he Prcm1crc prujc·.:t. Thc actu;tl file., can take substantial quantities of 

me mor:-, which would makc 1mrkms ,,·ith thc·m dit.ficult. Jnstcad, an1\dobe l'rcmiere clip 

contains <1 poinlcr lo thc >o urce lile slorcd on 1·our hard disk. Thc clip bch;wcs ,ts ifit wcre 

-·o 
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the so urce video or audio recording, but it is actually a sample, ora set of tlnnnlmails, of 

the so urce file. You work exclusive! y with the thumbnails. If other users háve access to your 

sourcc files (on a hard drivc or on a nctwork), they will be unablc to use or manipulate 

them while you are working with them in Adobe Premiere. 

Note: Bccmtsc a clip is only a referencc to its SOltrce file, do not throll' mvay thc source files 
whilc yo u are using thcm as clips inan Ado/Jc Premierc projcct. Once yo u ha ve u sed thc A1ake 
Moví e COIIlllliliUi to lnlÍld a movic, yo u can discard thc so urce files if yo u do not planto 
continuc editing tite projcct: 

WORKING WITH PROJECTS 

Once yo u ha ve decided which clips yo u want to use in your movie, yo u are ready to crea te 

a new project. A project is analogous ·,o a road map of your movie. ¡\]] of your editing deci­

sions are saved in the project. 

You can onlv havc one Adobe Premicre projcct open ata time. You start a ncw project by 

choosing Ncw > Projcct from thc File m en u. This procedure is prcscnted in "Crea te a New 

Project and lmport Clips" on page S. 

Selecting a project preset 

To start a ncw projcct, yo u must sclcct a prcsct. Prcscts spccify the projcct time base, movie 

framc ratc, comprcssion schemc, pt-c\·icw options, and output options for thc project. 

Each ncw projéct opcns with thc Ncw Proicct l'rcscts dialog box. 

CD-ROM - Aulhoring 
CD-ROM - Masleting 
OHhne V1deo Tape- NTSC 
01/lmc Video Tape - PAL 
Onhne VideoTape - NT SC 
Online Video T a e - PAL 

Presentatmn - 241hd BU 
Presentalmn · 32UK240 
Ae·miK Audm 
Timebase · 241ps -film 
T imebase · 25/ps: - PAL 
T rmebas:c - 30/ps - N T SC 

P1esel DcsCJiplion 

:u>-:- th1: c':-=-~~t íor g-::ta:"rd! PW~(·:-:: 
\'lüll, ::ltt.ú-.1::'1) PI·~!: 

,Co:-npr~~~or V1d.:-o 1 
Fr¿rn~ :.¡;:¡;. 1€.0-1.?0 

Note· il unsurc. choosc: 
''Prescntallon - 1 GllKll.O" 

OK f 1 Cancel 



Each available preset is optimized for a particular type of project, such as off-line editing, 

outputting to video tape, or creating a CD. Adobe Premiere comes equipped with severa] 

presets, which you can editor use as the basis for new presets. Yo u can see a short descrip_­

tion of each preset by clicking in the list. All settings can be changed once the project has 

be en crea te d. 

Loading or modifying project presets 

Yo u can load any existing preset into an open project. The projcct will be updated to rcílcct 

all scttings in the new prcset.ln adclition, you can moclify existing projcct prcscts for la ter 

use when opcning new projects. 

To load an existing prcsct: 

1 Choose Presets from the Make menu. The Presets dialog box appears. 

2 Select an avaibble prcset from the right column. ;\ description of thc p.resct appcars in 
the lower-right corncr of the dialog box. 

3 To load the selected preset into the projcct, click Load. 

4 Click OK. Thc curren! scttings for thc pruject ar-e updated. 

To add or modify a prcset: 

1 Choosc Prcscts from thc :"vlakc mcnu. Thc l'resets dialog hox appcars. 

2 To base the ne11· or modif1cd prcsct on an cxisting prcset, load thc prcscl using the 

preceding proccdurc. 

3 Tu chanl!c thc current scttinl!S listcd on thc icft si de of thc dialol! box, use the Time Base, ... , '- ... , 

Compression, Output Options, and l'rcvicw Options buttuns. 

For more information on out pul ,1nd comprcssion optiuns, scc Chaplcr ti, "Compiling 

and Vidcotaping iv!ovics." For more informal ion on prcvicw options, scc Chapter 4, 

''Prc\·ic\\'ing ,1 fvlovic.'' 

4 Click Scwc. Thc Prcsct Na me di,rlog hox :1ppcars. 

5 En ter a na me and dcscriptitln for thc pn:s,·:. Use a new na me if vou are adding a 

ncw prcsct. 

6 C:lick OK. Thc presct is mocliliccl or addcd to thL' Availablc l'rcsets list. 

7 Ciick OK in the Pr~scts dialog h<>x. The currcnt scttings for thc projcct are upclatcd. 

J 



Setting a project's time base 
' Every project has a timr b11sc. The time base determines how Adobe Premiere interprets 

imported clips and lets the program know how many frames make 1 second of a movie. 

The time base is expressed as arate, but has nothing todo with the actual playback rate of 

your movie. (The playback rate is determined by thc value yo u specify in the Compression 

Settings dialog box and by the limitations of thc target platform.) 

The time base affects the way clips are rcprcscntcd in thc Project, Clip, and Construction 

windows. For cxamplc, thc tick marks in thc Construction window's time ruiCr rcllect thc 

valuc of the time base. Sin ce thcrc <lrc scvcr<li standards in use today, spccifring thc one 

you want Adobe Prcmicrc to use ensurcs th<lt you and Adobe Prcmicrc are mcasuring the 

duration of clips in the same way. 

You initially set the time base when you choose the preset for a ncw project, as describcd 

in the preceding section. You can also change thc time base for a project by clicking the 

Time lhsc button in the Prescts dialog box. The time base can be set to the following rates: 

• 29.97 frames pcr second (fps), the N<ltional Telcvision Stambrds Committcc (NTSC) 

standard, which is used for broadcast-qualit:· videotape 

• 30 fps, a rounclecl vcrsion of NTSC \'ideo, which is somctimes used for non-broadcast 

videotape 

• 25 fps, the European tekvision standard 

• 24 fps, the rate at which film is proicctcd 

When setting the time base for a proicct, m u should considcr thc frame rate of vour tina! 

movie. \-Vhcn vou compile vour f1nal mo\·ic, :\dobc Premierc interpola tes dol!a from the 

project framc rate into thc compilcd mo\·ic frame ratc. Ifvour f1nalmovic will be compilcd 

ata diffcrcnt framc rate than thc time hc1sc, \'(lll should sckct a time ba>c th<lt is a multiplc 

of thc frame ratc tu ensurc that data is not lost cluring interpoi<ltion. For cxamplc, if yo u 

wo1nt to output a final movic oll ¡:; fps, ,·ou should sctthc time base to 30 fps hccausc it is 

~ multiplc of 15. ¡¡· nn1 W<llll to mitput ol linalnwvic at 12 fps, sct thc time hase to 24 fps. 

Saving projects 

Saving <l projcct S<l\'l'S all of :·our cditing dccisiuns ancl pointcrs toso urce clips. It also savcs 

thc last arrangcmcnt of thc program's windows. lt is a good idea to savc vour proiccts 

frcqucntly as vou work with thcm. 

To work with a proiect ;1g<1in. all ofthc original so urce m.ltCI'ialmust be a\·ailablc. To avoid 

h<lving to reiocate :·our sourcc lile> e~ch time :·ou opcn a project, you should not move or 

rell<llllC thc projcct's sourcc ci1J1S or prl'\·icw files. 



Opening existing projects 

Yo u open an existing Adobe Premiere project by choosing Open from the File m en u or by 

double-clicking the file in the File Manager. Adobe Premiere projects ha ve a .ppj filename 

extension. 

U pon opening an existing project, yo u may be asked to loca te so me of the clips or preview 

files associated with the project.lf yo u ha ve changed the file names or moved the files, use 

the scrolllists· in the Loca te File dialog to loca te and select the files. Yo u can ignore a file by 

dicking Skip in the dialog box, or ignore all missing files by holding clown Ctrl and 

clicking Ski p. Adobe Premiere then opcns thc projcct with thc availablc files. Yo u will h<lVe 

to regenera te any missing prcvicw files during thc Prcvicw or l'vlilkc Movic opcratio11s. 

Merging projects 

Adobe Premie re lcts yo u a cid the contcnts of a11 cxisting project to the currcnt projcct. This 

feature allows you to break up a largc projcct into smaller, more ma11ageablc picccs a11d 

then mcrge the individual pieces back togcthcr when you are rcacly to asscmblc your 

movie. Yo u can adcl a projcct to the bcginning or end of the current projcct, or insert the 

project at thc cdit line. 

When you merge a project, its clips are addccl to the Project winclow in a folder, and its 
~ - :. 

assemblecl clips are aclclecl to thc Constructio11 winclow at the location yo u specified. All of 

thc mcrged projcct's spccial effccts (transitions, filtcrs, motion settings, ancl so on) are also 

acldcd. lf additional tracks are requircd in thc Construction winclow, thcy too are adcled. 

To mergc a projcct witl~ thc currcnt projcct: 

1 Choose lmport > Projcct from thc r:ilc me11u. Thc Impon dialog box appcars. 

2 Sckct thc projcct vou wa11t to mc:·~c, a11d click OK. Thc lmport Projcct clialog box 

appcars. 

3 To spccify whcrc yo u wa11t the proicct addcd to thc current projcct, sclcct Bcginni11g, 

Edit Linc, or End, a11d click OK. 

lf yo u adcl the projcct at thc cdit li11c, thc cffcct will be the samc as performing an insert 

cdit. ,\ll u11lockcd tracks are split at thc cdit linc, and their contents shift to the right to 

accommodatc thc addcd projcct. For more information on insert ecliti11g, see "Pcrforming 

l11scrt a11d Ü\'<.:rLn· Edits" 011 pagc 91. 

Trimming projects 

As m u work 011 a projcct, \'OU sct nc·\\· in points and out points for clips. ( For information 

on setting in a11d out poi11ts, scc "Trimming Clips" on page 76.) Your projcct m ay cnd up 

ll'ith mam· scgmcnts that are a fr~1ction of thc sizc of thcir so urce clips. Thc projcct coulcl 
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also use severa! segments from thc same source clip but in different locations. Beca use 

video clips can take up large amounts of hard disk space, yo u m ay want to tri m the 

project so that unused frames are removed. Project trimming is especially useful for 

archiving projects. 

vVhen yo u tri m a project, Adobe Premiere crea tes a copy of thc projcct. In the new project, 

each clip's original in and out points beco me the new beginning and ending of the clip, 

respectively. The program also crea tes trimmed copies of the so urce clips. You can preserve 

a fcw seconds of frames at thc beginning and end of each trimmcd clip. 

Note: Jnstewi of crcating trimmed copies of tl1c projcct's clips, yo u can crea te a batc/1 list for 
rcdigitizing trimmcd clips. Doing sois especial/y IIScjul i(youused low-rcsolution clipsfor t/¡c 
initial editing. For infonnation on redigitizing low-rcsolution clips, scc "Using L0\1'-Rcso/u­
tion Clips to Improvc Pclfonnancc" 011 pagc 42. 

To tri m a project: 

1 l'vlakc thc Projcct winclow or Construction winclow active. 

2 Choosc Tools > Project Trimmer from the File m en u.' Thc Project Trimmer cl1alog box 

appears. 

3 Sekct Copy Trimmccl Source Files, and desclcct Creatc Trimmcd Batch List. 

Adobe Premicrc stores the trimmcd copies in the samc directorics as the sourcc clips and 

appcnds numbers to thc clip na mes. For cxamplc, if a projcct contains t·hrec different 

scgmcnts from ~~ sourcc clip named t!nnccrs.nFi, the Projcct Trimmcr cre~ltcs three 

trimmed clips named dtinccr_J.m·i, dnnccr_2.m·i, and dnnccr_3.nFi. If necess~n\·, thc file­

na mes of thc clips are truncated to ~lllow numbcr·s to be appendcd. 

4 To preserve a fcw extra scconds (/¡r¡nt//c;) at thc beginning and cnd of cach trimmcd clip, 

en ter the numbcr of seco neis vou want to preserve in thc Kccp Handles arca. 

Crc,lting hancllcs lcts ~·ou btcr makc rninorcditingchangcs in thc ncwly trimmcd project. 

lt is more importan! to crea te h~mdks whcn crcating a batch list for rcdigitizing than for 

h~1sic ¡noicct trimrnrng. lf thcrc is rwt c'llOLtgh sourcc matcri,ll to crea te handlcs, thc Kcep 

!-landlcs option is ignorcd. 

s Click Crcatc Proiect. Thc stand~ml s~l\'t: dialog box nppcars. 

6 Na me and storc the ncw proicct. Thc proicct uses thc ncw trimmcd clips with the 

numbcrcd namcs. 

.• 



Note: If the project uses two segments from the samc so urce clip and their in and out poilzts 
overlap, the Project Trimmer crea tes il single clip for those two segnzcnts. Similar/y, if yo u 
specify lwndles nnd tlzc lzmzdlcs of two scgmcnts in n clip overlnp, thc Project Trimmcr eren tes. 
n single clip for those two segmcnts. 

Exporting file lists 

Adobe Premiere lets yo u crea te a list of the names of all clips used in a project. A file list is 

a quick way to sean the contcnts of a large project. The list displays the clip na mes in the 

order in which they appcar in thc Project window. Clip folders and their contents are also 

included in the list. 

To exporta file list: 

1 Choosc Export? File List from the file mcnu. 

2 Use the standard Savc dialog box that appears to storc the list. File lists are savecl as text .;, 

(.txt) files. 

IMPORTING AND OPENING CLIPS 

\Vhen a new projcct is crc,ltcd, Adobe l'rcmierc opcns a new, untitlcd Project window.­

Clips must be imponed befo re thcy can be u sed in a project. All imponed clips are placee! 

in the Projcct winclow. 

Thcre are se,·cral "·~n·s to import clips into ~l projcct. You can importa single clip, multiple 

clips, oran en tire dirccton· ni' clips dirc·ctly· into thc Project winclow.lfyou want to 

examine ~1 clip bci'orc Jnlportmg it into thc· prujcct, you G111 tirst opcn thc clip in a Clip 

\\'indow and thcn !110\'C thc clip to thc Proicct or Construction window. You can import 

m u! tiple copies of <l clip (!Jspbwc!Jn a Clip w1ndow. 



To importa single clip into the Project window: 

1 Choose Import >File from the File menu. The Import dialog box appears. 

2 Loca te and select the clip you want lo import. If the clip is a movie ora bitmapped 

(.bmp) image, a small preview of the clip appears in the dialog box. Yo u can examine the 

previcw by clicking the Play button below the preview. 

3 Click OK to import the clip into the Project window. 

Clips are arranged in alphabetical arder in the Project window with the number 1 

appcaring after the na me of the first clip. If the samc clip is imported again, Adobe 

Prcmierc makes another entry in the Project window and assigns it the numbcr 2. Each 

time the clip is imported, Adobe Prcmiere makcs a ncw entrv and numbers it in ascending 

sequcnti~1l order. 

To import multiplc clips into thc Projcct window: 

1 Choosc Import >File from the File mcnu. Thc lmport dialog box appe.1rs. 

2 1-Iold down Ctrl <lnd sclcct thc clips vou ,,·,mt to import. You can also selcct thc first clip 

~111d drag thruugh thc following clips to sclcct a group of clip;;. 

3 Click OK lo import thc clips inltl thc· l'roicct windol\·. 

To importa dircctory of clips.into thc Projcct window: 

1 Choosc Import > Dirccton· from thc File mcnu. Thc Sclcct Directorv ckdo~ hox . . . 
appcars. 

2 Locllc thc director:· containing thc dcsircd clips, ancl click OK. 

Allthc clips in thc sclcctcd dircctm1· are· illlf'Ortct! into thc Projectwindoll'. :\n:· subdircc­
torics withln thc director:· will not be imponed. 
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To examine a clip and then add it to the project: 

1 Use the Opcn command in the File m en u to opcn the clip yo u want to examine. The clip 

appears in a Clip window. 

1 
ó__ Play button 

2 To examine movic and audio clips in thc Clip window, click the Play button. For infor­

mation on playing clips in the Clip window, scc "Using the Clip Window" on pagc 68. 

3 To import thc clip, drag it from thc Clip window into thc Projcct or Construc¡ion 

window. You can also draga clip directly into ~1 Library window ora Scqucnce window. 

4 To import-:1 copy of thc clip, hold clown thc Alt kcy and drag it to-thc Projcct or 

Construction window, or choosc Add This Clip from thc Projcct mcnu lo importa copy 

of thc clip to thc Projcct window. 

Importing copies of clips is use fui whcn yo u want to use multiplc scgmcnts fmm thc samc 

sourcc clip. To use multipk scgmcnts, sct thc in and out points for thc f1rst scgmcnt in thc 

Clip window, ami thcn import thc scgmcnt as a copy. Rcpcat thc proccss for cach subsc­

qucnt scgmcnt. For information on sctting in ancl out points, scc "Trimming Clips" on 

page 76. 

Note: Yo u wn ni so use onc o( t/¡c Cop)' to Con.<truction COIIJIIIIJJI(/s to per(onn <111 inscrt cdit 

from tl1c Clip ¡¡·indow to thc Con,iii'IICIJ0/1 ll'illi!Oll'. For infonnntion 011 inscrt cditing, scc 

"Pcrj(mning Inscrt nnd (!¡•crlnv Edil.<'' on pngc ':J l. 

., . 
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Compatible formats for clips 

Adobe Premiere accepts so urce files in a variety of formats, as shown in thc follo\\•ing table. 

Compatible formats include those for movie files, animation files, still-image files, and 

audio files. 

TYPE OF CLIP FILE FORMATS 

Movie· Video for Windows (.a vi) 
QuickTime for Windows (.mov) 
FilmStrip (.f/m) 

.. 

Animation AutoDesk Animator (.flc, .fli) 
AutoDesk 3D Studio (.flc, .fli) 
#Targa (.tga) 
#Windows bitmap (.bmp, .rle, .dib) 
#TIFF (. tif) 

Still lmage Adobe Photoshop (.psd) 
Windows bitmap (.bmp, .rle, .dib) 
Macintosh PICT (.pie, .pct) 
Wmdows Metafile (.wmf) 
TIFF (. tif) 
PCX (.pcx) 
Targa (. tga) 

Audio Audio lnterchange (.aif) 
Windows Waveform (. wav) 

The file fonn;tts preceded lw a pound sign (!f) repn:scnt ;¡series of numhered imagcs. 

\Vhcn Adobe l'rcmiere imports ;¡ sequence of nunibcrcd files, ea eh numbcred file repre­

sents a single frame of a clip, al! of which are combincd toe reate a single clip. So me utilities 

and programs, su eh as Adobe Dimcnsions"' ami lvlacroMedia Director"'·, can genera te a 

series of numbcred still-image files \hat rcprescnt the scquence of single fr;tmcs uscd to 

creatc an anim;ttion. 

Yo u can use a video digitizer to capture \'iclco and makc Video for \-Vindows or QuickTime 

movie files, and use anim;1tion progr;tms to make FLC/FLI files ora series of numbcrcd 

files. You can use graphics applications to make bitmappcd, TIFF, or Macintosh PICT still­

image files, and use prcscntation programs to convcrt spreadsheet charts and graphs to 

drawings. You can sean photos, linc ;trt, ch;trts. and othcr visuals with ;¡ high-qualitv 

scanner, and then convert the sc,tnnL·d images to bitmapped or Adobe Photoshop files. 



If your computer has a sound card and an audio input device, yo u can record and edit 

sounds with sound-editing programs that genera te waveform (. wav) files, such as Adobe 

Premiere. Most sound cards includc an audio capture program for creating sound files. In 

addition, many video capture cards digitize sound when capturing a movie, but your 

computer must still have a separa te sound card to play and edit souild files. 

Opening nu_mbered still-image files 

To open a series of numbered bitmappcd (./nnp, .dib, or .rle), Targa (.tga), or TIH (.tij) 
!des, thc filcnamcs must h;lvc thc corrccl file cxtcnsion for thc typc of scqucncc. In addi­

tion, the filenamcs must all contain an cqu;ll numbcr of digits-for cxamplc,.fi/cOOO.Innp, 
filcOOI.blllp, and so on. 

To open numbered still-imagc files and compile them into a single clip: 

1 Choosc Import or Open from thc File menu. 

2 Select Bitmap Sequcncc, TIFF Sequencc, or Targa Scquencc from thc List Files ofType 

drop-down list. 

3 Sclcct thc first numbered imagc in thc series, and click OK. 

The imagcs '1'T compilcd and ;1ppe.1r as;¡ single clip in thc Projcct llr Clip window. By 
dcfault, thc imagcs are ,l.,signcd a framc ratc of 1 fps. You c111 ch.111gc thc fr;1n1c ratc using 

thc Speed command in thc Clip mcnu. For a frame rate of 30 fps, en ter 3000 pcrccnt for 

the new ratc in the Clip Specd di:1Iog hox; for 24 fps, en ter 2400 pcrccnt; for 15 fps, en ter 

1500 pcrccnt. 

Opening QuickTime for Macintosh files 

In thc vVindows version nf Adobe l'rcmicre, vou can open a QuickTimc movie created on 

a Maci n tosh com pu ter i f the movic was savcd as ;¡ Jlattcncd, scl{cnn tn i ncd Qu ickTi me file, 

ancl if thc file was com-crtcclto a DOS file with thc .1110\' cxtcnsion. Flattening a QuickTimc 

movic whcn it is savcd appcnds thc rcsourcc fork to thc data fork and thus consolidates 

the lllll\"ic i nto one lile. Crea ti ng a se! f-conta i ncd Qu ickTi me m o vi e con sol ida tes al! of t he 

video and audio data into onc lile. 

In the !vlacintosh vcrsion of :\dobc l'remicre, yo u can exporta flattcncd QuickTime movic 

hr choosing Exporl > FLlttc·ncd :\im·¡c· Cmm thc· File mcnu. 

To open a flattcned QuickTimc file· in the \Vindows vcrsion of Adobe Premicrc: 

1 Chuosc Import or Opcn frum th: File mcnu. 

2 Sckct a mm·ic with thc .111<11" file extcnsion and click OK. 



WORKING WITH CLIPS 

This section describes many of the options for working with clips in Adobe Premiere 

projects. You can set the image size for clips, rename clips, loca te clips in other windows, 
dele te unused clips, create libraries of frequently used clips, and use minia tu res and low­

resolution clips to improve performance. 

Setting the im¡¡ge size for movie and still-image clips 

The Adobe Premiere output imagc sizc for movies can vary from 60-by-45 pixels to 
2000-by-2000 pixels, with a resolution of 72 pixels per inch (ppi). The output imagc size 

is initially set in the project preset, and can be changed in the Output Options dialog box. 
Befo re importing or adding any niovic and still-image clips toan Adobe Premiere project, 
it is a good practicc to match thcir sizes to the output sizc of your movie. For more infor­

mation on output image sizes, sec Chaplcr S, "Compiling <me! Videotaping lvlovies." 

You can rcsize still imagcs using Adobe Photoshop and then import them into Adobe 
PrcmicrC. Jf yo u necd to rcsizc <1 movic or still-imagc clip aftcr it h<IS been iniportcd, yo u 
c1n apply thc l~csizc filtcr. This filtcr lcts you scalc ,¡n image up or clown to match the 

o u tput frame size of the movie. For more information on the Rcsize filter. sce "ivlovie and 
Stili-Jmage Filtcrs" on page 147. 

By default, Adobe Prcmierc adjusts thc hcight-to-width ratio, or ospect mtio, of an image 
as nccdcd to match thc output framc dimensions. This can result in an undcsirable distor­

tion of ;1n imagc. Yo u can !oc k thc aspect r<llio for any clip in thc Projcct or Construction 

window by selccting thc clip and choosing ivlaintain Aspect Ratio from the Clip menu. 
Adobe Prcmierc will maintain thc hcight -to-width ratio of thc image, regardlcss of image 
sizc. For still-imagc clips, :·ou can specif\· Lock Aspcct Ratio as a default sctting by 
choosinu Prcfercnces > Stilllmagc from thc File mcnu. e• e 

Correcting the duration of trames in a clip 

1\11 \'ideo t;¡ pe de e k s c111 ¡)()tcnt i;d h· 1111 rod u ce fr .1111 e ra te erro rs i nto <1 e 1 i p d u ri n g e;¡ ptu re. 
In thc ¡\dohc l'l·clninc· pro~r.1111. it is impurt.1111 th.1l .di frames in a clip h:nT thc corree! 
dtll·ation. lkl(>rc importing clip,, >'ou c111 use thc Conform AVJ ivlovic comm,lnd to 
ensu1-c that ,¡J¡ captured frames in thc clips h;n·c L'X<!Cth· thc samc duration. Yuu can also 

conform clips cluring capture 1 for more information, scc "Sclccting Recording Options" 
on pagc 235 ). 



To correct the duration of frames: 

1 Choose Tools > Conform AV! Movie from the File menu. Thc standard Open dialog box 
appears. 

2 Select the clip file or directory of clips that yo u want to correct, and click OK. The 
Conform !vlovie dialog box appears, displaying the movic's currcnt framc ratc. 

3 From the drop-down list, choosc thc framc rate to which you want to conform the 
movie, and click Conform. 

Renaming clips 

You can rcname a clip by giving ita na me alias. This is cspccially uscful whcn you havc 
uscd a clip more than once in,¡ movic, or havc duplicatcd a clip zl!ld set new in and out 

points. Giving the clip a name alias hclps to avoid confusion when viewing duplicatcd clips 
in thc Proicct and Construction windows. 

A clip with an alias has an italicizcd clip na me whcn vicwcd in thc Projcct a11CI Construc­
tion windows. Crcating a na me alias does not ¡·en ame thc file on vour hard disk. You can 

~ . 
rcad thc original filcnamc of a clip al am· time by sclccting thc clip and choosin'g Namc 
r\lias from thc Clip mcnu. Clip namc aliases in Premien: can havc up to 30 characters and 
can includé spaces and uppcrcasc and to,,·crc1sc charactcrs. 

To assign a na me alias: 

1 Sclcct thc clip in thc l'rojcct o¡· Construction window, o¡· opcn thc clip in a Clip window. 
You c.m sclcct multipk c!ips in thc l'ro¡,·ct "r Construction windo\\'. 

2 Choosc Namc :\lias from thc c:Jip m en u. Thc Sl'l Clip N,! me !\lías dialog box appcars. 

3 Spccif,· a n'1mc ,di as for thc clip, ande lid~ O k lf vou sclccted multipk clips, thc Sct Clip 
Namc i\lias di,Jlog box rc.q,pc,¡rs for cach clip. 

To rcmovc a namc alias: 

1 Sckct thc clip in thc· Pro¡cct or C:onslruction w¡ndow, or opcn thc clip in a Clip window. 

2 Choos,· N,1!11c' :\li,Js from th,· Clip m en u. Thc· Sct Clip Na me :\lías dialog box appears. 

3 Click '\on,· to rcmm·c· th,· ll.l!lll' ,¡Ji,b. 



Finding clips in other windows 

When yo u are working with a clip in one window, yo u can use thc Find Clip command to 

sec wherc the clip appears in anothcr window. 

To find a clip in another window: 

1 Select the clip in the Construction, Project, or Clip window. 

2 Choosc Find Clip from thc Clip menu. The program finds clips as follows: 

• If the Clip window is active, thc corresponding clip in thc Projcct window or Foldcr 

window is highlighted. 

• If the Projcct window is active. thc corresponding clip in the Construction \l·indow 

is highlightcd. 

• If the Construction window is acti\T, the corresponding clip in the Proicct windm,· 

or Folder window is highlighted. 

• If a virtual clip is selectcd, its so urce will be highlightcd in the Construction window 

or Foldcr window. For information on virtual clips, see "Working with Virtual Clips" 

on page 101. 

Creating libraries 

An Adobe Prcmicrc libran· storcs clips from one or severa! projccts. For cxample, yo u m· 

want to stor~ al! the clips from onc projcct in .1library. or vou may w;mt to storc frcquent1: 

liscd clips in a library rathcr than opcn cach clip scpar;ttcl>• as you n.ccd it. Once you havc 

crcatcd and savc·d ;t lihran•. you C;tn opcn it ;t\ong with ·.tny projc·ct.J\I!.tttrihutcs. such as 

markcrs and in and out points. are s,¡,·cd with thc clips vou place in a libr.1n·. 

Yo u can scarch for clips in thc Libr.;ry window bascd on their na mes or on thcir attached 

commcnts and J.¡hcls. You search for clips in thc Libran· winclo\,. in the samc wa\· as you 

scarch for clips in thc Proicct windo11·. For lllformation on scarching thc l'roject window, 

scc "Locating Clips in thc l'ro¡cct Windo11" on p.1gc .JS. 

To crea te a library: 

1 Choosc 0icw > Libr;¡n· from thc File mcnu. 1\11 untitlccl Libran· windm,· appears. 

2 lmport clips into thc Libran· windo\\ using onc or thc following mcthods: 

• \Vith thc Librar>· window acti1·c. choosc thc lmport command from thc File menu. 

• Drag thc dcsircd clips from thc l'roicct or Clip window into thc Librar:: window. 



• Copy and paste clips from the Construction window into the Library window. 

3 Use thc Savc command in thc File mcnu to save the librar)·· Librarics are givcn a .plh 
file cxtcnsion. 

To opcn a library: 

Use thc Opcn command on thc File mcnu to opcn a libran•. Librarics kn•c a .pl/J file 
cxtensiOn. 

To changc the display of thc Library window: 

Choosc Lib1'ary Window Options from.thc \·Vindows mcnu or clic!Z'thc nght mouse 
button on thc Lihrarv Winclm1· ti tic h~1r. Yo u chan~c icon sizes for thc Libr,¡¡·v window in 

. e ; 

thc samc way you changc thcm for thc !'roicct window. For information on changing thc 
dispLn· o!' thc· l'rojcct Windo11·, scc "Ch~1nging thc Projcct Window DispLn·"on pagc 46. 

Making miniatures to improve performance 

f'or bcttcr performance during cditing ~md ¡ncvic11·ing, :·o u can use thc Miniaturcs Cea tu re 
to sea le clown thc imagc· sizc of l'lll!r origin~Ii clips. Whcn you ;¡re I'C<ldv to.m'akc thc final 
Ycrsion of thc mm·¡c·, :-ou rc·tric1·c tlll' origin<li imagcs using thc Re-Fine! Files command. 
F-or more in!'ormation, scc· "Rcplacing Mllli,lturcs and Low-Rnolution Clips" on pagc 44. 

To crea te a sct of miniaturc clips: 

1 Choosc Tools > !llini~ltmcs t'rom tite· File mc'ilLI. Thc Sclcct Dircctory dialog hox appcars. 

'·-" 



2 Select the directory containing the so urce clips, and click OK. The Crea te Miniatures 

Directory dialog box appears. 

e· ,. -".,'<. CreateMinlatun:sDirí:Cto,Y~'. · "''· .. :· · .;,-· 

Direct01y ~ame: Q.irectories: OK ! 
lminiproj c:\premiere\projecl 

1 Be:\ 
Cancel 

• • e premiere Network ... 
~ project 

• 
Orives: 

• \li3 e: l±l 
Mtniatwes .. 

Output Options .. Compre:sion ... 

3 To ch;mgc the ·output options, click Output Options. For bcst rcsults, selcct an imagc 
size bctween 120-b)'-lJO pixels ami 320-by-240 pixels. For more inCormati01i on output 
options, see "Sclccting Project Output Üptions" on pagc 205. 

4 To change the compression options, .:lick Comprcssion. For inCormation on compres­
sion options, sce "Sclccting Comprcssion Options" on page 214. 

5 Spccifv a na.mc Cor the ncll' ivliniaturcs director)', and click OK. 

The miniaturc clips are savcd in thc ncwly crcatcd dircctorv. from which the)' can be 
importcd or opened for use in your projcct. \Vhen ,·o u are rcady to output thc final movie, 
use thc Re-Find Files command to rctricve thc original11lcs. For inform<Hion on using 
the Rc-Find Files command, sce "l~cpLlcing 1vliniaturcs and Loii'-Rcsolution Clips" on 

Usi.ng low-resolution clips to improve performance 

You Glll savc disk sp<lce .1nd impro1·c cditing <llld prc1·ic\\'ing performance in :\dobc 
l'rcmicrc by 1\'orking ll'ith low-rcsolution cl1ps ,Jnd thcn rcdigitizing thc clips ata higher 
rcsolution ll'hcn I'Oll ;¡re rc·ad:· to ouq)ut thc movic. 

Whcn working ll'ith loll'-rcsolution clips. 1·ou shoulcl sturc still imagcs and any titlcs you 
cre:ltc' 111 sc¡)ar;llc fol1krs from thc ,·idcu and aud1o clips-vou can work 1\'ith thc still 
im;1gcs at their lin.li dllnemi<'llS, <lnd thc titk.; <liT automatically resizcd ll'hcn you com~;ilc 
thc mov1c. Onh· thc l'idco ,¡Jl(] ~ludio clif'S 11·illnccd to he rcdigitizccL For instructions on 
creatin~ lo11·-rcsolution clif'S. scc thc tip "L,tng Low-Rcsolution Clips to Construct ;¡ 

lvlc)\·ic" on pagc 278. 

. .. 



Befo re rcdigitizing, yo u use the Projcct Trimmcr to crea te a batch list of thc clips in your 

projcct. Thc batch list includcs only thosc scgmcnts of each source clip that are actually 

u sed in the Construction window, bascd on the in and out points yo u h:~ve se t. .(For infor­
mation on sctting in and out points, scc "Trimming Clips" on p:~gc 76.) Trimming thc 

project can significantly decrcase thc sizc of your project, dcpending on how m u eh cditing 
yo u havc done on the clips. The Projcct Trimmcr also crea tes a copy of thc.project. The 
new project uses the trimmed clips that you will rcdigitizc from thc batch list. 

You use the 1\;llch C1ptu1·e comm;md lo redigiti1.e the trimmed clips in thc batch list. 'J(¡ 

rcdigitize clips, the origmal sourcc clips must h<lvc bccn rccorded with timccodc when 
thcy werc capturcd. For more informal ion on using Batch Capture, sec "Batch C:apturing 
with Dcvicc Control" on pagc 2-t l. 

To redigitize low-rcsolution clips ata highcr resolution: 

1 .!vlakc thc Projcct "·inclow or Construction winclow active. 

2 Choosc Tools > Projcct Trimmcr from thc File mcnu. The Projcct Trimmcr dialog 

box appcars. 

3 Sclcct Crea te Tri m mee! Batch List, and dcselcct Copy Trimmed Sourcc Files. 

4 To preservé a smallnumbcr of extra fr;um~s (handlcs) at thc bcgintiing ami en.d of cach 
trimmcd clip, entcr th,· numhcrofscconds 1·ou want to preserve in thc Kccp H<lndlcs are<l. 

Prcscn·ing handlc, is import;mt whcn CIT<lling ,¡ b.llch list for redigitizing beca use thcy lct 
vou makc mino¡· 111 .me! out point ,¡cljustmcnts la ter. Yo u should preserve handlcs of at lcast 
1 sccond. 

5 Click Crc;ltc l'roicct. Use ihc· lirst Sa1-c di;llog hox that appcars tona me ancl storc thc ncw 
proicct. Use' thc sccond Savc ddo:c bo:-: tu na me .md storc thc batch list. 

6 Opcn th,· batel~ ii,t. 

Thc batch list appc;lr' in ;1 ll;llch Capture window. Thc list includcs only thosc parts of 
cach sourcc clip that are actu;lih· uscd in thc Construction window. Thc m·w clip namcs 
.1rc .1ppcndcd ,,·itl: numcric.li ntcn,Jons. Fo¡·,·x.lmplc, if a prnjcct cnntains thrcc diflcrcnt 
scgments from ~~ ,-¡¡¡, namcd Dunccr;, thc' batch list ll'ould includc thrcc trimmcd clips 
namccl DunccJ_i, 1 Jan ca_:!, and /Junccr_3. Thc· ncw projcct that was crcatcd b:· thc 

Projcct Trimmcr ·,,·ill!o,lk for tices,· clip namc·s instcad of thc original oncs. 

/5 
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Note: If tlie project 11ses two segments from the samc sollrcc clip, and their in mzd 0111 points 
overlap, the batch list designares a single clip for those two segments. Similar/y, if yo u specify 
hmzdlcs, ami thc handles of two scgnzcnts in a clip ovcrlap, the batch list designa tes a single 
clip for thosc two scgmcnts. 

7 Adjust the recording options and settings for digitizing the clips ata larger size or reso­

lution, using the commands in the Batch Capture mcnu. For more information on these 
commands, see "Capturing with De1·ice Control" on page 238. 

8 Make sure that your tape deck is connectcd to your computer, and click Capture in the 
Batch Capture window. You are askcd lo create a library for batch capture. CJ·cate thc 
library on your fas test harcl clrivc bcc:1use Adobe Premie re will c1pture the clips using that 
clrive. For more information on batch capture, sec "Capturing Clips Using a Batch List" on 

page 243. 

Adobe Premicrc saves thc clins in thc batch list in thc c!irccton·that contains thc librarv. If r ' , 
this is thc samc cliroctory th~1l contains thc original clips, yo u can open thc ne\1' projcct that 
was createcl by thc Project Trimmer. and thc projcct \\'ill automaticalh· use thc newh· digi­

tized clips. If this is not the director:· that contains 1·our original clips, vou will nccd to link 
thc newly digitizcd clips to thc proicct crcatcd b1· thc Proicct Trimmcr usin¡: thc Re-fínd 
Files command. ror more information on usim; thc Re-finci Files command, sce thc next 
scction, "Rcplacing Miniatures and Loii'-Rcso!ution Clips." 

Replacing níiniatures and low-resoltition clips 

Thc lzc-Find Files comm~1nd is uscd to rcpL1cc mini~1turc clips with thcir sourcc clips, or 
to rcplacc low-resolution clips 11·1th clips th~n han· bccn n:digitizcd at highcr rcsolution. 
For more information, scc the prcccding scctions. "lvlaking i'diniaturcs to lmprovc Perfor­
mance" and "Using Lo\1'-Rcsolution Clips to Impron· Performance." 

To use thc Rc-Find Files command: 

1 Savc your proicct. 

2 Choosc !Zc·-l'i11d l'ik' from thc· l'roic·Lt tnl'lll!. The lzc·-Find Files di.liog hox ~1ppcars. 

3 Use thc chalo¡: box to locHe and sclcct thc· c!q' indic.Hcd at thc· top ofthc dialog box. 

lf :·ouiL1vc·pL1ccd al! o l. thc Pri¡:in.d clil'' in thc s.unc· !'olckr,:\dohc l'rcminc ~Hltomatically 
cxch.mgc' thc minl.llurc di¡>s 111 thc· l'r"icct 11 111dow ~111d thc Construction 11·indow with 
l he o 1·igm.ll el i ps in tlw !( ,Jdc'l'. 1 t' ,."u h :ll'c' hu il t I'Ol\1' movic ll'll h mini ~1llllc'S from di ffcrcn t 
dircctorics, you 11·iil h~11'l' l<> loc.llc' c.1ch ciircctor•: indll'idualk.lf>·ou ~~·~ml to skip onc clip 
amllocatc·thc· ncxt, click ~kip in the IZc·-Find Fiics cilalog box. 



--------------------------------------------------------------------------------- l 

USING THE PROJECT WINDOW 

Clips importcd toa projcct appcar in thc Projcct window. Clips in thc Projcct window can 

be organizcd in foldcrs, which hclps make large projects more managcable. 

Audio clrp -

Std!-rm;:¡9c clrp 

~.tovre clrp wrth -­
!mked Jud10 

Movie clip -~~~~~ 
wrthout Jud10 

Cornment box 

Fu;! u;rer\'rC"I 

[mych~~J l.:~bel box 

For cach clip, thc default l'roicct window displays thc namc, a thumbnail, thc general typc, 
and thc duration. Thc window .1lso dispLl\'s a Commcnt box, and two Labcl boxcs. 

• Thc thumbnails \'ar:· clcpcnding on thc t1·pc of clip in thc Projcct window. For a movic 
or animal ion cltp, thc thumhmil dispLl>"s ;Jn approxim.llion of thc lirsl fr;11nc of thc di p. 
For ;1n audio clip, thc thumbnail is .1 sketch o(;¡ pon ion ofthc audio wa,·clc)]']n. For a still 
imagc, thc thumbnail displa1·cd is an appmximation of thc image. lf markcr O is sct in a 

clip. thc· thumlmail displ;li'S th.ll framc. 

• Thc clip t1·pc L1hcl m ay be "0·\m·ic," ":\u dio," "Still lmage,"''Filmstrip," "Background 
¡\-\attc," or "Ti tic." 

• Thc duration o( a clip (ho11·long .1 clip runs) 1s mcasurcd in thc stanclarcl formal 
apprm·cd h1· the Socict,· ul· !vlotion l'icturc an-1 'J(:Jc,·ision Enginccrs (Sivll'TE), which is 

1-lours:\·linutcs:S·,·conds:h:Jmes. :\clip 11·ith a duration of0:00:05:15 plays for 5 scconds 
;md 15 fr;Jmcs . .-\t ;he r.llc' o l. 311 fr;Jmcs pn sccond, this clip would pla1· i'or 5.5 scconds. 

!'or :~Hlrc· Jni'orm,l\ion ''11 sctllng thc·timc·codc, scc "Sivll'TE Timccodc" 011 pagc 2il4. 

• Thc sizc o( .1 mm·ic (r,Jl11l' m still-imagc clip is thc im;1gc's dimcnsions mqsurcd in 

p1xels; fur ;lUdio ci1ps, thc l'rojc·ct 11i11do11· displays frcqucnc1· in kiluhcrtz, s;¡mplc rcsolu­
tJon .. md ,,·hcthcr thc· cli¡' JS mo11o or SlcTco. 

1 l. 
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• The Comment box and two Labcl boxcs to the right of the clip na me lct yo u áttach notes 

toa clip. For example, you may want to add information about the contents or quality of 

a clip that can't be represented by the thumbnail. To add a comment ora label, click thl 

appropriatc box and type the text you want associated with the clip. You c:m use the stan­

dard Windows Cut, Copy, Paste, and Clear commands to edit the tcxt you en ter. 

Clips are displayed in alphabetical arder by na me. They can al so be alphabetized according 

to comments or labcls. Grouping or prioritizing your clips with attached notes can make 

it easier to keep your projcct organized. 

Changing the Project window display 

You can \'ary how clips appcar in thc l'rojcct winclow by choosing ;unong four thumbnail 

sizcs. Thc clcfault vicw uses mcclium thumbnails ancl clisplays clips by n;~mc, showing the 

typc of clip ancl its dur;~tion. 

To ch;~nge the Projcct window display: 

1 ivlake thc Projcct window active, and choosc Proicct \·Vinclow Options from thc 

VVindows menu or click thc right mousc button on thc wmdow ti tic bar. Thc Proicct . . . 
\Nindow Options dtalog box appcars . 

.5_011 N.:tme V1ew by 

¡~·, N ame (·· Comment <) labd 1 (' Labcl 2 

(cnttr:·IU~ <srrd [•c•t::< 
<111"1".': ur Úr>: Pro¡~C! 

wrndü~" eh<:'"]"'" 1·:-:o:-, :r:•! 

;¡ l_ag c-l¡p -cur;i,;:t· j 

o !:_lip conie~ in folders :::, ===: 
Q Show lcom 1 

OK 

Cancel 

2 ·¡;, 'ckct ;tn icon 'izc, click thc ;tpproprt.ill' hutl<>n.li";·ouw;tnlto turn oi"fthc displa;· of 

thumbnails so th;tt thc1· ,\l'f'C.ll" in thc l'roicct windo"· as gr;l\" hoxcs, dcsckct thc Slww 

lcons check box. Not displaying thumbnails spccds up acccss time whcn working in thc 

l'roicct windo1,·. 

Note: \"(m Cdll nl.<o togglc /)('/ltH'II t'Í<'lt'.' tdtc/1 tl1c /'ro¡cct ll'iurlotl' i,: uctn·c /J_l'iw/diu:;,do\\'11 

tl1c Ctrl kc_1· 11111i wing tl1c U¡> und /Jo\\'11 :\rnnl' kc,l'.' to clwu,;;c icou ,:izc. 

3 Tu spccit\· how thc clips in thc· l'roicct ll'illdl,,,. arl· sortcd alph;tbctictlh·, click Namc, 

Commcnt, Ltbd !, or l.abcl 2. 



Note: Yo u can al so click on a columnlzcading in tlzc Projcct window (Na me, Commcnt, La be/ 
1, or Labc/2) to sort the clips alplwbcticnlly. 

4 To automatically identify copies in the Comment field, select the Tag Clip Copies 

option. \-1/hen yo u copy and paste a clip in the Construction window, thc clip is addcd to 
the Projcct window and identified as a copy in the Comment fiel d. 

5 To hidc copies of clips in a projcct foldcr, sclect the Clip Copies in Foldcrs option. Whcn 
you copy and paste a clip in thc Construction window, the clip is addcd toa ncw foldcr 
calkd Clip Copies in thc Prnjcct windcm·. 

Using folders in the Project window 

Clips in thc Projcct window can be o1rranged in folclcrs, justas nlcs are arrangcd in folclcrs 
m the File iV!anagcr. Project folders are particularly uscful whcn yo u oli'C working with a 
complcx projcctthat has sccncs from many clips. Arranging the clips in a series of folclcrs 

makcs thc projcct cas1er to managc. 

To crea te a folder in the Projcct window: 

1 !v!akc the Projcctwinclow active. 

2 Choosc Add Foldcr from thc Projcct n:cnu. Thc Foldcr Namc clialog box appcars. 

3 Typc a namc o\nd click 01\.. 

To opcn a Foldcr window and add clips: 

1 Double-click thc foldcr \'Oll want to opcn. Thc Folclcr winclow appcars, displaying thc 

contcnts of thc choscn folder. 

2 Drag clips or othcr foldcrs from t1Jc' Projcct or Clip winclow to thc Foldcr winclow. If yo u 
add a clip from o1 Clip window, :\clobc· l'rcmicrc crc.1tcs a ncw copy of thc clip in thc foldcr. 
lf thc l'uldcr \\'Íllliuw 1' not <l!'CI1, l'llll c.111 .1dd .1 clip to o1 foldcr b1· dro1gg1ng it ovcr thc 
fulcb· icun 1n thc l'ro1cct ,;.1nclo1i·. 

To change thc display of the Foldcr window: 

1 Opcn thc· Foldcr windm,·. 

2 Choosc Foldcr \\'indcm· Options !"rum thc \Vincluws mcnu or click thc right mousc 
button on thc· Foldcr 11·inclo\\· titk Ílo1l'. lhc· Folc!cr Winclow Options clialog hox appcars. 

3 Chomgc' thc· displ.11" nf thc Foldcr \\'Í11do\\' i:1 cxo1cth· thc samc mannn o1s for thc Projcct 
\\'llldo11· h1· clwosing t"rom fom thumhnail sizcs. For information on changing thc display 

of thc l'roic·ct 1\'indc>\\', sc'C "Cho1nging thc Prnicct \Vindo11· Displa~-'' onpagc 46. 
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Deleting clips and folders from the Project window 

Yo u can delete one or more of the clips or folders in the Project window if yo u don't want 

them in your project. You can also have Adobe Premiere delete all clips in the Project 

window that are not currently used in thc Construction window. If vou try to delete a clip 

that is currcntly in use in the Construction window, a warning indicates that the clip will 

be removed from both the Projcct ancl Construction windows. 

To delete a clip or folder from the Projcct window: 

1 Select the clip or folder you want to clcletc. Hold clown the Ctrl key to select more than 

onc clip or folclcr. 

2 Press Dclctc, or choosc Clear or Cut from the Eclit menu. The clip or folder is clelcted 

from the Project window ancl the Construction window. 

Note: Thc Bnckspncc kcy cmz be uscd intcrclznngcnbly 1vitlz thc De/etc kcy throughout 
tlzis guidc. 

To delcte all clips not currcntly in use: 

1 i'v1akc the Proiect window active. 

2 Choose Remo1·e Unusecl from the Projcct menu. 

Locating clips in the Project window 

Yo u can h:we Adobe Prcmicre sc:nch for clips in thc Proicct window bascd on thcir na mes 

0/.'lm their atta~hed commcnts and labcls. For cxamplc, you can locatd.a!l clips with a 

common la he!, such as Opcning Sccnc. 

To locatc clips in thc Projcct window: 

1 Click thc l'roiect windu,,· to m:1kc it <lCti,·c. 

2 Choosc Goto/Scclrch from thc Proic·ct mcnu. Thc Projcct/Libran· Sc:1rch dialug 

bux appcars. 

3 Sclcct which columns in thc l'roicc·t window will he scarchcd: i\:1mc, Comment, 

Labcl 1. or Lahcl 2. 

4 Typc· a charactcr string to be used as :111 idcntilicr in thc scarch. 

• Click Fznd to !"cate ,1nd sclcct thc· lirst clip in thc l'roicct window associ:llc·cl with thc 

charactcr str·ins idcntilin; continuc clrckirrs Find tr.1 lucatc <llld sclcct succc·ssivc clips asso­

ciatcd II'Íth thc· char.1ctcr strins. 



• Click Find All to loca te and selcct all clips in the Project window associated with the 

character string identifier. 

6 Click Done when you have completed your search. 

USJNG THE CONSTRUCTJON WJNDOW 

Thc Construction winclow displavs all thc clips in your movic from lcft to right, in the 

sequence in which they will appcar whcn thc movic is playcd. This window is Adobe 
Premicre's "cutting room," beca use it is here that yo u do the work of assembling clips ancl 
cditing the movic. 

Thc Construction window cont<lins a time rulcr·for aligning clips, a tools pakttc for 
sclccting and ccliting clips, ancla vari<lblc numbcr of tracks (lhL' dcfault is scvcn tracks). 

Time rulcr 
Work areJ bar 

Snap tool :1~~~2§~~~~2~~~~~~§~~~~~ -- Play button 
Edgc vJew1ng tool ~ --- EcJ 1t lme Left 

Tooi~ p.l!cllc Currt•nt t1me unit 

l1rnt' un1! '>Cic<lor 

Traversing the Construction window 

and R1ght buttons 

¡·· :. v,deo "·"'A 

-- Tr.lmltlon track 

Ed1t hne 

Video track 8 

- Super1mposc 
trJck S 1 

Aud10 !rack A 

Aud1o track X 1 

·¡¡, tra\'Crsc thc C:onstruction "·indm,·, use the scroll bar al thc bottom of thc window. 

!'re" the Hume ke1· to disploi:-· thc beginning of thL· <lsscmbkd 11101·ie or thc start of thc 
sclcctcd clip. !'re" thc· 1'.11d kL·I·to disp];¡,· thc· cnd of the ;¡sscmbkd lllOI'ic or thc cllll of the 

sclccted clip. 

·'· 



Using the Construction window pop-up menu 

When the Construction window is ac:ive, clicking the right mouse button displays a pop­
up menu. The contents of the pop-up mcnu varies depending on the pointer's location. 

If the pointer is o ver a video track, the pop-up menu displays video-editing commands. If 

the pointer is ovcr an audio track, the pop-up m en u displays audio-editing commands. If 

the pointer is over a blank area, the pop-up menu displays the Ripplc Delete command. 

Clear 
Ripple Oelete 

,; Enabled 
Maint11in Aspecl R(1tio 

Motion .. . 
Filters .. . 

Speed .. . 
Duration ... 

Frame Hold ... 

Tirnecode ... 
Name Alias ... 

Field Options ... 

Changing the number of tracks in the Construction window 

Thc Construction wllldo\\· can cont:un up to 99 1·idco and 99 audio tracks. You sct the 
numbcr of tracks ,,·ith thc .\dci/Dcktc Tracks commancl in thc Projcct mcnu. You can 

spccif~· difk-rc11t numbcr.' of \'1Lko :1nd :1udio tr.1cks. but for cach t1·pc. ~·ou c.1n ha,·c no 
fcwcr than thrcc tr:1cks (thc· dcf.ll!ll scttin¡c.l. 

1\ddi l io11:d \'ideo l r:1cb :11 ,. :1dLkd :1' SllJlCri 111J'OSL' (S 1 1 r.1cb. \Yhcn ,·ideo t r:1cks :11-c :1ddcd, 
thcy :1rc l:lhckd scquc11li.di1· t'm1n S2 to S':J7, d,·¡'c'rllllllS 011 thc numbcr u( tr.1cks addcd. 
Similarh-. audio tracks .lrc· Llhc·kd \~lo .\Y/. Wlll'n dclcting tr:1cks. ,\clobc Prcmicrc . ' . 
rcmovcs thosc ,,·ith thc hishcst 11Umhcrs in thc Co11struction windm,·. lf nJu attcmpt to 
rcmovc a tr:1ck that h.1s c·ontc·nh, \'oll will he ~1\'L'n a warnin~ and be allowcd to cancel the 

. L ..._ e 

opcratio11. Dcktlll¡c. tracks c.111110t he t111do11c. 



Viewing tracks 

vVhen working with a large numbcr of tracks, yo u may have to enlarge thc Construction 

window to sec al! of them. If vou can't cn],¡rgc thc window, yo u can scroll through thc S 

ancl audio tracks using thc scroll bars on thc right sidc of thc Construction window. Thc 

arca of thc Construction window allocatcd to video ancl audio tracks cún be adjustcd by 

dragging the splitter bar locatcd betwcen thc two scroll bars. 

l Splitter bar 

¡¡¡,;....;~.· r! 
~i111 

l.t 

i 
' ! 
1 

f¡;,ou::.l r! S 
1)-,1! 

1 • . ' 
A A 

8 ·.e..:.. 

1 

X 
1 

Assembling clips in the Construction window 

To asscmblc )·our clips in the Construction winclow, drag thc thumbnail of cach of thc 

clips you wánt to use from thc Projcct or Clip window onto a track-in thc Const.ruction 

,,·indow. Thc clip tvpc must corrcspond to thc tr;1ck typc (for cxamplc, you cannot place 

an audio clip on a ,·ideo tr;1ck). :\dobc Prcmicrc placcs thc clip in thc Construction 

winclow whcn 1·ou rc\e,¡sc thc mousc hutton. 

.S \ 
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A small icon appears in the clip's information box in the Project window to shbw that the 

clip is in use. The icon is a color wheel for a movie or still-in1age clip and a waveform for 

an audio clip. A linked clip displays both icons. 

Audio icon 

Movie or still-1fnage 1con 

Yo u can al so add clips to thc Construction window by performing an inscrt cdit. An inscrt 

eclit lcts you sct precise cut points and durations for clips as you insert new material. For 

information on performing inscrt cditing, scc "Pcrforming Inscrt and Overlav Edits" 

on page 91. 

To copy multiplc clips from the Projcct window to the Construction window: 

1 Click a clip to sclcct it; thcn hold clown the Ctrl kc)· and click cach additional clip you 

want includcd in thc sckction. 

2 Dr;1g thc clips to thc Construction window. Clip> are pbccd on a single tr.1ck in thc 
prdcr th;lt thcy .1ppcar in thc· l'rojcct windm~:. 

To copy all clips from thc Projcct window to thc Construction window: 

1 Choosc Sckct Al! from thc Edit mcnu. 

2 Drag thc clips to thc Construction window. Clips are placcd on a single irack in the 

ordcr that thc)· appcar in thc l'roicct window. 



Using linked clips 

If a clip contains both video and audio, it is callcd a linked clip. vVhen you draga linh·, 

clip to the Construction window, both the video and audio portions of the clip are pla< 

on their appropriate tracks. For example, if yo u draga linked clip onto video track S 1 = 
thc audio portian of the clip is placed on audio track Xl2, providcd that thc track cxi' 

If a video track does not ha ve a corresponding audio track, yo u cannot draga linkcd e: 
onto the video track. 

You can separa te linkcd clips permancntly or temporarily. You can place linkcd audio"' 

video on c!iflcrcntly numbercd tracks if yo u tcmporarily rclease thc link. For more inl< 

mation on editing linkcd clips, sec "Separating and Rejoining Linkcd Clips" on pagc 'Y. 

To dclctc the audio or video portion of a linked clip without affccting thc othcr 
componen!: 

1 Click thc portian of thc clip in the Construction window that yo u want to dclete. 

2 Prcss Dcletc, or choosc Clcar from thc Eclit mcnu. 

Changing the Construction window display 

Yo u can display clips in the Construction window using thumbnails, filenamcs, or botl 

Yo u caí1 eh o ose from four icon sizcs for thumbnails. Yo u can ;riso specify which tracks ·' ·• 

displaycd in thc Construction 1\·inc\ow. For examplc, if yo u are working exclusively wit 

video tracks, )"OU can choosc to turn ollthc display of audio tracks. !3y clefault, al! thc 

tracks appcar in thc Comtructior~ window. 



To change the Construction window display: 

1 With the Construction window active, choose Construction 'vVindow Options from the 

Windows menu or click the right m o use button on the Construction window title bar. The 

Construction \A/indow Options dialog box appears. 
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2 Sdcct a trae k forma t. Thc Filcnamc Onh· track form'lt draws thc Construction window 
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thc fastcst. Thc middlc option, showing only the first and last framcs of clips. also allows 

rclativcl;· fast rcdrawing of thc windo\\·. 

3 To sclcct an icon sizc, click thc '1ppropriatc button. lJsc the smallcst icon sizc whcn you 

havc man\· tr,1cko to vicw in thc Construction window. 

4 Sclcct which tr,¡cks to dis¡!Ll\' in thc Construction window írom thc Track Display ~1rca. 

5 Choosc thc fr,¡mc numbcring form.llused to count i'ramcs in thc Construction winclow 

frotn thc Count dro¡'·down iist. 

Changing the number of thumbnails in the Construction window 

Thc dcfault time unit for thc Construction winclu"· is 1 sccond. which llll''lm that the 

Construction windo\\· displa1·s onc thumbn,lil for c.Jch sccond of a clip. :\ssigning a largcr 

valuc lo thc time unit. such as 1 minute. displavs fcwcr thumbnails pcr clip. but lcts yolt 

scc more ufthc Construction windo\\·. In general, thc more dct,lil you want lo scc in,¡ clip, 

thc smallcr thc time unit HHI slwuld sc·lcct. For morcof,¡n m·crvicw o fa clip,sclcct a largcr 

time u ni t. r\s 1·uu bccomc more Lnniliar \1·ith thc :\dobc Prcmicrc program, \'ou'll havc a 

bcttcr idc.1 uf when to use,¡ sm,Jil time unit ,llld \1·hcn to use a largcr onc. 



To change the time unit for the Construction window: 

Drag the time unit selector at the bottom of the Construction window, or use the zoom 

too! in the tools palette. Yo u can set the time unit from 1 frame (!/30th second for a 30 fps 

project) to 2 minutes. For more information on the zoom too!, sec "Using Tools in thc 

Construction Window" on page 58. 

·¡une 11111t Í1; Con::r:u_.! Ítln 11'1111/n¡·: :-el Id S Ji-:11/ll'.' 
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To view the en tire project in the Construction window: 

Make the Construction window active, and press the backslash (\) key. The numbcr of 

thumbnails shrinks so that the en tire project fits in the Construction window. and the time 

unit selector at the bottom of the window adjusts accordingly. 

Changing the display of audio clips in the Construction window 

You can display audio clips in thc Construction window with wavcforms or with straight 

bars. Thc straight bar ~lpproxim;l!ion ;1ppcars more quickly than wavcforms. Rcducing thc 

time rcquircd to rcdraw the Construction window is espccially beneficia! whcn the time 

unit is small (onc to eight framcs). 

To change the audio display: 

1 Choose Prefercnces >Audio from thc File mcnu. The Audio Prefcrcnccs dialog box 

appears. 

2 Choosc thc vic11' in which to approximatc thc audio; or choose Al! Views or No Views. 

3 Click OK. 

lC thc time unit docs not mc1tch thc sckcted vicw, thc audio clip appears as a straight bar. 

for examplc, if yo u eh o ose i'vlcdium Vicws but set the time unit to 4 seconds, the audio 

clip appcars as a straight bar. lf thc time unn marches thc sclectcd 1·iew, thc audio clip 

appcars as a 1\';wcform. 
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Disabling clips in the Construction window 

Clips that ha ve becn placed in the Construction window can be disablcd so that thcy won· 
be included when yo u build a pre,·iew or compile a movie. This fea tu re is uscful if yo u 
want to kecp severa! versions of a clip available for previcwing or compiling! or if yo u w;111 
to disablc the audio or video portian of a linkcd clip. It is also uscful if yo u havc many 
compositcd clips on m u! tiple tracks, but yo u only want tose e how two of thc clips intcr;ll't 
In this situation, thc disabkd clips are not visible and do not t;¡kc up proccssing time. 

Yo u can togglc thc st:llus of :1 clip bctwccn cnablcd and disablcd by sclccting thc clip in th 
Construction window and choosing Enablcd from thc Clip mcnu. A disablcd clip is 
markcd with a crosshatchcdlinc pattcrn. You must disablc thc audio and video portion.­
of linked clips scparatch·. 

Deleting clips from the Construction window 

If yo u decide that vou don't want to use a clip ii1 your projcct, yo u can dclctc it from thc 
Construction window. Dclcting a clip from thc Construction window docs m)t dclctc th. 
clip fromthc Projcct window. WhL'll you dclctc a clip, \'OU canlc:1vc :111 cmpty spacc onth­
track whcrc thc clip was, or yo u c;¡n pcrform :1 "ripplc" dclctc, which shil'ts th~ contcnts '' ·'' 
al! othcr tracks m·cr to closc thc g<lp lci't b)· thc dclctcd clip. 

To dcletc a clip from thc Construction window and lcavc an cmpty spacc·: 

1 Sclcct thc clip or clips in thc Construction \\'indow. 

2 P:-css Dcktc, or choosc Cic;lr from thc Edit mcnu. 

To pcrform a ripplc dcletc: 

1 Sclcct thc clip or c!ips 

2 Jf,·ou do ll<ll want a clip on anothcr track to shift ovcr, lock thc track. For informatio: 
on locking tr,1cks, scc ''L<Kking Tracks in th,· Construction \Vindow" on pagc 94. 

3 Choosc i\ipplc Dckte froi11 thc Edit mcnu, or prcss Ctri+DcktL'. 

··'' 



Using tools in the Construction window 

The Construction window contains a set of tools for s-electing and editing the clips in yo11r 

movie. Too! icons are displayed in the tools palette, located in the lower-left corner of l 

Construction window. The tools palette initially displays a range select too! under which 

resides an extended tools pop-up menu. When you choose a too! from this menu, it takes 

the place of the range select too! in thc palette. 

Extended tools pop-up menu 

To sclcct a too!, click its icon in thc tools palcttc, or press thc tool's corrcsponding lctter on 

thc kc:·lw,nd. ;\(ter;¡ too] is sclcctcd, thc pointcr ch,lllgcs to thc too]\ icon 1\'hcn posi­

tioncd ovcr ;m ;lppropriatc p;lrt of thc Construction window. 

. ~ " 



• 

1 n 1 

' '"""' ' 
1 . 
--~ 

Construction Window Tools 

Selection tool (s from keyboard) 

This tool selects and moves clips, transitions, and 
markers one ata time. 

lt changes into a stretch pointer when posi­
tioned over the edge of a clip, allowmg you to 

shorten or lengthen the clip by dragging. For in­
formalion on using the seleclion too! to change a 
clip's duration, see "Tr~mmmg Clips 1n the Con­
struction VVmdow" 1n Chapter 3. 

Range select tool (e from keyboard) 

This too! drags to select multiple items in the 
Construction wmdow. VVhen multiple items are 
selected, many commands írom the Clip and Edit 
menus are appl1ed to al! selected items. 

Zoom tools (z from keyboard) 

These tools perform the same func110n as the 
time umt slider at the bottom of the Construc­

lion wmdow. The zoom-In too! decreases the 111ne 
unn, the zoom-out too! (hold down the Alt ke¡·i 

mcreases the t1r.1e un1i:. 

This tool can also dra\'J J marquec ar.d fill thc 

Constí-.:Ct1on •:Ji:~do':! ·:;ith the selected v1c·.-.· Thc 
t1me un1t 1S adp . .:s~cd accordmgiy For HlÍormzn¡on 

or. hov: Ü1e t1me u:11t value affects thc display, 

sce "Changmg thc t~umbcr of Thurnbn,ld; 1n thc 

Construction VVn~do~·:" corl1cr in :h1s chnpc• 

1 +¡.. l Stretch too! (w from keyboard) 

Ti1is too! changes ¡hr ciuratlon of <J Glj) ond 

adjusts its speed to f!t the ne•:: durJt1on . 

Hand tool (h from keyboard) 

This tool scrolls the contents of the Construction 
wmdow to display different areas of your movie. 

Scroll the window by dragging. 

Block select too! (b from keyboard) 

This too! selects a segment of equallength from 
al! tracks 1n the Construction wmdow. For more 
information, see "Splitting Clips" and "VVorkmg 
with Virtual Clips" in Chapter 3. 

Track too! (t from keyboard) 

This too! selects al! clips on a track, from the first 
clip clicked to the en el of the \rack. To add toa sr 
leclion, hold down the Shift key and click. 

Multitrack too! (m from keyboard) 

TlliS tool selects al! clips in the Construction 

window that are placed to the right of the point 
you click. This includes clips that start atan earli· 

er po1nt on the time! me and extend beyond the. 
pomt you click. 

: ::>C ¡ Audio fade too! (v from keyboard) 

· ' This too! crea tesan <lUtomatiC audio cross dis­
solve between two chps. To create the cross di s­
salve, chck thc f~rst iluclio clip, then click a scc­
ond ilUdiD clip th,lt overlilps the first. 
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Razor tool (r from keyboard) 

This tool cuts a clip into two or more distinct 
clips. For more inlormation, see "Splitting Clips" 
in Chapter 3. 

In point tool (i from keyboard) 

Th1s tool sets in p01nts lar movie clips, audio clips, 
transitions, and the work area bar. For more tnlor­
mation, see "Trimming Clips tn the Construction 
Window" in Chapter 3. 

To select the in point tool when the selectlan tool 
1s active, hold down the Ctrl and Shilt keys. 

Out point tool (ofrom keyboard) 

This tool sets out pomts lar movie cl1ps, audio 
clips, transitlans, and the wmk area bar. Fm more 
mformation, see "Trimmtng Cl1ps in the Construc­
tion Wmdow" tn Chapter 3. 

To select the out potnt tool when the selection tool 
is act1ve, hold down the Ctrl key 

' 
Ripple edit tool (extended too/s pop-up 
or p from keyboard) 

This tool adjusts the durat1on of a cl1p without iJÍ­

Iectmg the duration of other c!1ps on the trae k. 
For mm e mfmmat1on. see "Us1ng the Ripple and 

Rolling Ed1t Tools "' the Construction W111dow" "' 
Chilpter 3. 

Rolling edit tool (extended too/s pop-up 

or y from keyboard) 

Th1s tool adjusts the duration of a cl1p and 1ts 
adjacent chp to mamtam the o11gmal combmed 
duration of the two cl1ps Jnd all subsequent cl1ps 
For more mformJtion, see "Usmg the Ripp!e and 

Rolhng Edil Tools 1n the Construct1on vV1ndow" 1n 
Chapter 3 

~~~ ._._~ __ 1 
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Link override tool (extended too/s 

pop-up or u from keyboard) 

Th1s toollets you move the video or audio port1. 
of a linked clip independently. For more inlorma­
tion, see "Separating and Rejoming Lmked Clips" 
in Chapter 3. 

Note: Although the video or audio portian ola 
linked clip can be moved independently when 
you use the link override tool, the audio and video 
portions of the clip rema in linked when you 
release the tool. 

5oft link tool (extended tools pop-up 

or 1 from keyboard) 

Th1s tool crea tes a solt lmk between an audio 
clip and a video clip For mme iníormation, 
see "Separatmg and Re¡o1nmg Lmked Clips" 
m Chapter 3 

Fade scissors tool (extended tools 

pop-up or k from keyboard) 

This tool crea tes two handles next 10 each oü,_ 
1n the Fade contra! section of an audio or superim­
posed clip. W1th two handles. you can make 
ad¡ustments that sharply m crease or decrease 
the fading ata poHlt For more information, see 

"Mixmg Audio Clips" 1n Chapter 3 or "Ad¡usting 
the lntens1ty of Superimposed Clips" in Chapter 7. 

Fade adjustment tool (extended tools 

pop-up or g from keyboard) 

This tool uniiormly adjusts a segment in the Fa de 
control sect1on of an ilUdiD or superm1posed clip 
for more lnform,ltlon, se e "l·~1xing Aud1o Clips" 
1n Chapter 3 or "Ad¡ustmg the lntenSity of Super­
imposed Clips" in Chilpter 7. 

-
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Using the time ruler 

The time ruler at the top of thc Construction window reflects the selected time unit. It 

displays the current position of thc pointcr and any place markcrs that ha ve bccn sct in thc 

Construction window. From the time rulcr, you can also determine thc starting and 

cnding positions of each clip and thc duration of the en tire movie. 

¡~ Construction Window 1· 
• •1• ~ 

:i:i' 000 o 00.02 00 0000-lOO 
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The largc tick marks on the time rulcr rcprescnt the current time unit; thc small tick 

marks represen! frames or scconds, dcpcnding on the current time unit. r\s you movc thc 

pointer in thc window, a hairline marker movcs in thc time rulcr to indicare thc currcnt 

pointcr position. 

Yo u can scroll in lhc Construclion window lo mo1·c lo a location on thc time nilcr, o¡· you 

can use thc· Goto/Scarch command. 

To use Goto/Scarch to move toa spccific Iocation on thc time ruler: 

1 Makc thc <;:onstruction window ;1ctivc, and choosc Goto/Scarch from thc Projcct mcnu. 

Thl' Coto Local ion cli;ilog box appcars. 

l1mc: lqq¡;¡.¡¡;.,r;l•l i is OO·OO 00:00 

OK j Cancel 

2 ·¡(, mm·c toa spccilic locllton, l'nln thl' time· or framc number of thl' location using thc 

Si'l'li'TE tinwcodc fornnt. For more ini'cHm·,\lion, scc "Siv!PTE Ti meco de" on pagc 2¡{4. 

3 Ciick OK. 

Note: )·[m ll/11 use' co!ons, SCIIIÍt"olou;, or ¡•crío,/s Ín!crclulllgcnl>ly ns scpnrutors(or 11 

tune cntry. 

,. 
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Arranging clips in the Construction window 

Adobe Prcmicrc plays all thc clips in thc Construction window in order fromlcft to right 

The simplest arrangement for a movie is to assemblc the clips end-to-end on a single videv 

track so that the out point of one clip butts against the in point of the next clip. To crea te 

a movie with less abrupt transitions between clips, yo u can place the clips on the A and B 

video tracks so that they overlap, and use thc T track for transitions. Use the S tracks for 

movie clips, still-image clips, or titles you want to superimpose. 

You can arrange clips in the rough ordcr in which you want them to play; then position 

them prccisely using the Snap to Edgcs option, the time ruler, or thc timecodc displayed 

in the lnfo window. You can also use place markers lo align clips. For information on place 

markcrs, scc "Sctting Place lvlarkcrs for Clip Alignment" on pagc 72. 

Whcn yo u draga clip to m ove it orto change its duration, Adobe Prcmicrc brackcts thc 

edges of thc clip with alignmcnl guidcs. These guiclcs hclp to align thc clip with clips on 

othcr lracks. \Vhcn you rclcasc thc mousc button, thc ,¡Jignment guidcs disappcar. 
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To position clips, use onc of thc following tcchniqucs: 

• To snap a clip lo thc cdgc of ,uwther clip whcn ;·o u dr.1g it, use thc Snap to Edgcs option. 

This is thc dcfault sctting for aligning clips in thc Cunslruction window. As \'OU draga clip, 

its alignmcnt guidcs \\·ill snap to thc cclgcs of clips or tr,¡nsitions on othcr tracks. This 

cnablcs precise cdgc ,¡J¡gnmcnt un,¡]¡ t1·acks. 

To togglc Sn.q' tu Edgc:. on .1nd of(. ciwosc Construction \·\'indo\\' Options from thc 

Windows mcnu and sclcct Sn.1p to Fcl~cs, or click tilc snap tool in thc uppcr-lcft corncr of 

the Construction \\'indo\\'. 

·< 



1 • 

L~J 

• To make a clip start ata certain time in the movie, align the left edge of the clip with the 

desired time on the time ruler, or drag thc clip to the desired starting point using thc lnfo 
window for reference. 

Crosspos avi !11 
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• To m;1kc a clip stop ata ccrtain time, align thc righl cdgc of lhc clip wilh thc rulcr m.1rk 
for that time. You cannot stretch movie and audio clips beyond lhcir originallcngth. 

• To selcct al! clips on a track al once, click thc track too! ancl thcn click thc first clip you 
want incluclccl in the sclcction. Drag lo align thc sclcctcd track of clips. Toa del othcr tracks 

to thc sclcction, holcl do\\"n thc Sh:ft kc1· ami click. 
' Note: Yo u H·illnot he nblc ro t1iign clips prcci.<cl)" i( tl1c ti111c unit yo u luwc se/ is ioo !t~rgc. Eor 

111orc inf(mnntion 011 t1djusting thc ti1nc unit, .<ce "Ciwnging thc Nu111/Jcr o(Tiunnlnwils in 

!he Con5trucfion \Fi!uiOH'" on pc1:;.c 5.J. 

• To includc linked clips when seiccting all clips on a !rack, choosc thc multitr,lck too! ancl 
thcn click thc f]rst linkcd clip you w~mt incluckd in the sclcction. All subscc¡ucnt clips 

. (linkcd anclunlinkcd) are sdccted. To c1cld to or subtract from a sc·kction w1th thc inulti­
tr,¡ck too!, huid clown thc Shi(t kL'\" ,¡nd c[¡ck. 

Deleting empty space between clips 

:\s Hlll place clips in lhe Construction "indow, vou can c¡uickly dcktc cmptv spacc 
bct11·ccn clips on a trae k. To delctc cmptv spc1cc bctwccn clips, sclcct thc spacc and choosc 

J~¡pplc Dcktc from thc Edit mcnu, or prcss Ctrl+Dclctc. Adobe Prcmicrc shifts ovcr all 
clips and tr.ms1t!ons on cm,· unlockc·d tr.1cks to closc up thc spacc. For inf(mnation on 
locking tr.1cks, scc "l.ocking Tr.1cks in thc Construction \-\'indow" on ¡)agc 94. 

' ' e 

USING THE INFO W!NDOvÍJ 

Thc In fu windo,,· dispbl"s inl(mnation ahm1t a sclcctcd clip, transit1on, or spacc. Thc 
informal ion 1·aric·s according to 11·hcrc \"Oll mc1kc l"(ll!r sclcction: 

• lf m u sckct a clip in thc Construction window, thc In fu window displays thc na me o( 

thc clip, thc t::pc uf clip, thc spccd uf thc clip (i( a spccd othcr than thc dcLwlt sctting has 
he en en te red), t he d ur,1t ion o ( t he el i p. t he sizc' o ( t he el i p, t he fa de e o n t rolle veis of sclcctcd 



points in the clip, the starting and ending times of the clip, and thc.current location of the 

pointer. lt is sometimcs helpful to watch thc starting an·d ending time in thc lnfo window 

as yo u drag to align a clip in the Construction window. 

¡.·,¡,, 1• 

Closeup avi !1] 
1.11)·/1~ 

['uratl•)n .o 00 021.? * 
1E·1:1' 120 

St..::rt1n9 ot O (11) 00 i 1..1 

End1r1g at O 00 o:::::: 
(UTS':'IZ:l (li)Q(\1:02 J 

• If yo u selcct a clip in thc Project window, thc Info window dispLws thc clip's na me, typc, 

duration, sizc, starting and cnding points, and the currcnt Iocation of thc pointcr. 

• Ifyou sclcct a transition in thc Construction window, the Info window di,,¡,Lws thc tran­

sition's namc, duration, starting and cnding points, and thc current locati0n of the 

pointcr. 

• ·¡f yo u selcct an empty spacc in thc Construction windo\1·, the Info windo"· displays thc 

spacc's duration and starting and cnding times. 

• If a Titk windtlW is active. thc Info wirídow displays rnform~rtion about c1 sclcctcd ob¡cct, 

including its sizc 'llld position in thc \1·indow. 

To display thc Info window: 

Choosc Info from thc Windows mcnu, or prcss Ctrl+S. 
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USING THE MOVIE ANALYSIS TOOL 

The Movic Analysis fea tu re providcs dctailed information about any Video for Windows 

movie, including thc file size, numbcr of video and audio tr<lCks, duration, average framc 

rate, audio ratc, and compression settings. 

To analyze a movie: · 

1 Choose Tools > ivlovie Ana!ysis from the File menu. 

2 Use thc standard Opcn File dialog box to loca te thc Video for \Vindows movic. Thc 
Analysis windo\\" displays information about thc movic . 

.j¿¡~:~ ro(e r: 17-;'.?.2!~ per ~-=·:ond 
11,- ·····' ,, ... i ,,rC-:-u trad'-[:].;:n.: i audro uacl<./:) 

· r r 2 ~ü:.t b•.'tes 1-:: ,.~·ra,J·: rr:~rue"' 10 3.:f: b•,ote:l 
ore 21j:=: f·.e:,•rro.rll''::. - · 

1 ·; 1 ·:· r:. 13 .:,~ ':.e•:(.n•J; 
r.; ~t-'3 9t-:~ b•:le; 

, :~ro: r: 2.2ü':.rJ sarnp'r"-': ioec 
' _:¡r-f,;ole sr:e r: 8 brt: 

Note: lo u mn cuwlFzc ti1c clip in ti ~e· nCI i1·c Clip 1vinrlcnv !>)· choosing M01·ic ;\nnlysis [ro111 thc 

Cf¡p 11·indo:\'·, Contro/¡¡¡,·nu. !nj(nlllti/Íon n/.>outtltc Cli>TC/11 clip nppcor' 111 thc Ann/ysis 

ll'indnw. 

3 TnLbpby :1 :;raph ot"th,· ciq1s d.ll<l r.1ll' Cllc'r tiillc, click thc D.lla lbtc button in thc 
:\nah·sis "·indm,·. Thc Data !~ate gr<lph s]w,,·s m u how smoothly thc video clip will play. 

4 Tu print thc contcnts of thc· :\n;;h·si> "·indo\\", choosc Print \Vindow fwmthc File m en u. 
·¡(, print thc· Uat,!l\oltc· gr.q'h, cl:,·i, thl· l'rint hutton inthc Dal<l Ratc Graph window. 

USING FUNCTION KEYS 

:\dohl· l'rc·mt·~rc· kt, I'OU <l"ign l.l"l'']LICillh· uscd comm.!nds lo Cunction kcys. Sume func­
tiotl kc-1·s <lrc· tli"C<l,signcd in :\doh·,· l'rl'lllil'l"l:. You Glll c1dd ;¡ddition;d assignmcnts or . ' ... ..... 

chan~l· thl· cxistlllg oncs. You c111 s,¡·;~· 1·om Cunction kcv c1ssi~nmcnts and load thcm ... ..._ ' ' ..... 



To change the function key assignments: 

1 Choose Preferences > Function Keys from the File menu. The Function Keys di:Jlog 

app~ars. 

2 To remove a function key assignment, sclect the command name next to the function 

key namc ancl press the Delete key. 

3 To acle! a function kcy assignmcnt, click the text box next to the function key name and 

choose thc comm:md that yo u want to assign to that function ke\· from the m en u bar. The 

commancl appears in the tcxt box. 

4 To assign commands toa function kcy plus thc Shift kcy, sclect thc Shift option and 

choosc thc mcnu command you want to assign to thc function kcy. 

Using thc Shift kcv allows yo u to assign a second commancl to the function kev. To choosc 

the commancl on thc kcyboarcl, prcss thc Shift kev and the íunction key. For cxamplc, yo u 

coulcl assign thc lmport >Director\· comm<lnd to thc F7 kcv and thc Import > Projcct 

commancl to Shift+F7. 

5 To savc \'Our assignments, che k Savc and specifY a filcnamc. 

6 To load an cxisting file of assignmcnts, click Load and scicct thc file. Function kcy 

assignmcnt files ha\"C a .pfl í1lc extcnsion. 

Note: You WllllOt clwngc thc assl~~lllllCilt o(Fl nml Sluit+Fl; tiiCsc kcys displny thc Adobe 
PrCinicrc Hclp S)'SICIII. 

PRINTING THE CONTENTS OF WINDOWS 

You c.m print thc contcnts of thc Pmjcct winclo\,·, thc Construction winclow, ora movic 

clip in thc Clip \\'indow. l'rintc·d windows ctn be uscf'ul as a stor;·board of ;•our proicct. 

To print a papcr copy of a window: 

1 Che k thc· l'roicct, Construction, or Cli¡' \\·indow to makc it acti\'c. 

2 Choosc l'rint \Vind,m· t'rom thc· Fik mc·nu. Thc !'1 int di<tiog box ~tppc.trs. 

3 Click Sctup rn thc i'rint di~t!og to ch.mgc :he printcr scttings. Ytll! can also clwngc thc 

printcr scttings bY chuosing l'rint Sctup from thc Fik mcnu. 

4 Click 01-:. 

•J 
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CHAPTER 3: EDITING 

~~j~ his chapter describes the basic techniques used to edit clips and construct a movie 

![~ ~~ in Adobe Premiere. This chapter also describes how to genera te an Edit Decision 
~;~ .... Stt;; List (EDL) from thc Construction windoll" for online editing of so urce videotape 

in a post-production studio. 

Un ti! rccent vears, video editing ,,·as strictly l111cnr; the en tire program of video, audio, and 
spccial cffccts scgmcnts had to be idcntified and sequcnced in cxact order bcforc the final 

videotape was madc. Thc editing proccss in .c\dobe Prcmicrc is nonlinmr; you can inscrt, 

copy, replace, transform, and delcte clips at any time. You can experiment with various 
scqucnccs and effccts, previell"ing thc changcs bcforc compiling vour final movic or 

outputting to vich~otapc. 

The following editing operations are prcsentcd in this chapter: 

• Vic\\'ing :1 clip 

• Sctting markcrs in a clip for precise ;dignmcnt with othcr clips and cílccts in 'thc 
Construction \\·indm,· 

• Trimming a clin (chanL;ing its startin·g and cndint! frames) .... t '- ..._ .... '·-' 

• Setting the duratwn of ;¡ still-imagc clip 

• Splitting a clip into two ncll" clip;, 

• Inscrt cditinn 
" 

• ChanL;inl! thc spccd of ;1 cli¡1 to achicve nwtion cffccts ..... .._, . 
• ¡\;jixing ;¡uclio clips (Slllld.ll" to mixing aud1o tr.1cks in a sound studio) 

• ,\·!odil\·ing clips in othc'l ;¡p¡,J:c,Jtions (suc:1 as i\dobc Photoshop) 

• Gcncrating an EDL 

Note: More udn1nccd cdiflng rc,·hnu¡ucs in¡·o/¡·c clf'i'lying tmnsitions /Jct\l'CCII clips, supcrilll­

po.<!llg clips, llililudding 111<'' i,n¡ clwl.<¡>,·<"iul <:/fc·t"!.< rá chps. Thcsc proccdurc.< are prcscntcd in 

su/1.-::c(¡ucnt cluljJllT.'. 

6~ 



Yo u edit clips in Adobe Prernierc using thc Clip window, the Construction window, and 

the Trimming window. Thc Clip window is u sed mainly for viewing clips, setting in points 

and out points in clips, and setting markers in clips. The Construction window is used 

primarily for arranging clips, splitting clips, inserting clips, layering and compositing 

clips, and mixing audio clips. It can also be used to trim clips and to change the speed of 
clips. The Trimming window is used to precise! y adjust the edit point betwcen two clips in 
the Construction window and instantly sec thc effect ofthe adjustment.. 

Note: A specinl typc of winrfow, cnllerf tlzc Co1ztrollcr, is uscdfor previcwing nn aren in tlzc 
Constnzction window. 1-1!/zi/c prcvicwing witlz tlzc Controllcr, yo u can sct 111nrkcrs nnrf znnkc 
cllts ncross tmcks in tlzc Constructionwinrfow For infonnntion on tlzc Control/cr, scc "Using 
tlzc Controllcr" 011 pnge 120. 

USING THE CLIP WINDOW 

By default, Adobe Prcmierc plays a movic oran audio clip in thc Clip window from begin­
ning to cnd, as it was origin;tlly rccordcd. You can use thc Clip window to chctngc thc 

star~ing and cnding framcs of a clip, to changc thc duration of a still-imagc clip, and to set 
markers in a clip for aligning with othcr clips, and for quick navigation. 

Thc Clip winclow controls are similar for \·ideo and audio clips. Thc íramc indicator 

displays thc currcnt position in thc ci;p. For still imagcs, the Clip window cont;\ins a dura­
tion control. 

.~ ln·pomt 
j indiC<ltOr 

Jog!Shuttle, 
control 

:- P!,1y ln/Ou! button 

Framc Forward 
! and Backw.1rd :· In button ; 

-Play button , 

0 Col!:'lpse Previcw ¡ Uutton 

loup l.Juttun 

·-Stop button 
1, ~ Out button 

- Slider '- FrJme mdicJtor 

·- Clip durJtion 

1 
-·, WJveform control 



You can collapse the Clip window and use the Clip window controls to view a video clip 

in the Preview window. This is useful when yo u bavc severa! Clip windows open on­

screen. You colbpse or cxpand the video clip using the Collapse Prcview button. 

Opening a clip in a Clip window 

In most cases, cach time yo u opcn a clip, a ncw Clip window opcns. Conscqucntly, yo u can 
havc a1w numbcr of Clip windows opcn at thc same time. Thc Clip window initially 
displavs thc lirst frame of a movic clip or the w~weforms of an audio clip. To reduce tbc 

screcn cluttcr that can occur if too m:~m· windo1''S are open at once, yo u can optionally 
opcn a clip in an cxisting Clip 11·indow. 

To open a clip in a new Clip window, use onc of thc following mcthods: 

• Doublc-click thc clip's thumiJnJil inthc Projcct winclow or in thc Construction window. 

Note: To opcn ¡m/y t he audio pomon oj'uli nkcd clip, doul>lc-click t i1c oud io l\'rll'c)Ónn port ion 

o(thc tlnunlmoil inthc Proj,·c: 1\'I!Idoll'. 

• Sclcct thc clip in thc Proicct wind011· or in thc Construction window, ;¡nd choosc Opcn 
Clip from thc Clip mcnu. 

• C:hoosc Opcn from thc· File m en u, and use thc Opcn dialog box to sclcct thc clip. 

To open a clip in an cxisting Clip window: 

Dr.¡¡; thc· chp's thumbn.1il from thc Projcct window to thc Clip windllll·. Thc original 
clip in thL' Clip windm1· cluocs ;¡mi is rcpbcccl hy thc ncw onc. If thc Clip window is 
collapscd, Jrag thc· thumhn.1ÍI m-cr thc wiml(m's timccodc ;Jrca to display thc clip in thc 
Prc1·icw 11·ind(m·. 

Viewing and playing clips in the Clip window 

Thc Clip 11·indm1· controls for 1·icwing Y ideo clips ancl playing audio clips are almos! idcn­
tical. :\lthough audio dat;l i, ,¡orcd as;¡ continuous dat,l strcam rathcr than as individual 

framcs, ;nidio clip, ;HL' smchronizccltothc framc raic of thc mc11'ic. This allows Adol­
Prcmicrc to rcfn to scctions of thc audio 1\'aveform as framcs in thc samc wav that it re. 

' 
to thc imagL' fr.1mcs of a 1·idco clip. 



To view or play clips in the Clip window, use one of the following methods: 

• To bcgin playing the clip, click thc Play button. To stop playing thc clip, click thc Stop 

button. Yo u can also press the spacebar to start and stop playing a clip . 

• To play the clip in reverse, hold down the Alt key as you click the Play button . 

• To play the clip between the in and out points, click the Play In/Out button. To play the 

clip continuously (loop) between the in and out points, press the Loop button or hold 

down the Ctrl kcy as you prcss thc spacehar. 

• To go forward or backward onc frame ata time, click thc Frame Forw:~rd or Frame 

Backward button, or press the Right Arrow or Lcft Arrow key. To go forward or backward 

fivc frames ata time, hold down thc Shift key while pressing the Right or Left Arrow key. 

• To scrub fonvard or backward through portions of the clip, hold the mousc button 

down on the Framc buttons, or hold down thc l~ight or Left Arrow kcy. 

• To fast-forward, press the F key. To rewind, press thc R key (movie clips only). 

• To m ove forward or backward through fr;lmcs orto }ump to another part of the clip, 

dr;¡g thc slidcr. 

• To scrub through thc clip frame bv framc, click ata point in thc Jog control and drag left 

or right. You can continuc to clrag outsidc the control arca if ~·ou don't rcle;Jsc thc mouse. 

• To pla)' the clip forwarcl or backw:ml ata vari;1blc speccl, Alt+click the Jog control to 

changc it to thc Shuttlc control. Drag the Shuttle control to thc right qr leti; the brther yo u 

'drag thc ShuÚic control from thc ccntcr, thc Í:1ster thc clip plays. \Vhcn nlu rclcase the 

mouse button, the clip stops pl;n·ing, ;me! thc Shuttle control moves back to the center 

position. (Thc modc of this control can also be ser in the General Prcferenccs dialog box 

or by choosing Clip Winclow Options from the Windows mcnu.) 

• To m ove fonvard or backw.1rd h~· :1 specilic dur:llion, press thc T1b ke)· ur click thc 

curren! fr:llllL' indicator lo select it; then entcr the duration using the SMI'TE timccodc 

form;¡t, and prcss li.cturn. 

For cxamplc, en ter +5:03 tomovc fon,·ard livc seconds anclthrec frames. En ter -1:23 to 
11l0\T bacb,·ard 1 second and ~3 (r;uncs. 

• To ch;lllgc thc 1·olumc ofthc linkcd ~ludio in <l video clip, chck thc speaker icon in 

the loi\'LT-right corncr of thc Clip ll'indol\'. Thc threc settings are full vol u me, halfvolume, 

ami off 

' ' 



To m ove to a specific frame, use one of the following methods: 

_ • To m ove to a specific frame, press the Tab key or click the current frame indicator to 

select it; then en ter the exact frame yo u want to m ove to ( using the SMPTE timecode 

format), and press Return. For example, if yo u en ter 0:00:43:05, the clip advances to the 

framc 43 seconds and 5 frames into the clip. 

• To m ove to the beginning of the clip, press the Home key. Press thc End kcy to m ove to 

the end of the clip. 

• To change the framc numbcring format used to count frames in the Clip window, 

choose Clip \Vindow Options in the Windows m en u and selecta format from the Count 

drop-down list. 

Resizing the Clip window 

Yo u can resize the Clip window by dragging any corner of the window. V\Thcn yo u resizc a 

video clip, thc clip's display snaps to onc of scvcral dcfault sizcs. To sea le thc display to 

match the sizc of thc Clip window, hold clown the Shift kcy as yo u drag. To doublc thc 

display sizc, Shift+click thc clip. 

Viewing the audio waveform in the Clip window 

Yo u can choose one of four diffcrent vicivs to display the audio wavéform in thc audio Clip 

window: cxpandcd, normal, condensed, and extra condensed. The expandcd view shows 

the most dctail, while the condcnsed vicws providc a longcr duration of sound in 

thc window. You can also cnlargc thc audio Clip window to makc it easicr to find points 

and sct markcrs, cspccially whc·n yo u are working with thc cxpandccl vicw of an audio 

wavcform. 



To expand or condense the audio waveform in a Clip window: 

Click the Waveform controllocated above the )og or Shuttle control to toggle bctween 
cxpandcd, normal, condcnscd, and extra condcnsed. 

Expandctl Nor111nl 

l:'xtm condcn:>t'd 

Note: For trim111i11g audio clips, thc audio wnvc[on11 ca11 be cxpn11dcd to siiDlv i11crc111e1lts ns 
s111n!l as J/600t/¡ scco11d. For 111fon11atio11 011 trit11111i11g, scc "Trimmi11g Clips" 011 pagc 76, 

To' see more detail in the low amplitude portions of the waveform: 

1 i'vlakc thc Clip window active, and choosc Clip Window Options from the Windows 
mcnu. 

2 Use the Clip \Vi1ldow Options di;tlog hox lo set the W;¡vefmm Displ.1>' option lo 
1\oosted. 

SETTING PLACE MARKERS FOR CLIP ALIGNMENT 

!'lace markers let you mark points in the time rulcr and in clips that can he used for align­

mcnt with other clips and tr,msitions in the Construction window. for examplc, you may 

want an audio clip to bcgin fading in ata particular frame in a video clip. By sctting place 
markers in hoth clips. vou c.m dr;¡g one markcr lo another for precise alignmcnt. 

l'vlarkers work in conjunction ll'ith the Snap lo Edgcs option in thc Construction window 

Options dialog hox. \Vhen Snap to Edges is selccted, <1 clip in thc Construction window 

snaps lo a marker in thc time rulcr when it m oves within a limitcd range of thc markcr. 

Similarlv, lll<lrkers in clips locltcd on diíkrenl tracks snap lo each othcr whcn brough't 
within a limited ¡·;mge. 

·-. 
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Using the Snap to Edges option 

The Snap too! in the upper-left corner of the Construction window indicatcs whcthcr thc 
Snap to Edges option is selcctcd. 

~ Snap tool 

1= Con 
'" ~ 
H~ ........... ,.-.. ,. .... -.- ... ·· :"'.•,,·;•·, 

~~ PO:OO 0:00:02:00 

If yo u do not want markcrs to snap dircctly to the centcr of ca eh othcr, dcsclcct thc Snap 
to Edges option in thc Construction Window Options dialog box. To togglc thc option, 
click thc snap to'ol; or with thc Cunstruction window active, prcss thc T1b kcy. 

Setting place markers in the time ruler 

You can sct up to 10 pL1cc markcrs in thc time rulcr to indicalL' whcrc clip' should bcgin 
or cnd. You can sct markcrs whik prcvicwing a movic or by sclccting a puint oJJ the 
time rulcr. 

Toseta place markcr in thc time ruler: 

1 l'vlakc su re that a clip is not sclcctcd; othcr\\'isc, thc markcr will be pl;Jcccl in thc sclcctcd 

clip. 

2 l'osition thc hairlinc in thc time ruin al thc clcsircd point. (You do not havc lo drag thc 
mousc; simpl>· mm•c thc mousc· until thc h;lirlinc in thc time rulcr is positioncd at thc 
dcsircd time.) 

3 Hold clown thc Shift kcy ;1nd prc·ss a numbcr from Oto 9. t\ numbcrcd grccn markcr 

appcars in thc time rulcr. 

4 Draga clip to thc markcr to pusition it at thc dcsirccl starting or cnding timc.lfthc Snap 
to Edgcs option is sclcctcd, thc lcít ot right cdgc of thc clip will snap to thc markcr. 



Toseta marker in the time ruler from a Controller window: 

1 Choose Controller from the Windows menu. The Controller and Preview windows 

appear. 

2 Use the Controller window controls to loca te the movie frame you want to mark. These 

controls function the same as those in a Clip window. For more information on the Clip 

window controls, see "Using the Clip Window" on page 68. 

3 Choose a number from the Mark pop-up m en u. A numbered markcr for the displayed 

framc is sct in the time rulcr. 

4 To set a marker whilc the preview plays, hold down the Shift key and press a number 

from Oto 9. The marker is set in the time ruler. 

To delete a place marker in the time ruler: 

1 Position the hairline in the time ruler ovcr thc marker yo u want to delctc. 

2 Press C. The marker is dcleted. Remaining markcr numbers are not reordered. 

Setting place markers in clips 

Yo u can set up ,~o 1000 place markers in a clip, but only 1 O ca1i be numbered. Yo~\can accu- -~ 

rately position:markers in an audio clip while thc sound is playing, simplif1·ing the task of 

svnchronizing audio tracks with video tracks. 
' e 

N u m bcrcd.a nd unnumberccl el i p m a rkcrs appca ras hluc tags in t he Constructio~ window 

thumbnails. Yo u Gln togglc thc dispi<l)' o( lll<lrkers on ando(( with thc Show Ma··i·kcrs 

option in thc Cmstrüction Window Options tli<dog hox. 

Toseta place markcr in a movic or audio clip: 

1 In the Clip window, find thc frame of thc clip or the are a of thc waveform yo u want to 

mar k using any of the methocls dcscribcd in "Vicwing and Playing Clips in the Clip 

Window," on pagc 69. 

2 To sct a numbered markcr, sclcct a markcr numbcr from the Mar k pop-up m en u. 

7 -.'-' 



Adobe Premiere places a bullet next to the number in the Mark pop-up menu to indica te 

that the marker is in use, and places the marker with the selected number in the framc or 
waveform. 

3 Toseta numbercd place marker whilc a movic or audio clip is playing, hold clown thc 
Shift kcy ancl prcss thc clc.,ircd numbcr on thc kcyhoard. 

4 To sct an unnumhcrcd m:1rkcr, prcss thc cc¡ual sign (=) kcy or plus ( +) kcy. You can sct 
unnumbcrcd markcrs whilc a movic or audio clip is playi11g. 

To align place markcrs in thc Construction window: 

1 ivlakc sure that thc Show ivlarkcrs optio11 is 011 by choosi11g Co11structio11 \'\1indow 

Options from the Windows mc11u. 

2 Positio11 thc sclcction too! 011 thc markcr vou wa11t to alig11 with a11othcr markcr. Thc . ' 
sclection too! turm gra1·. 

3 !3cglll draggi11g thc markcr. As yo u drag, a11 alig11mc11t guidc appcars through thc ce11tcr 
of thc markcr to hclp yo u alig11 thc markcrs. If thc S11ap to Edgcs optio11 is turncd on, thc 
markers s11ap to cach othcr. 

- MarkE'r m chp A 

'j¡ 1 1:: ' .. . . . 
" ~ 1· 

' -~------------ ----- - Marker ¡n cl1p B 
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4 When the markers are precisely aligned, release the mouse button. 

To delete a place marker from a movie clip: 

In the Clip window, position the pointer over the frame containing the marker and press 

C or X on the keyboard. Remaining marker numbers are not reordered. 

To delete a place marker from an audio clip: 

In thc Clip window, sclect the markcr in thc wavcform and prcss C or X on the kcyboard. 

Rcm<lining marker numbcrs are not reordcrcd. 

Finding place markers in clips 

You e<ln use the Clip window to find frames that havc been markcd in a clip. 

To find a marker, use one of the following methods: 

• Click Goto and selcct a numbcrcd place markcr from the pop-up mcnu.l3ullcts indica te 

which markers are in use in the clip. 

• Prcss a number from Oto 9 on the keybo<Jrd lo go toa markcr. 

• Movc to the ncxt markcr or prcvious markcr by holding down Ctrl and using thc Right 

or Left Arrow keys. · 

TRIMMING CLIPS 

Trinr111ing rcfers to adding or subtracting framcs to changc a clip's duration. The position 

6f a clip's star-ting frame is callcd the in p~int (somctimes referred to <lS the lrcnd), ~·nd the 

position of thc cnding fr'amc is callcd thc out point (somctimcs rcfcrrcd toas thc tail). Clips 

can be trimmed in thc Clip window, the Construction window, or thc Trimming window. 

Of thcsc thrcc, the Trimming window offcrs thc most precise control anci instant feedback. 

Changcs you make to thc in or out point of a clip <lffcct thc W<W that Adobe Prcmicre uses 

thc sourcc clip when building a movic, not thc sourcc clip itsclf on your h<lrd disk. 

You c1nnot lll<lkc a movic or audio clip longer than thc sourcc clip unlcss )·ou use the 

Spccd comrnand to slow clown the clip and cxtcnd its dt,lration. Thc shortcst duration for 

any clip is 1 framc. Thc longcst duration for any clip is 1 hour. f.or more informal ion on 

clip duration and spccd, scc "Sctting thc Duration of a Clip': on pagc 86 and "Setting the 

Forw<lrd or 13ackward Spccd of Clips" on page 95. 

Trimming clips in the Clip window 

A clip opcns in thc Clip window at thc framc corresponding to thc currcnt in point. Thc 

duration countcr shows the duration o( thc clip Crom the currcnt in point to thc current 

out point. 

'-



Note: You can use thc Clip window to sct in and out points for a clip befare importing it mto 
a project. This is useful for importing various scctiolls of a sillglc. clip as separa te clips. For 
informatioll 011 inzporting clips, scc "Importing a11d Opc11ing Clips" 011 pagc 33. 

To change the in and out points in the Clip window: 

1 Find thc place whcre you want to set the in point for the clip using one of the methods 

describccl in the section, "Viewing and Playing Clips in the Clip Window," on page 69. 

2 Click thc In button or press Shift+l to set the in point. 

For movie clips, thc in-point inclicator appcars in the upper-left corncr of thc Clip 

winclow. For audio clips, the in-point indicator appears at the corresponcling point alons 

the waveform. 

ln·point ind1cator 

3 Fincl the place wherc yo u \\·ant to sct thc out point for the clip, and click thc Out button 

or prcss Shift+O. 

For movic clips, Adobe Prcmicrc placcs thc out-point indicator in thc uppcr-right corncr 

of thc window. For aud1o clips, thc out-point indicator is placcd at thc corrcsponding 

point along thc wavcform. Thc duration counter at the bottom of thc window shows thc 

ncw duration of thc clip. 



For movie clips, AdobePrcmiere places the out-point indicator in the upper-right comer 

of the window. For audio clips, the out-point indicator is placed at the corresponding 

point along the waveform. The duration counter at the bottom of the window shows the 

new duration of the clip. 

Out·point indicator 

... '', . 

Note: Cllllnsins thc in111ul out points ofonwl'ic clip tllllt is linkcrl lo 1111 onrlio clip ll'illnj(cct 

UO[/¡ tflC 1/lOViC lllliflllldio f'OrliOilS O{thc finkcrf clip. 

Setting precise in points for audio clips 

Yo u can position the in point for an audio clip with a high dcgree of precision when sound 

synchronization is critical. Thc in points of audio clips can be adjusted in increments as 

small as l/600th.of a scconcl.l3ccausc Adobe Prcmicre synchronizesauclio clips to the 

frame rate of thc movic, yo u refer toa section of an audio wavefon~1 as a frame ... 

Toseta precise in point for an audio clip: 

1 Zoom in on the audio wavcform display by choosing Clip Window Options from thc 

V/indows m en u and choosing a ncw value for Ratc. Yo u can set thc ratc as small as 600 fps. 

(Rates of 100 and 600 fps are in tended for sctting thc in point only; thc audio may not play 

smoothlv at thcse scttings.) 

2 Use thc Framc Forward or Framc Backward button, or prcss the Right Arrow or Lcft 
Arrow key to go forward or b;rckward onc frame al;¡ time. 

3 Click thc 1 n button or prcss Shift+ 1 to sct thc in point. 

4 \Vhcn you havc finishcd setting thc in point, choose Clip Window Options from the 

Windows mcnu and rcsct thc ratc to its original sctting of 30 fps. 

Finding the in and out points of a clip 

Thc Clip winclow can be usccl to locHe thc in and out points of a clip. This is done in thc 

same manner as finding place markcrs in a clq.J. 

.•. 
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To find the in and out points, use one of the following methods: 

• Click Gato and choose In or Out from the pop-up menu. 

• Press I on the keyboard to go to the in point, or press O to go to the out point. 

Trimming clips in the Construction window 

Adobe Premiere providcs a number of ways to tri m clips in the Construction window. Yo u 

can use thc in point and out point tools or the ripple cdit and rolling edit tools, or you can 

simply drag the edges of the clip. Using the ripple edit and rolling edit tools is describcd in 

the next section, "Using thc Ripple Edlt and Rolling Edit Tools in the Construction 

Window." 

For bettcr trimming prccision, choosc a low time unit in thc Construction window. You 

can also use edgc viewing (dcscribcd in this scction) to vicw thc framcs in thc Prcvicw 

window as yo u drag thc cdges of thc clip. 

Whcn yo u changc thc duration of a clip in thc Construction window, thc Info, l'rojcct, ami 

Clip windows are autom,llically updatcd with thc ncw clip duration. 

To trim a clip using the in point and out point tools: 

1 Select the in point or out point too! in thc Construction window by clicking the too! 

icon or pressing 1 orO on the keyboard. 

Note: Ifyou click thc in point or ollt point too/ 011CC, thc too! reverts to thc sclection too/ after 
onc use. Doublc-click thc in point or 011t point too/ to use it rcpcatedly 

2 Click thc in point too! on thc lcft cdgc of thc first framc yo u wan t displayed in the movic. 

3 Click thc out point too! on thc right cdgc of thc last framc yo u want displayed in 

the movic. 

:--. In pornt too! Out point too! 



To trim a clip by dragging: 

1 Position the selection too! on the edge of the clip to be shortened or lengthened. The 

sclection too! turns into a strctch pointer. 

2 Drag to shortcn or lengthcn thc clip, and release the m o use button when thc clip rcaches 

thc desired lcngth. 

To trim a clip using the Edge Viewing option: 

1 Makc sun: that the Info ancl Prcvicw windows ¡lrc visible on the dcsktop. 

2 Turn on eclge viewing by clicking the edgc viewing too! in the upper-lcft corner of tbe 

Construction window. Yo u can also use thc Construction Window Opti¿ns dialog box tÓ 

sclcct the Edgc•Viewing option. 

3 In the Construction window, position thc selection too] on the edge of the clip to b~ 

shortened ~Jr lc;1gthened. Thc sclcction too! turns into a strctch pointcr. .. 

Twirl.av1 [1] 
Movte 
úurahon O 00 03 18 .S 
160x120 

Start1ng al O 00 00 29 
End1ngat· 0000-115 

Cursor ar· O 00 04 15 
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4 Bcgin dragging thc cdgc of thc clip. As yo u drag, thc framc corrcsponding to thc clip·s 

adjusted in point or out point is displayed in thc Previcw window, and thc timccodc 
addresses for the clip's starting and ending points are displayed in thc Info window. 

T wirl.avi [lJ 
Movre 
Duratron O 00 O~ 06 § 
160 :-· 120 

Startrng at O 00 00 29 
E ndrng at O 00 03 05 

Cursor at O 00 03 05 

5 Rcleasc thc mousc button whcn you rcach thc dcsircd in or out point in thc clip. 

Using the ripple edit and rolling edit tools in the Construction window 

Thc ripplc t;dit tool adjusts th~ duration of onc clip on a track whilcrctaining thc duratio11 
of all othcr clips 011 thc track. All clips and transitions on othcr unlockcd tracks that are 

placcd to thc right of thc adjustmcnt point are moved a long thc timc:linc to match thc clip 
movcmc11t on thc ripplcd track. (For information onlocking tracks, scc."Locking Tracks 
in thc Construction VVindow" 011 p;1gc 94.) Thc cffcct ofthc duratinn ch;111gc in onc clip 
;Icljusts (rippks) thc positions of othn clips and 111.1)' changc thc total duratio11 of thc 
mnvic. Ripplc ccliting is somctimcs callee! Jihn-stylc cditi11g. 

Thc rolling cclit tool acljusts thc duration oí o11c clip, but incrcascs or dccrcascs thc dura­

tion of thc adiaccnt clip to mai11tain thc original duration of thc two-clip scque11cc and oí 

thc en tire track. Rolli11g cditi11g is somctimcs callcd l'idcn-stylc cditing. Whc11 pcrforming 

a rolling cdit, yo u can use Edgc Vicwing to scc the cdgcs of thc clip a11d thc adjaccnt clip 
ill thc PI-c,·icw window. For information 011 sctting up Edgc Vicwing, scc "Trimming Clips 
in thc Construction \\'indow" o11 pagc 79. 



To trim a clip using the ripple edit too]: 

1 Select the ripple edit too! from the extended tools pop-up m en u in the lower-left comer 

of the Construction window. 

Yo u can also access the ripple edit too! by pressing P on the keyboard. 

2 Position the m o use pointer on the joint between two clips, and drag to adjust the dura­

tion of the desired clip. The clip's duration is adjusted without affecting the durations of 
the other clips. 

·• 

To tri m a clip using the rolling cdit too!: 

1 Sclcct thc rolling cdit too! fromthc extended tools pop-up m en u in thc lower-left comer 
of the Construction window. 

Yo u can also acccss thc rolling cdit too! by prcssing Y on thc kcvboard. 

' . .• 



2 Position the m o use pointer on the joint between two clips, and drag to tri m the clip. One 

clip's duration is adjusted, and the other clip's duration is shortened or lengthened to 

offset the adjustment. 

Trimming clips in the Trimming window 

If you want to be as precise as possiblc whcn trimming clips, use thc Trimming window. 

Thc Trimming window lcts you add or subtract framcs from clips at cdit points along thc 

timclinc. Whilc making adjustments, yo u can scc thc cxact framc that appcars on cach si de 

of thc cdit point. 

¡- Add/~ubtruct - Framc on lcft s1dc :- Frame on r1ght s1dc 
hume~ of edit point 1 of ed1t pomt 

; 
- Play bulton '·· Jog control 

1 
- Next edit pomt 

L Prev10us edlt pomt 

Resct button 

:_ Tot,ll numher of Ir ames 
addedlsubtractcd 

•J 



When trimming a clip this way, the durations of all other clips on the trae k remain the 

same, as if yo u were perforrning a ripple edit. All clips on other unlocked tracks that are 

placed to the right of the edit point are moved along the timeline to match the clip move­

ment on the rippled track. (For information on locking tracks, see "Locking Tracks in the 

Construction Window" on page 94.) Yo u ha ve the option, however, of using the rolling 

edit too[ in the Trimming window. The rolling edit too[ adjusts the duration of one clip, 

and in creases or dccreases thc duration of the adjacent clip. Doing so maintains the orig­

inal duration of the two-clip sequence and of the en tire track. 

Whilc working in the Trimming window, yo u can return the cdit point to its originalloca­

tion by clicking thc Reset button. 

Yo u can change the display of the Trirnming window in a variety of ways. The window can 

display up to five frames on cither si de of the edit point. Yo u can also sct thc number of 

frames to manipula te with thc add/subtract buttons, and how many seconds to preview 

around the edit point. 

To perform a ripple edit in the Trimming window: 

1 Choose Trimming from thc Windows mcnu. The Trimming window appcars. 

2 Click the Next or Previous button to mm·c the cdit linc to the point yo u want·to adjust. 

Thc frames on both sides oí the edit point are displayed in the Trimming window. lf yo u 

position the edit linc on a transition, the last frame oí the clip on track A and the first 

frame of the clip on track B are displ;lwd. 

3 '1(> add or suhtract:a spccilic numbcr of framcs from thc clip on thc lcft sidc ofthc cdit 

point, click eithcr thc + or- button on thc lcft si de of thc window. To add or subtract 

frames from thc clip on thc right sidc of thc cdit point, click cither thc + or- button on 
the right si de of thc window. 

4 To add or subtr;1ct a largcr numbcr of framcs, drag thc Jog control on cithcr side ofthc 

window. Thc cdit linc movcs in thc dircction and distancc you drag. 

Altcrnatcly, vou can add or subtract framcs by clicking onc of thc time displays and typing 

a ncw time valuc. 

5 To prcvicw the new edit, click thc Piar button. 

To perform a rolling edit in the Trimming window: 

1 Choosc Trimming from thc Windows mcnu. Thc Trimming window appcars. 

2 l'vlovc thc mousc pointcr to thc joint bctwccn thc two framcs displaycd in the window. 

The pointer changcs to thc rolling cdit too!. 

• 
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3 Drag to the left or right to trim thc clips. As one clip's duration is trimmed, thc other 

clip's duration is lengthened. 

4 To preview the ncw cdit, click the Play button. 

To change the Trimming window settings: 

1 Make thc Projcct Trimming window active. 

2 Choose Trimming Window Options from the Windows menu, or click thc right mousc 

button on thc window title bar. The Trimming Window Options dialog box appears. 

3 Selecta format for displaying the frames on both si des of the edit point. Yo u can display 

the single frame on ea eh si de of the cdit point, the three frames surrounding the cdit point 

on cach sidc, or thc fivc framcs surrounding thc cdit point on cach sidc. 

1

·- fr<~mc on lcft s1de 
of cdit pmnt 

Fr,1me on r1ght s1dc 
of edit pomt 

First frame 
of the source clip 

·- last frame 
of the source clip 

4 Spccify thc largc-framc offset (how many framcs to movc thc cdit point with thc largcr 

numbcrcd plus and minus huttons). Thc dcfault numhcr is 5 framcs. 

5 Spccify how many scconds (ccntcrcd around thc cdit point) of thc clip should play whcn 

you prcvicw thc ncw cclit point. 

6 To play prcvicws at thc maximum sizc availablc in thc Trimming window (or 

in the Previcw window if vou collapsc thc Trimming window), sclect Play Prcview 

at lvlaximum Sizc. 

7 Click OK. 



Setting the duration of a clip 

You can set the duration of any movie clip, still-image clip; or transition while the Clip 

window is active or while the clip is selected in the Project, Construction, or Sequence 

window. 

A new duration setting changes the out point of a clip. Time-based clips (movies and 

audio) cannot be lengthened beyond the duration of the original clip unless a slower speed_ 

is assigned to the clip using the Speed command in the Clip menu. For more information 

on the Speed command, see "Setting the Forward or Backward Speed of Clips" on page 95. 

The default duration of still-image clips is 1 second. Yo u can change this default duration 

by using the Preferences option in the File mcnu. 

To set the duration for a clip: 

1 Selcct thc clip in the Project, Construction, or Sequence window, or open the clip using 

onc of the mcthods described in "Using the Clip Window" on page 68. 

2 Choose Duration from the Clip m en u. If yo u are setting thc duration of a still-image 

clip, yo u can also click the Duration button in thc still-imagc Clip window. Thc Clip Dup­

tion dialog box_ appears. 

3 En ter a dur~iilon for the clip using SMPTE timecode (Hours:Minutes:Scconds:'Frames), 

and click OK. lf yo u sclccted m u! tiple clips, the Clip Duration dialog box reappears for 

each clip .. 

Toseta dcfault duration for still-image clips: 

1 Choosc l'rckrcnces > Stilllmage from the File menu. Thc Stilllmagc dialog box appears. 

2 En ter a dcfault duration foral! still-imagc dips, and click OK. 

PASTING CLIPS OR CLIP ATTRIBUTES IN THE CONSTRUCTION WINDOW 

Adobe l'rcmiere provides the standard \'\1indows editing commands for cutting, copying, 

a nd past i ng el i ps. Thc program a !so con tai ns two add i t ional past i ng commands: Paste to 
Fit and Paste Custom. 

Thc Paste lo Fit command pastes a copied or cut clip or transition into a sclected arca of 

thc Construction window, and changcs thc duration (sets a ncw out point) of the clip to 

fit it into the selcctcd arca. This fc~llure is cspccially uscful for rcpbcing a clip in the, 

Construction w111clow with anothcr clip of thc samc duration. 

•" 



The Paste Custom command pastes part or all of a clip, or a subset of its attributes (such 

as filters, motion settings, fade control, or transparency settings), into a selected clip or 

selected area of the Construction window. 

Topaste a clip and change its duration to match a selected area: 

1 Selcct a clip in the Project, Clip, or Construction window, and choosc Copy from the 

Edit menu. 

2 Select the area or clip in the Construction window where yo u want topaste the clip. 

3 Choose Paste to Fit from the Edit mcnu. 

Topaste a clip and choose how to affcct thc contents of thc Construction window: 

1 Sclect a clip in thc Projcct, Clip, or Construction window, and choosc Copy from thc 

Edit menu. 

2 Click a track ora clip in thc Construction window to sekct a dcstination for pasting 

thc clip. 

3 Choosc Paste Custom from thc Edit menu. Thc Paste Custom Scttings dfalog' box 

appears. 

. · ·Paste Custom Senlngs . 
¡ --

1 Normal li] 

' -------- ·-. ·-· --- -·-· ------ ·-- -- --··· 
::··¡ '}PitHH]\ -- - - - · 1 

o !_1llf~r~ .....-o .1 ltH.ISJl•llt~flC\' ~;t:I!Htq~ 1 

- n . ' U 1 ~ul•· Cnntwl :.....J !:4_nlron ~i•:llmq-;: 1 
:----------_______________________ .....! 

1 ~~a~t~! 1 1 Cancel 1 

4 Click Contcnt to sclcct a mcthnd for pasting a ·clip into thc Construction window. Thc 

Contcnt options allow you to adiust thc dur<Jtion of clips in thc Construction window to 

accommodatL· thc pastL·d clip, or vice versa. ThL· l',Jstc Custom dialog box displays an 

animatcd rcprcscntation of thc sclcctcd paste opcration. 

·< 



5 Choose from the following Content options: 

o Normal. Pastes the source (copied) clip onto the destination .(paste) area you select. If 

thc so urce clip is largcr than thc dcstination arca, thc sourcc clip's out point is adjustcd to 

fit the dcstination arca. Howcvcr, if thc sourcc clip is smallcr than the destination arca, thc 

unused portian of the destination arca remains blank (black). 

o M ove So urce Out Po in t. Adjusts thc sourcc clip's out point to fit the destination space. 

o Move Destination In Point. Adjusts the destination clip's in point to accommodate the 

duration of the so urce clip. 

o M ove So urce In Point. Adjusts the so urce clip's in point to fit the clip into the destination 

space. 

o Move Destination Out Po in t. Adjusts the destination clip's out point to accommodate 

the duration of the so urce clip. 

o Change Speed. Increases or decreases the so urce clip's speed (and, as a consequence, its 

duration) to accommodate the destination space. If the destination space is smaller than 

the so urce clip, the speed of the clip in creases. If the destination space is larger than the 

source clip, the spced decrcascs. For more information on changing a clip's sp'eed, sec 

. "Setting thc Forward or Backward Spced of Clips" on page 95. 

o Shift Linked Tracks. Shifts all clips on the track (and linked clips on other tracks) to 

accommo?ate the duration of the so urce clip (which m ay initially be smaller or larger than 

' that of the dcstination arca). 

o Shift All Tracks. Shifts clips on all tracks to accommodate the duration of thc so urce clip. 

6 Click Paste. 

Topaste a clip's attributes to other clips: 

1 Select the clip in the Construction window whose attributes you want to copy, and 

choosc Copy from the Edit menu. 

2 Sclcct thc clip onto which vou want topaste thc attributes. 

3 Choosc Paste Custom from the Edit mcnu. Thc Paste Custom Settings dialog box 

appears. 

4 Click Scttings to select options for pasting thc filtcrs, motion settings, fadc controls, 

or transparcncy scttings from thc clip on thc Clipboard to the clip sclccted in the ' 
Construction window. 

5 Click Paste. 
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SPLITTING CLIPS 

This scction describes how to use the Construction window to split a single movie or 

audio clip into two or more independent clips. It also describes how to split multiple clips 

and how to select Jnd move a block of clips. 

\Vhen you split a clip, you·arc actually crcating two copies of the clip, and thc Projcct 

window is updatcd to show two clips instead of one. Both clips still point to thc en tire 

so urce clip. If yo u split thc video or audio portian of a linkcd clip, both parts of thc clip 

are affcctcd. 

To split a clip ata precise framc, you can first split it atan approximatc Iocation and thcn 

use thc Trimming window to refine thc cut to thc cxact framc. Although yo u cannot rcjoin 

the ncw clips into one clip, yo u can resto re cithcr of thc split portions to thc original clip 

by using the Trimming window to adjust the cut point. For i1iformation on using thc 

Trimming window, sec "Trimming Clips in the Trimming \'\1indow" on page 83. 

Yo u can lock a track in the Construction winclow so that clips on thc trae k are not affcctcd 

by cditing on othcr tracks. For more information on track locking, scc "Locking Tr~cks in 

the Construction Winclow" on page 94. 

To split a clip into two clips: 

Select the razor too! in the Construction window, and click anywhcrc on thc clip. Thc clip 

splits into two scpúatc clips, and a new clip is addcd to thc Project window. Each clip 

reflccts its individual duration, with ncw scttings for the in point or out point. 

:_ Razor tool 

To split thc clips on allunlockcd tracks, hold clown thc Alt kcy and click thc razor tool. 

For more prccision whcn splitting .1 clip, vou can changc thc time unit in the Construction 

window lo dispLn· mon: framcs, or you c;111 LISL' thc zoom too! to zoom in on thc arca. 

Note: /)ou/Jic-cli<k thc m::or too/ (or ¡m·ss Sluii+li) to use thc tooljén nwrc t!wn onc 

OfJCI'I/110/T. 
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To copy a block of clips using the block select tool: 

1 Select the block select too! in the Construction window, and drag to crea te an area of 

equal width across all tracks. 

2 Move the block select too! anywhere inside the selected area and press the Alt key. The 

pointer turns into the hand too!. 

Note: If yo u do not use tlze Alt key witlz tlze block sclcct too/, the too/ fzmctions as a virtual clip 
selector. For more i11[ormatio11 011 virtual clips, scc "Working witlz Virtual Clips" 011 page 1 O l. 

Scfcctcd block o( ciips 
~ 

· 3 Drag to copy thc selcctcd block of clips toa val id area in thc Construction \\'indow. A 

val id arca is an empty arca of equal or grcatcr width than the selected block of clips. When 

you locate a val id arca, all tracks in thc Construction window are highlighted. 
.· •. 

4 H.clcasc thc motL~c button and thc 1\lt kc)' to place thc block of clips in thc ncy; location: 

Thc l'rojcct window is updaiL·d to show ;my ncw clips that wcrc crcatcd. 

Note: l(rou incl~ttlc liukcd dtf'-' iu )'O /Ir copicd sclcctiou, tiic IIC\V .<el o(clips will11ot rcÍoiu thc 
origi11al/iuks. 

~ 

V ·~ 
/ . 
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•. ~ 
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PERFORMING INSERT ANO OVERLAY EDITS 

There are three types of insert edits that yo u can perform in the Construction window. Yo u 

can draga clip between existing clips in the Construction window. Yo u can split clips ata 

, point in the time ruler and insert or overlay a clip. As a third option, yo u can inserta clip 

by setting the work area toa specific location and size and then replacing thc framcs under 

the work area with the samc number of frames from the new clip. 

Whcn inserting clips, you can lock clips and transitions on other tracks to prevent them 

from shifting. Locking tracks is useful, for examplc, if yo u want to inscrt a video clip in 

your movic without altcring an audio track. For information on locking tracks, scc 

"Locking Tracks in the Construction Window" on page 94. 

lnserting a clip between two clips 

Yo u can draga clip betwccn existing clips in the Construction window. Vlhcn yo u inscrt a 

clip between two clips, the clips and transitions on all unlocked tracks shift right (ripplc) 

to make room for the new clip. 

To inserta clip between two clips in the Construction window: 

Draga clip from thc Project, Clip, or Construction window to the joint bctwccn two clips. 

(From thc Projcct window, you can sclect multiplc clips to insert.) Thejoint appcars high­

lighted whcn the clip is positioncd corrcctly. Whcn vou rclcasc thc m o use button, thc clip 

is inscrtcd, and all clips and transitions onunlockcd tracks shift to thc right tnmakc room 

for thc ncw clip. 

Hc{orc 11/Scrt 

;\/in 11/:.crt 
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lnserting or overlaying clips using the edit fine 
Yo u can inscrt a clip onto !rack A by splitting clips a·t the edit point in the timeline. Yo u 

can inscrt a clip in onc of lwo W<lys: by shifting thc contcnts of allunlockcd tracks to thc 

right of the split to makc room for the new clip, or by overlaying the new clip on the 

existing material to the right of the edit point and by the fulllcngth of the clip between the 

in and out points. When yo u overlay a clip, depending on the material to the right of th~ 

edit point, you may replace framcs from more than one clip;. Whcrever thc ncw clip ends, 

a new cut point appears. 

To insert or overlay a clip using the edit !in e: 

1 Click in the dark gray area above the timé ruler to move thc edit !in e to thc point in thc 

Construclion window where yo u want to insert or overlay a clip. 

¡ P!ayback head 
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Thc Conlrollcr window appcars, and thc frame undcr thc edit line appcars in the Preview 

window. 

2 To movc lhc edil linc lo thc cxacl location for thc split, drag thc playb<tck hcad in thc 

Construction window, or use thc Controlkr winclow lo precise! y position lhc edil linc. For 

information on using lhc Controllcr winclow to position thc plavback hc<ld, scc "Using thc 

Controlkr·" on pagc 120. 

3 Sclcct thc clip you want to inscrt or ovcrlay from thc Projcct, Libran•, or Scquencc 

window, or opcn thc clip in a Clip window using onc of thc methods dcscribcd in 

"Opcning a Clip in a Clip \Vindow" on pagc 69. 
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4 To insert the clip on track A and shift the contents of other tracks, choose Copy to 

Construction > Insert at Edit Line from the Edit menu. Thc clips and transitions on all 

unlocked tracks split at the edit point and shift to the right to make room for thc insertcd 

flip. The insertcd clip and the new clips crcated by the split are also addcd to thc Projcct 

window. 

5 To ovcrlay thc clip on trae k A, rcplacing thc framcs to thc right of thc split, 111~1kc thc'Ciip 

winclow active and choosc Copv to Construction > Overlay at Eclit Linc from thc Eclit 

mcnu. Only thn:lip on track A is split at the cclit point, and thc inscrtcd clip rcplaccs 

framcs to thc right of thc split. Thc inscrtcd clip and thc ncw clips crcatcd by thc split are 

also addcd to the Projcct window. 

lnSertcd cl1p 

lnserting clips to fill the work area 

You can inscrt a clip b:· sctting thc wurk arca bar toa spccific location and sizc and thcn 

rcplacing thc framcs undcr thc work arca bar with thc samc numbcr of framcs from thc 

ncw clip. Thc clips on tr.1ck :\are split ,ll thc bcginning and cnd of thc work <lrca, and thc 

ncw clip lills thc spacc hctwccn. 



To insert a clip over frames in the work area: 

1 Position the work are a bar over the location where yo u want to insert the clip. For 

information on positioning the work area bar, see "Compiling Effects and Transitions" 

on page 121. 

2 Select the clip yo u want to insert from thc Project, Library, or Sequen ce window, or open 

the clip in a Clip window using one of the methods described in "Opening a Clip in a Clip 

Window" on page 69. 

3 Choose Copy to Construction > Replace Work Area from the Edit m en u. The inserted 
clip replaces all frames under the work area bar. The inserted clip and the new clips created 

by the split are also added to thc Project window. 

LOCKING TRACKS IN THE CONSTRUCTION WINDOW 

During so me editing procedurcs, you can lock tracks in the Construction window to 

prevent clip movement on other tracks from affecting the clips or transitions on the locked 

track. Track locking is particular! y useful, for example, if yo u want to inserta video clip in 

vour movie without affecting clips on an audio trae k. Convcrselv, vou mav want to editan 
1 ¡ 1 1 

audio clip without affecting clips on a video track. This type of editing is often referred to 

as "L" editing. 

A locked trae k is marked by orange and yellow bars across the !abe!. 

To lock or unlock a track, use one o.f the following methods: .· 
' " • 1-!old clown thc Alt kcy and click thc track labcllocated to thc right of the track. 

'_ "i;-
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• Choose Lock/Unlock Tracks from the Project menu, and click the track name in the 

Track Locking dialog box (locked tracks are indicated by a padlock icon). 

. · 1 · · .o Tradc Loclcing "' '. · 

Click on tracks lo lock/unlock lhem: 

• V1deo A 
T rans1tionsl 
Video B 
Supe1imposc 51 m:: 
Audm A 
Audio B 

CancCI Aud1o Xl 

Shottcut alt·chck 011 a trad, label1ro the Comtruct•on 
w1ndow to locf.lunlock that trad. 

Track label 

1 

1 

SETTING THE FORWARD OR BACKWARD SPEED OF CLIPS 

Yo u changc a clip's specd b;· applving a rate factor or sctting a new duration for the clip in 

the Clip Spccd dialog box. Thc dcfault clip spccd is 100 pcrcent for both movie and audio 

clips. You can sct a specd from bctwccn-10,000 pcrccnt and 10,000 pcrccnt. A negative 

pcrccntagc causes thc· clip to plav backw,¡rds. Whcn you changc a clip's spccd, thc Projcct 

and lnfo windows rcflcct thc ncw sctting. 

Changing thc clip spccd cffcctivcll' reduces or multiplics the numbcr of frames in thc orig­

inal clip; this affccts thc qualit1· of motion in movic clips and thc quality of sound in audio 

clips, as wcll as thc clip's duration. For cxamplc, sctting a movic clip's spccd to 50 percent 

(or doubling its duration) e reates a slow-motion cffcct by doubling thc numbcr of framcs 

and cxt<:nding thc clip's onginal duration; sctting its spccd to 200 pcrccnt (or halving its 

duration) doubks thc spccd of thc clip, crcating a high-spccd cffcct and halving thc clip's 

original duration. 

Ne>te: I(younrc 1\'0rking with 60ficld.<-pcr-sccollli (fj>s) clips, nnd you slow clow11 tlzc clip 

spccd, nurkc .<urc rlu11 ])cintcrlacc \VIren Spccd is l!c/o"' /00% issclcctcd intl1c Ficld Optiorrs 

diulog /JO.'C. Sinlilurl)·. i(Foli u re \\'orknl.~ ,,,11/r 60-Jj>s clips, onrl you ore rc\'Crsing tire cli¡. 



direction, make su re tha( Re verse Field Dominance is selected in the Field Options dinlog box. 
Sctting tlzcsc field options eliminares possible jerky motion. For more information on working 

----w,-.,itF1jiefds, see "Fuli::Fielli Proccssing of Clips" on page 208. 

To set the speed for a movie or audio clip: 

1 Select the movie or audio clip from the Project window or the Construction window. 

2 Choose Speed from the Clip menu. 

3 En ter a ratc value from -10,000 percent to 10,000 percent, or entera new duration in 

the SMPTE timecode forma t. 

4 Click OK. 

Thc movie or audio clip is set to thc ncw speed, and thc speed valuc appears next to the 

clip type in the Projcct window. If yo u sclcctcd multiplc clips, the Clip Spccd dialog box 

reappears for each clip. 

gl Pro]ect: Project,ppj J• 
211emt /Jame 

~ 
Fdanclul.avi [5[ 
MOYii;" 55:~ ------
Dura11on o 00 [19 03 
160 )( 1~0 

- Speed at 65% 

4 reel.<tvi [51 
Mov1~ 

Dura11on o oo o~ 0-1 
NormJI speed setting (100%) 
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CREATING FREEZE-FRAMES FROM VIDEO CLIPS 

You canfrcczc thc specific fr;Jmc in ;1 clip that you w;mt to hold for thc dur;1tim1 ofthc clip. 
Frcczing a framc crea tes thc samc ciTcct as a still imagc. You can frcczc the clip's in point, 
out point, or markcr O. 

Toe reate a frccze-frame: 

1 Sct thc in or out point on tlll' framc on whid1 vou want to frcczc. Altern;ltcly, place 
markcr O at thc fr;1111<:. For infonn.llion on sctting in and out points, scc "Trimming Clips" 
on pagc 76. For information on sctting place markcrs, scc"Setting Place ivlarkers in Clips" 
on pagc 74. 

2 Sclect thc clip in thc Construction window, and choosc Framc Hold from thc Clip, 
mcnu. Thc Framc I-!old dialog hox appc;1rs. 

3 Choosc In Point, Out Point, or I'vL1rkcr O from thc pop-up mcnu. 

..... 



4 If yo u are working with 60-fps video, select Deinterlacc to re m ove any jittering that 

freezing a frame could cause. For information on working with fields, sec "Full-Ficld 

Processing of Clips" on page 208. 

5 Click OK. 

BLENDING FRAMES 

\'\1hen thc frame rate of a movie is slowcr than the frame ratc at which a clip was capturcd, 

Adobe Prcmiere reduces the number of frames that it shows whcn the clip is playcd. For 

example, if a clip was captured at 30 fps but the movie is being playcd at 1 O fps, Adobe 

Premiere shows every third frame to achieve a 1 O fps rate, which causes the clip to be jcrky. 

Yo u can blcnd framcs so that thc clip plays more smoothly. Vv'hcn yo u blcnd framcs, Adobe 

Premiere interpolates the da.ta in the samplcd frames to smooth thc transition betwccn 

them rather than just "jumping" from one samplcd frame to the ncxt. 

E ven if thc so urce clip and thc movie ha ve the same framc ratc, yo u can e reate spccial 

effects by sctting an alterna te framc rate for the clip and blending framcs. For examplc, if 

your so urce clip was captured at 30 fps but yo u sct the clip's ratc to 1 O fps, Adob'e Prcm:~''l' 

shows evcry third framc to crea te a halting cffect (similar to using the l'ostcrizc TimL 

filterl. Ymf can then use the Frame Blcnding option to blur thc frnmcs. 

To blcnd frames: 

1 Sclcct thc clip in thc Construction window. 

2 Choosc Framc Hold from thc Clip mcnu. Thc Framc 1-lold dialog appcars . 

. 3 To set an alterna te framc rate l'nr thc clip, sclcct r\lternatc Ratc and type a frame rate in 

thc tcxt box. 1\dobc l'rcmicrc· displays ~lnC\1' framc at thc intcn·al you spccify, which cffcc­

tivclv lowcrs the framc ratc· of thc cli¡'. 

4 Sclcct thc Framc Blcnding option. 

5 Click OK. 

SEPARATING AND REJOINING LINKED CLIPS 

1\t times, \'Oll may \\\lnl to separa te thc linkcd ~lutlio ~lllll video portions uf a clip in thc 

Construction window so that thc audio canlcad the video, or vice versa. You can separa te 

lmkcd clips l"· brcaking thc llllk complctcl:· or by temporarily rclcasing thc link and rcpo­

sitioning ~~ portion of thc clip. 



There are two possible types of links between audio clips and videb clips in Adobe 

Premiere: hard links and soft links. When the linked audio and video clips origina te from 

the same movie file, they are lzard linked, and only one clip appears in the Project window. 

A hard link is established before the clip is importcd into an Adobe Premiere project.Aftcr 

a hard link is broken, two separa te clips are created. A hard link cannot be reestablished. 

A soft link is a link made in the Construction window. Yo u can crea te a soft link between 

any audio clip and any video clip in thc Construction window (provided that the clips are 

not airead y part of a hard link). Soft linking provides a way to rejo in clips that were once 

hard linkcd. A soft link behaves justlike a hard link, but the linked clips rema in as separa te 

entities in the Project window. 

To crea te a soft link bctween an audio clip anda video clip: 

1 Select an audio or video clip in the Construction window. 

2 Choose the soft link too! from the extended tools pop-up mcnu in the lowcr-left corner 

of the Construction window. 

3 Click thc clip that you want to link. If the clip is airead y part of a hard link, yo u cannot 

i¡]cludc it in a soft..Jink. lfthe clip is airead)· part of another soft link, tf1e new soft liÍlk will 

replace thc old soft link. 

To temporarily releasc a link for positioning: 

1 Selcct thc link override too! from thc extended tools pop-up menu in thc lowcr-left 

corncr of thc Construction window. 

2 Select thc video or audio portion uf thc linkcd clip and drag it to thc clcsircd location. 

Thc selcctcd portion willmovc indcpendcntly of thc linked portion. Thc link is rcestah­

lishcd whcn ~·o u rclcasc the kcys and thc mousc button. Small, red tri<lnglcs appcar on the 

lcft cdgc uf thc video <lnd audio portions of thc linkcd clip to indica te th<Jt thc video ancl 

.-t.:, 



audio are now out of sync. Click on either of the triangles to see by how many frames tlw 

video and audio are out of sync. To resynchronize the video and audio, drag to selcct thr 

displayed amount. 

Note: Links are also tcmporarily rclcascd wlzcn you cut tlzc l'idco or audio portian o( a linkcc, 
clip from t/¡c Constn1ction window. Tlzc link is reestablislzcd wlzen tlzc cut pon ion is pastcrl 
from tlze Clipboard back into the Constwctionwindow. For information on pnsting clips in 
tlzc Construction window, se e "Past ing Clips or Clip Att ributcs in thc Const ruct ion Wi ndow · 
on pngc 86. 

To break a hard ora soft link: 

1 Sclcct thc clip in thc Construction window. 

2 Choose Break Link from thc Edit menu. 

Thc audio and video portions bccomc separatc clips, allowing you to arrangc them indi­
vidually in thc Construction window. Anunnumbcrcd markcr is assigncd lo thc midpoint 
of thc ncwly indcpcndcnt audio ancl video dips. You can synchronizc audio and video 
clips by aligning the markcrs 111 thc Construction window. For more infmma'tion on 
aligning clips, scc "Sctting Pl,1cc Markcrs for Clip Alignmcnt" on pagc 72. 

MIXING AUDIO CLIPS 

You can havc up to 99 audio tracks playing simultancously in an Adobe Prcmicrc movic. 
Laycring thc ;¡udio clips on thcsc tracks is similar to sound mixing in ;nidio and tclcvision 
procluction. 

Thc thumbnails for audio clips show im;¡gcs of audio wavcforms. Each audio track has ;111 

Audio Fa de control that lcts \'O u acljust thc vol u me, or lcvcls, of thc clip. By dcfault, thc 
Audio Fadc control is initi,dh• sct tu mid-volumc, which is cquivalcnt lo O decibels on thc 
meter of a tape rccorclcr. 

Yo u can also acljust thc gain of thc en tire audio clip whilc lcaving intact any leve] adjust­
mcnts that havc becn maclc to thc clip. 



To adjust the levels of an audio clip: 

1 Position the pointer on the middle line in the Audio Fade control section at the bottom 

of an audio track in thc Construction window. The pointer changes to the finger pointer. 

2 Click to crea te a handlc (a black dot). You can crea te as many handlcs as necded. 

3 To delete a handlc, drag it out of the Audio Fade control arca. 

4 Drag thc handlcs up or clown to define whcn the audio clip facies in or out. 

¡,,,, 
Nounal.wav [11 

Fade Level '90~~ 
In 00 01:10 Out 00 0518 

Cursor ~\. O 00 O.l 20 

' -. 
A lim· "I'I'L'<lrs hctwccn thc· handk,, indicating whcthcr thc· ;1udio clip is fading in or out: 

;111 ;"ccnding linc sho\\'S audio rading 111; a dcsccnding lim· sho\\'S ,ludio rading out. Thc 

In lo windo\\' is upcbtcd as vou adiust thc t\udio Fack control. 

5 To adjust a scgmcnt bctwccn two handlcs uniformly, sclect the fadc adjustment too! in 

thc extended tools pop-up m en u in thc lowcr-right corncr of thc Construction window, 

ami drag thc sc·gmcnt up or clown. 



6 To make a cut in the Audio Fade control, select the fade scissors too! in the extendeu 

tools pop-up m en u in the lower-left corner of the Construction window, and click in thc 

Audio Fade control. Doing so creates two h,,_ndles next to each other. These handles are 

useful for making adjustments that sharply increase or decrease the vol u me for the clip 

ata point. 

To adjust the gainof an audio clip: 

1 Select the audio clip in lhc Construction window. 

2 Choose Gain from the Clip menu. 

3 Entera value from 1 percent to 200 percent. 

Previous adjustmcnts made to thc Audio Fade control do not change. 

Note: Yo u can in crease the gain ifyour original rccording was rccorded too sofí/y. Incrcnsing 
the gain of a wc/1-rccordcd audio clip, howcvcr, nwy muse distortion thnt is 11ot 11oticcaú/c 
through your C0111putcr's spcakcrs úut is ¡zoticcnúlc onthc playúack co111p11tcr or 011 videotape. 
For thc !Jest audio rcsults, yo u should adiust thc lcvcls of thc rccording úc(orc digiti::ing it. 

' 

WORKING WITH VIRTUAL CLIPS 

Adobe Prc.micre ;tllows yo u lo trcat a11v scgmcnt of lr<lcks along thc time rulcr asan indc- ~ 

pendent clip, callcd a ¡·irwal clip.¡\ virtual clip is a link to al! clips in a sclccted segment of 

the Construction window. With \'irtual clips you can do such things as mix the A and B 

video sourccs with a transition and thcn apply motion settings to thc mix, or use the mix 

as a so urce in :mothcr transition. 1\ny changcs \'oumakc to thc so urce clips of a virtual clip 

affcct thc virtual clip. 

Crcaling a \'irtual clip is similar lo crcating antndcpcndcnl block of clips. Once you crea te 

a virtual clip. il is lreatcd likc an ordinary clip. lt can be placcd on any video or audio track 

in thc Construction window, and it can be moved, copicd, and pastcd likc any othcr clip. 

You can alsn apply molinn scttings and filtcrs toa virtual clip. 

A virtual clip can be used as,¡ sourcc clip in another virtual clip. Adobe Premicre allows 

an original clip to be uscd in up to J61cvcls o( virtual clips. Thc dcfault dcpth sctting is 

cighl kvds. l'wcessing virtu,¡] clips wilh many lcvcls requircs a grcat dcal of processing 

time .1nd mcmon·. lf vnu are running out of mcmorv whcn you compile virtual clips 

(\·ou'll scc orangc and black hars in thc l'rcvicw window or Clip window), yo u should limit 

thc mc1ximum dcpth of virtu,1l clips. You can ch<lllgc lhc maximum dcpth hy choositw 

l'rcfcrcnccs >Virtual Clips from thc File mcnu and sclccting a ncw clcpth. 



Adobe Premie re uses a featu.re called safe layers that affects the way the track se.lector works 

when virtual clips are included on a track. To preserve virtual clips as they werc originally 

created, the track selector includes all tracks that contain source clips for the virtual clips 

on the selected track. When the selected track is moved in the Construction window, all 

other tracks associated with the virtual clips are moved accordingly. In this way, the virtual 

clips are preserved. Safe layers is the default mode for working with tracks. The option can 

be turned off by deselecting the Maintain Virtual Clip So urce Areas option in the General 

Preferences dialog box. 

For illustrated examples of how to use virtual clips, sec "Using Virtual Clips to Ncst Tran­

sitions" on page 264 and "Creating a 360-Dcgree Prcscntation" on page 266. 

Creating virtual clips 

For creating virtual clips, it is recommcnded that you designa te an area of your Construc­

tion window that is outsidc the time ruler of your actual movic, prcferably befo re the 

bcginning of the mov_ie. This will minimizc confusion o ver safe laycrs and ensurc that yo u 

don't inadvcrtcntly makc changes to thc so urce clips of your virtual clips as yo u edit 

your mov1e. 
.,. 

To crea te a virtual clip: 

1 Select thc block selcct tool by ciicking its icon in thc Construction window or by 

pressing B on the keyboard. 

o 

2 Drag to crea te a-block that encompasscs ·all tracks across the desireti"scgmcnt of ~­

the time rulcr. 

3 Movc thc block sclcct tool any\\"hcrc inside thc block. The pointcr turns into thc virtual 

clip pointer. 

Virtual chp pomter 

/ ·. 

., 
., .. 
'¡¡ 

., ... 



4 Click inside the block and drag to the desired location in the Construction window. 

A valid location for the clip is indicatcd by a sol id black box the size of the clip. 

5 Place thc virtual clip ,lt thc desircd location by rclcasing thc mousc button. 

V¡rtua! clip 
00 02c00 00 05 25 

Note: ]'(m wn eren te a Firtual clip o(only thc video tracks or thc audio tracks /Jy lwldin'g down 

tl1c Alt anrl Shi.fi kcys whilc click111~ imidc cithcr thc video or thc audio portion o( thc block 
sclcction. 

To determine the origin of a virtual clip: 

Sclcct the virtual clip in thc Construction window and choose Find Clip from thc Clip 

mcnu, or doublc-click thc virtu,¡J clip in thc Construction window. 1\ block arca showing 

thc boundarics of thc origin,1l sclcction appcars in thc Construction window. 

Viewing virtual clips 

You can 1·icw a l'irtual clip in thc Construction window by namc or by icon. Thc name 

vicw includcs thc starting and cnding points of thc virtual clip's origin in thc Construction 

window. In icon 1·icw, thc thumbnails show a compilcd vcrsion of thc clip. Thcsc may takc 

considerable time to genera te, cspccially if thcrc are virtual clips within virtual clips. For 

fas ter rcdispla;·ing of thc Construction window, thc clcfault vicw of virtual clips is sct to 

vicwing bv namc. 
·' . 

To display virtual clip thumbnails in thc Construction window: 

1 Clwosc l'rckrcnccs > Virtu;ll Clips from thc· File mcnu. Thc Virtual Clip l'rcfcrcnccs 

ckdog box appc;1rs. 

2 l.ksclcct thc option for l'iCI,·ing l'irtual clips b;· namc only. 
1 - r· . . 



Applying filters to virtual clips 

It can take considerable time for Adobe Premiere to preview, compile, or even generate 

icons for virtual clips if they include the use of many filtered clips. 

To set options for applying filters to virtual clips: 

1 Choose Preferences >Virtual Clips from the File m en u. The Virtual Clip Preferences 

dialog box appears. 

2 Choosc onc of thc following options for controlling how video filtcrs are applicd to 

virtual clips: 

• Never lea ves out <111)' of the so urce clip's filters when compiling virtual clips. 

• Always includes all filters when compiling both the thumbnails and thc final movie. 

• Largcr than Icons applies filters only when the final movie is compiled. This option 
improvcs performance whcn thumbnails are being generatcd in the Construction 
window. 

CREATING BACKGROUND COLOR MATTES 

Adobe Pn:micrc lcts yo u crea te a full-framc matte of sol id color that vou can use as yo u 
would a clip. This feature is useful, for examplc, if yo u want to superimposc titlcs ovcr a 
solid-colored background. It is also uscful whcn vou want to fadc to black in your movie. 

To add a backgróund matte: 

1 Choosc Add Color )Vlattc from thc Projcct mcnu. Thc color picker appcars. '" 

2 Sclect a color for thc matte using thc color picker, and click OK. The Color ivlatte dialog 
box appcars. For information on using thc color picker, sec "Using thc Pn:micrc Color 
Pickcr" on pagc 141. 

3 En ter a na me ami duration for thc ncw mattc, ami click OK. Thc m<lttc <rppcars as a 
Background M<lttc clip in the l'mjcct windmv, listcd alphahctie<rlly undcr its assignecl 
na1nc. 

4 Dr<rg thc mattc Crom thc Projcct windoll" toa video track in thc Construction window. 
Yo u canlcngthcn thc mattc's playing time by dragging cithcr edge of the mattc. IC yo u want 
lo reuse the mattc latcr, use thc Libran· fcaturc to storc thc matte. 

EDITING CLIPS IN OTHER APPLICATIONS 

This scction discusscs holl" lo cxpurt clips and cdit thcm in othcr gr<rphics applic<ltions . 

.For examplc, ;·ou can cxport a cli¡' to :\dobc Plwtoshop, modify thc clip, <rnd thcn rcopen 
thc file in Adobe J>rcmicrc. 

.. 
', 

.. 

1 
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Exportíng clíps for edítíng in other applícatíons 

You can exporta frame of a clip as a bitmapped file and modify the file in an imagc-cditin¡; 

application, such as Adobe Photoshop. Yo u can exportan audio clip as a wavcform file and 

modify it in a sound-cditing application, such <lS Turtlc Bcach's \·V,JVc Tools'-" for Window.> 

or Microsoft Windows W<lVcEdit. 

You can use the Make Movic command to compile a movie clip as a Filmstrip formar fik 

oras a sequen ce of numbered bitmapped, TIFF, or Targa files for cditing in Adobe Photo­

shop. In this manner, you can crea te filmstrips or numbcrcd sequenccs from al! or part of 

the Construction window. Yo u can also compile a movie clip asan FLC/FLI format file for 

editing in an animation program, such as Autodesk·· Animator Pro. For more information 

on using the tv1akc Movic command, scc "Compiling a Movic" on pagc 203. 

To exporta frame as a bitmappcd file: 

1 From thc Clip window, sclect thc single framc·you want to savc as a bitmappcd imagc. 

2 Choosc Expon> Fr,1111c as Bitm<lJ' from thc l'ik lllCilll. Thc Export Framc dialog box 

appcars. 

3 Typc a na me for thc file and click OK. 

To cxpo~t a clip asan animation file: 

1 From thc Clip window. sclcct only thc framcs you want to includc in thc animatinn file 

by sctting thc in and out points in thc clip. 

2 Choosc Export > FLC/FLI from thc File mcnu. Thc FLC/FLI File Export dialog box 

appcars. 

3 Choosc <l framc ratc bctwccn 1 fps and 30 fps from thc Ratc drop-down list at thc 

bottom oC thl· dialog box. 

4 Spccify thc imagc dimcnsions for thc animation file. To kecp thc clip's aspcct ratio, sclcct 

thc 1\.ccp ,\spcct option. 

5 T~·pc a na me for thc file, allll click 01\.. 

l_ () 
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Exporting clips for editing in other applications 

You can exporta frame of a clip as a bitmapped file and modify the file in an image-editing 

application, such as Adobe Photoshop. Yo u can exportan audio clip as a waveform file ami 

modify it in a sound-editing application, such as Turtle Beach's Wave Tools'" for Windows 

or Microsoft \"/indows WaveEdit. 

You can use the Make Movie command to compile a movie clip as a Filmstrip formal file 

oras a sequen ce of numbered bitmapped, TIFF, or Targa files for editing in Adobe Photo­

shop. In this manner, you can crea te filmstrips or numbered sequences from al! or part of 

the Construction window. Yo u can also compile a movie clip asan FLC/FLI format file for 

editing in an animation program, such as Autodcsk· Animator Pro. For more information 

on using thc Make Movie command, see "Compiling a Movie" on pagc 203. 

To exporta frame as a bitmapped file: . 

1 From thc Clip window, sclect the single frame you want to save as a bitmappcd image. 

2 Choosc Export ::o: Frame as Bitmap from the File mcnu. The Export f-ramc dialog box 

appears. 

3 Typc a na me for thc file ~llld click OK. 

To exporta clip asan animation file: 

1 From thc Clip windo\1·, sclcct onlv thc framcs )'OU want to incluck in thc <lnimation file 

bv setting thc in ancl out points in thc clip. 

2 Choosc Export > FLC/FLI from thc File mcnu. Thc FLC/FLI File Export dialog box 

~lppc~HS. 

3 Choosc a f¡·amc ¡·,ltc hctwccn 1 fps and 30 fps from thc Rate drop-down list at thc 

bottom of thc clialng hox. 

4 Specif)" thc image dimcnsions for thc animation file. To kccp thc clip's aspect ratio, sclcct 

thc Kccp Aspcct option. 

5 Typc <1 ll~llllC for thc lile, <llld dick ()Jo.:. 



To export an audio clip to a waveform file: 

1 Open the audio clip you want to export to a waveform file. 

2 Choose Export > Waveform File from the File menu. The Export Waveform File dialog 

box appears. 

3 Choose the desired options for audio rate and audio format, and click OK. 

Modifying filmstrips in Adobe Photoshop 

You can open a Filmstrip format file in Adobe Photoshop for editing. Thc lilmstrip 

is a single file that contains al! of the frames of the original movie clip. lf your original 

clip was recordcd with its timecode anda red namc, this information will be preserved in 

the filmstrip. 

After saving the cdited filmstrip in Adobe Photoshop, yo u can use the filmstrip as a clip in 

any Adobe Premicre project. You can also use Adobe Premiere to crea te a Video for 

Windows or QuickTimc movic of thc cdited filmstrip. 

To modify a filmstrip in Adobe Photoshop: 

1 Opcn Adobe Photoshop, and choose Open from the File mcnu. 

The filmstrip opcns as a series of fr<lmcs in a column, with cach framc labclcd b\· numbcr 

and timccodc. Thc number of frames displaycd dcpends on the duration of the clip and 

thc frame rate you ~clcctcd when you crcatcd the filmstrip. 



2 Make the desired modifications to the filmstrip. 

Clonmg out the hand 
from the 1mage 

When cditing a filmstrip in i\clobc Photoshop, use thc following guidclincs for bcst rcsults: 

• Channcls 1 through 4 (RC!l ami alpha) can he free! y cditcd. 

• Do not rcsizc or crop thc lilmstrip. 

• Drawino on thc nr,11·lincs di1·idim: thc framcs of thc lilmstrin clocs not <1fTcct thc filc's V b , ..__, r-

S[I"UC[UI"C. 

3 t\s desircd, cut, cop1, mm'l', allC! paste· sclcctions using thc Adobe Photoshop cditing 
fcaturcs. To align sclcctions from framc to framc, use thc arrow kcys and thc Shift, Alt, and 

Ctrl kcys in coniunction "·ith ,\clohc Photoslwp's normal kcystrokc opcrations as fóllows: 

• To cut a sclcction o1nd mtlvc it ttl thc so1mc· position within an adjaccnt framc, hold down 
thc Shift kc\' ami prc,s thc up ¡\rrow or Down i\ITO\\' kcys. 

• To copy <1 sclcctton anclmn1·c it to thc satnc position within an adjaccnt framc, hold 
down thc :\lt+Shift kc1·s allllptcss thc Up ¡\rrow or Down Arrow kc)'S. 

• To movc onh· a sclcction bordcr to thc samc position within an acljaccnt framc, holcl 
down thc Ctri+Ait kcy., and prcss thc up ,\rrow or Down Arrow kcys. 



4 View the filmstrip as a simulated movie clip and preview your modifications by holding 

down the Shift key and pressing the Page Up or Page Down keys to display the frames in 

sequence. For the best results, resize the window to slightly larger than a single filmstrip 

frame. 

5 Save your modifications using the Save or Save As command, saving the file in the Film­

strip file format. 

Note: Only imngcs tlwt were cxporterl from Adobe Prcmicrc in tlzc Filnzstrip file formnt can 
/Je snvcd or cxportcd in tlze Filmstrip file farnzntfi·om Adobe Plzotoslzop. 

6 lmport thc filmstrip into an Adobe !'t-emiere projccl using thc Import command 

from thc File mcnu, or open thc file in a Clip window using thc Opcn command 

from the File mcnu. 

To crea te a Video for Windows or QuickTime movie from a filmstrip: 

1 Import thc filmstrip into an Adobe Prcmicre projcct. 

2 Drag thc filmstrip clip toa portion of the Conslruction winclow. 

3 Compile thc filmstrip into a Video for Windows or QuickTime movic bv using thc Makc 

1vlovie command. For information on compiling movies, sec "Compiling a Mcwic" on 
70' pagc- .J. 

GENERATING AN EDIT DECISION L!ST 

Thi.> scction dc·scrihcs lww lo gc·tH:r.llc ;¡n Edtl lkcision List (J:lll.) fromthc Construclion 

window f(H· onlinc editing o l. sourcc vidcol;lpe in ;1 post-production studio. 

About online and off-fine editing 

Adobe l'rcmiere can he u sed for both onlinc ami oJHinc edlltng of digital video. Tradition­

ally, onlinc cditing h;JS mcanl working with original (source) vidcolapcs lo produce a 

maslct· tape for broadc;Jst or distribution. This rcquin:s thc use of high-cncl video cquip­

ment that is usu;1llv found onh· in hi~h-cusl editin¡; suites. \Vith cli~ital video, online . ' .._ ..._ .... 

cditing is esscntially cditing for finallinished out pul. If yo u are using Adobe Prcrnicrc to 

crea le a Video for \\'tndows or QuickTime mcwic orlo oulput a movic lo videotape. thcn 

you are performing onlinc ecliting. 

Off-fine cditing has traditionallv meant working with copies oforiginal tapes and low-cosl 

.:quipment to mak.: cditing decisions. The editing decisions are rccorded in an EDL. The 

EDL contains a list uf al! of thc clips. tr~1nsitions. ami special cffccts in thc movic. It is usecl 

to asscmblc a new tn(l\"ie (master) from thc sourcc tapes in an online cditing suite. Off­

fine cdtting ailows mulo use cxpcnsive onlinc cditing time more cfficicntlv. 



With Adobe Premiere, yo u have the ability to crea te machine-readable EDLs from your 

digitized source video. Unlike many off-line systems, Adobe Premiere shows you what a 

transition effect willlook like. Also, yo u don't have to watch the off-linc cdit from bcgin­

ning to end. Adobe Premiere allows yo u to preview any part you need to scc. 

Exporting an EDL 

Yo u can export EDLs from Adobe Premiere to many diffcrent formats, including thc CMX 

3400, CMX 3600, Grass Vallcy, Sony 13VE, and any additional third-party plug-in 

modules. '"'hen yo u crea te an EDL in Adobe Premiere, the visual editing dccisions you 

make in the Construction window are recorded in the EDL in text formal. Once yo u have 

exported the editing decisions to any of the EDL formats, yo u can view and print the EDL 

by opening it in Adobe Premiere or in any word processor that supports a monospaccd 

font (such as Courier), or output the EDL toa format that can be rcad directly by the 

editing systcm. 

Note: I(you planto exporr your EDL to rhe CMX or Cmss Vnlleyj(mnnt, thc(ílc IT/1/St he 
written to n11 nppropriatcly jónnnrted floppy disk. Praducts suc/1 ns EDL ;\ccess'" (includcd 
witlz Adobe Prenzicrc) eren te CMX-crnnpnti/Jic nnd Crrzss \1nllcy-compnti/Jic ji/e Jormnt .. 
diskettes on tlzc PC. 

If yo u intc1;d toe reate videotapcs from an EDL, it is importan! to ,,;~rk closcly with a post­

production housc to achicvc the bcst possible results. In general, Adobe Prcmieré providcs 

many spccial cffccts that are unavailablc on traditional cditing systems. Your post-produc­

tion editor can suggcst altermtc dfccts to use bcforc assembling thc fin,d n)ovie. 

Note: To m•oid confusionll'hcnl\'orking with EDLs, yo u should use 11 time hwc of29.97 Jps in 

thc Constmction 11nd Clip windows. l(you set 11 time htise o(30 Jps, Adohe Prcmicrc COII!lts 
video fmnte5 in tme 1/30tlt5 o(n .<eccmd. 13cmuse n/1 NTSC video is 29.97jjJs, thc tilnccodc 
displnyed in thc Clip windo11' 11111)' IIOI!IIiltch cxactly u·itlt tite visualtimccodc th11t is supcr­
imposcd 011 thc ¡·ideo iuwgc (tire ll'indoll' du/1). Wltcn 1111 EDL is gcncmted, lwwcvcr, Adobe 
Prc11ricrc nlllkC.< tire ncccssttry adjusti11CIII.' so tllllt tire timccodc lmmed into tire so urce 
1·itfco 111/IICf!e,: tire liiiiCCOdC 111 tire J::J)J.. 

To cxport a project toan EDL: 

1 i'dakc su re that all thc clips in :·our Construction winclow ha ve bccn assigncd a timccodc 

(cithcr assigncd ;\l thc time thn· werc captured or cntcrcd b)' using thc Timccode 

command in thc Clip mcnu).lf\·ou do not sct thc timccoclc for a clip,1\dohe Prcmicrc 

assumcs a starting time of 00:00:00:00. For more information on sctting thc timccodc, sce 
'· ' 

"Sctting thc Timccodc for C:ltps" on pagc 1 16. 

/ 
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2 Choose Export from the File menu and the desired EDL format from the submenu .. 

The Save EDL dialog box appears. 

For most EDLs, you can en ter the following options for the recording reel: 

• Ti tic for This EDL. En ter the title you w:mt displaycd in thc header section of the EDL. 

• Start Time Code. En ter the time at which you want recording to start on the record recl. 

• Frame Rate. Determine the frame rate by the time base set in the Time Base Settings 

dialog box. The default frame rate is nondrop-frame timecode; select the Drop Frame 

option if yo u want drop-framc timecode. 

• Audio Processing. See "Audio in thc EDL" on pagc 114 for information on thc audio 

cxport options. 

• Leve! Notes. Choosc an option from thc drop-down list to include commcnts in your 

EDL pertaining to audio lcve!s and superimpositions. 

• Crea te B-roii!B-roll in Separa te File. Crea te a transition in an EDL onlv if thc clips are 

on diffcrcnt video source reels. Thc Construction window may contain edits across a 

single sourcc rcel. For examplc, thcre ma)'bc ;1 dissolve from a clip on Reel 1 to anothcr 

clip from Rccl l. Thesc B-roll options a!low yo u to general e a separa te list of su eh 

conflicting edits. This list, c;¡llcd a B-roll conform list, is used by thc post-production 

facilitv to make an adclitional sourcc rccl of c!ips used in transitions. 

3, Click Wipc.Codcs to bring up Adobe P.rcmierc's Wipc Codc Editor, ancl assign thc wipc 

pattcrns to thL' codcs uscd by your post-production lCJCi!ity. For more inform;ltion, sec 

"Transitions, Spccial E!Tccts, ami Supcrimposcd Clips in thc EDL" on pagc 112. 

4 Click OK to close the Savc EDL dialog box. 

s Typc a na me for thc EDL allCI click OK. Thc EDL is gcncratcd and appcars in a tcxt 

window. 
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Components of the EDL 

\-\1hilc slight diffcrenccs exist among diffcrent EDLs, most contain eight primary columns 
and two auxiliary columns. 

Header 

FCt1 tlOt!-OROP FRA11E 

001 003 r; e oo oo:oJ 12 oo oo os· 1-1 01 oo ::o 01 01 oo 22 03 
00\ 004 l) 11001 204 00 00 06 24 00 00 12.23 01 00 os 12 01 00 \4.1\ 
EFFECTS !IAtlE IS ':·lllriG ltl 

oo:: oo-1 v e 01· 16 :::: o3 01 15 29 o:: Ol:oo o6 2-1 01 oo·tJ ::s 
002 OCt\ V W003 :;o..¡ 01 18 27 15 01 18 34.09 01 00 05 24 01 00 !3. 18 
EFFECTS tlHilE !S SLHNG 111 

ooJ oo.- v e 01·1s 33 15 01 oo 25 1-t Ol:OO: n 1s OI:Oo.::o.J:::: 
oo3 001 u wooo 20-1 01 1e 2s o:: 01 1s 44.2e· OJ.oo·D 1s OJ·oo:::o 12 
EFFECTS !IRME 1 S SW ltiG 111 

oo" oo-1 L1 e 01.19 Ir) o:: 01 19 1'5 oJ 01 19 ::o 12 01:19 ::s ~:: 
004 00\ U IJ002 204 01 19:2::: 19 01 19'30 13 01 00 20 12 01 0Cr:27.05 
EFFECTS liArtE 12 Sll 1 IIG 111 

005 004 
oo:. 00 1 

u e 0\.::'!4 12 o:: 01 34 1(·.04 01 oo :::::os 01 oo.::c-·ot. 
u l./011 ~03 01'!:·0 15:9 01 ~-0 ::::: 01 00 ;:-;- 06 01 00•3J 29 

E~FECTS I!AliE I'E Züü~l 

00'5 003 u e o 1"5~. H:::. o 1 :.: 16"05 01.00 33 29 01 00.3:-.15 

007 001 u e 01:3'3 08 00 01 39 14 " 01 00 58 15 01"01 :05 09 ~:...-
... - _, '-~ 

Source 1 Trans1tion Source m Source out Record m Record out 
reel ID type 

Event Ed1t mode 
number 

• Hcadcr. At thc top of cvcry EDL is thc na me of thc list and thc timt:coclt: in which thc 
record was crcatcd (drop framc or nondrop framc). 

• Ewnt Number. Thc e1·ent numbcr is ;ln idcntify111g counter, bcginning ;ll l. An cvc111 

rcprcsents a single cdit. ThL' ei'Cill numbcr can be important in thc rc-cditing proccss, 
beca use it ca lis an individual n-en t. Cert;lin cvcnts m;¡ y use more than onc linc of thc EDL. 

unnumbcrccllmcs accomp;¡nying c1·ents are callcd note.< or COJIIIIJCIIIS. 

• Su urce l~t:ci!D. Thc sourcc rccll]) is thc na me or numbcr of thc vidcoupc containing 
thc clip. 

• Edit ivlock. The cdit nwck indica tes ,,-hethn thL· cdits takc place on thc video track only 
( \'), t he ;1 ud io t r;1ck on h· ( :\ 1, m,¡ combinat ion uf both thc video ami the ;ludio tracks ( B ). 

·¡-O: 1 __ .: 
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• Transition Type. The transition type describes the type of edit: C represents a cut, 

W represents a wipe, K represents a key (superimposed), and D represents a dissolve. 

• So urce In and So urce Out. The first two columns of the timecode. are the so urce in and 

so urce out points. They describe the timecode of the first frame and the last frame of the 

clip as it appears on the so urce videotape. 

• Record In and Record Out. The last two columns of the timecode represent the time at 

which the source clip is to be recorded on thc master tape. 

Transitions, special effects, and superimposed clips in the EDL 

A standard EDL recognizes only the cut, the dissolvc, ami some wipe transitions. Thc EDL 

modules available in Adobe Premiere attempt to translate the edits from your project to 

the standard EDL forma t. For example, the Adobe Premierc effect named Cross D1sso/ve is 
interpreted as a "dissolve" transition by thc standard EDL. Although many of the Adobe 

Premiere transitions cannot be adequately described in the EDL, the na me of the Adobe 

Premiere effect is listed in a comment line in thc EDL. 

Adobe Prcmicre's filters and motion settings are complctely ignored in a standard EDL. 

Superimposed clips are clescribed as kcys. The only transition permitted under a key is a 

Cut; othcr transitions under kcys are removed from thc EDL. 

Many Adobe Prcmicre transitions corresponcl dosel;• to wipe patterns that can be 

procluccd by a video switchcr. Transitions that do not correspond to wipe patterns are 

. intcrpt\:ted <IS dissoÍvcs. Thc following list dcsci·ihcs how Adobe Prcmicrc Úansitions are 

intcrprctcd hy a standard EDL: 

• The following transitions are interprcted as EDL Dissolvcs: Additivc Dissolvc, Channel 

l'vlap, Cross Dissolvc, Cross Strctch, Cross Zoom, Curta in, Displace, Dithcr Dissolvc, Fold 

Up, Funnel, Image Mask, Luminancc lvbp, Non-Additivc Dissolvc, Paint Splattcr, 

Random 13locks, Random Invcrt, Slash Slick, Tcxturizc, and Threc-D. 

• Thc following transitions are intcrprcted as EDL !larnDoor Wipcs: l3and Slidc, Band 

'Ni pe, Barn Doors, Dllors. Sliding B.mds, Spin,\1\'<n·, and Split. 

• Thc following transitions are intnprctccl as EDL l\ox Wipcs: Iris Cross, Iris Diamond, 

Iris Point, Iris Shapcs, Iris Squarc, Iris Star. i'vlulti-spin, Spiral Boxcs, Swirl, Tumblc Away, 

Zoom, Zoom Boxcs. and Zoom Trails. 

• Thc follllwing tr<lllsitions <lrL' intcrprctcd .1s J:Ul. Ctrclc Wipcs: Clock \'V'ipc, Iris Round, 

and Pecl Back. 

• The following transitions are intcrprctccl as EDL Cross Split Wipcs: Ccntcr !vlcrge, 

Ccntcr Pccl, ancl Ccntcr Split. 

! /b 



• The following transitions are interpretcd as EDL Diagonal Wipes: Page Pccl, Page Turn 

and Radial Wipe. 

• The following transitions are intcrprctcd as EDL Diagonal Wipcs: Blocks, Chcckcr­

board, Wedge Wipe, and Zig-Zag. 

• The following transitions are intcrpretcd as EDL Wipcs: Cube Spin, Pinwhccl, Push, 

Random Wipe, Roll Away, Slide, Sliding boxes, Stretch, Swing In, Swing Out, and Wipc. 

• The following transitions are interpreted as EDL Horizontal Split Wipcs: Strctch Ovcr 

and Venetian Blind. 

• The Inset transition is intcrpreted asan Inset Wipe. 

• The Spin transition is intcrpretcd asan EDL Vertical Split Wipc. 

Video switcht'rs intcrpret wipc patterns as codes. You can map thc wipc pattcrns in thc 

EDL to the wipc pattcrn codcs used by your post-production facility using Adobe 

Prcmicrc's Wipc Codc Editor. Consult with your post-production Lrcilitv to1dctcrminc 

which wipc codcs are uscd hv thcir switchcrs. You can s;rvc EDL wipc codc scttings and 

load thcm whcn nccdcd. 

To assign wipe codcs: 

1 Choosc Export from thc File mcnu, and choose thc dcsircd ÉDL formal from thc 

submenu. 

2 Click Wipc Codcs. Thc EDL Wipc Codcs dialog box appcars. 

, ·" '·' . ·' · ·. · EDL:Wipe Codes · · · - . ;- . · 

! !.oad... j ! >_ave ... 1 Q.elaults J j OK JI Cancel 

'­' ' -/ ' ' 
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3 Click the wipe icons to see the wipe transitions animated. 

4 En ter the correct wip~ codes for the wipe transitioi1s that are used by your video 

switcher. 

s Loador savc EDL Wipe Code settings using the Loador Save button at the bottom 

of the dialog box. 

6 Click OK to apply the wipe codes to the EDL. 

Audio in the EDL 

Beca use Adobe Premicrc works with Video for Windows and QuickTimc movies, it 

controls sound in a way that differs significantly from traditional editing systems. Tradi­

tional tapc-bascd cditing systems are dcsigncd to record from (amito) one or more audio 

tracks on the videotape, or onto a separa te audio tape recorder. 

Adobe Premicrc provides up to 99 audio tracks in the Construction window for placcment 

of audio clips; howevcr, both Video for Windows and QuickTimc mix the audio tracks, 

creating a single track that can contain more than onc channel (such as lcft ancl right). In 

Adobe Premiere, mixing of audio tracks is controlled by the fa de controls that accompany 

each audio trae k. The standard EDL has no wa\· to mix sound, cxcept for thc mixing that. 

occurs whcn onc audio sourcc dissolvcs into anothcr audio sourcc. 

To takc advantagc of multiple audio tracks on videotape, yo u can define which audio 

tracks from Adobe Prcmiere are mapped to·the available tracks in thc editing wstem. 

To map audio tracks in the EDL: 

1 Choosc Audio Mapping from thc Proiect menu. The EDL Audio /vlapping dialog box 

;1ppcars. 

2 Assign audio !rack A, ;1udio !rack 11, ;Jilli thc rcsl o!' thc audio t1·;1cks lo thcir EDl. 

dcstinatio11. 

3 Click OK. 

Adobe l'rcminc provides thrcc output options i'or EDLs that affccl how audio cdits are 

addcd toan EDL. Consult vour post-product1on housc for a rccommcmL1tion on which 

option to use. 



Audio Fol/ows Video option 

The Audio Follows Video option causes the audio and video to be edited simulta11eously. 

according to the edits made on the video track: where the video cuts, the li11ked audio clip 
cuts; where the video fa des, the li11ked audio fa des; and so 011. With this option, the audio 
fade controls are ignored and any audio that is not linked toa video clip in the Construc­
tion window is dropped.· 

Audio Separa te/y option 

The Audio Separatcly option intcrlcaves the audio and video tracks as separa te edits 
within the EDL. For these options, the following rules gover11 the way that Adobe Premie re 
translates sound edits into a format that the EDL can i11terpret: 

• lf a clip on track A completcly overbps a clip 011 track B (it has thc s~¡mc or a11 carlicr in 
point and thc samc ora la ter out point), only thc clip on track A is considcrcd. 

Note: A(<utc point oJO 111 m1y clip c((cctivcly splits t/¡c clip at tlwt point sr1 tlwtthc clip is 
trcntcrl as t1:o clip,:/¡;- tl1c EDL. :J 

• If a clip on track :\anda clip on tr~Kk B ovcrlap, a transition is crc;ltnl_ in thc ovcrlappins .2 

arca so that _thc starting clip fadcs in to thc cnding clip. 

• Clips on S tracks are considcrcd only whcn ncithcr track A nor track B co.;:tai11s clips; ·~­

othcrwisc, thcy are ignorcd. 

Once this single "track" has bccn crcatcd, thc EDL intcrprcts fadc points in thc 

following way: 

• t\ f~1dc poi n t of O in a nv nont ra nsi t ion a rc<l crea tes a fa de bctwccn O a t t ha t poin l and 1 00 

at the ncxtncarcst point spccificd in thc clip, n:gardlcss of thc actual valuc that was spcc· 
ified for thc nonzcro pmnt. :\11 othn nonzcro fadc points arc ignorcd. 

• fadc points in any tran,ition arcas (that is, <liTas ofclips on tracks A ami B that ovcrlapl 
;m: ignorcd. 

Audio at End option 

Thc Audio at ·End option placcs allthc sound cdits togcthcr at thc cnd of thc EDL, 
following thc audio translation rules uscd with thc Audio Scparatcly option. 

1 ,• 
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SEITING THE TIMECODE FOR CLIPS 

Yo u can assign the timecode for the starting point of a clip when the clip is digitized, or by 
using the Timccode command in the Clip menu. If yo u do not set the timecode for a clip, 

Adobe Premiere assumes a starting time of 00:00:00:00. For instructions on assigning the 

timecodc while capturing video, see "Capturing Timecode" on pagc 245. For information 

on adjusting thc timecode to match a window dub, see "Calibrating Timccode" 

on pagc 245. 

To sct the timecode for a clip: 

1 Sclcct a clip in the Clip, Project, or Construction window. 

2 Choosc Timccodc from thc Clip mcnu. Thc Clip Timecodc dialog box appcars . 

. ':· Clip Tlmccodc: Fdam:2sLavl '''· ·.· '·'ii·'·· 
Timecode: ---------------, 

. ¡unawawaor 1 •~ oo·oo:oo:oo 

Fr<~me ndte: jJo lps j±l 
~====~ 

Fmmal: jNon-Drop Frame l!j 

S el timecode at: 

[~eel N ame 1 De.cuploon 

@ File beginning 

C; Cuuent hame 

OK 1 Cancel 

3 En ter thc following inform:ltion for sctting thc timccodc: 

• Timccodc. Entcr thc llL"\\' st:Jrlingtimc for thc chp in Sivii'TE l(mnat. Thc currcnl 

Sfvii'TE timccodc· :1cldrcss for thc starting time of thc clip is displaycd al thc top of thc 

d i:dog box. 

• Framc !{ate. Choosc thc fran1c r.ltc at wl11ch you wantthc clip cxportcd. (1-ramc rates 

of 24 fps or 25 fps do not support drop-framc timccodc.) 

• Formal. Choose drop-framc or nomlmp-framc timccodc. For more information on 

timccodc. sce"Sivll'TE Timccodc" on p:1ge 2i'4. . 
• Set Timecodc :\l. This option is :1\'ai\ahk onl;- whcn sctting thc timccodc from thc Clip 

,,·indow. Chousc File- lkginning l<l assign thc entncd timccodc addrc·ss to thc first framc 

in th<: source clip (the dcfault setting). C:hoosc· Currcnt Framc lo assign thc timccode 

addrcss lll thc currcntly displ:wcd fr:1mc in thc Clip window. 

•) 



• Re el Name/Description. En ter the reel na me of the so urce tape on which the clip is 

located. En ter a description of the clip, if desircd. Note that the number of characters yo u 

can en ter in this field may be limited by the selected export module. 

• Revert to Original. Clicking this option causes the clip to rever! to its original timecodc 

and name settings. If a clip is used more than once in a movie, this option affects all copies 

of the clip. 

4 Click OK. If yo u selected multiple clips, the dialog box rcappcars for ea eh clip. 

..¡ 
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CHAPTER 4: PREVIEWING A MoviE 

[J his chapter describes how to preview a project and how to set preview options. 

Previewing is a quick way to play part of a movie oran en tire movie without hav­

ing to compile the en tire contents of the Construction window into a Video for 

\-Yindows or QuickTime movie, which can take a substantial amount of time. 

There are two types of previews: compiled and uncompiled. Compilcd previcws requirc 

processing time, but they give yo u an accurate previcw of transitions and cffccts. Uncom­

pilcd previews don't require proccssing time but thcy may not providc adcquatc detail or 

accuracy. Adobe Premiere lets yo u mix these previewing modes. You can compile sclectcd 

effects and transitions and previcw both the compiled and uncompilcd scctions using the 

Controller. 

lt's important to note that previews can be compilcd diffcrently than thc fi¡i;llmovie. Pi'c­

view processing is fas ter when thc framc rate is !cm· and the frame sizc is small. Hówever, 

many users choose to process previcws using the finalmovie settings for sizc and ,frame 

rate. This saves processing time whcn thc finalmovic is made beca use Adobe Prcmiere 

uses the previ_ewed segments, savcd as Preview files, when it compiles_the finalmovic. For 

more information on prcvicwing options, scc "Sctting Previcw Processing Options" on 

1¡­pagc _J. 

Previews normally play in thc Prcview window. You can also use thc Print to Video com­

mand to vicw prcvicws on an NTSC (National Tclcvision Standards Committcc), PAL 

(Phase Altcrnation Linc), or SEC:\,\·1 (Scquential Coulcur Avec l'vkmoirc) monitor or in 

thc ccnlér of :·our computcr sc1wn with the rcm;1indcr of thc scrccn blackcd out. 

Note: 7(¡ prt'l'Ú'll' 1111/0\'IC on11n NTSC. 1':\l., or SECt\JV! 11/0IIitor, your C0/1/fJ//tcr 11/liSt be 11/J!c 

to produce tl1c llf'['I'OfJriatc ¡•ideo signa/. 

.• 



USING THE CONTROLLER 

The Controller is u sed in conjunction with the Preview window to display the contents of 

the Construction window. The Controller controls the position of the playback head in the 

Construction window, which in turn determines the position of the edit line and the frame 

displayed in the Preview window. 

Frame Forward 
and Backward 

Play In/Out button 

Audto level ~ Playback head 

Constructio g:;:;;;;;=.:;:t;::t:;~~¡¡:;;.=::::;::;=;:;;~ toggle 

V 
.t· 

L Edit line 

Frame indicator 

Clip duration 

Prcvicwing with thc Controllcr does not display transitions or othcr cffccts unlcss thcy 

havc.bccn prcviously compiled using thc Prcvicw or Snapshot commands. 1-!owcvcr, the 

Controllcr functions as a quick prcvie\,·ing tool bccausc vou're not compiling as you pre­

vicw. The uncompilcd scgmcnts are displayed with an X in the center of thc framc for thc 

dmation of thc. cffcct or transition. For mcirc information on compiling cffccts and tran­

sitions, scc "Compiling Effccts and Transitions" on pagc 121. 

The Controllcr has the samc controls ~1s thc Clip window. You can use thc Controllcr to set 

markcrs in thc time ruler of thc Construction window that correspond to thc framc dis­

playcd in thc Prcvicw window. You can also go dircctly to Construction window markers 

or Sivli'TE fr .1 mes. Fur i nl(mna t ion on u si ng m a rkcrs. scc· "Sctt i ng Plan· ,\,1;1 rkcrs for Clip 

Alignn1c11t" on p;tgc 77... 

To prcvicw using the Controllcr: 

1 Choosc Controllcr from thc \Vindows mcnu if thc Controllcr is not alrcack opcn. 

2 Choosc Prcvicw from thc \Vindows m en u if thc l'rcvicw window is not alrcady dis­

playcd. Thc Previcw window displays thc fr;1mc of thc mcl\'ic that corrcsponds to thc posi­

tion of thc playbaLk hcad in thc Construction \,·indow. 

3 Drag thc playhack hc;1d inthc Construction window to scrub through thc movie, or use 

thc Controllcr tu prc\·ic\\' spcciíic (ramcs: 

• Use thc Jog control to mov·_. thc playb.1ck heacl for\\'ard or backw~rcl. 



• Use the Frame Forward and Frame Backward buttons to preview the contents of the 

Construction window frame by frame. 

• Press the Play button to play a sequen ce of frames starting from the playback head. 

• Press the Play In/Out button to play the framcs under the yellow work arca bar. For 

information on adjusting thc work arca, sec "Compiling Effects and Transitions" 

on pagc 121. 

4 Use thc Mar k button to sct markers in the time ruler of the Construction window. Use 

the Gato button to go toa markcr in the Construction window. 

Note: Thc Play lmtton in tl1c uppcr right comer o( thc Collstmctioll wi11dow has thc son1c 

ji111ction os tlic Play !Juttoll in tl1c Colltrollcr. 

Changing the Preview window display 

Thc Controlmenu in the uppcr-lcft corner of thc Prcview window lcts yo u rcsizc thc Prc­

vicw window: changc its rcsolulion, and changc lhc Prcvicw window options.lo rcsizc lhc 

Prcvicw winclow to manv popular sizcs, Shifl+click any porlion of lhc window. 
' 

To kccp thc Prcvicw window on lop of othcr windows whilc prcvicwing or whilc scrubbing 

._, 
' 

.. } . 

through thc Construclion ,,·indow, choosc Üplions from the Prcvicw window Control ~' -. 
m en u, and in thc Prcvicw Window Scttings dialog box, sclcct thc ln front vVhcn Previcw- " 

ing and thc ln Front Whcn Scrubbing options. 

COMPlLING EFFECTS ANO TRANSITIONS 

\\'hcn buildi1_1g a movic in lhc· Conslruclion window, you should compile cfTccls and lran­

sitions so lhal lhcy can he oJccuralcly prcvicwcd. r\ compilcd movic scgmcnt is onc thal has 

bccn proccsscd and savcd lo disk. You designa le which cftccls anc! lromsilions you wanl 

compilcd by adjusling llw work arco¡ bar in lhc Construction window. r\clobc l'rcmicrc 

11orm.dh- savcs com~'ilcd cl"t"cct.s omd 1r.msi1io11s as tcmporoH>' movic· files. Thcsc files are 

uscd in subscqucnl prcvicwing a11d, dcpc11ding 011 vour scttings, can he uscd in thc com­

pilaliol1 of thc linalmo1·ic. Thc Conslruction window displays a lhin grav bar abuvc thc 

limL·lil1c lo inclicalc which l'ffccb and lransitions have bccn cumpilcd. For more informa­

l ion on prcvicwing modcs, scc "Sclccling a l'rcvicwing Modc" 011 pagc 128. 

To compile a prcvicw of thc work arca: 

1 Use o11c of lhc follo11·ing lcchniqucs to adjusl lhc ycllow work arca bar so thal il cxlcnds 

across thc cffccls omcl lransilions vou wanl lo compile: 

• Drag thc red trianglc al cithcr cnd of lhc work arca bar. You can also Ctrl+click abovc 

thc time rulcr to sct thc c11d poinl of thc work arca bar. 
/-----:. ' 



• Choose the in point and out point tools in the Construction window and click above the 
' time ruler. 

• Click the In and Out buttons in the Project controller to adjust the work area bar 

according to the position of the playback head. 

• Double-click the work area bar to extend it to the width of the Construction window. 

• Alt+c!ick thc work area bar to set the work arca for a continuous region in thc Construc­

tion window. A continuous region is uscful for finding gaps in the movic construc¡ion. If 

no gaps exist, thc work area will extend across the en tire movic. 

Red triangles 

1 

nragg111g th!' rccl tn11ngfc to ll'zdt'/1 thc work nrcn har 

2 To sct'options for thc proccssing size, prcvicwing modc, and othcr prcvic,~·ing parame­

tcrs, choosc l'rcvicw Options from thc ivLtkc nKnu. Thcsc options are initially sct whcn 

you choosc a prcset for a proicct. In most c;1scs you won't necd to changc them. Thc Pre­

vicw cornmand compiks a prcview bascd on thc scttings in thc Previcw Options dialog 

box. For more information on previcw options, scc "Sctting Pre,·iew Proccssing Options" 

on pagc 125. 

3 Choosc from severa! options to compile and vicw a prc\·icw of the work arc<l: 

• Chonsc Prcvicw from thc Proiect m en u. or prcss Rcturn. Thc work arca is compilcd and 

thc prcvicw plays autom<llicallv in thc l'rcvicw window. Ti.l intcrrupl thc prcvicw, 

prcss thc Ese kcy. 

• Choose Snapshot from thc !vlake mcnu. Thc work arca is compilcd, ami thc Controllcr 

comes forward for vicwing thc previc\\·. \Vith this mcthod, thc previcw docs not pla:· auto­

matically, but thc Controllcr gives ,·ou more control ovcr vicwing than thc l'rcvicw 

command. 

·< 



Previewing by dragging through the time ruler 

Yo u can preview any area of your movie by dragging the pointer through the time ruler. 

This is different than scrubbing with the playback head beca use effects and transitions are 

processed as yo u drag. This type of previewing provides a quick way of checking supcrim­

positions, motion settings, filters, or specific transitions from one clip to another. How­

ever, yo u aren't likely to get a good sen se of your movie's pacing beca use vou control thc 

speed of dragging. 

Processing takes place in real time as you drag, but thc previews are not saved to disk as 

temporary files as they are when you use thc Snapshot or Preview commands. Thus, you 

don't change any effects or transitions that have been compiled and savcd to disk. 

Note: lly rlcfault, proccsslllgfor this typc o(prcvicw is lwscd on thc scttings in thc Prcvicw 
Option rlialog lw,-:. Yo u can spccrlup thc proccssing /Jy rcducing tlzc Prcvicw window sizc or /Jy 
rcducing tlzc Prc!'Ícw window rcsolution to 1/4 or I/2. Use the Prcvicw window Controlmcnu 
to clwngc thc ¡vindm,• sizc or rcsolution. 1( thc Prcvicw options rlij}'crji'Oin tlzc.final output 
options, proccssizzg ¡m'l'Íc1vs ll'i// /Jc jnstcr, lnzt conzpiling thc(izuzlnwvic wi/1 t11kdozzgcr. . , 

To preview a movie by dragging in thc time ruler: 

1 Position thc m o use pointer anywhcrc in thc time rulcr. Thc pointcr changcs into a 

down arro\v. " 

1 Down urrow 

. :i 1 . 1 .... · -

:''::··~.. ~.··-1 <.'. 
2 Dr.1g thc arrow .dong thc· time rukr. Thc clips undcr thc arrow play in thc l'rcvicw win­

do\\'. You can clrag tu thc Icft orto thc right to makc thc prcvicw play forward or backward. 

PREVIEWING WITH PRINT TO VIDEO 

You can use thc l'rint to Video cnmmancl to prcvicw thc contcnts of thc Clip window. 

Us1ng this commanc!Is similar lo using thc l'rcvic\\' command, cxccpl that thc prcvicw 

plays in an NTSC monitor or in thc ccntcr of thc scrccn instead of in thc Prcvicw window. 



To play a movie directly from the Clip window: 

1 Select the part of the Construction window yo u want to play by adjusting the yellow 

work area bar above the time ruler, and compile the work area. 

2 Open the compiled movie in the Clip window. 

3 Choose Export/Print to Video from the File menu. The Print to Video dialog box 

appears. 

4 Select Print to Video options. (For a description of these options, sce "Using Print to 

Video" on page 219.) Do not select the Activatc Recording Deck option unless you want 

to record thc preview onto a controllablc recording device as it plays on the screcn. 

s Click OK. 

The prcvicw plays in the center of the scrcen against a black background. To intcrrupt the 

playing of thc prcvicw, press the Ese key. 

Note: ForlJcst pcr(onnnncc td1e11 plt1ying 11 prcvicll' dircctlyfrolll tiic Clip tt'HIIIOtt', yo11 siiould 

prcvictv in Effccts to Disk mor/c. For n10rc inforni(Ition, scc·"Sclccting 11 Prct•inl'ing Mor/e" 011 

pngc 128. 

MAKING A PREVIEW MOVIE 

\Nhcn a movic contains a numbcr of complcx lransitions, special cffccts, filtcrs, or audio 

clips rcquiring precise s:·nchronization, prcvicwing with the Previcw c0)11mand or by 

c\ragging in thc time rulcr may takc too long or mav not be accuratc cnough .. ·\ltcrnativcly, 

yo u canmah; a preview movic b:· compiling the clips undcr thc work ;nca bar into a Video 

for \Vindows or QuickTimc mm·ic. U1ilikc normal prcvicws, prcvicw tmwics are not 

linkcd to thc Construction window through thc Controllcr, but can be ldt on thc screen 

or s;wcd for la ter vicwing. 



Preview movies are built using the options specified in the Project Output Options dialo~ 

box. To build your preview movie more quickly, set a smaller size and lower frame ratc 

than.for your final movie. A size of 160-by-120 pixels anda frame ratc of 15 fps are rcc­

ommendcd. If yo u planto make multiplc previcw movics for thc projcct, considcr crcat~n: 

a prcset that you can load befare building the prcvicws. You can thcn rcload thc origin;tl 

preset befo re building the final movic. 

To make a previcw movie: 

1 Position thc work area bar ovcr thc clips yo u want to prcvicw. (Scc stcp 1 in thc scctio1 

"Compiling Effects and Transitions" on page 121.) 

2 Choose Makc Movie from thc Make menu. The Makc Movic dialog box appears. 

3 Click Output Options. Thc Projcct Output Options dialog box appcars. 

4 Choosc Work Area from thc Output drop-down list. 

5 Sclcct any othcr output options clcsircd. f.or more informal ion on out pul options, 

scc "Sclccti11g l'rojcct Output Options" 011 pagc 205. · 

6 Click O K. Thc Projcct Output Options dialog box closcs and thc Makc Movic dialog bo• 
-' 

rcappcars.- ·~· 

~ .. 

1 En ter a namc for thc prcvicw movic and click OK. 

Adobe l'rcmicrc builcls anc! savcs thc movic, a11d thcn opcns it in a Clip window. Click th• 

Play button lo vicw thc prcvicw movic. 

SETTING PREVIEW PROCESSING OPTIONS 

Prc,·ic"· optio11s affcct thc \\';n· thc prcvicw is proccsscd whc11 you choosc thc Prcvicw 01 

Sna¡,slmt comm;mds. C:hoosins <l projcct prcsct initially scts thc prcvicw options. ln mos· 

ctscs you \\'on't 11L'L'd lo ch;tngc thcm. You can, howc\·cr, customi1.c or crcatc ncw i\dohc 

l'rcmicrc prcscb to includc your l'rcCcrrcd prcvicw scttings. For more information on 

crcating or changing prcscts, scc "Loading or Modifying Pro¡cct l'rcscts" 011 pagc 29. 

.. 



To change preview options: 

' Choose Preview Options from the Make m en u, or double-click the Preview window. 

The Preview Options dialog box appears. 

. Prevlew Settlngs ·· · · · · . e 
-~------- -- --------------------- ----· ------------ ------·- ______________ ... , ·----. --- .. --· ... --·- --------- 'l 

r8J In front when previewing i 
' Preview Window Size: lirn j h @QJ v 

[8J In lront when scrubbing 
----------------·--··. ·----- ------- ------ ----· ·------ -·- ---------- --------- ---·-· ----· -- -- .. - -----.J 

------- [8J Video: -·--·-· • ---- -- ----. -- ·¡ 1 -.-

1 1 
nate· rj1""'5-lp-,------,¡-,~j ! 1 

Mode. jEIIech tu disk j :!J i ,1 

T_vpe: jrull Size frame j :!) 
! 
' "" O~h ~V 

L:::J Proceu al: 
<!j S ame as Projecl 

1 
[8) Video Filters 

--------- - ... --- -·- ·---· ·--- ·-·- ·--· 

1· Fewer Oplions... '1 

- ---------- [8] Aud1o: ------------ ---- 1 

nate: j22 k.tlz 

Formdl: j B bit - Mono 

{!)Disk 

()RAM 
O Disk 

@ RAh1 

[8] Aud1o Filten 

OK Cancel 

¡ 
l 

2 To changc thc Prcvicw window, set the following options: 

• Preview Winclow Sizc. En ter the dcsirecl prcvic"· irnagc size (in pixels). Adobe Prcrnicre 
processcs thc previcw at this sizc unlcss you spccifv a cliffercnt size using thc Proccss r\t 

option in, thc video portion of thc dialog box, as described in step 3. Kccp in r:Dincl that 
cíil.tr<>inn thc Prcvicw window mav dcoradc thc nrcvicw if vou are nrcvicwin<' from RAM b 0 , t" r , r 0 

'". ifyour hardware c:tnrwt pmccss thc brgcr irnagcs Ltst cnough. 

En ter a valuc in cithcr thc width or thc hcight ficld to automatically calcula te and updatc 
thc other f1cld b~tscd on thc aspcct ratio sct in thc Proicct Output Options dialog box. For 
cxarnplc, if thc 4:3 :\spcct Ratio option is sclcctcd in thc Project Output Options dialog 
box, a 4 to 3 width-to-hcight r~Itio is rn~tint~1incd. 

Note: }(JU Cllll ul.<o rc.<i::c tire l'rcl'iC\\' 1\'lllliOII' ¡,}' clroo;ing u stzc/Ímn tire windott•'; Control 

liten u, or /Jy dmgging tlll)' comer o(t/¡,· tl'illdOII'. \in1 wn tlltlolllllticullr rc;i::c tire tl'indow to 

numy popul11r sizc; hr Slliji+clicking 1111)' portion o(tllc l'rcvtctt' tt·indow, or /Jy holding down 

tire Shi{t kcy wlrilc dmgging 1111)' comer of tl1c tl'inrlott'. 

.• 



3 To change the video previcw options, set the following options (if all options do not 

appear, click More Options): 

• Rate. Selecta rate from 1 fps to 30 fps to specify the speed at which thc preview plays. 
Many computers are limited to maximum frame rates below 30 fps. 

• Mode. Selecta new m o de if yo u want to optimize how the preview is built and storcd. 

For a discu.ssion of previcwing modcs, see "Selecting a Prcvicwing Modc" on pagc 128. 

• Type. Match this sctting to thc way your video display board proccsscs NTSC or PAL 
video if yo u are previcwing in Effects to Disk mode and yo u intcnd to output to videotape 

at full-frame NTSC or PAL. Otherwise, leave thc setting at Full Size Framc. For full-framc 

video, many boards process only half the lincs in a frame and doublc thc captured lincs to 
complete thc frame. To find out how your board processcs video, sec thc documcntation 

that comes with your board. For general information on video boards, scc "Digitizing 

Hardw~1rc" on pagc 227. 

• l'roccss i\t. C:lick this option lo dclinc thc proccssing rcsolution of thc p1·cvicw, n:g~lrd­
lcss of thc Prcvicw winciow sizc. This option is aulomatically turncd on whcn r,ou en ter 

new values for.the horizontal anci vertical ciimcnsions. Processing ata smallcr sizc will 
~ . 

build pre\·iews fastcr, but al dcgraded quality. If you are prcviewing in Effccts tq Disk 

m ocie, VOl! shouJd considcr proccssing }•our prcvicws at the samc si'zc at which ·)'~~out pul 

your mO\•ic. This savcs rou proccssing time whcn the Print to Video command is selccted. 

For a discussion ofhow prcviews are processcd, scc "Sclccting a Prcviewing 1'v!ode" on page 

12H. 

• Video Filtcrs. Desclcct this option lo turn off thc application of filtcrs (thc default 

during prcvicwing) to enhancc performance. 

4 Set thc follllwing audio options (if al! options do not appear, click ivlorc Options): 

• 1Zatc. En ter,¡ sampl111g ratc for thc audio clips. Yo u can choosc a ratc of 11, 22, or 44 

kilohcrtz (kHz). 'vVith highcr sampling ratcs, thc sound in thc audio track will be clcaner. 
CD qu,dit)' audio is samplcd at .¡.¡ kllz with 16-hit rcsolution. 

• Forma t. Choosc bctwccn mono and stcrco, and bctwccn H-bit ami 16-bit for thc audio 

proccsscd in thc prcvicw.1f \'Our so urce clips contain S-bit audio, sctting thc Format to ló­

bit audio will onh· incrcasc thc time ~111d disk spacc rcquircd fm prcvicwing without 

impnl\'ing thc ,ludio. 

• Build/i'la)'. Click ~~ button tospccif;· how thc audio prcvicw will he built and thcn played. 
For more information on prnicwing moclcs, scc thc ncxt scction, "Sclccting a Previcwing 
,\·Jode." 

• ,\uclio Filtcrs. Desclcct this option to turn off thcusc of audio f1ltcrs (thc dcfault) during 

.• ... 



Selecting a previewing mode 
. . 

Yo u can specify whcther the program builds a prcview ·using available RAM, hard disk 

space, or both. Specifying the processing mode lets you optimize previewing for your 

hardware setup and for the desired accuracy. The processing mode affects the time 

required to build the prcview and to compile the finished movie using the Make lvlovie 

command. 

Proccssing a prcvicw works bcst whcn yo u save thc compiled movic segmcnts to vour hard 

disk in Effects to Disk modc. This is thc bcst prcvicwing modc for most projcct"s. In fact, 

all projcct Presets shipped with Adobe Prcmierc set the previewing mode to Effects to 

Disk. 

Modes for previewing video 

Filters, transitions, and superimpositions (collectivcly refcrred to hcre as cfti:cts) must be 

processed before they can be previewed accurately. You can proccss the dfccts whilc thc 

movic prcvicws ( which requircs a lot of RAM), or yo u can ha ve Adobe Prcmicre process 

the effects and save them to disk befo re playing back the previcw. lf your moví e contains 

no effects, then you can havc Adobe Premiere cache thc edits into RAM and play the pre­

view at thc fui! framc rate of your machine. 

In thc Prcvicw Options dialog box, sclcct from the following video pn:vicwing modes: 

• Effects to Disk.Sclcct this mode to havc Adobe Premicrc process al! cffccts in the work 

arca ahd savc thc information on thc hard disk befare playing back thc ¡ii-cvicw. In this 

modc, thc program proccsscs thc cffccts bcforc thc movic is pbycd back. This frccs up 

memory for loading and pbving mm·ic framcs that would othcrwisc be rcquircd for 

processing during pla:·back, and lcts you preview long movies smoothly and accurately. 

1 n EfTccts to Disk m ocle, Adobe l'rcmlcrc e reates tcmporary prcvicll" files (. 1 111[') for ca eh 

efTccts scgmcnt in thc Construction 1\'inclow, such as a tr,msition ora titk ovcrLtv. Thcsc 

flks are :mtomatically storcd in a director;· with a .1/Jif' file cxtcnsion, loGltcd in thc dircc­

tory ami disk volunll' that cont:1ins your ~'ro.icct. 

Adobe Premien: uses thc tcmporan· prc'\'iLw !1lcs for subscqucnt prcvicwing. Only thosc 

scctions of thc Construction windm,· that havc changcd sincc thc bst prC\·icw rcquirc 

reproccssing. Thc program also uses prcvicll" files whcn compiling thc final movic (using 

thc /VIakc· ivkl\'ic or thc l'rint to VidL'O comm.1nd) iC thc imagc dimcnsions :1nd comprcs­

sion scttings match thosc in thL' üutput Options and Prcvicw Options di:1log boxes. This ' 

reduces movic compilation time considcrablv. 

/ .. -



Adobe Premiere displays thin gray bars above the time ruler in the Construction window 
to indica te which portions of the window ha ve been processed and saved to disk as prcvicw 
files. The uppcr half of thc gray bar reprcscnts video prcvicw files, whilc thc lowcr half rcp­
resents audio prcview files. 

/ 
Video prevtew file mdicator 

Q Construction Window L l· 
;¡~ 

/ .. --""·'""-. ~- . . Audto prcview file indicator 

~· lO. DO 0000200 0000400 o ~JH 

Changing any variable in a transition, filter, or superimposed clip causes thc program to 
del etc any associated preview files. Su eh variables includc thc duration of thc transition or 
effcct, thc fadc kvels, thc key typc, and thc motion settings. If yo u changc thc Ratc, Typc, 
or Process At options in thc Prcvicw Options di;llog box, Adobe Prcmicrc will dclctc and 
rcproccss al! prcviously huilt previcw files. 

Note: 1(¡ cnsurc 511/0oi!I prn·icws i11 rlw FJ}i:cr:; ro Disk 111odc, 11111kc su re 111111 r!Ic di111cnsiom 
ofyour original clip; 11/ntch thc sctting o( t!Ic Proccss At option.in thc PnTicll' Opiions dialog 
box. !( thc diiiiCIISÍon:; do not lllillcll, Adobe Prcnncrc 11/llst rcsizc thc clips 11•hilc it plays thc 

prcvicll', w11Íc/1/WIJ' rcsulr 111 stuttcring. '· 
•.· 

• Effccts to Rr\lvl. In this modc, thc video clips are loadcd into Ri\ivl, ami thcn thc cffccts 
are proccsscd in real time as thc prcvicw plays. This mcthod is uscful il. yo u are prcvicwing 

short scgmcnts or yo u ha,·e lots of R:\lvl. lt is <liso use fu! whcn yo u are cxpcrimcnting with 
c!iflcrcnt transitions. Howcvcr. F.ITccts to Rt\lvlma~· not gi\'C accur;Jtl' rcsults, as somc tran­
sitions and cffccts Glnnol he proccsscd in real time, rcsulting in droppcd framcs in thc 
prcv¡cw. 

Proccssing prc,·icws in F.tTccts to IZ:\~·lmodc can be cspecially hclpful whcn working with 
clips th;ll ha\-c largc c!imcnsions ( largcr than 6·10-lw-4RO pixels). Building filtcrs and tran­
sitions for thcsc clips can takc consiclcrablc time. To crea te thc bcst 1\Mvl-basccl prcvicws, 
sct thc !\ate option lo lcss than :>O fps allCI reduce thc sizc of thc Prcvicw winclow so that 
more framcs can be loadcd into R:\\1. Once the framcs are loadccl, cffcct;, and J!lters can 
be appliecl lo the fr,Jmcs with almost no prc,·icw dclay. 

• Play Dircctly·. In this modc, thcrc is no prc-lo;Jding of video clips. Effccts are proccsscd 
as thc prc1·icw pla\'S. Th¡:; mcthod gcncralh· pnwidcs accuralc prc,·icws onlv if yo u ha ve a 
verv L1st compulcr and plcnt1· oí 1\:\:\-1, or i( vou don't ha ve cffccts in vour nwvic. 

/ -.. ' 
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Modes for previewing audio 

In the Preview Options dialog box yo u can choose from three options for processirig audio 

prev1ews: 

• Build to Disk/Play from Disk. In this modc, all audio is processed, saved to the hard disk, 

and then played back from disk. This is the bcst mode for working with projects that 

canta in only audio. If your project al so contains video, yo u nccd a vcry fast disk drivc with 

this option to prevent video from dcgrading. Video degradation is ca u sed by the disk drive 

searching for and playing back two files (audio and video) at the same time. 

• Build to Disk/Play from RAM.ln this modc, al! audio is processed and saved to thc hard 

disk, but instead ofbeing played from thc disk, it is moved into a RAM buffer. This option 

:1llows video to preview more smoothly, but may impose somc restrictions based on the 

amount of RAM instalkd in your system. As a general guideline, 1 minute of audio 

samplcd at 22kHz (mono) rcquircs 1.3 ¡\·fB offree RAM. 

• Build to RAM/Play from RAM. In this modc, all audio is processed directly in RAM and 

then playcd from RAM. Since nothing is s::1·cd to disk, thc audio must be reproccssed 

whcn yo u compile a movie or output a movic to videotape. This option has the same RAM 

rcquirements for playing audio as the prcceding option and works best when you are 

previcwing only audio mixes. 
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CHAPTER 5: U SING TRANSITIONS 

his chapter describes how to crea te eye-catching transitions between movie or 

still-image clips in Adobe Premiere. Each transition is unique and has a varicty of 

optioÍ1s for controlling the way thc image is transformcd. Thc most common 

transition bctwecn clips is a wt-an instanlancous switch from onc clip to anothcr. Thc 

tcrm is borrowcd from film editing, whcre a cutis achieved by splicing two shots togcther. 

To cut betwecn clips in Adobe Prcmicre, yo u simply arrangc the clips, hcad to tail, on thc 

samc track in thc Construction window. If, howcvcr, you want <l lcss <lbrupt or more elab­

ora te transition bctwccn clips, you havc many options from which to chomc. 

Adobe Prcmicrc includcs more than 70 lr,msitions such <lS i\dditivc Dissolvc, Band Wipc, 

Chcckcrboard, Slidc, ami Vcnetian I3linds. In addition, you can crea te your own custom 

transitions, which you can savc and use ovcr again. Thc Transitions window includcs a 

bricf dcscription of cach tr,msition, and whcn thc window is active, thc transition icons 

bccomc anima red. 
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lrrt.'l•,;Je ~ ~plrt: rnto tour part~ ara: :;lié.,.: t.: 
ltu:- cento:-r ro reve::lrru.:;~e E: 

Note: !(yo u plnn to gcncrnlc' 1111 Etlit 1 !ccision l.ist ( EVL) fár your 1110\'Íc, scc "Gcncmti11g 1111 

Edit f)ccisioll f.ist" on pug,· 108 Ji>r u dcscription oflw\\' trunsition.< in !ldo/Jc Prcmicrc ore 

llltcr¡nctccll>}' tlic E/JI. cx¡>ort 11/odulc·,. 

/ ·- . 
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ADDING TRANSITIONS 

When yo u crea te a transition betwecn clips, yo u must place one clip on video track A in 

thc Construction window ami thc othcr on video track 13. The transition goes on the T 

track, which is locatcd between video tracks A and 13. Thc clips on tracks A and 13 should 

overlap in time so that the transition can be placed in the overlapping area. 

Yo u control the din:ction of thc transition-from track Ato track B, or from track B to 

track A- by the position of thc clips on the tracks. Br default, when two clips start at the 

same time, the transition 1~1ovcs from trJck Ato trad. 13; whcn two clips st~ut at diffcrcnt 

times, thc transition starts with the clip that plays first (the lcftmost clip on thc timeline). 

Yo u ca·n override thc dcfault direction by clicking the transition's track selector. For infor­

mation on tog~ling the track selector, scc the next section, "Changing TrJnsition Scttings."··· 

To add a transition to thc Construction window: 

1 IC thc Transitions window is not visible, choosc Transitions from the \Vindows mcnu. 

2 Drag thc transition :·ou want to use from thc Transitions window to the T track in the 

Construction window. 

If clips on video tracks A and l3 ovcrlap, Adobe Prcmierc adiusts the transition to fit the 

overlapping arca. You can shorten or lcngthcn its playing time justas you would a clip. 

3 To replacc a transillon with anothcr transition, use thc Copy and the Paste to Fit 

commands in the Edit mcnu. Thc Paste to Fit command lcts yo u paste ~1 transition of thc 

samc sizc into the arca of thc previous transition. 

/ , 
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CHANGING TRANSITION SETTINGS 

Transitions ha ve various settings, all of which can be adjusted using the Transition Sctting' 

dialog box. In addition, you can access the most frequently used settings by clicking 

controls in the transition's thumbnail in thc Construction window. Thcsc controls includt 

the Track selector, the Forward/Reverse selector, the Edge selectors (which are optional, 

depcnding on the typc of transition), and the Anti-aliasing selector. Yo u m ay not be abk 

to scc thc controls if thc thumbnail in the Construction window is too short or too small 

To change transition settings: 

1 Selcct the transition and choose Transition Scttings from the Clip m en u, or doublc-clid 

the transition in thc Construction window. The Transition Scttings dialog box appears 

with a thumbnail of thc transition displaycd in thc lowcr-right comer. 

1 Start slider 

1 j Open point r End sl1der 
1 - • Iris Round Settlngs ':.' .. : ;' ; · -

1 Start ~ 0% Finish = 100%! 

A B 
Border Color ·-' 

'.;·~ 1 s.¡·.~.;- - forw.1rd/Reverse selector 
~ ~ . .::.J - - Antl·aii,JSing selector 
1' .. - . 

i O d_how Actu<al Source: : ________ - Track selector 

!1 1 Cancel 1 :o K' . ' 

' 
·- Border sl1dcr - Color swatch 

2 To scc thc starting ami c·nding Cramcs uf thc transition in thc boxcs providcd, sclcct · 

Show Actual Sourccs. 

/ ·- S 



3 To change the starting and ending points of the transition, use the Start and End sliders. 

Hold down the Shift key to simultaneously loe k and m ove the start and end sliders. For 

example, yo u might use this option to start or end the transition in the middle of the effect. 

Iris Round Settings ·· · 

Border Color • 
1· OK · j Cancel 

4 To adjust the width of the optional border on the transition, drag thc Border slider. 

The dcfault Bordcr is Nonc. 

· ¡ · · ·- 'Iris Round Settings: · '·'_.;\ _ .> 

Border Color 

"G"~ D 
OK 1 Cancel 

5 To sclect a bordcr color. click thc color S\\'atch c1nd use thc color pickcr to sdcct a color. 

For more information on usin~ thc color nickcr. scc "Usino thc Prcmicrc Color Picker" on 
~ 1 ~ 

pagc 141. 



6 To change the starting position of the Iris Cross, Iris Diamond, Iris Round, Iris Squarc, 
Iris Star, and Zoom transitions, position the pointer on the small, whitc, repositioning box 

in the Start window of the Transition Scttings dialog box, and drag to reposition the 
starting point. 

7 To display any custom settings for thc transition, click Custom. For cxamplc, you use 
custom settings to sct thc numbcr of bands u sed in'thc l3and Slidc transition. Custom 
scttings ene not availablc for alltransitions. 

8 To changc thc dircction of thc transition bctwecn clins, click thc Track selector on thc 
e t ' 

left si de of thc transition's thumbnail. Thc clircction can be cithcr clown (fróm track A' 

track 13) or up (fromtrack B to track ,\). You can also sct this option from thc transition .. 
thumbnail 1.n thc Construction winclmi· if thc thumbnail is largc cJí.ough. 

9 To changc thc oricntation of thc transitiun, click an Eclgc selector on thc transition's 
thumbnail. Thc Ecigc sclcctors are smcliltrianglcs borcicring thc transition icon. 

e e e 

For cxamplc, thc Barn Doo1·s transition can be oricntcd vcrtically or horizontally. Somc 

trc1nsitiuns do not havc Edgc sckctors bcc1usc thc transition has only onc oricntation. 

10 To makc thc transition p\a,· fo1·ward or backward, click thc Forwc1rd/Rcvcrsc selector 
inthc upplT-right cornn of thc trc1mition\ thuJnbn,lil. FoJ·cxamplc, thc Clock Wipc tran­
Sltion can pLJ,· clockwisL· or C<lllntnclockwisc. You can also sct thc forwc1rd or rcvcrsc 

diJ·cction from thl· transition's thumbnc1il in tlll' C:omtruction window. 

11 To adjmtthc smoothncss of thc transition's cdgcs, click thc Anti-alic1sing sC\cctor in ti 
lowcr-right corncr of thc transition's thumlmail. Clicking cyclcs through thc valucs Low, 

High, clllcl Off. 

·• 



The diagonalline on the selector beco mes progressively more or less jagged to indica te its 

val u e. Anti-aliasing smooths the frames affected by the transition by i·eplacing jagged 

edges between the images with dithered patterns. This makes the transition appear less 

abrupt. You can also set anti-aliasing from the transition's thumbnail in the Construction 

window. 

Anti-aliasitlg set to OJT Allfi-alitJSillg sct ro High 

12 Click OK. If yo u selected multiple transitions, the Transition Scttings dialog box 

rcappcars for each transition. 

CREATING AN IMAGE MASK TRANSITION . 
You can use a black-and-white bitmap imagc as a transition mask in which image ;-\ 

rcplaccs the black _in thc mas k, and image B rcplaccs thc white in thc mas k. lf yo u ¿¡se a 

grayscalc imagc for thc m:tsk, pixels cont:tining 50 pcrccnt or more gra;- will be convertcd 

to black, and t•ixcls containing less than 50-pcrccnt gray will be convertcd to whitc. 
.. 

l'or a more versatilc mask, use thc Track lV!attc kcy typc to crea te <1 mattc from the clip on 

thc ncxt S track; for more information, scc "Track !vlattc" on pagc 186. For an cxaniplc of 

using thc Track )Vlattc kc:· typc lo e reate a moving mattc, see "Playing a movic through a 

travding n1attl'" on pagc 262. 

To add an imagc mas k as a transition: 

1 Drag thc Imagc rvlask transition from thc Transitions window to thc T track of thc 

Construction window. Thc lma¡:c i'vlask Settings dialog box appcars. 

2· Click Sclcct lmagc. Thc Opcn di<llog box appcars. 

·-h . 
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3 Select the image file you want to use as a transition mask, and click OK. The imagc you 

selected appears in the Image Mask Settings dialog box. 

,. : lmage Mas k Settings • 

OK Cancel 

flll:nap flllt/P,C 

4 Click OK. 

Rcsulr tJ/ 1/1/li_I!.C 

nuuk ím. IIWl'IC chp 

CREATING A GRADIENT WIPE TRANSITION 

Adobe Prcmicre can use any importable gt·,wscalc image as a gradicnt wipc. In a gradicnt 
wipe, image B tills the black arca ofthc gr<n•scalc image and then shows through cach level 
of gray as thc ti·ansition progrcsscs until the whitc arca bccomes transparent. When you 

CI"C<He a Gradient \Vi pe transition, you e<m spccify thc "softncss" of the transitimú cdges. 

The 1\dobc Premicrc program includcs S<lmpk imagcs that vou can use as Gr<ldicnt \Vi pe 
transitions. Thcsc samplcs arc·locatcd in thc :\dobc Prcmicrc 3rl_f'!lrly dircctory. You can 

<llsocrcatc your o\\"n Cradicnt \Vi pe imagcs in thc :\dobc Photoshop progr<ltll. 

To crea te a Gradicnt \Vi pe transition: 

1 Drag thc Gr<tdtcnt Wipc tr<msition !"ro m thc Tr.msitions window to thc T track of the 
Constructton \\"indo\\". Thc Cradicnt Wtpc Scttings dialog box appcars. 

2 Click Sclcct lmagc, and use thc· Opcn dialog hox to sclcct the file you \\"ant to use in the 
w:pc. Thc t111<1gc \'OU sclcct appcars in the Gr.1dient Wipc Sctting dialog hox. 

' ·;' ~-., ·; ... · · ·'Gradlent Wlpe Settlngs-: . ' .. :·. _,, icc'.i 

Select lmage .. 

:=-

OK i Cancel 

-- --. 

113 



3 Adjust the softness of thc transition's cdgcs by dragging thc Softncss slidcr. As yo u drag 

the slicler to the right, imagc A incrcasingly shows through imagc 13. 

4 Click OK. 

CREATJNG CUSTOM TRANSITIONS 

In addition to the many transitions included with Adobe Prcmierc, yo u can apply vour 

own custom transitions using the Transition L1ctory. You determine how you want the 

transition to affcct the channcls (alpha, red, grccn, ancl bluc) of ca eh pixel in thc first imagc 

and thc second imagc by spccif1·ing arithmetic cxprcssions. 

Thc transitions you crea te can also includc Scttings dialog boxes. Thc Settings dialog box 
providcs up to cight sliclcrs for adjusting thc transitiotú effect. Whcn you clesign a tratísi­
tion, you in elude uscr,.supplicd slidcr information in thc cxprcssion. You ~liso dctcrmit}C 

thc nuinbcr of slidcrs ~:nd whcthcr thcv will ~1ppcar in thc Settings dialog box indil'idually 
or tn patrs. 

\-Vhcn :·ou cn·atc ~l·transition. Hlll c;1n sa1·c its·cxprcssions in ~1 tcxt file. Dóing so lcts you 

use thc Tr~msition Factory to cdit thc tr.msition l~ttcr. You can also add your custom tran­
sition as a built-in transition to Adobe Prcmicrc so that it appears in thc Transition 
ll'inclow. 

Thc ncxt two proccdurcs cx¡>binlw\\' to use thc Transition Factory to applv ~md savc 
custom transitions for use in t\dobc l'rcmicrc. Fur ~~complete discussion of using arith­
mctic cxprcssions to ~tchicl'c' an cfkct, scc :\ppcndix B, "Exprcssions for Crcating Transi­
tions and Filtcrs." Thc cxpr'Cssiom dcscrihcd in t\ppcnclix B are uscd by both thc Transi­
tion Factory ancl thc Filtcr Facton·. 

•:., 
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To crea te a custom transition: 

1 Drag the Transition Factory transition from the Transition window to the T track of thc 
Construction window. The Transition Factory Settings dialog box appears. 

u~ ...... ~ ......... 

• --o~·t:···-

2 Specif)· the cxprcssions as follows: 

• To spccify an cxprcssion i·n lhc ;dpha channcl, sl'lccl Single Fxprcssion ;md lypc lhc 
cxprcssion in lhc 1\ freid. Thc cv;Jiualion oflhc alpha channcl cxprcssiun will be applicd l<> 

' each of thc olhcr thrcc ch.mncls: 1~. G, and B. Whcn thc samc val u e is applicd to cac1· 

channel of thc pixels in ;m imagc, thc imagc will be a gravscalc imagc. 

• To spccit)· separa le cxprcssions for lhc R, G, and B channels, makc surc lhat thc Singk 
Expression option is dcsclectcd and typc thc cxprcssions in lhc R, G, and B ficlds. Evcn il 
you spccif)· thc samc cxprcssion in al! thrcc channcls, lhcir cvalualions will probably be 

d 1 rfcrc n t. 

As you typc an cxprcssion, a sm;111 ycllow caulion sign appcars. lt will rema in visible unlil 

you havc lypcd a legal cxprcssion. lf lhc caulion sign cines nol disappcar, il mcans that 
lhcrc is an error in lhc cxprcssion. To scc which part of lhc cxprcssion is in error, click tlw 
caulion sign lo sclccl lhc incorrccl portion. 

3 lf lhc cxprcssions includc uscr-supplic·d slidcr inform;Jlion, drag lhc approprialc Map 
shdcrs lo prl'\'ic·w lhc cfkcls. Thc i\'Llp O slidcrs corrcspond lo slidns O allC! 1; lhc Map 1 

slidcrs corrcspond lo slidc1·s 2 ;11HI 3; allll so 011. For ml(mnalion 011 including uscr­
suppliccl slidcr information in c·xprcssions, scc· "l'roviding Uscr-Conlrollcd Slidcrs" 
oi1 pagc 293. 

4 \Vhcn vou ha ve corrcclh· scl up thc lransition, click Savc to savc lhc cxprcssions in a tcxt 
file. S.n·ing thc cxprcssiPn allows \'Oll to load .rnd edil lhc lransilion in lhc futurc. You 
should sivc thc' tcxt ti le thc samc n;unc that you plan lo givc thc transition, but savc i ;1 

director:' othcr th.rn thc :\dohc l'rcmicrc plugins dirccton·. 

5 Ifyou 11·ant lo use this onc instancc ofthc tr;msition only, click OK lo apply thc transi 
tion.lfvou ,,·,mt lo use thc transitionmorc than once. scc thc ncxt proccdurc. 

•< 



To save a custom transitionfor additional use: 

1 Follow steps l through 4 of the previous procedure, "To crea te a custom transition." 

2 Click Build. The Build Custom Transition dialog box appears. 

3 Specify a unique module name with 8 characters or less in the DLL Module N ame fleld. 
' . 

4 Specify a na me for the transition in the Title field. The title will appear in the Transition 

window after you restart Adobe Premiere. 

5 Use the Author field to include credits or copyright information in the transition's 

Scttings dialog box; dclctc any information you do not want. 

6 Use thc Dcscription ficld to incluclc a dcscription of the transition. The dcscription will 

appear in thc Transition window aftcr vou restart Adobe Premierc. 

7 If the transition's exprcssions include user-supplied slicler information, select the appro­

priate number of Slider or Map options and specify labels for the sliders in the corre­

sponding text boxes. Tl¡e labels will appear with the sliders in the transition's Settings 

dialog box. 

To display thc sliders individually in thc Settings dialog box, use the Slider options. To 

display the sliders in pairs, use the Ivlap options. Whethcr· you shoulcl use indi1·idual or 

paired sliclers dcpcncls on the type of transition yo u ;¡re creating. 

8 Click OK. The custom transition module is saved in the Adobe Premierc plugin; direc-

tory'with the mocfule na me you specificcl and thc .¡mn file cxtcnsion. . 

9 '](¡ lll<lkc thc transition <lV<lilablc to uscr·s, restar! thc ,\dobe l'remicrc program. 

To cdit a custom transition: 

1 Dr;Jg the Transition Factor y transition from thc Tr<lnsition winclow to thc T track of the 

Construction window. Thc Transition L1cton· Scttings dialog box appears. 

2 'Ciick Load. Use thc Oncn dialog box to load thc tcxt file contaming thc transition's C C L 

expressions. You must h;wc savcd thc cxprcssions in <1 tcxt file when you cn:atccl the tran­

sition to be ablc to cdit it. 

3 Follm,· thc stcps in thc pre\·ious t\\·o proccdurcs to cdit and rebuilcl the transition. 



USING THE PREMIERE COLOR PICKER 

The Prcmiere color picker appears when you selecta color for a transition's bordcr, for a 

supcrimposition key, for titles and graphics, and for so me filtcrs. The Prcmiere color 

picker lets you visually select colors from the range of colors that can be displayed in a 24-

bit color sp;1ce. Yo u can choosc from the colors displavcd in thc Color Pickcr dialog box or 

vou can en ter RGB color valucs. 
' 

To selcct a color using the Premicrc color pickcr: 

1 Sclect a color using onc of the following mclhods: 

• In thc l'rcmicrc Color Pickcr dialog box, movc lhc cursor (shapcd as a circlc) lo thc 

dcsin:d color ;ll ;uw poinl on lhc succn, ;md click lo sclccl lhc color. Sclccl a shadc of gr<l)' 

bv clicking lhc continuous gr,1v sea le loca lec! alonl! lhc lcfl cdgc of lhc window. 
1 '-' V 1 '--' '--

• Specify a color by entering the RGB componcnts of the color in thc Red, Creen, and l3luc 

tcxt boxcs. En ter a numbcr betwecn O ancl 255 for cach componen t. 

Selecl Borde• Color: 

Red.l~ 1 

[irecn: 122-1 1 

Blue.~ 

OK 

Cancel 

Thc sckclccl color appcars in lhc uppcr-righl corncr of lhc Color Pickcr clialog box, bclow 

;1 prc\·iouslv sckctcd color. lf thc colo:·vou ha ve eh osen fa lis outsidc lhc NTSC color spacc, 

a warning sign will appc·ar lll'Xl to thc Sl\'alch along with a smalkr swalch that conlains thc 

NTSC-safc approximalion pf lhc scb:lcd color. Click lhc small swalch to substitutc thc 

NTSC-s.1k wlor for lhc choscn color. 

2 Click Oh:, or prcss !Zc·turn lo ;1ppl:' lhc color. 
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CHAPTER 6: U SING FILTERS AND 

MüTION SETTINGS 

~~~,~~\f) do be Prem.iere includes a variety of filters that Jet yo u distort, blur, sharpen, 
f.~ A~ smooth, texture, and color images. There are also a number of spccial-purposc 
"' [;3• t 1 
~;:-,-!:'1-'~11 filters, such as the Image Pan filter for panning and zooming in an image that i.' 
larger than the output frame sizc, and the Vertical and Horizontal Flip filtcrs for tlippint: 
the image along eilher axis. Audio filters includc the Echo filter, which produces an echo 
effect, and the Fill Left and Fill Right filters, which affcct the spatial gualit:· of the sound. 
In addition, yo u can apply your own custom filters, which yo u can save and use ovcr ag;1i11 

Adobe Premiere also lcts you crea te motion effects in movic ami still-imagc clips that an 

similar lo thosc achicvcd using an animation camera, such as zooming into an arca of 
' ' 

thc clip. 

APPLYING FILTERS 

This scction describes how to apply filters and filler settings to clips, and how to dcler ll 

guickly which filtcrs and filter scttinp ha ve bccn applicd toa cli_p. For examplcs of how 
filters affcct clips, scc "Efkcts of \l;¡rious Filtcrs" on pagc 163. 

Adobe Premiere pro1·ides more than 70 movic and still-image filtcrs and 5 audio filters, 
which are dcscribccl in "i'vlovie and Still-lmagc Filters" on page 147 ancl "Audio Fillers" on 
pagc 163. In ;lciclition, :\do be Prcmtcre works with third-party filtcrs in the standard 

:\dobc Premien.: ami Adobe Photoshop formats. Some filtcrs can be applied toa clip ovct 

time. hn CX<l111plc, vou can <lppk bnghtncss that gcts progrcssivclr brighter as the clip 
pbi'S. 

Note: J(;·ou /;,¡¡·e nnn/Jilll:d tite plugins dircctorics frouz Ado/Jc f'rcuzicrc llllri Adobe Plzoto­

slzop. souzc o( tlzc :\do/Jc Plzotos/l(>f' (ilrcrs, tlzous,lz acccssi/;/c, are 1101 appropriatc for use in 
:\doi!C fJronicrc. 

Applying filters to a clip 

You Clll ,1pph· ;¡ liltcr to more thottl ntlc' clip ,\t a time, ami )'"ll e;¡¡¡ ;1pply more than onc 
filtcr toa clip. 

To applv a filler lo a clip: 

1 Scb:t thc clip 111 thc Constructionwindcl\\·. To apply a filtcr to more than onc clip, .. e· 

thc ransc sckct too! tu sdcct thc clips. You could also sclcct onc clip ami use thc Paste 
Custom command latn to apph- thc filtn lo a numbcr of clips in scqucncc. 



2 Choose Filters from the Clip menu. The Filters dialog box appears. 

· · · - · · Filters . : - · · · · '· , 
Available Cunenl 

Antialias ..... . .... ¡..! 
1 

» Add » 1 Backwards (Vid~of" 
Bend 

1 
Remove << 1 Black L \1/hite 

Blur -5ett¡ng<;-
Blur More 

1 
Start... 1 Brighlness L Conlrast 

Camera Blur ..... 
Clip 0 Vd•Y Swap 

T 
Colm Balance 

1 
End ... 1 Color Oflset 

Color Pass 
. 

Colm Replace 
1 

OK 1 Convolution Kemel • 
581tem~ Cancel J U ltem: 

lf yo u havc selccted a movic or still-image clip, thc Filters dialog box displays only thosc 
filtcrs th<lt can be applicd to movic or still-im<lgc clips; ifyou have sclectcd an audio clip, 
thc filtcrs dialog box dispbys only thc audio filtcrs. 

3 Sclcct the filtcr from thc Availabk list and click Add, or double-click thc filtcr in the 

Availablclist. 

Note: Yo u WII n/so npply n filter to 11 clip /Jy positioiiÍ!lg thc pointcr over tl1c clip nnd clicking 
tl1c rigi!III!Oitsc l111tto11 to ncccss tl1c Co11structlon ll'indaH' pop-r1p mcmt. Click thc lcft mortse 
[Jlltton on Filtcrs to opc11 tite Filter; dialog /JoX. 

4 If thc ti !ter h.1s scttings. a Scttings di.1log box appcars. t\djust thc scttings as dcsircd, and 
click OK. You can changc a filtcr's scttings al anv time lw doublc-clicking thc filtcr in thc 

~ '-- ' ' ..__ 

Curren\ list. 

· Brlghtnees and Contras! Settlngs - . 

. ·-~ 
~-~-.:' 

Conlrasl = O :·- -r~ --~~-~~:~,~.=.;t 
iQK' 1 Cancel 

5 To apply additionill filtcrs to thc clip. rcpcat stcps 3 and 4. You can al so <1pply thc same. 
filter toa clip severa! times to intmsií\· (doublc. triple, cte.) thc effcct of thc filtcr on 
thc clip. 



Adobe Premiere applies filters in the arder in which they appear in the Current list in tlw 

Filters dialog box; if yo u want the filters applicd in a differcnt arder, rearrangc thc filler; 

in the Current list by dragging them up or down. 

6 To remove a filtcr fromthe Current list, sclect thc filler and click Rcmove or prcss Dclek 

7 Click OK to apply the filters. 

· In the Construction window, clips with filters applied to them are displavcd with a blue 

border at the top. 

Note: A _(iltcr is npplicrf to nn en tire clip nt a time. I(you wnnt to apply a filtcr to only parto¡ 
a clip, you must split thc clip using thc mzor too/. For more injonnation 011 splitting clips in 

tlzc Constructiun 1vindow, scc "Splitting Clips" 011 pngc 89. 

Changing filters over time 

You can apply anv filtcr thal lcls you spccify scllings to clips ovcr time. Fur cxamplc, yo11 

can apph• lhe Cuncr;¡ 1\lur.liller in such ;1 way lh;¡l lhe clip is progressivc·ly disloried ;¡; i1 

pb)''· /\nv 1\dobc· l'lwtoslwp liltcT that h,1s SL'IIim.:s, such ;¡s the Tiks liltcT, can also hl' 
' ' 

applicd ovcr time. 

To apply a filtcr lo a clip ovcr time: 

1 Follo1,. 1hc ba;ic procc·durL' dcsuibcd in lhc prc1·ious scction, "Appll'ing fillcrs lo a clip.· 

tu appl:· lhe filler. Whcn 1hc Sellings dialog box lirsl appcars, click OK lo return lo · 

lhc Filtcrs dialog box. The oplions in lhc Scttings arca o( lhe Filtcrs dialog box bccome 

avaiL1blc. 



2 Click Start. The filter's Settings dialog box reappears. 

· . Camera Blur SeHings · 

ÍOKI Cancel 

3 Adjust the settings as desircd for thc beginning of the clip, and click OK. 

4 Click End in the Filtcrs dialog box. The Settings dialog box appcars again. 

' · Camera Blur SeHings·--

IOKI 1 Cancel 

;· J f 

9 Adjust thc scttings as dcsircd for thc cnd of thc clip. and click OK. Thc Vary o¡ition in 
thc Filtcrs dialog box is now sclcctcd to indica te that you havc varicd thc f11ter o\:'cr time. 

6 To cxchangc thc St~Hl and End scttings, click Swap. 

7 To cancel thc time cfíi:ct ami use thc Start scttint:s for thc en tire el in, dcsclect thc Varv 
' t ' 

option. 

Determining which filters have been applied to a clip 

In thc Construction window, cllps that havc filtcrs applicd to thcm appcar with a bluc 
bordcr at thc top. You can quickly vicw a li,t of thc applicd f11tcrs for a sckcted clip and 
thcn changc f11tcr scttings. 

To determine which filtcrs ami filtcr options havc bccn applicd toa clip: 

1 \Vhilc prcssing thc r\lt kc\·, mm'L' thc pointcr ovcr a clip in thc Cnnstruction window. 
Thc pointcr changcs to ,lll icun of ~~ mJniaturc mcnu. 

:.1 

.• . .• 
·' .-...:. 
'· 



2 Hold clown the left mouse button to display a pop-up menu of filters that havc bccn 

applied to the clip. 

Filter s... 

3 To vicw or changc filtcr scttings sct for a clip, sclcct thc filtcr n~1mc from thc pop-up 
m en u. You Gln also apply addition.llliltn:; by choo:;ing Filtcr:; from thc pop-up mcnu. 

MOVIE AND STILL-IMAGE FILTERS 

:\dobc Prcmicrc incluclc:; thc following liltcrs that can be applicd to mtwic .1nd :;till-im,1ge 
clips. For samplcs of manv of thcsc filtcrs, scc "Effccts ofVarious Filtcrs" on pagc 163. 

Anti-alias 

Thc Anti-qlias filtcr smooths an en tire imagc by avcraging thc coiors in arcas of high 

contras t. Avcraging colors adds intcrmcdiatc shadcs that makc transittons bctwccn clark 

and light arcas appcar more gradual. 

Backwards (Video) 

The Back w~nd:; (Video) liltcr pL11·s .1 clip from l he L1:>l fr~1111e lo l he ti r:;t fr;11nc. i\n alterna ll' 
w;¡~· to pla1· .1 clip h;kk\,·;¡¡·ds is toseta net~.1tive speed l(,r the clip. l'or informal ion on 
sctting cltp speed, sec· "Sctting the Forw;ml or Backw.mi Spccd of ,1 Clip" on pagc 9'1. 

Bend 

Thc Bcnd filtcr hcnds ;¡n im.lt:l' lw strctching it horizonull:· ami vcrtically. You can sclcct 
a sine, circlc, tri.mglc, or squ.trc for thc wavc t:·pc, and adjustthc intcnsity, ratc, and width 

ofthc wavc ,;ha pe using thc slidcrs in thc filtcr's dialog box. You can also indicatc thc dircc­
tion in which thc w;n·c should mm-c. Choosc Lcft, Right, In, or Out for thc horizontal 

dircction. Choosc U¡'. Down. In, ur Out for thc I'Crttcal dircction. 

8/ack & White 

·:·he Bl.tck 0; \\,.httc í'ritn reduces all colors to shadcs of grav. 

.• 
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Blur and Blur More 

These filters elimina te noise in the parts of the image where significant color transitions 

occur. The Blur filter has a subtle effect, suitable for high-resolution images. The Blur 

More filter produces an effect three to four times stronger than the Blur filter and is more 

suitable for lowcr-resolution images. 

Brightness & Contrast 

Thc Brightness & Contrast filtcr adjusts the brightncss and contrast of the imagc. As you 

drag the slidcrs in thc filtcr's dialog box, thc prcvicw of the imagc changcs to rcflcct your 

adjustmcnts. 

Camera Blur 

Thc Camera Blur filtcr simulates an unfocused camera lens by crcating an extreme blur 

cffcct. By applying the effect to cither the starting or ending framc of a clip, yo u can simu­

late the image going in or out of focus. 

Clip 

Thc Clip filtcr trims rows of pixels off the edges of a clip. This can be useful for trimming 

away noisc and pixel skew that mav rcsult from overscanning during digitizing. Usi! the 

slidcr controls to crop cach edgc of the imagc scparatcly. Yo u havc the option of clipping 

in pixels or imagc pcrccntagc. 

If¡:ou want Adobc.Prcmicrc to autom~ltica!ly rcsizc thc trimmcd clip to its original dimen-

sions, use thc Cm¡\ illtn (dcscribcd on pagc 151) instc<ld of thc Clip flltcr. ... 

Color Balance 

Thc Color Balance filtcr changcs colors in thc image by adjusting thc RGB levcls. Drag the 

sliders in thc filtcr's dialog box to makc a color more or less prominent. As vou drag the 
..... ¡ ..._, 

slidcrs, thc prcvicw of thc imagc in thc dialog box changes to rcf1cct your adiustments. 

Color Offset 

Thc Color Ort:->ct filtcr shifts thc red, grccn, or bluc channcl ofvour imagc in onc direction 
e , e 

without mcwing thc othcr two channcls. 

Note: \V/¡cn crcating a 1110\'ic tol>c l'Ú'\\'cd tlm)//g/1 3D g/{lsscs ( anc red /cm and onc blllc /cns), 
sllijiing thc red clwnncl to thc lcji 11111kc.< thc inwgc drar l}{lck, ll'hilc shi(ting thc red clllmncl 
ta tl1c right lmngs thc inwgc(on,·nrd S111all shijis 11rc 1/SIIllll)' sufficicnt for COII.<idcmblc thrcc­
dilllcnsionlll cJTccts. 

·' 

V 
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Color Pass 

The Color Pass filler changes all colors in an image, with the exception of a single color, 

to black and white. 

To specify the. Color Pass settings: 

1 In the Color Pass Scttings dialog box, sclcct thc color that won't be convcrtcd to black or 

white bv clicking the color in the Clip Sample box, or by clicking thc color swatch to 

display thc color picker and sclect a color. ( For a dcscription of thc color picker, se e "Using 

the Premie re Color Pickcr" on page 141.) 

2 Drag the Similarity slicler to sclect colors similar to thc swatch color. Click Rcvcrsc to 

change only the sckcted color to black ancl whitc. 

¡- Eyedropper tool 
! 

O Colo! 

li.im1l<mly = ~ 

§~====3 
[J !.!_evmse 

3 Click OK to apph· thc filtcr scttings. 

Color Replace 

Output Sample 

Thc Color Rcplacc filtcr rcpl;lccs alloccurrcnccs of a sclcctcd color with a ncw color. 

To spccify thc Color Rcplacc scttings: 

1 In thc Color l~cplacL' Scttings ddog box. sclcct thc color to be rcplaccd by clicking thc 

color in thc Clip S;unplc box or lw chcking thc ·1;1rgct Color swatch to display thc color 

pickcr and sclcct a color. (For a dcscription of thc color pickcr, scc "Using thc Prcmicrc 

Color Pickcr" on pagc 141.) 

2 Sdcct thc rcplaccmcnt color h1· clicking thL' l~cplacc Color swatch to display thc color 

pickcr and sc!cct a color. 

__., -. 
/ 



3 Drag thc Similarity slider to select colors similar to the selected target color. Click So lid 

Colors to crcate an opaque rcplacement color. 

· · Color Replace Settlngs ,' · · , '· 

Clip Sample 

'" -~ 

~<"' --· 
~. .. ' . ~ " , 

~~~ T argel Colm 

• Aeplace Color 

~imilauly ,: ~ 

O S ohd Colors 

4 Click OK to applv thc filter settings. 

Convolution Kernel 

Output Sample 

OK 11 Cancel 

Thc Convolution Kernel filter changcs thc brightncss valucs of each pixel in thc imagc 
according lo a prcdcfincd mathcmatical opcration known as a convo/¡ttion. Thc Convolu­

tion Kernel Scttings dialog box dispbys a grid that rcprcsents a pattern of pixel brightncss 
multiplicrs; the so urce pixel is evaluatcd in the ccntcr of thc grid. 

To specify the Convolution Kernel settings: 

1 Choosc Filtcrs from the Clip mcnu, sclcct Convolution Kernel from the Available list, 
and click OK. Thc Convolution Kernel Scltings dialog box appears. 

' 

· . ·convoluUon Kernel Sealngs -:· >.: .;- ·'·' 

Convoluhon M ah•)( ~ ~Mise 

¡m 11-1 1 [!C]II otheo: Líí.O::=:J 
l-1 1 ¡s 1 1-1 1 · 

1 

\ Scale. 11 

)o \l-1 1~ ¡ 

\ !.oad.. 1 1 Save.. j ) OK j 1 Cancel 

2 Click thc ccntcr tcxt box, which rcprcscnts thc pixel bcmg cvaluatcd. En ter the valuc by 
which tu multiply that pixcl's hrightncss \·aluc. Valucs can rangc from +999 ro -999. 

3 Click a tcxt bm; rcprcscnting :111 :1diacc·nt pixel to which vou want tu assign a wcightcd 
valuc. En ter thc \·al u eh:· which I'OU 1\',llll thc adiaccnt pixclmultiplicd. For cxample, ifyÓu 
want thc· brightnc·ss ,-,duc· ofthc pixel tu thc nght ofthc curren! pixel multiplicd by 2, en ter 
2 in thc tcxt box to thc right ofthc ccntcr box. 

/ e 
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4 Repeat step 3 foral! pixels you want to include in the operation. You don't havc toen ter 

val u es in all of the text boxes. 

5 In the Scale text box, en ter the val u e by which to divide the su m of thc brightness valucs 

of the pixels included in the calculation. 

6 In the Offset tcxt box, en ter the valuc to be added to the rcsult of thc séalc calculation. 

7 Click O K. The filtcr is applicd to cach pixel in thc imagc, one al a time. 

Crop 

The Crop filtcr trims rows of pixels from thc cdges of a clip and automatically rcsizes thc 

trimmcd clip to its original dimcnsions. This can be uscful for trimming away noisc and 

pixel skcw that m:w result from overscanning during digitizing. Use thc slidcr controls ·lo 

crop éach cdgc of thc imagc separa te h-. '{o u haYc thc option of cropping in pixels or image 

. percentage. 

lf yo u don't want Adobe Prcmicrc to automatically rcsizc thc trimmcd clip lo its original 

dnncnsions, use thc Clip filler (dcscribcd on p:1gc 148) instcad of thc Crop f!ltcr. 

Crystallize 

The Crystallize filtcr crea tes a distortcd.mosaic pattcrn by dumping adjaccnt pixels into a 

sol id color in a polygnn shapc, orce/l. In thc filtcr's dialng box, yo u can sctthc ccll sizc frnm 

3 pixels to 999 pixels. 

Emboss 

The Emboss 11ltcr makcs an imagc appcar raiscd or stampcd br supprcssing thc color and 

tracing thc cdgcs with black. 

/ ·-
~· ::. 



Extract 

The Extract filter cxtracts a grayscalc mask from a video clip. Thc Extract Scttings dialog 

box displays a histogram and a preview of the grayscale mask. 

To extracta grayscale mask from a video clip using the Extract filter: 

1 In The Extract Scttings dialog box, drag the slidcr controls directly below the histogram 

to specify the gray levels of the so urce image that will be translated to white. Al! other arcas 

will bccome black. 

· . · Extract Settlngs.' - "-. : ·, . · · ··' ·' · 

Input Range: -~ lo ~ 

O !nverl 

1!_oftneu !SL~==3Jt ~ 

OK 1 Cancel 

2 Adiust the intcrmcdiatc shadcs of grav usin~ thc softncss control. 
' ...._ ' ...._ 

3 'To invcrt thc cffcct, click thc lnvcrt bulton. 

.. .• 

Thc display at thc bottom of thc dialog box shows thc mapping function that is bcing 

applicd to thc imagc to gcncratc thc mask. 

Field lnterpolation 

Thc Ficld lntcrpobtion liltcr rccrc~llcs a missing fi<.:ld (usually thc odd or cvcn sean lincs 

that havc bccn droppcd during imagc capture) b~· using linc avcrages. This filtcr can be 

uscful for full-scrccn output whcrc a missing 1\cld is likch· to be noticcablc. 

Filter Factory 

Thc Filtcr Factorv filtcr lcts you crea te your <Mn fdtcrs for use b1· Adobe Premicrc. For 

information on using thc Filter F.rcton·, scc "Crc~lling Custom Filtcrs" on pagc 163. 

Find Edges 

Thc Find Edgcs 1\ltcr outltm·s thc· cckes of a color imagc with colorcd lllleS ami outlincs 
~ ~ ~-

thc cckcs of a gra1·scalc imagc· with \\'hite linc·s. 
'-- ... ' '-

.· > 



Gamma Correction 

The Gamma Correction filter lightens or darkens an image without substantially changing 

the shadows and highlights. It does this by changing the brightness levels of the m id tones 

(the middle-gray levels) while leaving the black and white arcas unaffected. Thc dcfault 

gamma setting is 1.0. In the filter's dialog box, you can adjust thc gan1ma from 0.1 to 2.9. 

Gaussian 8/ur 

Thc Gaussian 13lur filter blurs an image by a large amount; the cffcct is similar to that of 

choosing the Blur or Blur More filters severa! times. ( Gaussian rcfcrs to thc bell-shapcd 

curve that is gcncratcd by mapping the color values of the affcctcd pixels.) This flltcr 

improves the quality of imagcs with sharp edges and can produce a hazy effcct. 

Gaussian Sharpen 

The Gaussian Sharpen filter sharpens an imagc by a large amount; thc cffcct is similar to 

that of choosing thc Sharpcn or Sharpcn rvlore lilicr severa! times. 

Ghosting 

Thc Ghosting flltct· ovcrlavs previous framcs of a clip with othcr transp<m;nt fr~m1cs to 

crea te a ghost-likc cffcct. 

Horizontal Flip 

The Horizontal Flip flltcr rcverscs thc imagc from lcft to right; thc clip still plays in a 

forward dircctioti. 

Horizontal Ho/d 

Thc Horizontal Hold liltcr sl;1nts thc clip from a vertical toa horizontal oricntation; the 

cffect is similar to adiusting thc horizontal hold on a tclcvision sct. Dr;lg thc slidcr to _, '- ..._ 

incrcasc thc clip"s slant. 

Hue & Saturation 

Thc 1-!ue ancl S;lluration liltcr adiusts thc llllc, saturation, .md lightncss of thc imagc. Drag 

thc slidcrs tn lll<lximizc or minttnizc l".lcil color componen t. i\s I"Oll dr;¡g thc sliders, thc 

prc,·ic"· of thc imagc in th,· di;dog bux changcs ·to rcfkct your ;¡djustmcnts. 



.. '- ·.:. ' . 

lmage Pan 

The Image Pan filter pans across images larger than the output frame size. Yo u can easily 

crea te rolling credits, or simula te the pan and zoom movements of a camera. Yo u can also 

use thc Imagc Pan filter to scale an imagc up or clown to match thc output frame size. 

Topan across an image using thc Imagc Pan filtcr: 

1 In thc lm<1gc Pan Scttings dialog hox, sct cropping rectanglcs lo define thc starting and 

cnding framcs of thc clip. Thc sizc am\location of cach cropping rcctanglc are shown 

above the starting and cnding framcs of the clip. Adobe Premicre thcn interpola tes the 

motion bet wecn these frames. 

2 Adjust thc sizc of the cropping rectanglcs by clicking the corncrs and dragging. 

Lelt e 'Width· ~ 

Top:C Height:0 

1 » Copy » j 

1 « Copy « 1. 

1« Exchg » J 

Cancel 

·OK, 

GJ End 

Lek D 'Width EJ 
Ton·~ Height.EJ 

O E ase Out 

·• 



3 Adjust the location of a cropping rectangle by clicking ií1side it and dragging. 

Lefl 0 \o/,dth: 11 GO -1 

Top:EJ Heighl:~ 

1 >> Copy >> 1 

1 « Copy ,·, \ 

!<< Exchg >> j 

r Cancel 

0 End 

Left: ~ Width. EJ 
Top:~ Height:~ 

O E ase Out 

4 Click OK whcn vou havc ími,hed making adjustments. 

Yo u can produce a zoom cffcct by van·ing thc sizc of thc cropping rcctanglc in thc starting 
and cnding fr~1mcs of thc clip. Yo u c1n produce a pan cffcct by placmg the cropping rcct­
anglcs at difkrcnt locations in thc· starting ami cncling framcs. lf thc source clip is large 

cnough, \'OU can sct thc· siz·.: of thc cropping rectanglcs to match thc output frame sizc 
without causing the program to intcrpolatc data (which can cause imagc dcgradation). 

lfi'Clll appk tlll' lm,Jgc·Pan liltcT without adJUSting thc cropping rcctanglcs, thc full framcs 
uf thc clip will he scdcd to thc output fr,mlc' oizc of thc mm·ic. lf the so urce clip has a framc 
size that i., smalkr than thc output ftamc si1.c, Adobe l'rcmicrc willusc intcrpolation to 

clcanlv su k thc· clip. Doing "' prm·idcs hcttcr ocaling th~111 QuickTimc Glll whcn it adjusts 
thc· sizc during thc· ;v1:1kc ,\Juvic· prn,·c·os. L;sing thc lmagc Pan liltcr this way is cquivalcnt 
tu using thc !Zcsi1.c tiltcr. 

lnvert 

!'he 111\·crt ti! ter ch~1ngcs cach cuior lo ito oppnsttc on thc color whccl. 



Lens Fiare 

The Lens Fiare filter simula tes the refraction caused by shining a bright light into the 

camera lens. Specify a val u e ( or use the slider) to indicate the percentage of brightness. 

Val u es can range from 1 O percent to 300 percent. Select a lens type, and click anywhere 

inside the image thumbnail to specify a location for the center of the fiare. 

Le veis 

The Levels filter manipulares an image's brightncss and contrast, and combines the func­

tions of the Color Balance, Gamma Corrcction, Brightness & Contrast, ancl lnvcrt filters. 

Yo u adjust the Lcvcls setting using a histogram in thc Levels dialog box. The x~axis of thc 

histogram represents brightncss values from darkest (O) at the far left to brightest (255) at 

the far right; thc y-axis represents the total number of pixels with that val u e. Thc darkcst 

pixels appear to thc lcft: the brightcst pixels appcar to the right. 

To adjust the brightncss and contras! using the Levcls filter: 

1 In thc Levels dialog box, enter valucs in the Input Levels tcxt boxcs, or drag thc slidcr 

controls directly bclow thc histogram to incrC<lsc (or dccrcasc) thc contras!. 

tnpullevel~ El~ !2551 

1.oad ... 

Q.ulput Levcls· lo 1l2ssl S ave ... 

1 OK 11 Cancel 

• To incrcasc thc shadows, drag thc black trianglc lo thc right. To dccrcasc thc shadows, 

drag thc rcctanglc to thc lcft. 
' ' 

• To incrcasc thc highlights, drag thc whitc trianglc to thc lcft. To dcCI·casc the highiights, 
drag thc trianglc to thc right. 

~ ' ' 

• To c1djust thc m id tones, drag tlll' grcn·tri;lnglc. 



2 En ter values in the Output Levels text boxes, or drag the slider controls at the bottom of 

the dialog box to reduce the contrast in the image. 

• To eliminate the darkest values in the image, drag the black trianglc to thc right. 

• To elimina te the brightest values in the image, drag the white trianglc to thc left. 

3 Click OK when you have finished making changcs. 

Mirror 

The lvlirror filtc1· rcllccts onc si de of thc imagc onto thc othcr si de, as though a mirror wcrc 

placcd along thc vertical or horizontal axis of thc clip. You can choose a horizontal or 

vertical mirror, and vou can choosc to rcllcct thc lcft, right, top, or bottom of thc image. 

Pinch 

The Pinch filter distorts an iinagc by stretching thc imagc toward thc ccnter from thc 

cdgcs. The filtcr's dialog box contains an option for sctting thc pcrccntagc of pinching. 

Pointillize 

The Pointillizc filter brcaks up thc color in an imagc. into randomly placcd dots (likc a 

pointillist painting) and uses a black background as a canvas arca bctwccn thc dots. In 

l'ointillizc dialog box, yo u can sct thc ccll sizc from 3 pixels to 999 pixels to spccify thc sizc 

ot" thc dots. 

Polar Coordinates 

The Polar Coordinatcs filtn converts a clip from its rectangular to pobr coordina tes ami 

vice versa. This filter can crc·ate a cylindcr anamorphosis, a type of art popular in thc !11th 

ccnturr in which thc distortccl imagc is dilf1cult to rccognizc unlcss viewccl in thc rcflec­

llon of a mirrored cl'iindcr. 

Posterize 

Thc l'ostcrize filtcr converts thc color spcctrum into a limitcd numbcr of colors and maps 

pixels in thc imagc to thc color that is thc closcst match. You can use this liltcr to crcatc 

largc, flat arcas in an imagc. :\s 1·ou clra!! thc slidcr in the filtcr's dialo<> box, thc small .... ..._ ' ...._, t'l 

pn:vicw imagc changcs lo rclkct 1·our adjustmcnts. 

Posterize Time 

Thc Postcrizc Time filter displavs a ncw framc al thc intcrval you sct in thc filtcr's dialog 

box to crea te a halt111g cft"cct as thc clip pb1·s, cffcctivel;•lowcring thc framc ratc. 



Radial 8/ur 

The Radial Blur filler produces a soft blur by simulating the effect of a zooming or rotating 

camera. Select the Spin blur method to blur along concentric circular lines, as if rotating 

the camera. Select the Zoom .blur mcthod to blur along radiallines. Yo u can drag the dot 

in the Blur Center box to change the origin of the blurring. Yo u can also set the Amount 

ofthe blur from 1 to 1000. With thc Spin blur mcthod, this value reflccts the degree of 

rotation; with the Zoom blur mcthod, this value reflects the intensitv of the blur. 

Replica te 

Thc Replica te filtcr divides thc screen into tiles and displays the whole image in each tile. 

Yo u can set the number of ti les by clragging the slider in the Repliclte Settings dialog box. 

Holcl clown the Shift kcy and clrag to adjust both sliders to the samc setting. 

Resize 

Thc Resize filter rcsizes thc image to the output frame size using intcrpolatcd scaling. This 

proviclcs better scaling than Video for Windows or QuickTime can achievc whcn it acljusts 

thc size cluring thc Makc iv!ovic process. 
- < 

Ripple 

Thc. Ripplc filtcr produces an undulating pattcrn on an image. likc ripplcs on thc surface 

of a pond. You can sclect a sine, circlc, triangle, or squarc for the wavc type, and adjust the 

intcnsity, ratc,_and width of thc wave shape using the sliders in the filtcr's dialog box. Yo u 

can also indica te thc dircction in which thc ripplc.should movc: Lcft. Right, In, or Out for 

thc horizonl<ll dircction .md Up. Uown. In, or Out for thc vcrttcal dircction. 

Rol/ 

Thc Roll filter rolls an imagc to thc lcft orto thc right, or up or clown, as if thc image wcrc 

on a cvlindcr. 

Sharpen and Sharpen More 

Thc Sharpcn ami Sharpcn l'v!orc liltcrs impnl\'c thc clarity of an imagc by incrcasing the 

contrast in acljaccnt pixels. 

Sharpen Edges 

Thc Sharncn Ed~.;cs liltcr llnds thc arcas in thc imagc whCI'c si\!nific.1nt color chanoes occur t ... '- '--' t:l 

and sharpcns thcm. 

Shear 

Thc Shc.n liltn dtstorts an inLtgc· .1\ong a Cll!'\'L'. Dr.t" thc band in thc middlc of thc dialoo ... ~ ;::-- 0 

box lo form <t cun·c· th.tt indica tes how )'Oll w.tnl tlll' imagc distortcd. You can adiust any 

point along thc curve. Sclcct ho11· to trc<ll arc;ts of thc imagc lcft undclincd by thc shcar: 

..... _ 

/ , .. 
l -
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• Wrap Around wraps the image to fill the undefined space so that the area is fillcd with 

content from the opposite si de of the image. 

• Repeat Edgc Pixels extends the colors of thc pixels along the edgc of thc image in thc 
direction specified. This crea tes a banding cffcct if the cdgc pixels are diffcrcnt. 

Solarize 

The Solarizc filter CITa tes a blend bet\\"een a negative and positivc imagc, crcating a "halo" 
effect. This cffcct is analogous to briet1y cxposing a print to light during dcvcloping. 

Spherize 

The Sphcrizc filter wraps an imagc around a sphcrical shapc, and is uscful for giving 
objects and tcxt a thrcc-dimcnsional cffcct. You can sct thc intcnsity (amount) from-100 
to 100. You can also sclcct thc direction in which thc cffcct is applicd: Horizontal Only, 
Vertical Only, or Normal (in all dircctions). 

Ti/es 

Thc Ti les flltcr breaks up an imagc into a series of tilcs. In thc filtcr's dialog box, yo u spccify 
thc numbcr of vertical riles m u want, thc maximum distancc yo u want a ti le to be offset 
from its original position, and how you want to fill thc arca bctwccn tilcs. You can fill 
arca with ,,·hite (thc background colo!'), with bbck (the forcground color), with an invcrse 
imagc, or with thc unaltcrcd im,lgc. 

Tint 

Thc Tint liltcr applic:; a tint toan imagc. To sckct thc tint color, click thc color swatch in 
the Tint Sctling;, dialug hox to di;,pb)· thc color pickcr. Set th<: leve! nfthc tint (from 1 lo 
100 pcrccnl) in thc liltcr's dialog hox. (!'or more information on thc color picker scc 
'"Using thc Prcmicrc Color Jlickcr" cm p.1ge ].j 1.) 

Twirl 

Thc Twirl filtcr rota tesan imagc around its ccntcr. Thc imagc is rotatcd more sharply in 

1ts cc·nllT th:1n .ll thc cdgcs. lnthc· fi!tcr's dialog hox, ;•ou cntcr thc twirl angk, ranging 
from -')99 to +':!99. 

Vertical Flip 

Thc Vntic·:d Fiip li!tcc· 11ips an imagc upsidc down. 

Vertical Hold 

Tl1l' \'nticil llold liltn semi\;, !he· clq' llJ"'·,¡rd: lhc cllccl ¡, si111ilar lo ;¡d_jusling thc ve······;¡\ 
hold 011 a tck\·J;,illtl scl. 



Video Noise 

The Video Noise filter adds a small amount of video noise to ·a clip. This can be useful 

when yo u want to visually blenda clcan still image or graphic with a video clip that 

has noise. 

Wave 

Thc Wave filter distorts an image to makc it wave-shaped. 

To specify the Wave settings: 

1 Choose Filters from the Clip menu, selcct Wave from the Available list, and click OK. 

Thc Wavc dialog box appears. 

Number of §.eneralors: 1~ 1 Type: OK 
~) S!ne 

Cancel 
M in. ... , C· !riangle 

'W aveleng!h_ ~ @O O Sguare 

Amplitude: o ~ 
Horiz. Verl. Undefrned Areas: 

.. ,. ~cale ~ 4 ~ 7. O \.1/!aP Around 

~) Aepeat ~dge prxels 
I3J Randomrze Qaramelers 

2 Specify the numbcr of wavc gcncrators, from 1 to 1 OO. 
... 

3 Specify the w;¡vclength .111d amplitude for the gcncrators. Thc ll'llvc/cn:;th is thc distancc 

from une wavc crcst to thc ncxt, spccil1cd by a val u e· from 1 to 9999 in thc i\·linimum and 

lvlaximum \Vavelength lields. Thc 11111plitudc is thc height of thc wave, spccified by a value 

from 1 to 9999 in thc i\·linimum ,¡nd Mc1ximum Amplitude lields. 

4 Sckct l~andomize if vou want :\do be l'remiere to randomly sclcct el 1·aluc that falls 

betwccn thc minimum cllld maximum wavelcngth ;md amplitucle valucs; othcnvisc, thc 

waves c1re of a uniform amplitude .md frequcnc1·. 

5 Sl't the horizontal and vcrticaiscak from 1 perccnt to 100 pcrccnt. Thcsc paramctcrs 

cuntrol thc lll<lgnitudc of thc distortion, both horizontally and vertical!¡-. Setting thcm to 

O givcs \'ou an undistortcd imagc. 
' . ' 

6 Selcct the typc of shape mu \\',llll the W<li"L'S to have: Sine (rolling). Triangk (pointed 

crcsts), or Squarc (squarc crests). 



7 Set the Undefined Areas option to select how portions of the image pulled into thc selec­

tion from the edges are treated. The V/rap Around option wraps the image to fill thc spacc; 

thc Repeat Edge Pixels option extends the colors of the pixels along the edge of the image. 

8 Click OK. 

Wind 

The Wind filter distorts an imagc to make it look as though wind were blowing pixels off 

the sur fa ce of the image.' Yo u can selcct the amount of distortion by selecting the Wind, 

Blast, or Stagger option. Yo u can also change the dircction of the "wind" to blow from the 

lcft or the right. 

ZigZag 

Thc ZigZag filtcr distorts an imagc radially. The Amount field reprcscnts thc magnitudc 

of distortion; en ter a val u e from Oto 999. Thc Ridgcs ficld rcprescnts thc numbcr of dircc­

tion rcvcrsals of thc zigzag from thc ccntcr of thc clip to its cdgc; en ter a \';lluc from 1 to 

999. Sckct an option to displace thc pixels in thc im;¡gc: thc Pund Ripplcs opt ion displaces 

pixels to thc uppcr lcft or lowcr right; thc Out From Ccntcr option displaces pixcli toward 

or away from the ccnter uf thc imagc; thc r\round Center option ro tates pixels around th 

centcr of thc imagc. 

i 



EFFECTS OF VARIOUS FILTERS 

Brightness & Contras! Camera Blur Clip Crop 

Emboss Extrae! Fmd Edges Gausstan Blur 

.; 

Ghostmg Homontal Flip lnvert Lens Fiare 

Wmd Pmch Pomtilb~ Posteme 

Rad1al Blur Repltcate Sharpen Shear 

Solartze Srmerize 

/~ 
'--' _ .... 



AUDIO FILTERS 

Audio filters control sclected frequencies and alter the overall sound of your audio clips. 
Adobe Premiere includes five audio filters: 

• The Backwards audio filter plays sound backwards. This filter ovcrridcs any filter 
preceding it in the Filters dialog box. An alterna te way to play a clip backwards is to sct a 
negative speed for thc clip. For information on setting clip speed, scc "Sctting thc Forward 

or Backward Spccd of <1 Clip" on pagc 95. 

• The Fill Left and Fill Right filtcrs allow vou to isolate the audio track to onc channcl 
L ' 

or another. 

• Thc Echo filter crea tesan echo effcct. Thc Echo Settings dialog box contains options for 
sctting the de la y and the intcnsity of the echo. Thc De !ay optionlcts vou control the lcngth 
of time bctwcen thc bcginni'ng of thc original so une! ancl thc bcginning ot its echo. 

• Thc Pan filtcr Cl·catcs the cffcct of sound moving fromlcft to right or right to lcft. The 
L L L 

Pan Scttings dialog box contains a slidcr to acljust thc "location" of the sound. 

CREATING CUSTOM FILTERS 

In <tdclitiol_l to thc m;tn~· filtcrs includcd w1tit i\dohc i'remiere, you can crc.ttc your own 
fdtcrs using tite Filtcr F.tctory. Yo u dctc:rminc· how yo u want thc liiÍ~r to aflcct thc ch;mncls 
(alpha, red, grecn, ancl bluc) of c.tch pixel in thc first imagc ami thc sccond image by spcc­

ifying arithmctic expressions. 

Thc filtcrs vou crea te can also includc a Sctting dialog boxcs. Thc Scttings dialog box 

providcs up to eight slidcrs for adjusting thc filtcr's cffcct. Whcn you dcsign a filtcr, you 

includc uscr-suppliccl slidcr informatiun in thc cxprcssion. You also determine thc 
numhcr of slidcrs ;md \\'hc·titcr tite·~- .1ppcar in thc Scttings dialog box individually or in 

pa1rs. 

Whcn vou e reate a filtcr, yo u can son·c its cxprcssions in a tcxt file. Doing so lcts yo u use the 
Filtcr Facton· to cdit thc filtcr latcr. 

Thc ncxt two proccdurcs npbin lww tu u"· tite Filtcr Factory to apply and savc filtcrs for 
use in ¡\dohc l'rcmicre. Fm ,1 complete discu"ion nf using :trithmctic cxpressions to 
.tclliCIT an ct't.cct, scc :\ppcnclix B "Exprc·ssions for Crcating Transitions and Filtcrs." Thc 

cxpn:ssions dcscribc·ci in :\pp·:ndix B :1rc u sed lw both thc Filtcr !'actor:· and thc Transition 
FJCtOI'\'. 

/. 
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To create a custom filter: 

1 In the Construction window, select the clip to which you will apply the filter. 

2 Choose Filtcrs from the Clip menu. The Filters dialog box appears. 

3 Select Filter Factory from the Available list and die k Add. The Filter Factory Settings 

dialog box appears. 

4 Spccify the cxpressions as follows: 

• To specify an expression in the alpha channel, select Single Expression ancl typc the 

expression in the A field. Thc evaluation of the alpha cha1mel expression will be applied to 

each of the other threc channels: R, G, and B. \Vhen the same value is applicd to each 

channel of thc pixels in an image, the imagc will be a grayscalc image. 

•• To spccify separare expressions for thc R, G, and B channels, make sure thc Single 

Exprcssion option is dcsckctcd and typc thc cxprcssions in thc R, G, and B 11clds. Evcn if 

you spccify thc samc·cxprcssion in all thrcc channcls, thcir cvaluations will probablv be 

differcnt. 

As you typc an cxpression, a small vcllow caution sign appcars. Jt will rcmain visible until 

yo u havc typcd a legal cxprcssion. If thc caution sign docs not disappear, it mcans that 

therc· is an error in the cxprcssion. Tose e which part of thc expression is in error, die k thc 

caution sign to selcct thc incorrect portian. 

5 If thc cxprcssions includc mcr-supplicd.sl!dcr infmm;l\ion, drag thc·appropriatc'Jv!ap 

slidcrs to prnicw thc elfccts. Thc J'vlap O slidns COITCSf'Ond to slidcrs O and l: thc f!ap l 

s\idcrs corrcspond Io slidcrs 2 ami 3; ami so on. For inl(,nnation onindudms uset'­

supplied slidcr information in cxprcssions, scc "Providing Uscr-Controlkd Sliders" 

on pagc 293. 

6 \>Vhen vou havc corrccth· sct up thc· 1\ltcr, click Savc to savc thc cxprcssions in a text file. 

Saving the cxprcssion allows :-ou to load and edit thc filtcr in thc futurc. The text file 

should havc thc samc na me as the liltcr. but savc thc tcxt file in a dircctory other than thc 

Adobe l'rcmicrc plugin,: dirccton·. 

7 If yo u want to use this onc inst;mcc of thc liltcr only, die k OK to apply thc filtcr. lf yo u 

want to use thc flltcr more than once, use thc ncxt proccdurc, "To savc a custom filtcr for 

additionalusc." 

To savc a custom filtcr for additionalusc: 

1 Follm'' stcps l through 6 uf thc prc,·ious proccdurc, "To crea te ;1 custom filtcr." 

2 Click Bu del. Thc Build Custom Filtcr clialog box appcars. 

1 



3 N ame the filter using the Ti tic field. The name will appear in the Available list of the 

Filters dialog box and in the title of the filter's Settings dialog box, if thcre is one. 

4 Use the Author ficld to include crcdits or copyright information in thc filtcr's Scttings 

dialog box. Delcte any information you do not want. 

5 1 f thc fil ter's expressions i nclude user-supplied slider informa tion, sclcct thc appropria te 

numbcr of Slidcr or Map options and specif)• la beis for the sliders in thc corrcsponding 

tcxt boxes. The labels will appcar with the sliders in thc filter's Scttings dialog box. 

To display thc slidcrs individually in the Settings dialog box, use thc Slider options. To 

display thc slidcrs in pairs, use thc Map options. Whcthcr you should use individual or 

paircd slidcrs dcpcnds on thc typc of filtcr yo u are crcating. 

6 Click 01\:. A standard Savc dialog box appcars. 

7 Savc thc filter in the Adobe Premiere plugi11s dircctory. 

8 To make thc filtcr availablc to uscrs, rcstart thc Adobe Premierc program. 

To cdit a custom filter: 

1 In thc Construction window, sclect the clip to which you want to apply thc filtcr. 

2 Choosc Filtcrs from thc Clip mcnu. Thc Filtcrs dialog box appéars. 

3 Sclcct Filtcr Factory from thc ;\vailablc list ancl click Aclcl. The Filter Factory Scttings 

di<liog box appcars. 

4 Click Load. Use thc Opcn dialog box to load the tcxt file containing thc filtcr's cxprcs­

sions. You must ha\"C s.l\'cd thc cxprcssions in a tcxt file whcn you created thc filtcr to be 

ablc to cdit it. 

5 Follow thc s\L'ps in thc prc·\·ious two procc·clurcs to cdit and rcbuild thc filtcr. 

/_ -
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CREATING MOTION 

Adobe Premiere lets you define a path along which a clip can m ove in the movie frame. 

Yo u can define a motion path for any movie or still-image clip. You begin by creating 

points on a motion path; then you can choose from severa! motion options for each point 

on the path. 

Note: Adobe Premierc uses subpixelnzotion. This positions mz imagc in incrcmcllts of 
1/256 pixels, resulting in extreme/y smooth znotiorz and rotation. 

To define a motion path for a clip: 

1 Selecta clip in the Construction window. 

2 Choose Motion from the Clip mcnu or from thc Construction \\'indow pop-up mcnu. 

The Motion Settings dialog box appears. 

In the top lcft corner of the dialog box, a samplc of the selected clip appears as it m oves 

along thc clcfault motion path. Thc dcfault path has only Start and Finish points. 

~ Play button r Start pomt 

i 
¡· F1msh point 

1 

.Load ... 

Saye ... 

i 
" 

O ~howAII 
O ~hnw !]ullrncs O Show tdlh 

1±1 
Center 

OK 

Cancel 



3 Set points on the motion path using one of the following methods: 

• l'vlove the Start and Finish points. 

• Position the pointer anywhere on the motion path. The pointer turns into a pointing _ 

finger. Click to add a point to the path, and drag to adjust its position on the path. Whcn 

you release the mouse, thcpoint is sclcctcd and you can add options to thc sclcctcd point. 

• Click abovc the timclinc. 

Adjusting points on the motion path 

Once ;·o u ha ve crcatcd cach of the points on thc motion path, yo u can sdcct and adjt 

cach point:s position. 

To selcct a point on thc motion path, use onc of the following mcthods: 

• Click a point with thc lingcr po:ntcr. 

• Prcss thc 'L1b kc,· to sckct succcssi,·c points from thc Start to finish posit.ions along thc 

motion path. Hold clo"·n th,· Shift kLT ;111d prcss ·r;¡b to 11lO\'C from point to point in thc 

oppositc d:rcctlon. 

Note: I(n t,·xt Cllfi'J' /1ox is nct il'c in thc Mot ion Scttings dialog lmx, prcssing '[¡¡/¡ will highliglu 

succcssin· tl'X! /Jo.\cs mtliLT tlu111 sl'icct succcs.<il·c motion points. 

To adjust thc positioning of a point on thc motion path: 

1 Sclcct thc point. 

2 Use onc of th,· fol!m,·i:'S mctlwds to adj;:st thc point's position: 

• Prc·ss an ;IITO\,. kc,· to mo\'C thc sdcctcd point 1 pixel al a time in thc dircction 

o(thc a:To\\·. 

• Huid down thc· Shift Le,· ,tnd prcss ;m ;t:Tow kcy to mo\•c thc point in )-pixel incrcmcnts. 

• En ter wordin,:tcs íor thc point's position in thc Info licld bclow thc timclinc. 

/ 



To center the image·frame ata point on the motion path: 

1 Select the point. 

2 Enter the coordinates (0, O) for the point's position in the Info field below the timeline, 

or click the Center button to Jet Adobe Premiere enter these coordina tes. 

To copy the motion settings from one point to another point: 

1 Select the point from which you want to copy the settings. 

2 Press Ctrl+C. 

3 Select the point you want topaste scttings to, and press Ctrl+V. 

To delete a point: 

Select thc point, and prcss Deletc. 

Observing the effects of motion 

· Thc motion scttings 'liT '1pplicd to thc s,1mplc in thc upper-lcCt comer oC thc fvlotion 

Scttings di,dog bo:-:, lctting ~·o u sec the scttings' ciTccts immcdiatcly. 

Yo u can a !so nrcvicw thc motion scttinos bY dra<n•ino throuoh thc orav bnr be lo\\· thc· timc-r t:> , t'>;::"J ,:-. o e , 

linc. To .observe thc dkcts Cor spccilic points nlong the motion pnth, click thc Pause button 

ncxt to thc motion thumbn,lil and click a point on thc gra:· bar bclow the timcline. You 

can also use thc s~acebar to start and pause thc prcview. Chck Show Al! to see the othcr 

video tracks in your movic includcd in the pr·evicw. 

.. 
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Changing the speed of motion 

Points that have been added to the motioí1 path are represented on the timeline bclow the 
path. The length of the timeline represents the duration of the clip. The rclative spced of 
motion between path points is dctermined by thc distancc betwcen points a long thc timc-

_line. Adjust thc spccd by dragging points closcr together or farther apart along thc timc­

linc. 

T1me '1------------'---11 IL • 

1 

•. -~ j 
c_ _______ __,tc_ _____ .-cnCc:.l OccO.:c?l:_,'=J' - Time md1cator toggle 

;_ __ Time mdicator 

Tlic time indic1tor next to thc timclinc displ;l)'S the time sctting for thc selcctcd point in 
onc of two \\'.tvs: 

• If vou set thc bluc time indicatoi"togglc so that thc two arrows touch,-thc time shown i, 
where the point occms, mcasmed from thc beginning of thc clip. 

• If \'OU sct thc toggle so that thc lii'O arrows are scpar.!lcd, thc time shown is whcrc the 
point occurs, mcasurcd from thc bcginning of thc projcct in thc Constructiot" window. 

Specifying motion options 

Tlm sccti;,,1 describes how to use the· i\1otion Scttings dialog box to spccify movcmcnt 

options a long a clip\ motion path . .-\n imagc can be rotatcd, distortcd, and zoomcd in or 

out along thc path. 

:\dobe Preminc distribute' thc cl't'ects of mo\'Cillcnt options betwccn 'uccessivc points 011 
thc motion p;!lh. Fui· cxampk, supposc ,·ou ha\'c a motion path with succcssivc points ¡\, 
B, ancl C. l'o111t .\has a rot.nion scttlllg of O dcgrccs; jlOint !\has a rot;llion sctting of 90 

degrces; ami pomt e hc1s ,1 rut;llJon sctting ufO dcgrccs. The clip is oricnted atO dcgrccs al 
point .-\. Thc cli¡• rotales 90 ,Jcgn:cs clockwtsc as it mcwcs betwccn points A ancl B; thcn it 
rota tes 'JO dcgrL'CS countcrclockii'ISL' as it 11)(1\'CS bctwccn points B <lllci e to n:turn to its () 

Jq;rcc uricntation. 

/ .. -
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To set movement options for a point on a path: 

1 In the Motion Settings dialog box, click to selecta point where it falls on the timeline or 

along the motion path. 

2 Choose from the following options: 

o Rotation. Determines the angle of rotation for a clip ata specific point. The angle can 

range from -1440 degrees to 1440 degrees, resulting in up to eight full rotations of the clip. 

The clip begins toro tate as it moves from thc preceding point on thc motion path toward 

thc sclcctcd point on thc motion path. Use the tractor trcad slidcr control, or typc in an 

anglc for thc rotation. 

O ~howAII 
O Show Q.ut!ines O Show !:ath 

O !smoolh Mohon liJ 
Alpha· ® U se f.lip's _ 

. Ü C1eate new 

lr--------=~,-----""',o·,---. --,/1 
T•me f-' ------,-'-------1 Üo-~015..:.:_ 

D1slmtion 

- Oc!ay slidcr 

-- Zoom sl1der 

· -- Rotation slider 

b_oad ... 

S ave ... 

Center ·' 

Res el 

OK 

Cancel 

• Zoom. lncrcascs or dccrcascs thc SIZL' of ~~clip ,1t ,1 spccific point on thc motion path. 

Adjust thc zoom k1·clusing thc tractor trcad slickr control or bv t1·nin<> in~~ 1·aluc between 
· '- ' , t V 

O pcrccnt and 500 pcrccnt. 

o Dcl~1~·- Clllscs a cli¡' lo pause for an amou11t of time 011 thc motio11 path. To sct a dcla\', 

use thc tractor trcad slidcr. :\ hluc· bar anncars 011 thc timclinc, indicatil1" thc kn<>th ofthc t t ;:. ;:, 

dcla:·. A pcrcc11tagL· ~-~duc for thc dcla1· (rclati1-c tu thc tot~d clip duration) appcars ncxt to 
thc slidcr. 
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• Motion. Achieves smooth motion when zooming by speeding up or slowing clown 

movement where necessary. If the clip's motion is zooming from small to largc, sclect 

Acceleratc. If the clip's motion is zooming from largc to small, sclcct Dccelcratc. 

• Dislortion. Dislorls lhc imagc al a poi ni along lhc mol ion p:11h. Urag lhc four cornn' 

of the thumbnail imagc in lhc distortion bo.'\ to dcí1nc thc dislortion. 

U~howAll 

O Show Ou!ltn't:s O Show E_ath 

O [srnooth Mollon 1 ±l 

Alpha. ~)Use .f.\ip's 

~·-·-·- // . . 
. . 
. 

// ····• 

,hoad ... 

Saye ... 

Centc1 

(j Crct~tc !!_ew 
r'----------;:;--------=:----, 1 Resel 1 ¡ "'''' T t l b~:~Ü 15 ,.¡ ¡_:=~_! 

F>ll Colm- ?==::;::;==.===;e=,::==='===;=====~=~ 
1 1 Cltcf.. on d poml dbo ... c 

___ ..J ] lnt··· 1-!1 1 ~ ~: D 1-2 Dtst01llon 

· 1''" ·,•,-:n I<JI.:~I:f:¡_;¡:t;¡;¡¡;fl.L_j · ~ 
~ [ ="·'" l<ll•''"'::ct·lJ;:,qr>¡iliiol 1 ---- -·-''··-··-· 
,IJJ.W!I)I ¡.,, l<li '•' 1 ' ' • : ,f[>!ll!._l:. .;: 1 OK l 
1 

1 
¡
1 

•' ':r,-: lltnc.1t !iJ / Cancel 1 

Otstortmg the image 
<lt il point 

·¡¡, spin a dislortcd imagL' :m1llnd a Cc'IliL'r point, hold down thc t\lt kc;• and position tlw 

po111tcr on a corncr point: thcn drag lo spin thc imagc around a ccntcr point. 

Dtslot tiOtl 

To mm·c all four corncr poinb al once, p<lsttion 1hc pointcr in thc ccntcr of 1hc imagc. 

Ot,lo! trnrt 

• Rcsct. RL·movcs thc dist<lrtion, dcl:1\·, r<llalion, :1ncl z0om scttings for a sclcctcd point. 
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3 Set the following motion options that apply to all points on the path: 

• Fill Color. Specif1es a background color for the moving clip. To selecta background 
color, click the desired color on the thumbnail in the Fill Color box (the pointer turns into 
the eyedropper too! when it is on thc thumbnail), or click the color swatch above the 

thumbnail to access the color picker and choose a color. 

• Smooth Motion. Smooths thc path along which the clip tra\·cls. This option smooths 
sha rp cha nges in el i rcction, rotation, a nd d istortion. Yo u can control thc smooth ncss of thc 
path by choosing an option from thc clrop-downlist. TheSmooth ivlotion option providcs 

thc smallest amount of smoothing; thc Averaging-High option providcs thc grcatcst 
amount of smoothing. 

• Alpha: Use Clip's. Supcrimposcs a clip using its cxisting alpha channcl. This is ¡he 
normal setting for titlcs or graphics crC<ltcd in anothcr application that has alpha channcls, 
such, as Adobe Ph~1tnshop. This option will onh· affcct clips th<lt havc bccirassigncd an 
Alph<l Kcy Typc in thc Transparcncy Scttings dialog box. 

• t\lph<l: Crc,lll" Ncw. Cn:atcs <ln opaque fill for clips that do not h<lVC an cxisting <lipha 
channcl. With this option sckcted, an alpha channcl is crcatcd in the shapc of ihc clip as 
it mm·cs. This option onl)' affccts clips that havc bccn assigncd an alph<l kcv tvpt' in the 
Transparcnn· St.'ttings dialog box. 

Note: Clu>o>n>¡; tiH' Crcutc Nc\\' op1Í011.fin·tl!l Íl)!ti!,:C contoining 1111 o!plw clwnncl O\'Crll'ritcs 

tl1c ori¡;inul ulplw clunznc/ 11'/zcn tlzc znw¡;c i:; :;upcrinzpMcd. 

• Sho"· :\11. DispLn-s tht' ima¡:L· ,dong thc motion path as it would be compositcd in thc 
Construction windo,,·, including tr<lnsitioiL. filtcrs. and transparcncy scttings. Note that 
thc motinn thumbnail will not play as smoothh· with this option sclcctcd. 

·~. 



• Show Outlincs. Displays an outline of each frame along thc motion path. 

• Show Path. Shows thc motion po1th m more c!ctail. Al! points bctwccn thc kcy framcs 
(representcc! as small squarcs) are shown as c!ots along thc motion path. Sdecting this 
option makcs it casier for you to check the motion path, especial!;· at points whcrc thc 
motion accelcratcs or dccclcratcs. 

Saving, loading, and deleting motion settings 

'{ou can use the Savc anc! Load buttons in thc Motion Settings dialog box to ,savc thc 

motion scttings vou crcate for a Clip for latcr use with othcr clips. Motion scttings a 
applicd \9 en tire clips; thc\' cannot he applicd toa limitcd numbcr of framcs of a clip. 

To 1Tl110\'e all motion scttings o1pplicd toa clip, click Rcmove in thc Motimi Scttings 
el ialog box. 

Note: :\cloliC JYrc111icrc iuc//1(/cs <1 se: o(nu>lion {hltlzscttings, ¡¡·{uch <1rc contniucd intlzc 

Illlltion su{,dir,·ctOJT in tl;c :\cloh· !':c/1/icrc dm·ctor;: 
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CHAPTER 7: CREATING SuPERIMPOSITIONS 

AND TITLES 

~k ... .j,~ his chaptcr explains how to superimpose movie and still-imagc clips. It also 
,~;¡~ j1!..j describes how to use Adobe Premiere's Title window to crea te titlcs ancl graphics 
1§1o.:.,_j~] fGr a movic. The Titlc window lcts you crea te clips with typc. Titlc clips can be 
superimposcd to crea te titlcs and crcclits that pbv over othcr clips. 

SUPERIMPOSING CLIPS 

Thc proccss of supcrimposition, callee! kcying in tclcvision procluction and nwfling in film 
oroduction, incorpora tes various mcthods of playing a clip ovcr ancithcr clip. Yo u makc 
arcas of thc top clip, callee! thc s11pcriniposcd clip, transparcnt to allow thc bottom clip (or 

background clip) to show through. Adobe Prcmierc crcatcs transparcncy in thc supcrim­
poscd clip in a varicty of W<JVS, from blocking out portions of thc clip ( crc.1ting ,Jmattc) to 
spccifving rangcs of color to be transp<lrcnt. 

' Clips that you want supcrimposcd can go on any ofthc supcrimposc (S) tracks in th 
Construct1on winclow. Clips that you w,111t playing undcrncath go on tracks A or B, 
alignccl wÍth the clips on thc S tr<lck. Adobe Prcmicrc constructs süpcrimpositions by f1rst 
asscmbling thc clips on tracks A and B, including any cffccts on thc transitions (T) track, 

and thcn supcrimposing thc chps on thc S tracks onto thc asscmblccl clips. Clips on thc S 

tracks are sCipcrimposcclln numcriul ordcr ,¡s thcy appcar in thc Construction winclow. 
Thus, clips on highn numbcrcd S tracks are pLn•cd ovcr clips on lowcr numbcrcd S tracks. 

Once vou place a clip on an S track, mu can spccit\· thc parts of thc clip that you want tn 
makc transp<lrcnt usins thc Tr.lllSp.lrcnc\· Scttings d!alog box. 



To superimpose a clip: 
. ' 

1 Drag the clip from the Project window to an S track in thc Construction wmdow. 

1 

END END 1 END END 

2 Sclcct thc clip on thc S track. 

3 Choosc Transparcncy from thc Óip mcnu. Thc Transparcncy Settings dialog box 

appc~n·s. 

··. • ' · . · · ' -Transparency Settlngs '·;;· ;:<:· ·~:>. ,,,,: .. _,, ":· :\ 
MaMe ....... ·· · ·- · ··-·-·Color ··--... 

f.hoose... J 

D'D 
fey lype: ll!:fí\jtf i.~i!"'t!®! •J 

..... 

Sample-

1 {¡,. 

l. 
END 

O l!•op ~;h<~dnw 

LJ ~.d !tul.,. 

' 

~muolhin!r !Nnne j &.) 

o~ 1 Cancel 

Thc first framc of thc clip appcars in thL· Sampk box in thc uppcr-right corncr of thc dialog. 

box. For sillnc kcy \\·pes thc fr,tmc \\"ill also ~1ppc~1r in thc color swatch. 

Note: llccnuse tite cf/L-ct:o o({//n)iitcrs npplicrl to tt clip are tlispinrcd in tite han.<¡>nrcncy 

Scttin~:o rlinlog /Jox, fiitcr:o can :ololl' tiz,· di:oplrt)' o( tite rlinlog />ox con:oirlcml,fy. f(po.<:oi!Jlc, sclcct 

tmnspnrcncy sctting:olnforc npplringfiltcr.< lo n supuÍIItf'OScd clip. 

.• 



4 Choose a key type from the Key Type drop-down lis t. For an explanation of key t) 

see "Selecting a Key Type for a Clip" on page 179. 

s Choose one of three options for the way the background appears in the Samplc box: 

• Set thc background to black or whitc by clicking thc black-and-whitc icon bclow thc 

Samplc box (continuc clicking to togglc bctwccn whitc and black). 

• Set the background to checkerboard by clicking the checkerboard icon (click ag;tin to 

reverse the pattern). 

• To scc the actual background imagc in thc sample imagc, click thc pagc pecl icon. 

P.Jge pecJ ICOn 

6 Spccify the arcas of thc clip to be transparc.nt by adjusting thc scttings for thc sclcctccl 

key typc. For a dcscription of thc scttings, scc "Making Kcy Typc Adjustmcnts" on 

pagc 186. 

For incrcascd control in adjusting transpan:ncy scttings, use the zoom and hancl tools 

locatcd bclow thc Samplc box: 

• To zoom in on the samplc imagc, sclcct thc zoom too! ancl click thc imagc. 

• To zoom out, Alt+élick thc Jmagc with thc zoom too!. 

• To rcposition <1 closc-up vic\\· of thc imagc in thc S;1mplc box, use thc h;lllcl too!. 

lQS ' · 198 ,., •. ' ' ' 

· Sample · .. Sarnplc 

·- Zoom tool !..___ Hand tool 



• To show the sample imagc at actual sizc, double-click the zoom too! icon. Thc plus or 

minus sign in the zoom too! appears asan outline when the image is being vicwed at 

true size. 

• To fit the sample image in the Samplc box, doublc-click the hand too! icon. 

When you have selected the zoom too!, holding down the spacebar selccts the hand too!. 

Likewise, yo u can select the zoom too! while the hand too! is selected by holding down thc 

Ctrl key (to zoom in) or the Alt key (lo zoom out). 

lf the clip is a movie clip, use the slidcr under the Sample box to scroll through thc clip and 

scc thc cffcct of thc transparcmy scttings on cach frame. 

7 Click OK to apply the transparency scttings. 

Creating a garbage matte 
With all key types, Adobe Prcmicre allows yo u to crea te a gnrbngc mnttc, which blocks out 

arcas cif the clip to be transparcnt. Thc underlying clip shows through thc blockecl 

out arcas. 

To crea te a garbage matte: 

1. Sclcct thc clip for which yo u want to crcc1tc thc gctrhagc mattc, and choosc Trcmsparcncy 

from thc Clip mcnu. Thc Tr;tmpctrcnc:• Scttings dic1log box c1ppc.ns. 

2 Crea te thc sh;lpc for thc gctrhagc mattc by dragging thc handlcs in thc corncrs ofthc clip 
in thc· S.ttnplc ho~. 

~ey typc -~ --------~~ 

/ .- ·,-
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3 To make the areas outside the garbage matte transparent, select the Reverse Key option. 

4 Click OK. 

i\-íOl'IC croppcd /¡y 
f_!Jlrbagc ll!llf~C 

Note: Gnrlwgc 111/lllcs do not n1ovc ¡¡•ith clips th11t huvc 111otion sctting,; npplicd to t!Jclll. 

For 111oving nwsks, tl1c Twck Mnttc kcy typc ¡,; rccOIIIIIJCIIdcd. 

Selecting a key type for a clip 

Adobe Prcmicrc providcs 15 kcy (supcnmpose) options that can be applied toa clip on an 

S trae k. Thc kcy n·pc determines what part of t.he image is "keyed out," that is, wbat part 

of thc imagc is madc transparcnt. Although all ke;· types are dcscribcd in this scction, ti 

cffccts of se1:cral kc;· typcs are best displa;'C(l in color and are illustratcd in Chaptcr 10, 

"Tips ancl Techniqucs." 

Non e 

Thc dcLndt kcv typc is Neme. ,\t thi., setting, no p:1rt of the superimposcd image is kcycd 

out. Hmwvcr, ;·uu c.1n sct thc UJ'.lcitl· uf thc supcrimposcd imagc bv :1djusti1.1g thc Fadc 

control bcncath thc clip on thc S track. You can also use the Nonc kcy typc for crcating 

garbagc malles. For more· infurmation on thc· Faclc control, scc"i\djusting thc lntcnsity of 

a Supcrimposcd Clip" on p:1gc ]¡)7. 

Chroma 

Thc Chron1:1 kc·,·t;·pc allows vou to sckct a color ora range of colors in thc clip to be trans­

parcnt. Use thc· c;·cdroppcr too! tu sl'icct a color from thc imagc, or click the color swatch 

to sckct from thcn1lnr pickcr. lisc thc Similarity slidcr to sclcct the rangc of similar colors 

to be kc·1-cd out. Fur more· informal ion on choosing a color, scc "Sclccting a Color to be 

Tr.lilsparcnt" on p.1gc· !S/. Fn1 .m c':\,llll]'k of using thc Chroma kc·v tvpc·, sce "Supcrim­

~10SII1~ Fi_surc.-. :\g.1i11st a B.h:k_sJound'' 011 p;1gc 256. 

·• 



RGB Difference 

Like the Chroma key type, the RGB Difference key type lets you select a color ora range 

of colo~s that will beco me transparent in the clip. The difference betwcen the Chroma and 

RG B Difference key types is that the Chroma kcy type lets yo u adjust the color and the gray 

values of thc superimposed pixels indepcndently, while the RGB Difference key type 

adjusts these components together. Use the eycdropper too! to selecta color from the 

image or click the color swatch to select from the color pickcr. Use the Similarity slider to 

sclcct a rangc of similar colors. For more informatio11 011 choosi11g a color, see "Sclccti11g 

a Color to be Tra11spare11t" 011 page 1 87. 

Matte .. Color 

_Ghoosc.. 1 -CJ 
,!ley type: 

Mat1e 

Lhn!H!', j 

D 
Similarity = 16 

r=lif-====3 
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U Ucvt·l~t; •:t:\' 

n Drop 5hadow 
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Luminance 

The Luminance key type lets you key out the imagc's gray values, while retaining its color 

val u es. Use the Threshold and Cutoff sliders to adjust the shadows and definition of detail 

in the image. For an example of using the Luminance kcy type, see "Adding Texture to 

Movies" on page 255. 

Alpha Channel 

An nlp/1(1 chmmcl is an invisible grayscale channel assigned toan image, oftcn used for 

creating masks that isolate part of thc image. The Alpha Channel kcy typc lcts yo u supcr­

imposc an image by kcving out the black areas of an image's alpha channel and making thc 

whitc arcas of thc alpha channcl opaque. Yo u can sclcct thc Reversc Kcy option to rcvcrsc 

(invert) the alpha channcl. 

Thc Alpha Channcl kev typc does not crcate an alpha channel in an imagc .. \Vhen you 

crea te titlcs, Adobe Prcmicre automatically crcatcs an alpha channcl. '{ou must crcatc the 

alpha channcl in othcr applicltions with that capability, such ;¡s Adobe Photoshop. Scc 

your <lpplication's user documcntation i'or an cxpbn;ltion ofhow it e reates ;1lpha channcls. , 

If your imagc has a srmight alpha channcl, use thc Alpha Channcl kcy typc. If your im;1g1 

contains a prcn¡¡¡/tipl!cd alpha channcl, use cither thc White Alpha Mattc or !3lack Alpha 

ivlattc kcy t)·p~s bcc,Jusc thc :\lpha Channcl kc,· t\'Pc can cause a whi·t·c or black halo 

around thc imagc. (You can tcll thc diffcrcncc bctwecn straight and prcmultiplied alpha 

channcl imagcs beca use a straight imagc may havc somc blockiness whilc a prcmultiplicd 

imagc ll'ill not.) :\n alpha ch;lnncl supcrimposition crcatcd on ;1 black or whitc back­

ground (for namplc, titlcs on a ll'hitc background) works best whcn using thc !3lack 

Alph;l Mattc or \Vhitc :\lpha /ví;lttc kcv t\·pc. 1\11 Adobe Prcmicrc ti tic has a prcmultiplicd 

alpha channcl. 

1' 

·• 



The following illustration shows an Adobe Photoshop still image with a gradation (b!cnd) 

in the alpha channel. The gradation in the alpha channel causes the image of the douds to 

fade as the gradation darkens. The area where the alpha channel is salid black is trans­

parent. The area bccomes less transparentas the gradation blends to 50-percent gray, and 

it beco mes opaque where the gradation is either less than or equal to 50-percent gray or 

all white. 

Sti/1 imngc n·ith gradar ion 111 

thc alplw dulllllcl 

Matte -

!:honse ... J 

Gmdcuion i11 alphn clumncl 

u D 
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Black AlphaMatte 
Choose the Black Alpha Matte key type to superimpose an image that contains an alpha 

channel and that has been crcatcd on a black background. (Note that Adobe Prcmicrc 

automatically e reates alpha channels for titles.) The Black Alpha tvlattc kcy typc climi na tes 

the remnants (halo) of black around the edges of the foreground imagc. lf the Black Alpha 

Mattc kcy type does not produce satisfactory results, try the Alpha Channcl kcy typc. 

------- Matte Color · Sample -

\ Chno~ ~~... 1 

1 1 

White Alpha Matte 

Choosc: thc \Vhitc: .-\lph.r i\btlc' kc·' t;·pc to supcrimposc: ;m imagc that contains an alpha 

channcl and that has bc:c:n crc:cllc:d on ;¡,,·hile' b.1ckground. (Note that ¡\dobc Prcmicrc 

automc1ticalh' ere·.¡ tes cdphc1 cL.lt11lc'b Cor titks.) Thc: \Vhitc ,\lpha ivlattc kcy typc climi­

naks thc rc:mnanb (halo! o l. "·httc: .1mund tlw cdgc:s of thc forcground imagc. This typc 

1 
1 1 

·• 



of matte is useful for superimposing titles that ha ve been created on a whitc background .. 

If the White Alpha Matte key type does not produce satisfactory results, try the Alpha 

Channcl key type. 

· ' . Transparency Settings · . · 

····· Matte ·· ·· ····~· Color···- ···-· ·-···-··--·· Sample 

Chootc... ( 

DD 
\Vhirc Alplw hlmte kcy t_rpc sclccrcd 

lmage Matte 

Thc lmagc l\Ltttc kcy typc lets you pi<ly thc movic through a still imagc pi<lcccl on top of 
thc clip on thc S track. Once you ha ve choscn thc imagc, it is displayccl in thc Mattc 
samplc box •1nd in thc Samplc box (combincd with thc supcrimposccl clip) to show how 
thc kcy typc aflccts thc supcrimposcd clip. To sclect an image for thc m•lttc, click thc 
Clwosc button in thc M•1ttc samplc box and use thc Opcn di<liog box to opcn thc fdc you 
w,1nt to use. 

· ' · '· · ··•. · · ·. Transparency Setllngs e,."'": '' · • ·,. "•, 

Matte Color 

:choo:ce ... --·,; ""' ¡' 

. . . 
---~.-·.J~_·c ·.:.J••.· ·:· F.;;r, .. 
·"''. ';, . -

" . 
END 

!;,ey type_ llmage lotdtle 

-- Background un<~ge of doud~ 

appeilrmg through 1magc matte 



Difference Matte 

The Difference Matte key type kcys out thc identical areas of two clips and rctains thc 
difference. For example, if two frames contain identical backgrounds but onc of the framcs _ 

contains an image in the center of the frame, only the image in the center of thc framc is 
retained. To select an image for thc difference mattc, click Choosc in the rvlattc samplc box 

and use thc Open dialog box to opcn thc clip you want to use. 

Mattc · 

!;_ey lypc ID•IIeu:nce Malle 1 !) 

Simil¿jrity ;" 9 

§]======= .... 
. ··-· , .. 

8/ue Screen and Green Screen 

----!·-'+-ti- Clip cont.1ining 

[J D._cverse Kcy 

O Q.rop Shddow 

D M_,u.l:. Onl_y 

OK 1 Cancel 

D1fference Mattc 

The !3lue Screcn and Creen Screcn kcy types are uscd on imagcs with truc chroma bluc 

and truc eh roma grcen backgrounds. :\ftcr choosing thc dcsircd kcv tn>c, drag thc Cut off 
slidcr lo thc· ¡·ight untilthe contr~1st inthc f"rcgrouncl im~1gc st.1bilizcs; thcn drag thc 
Thrc·,holcl slider tothe lcft untilthc· hlue or grccn background is tr;1nsp;1rent. To adjust thc 
tightncss of the kc:·, drag thc Cutnt't' and Thrcshold slidcrs an cqual distancc to thc lcft. If 
thc h.1ckground is hlccding thrcJugh, lll<J\'C thc· Cutoff slidcr to thc right. 

'- .... ... '-

. .; 



Chronza blue is a so lid blue containing little or no red or green and corresponds approxi­

mately to PANTONE" 2735. Chroma green is a salid green containing little or no redor 

blue and corresponds approximately to PANTONE 354. 

Multiply 

The Multiply key type keys out the areas of the superimposed image that are lighter than 

the underlying image. Use the Cutoff slider to control the opacity of thc resulting super­

imposed image. For an example of using the Multiply key type, see "Crcating a 360-Degree 

Prcscntation" on pagc 266. 

S creen 

The Screcn kcy typc lightens the areas of thc undcrlying image that are lighter than the 

superimposed image. Use the Cutoff slider to control the brightness of the underlying 

tmage. 

Track Matte 

The Track Matte kev typc uses the clip on the next S trae k of the Construction window as 

a tilattc. A track mJtte can be crcatcd from a moving or still imagc. A track matte created 
" from moving images is callee\ a tmvcling mnttc. For an example of using the Track Matte 

kcy type, sce "Playing a Movie Through a Traveling lvlatte" on page 262. 

NotRed 

The Not Red kcy typc is designcd for use wi.th imagcs that ha ve green or.blue backgrounds. 
' lt is similar to thc 13lue Screcn and Creen Screen key types, but its Blend slider lcts you 

crea te scmitransparcnt objccts and hclps reduce fringing around the edges of nontrans­

parcnt objccts. It works especially wcll with grcen backgrounds. 

Making key type adjustments 

Once yo u ktvc sclcctcd a kcy t y pe i"or thc clip. yo u can adjust thc t:!Tcct oi" thc kcv and sclcct 

othcr options associatcd with that kc>· typc in thc Transparcncy Scttings dialog box. 

Controb and optiom are gr;t)•cd out ii' thcv .trc· not ;tvaibblc i'or thc sckctcd kcy typc. 

• Thc Simibrity slidcr lcts yo u sclcct a rangc oi" colors to be transparcnt. To sclcct a range 

of colors similar to thc onc in thc color s\\·;Hch, drag the Similarity slidcr bctwecn None 

ami High; thc highcr thc Similaritv sctting, thc hroadcr thc range of colors in thc sc\cction. 

• Thc Blcnd slidcr smooths sh;np tr;tnsitions in color b1· crcating a gr;tdual changc in 

opacity in thc pixels bctwccn thc two colors. 

• Thc Thrcshold slidcr kts mu .tdiust thc anwunt or shaclow in a supcnmposcd clip. 

• Thc Cut off sliclcr lcts yo u adjust thc shadow dctail with the luminance and eh roma keys. 

•. 



• The Reverse Key option allows you to revérse the transparent area (for example, from 

the area inside a matte to the area outside a matte). 

• The Drop Shadow option applies a 50-percent gray shadow slightly below and to the 

right of thc transparent portian of the clip. 

• The Mask Only option crea tes a black-and-white or grayscale mask from the trans­

parent portiqn of the clip. This option is uscful when yo u want to cxport a clip to thc 

Adobe Photoshop program for retouching with its paint tools or when you want to scpa­

ratc the kcy channel from the image channel. 

·• The Smoothing option cr·eatcs soft cclgcs whcrc color transitions occur throughout thc 

supcrimposcd clip. Choosc from Nonc, Low, and High. 

Selecting a color to be transpárent 

Thc Chroma, RGB Diffcrcncc, and Differcnce Mattc kcy typcs define a color or rangc of 

colors as transp~ucnt bascd on thc color yo u sclcct in thc color sw~llch In thc Transparcncy 

SettiiH!S dialog box. Use onc of thc following mcthocls to sclcct a color: ..._, ..._ '-

' 
• To selcct a color from thc clip, use thc slidcr in thc Samplc box lo scroll through thc el" 

until :·ou scc the color you want. Position thc cursor ovcr thc dcsircd color in the frame 

shown in thé color swatch (the cursor cl"iangcs toan cyedroppcr), aJÍCl click lhc color. Thc 

sclccted color appcars in lhc swatch abovc lhc color swalch. 

• To sclcct ~1 color using thc color pickcr, click lhc color swatch. Thc color pickcr appcars. 

Sclect thc color you want, ancl click OK. For instructions on using thc color pickcr, scc 

"Using the Prcmicre Color !'Jckcr" on pagc 141. 

Adjusting the intensity of a superimposed clip 

Thc Fadc control al thc bottom of thc S lrack lcts you adjusl thc inlcnsilv of a supcrim­

poscd clip. Fading in makcs lhc supcrimposcd imagc more visible, whilcfruling out makcs 

thc imagc lcss visible. Yo u c1n al so adjust thc g~1in of thc en tire supcrimposcd clip without 

ch.mging an\" of thc kvcl <lcljustmcnts vou havc madc lo the clip. 

To adjust thc fading: 

1 Position thc pointcr ovcr thc top linc in thc Fadc control panel at thc bottom of thc clip 

on thc S track. Thc po111tcr changcs toa pointing fingcr. 

2 Click to crea te .1 hancllc la hlack dot), and drag thc handlc up or clown to acljust thc 

facling; e reate as mam· handlcs as nccdcd. Whcn thc h<lllcllc is at thc top oC thc Fa de contr· 

panel, thc supcrimposcd im~:gc is fui!:· visible; whcn thc hancllc is at thc bottom of thc 



panel, the superimposed image is invisible. The Info window displays the Fade Leve! of a 

selected han die as a pertent opaque ( 100 percent =opaque). To delete a handle, drag it out 

of the S track. 

Fade control area 

{¡y,-. 

[1[ 

0000.::1-l .¡. 
3::0 :• ,?.!1)- .:..\pl,¿, 

Fad.; L.:-\·el O;. 
1r, oooo:;: Out 0001·17 

~,;,;;,:;¡¡¡ Cursor at O 00 OO· 26 

Thc linc bctwccn two handlcs indica tes thc dircction, lcngth, and spccd of thc fadc. Thc 

stecpcr thc anglc, the more suelden thc change in intcnsity. 

3 Adjust the opacity between two points by choosing the fade adjustment too! from the 

extended tools pop-up menu in the lowcr left corner of the Construction window and 

dragging the line segment up or down. When using thc selection too!, you can also choose 

thc fade adjustmcnt too! by holding down thc Shift kcy. The opacity of the superimposed 

clip can be set Ío a constan! value b)' adjusting thc Fade control in this manner befo re 

crcating handlcs. 

4 To makc a cut in thc Fadc control, clwosc thc fadc scissors tool from thc extended tools 

pop-up mcnu in thc lowcr left corncr of thc Construction window and click the Fa de 

control. Doing so CITa tes two handlcs right ncxt to cach othcr. This is uscful for making 

adjustmcnts that sharply incrcasc or dccrcasc thc lcngth and spccd of thc fadc ata point. 

/.::;; ... . r 



To adjust the gain of a superimposed clip: 

1 Select the clip in the Construction window. 

2 Choose Gain from the Clip m en u. The Leve! Control Gain dialog box appears. 

3 Entera value from l percent to lOO percent. 

4 Click OK. 

Previous adjustments made to the Fade control do not change. 

Adding a background matte 

Adobe Premiere lets you create a full-frame mattc of a salid color that can be used like a 

clip. This fcature is useful, for example, if yo u want to superimpose moving tilles 

over a solid-colorcd background. (For instructions on crcating a background matte, 

see "Creating Background Color Mattes" un page l 04.) 

CREATING TITLES 

You create type and graphics in Adobe Premiere's Title window. Ti tic clips can contain 

typc, straight lines, and various geomctric shapcs. Yo u can supcrimpose ti tic clips to' te 

titlcs and crcdits that play ovcr othcr clips. Adobe Premicre automatically assigns anti­

aliased alpha channels to tnx~ and graphics generatcd in the Ti tic window. 

Whcn the Titlc window IS active, thc Ti tic mcnu appcars in thc m en u bar. Thc Ti tic m en u 

contains options rclatcd to typc and objccts drawn in thc Ti tic window .. You can set addi· 

tional opl ions for l he Tille wi ndow b~· choosing Tille \Vindnw Oplions from lhc Windows 

mcnu or lw clicking lhc righl nwusc hullon on lhc Titlc window tille b.1r. 

Whilc crcating graphics in thc Tille wmdo\\·, vou ha ve thc option nf vicwing a framc from 

a movie or still imagc ,¡s a background. You can 1hcn use thc background to position titlcs 

or sclcct colors using thc c1·cdroppcr lool. 

/ ,_.. . 
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To crea te a title: 

1 Choose New > Title from the File menu. The Title window appears, and the Title m 

appears in the menu bar. 

Object color swatch 

Shadow color swatch 

Opac1ty controls -

Blend swatch 

Shadow control 

· · · · · · · · · · ' · ' ' · ' · · · · · ' · · · · · · · · ' ··--+"'11- Title safe area 

:-l:...:¡j- Motion safe area 

2 Use the typc and object tools to crea te thc type and drawings you want in the titles. 

information on using thcse tools, see "Creating Type and Objects in ti~ e Title Window' 

page 195. 

3 Choosc Savc from the file mcnu to savc the clip. 

4 Hold clown the Ctrl key and drag thc clip from the Title window directly into the 

Construction window. Alternatively, you can import saved title clips into a project by 

using thc lmport command in thc file mcnu. 

Using the Title window toolbox 

Thc Title window toolbox contains tools and controls for crcating and editing type a1 

objccts. To use a too! for a single opcration, click thc too! in thc toolbox; to use a too! 
more than one opcration, doublc-click the too!. 

·< . 



Title Window Toolbox 

Selection tool 

· This tool selects an object ora block of text. Use 
the Shift key in conjunction with the selection 
too! to select mult1ple objects. The selection too! 
turns into a res1ze pomter when positioned over 
a point on a selected object. 

Eyedropper too! 

Th1s too! changes settmgs in the Title wmdow 
based on the attributes of an object or of a 
selected color in the background. Chck any ob¡ect 
or shadow to assign its color, transparency, and 
gradient f1ll attributes to the object color swatch 
Option-click any object or shadow to assign 1ts 
attributes to the shadow color swatch. Cllck a 
pixel anywhere on the background to selecta 
color from the background image. 

Type too! 

This too! creates type and lets you edit text. 

Line tool 

This too! draws straight line segments. 

Rectangle tool 

Th1s too! draws rectangular shapes Click the 

fi!led (nght) s1de of the rectangle tool to draw a 
fdled rectangle. Click the left side of the rectilngle 
to draw a framed rectilngle. 

Polygon tool 

This too! draws polygons. Click the filled (right) 
side of the polygon too! to draw a fdled polygon. 
Click the left si de of the polygon too! to draw a 
framed polygon. Draw the polygon one side ata 
time, clicking to define the end points of each 
straight lme segment. To complete the polygon, 
pos1tion the cursor over the first point and click 
when a small circle appears next to the cursor. 
You can also double-click at any po1nt to com· 
plete the polygon. 

Rounded rectangle tool 

· This too! draws rectangles with rounded corners. 
Click the filled (right) s1de of the rounded rectan­
gle too! to draw a filled rounded rectangle. Click 
the left side of the rounded rectangle to draw a 
framed rounded rectangle. 

Oval tool 

Th1s too! draws oval shapes. Click the filled (nght) 
side of the oval too! to draw a filled oval. Click the 
left side of the oval too! to draw a framed oval. 

Draft mode check box 

This check box is selected if you want to work 
w1thout prev1ewing color and opacity gradients, 
wh1ch enables fas ter redrawing of type and 
objects in the Title window. This option does not 
affect the quahty of the actual tille clip. This 
option can also be selected or deselected using 
the accent ( · ) key 
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1 [8] [illl Kerning tools 

These tools (visible only in type edit mode) let you add or remove space between twci characters 
or between multiple characters in a selected type block. Ctrl-click the kerning tools to remove any 
previously applied kerning. 

Line weight slider 

This slider (not visible when you are editing type or filled objects) lets you adjust the line weight 
of a framed object. 

Color swatches 

TI1e object color swatch (upper left square) d1splays the color of the currently selected object; the 
shadow color swatch (lower right square) displays the color of the selected object's shadow. 

Shadow offset control 

This controllets you positiOn a shadow in relation to its object. The shape of the control reflects 
the type of object selected. To remove a shadow, drag it out of the control area. 

Gradient controls 

These controls let you crea te color and opacity gradients across objects and shadows. The start­
ing and endmg colors of a gradient are represented by the small color swatches. Opacity set11ngs 
for thé starting and endmg p01nts are posted above the respective color swatches: A preview of 
the grad1ent appears m the box below the color swatches. 

Opacity sliders 

These sliders pop up when you click the small black arrows above the start and end color 
swatches. They control the opaCity for the startmg and ending points of the gradient and the 
uniform opacity of a salid fill. 

.• 



Setting up the title area 

Options for setting up the drawing area of the Title window in elude setting the drawing 

size, selecting a background color, using NTSC-safe colors, and identifying thc pcrimeter 

area of the Title window that m ay not show up on a television screen. 

As a guidc for positioning titles and graphics, you can view a framc from a movic clip in 

thc Titlc window. The frame does not beco me part of the title clip; it is used as a posi­

tioning guide only. You can, however, use the eyedroppcr too! to lift colors from thc 

displayed frame. 

To use a clip frame for title positioning: 

1 Set markcr Oto the framc of the clip you want displayed in thc Titlc window. If no 

markcr O is sct, the in-point framc is displaycd. For information on sctting markcrs in 

clips, see "Setting Place Markers for Clip Alignment" on pagc 72. 

li ·· : Clip: Finalbow.avl (1 J 111 

2 Drag thc clip from thc Clip or Projcct winclow into thc Titlc window. Thc markcd frame 

is displaycd in thc Ti tic window. 

3 Ecmovc thc framc from thc Titlc window b)' choosing Rcmovc Background Clip from 

thc Ti tic mcnu. 

Note: h>11 wn clulllgc t/¡cfiwnc displaycd in tite Ti tic windol\' /Jy sctting a IIClv lllarkcr U [01 
tilc clip. Thc ncwly nlllrkcd(mlllc wi/1 autonwtically appcnr in thc Tille willilol\'. 

·• 
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To select options for the drawing area: 

1 Make sure that the Title window is the active window. 

2 Choose Title Window Options from the Windows m en u or click the right mouse bu 

on the Title window title bar. The Title Display Options dialog box appears. 

3 En ter the following settings and options: 

o Drawing Size. Sct thc sizc of the drawing area from 60-by-45 pixels to 2000-by-201 

pixels. In general, the size of the drawing area should be the same·as the output size ·' 

the Output Options dialog box. However, this is not critica!, as Adobe Premiere will: 

the title to match the output frame size. Note that if the 4:3 Aspect Ratio option is sele. 

you en ter just the width or height; thc program updates the other dimension to mail 

a 4-to-3 width-to-height ratio. 

o Background. Selecta background color for the title clip by clicking the color swatc 

display the color picker. (For information on selecting colors, sce "Using thc Premie1 

Color Picker" on page·l4l.) Yo u can also choose to make the background color opaqt 

transparent. The default background is transparent; the background will be keyed 01 

you apply thc Alpha Channel key type. Choose Opaque from thc Background settin~ 

makc thc background opaque. 

Note: \A,I/¡ctl tilc Titlc windo1v is actil'c, yo u CtJII se/ tilc /)(]ckgrolllul color to blnck orwilitc, 
tilc ~cyboarrl by prcssing B for block or Wfor wilitc. .• 
o .Safe Titlc Area. Beca use a picturc tube on a tclcvision scrccn is gcnerally over-scan 

images may be partially truncated or lost when output lo videotape. You can use the S • 

Safe Titles option to sec thc arca in which titles ::md objects are protected from parti:1 

truncation. 

: :..-~ Motion safe 

Tille sale 

o NTSC Sak Colors. Sclect this option lo restrict colors in the Ti tic window to NTSC- · 

colors. NTSC-safc colors are thosc acccptable for tclcvision rcproduction, preventin~ 

ovcrsaturatcd colors from blccding across telcvision sean lines. 



Creating type and objects in the Title window 

This section describes how to crea te type, rectangles, ovals, polygons, and straight line 

segments in the Title window. It also describes how to crea te color and opacity gradients 

. across type and graphic objects. 

In Adobe Premiere, a geometric object is either framed or filled, but not both. Yo u can, 

however, create the illusion of a framed and filled object by creating two separa le objccts 

and having the program align them for yo u. 

Thc Ti tic window enablcs yo u lo crea le typc. Yo u can modify typc using commands from 

the mcnus or tools from thc toolbox. Type is trcated as a fillcd object and cannol be 

convertcd toa framed objcct. You Glll anima te typc by applying motion scttings toa titlc 

clip in the Construction window. For more information, see "Crcating Motion" on 

page 166. 

To crcatc framcd and fillcd objccts: 

1 Crea te a framed or fillcd object using a drawing too! in thc toolbox. Click a point in thc 

Titlc window and drag lo crea te a framcd or filled object. Hold down the Shift kcy us you 

drag to constrain an oval toa circle, a rcclanglc lo a squarc, ora linc loan incrcmcnt of 

45 degrces. 

2 Click an objccl to sclccl il, lhcn me lhc swalchcs and lools in lhc loolbox lo adjusl 

thc color, opacity, or shadow. For informal ion on using lhcsc tools, scc proccdurcs la ter 

in 1his scction. 

3 Adjusl lhc !in e width of a framcd objccl using lhc Line Wcighl slidcr in lhc toolbox. 

Drag lhc sliclcr lo choosc :1 linc wcighl fm an objccl bclwccn 1 pixel and 16 pixels. 

' ~-. lme wcight slider 
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4 Toe reate a framed version of a filled object, select the object and eh o ose Crea te ·Fram. 

Object from the Title menu; to create a filled version of a framed object, choose Crea te 

Filled Object from the Title m en u. Adobe Premiere makes a copy of the object, converb 

to a filled or framed object, and alig11s it with the selected object. 

5 To convert a framed or filled object, choose Convert to Framed or Convert to Filled fro 

the Title me11u. 

6 To resize a selected object, position the pointer too] over a poi11t 011 the objcct and dr; 

7 To resizc sclected type, hold down the Ctrl key, position the pointer over a corner poi 

of the selectio11 area, and drag. To resize type toa particular point size, use the Title me1 

commands as described in the procedure "To adjust type attributes" 011 page 197.) 

To smooth a polygon object: 

Click an object that was created with the polygo11 too!, and choose Smooth Polygo11 fro 

the Title mc11u. 

To crea te type: 

1 Sclcct thc typc too!. 

~fl~fl~ 
j~ V'f V1 

• • 

2 Click in the Titlc window whcre you want the typc to bcgi11, and typc the desired tex. 

Yo u can edit typc in the tcxt cntry box by selecting the typc with the cursor, and then usi1 

standard cut and paste opcrations. 

3 Click outside the text cntry box when you h<we finished typing. 

Any color, transparcncy, or gradient scttings in thc toolbox are applied to the type. 

B:· def,ndt, newly cn:atcd typc· has no sh<Jdow. 

·• 
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To adjust type attributes: 

1 Select the typc too!, then clrag to select the type you want to acljust. 

2 Choose Font from the Title menu. In the Font clialog box, change the font. 

3 Use the Title menu commancls to change the type style, justification, and shaclow. The 

Title menu commancls provicle a variety of type styles ancl shaclows, inclucling an Emboss 

type style. 

4 To change the type size, choosc Sizc from the Titlc m en u ancl sclcct a point sizc. 

Yo u can holcl clown the Ctrl key ancl prcss thc Grcater Than (>) or Lcss Than ( <) kcy to 

in crease or clecreasc the point sizc in 1 -point increments. Yo u can also stretch ancl shrink 

type to change its sizc ancl aspcct ratio; for more information, scc thc ncxt proccdurc, "To 

strctch or shrink typc." 

5 To kcrn thc typc, click to position thc cursor bctwcen two charactcrs or drag to sclcct all 

of thc charactcrs vou w'mt includcd for adjustmcnl; thcn choosc onc of thc following . . 
oplions: 

• Click thc lcft kcrning toolto reduce spacing bctwecn charactcrs; click thc right kerning 

too! to incrcasc spacing bctwccn charactcrs. 

• 1-Iolcl clown thc Ctrl kn· and use thc Lcft and Right Arrow kcys to dccrcasc ancl incrcasc 

thc spacc bctwccn charactcrs. 

• To rcsct thc kcrning, hold clown thc Clrl kc1· ancl click cithcr kcrning tool. 

1
• kernmg tools 

6 "I(J changc thc lcading, hold clown thc Ctrl kcy and use thc Up and Down ,t\rrow kcys to 

incn:,lsc or dccrcasc thc lcading in !-pixel incrcmt:nls. 

.• 



Note: The selected font, type síze, and type justífication are applied to all typc in a text block. 
To mix fonts, type sízes, and type justífications, you must create more tharz one text block. 

To stretch or shrink type: 

1 Using the selection too!, select the type yo u wan t to stretch or shrink. 

2 Hold down the Ctrl key and position the pointer over a comer point of the sclected type. 

The selection too! turns into a type resize pointcr. 

3 Drag to stretch or shrink the selected type arbitrarily. Dragging the type also changes its 

aspect ratio. 

To center type or objects in the drawing area: 

1 Using the selection too!, select the type or object yo u want to centcr. If multiple text 

blocks or objects are sclected, they are centercd as a group. 

2 To centcr type or objects within the drawing area, choose either Ccntcr Vcrtically or 
Center Horizontally from the Title menu. 

3 To center type or objects horizontally in the lowcr third of the drawing area, choose 

Position in Lower Third from the Title mcnu. 

·Toe reate a shadow for typc or for an objcct: 

1 Select the type or objcct for which you want to create a shadow. 

2 Drag the Shadow Offset control in thc toolbox to determine thc position of the shadow. 

Hold down the Shifl key lo constrain lhe angle of lhe offset to 45-lkgrce increments. The 
offset coordina tes, given in pixels, are displayed above the control. 

3 Click the shadow color swatch in the toolbox lo selecta color for the shadow. 

No Sf••llvw 
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4 With the shadow color swatch selected, use the pop-up opacity sliders to adjust thc 

transparency of the shadow. 

• • 

RINGS 
• • 

5 Choose Shadow from thc Ti tic mcnu to sclect thc Single, Salid, or Soft option for the 

shadow. You can also select thc ncxt shadow style by Alt+clicking the Shadow Offset 

control. 

S111glc Sol11i S off 

6 To rcmovc the shadow for a sclcctcd objcct, drag the shadow control into thc center or 

outsidc of thc control box. 

To crea te a gradicnt fill across an objcct or shadow: 

1 Sclcct thc objcct you want to fill in thc Ti tic windo.w. 

2 Click thc objcct color swatch if \'OU want to crea te a gradicnt fill for thc objcct; click thc 

shadow color swatch if you want to crea te a gradicnt fill for thc shadow. Click the curvcd 

arrow bctwccn thc swatchcs to cxchangc thc objcct and shadow gradicnts. 

R 
Objcct color ~watch 

- Shadow color ~watch 
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3 Selecta starting color by clicking the left color swatch in the gradient controls to display 

the color picker. (For instructions on using the color picker see "Using the Pr~miere Color· 

Picker" on page 141.) Select an ending color by clicking the right swatch in the gradient 

controls. A preview of the gradient appears in the box below the color swatches. 

Right color 
swatch swatch 

Note: Yo u cm1 crciltc a Jull-spectrwn hlenrl by sclting thc gradiwt starting and ending colors 
to the smne color. Todo so, draga colorfrom cithcr gradicnt swatch to any of thc other color 
swiltchcs in thc toolbox. 

· 4 Change the opacity of the starting or ending point by clicking the small black arrow 

above the respective color swatch and dragging the opacity slider to the desired setting. 

·Opacity scttings for thc starting and cnding points appcar abovc thc rcspcctivc·color 

swatchcs. Opacity can van: betwccn O pcrccnt (clcar) and 100 pcrccnt. 

S Sct a common opacity for thc starting and cnding points of thc graclicnt (remove thc 

graclicnt) by clicking thc small bbck triangle bctwccn thc swatchcs ancl adjusting the slidcr 
control. 

6 Changc thc dircction of thc gradicnt (in 45-dcgrcc incrcmcnts) by clicking one of thc 

cight small arrows around thc prcvicw box. Thc gradicnt starts from thc location of thc 

selcctcd arrow. 

. .; 



Selecting and moving objects in the Title window 

You can select and move an object in the Title window by dragging it or by using the 

Tab and arrow keys on the keyboard. Yo u can also select m u! tiple objccts and movc thcm 

as a group. 

To select and move objects: 

1 Select objects using one of the following mcthods: 

• To selecta single objcct, click with the sclection too!. 

• To sclcct m u! tiple objccls, Shift+click wilh thc sclcclion too!. 

• To select all objects in the Title window, choose Sclcct All from thc Edit mcnu. 

• To sclcct objects in front-to-back ordcr, prcss thc Tab kcy. To sclcct objccts in the oppo­

sitc order, hold dci1m thc Shift kcy and press thc Tab key. 

2 Drag lhe object lo thc dcsirccllocation. Prcss thc arrow kcys to m ove thc objcct in 1-pixcl 

increments in thc arrow dircclion. Hold down the Shifl kcy ancl prcss thc arrow kcys to 

movc the objcct in S-pixel incrcmcnts in thc arrow dircclion. 

3 To ccntcr a sclcctcd objccl in thc dr<lwing arca, choosc Ccntcr Horizonlally or Ccntc1 

Vcnically from thc Ti tic mcnu. 

4 To ccntcr a sckctcd objccl horizontal! y in lhc lowcr third of lhc clrawing arca, choosc 

Position in Lowcr Third from lhc Ti tic window. 

Changing the arder of layered objects 

By dcfaull, mulliplc objccls in lhc Ti tic window are laycrcd in lhc ordcr in which lhcy wcrc 

crcatccl. Yo u can changc thc ordcr of lave red obiccts by sclccting an objccl ami choosing 

Scnd lo Back or Bring lo Fronl frum lhc Tille mcnu. 
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CHAPTER 8: COMPILING AND 

VIDEOTAPING MoviES 

hen you have finished assembling and editing your clips in the Construction 
window, yo u can play your movie on your computer monitor or NTSC screen, 

compile your movie into a self-containcd Video for Windows or QuickTime 
movie, or output the movie to videotape. 

This chapter provides information that will help yo u make movies of the highcst quality. 
It explains how to compile your clips into a Video for Windows or QuickTime movic and 
how to use thc Print to Video command lo play movies and record them lo viclcot;¡pc. lt 
also explains how to crea te a mo\·ic by linking shorter movies together. 

COMPILING A MOVIE 

Clips in thc Construction window do not bccomc a sclf-containcd Video for \Vindows or 
QuickTimc movic until you compile thcm into a Video for Windows or Quick'f-imc file 
using thc ivlakc i'vlo\·ic command. 

Aftcr a movi-e is compilcd, vou can play it on your computcr scrccn er import itinto othcr 
applications that support Video for \Vindows or QuickTimc. Thc quality of your finishcd 
movie depcnds on a numbcr of factors,such as thc typc of imagc comprcssion yo u use, thc 

framc ratc al which you out pul the movic, and thc spccd of thc computcr systcm uscd to 
play thc movic. 

lf !'OU uscd thc i'vliniaturcs command or ll;1lch Capture window to cn:atc a set of smallcr 

clips to work with whilc constt·uctlllg your nwvic, youmust rcplacc thc smallcr clips with 
thc original clips bcforc compiling thc movic. For information on this proccclurc, scc 
"Making J\·liniatures to lmprovc· Performance" on pagc 41. 

Bcforc compiling :·our movic, make sure th.11 you have cnough disk space lo storc it. A 
Video i'or \Vindows or QutckTtnlc' nwvic Glll he ancxtt'l'mely brgc lile. 

.• 



To compile a movie: 

1 Make su re that yo u ha ve enough free disk space to store the movie. If yo u run out of disk 

space as the movie compiles, yo u will receive an alert and will ha ve the chance to make 

more disk space available or save all of the movie that has been compiled. 

2 Choose Make > Make Movie from the Project menu. The Make Movie dialog box 

appears. 

· · ' Make Movle ·· ·· • 

File N ame: 

ID 
Qireclories: 1 OK 1 
c:\premiere\project 
rr:::--,;-----.,-:,. j. Concel ·1 

-t ~e:\ , . 

B premiere 1 1 Nelwmk ... 
E:> project · 

• 
Orives:: 

c_ ______ .J..•;.¡ j ¡¡¡;¡ e: 

Make: \1/mk. Arca as AVI Movie 
Video 160 x 120@ 151ps 
Compressmn: "M rcrosotl Video 1" @ 75'.::: 
Aud1o. 22Khz- 8 brl -Mono 

Qutput Oplions ... ~ompression ... 

The current settings for output options and movie compression are dispbyed in the lower 

half of thc dialog box. 

3 To change the output options, click Output Options. The Project Output Options dialog 

hox .tppc·ars. (Output options <II"L' inilialh· set in the project presets. Thc options are 

describcd in "Selccting l'rujcct Output Opiions" on page 205.) Adjust the output options 

as dcsired, a!l(l click OK. The Makc Movic dialog box reappcars. 

4 To change thc comprcssion scttings, click Comprcssion. The Compression Settings 

dialog box appears. Comprcssion options are describcd in "Selecting Compression 

Options" on pagc 214. 

5 Typc a namc for your moYic, and click OK. A progrcss bar appears as thc movie 

compiles. 

To stop thc compila tion process, press the Ese ke\'. Adobe Premiere saves as m u eh of the 

movic as has bccn const ructcd. 



When compiling a movie, Adobe Premiere issues a warning if the available disk space 

drops below the Low Disk S pace Warning Leve! set in the General Preferences dialog box. 

The warning lets yo u switch to the File Manager to make more space available, or to stop 

the process and save the portion of the movie that has been compilcd so far. l f yo u ignore 

the warning, yo u can continue compiling, but yo u risk running out of disk space. 

lf yo u sclcct thc Bccp VVhcn Finishcd or thc Opcn Finishcd Movic options in thc Project 

Output Options dialog box, thc program bccps or opcns thc movic in a Clip window whcn 

it finishcs compiling and saving the movic. Plav the opcn movie using thc controls in the 

Clip window or by using the Print to Video command. For more information on the Print 

to Video command, sec "Using Print to Video'' on pagc 219. 

SELECTING PROJECT OUTPUT OPTIONS 

Thc Project Output Options dialog box lets you spccify how thc movic is compilcd. You 

use thcse options lo spccify the out pul file typc, which part of the Construction window 

to compile, the im<lge sizc, <llld the audio sampling rale. 

Output options are initially set by thc projcct prcsct, which yo u eh o ose whcn vou 'e reate 

thc project. You probably won't necd to changc thc project output options unlcss the 

in tended use of the movic has changed. For more information on clwosing a presct, sec 

"Sclccting a Project Prcset" on page 28. 

To set project output options: 

1 Choosc Output Options from thc Makc mcnu, or click Output Options in thc Makc 

Movic dialog box. Thc Pr'ojcct Output Options dialog box appcars. 

• ·· Projed Output Optlons •· ·:. 

.Q.ulput. jWmk. /'ued 

-- -[J Y.ideo 

' 

~IZC §Jh @Dv 

: lJ'pe jFull Size Fldme 

O Qeep when hnuhed 

@ Opcn Fmuhcd Mov1e 

1±1 '" IAVI MovH! 

D é.ud10 · · 1 

[J 4 3 AsQecl 

' 
: 

! ±] 
[01mal juDit-Mono 

!i ot e "12"'"2-k-H ,-------,1-,iJ J 

L!l 1 

T ypc 1 Uncomprcucd L!J 1 

-- __ I!J j ' tntclle,wc j1 Second 
·····--- -· ·-- --- ------ ----

Cancel 

2 hom thc Output drop-down list, sclcct wh1ch part of thc Construction window to 

compile: En tire Projcct to compile C\"Cr~·thing in thc C:onstruction window, or Work Arca 

to compile onh· thc scgmcnt undcr thc vcllow work arca bar. 



3 Select the output file type from the drop-down list in the upper-right comer of the 

dialog box. For more information, see the next section, "Selecting the Output File Type." 

4 Specify video output options in the left si de of the dialog box. For more information, 

see "Selecting Output Options for Video" on page 207. 

s Specify audio output options in the right side of the dialog box. For more information, 

see "Selecting Output Options for Audio" on page 209. 

6 Click OK. 

Selecting the output file type 

You can choosc from scven oulpul file typcs in lhe Output As list. 

AV/ Movie 

The AV! Movie option genera tes a movie file in the Microsoft Video for 'vVindows .nvi file 

formal, which is compatible with any software that supports this forma t. 

QuickTime Movie 

The QuickTime Movie oplion generales a movic file in the QuickTimc for Windows .mov 

file format, which is compatible with any software that supports this forma t. 

· Filmstrip File 

The Filmstrip File option genera tes a Filmstrip format file that can be opened and modi­

fied in Adobe Pholoshop. The file vou open in Adobe Photoshop is.a single file containing 

all the framc·s of the movie. Filmstrip files are uncompressed and m ay require l~rge 

amounts of disk spacc. For more informalion on Filmslrip files, sec "Modifying Filmstrips 

in Adobe Photoshop" on page 106. 

Autodesk FLC!FL/ 

Thc i\ulodcsk FLC/FLI option generales an Aulodcsk Animalor (.jlc or f/i) file. The 

Anirnator file is a single file conlaining all lhe frames of lhe movie, which can be opencd 

in any ~mimalinn applicalion lkll supports lhis file forma t. 

Bitmap Sequence 

The Bilmap Sequen ce oplion generales a series of bitmapped ( .b111p) files, one for each 

frame of the tinalrnovic. The files are nurnbercd scquentially beginning with lhe number 

01. which is appendcd lo thc tilcnamc (for cxamplc,jí/cOJ.bmp,filc02.bmp, and so on). 

Numbcred bitmapped files can be imported into olher applications that may be unable to 

accept Video for Windo\\'s or QuickTimc movics. 

/ 
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Targa Sequence 

The Targa Sequence option genera tes a series ofTarga (.tga) files, one for ea eh frame of the 

final movie. The files are numbered sequentially, beginning with the number 01, which is 

appended to the filcname (for examplc,filcOI.tga,filc02.tga, and so on). 

TIFF Sequence 

The TIFF Sequen ce option genera tes a series ofTIFF (.tifJ files, one for cach frame of the 

final movie. The files are numbcred sequentially beginning with the numbcr O 1, which is 

appcnded to the filename (for examp!c,filcOJ.tif,filc02.tif, and so on). 

Selecting output options for video 

The Project Output Options dialog box lets yo u spccify the dimensions of the movie 

frames whcn output and how the fields are captured. 

Size 

The Size fields determine the height and width (in pixels) of the movie framcs when . 

output. lf the 4:3 Aspect Ratio option is selccted, you en ter only the height or width and 

the other field is updated automatically. Note that larger images usually result in l-cduce.--1 

playback rates if yo u don't ha ve a board with hardware compression. Vlith larger imagc 

you m ay noLKhicw normal plaving specd when playing the movie.on your computer or 

recording it on videotape. Increasing output size also increases the file sizc of the final 

movie. The aspect ratio of the Preview window is automatically detcrmined by the propor­

tions of the video output frame. 

4:3 Aspect Ratio 

By default, the dimcnsions of th<: movie frames are constrained to the standard analog 

video width-to-hcight ratio, or aspcct mtio, of 4 to 3 (width = 4; height = 3).lfyour orig­

inal clips wcrc captured from analog video, changing thc 4:3 aspcct ratio will distort the 

image; or if the movic is latcr played on analog video, changing this ratio will cause the 

analog video image to be distortccl. 

Type 

This sctting should match thc way vour vidco display board processcs NTSC or PAL video. 

Lea\;C this sctting at Full Sizc ha me if your board do es not process the separa te ficlds in an 

NTSC video frame. If your board proccsscs full-framc, 60-ficld video, selcct the proper 

ficld dominance for the board, cithcr Ficld 1 or Field 2. For more information about field 

1 ami ficld 2 dominancc, scc thc· nc·xt scction. 'Tul! f'icld l'roccssing of Clips." 

Ifrour clips wcrc capturcd with diffcrcnt capture boards, your projcct may contain some 

clips with ficld 1 dominancc and somc with fidd 2 domínance. 

1; 
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Full-field processing of clips 
Field processing is an issue when you're working with full-framc (640-by-480 pixels), 

60-field NTSC or 50-field PAL video. You should specify how Premiere processes the fields 

for a specific clip when you're changing the speed of a clip, exporting a filmstrip, or 

freezing on a video frame. 

Each frame of NTSC video contains two fields, onc containing odd sean lincs and thc 

other containing even scanlincs. Most NTSC video is ji c/d 1 dominant. This means that 

thc odd f!eld precedes the evcn ficld in the dcsignation of the video frame. If thc ficlds are 

revcrscd, motion can appcar jerky. Somc video capture boards can capture with field 1 or 

ficld 2 dominance. Othcrs assume field 1 dominance. 

To set field processing options for a clip: 

1 Selcct the clip in the Construction window. 

2 Choose Field Options from the Clip menu. 

3 Set options for field processing as described in the following sections, and then click OK. 

Reverse Fie/d Dominance option 

This option ccvcrscs the ficld dominance of a clip so that it matches the field sJominancc 

uscd by your~video board, and is uscful ifyour clips weren't all digitized by the same 

capture board. Al! clips in a movie should havc thc samc field dominance. 

None opiion. 

This option turns off interlacing. 

Interface Consecutive Frames option 

This option converts consccutive framcs into intcrlaced ficlds ofvidco. ivlany animation 

applications don't considcr video ficlds. For smooth animations, use this setting to convert 

60 fps animations into 30 fps animations with two ficlds per video frame. 

Always Deinter/ace option 

This option convcrts thc interlaccd f!clds into framcs of video with no discernible fields. 

Thc video frames are gcnerated from an averaoc of thc ficld data, rcsultino in no in ter-
~ b o 

lacing or time offset. Yo u should sclcct this option if yo u are working with a freezc framc. 



Flicker Remova/ option 

This option elimina tes the flickering of thin horizontallines. When this option is not 

selected, a horizontalline of 1 pixel appears in only one of the two video fields, which 

results in flickering during playback. Sclecting this option blends each line with a 

percentage of the !in es above and bclow it so that a !-pixel high !in e appcars in both video 

fields. 

Deinterlace Fields When Speed is Below 100% option 

This option converts the interlaced fields into frarnes of video with no discernible f1clds 

.when the specd of a clip is reduccd. This option is selected by default. 

Selecting output options for audio 

The Project Output Options dialog box includes the three options for thc audio portion 

of the movie: 

Rate option 

This option determines the sampling rate for thc audio clips. Thc highcst frequency that 

vou can achievc in thc final audio output is cqual to half of the sampling ratc; for 'cxampln 

a 44kHz samplc rate is capable of producing a 22kHz frequency. Compact disc (CD) 

audio is sarÍlplcd ata 44 kl-!z rate. ·• 

The Format option 

This option sets the audio output to R-bit or 16-bit mono or stereo resolution forma t. 

The Type option 

This option lcts you choosc whethcr to comprcss thc audio. Choosc Nonc to !cave audio 

uncomprcssecl. Choosc !1"vl1\ ADPCM or lvlS-ADPC!v1 to comprcss audio using a 4:1 loss­

lcss comprcssion schcme. Comprcssing audio allows vou to havc highcr-quality audio 

without rcducing thc movic's framc ratc. Most souncl cards can uncomprcss audio whilc 

playing a movic. lf your sound carel supplics additional audio comprcssors, they will 

appear in thc Typc drop-clown list. 

The lnterleave option 

Yo u can sct thc amount of audio to be storccl in the movie bctwccn blocks of video, cal lec! 

interlcaving audio and video. You can specify amounts in framcs, scconds, or minutes. In 

most cases, thc· dcfault amount ( l sccnnd) works best, but il.vou noticc dcbys in your 

nwv¡c and chopJ'Y .1udio, vou may want lo cxpcrimcnl with diffcrcnl amounts. For 

movics that will be pbvcd from CD-1\0M, choosc l framc. · 



Note: For the smoothest playback, you can load all of the audio into RAM first, which allows 
the video fraines to be retrieved from the hard disk without interruption. To load all the audio 
into RAM first, choose a value for the Interleave field that is longer than the duration of 
the en tire movie. For this method to work properly, yo u must have enough RAM available 
to load the en tire audio portian of the movie and the audio portian must be ji ve minutes or 
less in duration. 

DIGITAL VIDEO COMPRESSION 

Compressioll is the process of removing or restructuring data to decrease the size of a file. 

Digital video files are very large, requiring high data transfer rates for capture and play­

back. As yo u compile a Video for Windows or QuickTime file, yo u compress thc data to 

reduce thc file size ami facilitate the playback of the movie. Data decompression takcs 

place as thc movie plays back. Comprcssion and dccompression are critica! if thc movie is 

to play off a CD-ROM drive or play at full sizc from a hard drive. 

Severa! compressíon/decompression algorithms (codees) are available for compressing 

Video for Windows and QuickTime movies. Codees can be software-bascd or hardware­

bascd. Hardware compression is significantly faster and more effective than software 

compression. The codee yo u choose affccts the visual quality of the movic and the speed 

\vith which it plays on your computer monitor or NTSC screen. In general, full-framc, 24-

bit video imagcs can only be played back in real time (that is, at normal playing spccd) 

, using hardware compression and decompression. Video for CD-ROM is normally 

compressed with software codees beca use it allows anyone with a CD-ROl'vl player to view 

movies without specializcd hardware. 

Yo u can compress Video for Windows movies in Adobe Premierc using any of the software 

codees that come with Video for Windows. Yo u can also add third-party codees to your 

system to givc you a varietv of comprcssion formats from which to choosc. Somc codees 

are optimized for imagc qualit;• compression, whilc others are optimized for speed. For 

more information, scc "Video for \Vindows Software Cnmprcssors'" on page 212. 

Yo u can compress QuickTimc mm·ics in Adobe Premierc using any of thc QuickTime soft­

ware codees that come with Adobe Premiere. For more information, see "QuickTime Soft­

ware Comprcssors" on pagc 213. 

Severa! third-party video bnards offer hardware comprcssion based on the Motion JPEG 

( )oint l'hotographic Experts Group) forma t. Motion J PEG allows display of full-frame 

images at 30 framcs pcr second, ami with somc boards, 60 ficlds per sccond. For more 

information on thircl-partv hardware, scc the rcnd111c file shippcd with Adobe Premierc. 



Outputting full-screen images 

You can output full-screen images (640-by-480 pixels) to your computer screen orto 

videotape in real time (at the normal playing speed of 30 fps), only if your playback system 

has hardware compression. Yo u can record full-screen images to videotape in nonreal time 

(below normal playing speed) using software compression if yo u ha ve a controllable tape 

deck. You can output half-screen images (320-by-240 pixels) at full frame (640-by-480 

pixels) to your computer screen orto videotape using the Zoom Screen feature of the Print 

to Video command, with either hardware or software compression. For more information 

on printing to video, scc "Using Print to Video" on page 219. For more information on 

outputting to videotape, scc "Outputting a Movic to Videotape" on pagc 222. 

Note: Yo u can Iza ve Adobe PI"Cinicrc genera te a11 Edit Dccision List (EDL) for crcating a video­
tape 11sing traditional post-production tcclzniqucs. Tlzc EDL_contains alisto( al/ of tlzc clips, 
transitions, ami special cffccts in thc nwvic, and is uscd to asscmblc a new 1novic (master) 
from tlzc original (sourcc) tapes. For more information 011 EDLs, scc "Generating an Edit 
Dccision List'' on pagc JOS. 

Achieving the highest possible playback rate 

The playback rate of your movie determines how smooth and natural-looking the mG _ 

appcars. Arplayback ratcs bclow 15 fps, you notice the frames thannake up a movic; thc 

lowcr thc playback ratc, thc more distinct cach frame becomes, un ti! thc illusion of contin­

uous motion is lost complete! y. !-lighcr plavback rates give the illusion of continuous 

motion; the individual framcs are unclctcctablc. For best results, you want the highcst 

possiblc pi.tyh.tck J";\[C (up [O 30 fr.llllCS/(1() ]Íc]ds J'CI" SCCOild). 

Thc highcst playback ratcs are achicvcd with fast hard drivcs and video boards capablc of 

processing data to the scrc.:n vcrv quickly. Hardware compression (such as Motion )PEG 

comprcssion) yiclds thc bcst rcsults. In m~my cases, howcvcr, the playback computer 

will not be able to display 30 fps, espccially if your movic is distributcd on CD-ROM. 

For more information about pLwback on CD-ROivl, scc "Making lvlovics for Playback 

on CD-ROM" on page :?.1 S. 

Data compression schemes 

Cod.:cs use sc,·.:r.li schemcs for removing or rcstructuring data to dccrcasc thc sizc of a file. 
Losslcss compr.:ssion schcmcs prcs.:rvc thc original data, ensuring that thc imagc is thc 

samc aftcr comprcs>ion .1ml dccomprcssion. Most losslcss schcmcs use run-lcngtlz 
cncoding, .t proccss that discanb Clllltinuous regions of duplicatc colors. This tcchniq 

works ven· wc\1 for imagcs that are gcncratcd elcctronicallv whcre colorcd arcas are oftcn 
' ..... ..__ 1 



composed of sol id colors. In general, however, lossless compressi<in is not very effective 

with digitized video and scanned photographs because.colors in these images are usually 

represented by high dithering and diffusion and contain few areas of continuous color. 

Lossy compression schemes, on the other hand, attempt to remo ve picture information 

that viewers are not likely to notice. Lossy compressors do not preserve original data; 

image information is lost and cannot be recovered. The amount of data that is lost · 

depends on the degree of compression, controlled by the image quality setting in the 

Compression Scttings dialog box. A high Quality setting for a movie results in much less 

information being lost than with a low Quality setting. In addition, many lossy compres­

'sors rcsult in additivc loss-as the images are rccomprcsscd, evcn more data is lost. Addi­

tivc loss varics with thc comprcssor; the QuickTimc Video codee, for example, has bcen 

designed to have little additive loss when recompressing. 

Spntinl compression compresses the data in each frame of a clip, while temporal compressio11 
compresses the data by comparing frames over time. Common side-effects of spatial 

compression in elude blurring, blockiness (small blocks of constant color instead of the 

random dithering found in the original content), streaking (lines of constant color), and 

contouring (regions of constan! color). · . 

Fmmc dijfcrc11ci11g is a type of temporal compression that minimizes the amount of data 

rcquired to represent each frame in a clip by storing data for only the frames that contain 

changes. This typc of comprcssion works well when a movie contains a small amount of 

movcmcnt and thus contains a fair amoúnt of duplication from one'framc to theínext. 

Frame differencing schcmcs storc thc data from certain kcy frames and discard ot11'ér data. 

A common sidc-cffcct of framc differcncing is blockiness in the video images. 

Video for Windows software compressors 

. Thc following software codees are shippcd with Video for Windows and appcar in the 

Comprcssor drop-down list in the Comprcssion Settings dialog box. Additional third­
party codees, suchas Motion )I'EC, ;tppe;tr if yo u are using a video capture board that h;ts 
han_hvarc con1prt:ssion. 

Microsoft Video 1 codee 

Use thc Video 1 option for comprcssing analog \'ideo. The Video 1 comprcssor is a lossy, 

spatial comprcssor that supports pixel dcpths of 8 or 1 ó bits. 

Microsoft RLE codee 

Use the RI.E option for comprcssing animal ion ;md computn-synthcsizcd imagcs. Thc 

RLE compn:ssor is a spati;tl 8-bit compressor that uses run-lcn¡;th encoding technic¡ucs. 



Cinepak codee 

Use the Cinepak codee when compressing 24-bit video for playback from CD-ROM discs. 

This codee attains higher compression ratios, better image quality, and faster playback 

speeds than the Microsoft Video 1 codee. It is availablc on both Windows and Macintosh 

computers. For best results, use the Cinepak codee on raw source data that has not been 

previously compressed with a highly lossy compressor. Cinepak is a high!'y asymmetric 

codee, which means that decompression is much fas ter than compression. Yo u can set the 

. data rate for playback (see "Selecting Compression Options" on page 214). 

lntellndeo Video R3.2 codee 

Use the lndeo Video option when compressing 24-bit video for playback from CD-ROM 

discs. This codee attains higher compression ratios, bettcr image qualiry, ami fas ter play­

back speeds than the Microsoft Video 1 codee. lt is available on both Windows and Macin­

.tosh computers. For best results, use the lndeo Video codee on raw source data that has 

not been previously comprcssed with a highly lossy compressor. When used with a data 

rate for playback, this codee produces movics that are comparable in quality to thosc 

comprcsscd with thc Cincpak codee. For more information on setting the data r¡llc, see 

"Sclccting Compression Options" on page 214. 

Jntellndeo Video Raw codee 

Use the lntellmieo Video Raw option for capturing uncompresscd video. This option 

provides excellcnt imagc quality, becaüse no compression is applied. Captured video files 

are smaller than those captured with thc Nonc option. 

None option 

Use thc None option for real-time acquisitinn of analog video. This option provides cxccl­

lcnt imagc quality, beca use no compression is appliecl. Data can be comprcsscd later or 

rccompukcl for playback from CD-I(OM. Thc disadvantage of using the Non e compres­

sion option is that largc amounts of disk space are rcquircd, and thc video cannot be 

playcd back. 

QuickTime software compressors 

Tbc follo1,·ing QuickTimc for Windows coch:cs are shipped with Adobe Prcmicrc and 

appcar in tlll' Comprcssor drop-down list in thc Compression Settings dialog box (for 

more information, scc "Sdccting Compression Options" on pagc 214 ). Choosc a codee 

b.1s~d on thc lypc of orisinal imasc:- yo u ha ve and your clcsirccl rcsults. 1 f your video board 

providc:- hardware comprcssion, rckr lo thc 1·idco board documcntation 1-or rccomr 

da1ions ahout which codee lo choosc. 

. .; 



Cinepak codee 

Use the Cinepak codee when compressing 24-bit video for playback from CD-ROM discs 

This codee attains higher compression ratios, better image quálity, and faster playback 

speeds than the Video codee. lt is available on both Windows and Macintosh computers. 

For best results, use the Cinepak codee on raw source data that has not been previously 

compressed with a highly lossy compressor. With Cinepak, decompression is much fasteJ 

than compression. You can set the data rate for playback (see "Selecting Compression 

Options" on page 214). 

lnte/lndeo Video R3.2 codee 

Use the Indeo Video option when compressi11g 24-bit video for playback from CD-RO!vl 

discs. This codee attains higher compression ratios, better image quality, and faster play­

back speeds than the Video codee. It is available 011 both Windows and l'vlacintosh 

computers. For best results, use the I11deo Video codee 011 raw source data that has not 

been previously compressed with a highly lossy compressor. vVhen used with a data ratc 

for playback, this codee produces movies that are comparable in quality to those 

compressed with the Cinepak codee. For more information on setting the data rate, see 

"Selecting Compression Options" on page 214. 

Video codee 

Use the Video codee for the capture ami compression of analog video, high-qualitY. play­

back from hard disk, and modera te quality p!aybackfrom CD-ROM. This codee supporb 

both spaiial ami temporal comprcssi.ol1 of 16-bit'video and can play back at rates of 10 fp, ·~. 

or more. Data can be rccompressed or recompilcd la ter for highcr comprcssion ratios. Th, 

Video codee allows recomprcssion with minimal or no quality degradation. 

None option 

Use the Non e optio11 for real-time acquisitio11 of analog video. This option provides excel 

k11t imagc quality beca use no comprcssion is applied. Data can be compressed later or 

recomputcd for plarback from CD-ROM. Thc disadvantagc of using the None compres­
sion option is that largc amounts of disk space are rcquired. 

SELECTING COMPRESSION OPTIONS 

Comprcssion options are initially set by thc project preset, which you choose whcn you 

e reate thc projcct. Yo u probably won't need to changc thc compression options unless thc 

in tended use of the nwvie has ch;mged. For more information on choosing a preset, 

see "Selecting a Projcct Prcsct" on pagc 28. 

., 
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To change compression settings: 

1 Choose Compression from the Make menu, or click Compression in the Makc Movic 

dialog box. The Comprcssion Settings dialog box appcars. 

:· ., - : ~-~· ..... , Compression Settings ., 

CompJeUJOO T ype: 1 

Compressor 

M_ethod: I"M;-oc-w-,-o;:-ft-;-;Vc-;;dc-eo-;-1 ------.,.[""!:!::] 1' Configure::. ·1 

Qepth: 1 T housands !:!JI :·,·p~leÚC.~:-:--··1 

75% 

Options 

Erames per second: [IO [!1 
O !;_eyhame every ~ Ir ames 

[8J Opllmize slllls 

Data Rate 

Sample 

O !:.imit Data A ate lo ~ K/sec O CD-ROtr-4 

O fiecompren !Aiways I!J 

1 o~ Cancel 

2 To sce hmv thc comprcssion scttings will affcct your compilcd movic, copy a clip from 

your project to thc Clipho;1rd. ¡\ framc from thc clip appe;ns in the Compression Settings 

samplc box. The framc displa)' is a snapshot preview of thc compilcd movic. 

3 Sclcct which codee to use in compiling your movic. Jf your board provides hardware 

comprcssion, sclcct thc propcr tvlotion )PEG codee. Othcrwise, sclcct a software codee. 

For more i nformation, sce "Video for Windows Software Comprcssors" on pagc 212 and 

"QuickTimc Soft\\"arc Comprcssors'' on pagc 213. 

4 !f your comprcssor allows yo u lo sct comprcssion quality options, click Configure and 

sct thosc optiuns. 

5 Sclcct a pixel dcpth for thc movic from thc Depth drop-down list.The pixel depth deter­

mines the numbcr of colors that can appcar in the imagcs. Smallcr depths can reduce thc 

file sizc but ma:· degrade thc imagc qualit\·. Some codees, such as thc Cincpak codee, have 

a lixed pixel dcpth that cannot be changcd. 

... 



6 If yo u are limiting a movie to 256 colors, click Palette and selecta movie palette. Select 

the Calcula te a New Palette option to have Adobe Premiere calcula te a palette for each 

movie. Select the Load Palette Now option to load a palette you have previously created. 

7 Use the Quality slider to set the spatial compression quality. The lower the Quality 

setting, the more the movie is compressed ai1d the smaller the file size. A high Quality 

setting results in less information being lost than with a low Quality setting. To preview 

the effect of spatial compression on your movie, place a sample image in the box abo ve the 

Quality slider, as described in Step 2. For more information on spatial compression, see 

"Data Compression Schemes" on page 211. 

8 Set the compression options, as described in thc following sections. 

9 Click OK when you havc finished specifying thc comprcssion. 

Frames per Second option 

This option specifies thc maximum playback ratc of the movic in frames pcr second (fps). 

Choose arate r;·om 1 fps to 30 fps from thc drop-down list (30 fps is the maximum rate 

for playback on a PC). In general, higher rates yicld bettcr rcsults, with smoothcr, more 

natural-looking motion. !-lowcver, you should sclect arate that matches thc maximum 

. playback ratc of the computcr systcm on which yo u intend to run the finishcd movie. 

Sclecting a r.ltc th<ll cannot be achicved by thc playback systcm will rcsult in dropped 

framcs and possiblc fluttu whcn yo u pla:· your movic. The maximum rate of the playback · 

, systcm dépcnds on the speed of its cmnponcnts: the CPU, the hard drivc, and:the display .,. 

can!. For more informationon playback r<llcs, scc "¡\chicving the 1-lighcst i'ossiblc Play­

back R<lle" on pagc 211. 

Note: Sctting thc plny/111Ck ratc hig/¡a tlwn tl1c ratc of tl1c origino/ clips will rcpliwtc [ra111cs; 
it docs 1101 incrc11sc thc m te uf thc origin11l dips. 

Key Frame option 

This option is availablc if n1u ha ve sclccted a codee that uses frame diffcrencing, which is 

a type of temporal compreSSlllll. ( For more inf(mnation on frame ditTercncing, see "Data 

Compression Schcmes" on pagc 211.) A kqliwnc is thc bascline framc against which 

othcr frames are comparcd for differcnccs. Thc kcv framcs are savcd in their entircty, while 

intcrvcning framcs, Clllcd dcltojiwncs, <He' comprcsscd bascd on thcir differcnces from the 

key framcs. Thc Kc~· ha me option spccifics thc ratc al which thc movie is samplcd for key 

framcs. Using thc.Kcv l'r.1mc option allows for ~rcatcr cnmprcssion and incrcascd play­

back spccd, but can de la~· <lCCcss of mdividual fr<lmcs in a movic. 

1. lt. 
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As a general rule, you should set the Key Frame option to the recommended rate for the 

codee, which will automatically appear in the Kcy Frame text box. Otherwise, sct the Kcy 

Frame option to one key frame per second. For example, if the playback rate of your movic 

is 10 fps, you should set the Key Framc option to 10 so that thc movic is sampled for a kcy 

frame every 1 O frames. If yo u do not select the Key Frame option, the comprcssor treats 

every frame as a key framc. 

Optimize Stills option 

This option, which is selected by dcfault, optimizes still images that extend more than onc 

frame. When this option is sclected, only thc first frame of the still imagc is comprcsscd. 

Data Rate option 

This option is available yo u are using certain comprcssors, such as Cincpak and In deo, for 

CD-ROM playback. For playback on a single-speed CD-ROM drivc, sct thc data rate limit 

in the range of 90K to 1 OOK pcr sccond. For playback on a doublc-spccd CD-ROM drivc, 

set the rateas high as ISOK to 200K pcr second. For playback on a triplc-spccd CD-ROM 

drivc, sct thc ratc as high as 300K pcr sccond. Adobe Prcmicrc automatically adjusts thc 

spatial and temporal quality of thc movic to achicvc the data ratc yo u spccify. To 'cxami·· · 

the data rate of a Video for Windows clip or movic, choosc Tools > Movic Analysis fro .. 

thc File mcnu to scc a graph of thc dat<l ratc over time. . .. 

CD-ROM option 

This option pads framcs to evcnly fill thc 2K blocks, or scctors, on a CD. Many CD-ROM 

drivcs pla;· uncvcnly if a movic docs nol maintain an cvcn data ratc. 

Recompress option 

This option is availahlc whcn yo u are using certain codees, such as Cincpak and In deo. Yo u 

can use this optionto control when comprcssion is applicd. Sclcct Always to always rccom­

prcss al! clips. Sclcct i'vlaintain Data Rat<: and providc a tolcrancc to allow somc spikes in 

thc data ratc. Video clips often havc small spikcs in thc data ratc, particularly at thc bcgin­

ning of thc clip, that do not degrade thc pcrl(mnancc. Using the Maintain Data Ratc 

option allows thosc spikcs to rema in. 

\Vhen Adobe l'n:micre compiles <l 11Hl\'ÍC or builds <l prcvicw, al! of thc clips are proccsscd 

using the same compression, frame ratc, and other output scttings. lf you are using dips 

that havc airead;· bccn compresscd ami that airead;- havc thc samc output settings as thc 

linalmm·¡e, vou gcncralh· W<lllt to :1\·oid rccomprcssing those clips. For eX<lmplc, you may 

be using sourcc clips from a CD-\~Oi'v1 or clips that wcre capturcd using the same cod 
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ami output settings as your final movie. You want to ;lvoid ITcompression bccause it 

degrades the image quality of the clip ami beca use it can take a long time, particularly if 

you are using the Cinepak or lndco codees. 

By default, Adobe PrcmiCÍ"c williiot rccomprcss a clip if thc projcct's compression options 

and output options are sct to thc same valucs ,1s thosc of the source clip and if no spccial 

cffects ha ve bcen applicd to the clips. To prcvent rccomprcssion, thc project and the so urce 

clip must ha ve the same scttings for all uf thc following: 

• framc size 

• frame rate 

• kcy frame rate 

• codee 

• color depth 

Ncw m;ltcrial, su eh as effccts, will be ;dways rccomprcssed, as will ;¡ny clips whosc settings 

are not the samc as the project output and preview scttings. To control rccomprcssion, vou 

can use the Limit Data Ratc ancl thc Recompress options. 

MAKING MOVIES FOR PLAYBACK ON CD-ROM 

CD-ROM drives process data relativcly slowly-in thc rangc of 90K to 250K per second, 

depending on the speed of the drivc. At this limitcd transfer ratc, data compression is crit-

1cal. Thc quality of your final movies dcpcnds on the way yo u capture thc video and 

proccss the digitized clips. 

Currcnt data transfer ratcs for CD-ROM effectively limit the movie size to 320-by-240 

pixels. Higher frame ratcs are achicved with a size of 240-by-l SO pixels. Yo u should 

capture at 30 fps (or at the highest rate possible) using the finalmovie frame size. Ifyour 

hardware allows, yo u can capture at larger sizes and rcsize the movie in Premiere, but 

improvcments in thc final image quality m ay be imperceptible, and working with larger 

imagcs substantially in creases compiling time and the amount of disk space requircd to 

store the data. 

Always start with the deanes! analog video so urce available when yo u capture movies, as 

video noise increascs the amount of data that must be comprcssed. \A/hen capturing, use 

hardware compression if it is available, and keep your digitized clips at the highest possible 

quality until yo u are ready to compile your final movie. After building your movie in 

Adobe Premiere, compile it using the Cinepak or Indeo compressor. These compressors 



allow yo u to limit the data rate for the movie. In addition, beca use these software compres­

sors are ;wailable on both the Macintosh and the PC, movies compressed using these 

codees can be played back on both platforms. 

For best results when making movies for playback on a CD-ROM. use the following 

settings in the Compression Settings and Project Output Options dialog boxes. (Some of 

these settings are u sed automatically if yo u ha ve selected the project preset for CD-ROM 

mastering.) 

• Output As: Video for Windows (.avi) or QuickTimc Mnvie 

• · Size: 240-by-180 pixels 

• Rate: 15 fps 

• Audio Ratc: 11 kHz sound rate 

• Compressor: Cinepak or Indeo 

• Key Frame: selccted and sct to the automatically recommendcd kcy framc rate 

• Quality (Temporal): Normal 

• Rccompression: Compress if the data rate excceds thc requcstcd ratc 

• In terkavc: 1 fps 

• Data Ratc: 90K/sccond for singlc-spccd drivcs; 150K/sccond to 200K/sccond for 

double-spced drivcs; 300K/second for triplc-spccd drivcs 

• CD-I~Oiv1: sdcctcd 

USING PRINT TO VIDEO 

Adobe Prcmicrc's Print to Video fcaturc lcts you cxport a movic from thc Clip window to 

your computcr scrccn or video monitor whilc bbcking out al! othcr windows. The Print 

to Video command is uscful for viewing compilcd movics and for rccording movies onto 

videotape in real time as they pla:· on your scrcen. Print to Video lcts you perform hard­

ware zooming as yo u play a clip, so that yo u can view a quarter-screen movie at full-screen 

size. For information on making vidcotapes, see "Outputting a Movie to Videotape" on 

page 222. 

To play a movie ccntcrcd on a blank screen: 

1 Chonsc Opcn from thc File n1cnu .. Thc Opcn dialog box appcars. 

2 Sekct thc mm·ic \'Oll want to play from thc file list, and click OK. Thc movic: appc:a .. n 

a Clip Wllldow. 



3 Choose Export > Print to Video from the File menu. The Print to Video dialog 

box appcars. 

Prlnl To Video · · 

Color bars lor U Seconds 

Blank Screen lor D Seconds 

O Full S creen 

O Zoom by 2 

O Loop Playback 

O At.:llv.tlt! re-cordlll!J Jec~. 

OK 1: Cancel · 

4 ln the Color Bars text box, sct the duration for displaying color bars at the beginning o! 

thc movie. Thc dcfault setting is O seconds. 

5 In thc Blank Scrccn tcxt box, sct the duration of the blank scrccn displavcd at the bcgin 

ning and cnd of the movic. The default setting is 1 second. This setting works well if you 

are using Print to Video to vicw thc movic. For recording on videotape, you should sct thL 

duration of thc blank screcn to about 15 seconds. .,._ \e 

6 Asan option, sckct Full Scrccn to play thc movic at thc full size of thc scrcen. 

7 As an_option, select Zoom by 2 to magnif)• thc frame sizc of the movic by a factor of two. < 
This is an effcctive way of enlarging quartcr-screen movies (320-by-240 pixels) to full sizc ··-~ 

(ó40-by-4RO pixels). The spccd with which you can zoom with software is de,termined by 

the hardware you havc. 

Note: Hcm¡tsc cvcry pixel is n111ppcrlto fo11r scrccn pixels when thc 111ovic is nlllgnífierl, 
zoomíng lllil}' muse noticca/J/c pixclizotion or /J/ockiness in tlzc ímogc. I( tl1e movie is Olltpltl 
to tape, cncoding wil/ reduce 501/IC o( this blockincs,:. 

8 Asan option, sclcct Loop Playback to pbv thc movic as a continuous loop. Press the Ese 

kcy to cancel continuous pl.1yhack. 

9 Asan option, sclcct Activa te l~ccording Dcck if yo u are recording toa controllable 

devicc. The movie will be rccorded to thc tape dcck that you have sclccted in the Devicc 

Control dialog box undcr thc Prcfcrcnccs mcnu. This option is graycd out if no such 

dcvice is sclcctcd. ( For a dcscription of thcsc options, sce "Outputting ;¡ Movic to Video­

tape" on page 222.) Do not sckct thc Activa te Rccording Dcck option unlcss vou want to 

record thc mm·ic onto a controlbbk dc,·icc as it plays on your scrccn. 

' 



10 Click OK. The movie plays at full screen or in the center of the screen against a black 

background, depending on the frame size. To interrupt the playing of the movie, press the 

Ese key. 

LINKING MOVIES 

You can link a series of short movies using the Sequence window. The Sequence window 

is simpler to use than the Construction window and is good for storyboarding or 

producing quick results with existing clips. \'Vhcn yo u compile a movie using the Scquence 

window, additional compression is not applicd. 

You can use the Print to Video command when the Sequence window is active to output 

the contents of the window directly to your computer screen orto videotape. 

To make a linked movic using the Sequen ce window: 

1 Choose New > Sequence from the File menu. Thc Sequence window opens. 

2 Use thc lmport command in thc File mcnu to import thc nwvics you w;mt in thc 

composite movic. You can also drag movics from a Clip window or the l'rojc_ct window 

into thc Scqucncc window. 

Thc thumbnails of thc movics yo u sclccted appear in thc Sequen ce window. Thc arca 

under the ti tic bar of the Sequen ce window displays thc numbcr of movics in the window 

and thc total duwtion of thc combined movics. 

11 

Clo~eu:· avt 
00 0212 

Sequence: Noname4.psq 1· 
lo!alnme 0000182.; 

Tw1rl d\'1 

0012 213 00 03 Jt, 

3 Tu changc thc ordcr in which thc movics are linkcd, drag the thumhnails to rcarrange 

thcm in thc Scqucncc window. l'rcss thc Shift kc:• to sclcct and move more than one 

thumbn;lil at ;1 time. 

4 Choosc !v!akc ,\·lovic from thc J\l;Jkc mcnu. Thc 1\lakc l'vlovic dialog box appcars. 

5 T:-pc a na me l(ll- thc lllO\'ic, and click Ol\:. 

Adobe l'rcmicrc bcgins crcating thc linked movic. '[()stop thc compilation, prcss thc 

Ese kcv. 

1 ; 
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To display a sequen ce using Print to Video: 

1 With the Sequence window active, choose Export > Print to Video from the File men 

2 Choose options from the Print to Video dialog box. For a description of these option 

sce "Using Print to Video" on page 219. 

3 Click OK. 

Movic, audio, and still-imagc clips play in thc ccnter of your screen, in thc arder that thc 

appcar in the Sequcnce window. 

To save a Sequen ce window: 

1 With the Sequence window active, choose Save from the File mcnu. The Save File dial1 

box appears. 

2 Type a name for thc Scquence file, and click OK. 

Note that the Sequence file contains only a referencc to the movies uscd to build the 

compositc movie; thcreforc, the file size is vcry small. 

OUTPUTT1NG A MOVIE TO VIDEOTAPE .. 
Yo u can record an Adobe Premien.' movic or movie sequen ce to videotape using the Pri1 

to Video command. You nced a sean convertcr andan NTSC or PAL encodcr to converl 

thc RG B signa! to an NTSC or PAL signa!. Yo u can use externa! devices or the converter 

and cnéoder that are built-in on somc video boards. You necd'only one tape deck for ··~ 

rccording a movic; time base corrcctors, switchers, effects gencrators, and other special !)¡ 

equipmcnt are not nccdcd. After thc movic is output to videotape, you can play the tape 

on any television or analog video monitor equipped with a videotape deck. 

You can record Adobe Prcmiere movics aftcr they have becn compilcd. You can use the 

Print to Video command to view the movie on your computcr monitor befo re activatin 

your recording deck. This provides yo u with a preview of what the movie should loo k lik 

on videotape. For more information, sec "Using Print to Video" on page 219. 

You can videotape thc mm·ic in real time as it plays on your screcn, or in nonrca] time i1 

vou havc a contrull,Jhle i'rame-accuratc rccording deck. Tu achicvc accentablc results witl 
; e " 

real-time rccording vou necd a computcr and video displa>· board that is capablc of 

producing an acccptable output ratc. If your movie skips framcs when it plays on your 

monitor, tlwsc framcs will bL· lost in real-time rccorcling. 

Nonreal-time recording mc;tns rcco1·dingat a speed othcr than thc movic's normal plavin 

spccd. Thc ,tch·ant;tgc uf nonrcal-timc rccording is that you are assurccl uf capturing cver 

i'ramc uf your nwvic on \'Jdcotapc. Howcvcr, yo u necd a controllablc rccorcling deck an, 



a machine controller, such asan ARTI or V-LAN controller. In addition, you need a 

third-party software program that allows nonreal-timc framc grabbing and printing 

to videotape. 

Befo re outputting to video, you should use the Print to Video command to view at least a 

portian of the movie cm your monitor befo re yo u activa te your recording dcck. (For more 

infqrmation, see "Using Print to Video" on page 21 9.) If yo u will be recording in real time, 

this providcs yo u with a preview of what the movie should loo k like on videotape. 

Note: Yo u canlzave Adobe Premie re genera te an Edit Decision List (EDL) for creating a video­
tape using tmditional post-production tcclllliqucs. Tlzc EDL contains a list of al/ of tlze clips, 
transitions, ami specia/ effects in tlze nwvic, and is uscd to assemhle a 11ew 1110vie (master) 

from tlze original (source) tapes. For 1110re infonization on EDLs, scc "Generating an Edit 
Decision List'' on pagc JOS. 

To output a movie to videotape: 

1 Make sure that your computcr is capablc ofproducing NTSC-comp,lliblc signals. (For 

more information, scc the nexl scclion, "Producing NTSC-Compatiblc Signals_.") 

2 Make surc that yo u ha ve a cable connection from thc NTSC encodcr (or from your 1 o 

board if the board has a built-in encodcr) lo your tape dcck. lf you.havc an NTSC monitor, ... 

yo u should have a cable connecting the cncodcr output to the monitor input ánd another 

cable connecting the NTSC monitor output to the tape deck input. 

3 Selcct one of thc following sourccs for the movie you want to record: 

• The Clip window, for compílcd movies 

• The Scquencc wíndow, for línkcd movíes 

4 If yo u havc a controllable devícc and want Adobe Premícrc lo start and stop thc 

tape automatícalh·, sclect Prcfcrcnccs > Dcvíce Control from the File mcnu and choosc 

thc controllable dcvicc you are using from the drop-down list in the Dcvice Control 

dialog box. 

5 Choosc Export > Print to Video from the File mcnu. The Print to Video dialog box 

appcars. 

Note: So 111 e l' id e o /1011 rd 111111111_¡; 1 ct 11 ras s 11 p {' 1 y e 11 ha 11 ccd cxpo rt 11 wd 111 es [orAd o be Prc 111 i ere. 
Thesc exporr tnodu/,·; .<upport j(·aturcs unu¡uc to the IJOard. Like Adobe fJre111icrc's lmilt-in 
l'rinr to Video 111odu/c, tl1csc third-¡)(Jr/)' cx¡>ort 111odu/cs are imple111Ciltcd lty choosing ·· 
COII11111111cl in t!Jc Export 111Cilll. J(c{i:r [(> t!Jc clncwncntation tl1at co111es witl1 your vidcc. ,-el 
fa r 111 o re 111/o n 11 a 1 i o 11. 



6 Select Print to Video options. For a description of these opti"ons, see "Using Print to 

Video" on page 219. 

1 Click OK. 

s If yo u are recording in real time without a controllable deck, press Record on your tape 

deck. A Blank Screen setting of 15 seconds in the Print to Video dialog box should allow 

yo u enough time to activa te the deck and get it up to speed befo re the movie starts playing. 

The movie begins recording to the videotape on the tape cleck. If yo u are using a control­

lable deck, the cleck stops after the movie has been recorded. If yo u are not using a control­

lable deck, you must manually stop the cleck. 

Producing NTSC-compatible signals 

To videotape an Adobe Premiere movic, your hardware must be set up to produce NTSC 

sean rates ancl encocle the video signa! for NTSC display. The ability of your computer to 

perform these two tasks clepends on the capabilities of your computer and your video 

board. Somc video boards havc both capabilities and provide an NTSC output signa!. See 

the documentation that comes with your computer and your video board for information 

on their capabilities. 

·NTSC-compatib/e sean rates 

Ikfon: your computer can output ;¡ movic to videotape, thc sean ratc of the video board 

must be se~ to NTSC-compatiblc ratcs. NTSC video is scanned at 29.97 Hz. Computer 

video boards sean ;ll manv diffcrcnt ratcs, including NTSC rates, dcpcnding on which 

monitors thcy are driving.lfyour board is not capablc ofNTSC-scan ratcs, you will need 

a sean convcrter to output vour movic to tape. 

Encoders 

NTSC tclc\·ision sign;ds ;lnd computcr signals diffcr in how thcy are scnt to the scrcen. 

Ifyour video board is ctp;1ble of outputting NTSC-compositc signab (or ifvou already 

ha ve;¡ SGlll converter), yo u can output a movie dircctly to tape; if vour video board is 

capablc of outputting unh- NTSC-I~C1\ signals, you will nccd an cncodcr. ivlany encodcrs 

that plug dirccth- into thc video board of your computer are availablc from third-party 

dcalcrs, who also providc cabling for the monitor and jacks for connecting the computer 

toa VC:I~ or TV 

. PLAYJNG ADOBE PREMIERE MOVIES IN OTHER APPLICATIONS 

In Adobe Prcmicrc for the !vlacintosh, :·ou Glll open a QuickTimc movic that was created 

in thc \Vindows versiun of thc program ami use it _iust like anv other imported clip. You 

can al so plav Adobe Prcmierc movics in anv \Vindows application that supports the Object 

Linking and Embcdding (OLE) standard. 

0,(~1 
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Using movies in Adobe Premie re for the Macintosh 

Yo u can import movies that were created in Adobe Premiere for vVindows into the Macin­

tosh version of the program, and you can import Macintosh versions of Adobe Premiere 

movies (from version 3.0 or higher) into the Windows version. A movie imported from a 

different platform is treated as a single clip. You can't edit the movie's individual parts 

unless you use the razor tool to split the movie into scparate clips. 

To use a Windows movic in thc Macintosh version of Adobe Premiere: 

1 In Adobe Prcmiere for Windows, compile thc movie in thc QuickTime forma t. 

2 Open the file in Adobe Premierc for the Macintosh and answcr Yes when thc program 

asks whether yo u want to rcformat the file in the QuickTimc forma t. . 

3 Import thc movie in thc Project window justas you would any nther clip. 

To use a Macintosh movic in thc \V'indows vcrsion of Adobe Premicrc: 

1 In Adobe Pn.:micre for thc lVlacintosh, use Export > r:lattcncd Movic to crea te a Oattcncd 

QuickTime movie. Don't use any compression unless you havc thc samc comprcssion 

codees on both systems. Be su reto use the Windows filc-naming convcntion (8-charc r 

prefix, 3-charactcr cxtension), and use the .11zov file extcnsion. 

2 In Adobe Premiere for Windows, import the movic in the Project window justas you 

would any other clip. 

Transferring Adobe Premiere movies to OLE applications 

You can use :\do be l'rcmicrc Video for Windows movies in applications that support the 

OLE standard by using thc Video for Windows ivlcdia Playcr to copY ~111d paste the movic. 

. .. 
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CHAPTER 9: CAPTURING VIDEO 

[j his chapter describes how to record video images and sound directly to your 

computer by digitizing, or wpturin!;, thc analog video and audio signals. Thc 

chaptcr begins with a discussion of hardware requircments and considerations 

for producing the highest quality video and audio possible. The remainder of the chapter 

explains how to capture video and audio using Adobe Premiere's l'vlovie Capture, Audio 

Capture, and Batch Capture commands. 

DIGITIZING HARDWARE REQUIREMENTS 

To record video, vou necd a video source (such as a VCR, camcordcr, or lascrdisc) anda 

video digitizing board (also called a video capture board or digitizer carel). For recording 

sound, you need an audio capture board and the appropriatc devicc drivers. Some video 

capture boards offer audio digitizing capabilities as well. 

Video digitizing boards diffcr widely in thcir functions and capabilities. l'vlany function as 
' graphics display boards and video output boards. To digitize video using Adobe Premie 

the board must be compatible with Video for \Vindows. Your system must ha ve the app' .. · 

priate Videcí for Windows drivers instal"led on it. ·• 

If yo u have a controllablc video playback devicc, yo u can capture video clips automatically 

by making rcfcrcnce to their timecodc. Todo this, you nccd a dcvice controllcr such as 

thc ARTI or the Videomcdia V-LAP.: to control the so urce rcmotcly using ,\do be Prcmicrc. 

Adobe Premicrc also supports the control of any device with an MCI (ivlcdia Control 

Interface) device driver. With a controllablc dcvicc, clips can also be vicwed and logged 

with rcfcrcncc to thcir timccodc and thcn batch digitizcd. 

Thc connections bctwecn hardware componcnts vary according to thc cquipment you 

use. Yo u necd to conncct thc video out ports of your video so urce tu your video capture 

board, usually through a port in the back of your computer. lf your digitizing board a !so 

supports audio, ~·our ;ludio source (nonnallr the.audio out port of your video source) 

mmt a !so be conncctcd to thc· dig1tizing ho,nd. H.cfcr to thc documcntation for your 

computcr and Your digitizing bo;nds for thc propcr hardware setup and configuration. 



GUIDELINES FOR CAPTURING VIDEO 

Digital recording of full-framc, full-motion video requires a fast computer and lots of disl 

storage space. The size of the imagc frame, the number of colors, and the frame rate al! 

affect how much data must be captured, and thus how quickly and how well video can b, 

recordcd. (For more information on mcmory requirements for capturing video, see 

"Digitizing Video" on page 285.) 

As quality increases, so does the amount of data required to represent the video. Recent 

advances in processing powcr and mcmory have enabled desktop computer systems to 

process data effectively enough to capture, store, and play back digital video. But limita­

tions rema in. This section discusses how to maximize computcr resources to decrease th, 

amount of data nccded while capturing video at thc highest quality possible. 

Strategies for reducing the amount of data needed to capture video 

You must make some tradcoffs when trying to reduce the amount of data nceded whcn 

capturing vid<io. Therc are three main stratcgics for rcducing the data, cach of which 

compromiscs the quality of the capturcd video: 

• Compressing the video data 

• Rcducing,.thc imagc dimcnsions of thc captured video 

• Rcducing thc frame ratc of thc capturcd video 

Yo u can ·comprcss video data using hoth hardw.ue comprcssion and softw¡ue comprcs­

sion. Severa] software compressors <liT <lV<lÍLtblc in Adobe Premien:. For more informa-
' . 

tion, sce "Digital Video Comprcssion" on page 21 O. 

lf yo u can compromise the quality or the image dimensions, vou'll be ablc todo a lot more· 

with lcss. For examplc, you can capture at lcss than full framc and 30 fps whcn d1gitizing 

video for use on CD-ROI'vls beca use CD-ROM players have limitcd plavback capabilities. 

For more information, se e "Sclccting Rccording Options" on pagc 235. 

lf you nccd to c1pturc fu]].framc video at 30 fps, )'ou'll need spccialt)' hardware anda lot 

of data storagc capacity. C1pturing full-frame video at 30 fps rcquircs so me type of hard­

ware comprcssion through the <.ligitizing board. 

7_:,'¡ 



Capturing the highest quality video 

Capturing the highest quality video depends on the quality of the so urce video and on 

hardware factors. 

Beca use the quality of the captured video will never exceed the quality of your so urce 

video, you should use the highest quality source possible. Currcntly, the highest quality 

video formats are the D l, D2, and D3 formats, followed by the Beta and 3/4-inch formats 

(uscd in the broadcast industry). Other more widely available formats are, in order of 

qualitv, lascrdisc, Hi S, Super VHS, S mm, and VHS. lf your video capture board supports 

both Composite and S-Video input, yo u should use S-Video if possible beca use S-Video 

is a higher-quality signa!. 

Thc following hardware factors affcct the maximum framc ratc and image size that can be 

achicved during capture and playback: 

• Speed and comprcssion capabilitics of thc video capture board 

• Speed of the computer's hard drive 

• Specd of the computer's ccntm! proccssing 1111it (CPU) 

• Data proce.ssing load on the CPU 

• Speed of the computer's datalms (thc interface between the digitizing board and thc 

CPLi and hard drive) 

• .1\\·ailablc Rt\i'vl, if yo u are capturing to memory 

Video capture board speed and compression 

The fastcr your video board, thc fas ter the video framcs can be drawn on-scrcen. To 

capture full-frame video at 30 fps, most boards capture onlv onc of two fields (half thc 

scrcen lincs) in each framc and replica te the data to complete the frame. This compro­

mises 1magc quality. For capturing quartcr-screen or smaller images, this compromisc is 

not usuallv nccessarv. . . 

In general, hardware compression on the capture board grcatly increascs movie capture 

performance. Video boards that ha ve ivlotion JPEG compression can usually capture full­

motion video ven· etTectively. You \\'ill nccd to cxpcriment \\'ith your computer and video 

digitizing board to determine· what settings in Adobe Prcmierc nroclucc thc bcst rcsults . ..._ ..._ .... t 

Hard drive speed 

The fastcr your hard drive, thc fastcr thc computer can rcad ancl wntc elata to and fr01r. 

thc hard disk. For 30 fps capture, it 1s rccommcndcd that your hard disk have an average 

3Cccss time of 10 milliseconds (ms) or lcss, ;1nd a data transfcr ratc of 3 mega bytes (MB) 

·• 



per second or more. (This data transfer rate is currently available with 5400 rpm drives. 

As a general rule of thumb, the video data transfer rate will be about half the data transfer 

rate of the drive. Yo u m ay achieve higher transfer rates with special SCSI connections, su eh 

as disk arrays, SCSI II or fast SCSI.) 

CPU speed 

The faster your CPU, the faster your computer will be able to process the data necessary to­

capture and play back digital video. Currently, the fastest processors are the Intel Pentium 

and the I ntcl 486 DX2 66 and 486 DX4 1 OO. 

CPU data processing load 

During capture, make sure that yo u ha ve as m u eh of the CPU dedicated to the pro'cess as 

possible. This means turning off allunnecessary applications and minimizing all open 

windows except the Movie Capture window. Yo u should also limit thc size of thc disk 

cache and make sure that thc virtual memory allocation is no larger than twice the amount 

of installcd RAM. 

Data bus speed 

The computer's data bus controls the r~ltc of data transfcr from the captui·e devicc to the 

CPU. Currcntly, the fastest bus standards are thc VESA Local Bus (VL-l3us), and thc 

c.'mcrging PCI standard, which is av,¡iJable on many Pcntium computcrs with an lntel '!' 

mothcrboard. The VL-l3us is a 32-bit bus. Thc ncwer VL-l3us 2.0 and thc PCI bus are 32-

to 64-bit buses. 

Capturing directly to memory 

On manr computers, thc best video capture method is directly to memory, or RAM. 

Capturing to RAivl is fas ter than capturing toa hard drivc, and is recommendcd when you 

havc enough free memory to storc the movie being captured. 1-Iowevcr, thc movie's size is 

limited to the amount of free mcmory. The amount of memon· you need depends on thc 

image sizc, framc ratc, comprcssion mcthod, amllcngth of the capturcd ,·ideo. Experi­

mcnt with a clip to determine whethn you have cnough memory . 

. Use these guidclines when capturing ,·ideo to mcmory: 

• Free up as much memor1· as possihlc h~· closing other applications and turning off 

unncccssan· utilitics. The more mem(Jr\' mu havc availablc, the longcr the movie you 

can capture. 

• If you have a fast video board with hardware comprTssron, you can perform compres­

sion as thc movic is beins captured. This allows you to record longcr clips to mcmory. 



If yo u do not have enough free memory to capture to memory, yo u must capture video to 

a hard disk. Use these guidelines when capturing toa hard disk: 

• Use a high-speed hard disk and drivc controller; the disk's specd is mcasured by the 

disk's sustained data transfer rate. Jf yo u have severa! hard disks, capture to your fastcst 

hard disk. 

• Use a dedicated hard disk or crea te a separa te partition on your hard disk for capturing 

video. 

• Crea te a preal!ocated capture file so that video data can be recordcd in contiguous clus­

ters on the hard disk. This reduces disk drive activity during capture and reduces thc 

chances of droppcd frames. After capturing video data toa capture file, you !Ímst m ove 

the file toa new location. The next time you capture data, it will be writtcn to the samc 

capture file on the hard disk. For more information, scc "Sctting Up the Capture File" on 

¡1;lge 233. 

• Do not record toa fragmentecl hard disk, beca use it can reduce the framc r;ttc at w!lich 

movies are c;tptured. Use a dcfragmenting utilit)", such as Norton Utilities, to optimizc and 

dcfragmcnt thc hard disk as often as nccessary to keep it efficient. 

• Jf yo u havc more than onc hard disk, use the Scratch Disks Prcfenmces to sclect the disk ... 

to which you want to record. Todo this, choosc Preferences > Scratch Disks from the File 

m en u; then sdcct the disk na me from thc list of úvailable na mes in the dialog box. 

Capturing without software compression 

Thc compression proccss itself rcquires time. Thus, with smal!cr movics ( 160-by-120 

pixels), vou can achieve highcr frame ratcs bv capturing the movie with no compression. 

As you increasc the size of the mo,·ic. howevcr, ctpturing without compression decreascs 

thc frame r,nc· becausc thc· capturing is limitcd [H' thc elata transfcr rate ofthe bus. In 

general, vou shoulclusc the compression ntetlwd that is automatically chosen by your 

video capture driver. 

Capturing full-screen images 

You can capture full-screen video (640-by-480 pixels) two ways: in real time using hard­
ware comprcssion, or in nonrcal time using a framc-accuratc tape dcck ora laser disk that 

is wntrolbblc lw the computer.ln general, capturing in real time with hardware compres­

sion proviclcs the fastcst and easiest mcthod fnr capturing full-scrcen video. 

Nonrcal-timc capture mctlwds, or stcp wpturc mcthocls, graba single fr,11ne of the m o. 

at ;1 time, or makc multiplc passcs un ti! thcy havc capturcd al! thc neeckd framcs. Thesc 

methocls requirc that you havc a framc-accurate tape dcck, timccodc on your source tape, 



anda third-party device controller that can perform nonreal-time capturing of video data. 

Video captured in nonreal-time is generally not of very high quality unless yo u use a high-

end deck ora laserdisc. · 

Yo u can produce rcsults that are similar to video captured at full-frame by capturing video 

at quarter-screen (320-by-240 pixels) and then using the zoom éapability of the Print to 

Video command during playback or recording to videotape. Capturing at quarter-screen 

and then zooming requires substantially less disk space for data storage, improves editing 

performance in Adobe Premiere, and gene rally produces the same results as if yo u had 

captured the video at full-frame. The latter is beca use most video capture boards can 

capture all ;f the video data at quarter-screen, but only half of the video data at full, screen. 

For information on hardware zooming with Print to Video, see "Using Print to Video" on 

page 219. 

You can also improve performance when working with full-screcn video in severa! ways. 

Yo u can improvc editing performance by crc~lting a sct of miniatures from.thc original 

clips, and then rcplacing the miniaturcs with thc original files whcn you are rcady to 

output the final movie. (For more information on creating a set of miniatures, see 

"Making Miniatures to Improve Performance" on page 41.) If yo u ha ve a controllable tape 

deck, another cffective strategy is to digitize clips at low resolution for editing, 'imd then 

redigitize all the clips in the Project window using Batch Capture. (For more information 

on batch capturing, see "Batch Capturing with Device Control" on page 241.) 

GUIDELINES FOR CAPTURING AUDIO 

With Adobe Premicrc, yo u can c1pturc audio in thc sound channcl of a Video for 

VVindows file oras a Windows wavcform ( .wnv) file. For both types of capture, yo u can 

selcct options that affcct thc quality of the audio files. 

The quality of digitizcd audio and thc sizc of thc audio file depcnd on the sampling rate 

and bit dcpth of the samplc. Thcsc paramctcrs determine how wcll thc analog audio signa! 

is rcprescntcd when it is digitizcd. 1\udio sampled at 12kHz and 16-hit rcsolution is far 

superior in quality to audio s~nnpkd ~lt 11 k Hz and 1'-bit rcsolution. CD audio is normally 

digitizcd at 44kHz and IG-bit rcsolution. :\s with video, howevcr, as quality increases, so 

docs thc amount of data requircd to reprcsent thc samplc. CD-quality aúdio may not be 

pr~1ctical for your video beca use of the memory requirements. 



SETIING UP THE CAPTURE FILE 

When Adobe Premiere captures video, it temporarily stores the video data in a capture file 

on your hard disk until you save the video asan .avi file. If your hard disk is fragmented, 

Adobe Premiere may need to seek additional disk space during the capture, 1vhich may 

result in dropped frames. 

You can preallocate sp<lCC on your hard disk for the capture file so that Adobe Premiere 

does not need to look for additional space as it is capturing data. A preallocated capture 

file is created in contiguous blocks on your hard disk. Adobe Premiere simply reuses the 

same space for each capture scssion, so you do not nced to rebuild the capture file. You 

must, however, sJve the captured dJta toan .avi file when you finish capturing video; 

otherwise, your data will be overwritten during the ncxt capture session. 

To use a prcallocatcd capture file: 

1 Choose Capture File from thc Movic Capture mcnu. Thc Capture File Options dialog 

appears. 

2 Select the Use PrcallocJtcd File option. The Crea te Capture File dialog appear6. 

3 En ter the size of thc capture file in mega bytes. The dialog box shows the currently <L 

able amoUI1t of space on the scratch disk. The capture file size can be up to 2MB less than ... 

thc availablc disk space. Thc capture file is called mpfilc.nvi and is crcated in the root direc­

tory of the hard disk sclccted in the Scratch Disks Prcferenccs. 

4 Click OK. 

SELECTING PREVIEW OPTIONS 

Preview options lct vou specif;· how yuu previcw movies befo re you cJpture them. Ifyour 

1·ideo capture board supports ovcrl<n· prc1·icwing, you can previcw a livc video signJI on 

your computcr monitor. In m-crlay mnck, thc sourcc video passc.:s directly to thc Capture 

window rathcr than bcing processed bythc board. Overlay previewing requires much lcss 

proccssing than docs standard previcwing. 

You can specify thc framc ratc for prcv!c\,·s that you pla;• eithcr before or during capture. 

Dccrcasing thc framc ratc reduces thc proccssing time; incrcasing thc framc ratc givcs a 

more accuratc prcview. 

To use overlay previcwing: 

Choosc Ovcrlav from thc i"vlovic C1pturc mcnu. Thc chcckmark next to Ovérlay indi, _; 

that this fcaturc is turncd on. 

"1.1 \ 



To set the preview rate: 

1 Choose Preview Rate from the Movie Capture menu. 

2 Select the frame rate when previewing and the frame rate when capturing from the 

drop-down lists. 

3 Click OK. 

CAPTURING WITHOUT A CONTROLLABLE DEVICE 

Yo u can capture video to your hard disk in real time by monitoring the signa! in the Movie 

Capture window and recording the frames that yo u want. The effectiveness of this method 

depends on the speed ofyour CPU, the capabilities ofyour video digitizing board, and the 

size of the video frames yo u are capturi11g. Yo u should el ose al! other applications befo re 

capturing. For more information 011 capturi11g video, see "Guideli11es for Capturing 

Video" on page 228. 

Note: Ifyou are using a controllab!c dn·icc to wpturc 11 IIIOl'ic, scc "Caplllring with !Jcvicc 

Control" on pagc 238. ' 

To capture without a controllable device: 

1 Choose Capture> Movic Capture from the File mc11u. The Movic Capture wi11dow 

appears, and the Movie Capture menu appears in the menu bar. 

2 Sclcct rccording options using thc Rccording Options command in the Movie Capture 
-· :'l. 

menu. For more it1formation on rccording options, scc "Sclecting Recording Options:' 

on page 235. 

3 Use the Video Sourcc command in thc Movic Capture menu to sclect a video source 

and sct video sourcc options specific to your system configuration. The dialog box that 

appcars depcnds on thc video d rivcr yo u ha ve i11stallcd: it usually allows vou to choosc the 

typc of video signa!, such as NTSC or Pi\ L. Sec your capture board documcntation for 

more inform;Hion. 

4 Use the 1\udio i{ccording Options Ulllllll;lnd in thc· Mm·ic Capture mc11u to sclcct audio 

options spccilic to your systcm conf1guration. For more i11formation on audio options,sce 

"Capturi11g Audio" 011 pagc 237. 

s Press the Play hutton 011 thc t.! pe dcck to start thc u pe. lf yo u ;m: rccorcli11g images, the 

tape bcgins to prcview in thc sample are;¡ of the Mcl\'ie Capture window. 

,.•, 
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6 Click the Record button to start the recording. You should start the recording 1/2 second 

to 1 second befare the first frame yo u want in your clip, to ensure that the video capture 

board is digitizing at full speed. 

a Movie Carrture t • a 

The pointer disappears during recording. To stop recording, click the mousc button 

or press the Ese kev. When the recording has finished, the clip appears in an untitled 

Clip window. 

7 Use the Savc command to save the clip. 

SELECTING RECORDING OPTIONS 

The Rccording Options dialog box let.1 vou determine how Adobe Premicre captures 

video. The "ideo optinns th.lt ;¡re ,1\'ailabk ckpend on thc video ctptun: driver that is 

instalkd on your system. 

To set recording options: 

1 Choose Capture> Movie Capture or Ctpturc >Batch Capture from the File menu. The 

tvlovie CaptutT or Batch Capture mcnu appcars in thc mcnu bar. 

2 Choosc Rccording Options from the ivlovic Capture mcnu. Thc Rccording Options 

dialog bnx appe;trs. 

· • Recontlno Opllono • 

3 Selcct thc frame rate Cor thc capturcd movie from thc Ratc drop-down list. 



4 Click Video Formar and set the video format options. The dialog box that appears 

depends on your installed video capture driver. Generally, the dialog box includes options 

to set the image size in pixels and the image forma t. Standard image formats include S-bit 

color, 16-bit color, or 24-bit color and RGI3, MPEG, or ]PEG formar. Keep in mind that 

larger image sizes anda higher number of colors increases the size of data for each frame. 

In general, the default compression options for a particular video capture board are the 

most efficient capture settings. For more information about the options in this dialog box, -

see your video capture board documentation. 

5 Click Compression to set compression options for your video board. The dialog box 

that appears depends on your installed video capture driver. It generally provides controls 

to set the compression type and quality for compressing video data aftcr it has been 

captured, which yo u would use if yo u were capturing without hardware compression. 

Beca use many boards use hardware comprcssion, these options are usually not available. 

6 To sct thc rnaximum numbcr of seconds to capture, select Capture Limit. 

7 To capture to memory rathcr th;1n to disk, sclcct C1pturc Dircctly to Memory. 

Capturing to mcmory is fas ter, but it rcquircs a grcat cica! of rncrnory. 

a To ha ve Adobe Prernicre analyze the movie for dropped framcs after video capture, 

sclect the Rcport Droppcd Framcs option. A warning appears aftcr capturing if any frames 

have been dropped. ,, ''· 

9 To cnsurc t)l;lt al! captured framcs havc exactlv thc samc duration,-select thc Ccinform ·• 

Movic To option and sdcct a frarnc rate from the drop-down list. This is a built-in time 

hase corrector. Al! video t;1pc dccks ha ve a poten tia! for framc ratc errors. For precise 

editing, it is importan! that al! framcs ha ve thc corrcct duration. If yo u are capturing at fui! 

spccd (30 fps) and :·o u will be outputting :·our movic to videotape, set the conform frame 

ratc to 19.97. Othcrwisc, sct thc conform framc ratc to thc rate at which yo u are capturing 

video. Adobe Prcmicre adjusts cach captured framc to match exactly the frame ratc that 

you selcct. 

10 If you are using dcvicc contml, sct the following thrce options if they appcar in the 
H.ccordin~ S.:ttings di;do<> box: ..._ .... b 

• Prc-Roll Time. use this option to ;ldjust the pre-roll time that allows thc tape deck to gct 

up to spccd bdorc digitizing occurs. The deLllllt sctting (3 s<:conds) is usual!;· adequatc. 

• Timecodc Oihct. Use this option toen ter ;m ;Jdjustmcnt sctting to calibra te thc capturcd 

framc ratc. For more information, sec· "Calibrating Timccodc" on pagc 24:1. 



• Use Reel N ame as File N ame in Logging Window. Use this option if yo u want Adobe 

Premiere to use the reel na me as the filen ame in the batch capture log. For information on 

batch capturing, see "Batch Capturing with Device Control" on page 241. 

11 Ifyou are using a device control driver that supports step capture, set thc following 

options if they appear in thc Recording Settings dialog box: 

• Average Frames. Use this option to capture the same frame more than once and then 

average the frames to get the final captured frame. Using this option helps correct for the 

jittering caused by freezing on a video frame. 

• 2x Oversample. Use this option to capture video at twice the desired im:1ge size. Adobe 

Premiere thcn scalcs thc imagc to the movic's spccified image size. 

CAPTURING AUDIO 

Yo u can use Adobe Premiere to capture audio as part of a Video for VVindows movie or yo u 

can use a third-party audio c;¡¡1turc program such as thc l'v!icrosoft \Vindows Sound 

Recorder to capture audio as a wavefor111 (. 11'111') lile. You can also capture only the audio 

portian of a Video for Windows movie to crea te a wavcform file, as describcd in \he 

following section. 

To capture audio as part of a Video for Windows file: 

1 Choose Capture> Movie Capture from the File menu. 

2 Choose Record Audio from the /vlovic Capture menu. The checkmark indicates that 

audio capture is turned on. 

3 Choose Audio Recording Options from thc J'vlovie Capture mcnu. Thc Audio Options 

dialog appears. 

Audio OpUrtns , 

f OltiOal 111 lllr l!j 

Rale la B~ · Nnnn w 
1 :me Concel 

4 Sclcct a fonn<ll from thc Formal drop-down list. You can selcct eithcr 11 kl-lz, 22 kl-!z, 

or ·14 kl-lz. 

5 Sclcct arate from thc Ratc drop-dnwn list. You can selcct S-bit or 16-bit resolution in 

either mono or stereo. 

6 Click Oh. 

7 Use the 1v!ovie Capture window lo bcgin rccon.ling. 



To capture audio using a third-party program: 

1 Choose Capture> Audio Capture from the File menu. 

2 In the standard Open dialog, loca te the capture program you want to use. For example, 

to use the Microsoft Sound Recorder, loca te the file so!llzdrec.exe in the Windo•Ns directory. 

3 Click OK. 

4 Use the audio capture program to record an audio file. 

Adobe Premicre remembers the program you use to record audio. The next time you 

choose Captme >Audio Capture, the program is automatically started. 

CAPTURING VIDEO OR AUDIO ONLY 

Yo u can capture Video for Windows movics without the video or audio portion. To record 

the video portian of a movic, choose Record Video from the /vlovie Capture m en u. To 

record the audio portion of a movie, choosc Record Audio from the Movie Capture m en u. 

If an option is not sclcctcd, thc corresponding portion of a movie willnot. be captured. If 

yo u capture only the.audio portian of a movic, it is saved as a waveform file. 

CAPTURING WITH DEVICE CONTROL 

If yo u ha ve a controllablc tape dcck that supports timccodc, a dcvicc controlkr, anda,., 

plug-in module that allows you to control thc tape dcck through Adobe Prcmiere, you can 

<;ontrol thc ópture of video clips by idcntifying thc timecode address for the starting and ·• 

ending framcs (c,1llcd cnpturing ll'ith dcvicc control). You can capture with dcvicé control !· 

only if the sourcc videotape was rccorded with timccodc. 

Be su reto calibra te your systcm if yo u plan to capture timccode with your clips, 

cspcciall;· if \'OU will r<.'digitizc your clips or if vou plan to crea te an Edit Dccision List 

(EDL) from your project. For more information on calibration, sec "Calibrating Timc­

codc" on pagc 245. 

Using dcvicc control has thc follo\\•ing advanl<lgc·s: 
' ' ' 

o Yo u can control thc tape dcck from thc computcr scrcen instcad of switching betwccn 

the computcr and thc tape deck. 

o You can sct in points and out points for clips using the lvlovic Capture or Batch Capture 

windows allll thcn record betwccn tlwse points automatically. 

o You can automatically ath·ancc vour ta¡K dcck to thc framc disphn-cd in the In or Out 

ficld of thc i'dO\·ic Capture windo\\· by :\lt+dicking thc In or Out button in the Movic 

Capture window, or by prcssing 1 orO on the kevboard. 

. l '\'1 



• Yo u can stamp timecode onto the digitized movie if your deck has the capability of 

reading timecodc. Yo u can also calibra te this timecode if the sourcc video has burned-in 

timccode (also called visual timccode, or window clubs). 

• Yo u can capture movies in slow moti un if your dcck is capablc of variable playing 

speeds, and thcn increase the frame ratc after the movie has bcen captured. This lcts yo u 

capture movies at higher frame rates. 

• You can crea te EDLs for online editing in a post-production studio. 

To record using device control: 

1 Choose Prcfcrences > Devicc Control from the File mcnu. Thc Devicc Control dialog 

box appears. 

2 Selcct the device controller you are using from the drop-down list. 

Note: Jfyou nrc tlsing n VJSCA tnpc dcck, youlllliSt havc n VJSCA driver installcd 011 your 
syste111. Thc \IJSCA driver is illcludcd with Adobe J'rclllicrc i11 tite drivers dircctory. )·(¡¡¡ cnn 
sclcct n VJSC;\ dcvice b;· clwosillg MCI VCI\ in tite De vice Control clinlog IJOX. 

3 Choose Capture> ivlovic Capture (or Audio Capture) from thc File menu. The MovÍ• 

Capture windm,· appears. 

Note that thc controls that appcar in thc di,llog box vary slightly according to thc capabil­

itics of thc rccording dcvice. 

4 Select rccording options using thc Rccording Options command in the ivlovie Capture 

menu. For more information on recording options, scc "Selccting Recording Options" 

on pagc 235. 

5 u,c thc Video Sourcc command in thc 1V1ovic Capture mcnu to selcct a video source, 

ami sct video sourcc opt¡ons s¡,ccilic lo your sy.,tcm configur;ttion. Thc dialog box that 

appcars dcpcnds on vour tnst;d\cd ,·ideo capture driver; the dialog hox usuarly lcts you 

choosc thc typc of video sour(c, su eh as NTSC or Pi\ L. Scc your capture board documcn­

tation for more information. 



6 Use the Audio Recording Options command in the Movie Capture m en u to select audio 

options specific to your system configuration. For more information on audio options, see 

"Capturing Audio" on page237. 

7 To identify the recl you are using, click the Reel button in the Movie Capture window 

and type a name in the Reel N ame text box. 

a Use the Jog control, Shuttle control, or control buttons at the bottom of the Movie 

Capture window to control the tape deck and loca te the frames that you want to digitize. 

You can also use these keyboard shortcuts: 

• Press P or the spacebar to play or pause the videotape. 

• Press S to stop the videotape. 

• Press the right arrow key to advance one frame. 

• Press the left arrow key to back up one frame. 

• Press F to fast-for.ward the vidcot~1pe. 

• Press R to rcwind thc videotape. 

Thc timecode display at the bottom of the window shows the current frame. Yo u can cue 

the tape dcck toa specific location by clicking the display, typing in the timccodc address, 

and pressing Return. 1 f vou type a plus ( +) or minus (-) sign befo re the timecode, the deck 

will advance or rewind by the spccificd amount of time. ' 

9' Jdentify thc "framcs ;·o u want capturcd in one of the following ways: 

• As the tape pbys, click thc In and Out buttons to indicatc the starting and cnding 

frames. The timecode addrcsscs for thcsc frames will be entered automatically into 

the In and Out fields. 

• As thc tape plays, press Shift+l to sd thc in point frame or Shift+O to set the out point 

frame. 

• As thc tape pL1ys, prcss thc 1, .J, or 7 kcy in thc numcric keypad to set thc in point framc. 

Prcss thc 3, 6, or lJ kcy to idcntih· thc out point frame. The timecodc addresses for these 

frames will be cntcred ~lutomatic¡lly into thc In and Out fields. 

• Click thc In or Out timccodc d1spbys (or prcss 1 01: 0) and tn'c in thc timccode address 

for thc starting and ending framcs. Yo u can cuc thc tape dcck to the frame displayed in the 

In or Out ficlds by holding down thc Option kn· and clicking thc In or Out button, or.by 

holding down thc Optii>n kc;· ,IJld prcssing 1 or U 011 thc kcyb<nml. 

10 Turn thc /\uto Record option 011. 



11 Click the Record button at the top of the Movie Capture window, or press G on the key­

board. The tape deck searches for the displayed timecode and records the selected images. 

When the recording has finished, the tape deck pauses automatically and the clip appears 

in an untitled Clip window. 

12 Use the Save command in the File menu to save the clip. 

BATCH CAPTURING WlTH DEVICE CONTROL 

This section describes how yo u can log the timecode information for the in and out points 

of severa! clips yo u want digitized, and then have the program capture the clips automat­

ically. This process is called batch capturing. 

Batch capturing is especial! y uscful if yo u want to cdit a movie using low-resolution clips 

and to redigitize the clips later at highcr resolution for outputting your movie. This 

approach improves editing performance in Adobe Premicre and uses less space on your 

hard disk. For more informatitin on using low-rcsolution clips, scc "Using l.ow-Rcsolu­

tion Clips to lmprovc Performance" on pagc 42. 

Generating a list for batch capturing 

Clips are loggcd into a batch list using tl.1c Log 1 n/Out fcature of the Movic Capture 

window. 

The Batch Capture window storcs a timecodc lag-a list of clips with their associatcd 

capture parametcrs. Whcn digitizing a batch list, Adobe Prcmierc uses the curren! settings 

for rccording, comprcssion, video input, ancl audio inputunlcss you havc assignccl 

Settings files (savcd using thc Savc Scttings commancl) to individual clips in thc list. 

Assigncd scttings are loadecl automatic.lllv when Adobe Prcmicrc digitizcs a clip in the 

batch list. 

Yoti can creatc or opcn multipk B.1tch Cq,turc winclows. Creatc a ncw Batch Capture 

winclow In· choosing Cq,tur,· > ll.Jtch C:,¡¡,tur,· from the File mcnu. S,1vc an active Batch 

Capture window by using th,· Sa,·c· COilllll,lnd in thc File menu. Open an cxisting Batch 

Capture window lw ming the Opcn command in the File mcnu. 

Note: Tinzccod,·lo:-:.< intlzc llutclz Czpturc \\'lllrlcnv wn lJC exponer! une/ inzportcd as tcxt files. 

Use ti1e Expurt lo hxt File Wllllllalufn¡ tl1c lJutclz Capture IIICIIuto snve n tilllccorlc log. Use 
tl1c l111port jímn 7(·xt File C01111111111clto in1port u ti111ccodc lo:-: into !111 nctn·c Jlatc/1 Capture 
¡¡·zncloll'. U.<e tlic !lllport/l'x{'urt Scttin:;> COIIIIIlClllcitu rcarrangc tlzc orclcr o( tlic colunzns ¡, 

tlie i111portecl or cxpurtecl tinlet"ucle lug 
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To genera te a timecode Iog for batch capturing: 

1 Choose Capture > Movie Capture from the File menu. The Movie Capture window 

appears, and the Movie Capture menu appears in the menu bar. 

2 Select recording, compression, video input, and audio input options (for more informa­

tion, see "Selecting Recording Options" on page 235). 

3 To identify the reel you are using, click the Reel button and type a name in the Reel 

Name text box. 

If yo u want Adobe Premiere to automatically na me the files in the batch list, click the Use 

Reel Na me as Filename in Logging Window option in the Recording Settings dialog box. 

4 For each clip that you want logged, identify the frames that you want to capture br 

clicking the In and Out buttons as the tape plays, or by typing the timecode into the In and 

Out fields. 

Yo u can use the control buttons at the bottom of the Movie Capture window to control 

the tape deck and locate the frames you want to digitizc. Thc timecodc display at the 

bottom of the window shows thc current frame. Click thc display to entc1: thc timecode, 

and press En ter to cue the tape dcck to that location. 

S Click thc LogIn/Out button or prcss Rcturn to cnter thc clip in the timccode log. 

If yo u do not ha ve a batch list open, Adobe Premierc will crea te an untitlcd Batch Capture 

,window. The timccodc logis updatcd in thc Batch Capture window cach time ,iou click 

the LogIn/Out button. For cach clip in the list, ;¡ sct of c;¡pturc par;unctcrs is displaycd: 

rcciJWlllc, in point, out point, lilcn;nne, ;Jnd scttings. 

6 Use thc Sort button in thc Batch Capture window to sort the list alphabctically and 

numnicall:· b1· thc rccl na me and thc timecode start times. 

To add comments or change batch capture parameters: 

1 Doublc-click a clip in thc Batch Capture window. Thc Clip Capture Parameters dialog 

box appcars with the currcnt scttings for thc clip. This dialog box also appears when you 

click i\dd in thc Batch Capture window, allowing yo u to acld a ncw clip to thc list by typing 

in thc paramctcrs. 

2 En ter upclatcd values for thc rcclnamc, filcname, in and out points, framc rate, and 

timccodc formaL 

3 Add a comment toa clip b:· mtcring tcxt in the Commcnt ficld. 

4 Click OK lo cntcr thc updatcd 1·alucs in thc Batch Capture window. 



To assign settings toa clip in the batch list: 

1 Select the clip in the Batch Capture window. Shift+click additional clips to apply the 

same setting to multiple clips. 

2 Choóse Attach Scttings from the Batch Capture menu. Thc Attach Scttings dialog box 

appears. 

3 Loca te the file that contains thc settings, and click OK. The na me of the attached scttings 

file appcars in thc batch list. For more information on saving scttings, sce "Loading and 

Saving Rccording Scttings" on pagc 244. 

To remo ve the settings, select the clip and choosc Re m ove Scttings from the Batch Capture 

m en u. 

Note: Whcn Ado/Jc Prcmicrc digitizcs n clip with nttachcd scttings, thosc scttings/Jcconlc thc 
CIIITcnt Mov1c Capture scttings nnd ll'ilf[¡e npplicrl to su/Jscr¡uent clips in the /ist tl111t do 1101 

!lllvc attnchcd sctt inc.:s. 

Capturing clips using a batch list 

A small black ckunond ncxt toa clip's rccl namc indicatcs that the clip will be captured 

when you clis=k thc Capture button in the Batch Capture window. You can toggle the 

diamond on and off by clicking to thc ict\ of the red namc. After a cll.p has been captured, 

a check mar k appears in pl~1ce of thc di,unond. A .red X indica tes that an error occurrcd 

whcn thc clip was bcin¡:! digitized. 

You can use thc !-Lmdlcs command in thc Batch Capture mcnu to digitizc extra frames 

bcforc thc in ¡lUint and after thc out point of each clip. Thc in point and out point of each 

clip will not change, but the extra framcs will enablc you to extcnd thc clip la ter, if desircd. 

Note: To opcna ¡m·¡·iousl)' Srli"L"d lintel! Cupturc wiiU!OII", use thc Opcn COilllllilllll in thc 
F!le 111Cllll. 13ntc/¡ wpture lists rn·<" sm•erl "·' text lile.< with rl .pbllilc cxtcnsion. 

To capture clips in thc batch list: 

1 ivlakc su re th~lt thc clips vou want digitizcd appear with a small dianwnd next to thc recl 

namc. lf no dianwnd appears, click to thc lcft o!' the red namc. 

2 Click Capture in thc lowcr right curnc1 tl!'thc Batch Capture windmv. The Sclcct l.ibrary 

di,11Dg box appcars. 

3 Loca te· thc libran· lile 1\·hnc thc capturcd dips are to be placed, or click Ncw to crea te :1 

ncw libran·. 

.• 



After yo u have located the librar y file, Adobe Premiere prompts you to insert the proper 

reel in the tape deck. When you have done so, the tape deck searches for the timecode 

addresses indicated and records the selected images. When all Clips have been recorded, 

the tape deck stops automatically. 

The digitized clips appear in the Library window. The cli ps are stored in the directory that 

contains the library. You can drag clips from the Library window to any Project or 

Construction window. 

Creatrng a batch list from an existing project 

Using batch capture, yo u can redigitize the clips in an existing project and log the clips 

according to their existing in points and out points to create a batch list. -

A batch list lets yo u easily rcdigitize the clips when higher resolution files are needed for a 

project and minimize file sizes bv recapturing only the needed segments from the original 

so urce recl. Yo u can crea te a trimmed batch list ora manual batch list. For more informa­

tion on using low-rcsolution clips and rcdigitizing, see "Using Low-Rcsolution Clips to 

Improve Performance" on page 42. 

To genera te a trimmed batch list, use thc Project Trimmer. All clips are logged according 

to their in points and out points. This minimizes the disk space needed beca use Adobe 

Premicre will recapturc only the trimmcd portian of cach clip in the project. For more 

information on using the Project Trimmer, see "Trimming Projects" on page 31. 
. . 

To manually log project clips in ,1 batch list, drag thcm from thc Proicct windo\v into a 

!Lnch ClJ>turc window. TIK~' are autom;ltically loggcd ;1ccording to thcir origiilal dura­

tion. A1w changcs to thc in ami out points an: discardcd. 

LOADING ANO SAVING RECORDING SETIINGS 

Thc rccording, compressiun, video input. and sound input scttings for any video or audio 

digitizing scssion can be savcd ;¡s a .pe.< file Lw choosing the S;wc Settings command from 
'- 1 .._ ....__ 

the Movic Capture m en u. Yo u can load settings for digitizing ata la ter time using thc Load 

Scttings command in thc rvlovic Capture mcnu. 

Note: Sellin.~sfin liccort! Video or liccoul 1\urlio lvillnot /Jc SIII'Crl in tl1c scllingsjilc i/tiJcy 
/w¡•c hccn tumct! off in t!Jc M1ll"ic Capture 1ncnzt. 

:t. 'i J 
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CAPTURING TIMECODE 

Timecode provides a mcans of accurately locating frames and synchronizing picturc and 

audio elements in video. SMPTE (Society of Motion Picture and Television Enginecrs) 

timecode identifies each video frame with a unique addrcss, in thc form Hours: Minutes: 

Seconds: Frames. For more information, see "SMPTE Timccodc" on pagc 284. 

Capturing timecode with device control 

To cnsurc that thc timccodc is accuratcly rccordcd whcn you use controllcd movic 

capture, calibra te your devicc controllcr (scc "Calibrating Timccodc" on page 245), and 

turn off other applications that may intcrrupt your systcm (such as c-mail, file sharing, 

and special clocks). 

Duririg capture, only the in point of the movie needs to be autorecorded, beca use the 

pre-roll of the deck guarantees the framc accuracy. By default, thc out point timccode is 
greater than the length of your tape; thus, the en tire tape can be captured without setting 

an out point at the end of the tape. Yo u can stop autorecording at any poin t during capture 

by clicking the mouse button. 

Note: Ti1Hccodc capture with co¡¡trollablc dcvices dcpclld5 on thc capa/Ji lit)' ofrour tape de 

I( your tape ílcck Wllllot rcad tlzc ti111ccaJc accumtcly, yo u z¡¡ny lwvc to wlif,rntc yo¡zr 5ystcn1 
or 111<11lllrllly as;igll thc til/lccodc to your lliOvic [Jy nwtchillgji·amcs, a5 dcscri/Jc¡/ i11 thc 
followillg scctioll .. 

Calibrating timecode 

'vVhcn capturing SMPTE timccodc with a controllablc dcvicc, you should makc su re that 

your system is calibratcd. With so me dcvicc controllcrs, changcs to video and audio input 

options can affcct thc timccodc stamping ofVidco for \Vindows movics. As a result, the 

timccodc rcading of thc first framc that appcars in the Clip window m ay not correspond 

to thc timccodc on your videotape. To compensa te for thcsc errors, t\dobc Prcmiere 

prm·idcs ~1 manu~d calibration f'caturc. 

Thc manual calibration fcaturc, callcd Timccodc .Offset, appears in the 1\ccording Options 

dialog box whcn yo u havc a dcvice controllcr sdectcd. Timecode Offset lcts yo u adjust the 

capture ratc in quartcr-framc incrcmcnts. lnmost cases, howevcr, crrors appear in wholc 

framc incrcmcnts. l(J c.1libratc by whole framcs, en ter the numbers inmultiples of four. lf 

thc timccodc displaycd in thc Clip window is grcater than the actual timccode, en ter a 

positivc numbcr in the calibration sctting. Othcrwisc, entcr a negative value by typin¡!" 

minus si¡:n (-j bcforc thc numcric \'aluc. 

\_ ·: { 
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Even when calibrating timecode manually, it is best to use a video source that has burned­

in timecode .. Ifyou do not have a video source with burned-in timecode, you must 

compare frames in the Clip window with frames from the video tape. lf the frames and the 

timecode addresses do not match, change the Timecode Offset value. 

STOP-MOTION CAPTURING 

Adobe Premiere's Stop-Motion feature allows you to perform single-frame manual and 

time-lapse video captures. This is especially use fui for building stop-frame animations, 

whcrc yo u point a camera ata sccnc and record frames as thc scene changes. Yo u can also 

use the Stop-Motion feature to capture a frame and save itas a still imagc. 

Note: Any movic jimnc wn be u sed as a visual guidc for positioning during stop-motion 
cnpturing. Tlze procedure for sctting up a background image work;; tlze samc way for thc Stop 
Motion window as it docs witlz thc Ti tic window. For 111orc infonnation, sce "Setting Up the 
Title Arca" on pagc 193. 

To perform stop-niotion capturing: 

1 Choose Capture> Stop Motion from thc File menu. Thc Stop /v!otion window appears, 

and thc Stop /V!otion menu appears in the menu bar. 

2 Choosc C1pture Options from thc Stop Motion mcnu. The Stop Motion dialog box 

appcars. 

Stop MoUon Opttans 

C41plure tyroe ~ • .ll.'ill 
r;o .. tmovre ... n pld¡; b .. d. di [D [!J hn 

Morumul!l duk lree •pdCe IJ07• \r. 

j Video Fomoet . ) 

1 C01t1'"enion . / 

O< 

C.Ocel 

3 Sct thc l(>llowing rccording optinns: 

• C1pture "!\·pe. Select Time Lapsc for automatic, t imcd rccording of single frarnes. Sclect 

/V!anu;¡J Capture to manually capture single fr<llllCS. 

• Mínimum Disk Free S pace. Set thc minllllum free spacc on :·our disk to be maintained 

during capture. Yo u will be alcrted if the free space útlls below this val u e, thus stopping the 

capture bcfore you run out of disk space. 

'-}l 



• Capture Frames. If yo u are capturing in time lapse mode, en ter the number of frames 

you want captured per unit of time. 

• Capture Limit. If yo u want to limit the number of cap tu red frames, select this option 
and entera limit. 

4 Start your video soun:e (camera or tape deck). 

5 Press thc Start button in thc Stop Motion window. 

• If yo u have the Time Lapse option selccted, Adobe Premiere will capture frames at the 
specificd ratc. Click thc Stop button in thc Stop Motion window to stop capturing frames. 

• If yo u are captunng manually, prcss the Stcp button in thc Stop Motion window to 
capture a framc. l'n:ss a numbcr on thc kcypad to·captucT ~~ spccilied numhcr of contin­
uous frames. Prcss Dclcte to removc the last framc captured. 

6 Prcss thc Done button in thc Stop ivlotion window when you havc finishccl capturing. 
Thc capturcd framcs appcar in an untitlcd Clip window. 

7 Use thc Save command to save the clip. 

To capture still imagcs: 

1 In the Stop'l'vlotion dialog box, sclcct Stilllmage in thc Capture Typc drop-down list. 

2 Click Video Formal and sclcct an S-bit or 24-bit imagc formal. You must save still 
e 

images in one of thesc two fonnats. 

3 Start yc>ur \'ideo sourcc· (c;lllll'l'a or tape deck). 

4 Whcn vou'vc loGJtcd the framc you want to capture, click Capture in thc Stop Motion 
winclc1\, .. Thc imagc is capturcd as ;1 bitmap (.lnnp) fclc ancl appcars in an untitlcd Clip 
wi m! m,·. 

5 Use thc Savc command to sa\·c thc imagc. 



CAPTURING A PALETIE 

Jf your movie will be played back on an S-bit color compute·r, yo u can capture video using 

a color palette that limits the number of colors in the captured movie. Using the Capture 

Palette command, yo u can have Adobe Premiere crea te a new palette for each movie that 

yo u capture; or yo u can load a color palette file that yo u have edited. 

To crea te a palette during movie capture: 

1 Choosc Capture> Movie Capture from the File mcnu. 

2 Choosc C;¡pturc Palette from the Movic Capture window. The Capture Palcttc dialog 

;-tppcars. 

3 In thc Colors text box, typc thc number of colors to create. Type a numbcr between 2 

and 236, or type 256. Although thc total number of availablc colors in a color palette is 

256, vVindows reserves 20 colors for items on the Windows desktop. To avoid ovcrwriting 

those color cntries ;¡nd disrupting the appearance of the vVindows dcsktop whcn your 

movie is played back, you should capture no more than 236 colors. 

4 Type thc numbcr of framcs you want to use to crea te thc palettc in the Fr<lmcs text box.· 

s Click OK. 

6 To save thc palctte, choose Savc Palcttc from thc Movic Capture mcnu. 

To use an cxisting palcttc: 

1 Choosc Loa'd Palctte from thc Movic C.tpturc window. 

2 In thc st;tnd.ml Opcn·di;tlog, locttc thc p;tiettc file (.poi) you want to use. Click OK. 

.,i • 
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CHAPTER 10: TIPS AND TECHNIQUES 

[J his chapter contains a collection of step-by-step procedures for achicving profes­

sional video-editing results using Adobe Premiere. The procedures describe tra­

ditional techniques, such as superimposing figures against a background, as well 

as less convcntional tcchniqucs, such as rotoscoping filmstrips. 

This chapter assumes that you are familiar with the basic featurcs of Adobe Premierc and 
how to use thcm. For information on a spccific fcaturc, se e thc appropriatc scction of this 
user guide. 
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1• A cl1p of an owl 

plays in an 1nset 

while a fceld scene 

plays 1n !he back­

ground. 

Creating insets 

This procedure shows how to crea te an 

inset for simultaneously playing a separa te 

clip in the movie frame. 

1 Start by dragging the clip yo u want to 

play in the background onto track A and 

the clip yo u want to play in the inset onto 

track B. 

2 Draga transition, su eh as the Iris Squarc 
(shown he re), Iris Round, or Zoom transi­
tion, onto thc T track. ( For an cxamplc of a 

Zoqm transition insct, sce steps 22 and 23 

of"Creating a 360-Dcgrec Prescntation" 

on page 271.) 

3 :\lign thc ldt cdgc of thc transition with 

thc bcginning of thc clips ancl thc right 

cdge of the transition 1\'ith thc en el of thc 

clips. Double-click thc transition to display 
the Transition Settings dialog box, and 
sclcct Show :\ctual Sourccs. 

4 To crea te the inset rectangle, he· 
the Shift key and drag the Start slit.. ·' 
right. Holding down the Shift key ca u, 

the End slider to m ove with the Start si 

creating the same size inset rectangles 

both the start and end points of the cli 
that the size of the inset remains const 

Drag to the right un ti! the insct is thc 
desired size. 

. • lrls Sqaare Setrlngs - ,.., ' 

Bt.J .. 
1 ¡~3 

Bordr:r Color • 
o~ i cane .. l 

S To apply a bordcr to. the inset, use th 
Border slidcr to sct thc width; then 

color swatch to display the color pickc1 
and selecta color for thc border. 

-· " Iris Square Sealngs · : 
St11rt =LOS 

11 
' =l 

Bord~r Colnr 

·~1 1 
[; Shuw At;h.O•I ~Uutt;eo 

OJ; 1 1 c-:el 
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6 If yo u want the inset to play on a 

different part of the moví e screen, drag the 

dot from the middle of the Start preview 

window to the desired position. 

· Iris Square Seftlngs · • 

7 To rcposition thc clip within thc insct, 

selcct thc clip on track.B, and choosc 

Motion from thc Clip window to display 

.the Motion Scttmgs dialog box. Click thc 

Start (lcft) point on the motion path, and 

applv a dclay of lOO pcrcent. This kccps thc 

clip stationaí'y and lcts yo u use thc ivlotion 

Scttings rcposllioning fcaturc \\'ithout 

actually applying motion to thc clip. 

---¡'L~ 

i :--,;;.--, 
' 

"--¡]~"'-"" 
~]~..._u ......... :: .,..,,w , ... ~ 

e;~~~ .. :.., ____ }] 
·----~-- ___ : -·c-;,.;-1 ........ . '"· ..... . 

(•l ..... ,.._ 
. ; -R-~.¡- 1 ·--- ... ----- ~-- ------

8 To freeze the motion and preview the 

inset, select the Show Al! option, and click 

the Pause button to the right of the preview 

window. You'll see the background clip 

with a cut-out whcre thc insct will play. 

Click thc Start point of thc motion path 

and drag thc point into thc Visible arca; the 

previcw window changcs to rcflcct thc 

rcpositioning of thc clip. To m ove thc Start 
point in l-point incrcmcnts, sclcct thc 

Start point and press the arrow keys. Whcn 

the clip is centercd within the inset 

window, click O K. 

9 Prcvicw thc rcsults. 

--~,9 
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1• Two sk1ing 

cl1ps play on a 

spl1t screen. 

Creating a split screen 

This procedure shows how to crea te a split 

screcn for playing two clips simulta­

neously. 

1 Start by dragging two clips into the 

Construction window: onc to track A and 

one to thc S 1 track. 

2 Sckct thc cli¡' on thc S 1 trae k, and 

choosc ·rr.msp;rrcnc>· from thc Clip mcnu 

to displa;· thc Transp.rrcncy Scttings dialog 

hox. Use thc dcLrult key typc of Nonc­

you'llusc a garhagc mattc w crea te thc split 

scrccn. In thc Sampk window, drag thc 

handlcs of thc garbagc mattc to crop half of 

the imagc. 

E~-;~~1 

~---··- -¡ 

' 

Coom 

:J~~ •• ~ ... 
::J (¡,..,, '•'-'-• 

._~ ..... IJ .... 

3 Click the page peel icon to 'v 

garbage matte. Use the slidet .. o• 

garbage matte to preview the clip 

the matte. 

¡ 

DL"·"'~'-"·• o .. ~ .. u .... 

~-lw!Q ~ 

__ j E:E:J !~·e_. 1 

· 4 Prcvicw thc rcsults. 

Expcriment with di!Tercnt shapcs. 

garbagc n1attcs. 

· .. · 
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" ;.. chp of one 

· r1~bce pi ayer 

·.:mals away 

::om the screen; 

:ncn a clip of 

.¡nother spirals m 

Customizing transitions 

You can use a transition twice to givc the 

appearance of a new transition. 

1 Start by dragging a clip onto track A and 

aligning it with the 0:00:00:00 mar k on the 

time ruler. Drag the Motion transition 

onto the T track, aligning thc end of thc 

. transition with thc cnd of thc clip. Double­

click the transition to display its dialog box, 

and click the Forward/Reverse selector to 

select R (reversc). This causes clip Ato play 

as it spirals away toa black background. 

2 Copr thc i'vlotion transition; thcn click 

thc section of thc T trae k to thc right of thc 

original, and paste thc cop)·. Draga sccond 

clip onto trae k t\, aligning it tlush lci't with 

the first clip. 

3 Preview the transition. Noticc that thc 

second clip opcns at full-scrcen whcn 

the first clip cnds. To make the sccond dip 

appcar to spiral back in, double-click thc 

second transition to display its dialog box, 

and click the track selector so that it points 

u p. Select thc right cdgc selector, and 

changc the Forward/Revcrsc selector from 

R to F. 

Motlon Sctllngs · • 

1 c;\111 • .,. • 1 "' 

4 l'rcvic·w thc rcsults. 

Try this tcchniquc with othcr transitions 

that swing in and out such as thc Spin, 
Swing In, Swing Out, Splil. and \Ni pe 

transitions. 

'{' .. 
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1~ As a sw1mmN 

move~ acres~ the 

screen, tne 1mage 

out~1de the S 1S con-

verted to grayscale. 

Applying filters to isolated areas of clips 

Yau can apply a filter ta an isalated area 

af a clip using the Jmage Mattc kcy type. 

1 Start by dragging a clip anta the SI track 
af the Canstructian windaw, and then 
capy and paste the samc clip anta track A. 

, . ... · Construdloñ Window a 

2 Crea te a still image to use as a ke)' ar 
"mask." Yo u can use a lcttcrform ar abject 
crcated in thc Ti tic window. as in this 
cx;unpk; or you can use ;Jll 1111.1gl' crc;l!cd 

in ¡\dobe l'lwtoshol'· 

' 3 Select the clip an the S 1 trae' n 
chaase Transparency fram the ... p 
ta display the Transparency Setting: 
bax. Sclect the Image Matte key typ 
Chaose, and select the still-image k 
just madc. Thc Sample windaw prc 
the image matte. Sclcct Rcverse Kc1 
invcrt the efícct.' 

. -- - S•mpl~ ·---

·'·r¡· 1~ 
~ . - i 

S !!•• .. •• ~., 
o,,..,.-...... ~­
o .. ~·•u·•· 

4 Selcct thc clip on trolCk A. Chaosc 
i'rom the Clip Ille!HI to display 1 

diodos l1o:-; .1lld sc·lect '' filtn tl1 apph· 
Lit p. This ,.-xatllplc· used thc Black & · 

filtcr tl1 con\'crt thc· color imagc toS' 
sea le. l(ccp in mind that if yo u use a 
that doesn't alter the clip's color. thc' 
may he suhtk. 

5 Pr,·,·icw thc rcsults. 
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" The gray values 

ola clip of rl!IHllll9 

horses are superim-

posed over a st1ll 

image of stone. 

Adding texture to movies 

Thc Lumin~ncc kcy typc ;dlows \'OU to 

supcrimposc mm·ics o\·cr tcxturcd back­

grounds, so that thc supcrimposcd mm·¡c 

assumes thc tcxturc of thc background. 

This pmccdurc wurks hc·st with im;l~c·s 

1\'ith a widc r.1n~c uf ~r.1v \'alucs bcGIUSc 

thc Luminancc kcy option kcys just thc 
orav valucs uf an inld~'C withnut kc\'11111 o . ~ ' ~ 

thc color. 

1 Choosc a clip to pby 0\'L'I' t he back­
ground; thc clip should h.tve a widc r.tngc· 
of grav valucs. Ncxt, choosc a tcxturcd 
background for thc nHwic, cithcr a still­
imagc clip ora movic clip. 

2 Drag thc tcxturc clip onto tr~ck :\, ;tml 
drag the clip you want to supcrimposc 
onto thc S 1 tl'ack. 

Note: \1'/,c" us111g ,, still-i111ngc clip Jcn , 
!CX{/li"C, }'0/l Ol/1 Stl\'C C011IJlifing 1111/C [J_\· 

clf'{'lyillgjiltcrs or c((ccts to tilc dip in;\,. 

PllolciSiu>p. Tilcn i111port tilc sti/1 inwgc 

:\c/,,/Jc l'rc111icrc. 

3 Sdcct thc clip on thc S 1 trae k. Cho<> 
Transparcncv from thc Clip mcnu to 
displ.ty thc Transparcncy Scttin~s dial. 
box, ami sckct thc l.uminancc kcy l)'J'• 

Click tlll' pagc pccl icon to prcvicw ¡¡,, 
L'ikct of thc kcy on thc clip on track 1\ 

Drag thc Thrcshold and Cutoff slidcrs 
control which ~ray valucs are supui111 
poscd and to adjust thc brightncss of ti 
grav val u cs. 

Tt S • 

....... 
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! 
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4 Prcvicw thc rcsults. 
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256 1-Ciwpter 1 O 

~~ A f1gure and its 

shadow are suoerim­

posC'd over ¡¡ map 

Superimposing figures against a background 

Using the Chroma key type, yo u can isolate 

a figure and then superimpose it over a dif­

ferent background. 

1 Start by videotaping a figure against a 

bright, plain background. Thc background 
should be a color that contrasts with thc 

figure becausc thc goal1s to isolate thc 

figure from the background. This example 

uses a uniformly lightcd, in tense bluc 

(called chromn bli1c) background. The bluc 

background works wcll bccausc skin tones 

typically contain no blues. The contrast 

between skin tones and background mcans 

that the keying process in Adobe Premiere 

won't kcy out ( that is, make transparent) 

anything other than thc background. 

2 Drag thc clip of the figure onto the S 1 

track. and draga clip or thc background 

you want to t!SL' onto track A. You can use 

anything for the background clip; this 

cxamplc (sec stcp 7) u sed a still-imagc clip 

ofa map. 

3 Select the figure clip on the S 1 t. ., . 

eh o ose Transparency from the Clip me 

to display the Transparency Settings di" 

box. Select the Chroma key type. 

:_~;~y: ~pi¡~]; 
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4 Specify the color to key out (in this c. 
bluc); thc dcfault masking color is whitc· 

the Color scction of thc Transparency 

Scttings dialog box, use thc eycdroppc1 
too! and click to "1m pie thc bluc 1- 1,. 

gruund of the clip. Thc previcw ÍL .e' 

S" m pie wmdow ch;u¡gc' to relléct thc· -• 
s.1mplcd color; the ;J!'c'.lS that appcar wl1 

will be the arc.1s through which thc cli¡' 

track t\ plays. Click the pagc pccl icon ¡, 

prc,·icw thc clip through thc kev. 
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5 Use lhc Similarily sliJcr to adjusl lhe 

range of color.s lhat are kc)'ed out. Drag lhc 

slidcr to 1hc right untd all of the back­

ground appcars white in lhe Sample box. 

You may nccd to expcrimcnl by sampling 

ditkrcnl hlue pixels from diffcrent arc;ls of 

lhe Colm hox, ami lhen rcadjusling lhc 

Similarily slidcr lo scc which scttings gtvc 

thc bcst results. Use thc Smoolhing oplion 

to soflcn lhe cdgcs between lhe lígure and 

thc kcycd-oul background. Click lhc zonm 

tool, and then click the prcvicw lo see lhe 

kcying cffccls. Thc hand lonl kls you sctnll 

around lhe prcvicw. 
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6 Use lhc Threshold slidcr lo control how 

shadows in 1he clip are keycd out; moving 

!he slider lo lhc nghl incrcases lhc amounl 

ofshadow lhat will he includcd in thc kq•. 

Use lhc Cutoff slidcr lo control lhc trans­

p.ncncy of lhc shadows. 
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7 Prcvicw the rcsults. 
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an audto cltp of a 

man talkmg leads 

h!S VIOE'O. 

Creating a split edit 

A common edit in video is a split edit 
where, for example, a clip's audio leads the 

video while another video clip plays 011-

screen. Starting the seco11d clip's audio 

befare its video produces a more gentle 

tra11sition. To ueate a split edit, youlock 

either the audio or video track, and then 

edit the unlocked trae k. This proccdurc 

maintains a synchronizcd link between the 

audio and video clips. 

1 Dr.tg a movie clip that has linked ,\lidio 

onto track A in thc Construction window. 

Dr;tg ,\ second clip that has linkcd audio 

onto track :\ next to th,· lirst clip. Lock the 

audio track b~· Alt+clicking the track !abe! 

to thc right of thc trae k. Locking thc tr;tck 

lets you edit linkcd tracks indcpendently. 

l ... /otc: )(n¡ t"tl!J n!so flt'l:f;}/'fll rlus proccdurc 

l•.t·l.,d;ing t!It· l"lri<·<' ll<l<"k <11Itl ,·,/itiu~ tire 
tllltlio trílt'f.. 

2 To precisely adjust the edit point 

between the two video clips, open the 

Trimming wi11dow and click the Next E. 
button to view the frames 011 either si de 
the edit point. To perform a rolling edit 

( that is, adjust the duratio11 of the adjacc 

clip as yo u edit the first clip), m ove the 

pointer betwee11 the two frames and dra 

lcft or right to tri m thc clips. Thc other 

clip's duration is shortcned or lcngthenc 

,to offset the adjustmcnt. 

Editing bre;lizs thc link betwccn th. .k< 
and ;wdio ;tnd inscrts a soft link. Once 

you've madc the split cdit, a red trianglc 

will appcar at thc bcginning of the clip il 

thc audio and ,·ideo gct out of svnch. 

Rcs~·nchronizc thc clip by clicking the re• 

triangle and dragging to select the amotll 

that appcars in thc pop-up mc11u. 

3 Unlock thc audio track that yo u lockc·, 

in step l. 

l e ,-



7 Click OK to set the output options; then 

choose Make Movie from the Make m en u. 

8 N ame the file and die k O K. 

Note: Exportcd filmstrip files lose any audio. 
Be su reto save the so urce clip with in and out 
points ifyou planto relink the filmstrip to its 
original audio. 

9 In Adobe Photoshop 2.5 or higher, open 

the filmstrip. The filmstrip opens as a series 
of frames in a column, with each frame 
labeled with a number anda timecodc. 

10 Use all)' of the Adobe Photoshop 
_ painting tools lo dr:1w on or paint thl' 

fr:uncs. You llll!St rcpcat thl' <.ksign ovl'r 
severa! fr;l\lles for it lo appc·ar \\'hl'll you 
play the movic. The numbcr of fr;uncs 
to paint depcnds on the frame ratc of 
your n1ov1c. 

For example, with a frame rate of !5 fps, 
you should paint a design in 15 frames to 

have it play for 1 second. If yo u selected a 

Field option in step 6, there will be two 

filmstrip frames per source frame. 

For editing guidelines, see "Modifying 
Filmstrips in Adobe Photoshop" 

on page !06. 

Adobe Photoshop 2.5 and higher has spe­
cial commands for moving selections pre­
ciscly from frame to framc in a filmstrip. 

Using any of the Photoshop painting tools, 

you can retouch flaws in the original foot­
age, or make random marks from frame to 

framc. You can also use thc rubber stamp 
too[ to clone parts of one frame onto 

another. 

;) 



This example shows the lasso too! used to 
select background areas. The areas then 

were filled with color and patterns. 

Yo u can paint ovcr thc gray bordcrs 

bctwecn framcs. Do not, howcvcr, scalc or 

crop thc tilrilstrip. 

11 When you have finished painting, save 

your file in the Filmstrip format. 

12 In Adobe Premicre, open the roto­

scoped filmstrip in a Clip window, and 

preview the results. If yo u creatcd the film­

strip with separa te tields in stcp 6, choosc 
Ficld Options from the Clip mcnu, and 

select thc Interlace Consccutive Framcs 
option; this instructs thc program to intcr­
lcavc thc fidds back togcthcr. 

Note: J(you 1111151 n·Jink your.filntstrip witit 

tite audio, drag tite originall'idco tlllli medio 
clip 0111011 tmek in tite Conslmctionwi11(/aw 

and cul tite l'ideo portian. Dmg tite cditcd 

.filtttstrip clip onlo tite entpl)' 1·ideo tmck, and 
sclcct IJOtit tite clip tll/(1 tite audio 10 crea/e 11 

so(t link. 



~~ A clip of clouds 

m rnotmn plays in 

the background 

wh1le a clip of a 

tyclist plays with1n 

,1 zooming mask 

uf squares. 

Playing a movie through a traveling matte 

This procedure shows how to !ayer a movie 

that plays within a moving mask-called a 

traveling matte-on top of a background 

movze. 

1 Start by dragging the clip that will play 

in the background onto track A in the 

Construction window. Drag the clip that 

will play within the moving mask onto the 

S 1 track in the Construction window. 

Adjust thc length of the clips so that thcy 

match. 

2 Ncxt, C!·catc thc m;tSk in which you w;mt 

a clip to play. This cxampk uscd four 

simple shapcs creatcd with thc polvgon 

too! in thc Title window; savc thc titlc when 

vou haw linishcd. 

You can also importa lile from Adobe 

Photoshop tor vour mask. 

Note: Whcn importingfilcs from Adobe 
Photoshop, yo u should use cither a /Jlack­
and-white file or gmyscalc file; color files 11111 

produce wzcxpccted results. 

3 To apply the mask to the clip on the S 1 

track, first make the Construction windm 

active and add another superimpose (S) 
track by choosing Add/Dclete Tracks fron 

the Project menu, and entering 4 in the 

Total Video Tracks field. This adds a track 

labcled S2 below the S 1 trae k. Drag the 

mas k clip onto thc new S2 trae k. ami adjm 

ib length to m;1tch thc othcr dips. 

4 Sckct thc movic clip on thc S 1 trae k; 

choosc Transparcncy from thc Clip menu 

to disph1)· thc Transparency Settings dialog 

box. Choosc Track Mattc from the"Key 

Tn'c drop-down lis t. Thc Track lv!atte ke)· 

type uses the lightcst areas of the clip on thc 

track bclow as a mask, and "tracks" any 

motion applied to the clip. 

., . 



Click the page peel icon and drag the slider 

below the Sample window to previcw the 

effect; the movie clip on track A should 

appcar in the mask, and the movie clip on 

the S 1 trae k should appear in the back­

ground behind the mask. Selcct Rcvcrse 

Key to make thc movie clip in S 1 appcar 
within thc mask. 

- Uonc C~lu< 

~ ¡; r===J 

~U.U:.~ 

5 Now apply motion settings·to thc mask 

to makc it movc by sclccting thc mask clip 

un thc 52 track and choosing tvlotion from 

thc Clip mcnu. The Motion Scttings dialog 

box appear-s. Sclect thc Show All optionto 

prc,·iew thc maskcd clip in motion. Click 

thc Pause button to frcczc thc motion. 

: IO;i;l --. ' .. ,., -···" 

¡~J 
::...~~ 

6 l'vlovc thc St;Jrt and finish points of thc 

motion path. "~" add points to thc path to 
crea te thc motion you want. 

For example, e reate a zoom cffect by selcct­

ing the Start point and entering O in both 

coordinate fields to ccnter thc Start point 

in thc framc; then apply a zoom of 25 pcr­

cent to the point. 

7 Ncxt, sclect thc Finish point on thc path 

and ccntcr it in thc framc by cntcring O in 

both coordinare ficlds; !cave thc zoomlcvcl 

at 100 pcrccnt. This makcs thc maskcd clip 

appcar to zoom in fnn11 thc ccntcr of thc 

background clip. 

. ....... ~.... . 

Note: ·¡¡, sclcct srtcccssi¡•c f'Oli11S 011 tl1c 

t11otio11 patlr "''"'11 tlrcy are positw11cd prc­
ct.<cly 011 /Of' o( caclt otlrcr, prcss tl1c 7ir/J kcy. 

... 
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1• One cl1p of a 

spons se ene makes 

the trJnSitlon into 

another behind 

a sportscaster. 

Using virtual clips to nest transitions 

This example shows how to use the virtual 

clip fea tu reto crea te a transition between 

two clips that are playing within an inset. A 

virtual clip is a "snapshot" of an area in the 

Construction window that is used as a clip 

elscwhcrc in thc Construction window. 

1 Start by importing thrcc clips: onc to 

play as the m a in movic and two to play in 

thc insct. Dr,tg thc first clip for thc insct 

onto track A in the Construction window 

and drag the second clip for thc inset onto 

track 13. Arrangr thc clips so thal thcy 

overlap by at lcast one second. 

2 Drag the Clock Wipc transition onto 

track T and·;llign it bctwcen the two movic 

clips. Adobe Premie re automaticallv 

adjusts the kngth of thc transition to 

match thc amount of ovcrlap. 

3 To make the clips and transition act 

as one clip, combine them into a virtual 

clip. Todo so, sclect the virtual clip too! 

and drag to select the block of clips and 

the transition. Then place the pointer 

inside the selcction; it changes to the 

virtual clip icon. 

4 Drag thc sekctcd block of clips toan 

open space on track B. l'review thc virtu.1 

clip by dr.1gging through thc tin1c rukr. 



S Drag the Zoom transition onto the T 

track above the virtual clip, and adjust 

the length of the transition to match the 
length of the virtual clip. Drag thc third 
clip onto track A (this example uscd 

footage of a sportscaster), and adjust its 

length to match the virtual clip and 
Zoom transition. 

6 Now use thc Zoom transition to make 

the virtual clip play in an inset window. 
Todo so, double-click the Zoom transition 

to display the Zoom Settings dialog box 

and sclect thc Show Actual Sources optl<Hl. 
Hold clown thc Shiti key and Jrag thc Start 
slider to the right un ti! the insct window 
is the dcsired sizc; holding down thc Shift 
kcy causes the Ene! slidcr to m<Ívc with thc 

Start slider. 

The Zoom transition scales the virtual clip 

to fit within the inset; setting the Start and 

End sliders to the same val u e constrains thc 
zoom inset window to thc samc sizc for thc 
duration of the clip. 

Zoom Settlngs 

7 In the ccnter of thc Start windnw, posi­

tion thc pointcr ovcr the small squarc; 
when the pointer changes to a finger, drag 

the square to rcposition thc insct vtindow. 
ClickOK. . 

Zoom SeUings '"' · 

lloulrr ~~ ~~ti 

8 In the Construction window, adjust the 

work arca bar to extcnd across the virtual 

clip and previcw thc rcsults. 

... 
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1• Five c!rps of 

sea scenes play 

simultaneously on 

the surfaces al a 

three·drmensional 

space. 

Creating a 360-degree presentation 

This procedure shows how to use transi­

tions a11d a series of virtual clips to crea te a 
three-dime11sional spaceeffect with movies 

playi11g 011 five separare "walls." This two­
part procedure rcquires fivc clips of cqual 
duration to play on thc walls. 

In thc f¡rst part of this proccdurc, you 
crea te gradient fills that will be supcrim­

posed ovcr each clip a11d add dimensional­
ir y to the fi11almovic. 

1 Start by draggi11g thc clip that will play 
011 the ceili11g unto track A a11d align the 
clip with the start of the time ruler; then 
drag thc ncxt three cli¡)s 01110 trae k r\ in the 
following order: floor, right wall, a11d left 
wall. Leavc the clip that will play on thc 
back wall in the Projcct window. 

2 Next, create a grayscale gradient that 
will be superimposed over the clips. Opct 
a 11ew Title wi11dow by choosi11g 
New > Title from the Filcme11u. Set the 
gradation start color to black a11d the 
gradatio11 end color toa medium gray. 
Thcn use thc fi!lcd rei:tanglc too! to draw 
rcctangle that covcrs thc lowcr half of thc· 
wi11dow. 

3 Rcverse thc dircction of the gr,1dicnt 
lw clicking thc tri.mglc at thc bottom 
Centcr of thc gmdient S\\',l!Ch; cha11ge thl' ·~~· . . 
opacity or the gr.ldicnt ene! color to J 

1 perccnt by clicking thc right triangle 
above the ene! color sw,nch and dr,1gging 
the gradient swatch to 1 percent. Savc the 
title as cciling.ptl. 



4 Drag the title onto the S 1 track in the 

Construction window, aligning its left edge 

with the beginning of the project. Stretch 
the right edge of the title clip until its dura­

tion match es the ceiling clip on track A. 

5 With thc titlc clip sclcctcd, choosc 

Transparency from thc Clip mcnu to 

display thc Transparcncy Scttin¡;s dialog 

box. Appl)" thc Multiply kcy typc. Click thc 

pagc pccl icon bclow thc Samplc window to 

previcw thc kcyapplied to thc clip. The clip 

is darkcncd at thc bottom whcrc thc supcr­

imposcd gradicnt is black ami changcs to 

its actual color gradu.1llv whcrL· thc . ; 

gradil'nt is gr.ty and thcn whitl' . 

....... 

~~~ ~·~~:! 
~-----------

When the clip plays on the "ceiling," the 

shading makes the clip appear darker as it 

recedcs to the back wall. 

6 Repeat steps 2 through 5 to crea te threc 
additional superimposcd gradicnts for thc 

other walls of the room. Use thc trianglcs 

located a long the si des of thc gradicnt 
swatch lo changc thc dircction of thc gradi­
cnts as follows: thc gradicnt for thc floor 

clip should st<lrt with black at thc top and 
fadc to l perccnt opacity in thc middlc; thc 
right wall gradicnt should start with black 

on thc right sidc and fadc to l pcrccnt 
opacity in the middle; thc left wall gradicnt 

should start with black on thc lcft sidc and 
faLk to l pcrccnt op;Kity in thc middk. 

267 
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In the final part of the procedure, yo u use 
the virtual clip feature with the four clips to 
build the three-dimensional movie. 

7 Select the range select too], and drag to 
select just the ceiling clip on track A and its 
superimposed gradicnt on the S l track. 
M ove the pointer inside of thc selection; 
the pointcr changes to thc virtual clip icon. 

8 Dr<tg thc sclcction onto thc blank spacc 
at thc cnd of !rack A. Thc two clips are 
compositcd as a virtual clip. 

9 Repeat steps 7 and 8 for ea eh clip and it 
superimposed gradient, placing the virtu. 
clips on track A in the same order as the 
source clips. 

10 To makc thc first virtual clip appear t< 
play on thc cciling, drag the Swing In tra1 
sition from the Transitions window onto 
the T track in thc Construction window. 
Adjust thc transition's duration to match 
thc first virtual clip on t.rack A. 

... 



11 Double-click the Swing In transition to 

display the Swing In Settings dialog box. 

Select the Show Actual Sources option. 

Hold clown the Shift key and drag the·Start 

slider to 25 pcrccnt. (Holding clown the 

Shift key adjusts the Start and End sliders 

simultaneously, kceping the effcct constan! 

throughout thc clip.) Click thc track 
selector so that thc blue arrow points up; 

thcn click the top cdge selector to makc thc 

clip play on thc cciling. 

• SWing fA SetUngs ··' 

12 Using thc rangc sclect too!, drag to 

sclcct thc first virtual clip and thc Swing 

In transition. 

13 Drag the block of clips onto track B, 

creating a new virtual clip, and align its 

in point with the end of the Swing In 

transition. 

14 To i:rcatc thc !loor and combine it with 

thc cciling, sclcct thc Swing In tr:msition 

on thc T track, copy it, and paste thc copy 

onto thc blank arca of thc T trae k ncxt to 

thc original. 

.... 
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15 Double-click the copied Swing In tran­
sition, displaying the Swing In Settings 
dialog box, and select the Show Actual 
Sources option. Click the bottom edge 
selector, and click OK. 

swtng In SetUngs • · 

florder Color 

11 

16 Using the range select too!, drag to 
select the second column of clips 
containing the ceiling and floor clips. 

17 Drag the column of clip> onto thc blank 
spacc on track ll, ncxt to thc cciling 
virtual clip, toe reate a sccond virtual clip 
on t r:ll'k B. 

18 Paste a third copy of the Swing In tra1 
sitian onto the T track. In the Swing In 
Settings dialog box, select the Show Actu. 
Sources option, and click the left edge 
selector. 

· • Swlng In Settings 1 1 

norder Color 

111 

19 Use the range select too! to select the 
third column of clips containing the 
ceiling, floor, and left wall clips. Drag thc 
selection onto the blank space on track B 
to crea te a third virtual clip. 

20 Toe reate thc right wall of thc movie, 
p:~stc" fourth copy of the Swing In trans1 
tion ncxt to thc thircl copy on the T track. 
In thc Swing In Scttings dialog box, sdcct 
thc right edge selector. 



-------------------------------------------------------------------------, 

21 Use the range select too! to select the 
en tire column containing the last Swing In 
transition, and drag the fourth and final 
virtual clip onto the empty space at the end 
of track B. 

22 To makc thc back wall of thc movic, 
draga new clip from the Project window 
onto track A, and align the clip's start and 
end points with those of the last virtual clip 
in track B. Drag the Zoom transition from 
the Transitions window onto the T track 

bctwcen the new clip and the last virtual 
clip. Adjust thc duration of the transition 
to match the clips. 

23 Double-click the Zoom transition to 
display the Zoom Settings dialog box. 
Select the Show Actual Sources option, and 
click the track selector so that the arrow 
points u p. Hold down the .Shift key, and 

drag the Start slider to 51 percent. 

Zoom Sdtlrtgs - - . ' 

24 Adjust thc work arca bar so that it 
covcrs only thc column containing thc 
back wall clip and thc last virtt!al clip. 
Preview the movie. 

You can substitute different clips for the 
walls and ceiling of your movie using the 

Paste to Fit command. Thc virtual clips are 
automatically updated to reflect the new 
sourcc clips. 

i2 
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• , A lago and other 

graphic elements 

are an1mated and 

":>uper1mposed 

over a movie of 

J sp1nnmg globe. 

Animating graphics 

This procedure shows how to crea te ani­

mated graphics in the Title window and 

then superimpose them over rnovie clips 

using motion settings. 

· 1 Start by dragging a rnovie clip onto !rack 

A in the Construction window. Choosc 

Construction Window Options from thc 

\Vindows mcnu. In thc Construction 

Window Options dialog box, selcct thc 

Video and Supcrimposc track display 

options. 

2 Open a ncw Title window by choosing 

Ncw >Ti tic from thc File mcnu. 

3 To use a framc of the movic clip in thc 

background for positioning thc titlc, open 

the movic clip in a Clip window and drag 

the clip into the Titk window. Thc lirst 

fr.unc of thc clip ;1ppears in thc back­

ground; it docs not bcnnne part oi' thc 

lit k clip . 

4 To change the clip frame appearing in 

the background, scroll through the movie 

to loca te the desired frame in the Clip 

window, and then assign marker O to the 

frame. The frame in the Title window is 

automatically updated to that frame. 

,.~ ~· . 
·'.· .· ·.\:: \ 

5 Use thc Ti tic window tools to crcate thc 

graphic clcments. Draw ;1 squarc with the 

filled rectangle too! by holding down the 

Shift key as you drag. Crea te a color . 

gradicnt by clicking thc small réctangular 

swatch to the lcft of thc palcttc to display 

the color picker, and selecta start color. 



6 Complete the gradient by clicking the 

small rectangular swatch to the right of the 

palette and selecting an end color. Set the 

opacity of thc squarc by positioning thc 
pointer on the triangle betwcen thc two 

small swatches, and dragging to the 
desircd value. 

7 ·¡;, nc.llc transp.trcnt di"c·ct,, add 
ckmcnts ;111d sct thcir lill opacit)· to ckar. 

For cxamplc, use thc typc toolto l.tycr a 
numbcr (wcr thc top of thc squarc, and 

thcn sct its opacity to clear. 

8 To center the elements in the window, 

choose Center Horizontally or Center 

Vertically from the Title mcnu. Dcsclect 

the el cm en ts. 

9 To superimposc thc tille ovcr anothcr 
clip, save the title, and then drag it onto thc 

Sl track in thc Construction window. 

Adjust the length of thc titlc clip to match 
the movie clip. 

10 'vVith thc tille dip sckctcd, d~<HlSC 
Transparcncy i"rom thc Clip tncnu to 
display thc Transparcncy Scttings dialog 
hox. Sckct an appropriatc kcy typc. (\Vhitc 
Alpha Mattc was uscd for this cxamplc.) 

Click the pagc pcel icon to prcvicw thc kcy. 

',.,_,. 1 

!i 
1 ' 
~--~-~ 

Note: Whcn applring nzotiou in Aclobc 
l'rcnricrc 4.0, thc progrcun autontlltica/ly 
sclccts tilc kcy typc using a l>cst gucss. 
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11 To anima te the title, select it in the 

Construction window and choose Motion 
from the Clip menu. In the Motion 
Settings dialog box, select the Show All 
option to see the title superimposed over 
the clip. Click Pause next to the preview 
window to freeze the motion. Click the 
Finish point (right end) of the motion path 
and m ove it into the Visible Area; the 
preview window updates to show the repo­
sitioning of the finish point. To center the 
finish point within the frame, en ter O in 
both Info fields below the time line. Posi­
tioning the Start and Finish points as 
shown makes the title roll in from the left. 

--; ------ --- ¡¡;¡¡-,.;;-~-. -- . 
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12 Crea te an additional graphic elerrient in 
a new, separa te Title window. In this 

example, a rectangle was created with a 
gradient fill. To make the gradient appear 
to fade into the background clip, set the 
opacity to a low percentage. 

13 Add an additional S track to the 

Construction window by choosing 
Add/Delete Tracks from the Project menu 
and entering 4 in the Total Video Tracks 
field. Drag the second title onto the new S2 
track, and adiust·the length of the clip to .~ 

match the othcrs. · 



14 To apply a key type to the title without 

opening the Transparency Settings dialog 
box, position the pointer over the clip in 
the Construction window and press 
Shift+Alt. Click the clip to display a pop-up 
menu, and drag to selecta key type. 

15 Select the sccond titlc clip in thc 
Construction window and choose Motion 
from the Clip window todisplay the 
Motion Settings dialog box. Selcct thc 
Show All option to prcvicw thc back­
ground movic clip, including thc first 
supcrimposcd graphtc. 

16 Click the Pause button to freeze the 

animation. Click the Finish point of the 
motion path, and drag to reposition it. As 
you drag, the prcview changcs t6 show the 
positioning of thc background movic and 
each superimposed graphic.Sct thc Start 
and Finish points as shown in thc following 
illustration to makc the rcctangle roll in 
from thc top and land prcciscly ncxt to thc 
first graphic. 

------~...;¡, ... ~------ -

17 Crea te additional graphics using thc 
Titlc window, and add additional S tracks 
for supcrimposing thc graphics. 

18 Prcvicw thc rcsults. 
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t• Thrt•c dips <,hot 

'frorn difieren: 

camera angles are 

combined ustng 

S tracks. 

Making multicamera edits 

Yo u can use this technique to edit severa! 

movie clips of the same subject shot simul­

taneously from diffcrent camera anglcs, or 

to cdit severa! clips that sharc the same 

audio.lnthis procedure, you'lluse only the 

S tracks and adiust the fadc controls to cut 

between the different views while preserv­

ing the audio. 

1 Start in thc Construction window by 
adding additional S tracks using thc 
Add/Dclctc Tracks command from the 
Projcct menu. To displa); thrcc S tracks, 

sct thc total numbcr of video 1 racks to 5. 

Lea ve thc numbcr of audio tracks at 3. In 

thc Construction Window Options dialog 

box, dcsclect thc Transitions/Track ll 

display option; make su re that the othcr 

Track Display options are selectcd. Drag 

thc first clip onto the S l track. Thc audio 

port~on appears on thc XI track. (Lea\'C 
track A cmpty.) 

2 To copy only the video part of the second 

clip (with identical audio), hold down 

Shift+Alt, select the clip's video thumbnail 

in thc Projcct window, and drag thc clip 

onto the 52 track. Repeat this step for thc 

third video clip. 

3 Click the Fade control to crea te handlcs 

(black dots), and clrag the handles lo crea te 

visual cuts from onc clip lo the next. lly 
dcfault, clips on.highcr numberecl S tracks ., 
dominatc lowcr numbcrcd tracks. To clrop ; "1 

thc fadc lcvcl toO pcrccnt and reveal the S:' 
track undcrncath, use thc fadc scissors too! 

(in the extended tools pop-up menu); click 

thc bottom of thc 53 track to crea te two 

m·w hancllcs closc togcther. 



4 Use the fade adjustment too! to move 

the segment uniformly, and drag the right 

segment to the bottom of the bar. This 

changes the fa de leve! toO percent, to rcveal 

thc 52 track underncath when yo u preview. 

'{ou can use thc Info window to scc thc 

cxact Fadc Leve! pcrccntagc as you make 

changes. 

Note: Tlzc dist11ncc /;ctwcclt thc lwndlcs (tlzc 
black dots) dctcnnt11es tlzc [11dc m te {Jctwcclt 

c/ips. For 11 111orc gmdu11l [11dc, sprcad the 

h11ndlcs 11part. To wt dircctly to the next clip, 

c/ick using thc fa de scissors too/ [ro111 thc 
extended tools pop-up lllCIIli. Gmdu11l fadcs 
takc 111orc ti111c to prcvinv. 

5 ·¡¡, f.~ek from thc clip on thc S~ tr.tck to 

thc clip on thc S 1 track, m ove thc pointcr 

slighth· to thc right in thc Fadc· control 

scction at thc bottom of thc S2 track .md 

rcpcat stcps 3 ami~-

6 To fade from the clip on the S 1 track 

back to the clip on the 53 track, move the 

pointer slightly farther to the right in the 

Fa de control section at thc bottom of thc 

53 track. Return thc fade leve! on thc 53 

track to 100-percent opacity by rcpcating 

stcps 3 and 4 and dragging the ncwly 

creatcd segment to thc top of thc bar. 

7 Preview thc cffcct by clicking thc Play 

button. 

Note: Ado[,c Prclllicrc docs not lzavc to 

proccss 11 prcvicw wlzen 11 clip on thc S tmck 
is sct to /00-pcrccnt opacity. Tl1c progra111 

trcats suelta clip as if it ,,·ere on tmck A and 

thc only clip in tlzc prcvicll'. 

... 



Chapter JO 

Using low-resolution clips to construct a inovie 

Yo u can save an enormous amount of pro­

cessing and compiling time, as well as hard 

disk space, by capturing and using low­

resolution versions of clips to crea te movies 

in Adobe Premiere. Yo u can use the smaller 

and faster low-resolution clips for all edit­

ing and effects, and then replace the clips 

with higher resolution versions once you 

have made all editing decisions. 

This procedure requires batch-capturing 
video with device control. For more 
information about batch capturing, see 

"Batch Capturing with Device Control" 

on page 241. 

1 Asan optional time-saver, crea te a batch 

list for your original source tape by 

choosing Capture> Batch Capture or 
Movie Capture from the File menu. The 

Batch Capture or Movie Capture menu 

appcars in the menu bar. 

2 Choose Recording Options from the 

Batch Capture or iv!ovic Capture menu. In 

the Recording Options dialog box, sct the 

frame size toa dimcnsion smalkr than 
what yo u will use in your finalmovie. For a 

full-frame movie, thc recommended 
dimensions are 320-by-240 pixels, or 
240-by-1 HO pixels. 

Reconllng Optlons ,-

¡¡v-.............. :,:1 
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t=: RotpOII Ooopcoed r ........ 
O Co.nlou• ..,.,.., lo ·,=b~CCOC.O ,-,.~lij 

3 Befare yo u make the first capture, be 
sure to calibra te your timecode to ensure 

that the movies are accurately stamped 

with the timecode. Add the timecode 

during capture using device control or by 

manually entering the timecode. 

4 Choose Video So urce from the Batch 

Capture or Movie Capture menu; sét the 

Compressor to the compressor related to 

the capture card. Although yo u can use any 
compression for the low-resolution 
version, it's best to use Motion )PEG hard­

ware compression, if yo u ha ve it. Set the 

Qúality between Low and Normal, or seta 

lower data ratc if your board supports data 
rate limiting. 

5 Set the Frame Rate to the same raté that 

you will use in your final high-resolution 

movie. (You can halve the frame rate if 

yo u need to save space and only need to 
be accurate within· + 1 or ...:1 frame.) Digi­

tizc the low-resolution clips using the 

Capture command. 

6 Using the low-resolution clips, construct 

the movie by opcning a new project. 
Choose a preset that match es the library of 
movies that yo u created by batch digi­

tizing. Crea te any stills at their final dimen­
sions; crea te title., at any size-they will be 

rcsized automatically when you compile 
thc movie. Sto re thc stills and titlcs in a 
separate folder from the low-resolution 

movies that will be replaced. Later in this 
procedure (in stcps 11 and 12), you'll 
replace thc clips with high-rcsolution 
VCrSIOnS. 



7 Drag the clips into the Construction 
window for editing. 

8 Save the project. 

9 Delete any clips in the Project window 
that you didri't use by choosing Remove 

Unused from the Project menu. 

10 Choose Tools > Projcct Trimmcr from 
the File menu. In the Project Trimmer 
dialog box, select the Crea te Trimmed 
Batch List option. Deselect the Copy 
Trimmed Source Files option; you d01Ú 
nced copies beca use you will redigitize the 
clips. To avoid droppcd frames at the 
bcginning and cnding of clips, acccpt thc 
dcf.ndt of Kccp Handlcs at 1 sccond. Click 
CI·catc Projcct. Na me thc ncw pmjcct and 
click OK; name the batch list and click OK. 

• .,. Projed Trimmer •r 

0 Cu1.tte. III!DIIIed b~ch btl 

O Copy t1nn111ed IOUice hiel 

~eep [[] 1econd handlu 

Note: Adobe Prcnzicrc adds a st~ffix of _1, _2, 
_3, and so 011 to thc clip na mes in zhc ncw 
barclz list to distingzúsh tlzCin frnnz thc orig­
inal clip 11anzcs. \Vhcn yo11 rcconsl ruct thc 
high-rcsol11tion clips. thc ncw proicct loob 
for thc original clips 1}{/sccl on thc clip nmncs 
in thc ncw lmtch list. Do not clzlllzgc citlzcr 
thc orig11zal or thc ncw clip nmncs 11nt il )'OII 

lun·c Sllcccssfllil)' rccanstrllclcd thc projcct. 

11 Edit the batch list, if necessary, to 

remove any references to clips that you do 
not want to redigitize. Choose Recording 
Options from the Batch Capture or Movie 
Capture menu, and sct the size and quality 
desired for your final movie. (Usually, yo u 

would choose a size of 640-by-480 pixels 

and high quality.) 

12 Redigitize the video using thc new 

batch list. 

13 Opcn the project created by the project 
trimmcr in stcp 1 O. If promptcd, loca te thc 
new high-rcsolution clips. Load a ncw 
preset with thc final options, or changc thc 
prcvicw and output options. 

14 l'rcvicw thc projcct with thc samc 
scttings you'll use in your fínalmovic. 

15 Choose l'vlake Movic from the Make 
mcnu to compile thc ,final high-rcsolution 
lllOVIC. 

.. 
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1• A (Ontmuous 

stream of cred1ts 

roll~ througn the 

soeen from bottom 

to !Op, 

Creating rolling credits 

This procedure shows how to use the 

Image Pan filter and the Title window to 

crea te rolling credits. 

1 Choose New > Title from the file menu. 

2 !(ight-click thc Ti tic wtndow bar to open 

thc Ti tic Display Options dialog bnx. 

3 Deselect the 4:3 Aspect Ratio option and 

en ter a drawing size that has the same 

width as that of your Adobe Premiere 

movie (as set in the Output Options dialog 

box) and enough height to creare the 

necessary text for your crcdits. This 

example uses a box measuring 160 -by-720 

pixels. 

4 Use thc typc too\ to add crcdits. formal 

thc typc as dcsircd. 

5 Savc the ti tic. 

6 Drag the title clip onto a track in the 

Construction window. Adjust the duration 

of the clip to reflect the length of your 
credits. 

. 7 Select thc ti tic clip in thc Cnnstruction 

window. Choosc Maintain Aspect Ratio 

from thc Clip mcnu. 

8 Choosc Filtcrs from thc Clip. m en u to 

disnlclv thc Filtcrs dialog box, and sl'icct th,· 
t ' ' 

lmagc Pan 11\tcr. 

9 In the Imagc Pan Scttings dialog box, 

en ter 120 for thc Start hcight; kavc the 

Width as 160. :\ rcctanglc appears at 

thc top of thc Start tm:tgc. Click Copy 

to cop:· thc rectanglc dimc·n.<ions to the 

Fnd SL'I t ings. 

Cloooln 

--"_·:,rir. 
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10 Place the pointer inside the rectangle 

for the End settings and drag the rcctangle 

to the bottom of the End image. The 

animated preview at the top of the dialog 

box shows the clip being panned from top 
to bottom. 

o 

~ 
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11 Click OK to apply the filtcr to thc clip. 
Adjust the work arca bar in the Construc­

tion windsnv, and previcw the clip to Yiew 
the rolling crcdits cffcct. . 

You can adjust the duration of the clip as 
desired to make the credits rol! fas ter or 

slower. If yo u are using a particubrly long 
Iist of credits, you may want to divide it 

into severa! title files to make the files more 

manageable. 

Ynu can also supcrimpnsc rolling crcdits 

OVLT .1 1nnving video by creating type and 
graphics in thc Title window and position­

ing thl' title clip on thc S track. Use thc 

Whitc Alpha Mattc kcy typc to supcrim­
posc just thc typc ot· graphics ovcr thc 

moYic on thc Yidco track. 

.• 



APPENDIX A: VIDEO B'ASICS 

This appendix provides a basic introduction to analog and digital video. Like film, video 

is a sequen ce of individual images, called frames, projectcd on a screen befo re a viewer. 

Projecting severa! images per second creates the illusion of a motion picture beca use the 

brain cannot register thc individual images. With a frame rate typically ranging from 24 

frames per second (fps) to 30 fps, video projects motion that appears smooth and contin­

uous. Normally, one or more audio tracks are synchronized with the video frames to 

provide sound to the movie. 

RECORDING AND ENCODING ANALOG VIDEO 

This section discusses how video cameras record video signals, including how video 

cameras interpret color and meas u re the resolution of video signals. 

Conventional video cameras contain light-sensitive devices called clwrgc-wuplcd dcviccs 
(CCDs), which digitize or mpturc the individual images as optical images and convert or 

Cllcodc them into clectrical signals. Once an analog video signa! has been encoded by the 

camera, it can be broadcast, rccorded onto analog videotape, or recorded digitally onto a 

disk storage device. The electrical signals captured by a video camera represen! the color 

and brighiness information of the image. Cameras are rated, amo11g other things, by their 

charactcristic color response and image n:solution. 

How video cameras interpret color 

Video cameras interprct color as a combination of thc threc additive primarics: red, green 

and blue. This light-based color model is commonly referred toas RG/3 color. Video 

cameras differ in how they encocle this color information into a video signa!. Some high­

end cameras process separa te signals for each of thc RGI3 components, or thcy process 

signals for thc chrnminance (color) and luminance (brightncss) informal ion, which 

rcsults in a COII!f'OIIC//1 video sign.li. t\ more commnn proccss cncodes thc !{Gil ami lumi­

nance information intn onc signal, knnwn as a wnzposirc signa l. 

In the United States and )apan, the standard composite signa! adoptcd by the tclevision 

and \·ideo industries is thc National Tclevision Standards Committee (NTSC) signa!. An 

NTSC signa! has a frame rate of 30 fps (or, more precisely, 29.97 fps). In Europe, the most 

commnn compositc video signa! is 1':\L (!'hase Alternating Line), which has a frame rate 

f 7- ¡· o _J ps. 
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lmage resolution 

Another importan! concept i~ describing a video signa! is inzagc rcsolution, which 

measures the quality of a video image based on the number of picture elements, called 

pixels, that makc up the image. 

A projected video image is a conglomerarían ofpixels that project the color and brightnes' 

of thc image. Picture quality in creases as the number of pixels in creases in a unir are a of 

thc imagc. A video camera encocles the image informarían as a grid of pixels, much likc a 

collection of ti les in a mosaic. An NTSC video frame contains 486 horizontallines of 

visible pixels, with each linc containing 720 pixels. Thus, an NTSC video frame is made up 

of approximately 350,000 pixels ( 486 x 720). 

Displaying the video signa! 

for thc analog video signa! to be convertcd toa recognizable image, thc signa! must be run 

through a decodcr. Thc decoder splits a composite signa! into RGI3 signals so that thc 

image can be displa:•cd on-scrccn. Tclevision screcns are madc up of tiny phosphors that 

emit varring intcnsitics of red, grccn, and bluc líght whcn struck by a carcfully controlbl 

elcctron bcam. For a standard tclcvision signa! to be projcctcd, the elcctron bcam must 

sean across 525 lines on thc screcn 30 times every sccond. ln actuality, thc clcctron bcam 

scans a tclcvision scrcen in intcrlaccJ modc-that is, the beam scans all tk even lincs ~r ,¡ 

frame and then al! odd lincs of that framc. The cvcn lines and the odd lines of each fr ..... ,. 

are rcfcrrcd to separatcly as jiclds. To maintain a framc ratc of 30 fps, thc clectron bcam .. 

must sean ata ratc of 60 ficlds pcr sccond. \Vhcn yo u frccze on a video frame, yo u actual!:· 

scc thc two liclds hcing alternatl'iy sc.tnned on thc NTSC monitor. 

t\ computcr scrccn opcrates in ll<'IÚIItcrlcm·cd mode. That is, thc clcctron bcam scans al! 

rows of phosphors sequen tia!!:· to crea te tite imagc on-screcn ;md repcats the proccss 

ahout (,1) lo 75 times pcr- 'ccond to rL·i't·esh the screcn. 

SMPTE timecode 

The duration of a video clip and its starting and cnding frames are commonlr mcasurcd 

using a unit or address called ti111ccodc: Timccocle ickntifies each framc of a videotape for 

control in cditing ami bro,ldC!sting. When vou are cditing video, timecodc allows vou to .... ..._ . '- ' 

loca k fr,tmcs •tccuratch· amito s~·nchronizc picturc •tnd .tudiockments (•tLiu calkdfm111c 

ciCCill'tiiC s:·nchronization). 

Thc timccoLk liSL'd ll\' the ~ocict:· o!" ivlotion l'icturc and Tclcvision Enginccrs (SMPTE) 

idcntiliL·s cach framc with a unique address in the form hours:minutcs:scconds:framcs. r\ 

clip with a duration of 00:02:31:15 pL!ys for 2 minutes. 31 scconds, and 15 framcs. At thc 

ratc of 30 fps, a clip with a duration of 00:02:31:15 pL!ys for 2 minutes and 31.5 seco 



There are severa! SMPTE timecode standards targeted for the different frame rates u sed in 
the film, video, and television industries. For technical reasons involved with 
broadcasting, the NTSC adopted a standard of 29.97 fps rather than thc 30 fps originally 
used in early black-and-white television programming. The SMPTE timccodc for NTSC 
video assumes a framc rate of 30 fps, which results in a 0.1 percent discrepancy between 
real pbying time and the timecodc's duration measurement. 

To address the discrepancy between thc playing time mqsured by SMPTE timccode and 
real playing time, the drop-framc format was dcvcloped. With drop-frame timecodc, two 
frame counts are dropped (actual frames are not dropped) from the count every minute, 
for 9 out of every 1 O minutes. Thc nondrop-[ra111c timccode ignores this discrcpancr and 
thus is not duration accuratc. 

Most video-cditing systems handlc both drop-frame and nondrop-frame timecode 
formats. While you can use either format, it is important to know which format was used 

· in recording your video soure<: material and to edit your videotape using thc same format 
throughout so that you know how re.1l time is being represcnted. 

DIGITIZING VIDEO 

NTSC and !'AL video signals are analog in nature. Computers, howcvcr, display infor­
mation digitally. So NTSC and PAL video signals must be digitized,'(,r soJnplcil, b~fore 
they can be used by the computcr. The process of digitizing video is commonly called 
copturing. A video-graphics adapter (oftcn called a frame grabber or video capture board) 
is used to digitize an an.1lng video signa! .md convcrt it into a computcr graphics signa!. 

Note: Thcrc are 111any 1·ideo capture boards 011 tl1c 111arkct, and thcy di.(já widcly in thcir 
fcatures a11<l mpabilitics. It is in'}'OJI<itllc swpc o( this docunlcllt to m te 1·idco/JOartls. 

Digital rccording of a video signa! n:quires substantial amounts of disk storage beca use the 
color and brightness information for c.1Ch pixd in cvery image frame must be stored. A 
fu 11-scrcen i mage on a 13- in eh en m pu ter monitor meas u res 640- by-4XO pixels. Thus, ea eh 
full-screen frame of video contains 307,200 (6·10 x 4SO) pixels. To displa)· the full-screen 
imagc in 24-bit color, ca eh pixel must represen! 24 bits of information (or R bits pcr RGB 

componen!). Twenty-four bitsofinform.ttion are cqual to3 bytes. That figure multiplicd 
In·'' full-screcn, 307,200-pixcl image rcsults in a storage rcquircmcnt of '.121 ,600 bytes for 
cach framc of digitizcd ,·ideo . .-\t a frame rate uf 30 fps, storing 1 sccond of digitized NTSC 
\'ideo rcquires more th.111 27 mcg;dl\'tes 1 Such use of disk space to store digitized video is 
not fcasiblc fot· most compulL'f users. 

1; 
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An even bigger obstacle is the cornputing power required to play back the stored infor­

rnation at sufficient frarne rates. Bringing video to the desktop cornputer has involv 

advances in data cornpression technology and cornpromises in frarne size, color depth, 

and irnage resolution. By far, the rnost important advances to date ha ve occurred with th, 

way the data is compressed. (For more information, see "Digital Video Compression" in 

Chapter 8.) 

DISPLAYING ANO OUTPUTTING DIGITAL VIDEO 

Once a video signa! has been digitized and compressed, it can be manipulated and 
organized in much the same way that still images are manipulated in image-editing 

programs such as Adobe Photoshop. In fact, many of thc graphics tools found in Adobe 

Photoshop, such as image adjustment, filters, and text generators, are available in Adobe 

Premiere. The major difference wid1 the digital processing of video is the time-based 

aspect of the medium. 

Desktop video became popular on dcsktop computcrs when Apple Computer released it' 
QuickTime system software extension and Microsoft rcleased its Video for Windows 

standard. Video for Windows and QuickTime movies are stored on disk as files, and can 

be played by applications designed to support Video for Windows or QuickTime, such a' 
Adobe Premiere. 

Outputting the video image 

To output a digital imagc to videotape requires severa! conversions. The video board 

encoder first corwerts the color of each pixel from thc digital color standard of RGB to the 
tekvision color stambrd, which rcprcscnts a color as a combination ofhue and saturation. 

Thc digit;l\ information is convertcd toan analog waveform, and thc encoder thcn adds 
calihration pulses to thc d.1t;1 amloutputs .1 stand.ml NTSC video signa!. 

So me video capture hoards now av.lilahlc on thc market ha ve thc capability uf outputtin~ 
black-and-white or color NTSC sign;lls to videotape. 



DIGITIZING AUDIO 

Audio is an important componen! of most media productions. Like video, analog sound 

must be digitized, or sampled, to be used with videotape. Fortunately, audio is not nearly 

as hard to digitize as is video. Sampling analog sound breaks up the sound into discrete 

frequencies. There are two steps in digitizing audio-setting thc audio leve! controls to 

avoid distortion and setting the audio resolution or quality. 

The quality (or rcsolwion) of digitized audio and the size of the audio file dcpcnd on the 

sampling ratc and bit dcpth of thc audio. Thc sn111pling rntc, similar to thc framc ratc for 

digitizing video, mcasures the number of frcqucncics into which thc sound is brokcn. Thc 

/Jit dcpth, similar to color clcpth, mcasures thc number of tones pcr samplc. Thc higher thc 

sampling ratc ami bit clcpth, thc bcttcr thc snund qu.dity. t\udio samplcd at 11 kHz and 

S-bit rcsolution is similar to mono sound, ami audio sampkd at 22 kl-lz and 16-bit rcso­

lution (which reqüires twice the file size for thc audio clip) is similar to stereo or CD 

sound. CD audio is normally digitized at 44kHz and 16-bit resolution. 

.... 



APPENDIX B: EXPRESSIONS FOR CREATING 

TRANSITIONS AND fiLTERS 

The Adobe Premiere program lets you crea te your own transitions and filters. This 

appendix explains how to set up the arithmetic expressions that describe what the transi­

tion or filter will do. Using the Transition Factory to crea te transitions is described in 

Chapter 5, "Using Transitions." Using the Filter Factory to crea te filters is describcd in 

Chapter 6, "Using Filters and Motion Scttings." 

ABOUT DIGITAL IMAGES 

A digital video image is a conglomeration of tiny picture clements, called pixels. Pixels 

projcct the color and brightness of thc imagc. Each pixel in an image is uniqucly idcntified 

by its coordina tes. The first coordina te is the horizontal position of the pixel, and thc 

second coordinareis the vertical position of the pixel. The horizontal coordina tes start 

counting at the left edge of the imagc and increasc as yo u m ove to the right. Thc vertical 

coordinares start counting at the top of the image and increase as yo u m ove down: Thcre­

fore, thc top left corner of thc imagc has thc coordinares (0,0). The rangc of c.oordinatcs 

· for an image dcpcnds on its rcsvlution .. 

In RGB formal, the color of a pixel is storcd as thrcc numbers: thc amount of red, the 

amount of grecn, and the amount bluc. Thc tluee color val u es are callcd clulllncls. Channel 

values can rangc from Oto 255. 

o If a channcl valuc is sct toO, non e of its color is present in thc pixel. 

; If a channcl valuc issct to 255, thc maximum amount of that color is prescnt in thc pixel. 

For cxamplc, if a pixel has thc channc! valucs (255,0,0), the pixel is cntircly red: 255 red, 

O grecn, O bluc. 

o lf all thrcc channcls ha ve thc samc valuc, thc pixel is a shadc of gray. For cxamplc, 

(80,80,80) is a dark gray, ( 121-l, 128, 128) is a mcdium gray, and (200,200,200) is a light gray. 

o lf al! three channcls are O, thc pixel is bbck. lf al! thrcc channds are 255, thc pixel 

is whitc. 
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Appendix B 

The transitions and filters yo u crea te affect the channel values of the pixels in an image. 

Yo u specify an expression for ea eh channel, and ea eh operation is performed on the appro­

priate channel for every pixel in the image. Expressions can include specific pixel coordi­

nares whose channel values are evaluated and used in the calculation. 

Note: If an expression cvalrwtes toa munber greatcr than 255, the channel is set to 255. 
Likewisc, if an expression cvaluates toa number /ess than O, the chmmcl is set toO. 

COMPONENTS OF EXPRESSIONS 
A transition or filter performs an operation on the channels of each pixel in an image. 

These channel operations are described by arithmetic expressions. Expressions are 

m acle up of combinations of four types of components: constants, variables, functions, 

and operators. The following sections describe these four components. For a quick 

reference of all allowable variables, functions, and operators, see "Expression Reference" 

on page 297. 

The Transition Factory and Filter Factory allow only integer numbers in expressions-no 

fractions or decimal numbers are allowed. Variables and functions will afways evaluare to 

integers. 

Constants 

A consta~t is a number that is supplied directly in the expression.Constants can be used 

to construct simple expressions such as 1 0+5, and these expressions can always be replaced 

by another const;mt; in this case, 15. 

Constants can also be written in hex;ldccimal form. To use hexadecimal values, prefix the 

numbcr by Ox, as in OxaflO. 

Variables 

A variable is a short na me, su eh as x, that can be evaluatcd. The value of a variable depends 

on thc current imagc, thc current pixel, or thc current channel for which an expression is 

being evaluated. For cxamplc, the variable x always evaluares to the horizontal coordinare 

of thc current pixel, and thc variable y always evaluares to the vertical coordina te. The vari­

ables for thc curren! pixcl's channcl values are r (red), g (green), and b (blue). 

If yo u are crcati-ng a transition, yo u spccify whether yo u are affecting the first image or the 

sccond imagc. Todo so, includc a O ora 1 with thc variable. For example, rO is the red 

channd va\ue for the currcnt pixel in thc lirst imagc, while rl is the red channel value for 

the current pixel in the second imagc. 



Yo u can combine variables and constants to form expressions. For example, the expression 

r+g retrieves the red and green channel values for the current pixel and adds them · 

together. 

Functions 

Functions are short names that can be evaluated and that reguire one or more arguments. 

For example, the rnd function (random function generator) reguires two arguments. It 

evaluates to a number that is greater than or egua! to the first argument and lcss than or 

egua! to the second argumcnt. The cxprcssion rnd( 1,1 O) cvaluates toa numbcr bctwcen 1 

and 10, inclusive. (The rnd function is useful for adding noise or texturc toan image.) 

Arguments are written within parenthcsis and are separated by commas. Thc arguments 

can be expressions. For examplc, the expression rnd(r-1 O,r+ 1 O) cvaluates lo the red 

channel of the current pixel, plus or minus 10. 

Another function, src (sourcc), retrievcs channcl values for a particular pixel. lt reguires 

three arguments: the horizontal coordina te of thc pixel, thc vertical coordina te, and the 

channel index. The indcx for the red channcl is O; the grccn channcl is 1; thc blue channel 

is 2. For examplc, thc exprcssion src(10,20,0) rctrievcs the red channcl valuc for the piy··' 

at coordina tes ( 1 0,20). Thc cxpression src(x,y,O) rctrievcs the red channd val u e for thc: 

current pixel. Thc expression src(x+ 1 ,y, O) rctricvcs the red channd for thc pixel to the 

right of the currcnt pixel. 

Thc available functions are described in thc section "Exprcssion Refcrencc" on page 297. 

Operators 

The operators in elude all of thc arithmctic components that can be u sed in an exprcssion. 

There are fivc typcs of opcrators: basic, relational, logical, conditional, and bitwise. 

Basic operators 

Thc basic opcrators are+,-, ·,/,ami %J. Thc% (modulo) opcrator calcula tes thc 

remaindcr of a di,·ision. For cxamplc, thc cxprcssion 11 '7b3 cvaluatcs to 2. 

Relational operators 

The rclational opcrators are<,<=,>,>=,==, and '=. Thesc operators compare two 

exprcssions and cvaluatc toO (falsc) or 1 (truc). For examplc, thc < opcrator evaluatcs to 

1 if thc exprcssion on thc lcft is lcss than thc cxprcssion on the right. Thc expression r<g 
cvaluatcs to 1 when thc red channcl of thc currcnt pixel has a !owcr valuc than thc grcen 

channcl. Othcrwisc, it c\·~¡Juatcs toO. 
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The == operator evaluates to 1 when the two expressions surrounding it evaluate to the 

same thing. The != operator evaluates to 1 when the two expressions surrounding it eval 

uate to something different. For example, the expression 1==1 evaluates to 1, and the 

expression 2==1 evaluates toO. The expression 1!=2 evaluates to 1, andthe expression 

1 != 1 evaluates to O. 

Logical operators 

The lugical operators are&&, 11, and !. These operators let you combine severa! relational 

cxpressipns. For cxample, yo u could cvaluatc whcther the horizontal coordina te of a pixel 

is bctwcen 10 and 30, inclusive. Thc appropriatc relational exprcssions are x>=lO and 

x<=30. You can use thc logical && operator to combine them into the single expression 

(x>= 1 O)&&(x<=30). The && operator evaluates the expressions on both si des. lf neithe1 

expression evaluatcs toO, the && operator cvaluates to l. If either expression evaluates to 

O, the && operator evaluates to O. 

The logical operator 11 is similar to the operator &&, but it performs a slightly different 

logical operation. The 11 opcrator is also placed between two relational expressions. If 

either of the expressions evaluate to anything but O, the 11 operator evaluates to l. If both 

cxpressions evaluate toO, the 11 operator evaluates toO. For example, the expression 

(x> l Oll(y> lO) evaluates to l when the horizontal coordina te is greater than 1 O. The only 

time this exprcssion cvaluatcs tu O is whcn thc horizontal coordinatc is <=lO and the 

vertical coordina te is <=lO. Thc following tablc shows thc difference between the && allll 

11 opcrators: 

LEFT EXPRESSION 1 R!GHT EXPRESS\ON ILEFT&&R\GHT ILEFTIIRIGHT 

o ¡o lo ¡o 
' 

lo 1 1 o [1 
1 

lo [1 1 iO 
1 ' 

1 1 1 1 1 11 1 1 

Finall:·. :·ou place the 1 operator befo re an expression to invert thc expression's evaluation. 

Jf the expression evaluatcs tu O, the 1 operator cvaluates to l. If thc expression evaluates to 

anrthing but O, the 1 operator cvaluatcs toO. 

Conditional operator 

The singk conditional opercltur' lets vou make a choice betwccn two altcrnatives. A 

conditional cxpression includcs a condition cxprcssion and two altcrnative expressions. 

Thc conditional operator cvaluates thc condition cxpression and uses the result to decide 

~ 



which of the two alterna ti ves it should cvaluate. If the conditional expression evaluates to 

anything but O, the first alternative is evaluated. If the conditional exprcssion evaluatcs to 

O, the second alternative is evaluatcd. 

For example, in the cxpression (x%2)?r:g, the? conditional operator separa tes thc comli­

tion expression (x%2) from thc two alternative cxprcssions r and g. Thc a.lternativc cxprcs­

sions are separated by a colon(:). The condition cxpression divides the horizontal coordi­

nate of the currcnt pixel by 2 and returns thc rcmainder of thc division. If thc horizontal 

coordina te is an odd numbcr, thc rcsult is something othcr than O, and if thc horizontal 

coordina te is an even numbcr, the result is O. Therefore, if the pixel has an odd horizontal 

coordinare, the conditional opcrator rcturns thc valuc of thc red channcl. If thc currcnt 

pixel has an cvcn horizontal coordinatc, thc conclitional opcralor rcturns thc val u e of thc 

grccn channcl. 

Bitwise operators 

Thc bitwise opcrators are&,¡, A,-,<<, ami>>. Thcsc opcrators din:ctlv manipulatc thc 

bits in a valuc. You place thc &, ¡, and A opcrators bctwccn two cxprcssions. Thc & ópcr­

ator pcrforms a logical-and opcration on thc corrcsponding bits of thc cvaluaicd cxprcs­

sions; the 1 operator performs a logical-or; and the A opcrator performs a logical-cxcl 

sive-or. Thc- opcrator takcs only onc cxprcssion, and it pcrform~a logical-not on cach 

bit of the evaluatcd expression. 

The << and >> cxpressions are placed bctwccn two cxprcssions. !3oth opcrators shift thc 

bits in thc left expression's cvaluation b:· somc numbcr, which is spccitlcd by thc right 

exprcssion's cvaluation. Thc << opcrator shifts bits to thc lcft. Thc >> opcrator shifts bits 

to thc right. 

PROVIDING USER-CONTROLLED SLIDERS 

\Vhen you crea te a transition or filler, you can provide up to cight slider controls for thc 

uscr to adjust whcn applying thc cffcct. Slidcr values can rangc from O lo 255. You sct up 

thc cffcct's slidcrs by using thc ctl (control), val (valuc), amlmap (mapping) functions in 

your exprcss10ns. 

•. Thc ctl function rctric,·cs thc spccificd slidcr's curren! valuc. This function rcquircs onc 

argurncnt: thc slidcr control indcx, which is a nurnbcr bctwecn O and 7. For cxamplc, thc 

cxprcssion cti(O) cvaluatcs thc curren! valuc llf thc first slidcr. 
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• The val function converts the range of possible slider values (always Oto 255) into a 

range that you specify. For example, to get a value between 1 and 100 from a slider, you 

would use the expression val(0,1,100). If slider O is set toO, the slider value evaluates toO. 

If slider O is set to 255, the slider value evaluates to 100. Slider values between O and 255 

are converted into values between 1 and 100. 

• The map function groups the sliders into pairs. Ea eh even/odd slider pair sets the values 

in atable, which is accessed by the map function. There are four mapping tables-one for 

each slider pair. Sliders O and 1 set thc values for mapping tableO; slidcrs 2 and 3 set the 

val u es for mapping table 1, and so on. Ea eh table contains 256 en tries, which are calculated 

cach time the slider values change. 

The map function takes two arguments: the table index and the item index. For example, 

the expression map(l ,20) returns item 20 from table l. The table index must be between 

O and 3. Thc item index must be between O and 255, inclusive. 

lf yo u use thc these 'functions to retrieve slider information, yo u should set up the Slider 

or Map options in the Transition Factory's or Filtcr Factory's Build Custom dialog box. For 

information on using the Build Custom Transition dialog box, see "Creating Custom 

Transitions" on page 138. For information on using the Build Custom Filter dialog box, 

sec ''Creating Custom Filtcrs" on page 163. 

EXAMPLES · 
' . 

This section provides severa! examples of using cxpressions to achieve a result. The exam-

plcs are prcscnted in thc order of thcir complexity. The Adobe Prcmierc program also 

¡:irovides so me sample transition and filter exprcssions. Thesc samplcs ha ve bcen savcd as 

text files and are located in a dircctory in your Adobe Premicre directory. You can use the 

Transition Pactory or Filter PactOT)' toload a sample file and observe its cffcct. 

Affecting a single channel (filter) 

To make an imagc more red, you could use thc following cxpressions: 

A: O 

R: r+ 100 

G:g 
B:b 

The second cxpression C\'aluatcs thc red channcl of ca eh pixel and adds 100 to ea eh one. 

Thc next two cxpressions cvaluatc thc othcr two channels ancllcavc them unchanged. 



Affecting channels using sliders (filter) 

To add a user-controlled slider value to the current channel values, you could use the 

following expressions: 

A: O 
R: r+cti(O) 

G: g+ctl( l) 

B: b+ctl(2) 

The second expression evaluates the red channel of each pixel and adcls the valuc of slider 

Oto each one. The next two cxpressions do the same thing to the green ancl blue channels, 

using thc values of slicler 1 and slidcr 2, respectively. 

Adding noise to channels using slider and random values (filter) 

To use slicler values to determine the range of rancio m numbers, you coulcl use the 

following cxprcssions: · 

A: O 

R: r+rncl(-ctl(O),ctl(O)) 

G: g+rnd(-ctl( 1 ),ctl( 1 )) 

B: b+rnd(-c;tl(2),ctl(2)) 

The filter clefinecl by thesc expressions adds noise to al! three channcls. The amount of 

noise in ca eh channel is detcrmined by the slicler controls. The second expression evaluares 

the slicler setting from slider O. This value is used <lS the argument for the rnd function. lf 

the slicler setting is O, the rnd function evaluates toO. lf thc slicler setting is 100, the rnd 

function can return any numbcr bctwcen -100 ancl 100, inclusive. The result of the rncl 

function 1s then adcled to the curren! val u e of the red channel. As the slicler setting is raised 

from Oto 255, the ranclom numbers are selected from a wicler and widcr range, resulting 

in more and more noisc bcing addcd to the red channcl. 

The last two expressions pcrform thc same opcration on thc grecn ancl hlue channcl, using 

slidcrs 1 and 2 for input, respcctivcly. 

Amplifying or toning down channels (filter) 

To amplify or tone clown a channcl hased on the values of a different channcl, you could 

use thc following exprcssions: 

t\:0 

R: (b> 1 OO)'r+50:r-50 

G: g 

!3: b 

29 
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The second expression evaluates the blue channel to determine if it is greater than 1 OO. If 

it is greater than 100, the en tire expression evaluates to the red channel value plus 50. If it 

is not greater than 100, the expression evaluates to the red channel value minus 50. The 

other two expressions do nothing. Thercfore, this filter amplifies the red channel if there 

is more blue than yo u want, or it tones down the red channel if there is less bluc than yo u 

want. 

Yo u could also use slidcr values in a similar type of filter, as fol!ows: 

A: O 
R: (b>ctl(O))?r+ctl(J):r-ctl(l) 

G:g 

B: (b>ctl(O)?b-ctl( 1 ):b+ctl( 1) 

Thc second expression uses the setting from slider O as a "cutoff" val u e. If the blue channel 

is grcater than thc cutoff value, the red channel is amplified by the val u e of slider l. If the 

bluc channcl is lcss than thc cutoff valuc, thc red channcl is toncd clown by the val u e of 

slider 1. The fourth cxprcssion is the opposite of thc first one, but it works on the blue 

channel instead of the red channel. The effect is that anything that is added to the red 

ch;mnel is subtracted from the blue channcl, and vice versa. 

Dissolving between two images (transition) 

To crcatc-.1 simple cross dissolvc betwccn the first clip and the second clip, you could use 

thc following cxprcssions: 

A: mix(cl,cO,t,total) 

R: mix(cl,cO,t,total) 

G: mix(cl ,cO,t,total) 

13: mix(c 1 ,cO,t,total) 

The first exprcssion combines the current val u e of thc alpha channel in thc first clip with 

the current val u e of the alpha channcl in thc sccond clip by using the fraction 

time/total time. The rcmaining threc cxprcssions do the samc thing for thc current values 

ofthe R, G, and !\ channcls. 

Averaging the channel values of neighboring pixels (filter) 

You can use the src (source) function lo rctricvc the channel valucs from ncighboring 

pixels ami average thcm, as Collows: 



A: O 
R: (src(x-l,y,O)+src(x,y,O)+src(x+ 1 ,y,O) )/3 

G: ( src(x-1 ,y, l )+src(x,y, 1 )+src(x+ 1 ,y, l) )/3 

B: (src(x-l,y,2)+src(x,y,2)+src(x+ 1 ,y,2) )/3 

The second expression uses the src function to retrieve the red channcl valuc for thrcc 

different pixels: the pixel to the left of the curren! pixel, the curren! pixel, and the pixel to 

the right of the currcnt pixel. These three val u es are added togcther and thcn dividcd by 3. 

Thc last two cxpressions do thc same thing using the grecn and bluc channcls, rcspcctively. 

Pushing the second image into the first image (transition) 

To crea te a transition that would "push" thc sccond imagc into thc first imagc from lcft to 

right, you could use the following expressions: 

A: O 
R: x' 1 024/xmax<t • 1 024/total?srcO( xmax+x-t • xmax/tota l,y,p) :src 1 ( x-t' xmax/total, y,p) 

G: x' 1 024/xmax< t • 1 024/total1src0( xmax+x-t' xm;tx/tntal, y.p) :src 1 ( x-t' xmax/tntal, y,p) 

B: x'l 024/xmax<t '1 024/total'srcO( xmax+x-t • xmax/total,y,p ):src 1 (x-t' xmax/¡otal,y,p) 

1n ea eh of these expressions, the comparison befnrc thc qucstinn mar k determines the 

image uscd to samplc pixels. Thc two cxprcssinns aftcr thc question mark sclcct thc corrcct 

pixel for e;ch imagc bascd on thc percéntagc of thc time that has p'asscd for the clip. 

EXPRESSION REFERENCE 

This scction prm·idcs a summan· of all operators, \'aria bies, and functions that yo u can use 

in Transition Factnn· ami FiltcT bctory cxprcssions. 

Operators 

Ynu can use thc following opcrators in ;•nur cxprcssions. The operators are prescnted in 

thcir ordcr of prcccdcncc. l'rcccdcncc determines which opcrators are evaluatcd first 

within an expression whcn thc ordcr of cvaluation is ambiguous. For cxamplc, in thc 

cxpression 2+ Y 4, thc • npn;llor is cvaluatcd first beca use it has higher preceden ce than 

thc + npcrator. 

' OPERATORS i DEFINITIONS 

!. - ! logical not. brtwise not 
-

' ' Add, subtract +,- ; 

•, /, 
0/o Multiply, divrde, modulo 

----------------------- ------
<:<,>> 

' 

Sh1ft left. shift right 

... 



OPERATORS 1 DEFINITIONS 

<, <=,>,>= Less than, less than or equal to, greater than, greater than or equal to 

==. != Equal to, not equal to 

&,"',\ Bitwise and, bitwise exclusive or, bitwise or 

&&,11 Logical and, logical or 

?: Conditional 

• The arithmetic operators +, -, *, /, and 01ÍJ opera te on signed, long integers that are 32 

bits widc. 

• The logical operators &&, 1[, and! treat al! expressions as either true or false. Any value 

other than O is considcred true, and only a O value is considered false. 

• The shifting operators ( << and >>) perform logical, not arithmetic, shifts so the sign of 

thc shifted opcrand is not prcserved. 

Variables 

Yo u can use thc following variablés in your expressions. When creating a transition, 

appcnd a Oto variables dcscribing val u es for the clip that plays first (such as xO for the 

horizontal coordinatc of the currcnt pixel in the first image). Append a 1 to variables 

describingvalues for thc clip that plays.second (such as xl for the hqrizontal coordina te of 

'the currcnt pixel in the second image). 

VARIABLES 1 DEFINITIONS 

r, g. b Red, green, and blue channel values for the current pixel 

a 
1 

A\pha channel va\ue for the current pixel 

e 1 Value of the current channel. whichever channel the expression is defining 
' 

i, U, V 1 Calculated channel va\ues for the current pixel in YUV space 

x.y ·¡ Coordinates of th~ .current pixel 
¡ 
' p j Channel index for the current expression 

d i Directton (angle) of the current pixel from the center of the image, where 
1 d is an integer between O and 1024, inclusive 

' 
m 1 Distance (magnitude) from the center of the image to the current pixel 

t 1 Current time 
-

total 
1 

j Maximum time 

1 

xmin, xmax 1 Range of honzontal coordinates over the width of the image 
' 



VARIABLES DEFINITIONS 

ymin,ymax 1 Range of vertical coordinates over the height of the image 

pmin, pmax Range of channel indexes within one pixel 

dmin, dmax Range of angles within the image, where dmin is always O and dmax is 
always 1024 

mmin, mmax Range of magnitudes with the image, where mmin is always O and mmax 
is always one half the diagonal size of the image 

• The i, 11, and v variables do not cxist in an RG!3 image, so thcy are calculatcd from thc 

RG!3 channels. Beca use this calculation takes some time, using thcsc variables is slowcr 

than using thc r, g, and /;variables. Thc following formulas are uscd to convcrt from RGB 
to YUV: 

i=( (76' r )+( 15ü•g)+(29' b) )/256 

u=( (-19' r)+( -3 7' g)+( 56*b) )/256 

v=( (78* r )+( -65 • g)+ ( -13 • b) )/256 

' 
• The x1nin and xnwx variables rcturn the rangc of possiblc values for thc x variable. Thc 

ymin and J'IIIIIX V<Hiablcs rcturn thc rangc of possiblc val u es for thc y variable. Thc pnii. 

and pnwx variables rcturn thc range of.possiblc val u es for thc p variable. Thesc rangcs are 

closcd on thc minimum allCI open on the maximum: :onin<=x<XIIliiX, pnin<=y<ymax, 

and p111in<=p<pmax. 

Functions 

Yo u can use thc following functions in your cxprcssions. Many functions place restrictions 

on thc possiblc valucs of thcir argumcnts. lf an argument is out of range, thc expression 

will rcturn a O. For cxamplc, the exprcssion cti(R) cvaluatcs toO beca use thc ctl function 

rcquires an argumcnt bctwcen O and 7. 

Whcn crcating a transition, appcnd a O to sourcc functions (src, cnv, and rad) dcscribing 

valucs for thc clip that plays first. ( For cx.lmplc, thc cxprcssion srcü( 1 0,20,0) cvaluatcs to 

thc red channcl nluc for thc pixel at coordinatcs ( 10,20) in thc first imagc.) Appcnd a 1 lo 

sourcc functions dcscribing valucs for thc dip that plays second. (For cxamplc, thc cxprcs­

sian src 1 ( 10,20,0) cvaluatcs lo thc red channcl \·aluc for thc pixel at coordina tes ( 1 0,20) in 

thc sccond imagc.) 

FUNCTIONS ~ DEFINJTIONS 
1 

src(x,y,p) Channel p for the p1xel at coordinates x.y 
----

cnv( ... ) Convolution of neighboring channel values 

... 
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FUNCTIONS DEFINITIONS 
:, 

rad(d,m,p) Channel value of pixel p in the source image, which is m units away, atan 
angle of d, from the center of the image 

ctl(1) Value of slider i, where i is an integer between O and 7, inclusive 

val(i,a,b) Value af slider i, mapped anta the range ato b 

map(i,n) ltem n from mapping table i, where i is an integer between O and 3, 
inclusive, and n is and integer between O and 255, inclusive 

min(a,b) Lesser of a and b 

max(a,b) Greater of a and b 

abs(a) Absolute value af a 

add(a,b,c) Su m af a and b, ore, whichever is greater 

sub(a,b,c) Oifference of a and b, ore, whichever is greater 

dif(a,b) l Ab~olute value of the difference of a and b 

rnd(a,b) l Random number between a and b. inclusive 

mix(a,b,n,d) Mixture of a and b by fraction nld 

scl(a ,il,ih,ol, oh) Sea le a from input range (i/ to ih) to output range (o/ to oh) 

sqr(x) Square root of x 
. 

~--~ine of x, where x is an integer"between O and 1024. inclusive sin(x) 
' 

cos(x) 1 Cosine of x. where x is an integer between O and 1024, inclusive 

tan(x) \ Tangent of x, where x is an integer between O and 1024. inclusive 

r2x(d,m) 1 x displacement of the pixel m units away, atan angle of d, 
from an arbitrary center 

¡-
r2y(d.m) 1 y displacement of the pixel m units away, atan angle of d, 

1 from an arbitrary center 

c2d(x,y) 1 Angle displacement of the pixel at coordinates x,y 

c2m(x,y) -r~agnitude ~~~~~me:·~f the pixel at coordina tes x.y 

• The src (so urce) functton is slow compared to thc othcr opcrators and functions. Sevcral 
cvaluations of thc src function in one cxprcssion can noticeably slow clown thc proccssing 
of an image. Thc coordinatcs passcd to thc src function should be within thc ranges spcc­
iflcd by thc X111in,y111in and XIIIIIX,y111ax \'ariablc~; otherwise, thc coordinatcs will be 
pinncd. 

.. 



• The cnv ( convolution) function retrieves the channel val u es of thc pixel adjaccnt to the 
current pixel and scales them by the arguments. The adjacent pixels are determined by a 
3-by-3 pixel grid with the currcnt pixel in the center. The first nine arguments to thc cnv 
function correspond to the channel values of these nine pixels. 

The cnv function multiplies each channel value by its corresponding argument, adds the 
products together, and divides the rcsult by the tenth argument in the lis t. For examplc, 
the expression cnv( -1-2,-1,-2,16,-2,-1 ,-2,-1 ,4) scales the channel values as follows: 

·1 1 ·2 1 ·1 

~l16 1·2 
·1~ 

The channcl val u es of the curren! pixel, in the center of the grid, are scalcd by 16; the 
channcl val u es of the pixels directly a hove, bclow, to the left, and to thc right of the curren! 
pixel are scaled by -2; and so on. All of thcse products are then adckd togethcr, and thc 
result is di\·ided by 4. The effect of this expression is to sharpen the imagc's channel values. 

• The val (valuc) function converts the requcstcd slider sctting into a value in thc 
requested r~ngc. Thc slider sctting is multiplicd by thc size of thc ra11ge (b-a) and offset 
by thc start of thc rangc (a l. This function is uscful when thc range rcturned by the sliders 
(always Oto 255, inclusive) docs not match thc range ofvalues you W<lnt to use. f.or 
cxample, if the requestcd range is 1 to 10, a slider setting of O returns a value of 1, a setting 
of 255 retums a value of 1 O, anda setting of 127 rcturns <l value of 5. 

The start of thc requcstcd rangc does not ha veto be lcss than the cnd of thc range. For 
examplc, thc cxprcssion vai(O,I0,-10) rcturns values betwccn 10 and -10. 

• The map (mappingl function uses tablcs that are constructcd according to the slidcr 
settings. Ea eh tahlc uses a pair of slidcrs: t;1ble nuses slidcrs 2n and 2n+ 1 for the high and 
lo\\" val u es, rcspccti\·cl:·. The tahlc is constructcd as follows, wherc Lis the value of the low 
slider, /-1 is thc val u e of the high slider, and 1 is an cntry: if l<=L, use O; if 1>=1-1, use 255; 
if L<I<H, use U-L)' 2551(/1-L ). 

• Thc rnd (r.mdom) function rcturns a diffcrcnt random number cach time it is callcd, 
but thc en tire function n:scb c·ach time an image is processed. t\s a rcsult. a transition or 
liltcr that uses thc· rnd function will havc the same ciTect c.Kh time it is uscd on thc samc 
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¡>endix B 

• The mix (mixture) function combines the two input values using the specified fraction. 

A fraction of 1/2 returns the average of the two input values. A fraction clase to 1 returns 

the first input val u e, anda fraction el ose toO returns the second input val u e. The mix func­

tion is defined as a*rzld+b*(d-n)!d. 

• The scl (scale) function maps a value from an input range onto an output range. For 

example, an input range ofO to 255 could be mapped onto an output range of -lOO to 100 

by the expression scl(c,0,255,-IOO,IOO). In this example, channel values close toO are 

mapped starting at -100, and channel val u es el ose to 255 are mapped up to 1 OO. 

• The r2x and r2y functions convert radial expressions to cartesian expressions. The c2d 

and c2m functions convert cartesian expressions to radial expressions. 
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capturing single 246 

exporting a~ bitmappcd 

imagcs 1 OS 

frcCI.ins 20.S 

numbcring form;¡t 71 

numbcring formai, !-.Ctting 54 

paint1ng nn individual 259 

rotoscoping 259 

.splitting cllps at cxact .S\1 

tnmming from clip:-. 76-.S6 

vic\\'ing 120 

viL·wing :-pccific in Chp 

windo\\' 71 

frcc1.c- fr.lnH.' 

c!Jp:-. crcatin~ 'Jó 

video; lil'ld:- .1nd ~~-i 

fuli-fr.l!lll' VJdl·o, p\.¡ymg 111 rc.d 

llllll' 210 

full-scn.·cn \'Jdco 

Glptunng 231 

outputting 211 

function kcy:-. 

functions (Transition Factory/Filter 
Factory) ' 

c2d/c2m 302 

CIW (convolut!on) 301 

ctl (control) 293, 295, 296 

for crcating slidcrs 293 

map (mapping) 294, 301 

mix (mixture) 296, 302 

r2x/r2y 302 

rnd (random) 291,295,301 

se! (scalc) 31l2 

src (:-.ourcc) 291,296,297,300 

val (v,¡Juc) 294,301 

;¡dJu~tin~ íor .wdio clip:- 99, 101 

adjwiting íor ~upcnmpo!->cd 

clips 189 

Gain comm.l!ld 101 

Gamma Corrc.ction filler 153 

garb.tgL' m.lttcs 17.S, 252 

G;¡u ........ i.m Blur filtn 153 

G.lll!->"i:w Sh.lrpt·n filtc1 153 

(; l'lll'r.JJ j'll'l\.Tt'lh.'l'\ 

/ot:/Shuttk ~..-ont1ol.md 70 

v1rtu:d cl1p :-o u re~.· .1rc:1:- and 102 

(;]w:-tin¡; filltT l::l.l 

(~nto hutton (Clip \\'IJhlow} /(l, 7'J 

Coto/SL'.Irch cumJ11.111d 41-i, (ll 

gr.tdÍL'Ilt control:- (Titk window) 190 

(;radirnt \Vipc tr.lll:-.Ítloll 1.'\7 

gr.1ph1c:-

(IL'.lting¡n'J¡tk \\'lndow 19'>-2011 

:-u pcr i m pu:-111 ¡;. .mi m:11 ni 

grayscale imagc~ 
as gradient wip.c transitions 137 

•• J 

grayscale masks, cxtracting from 

clips 152' 

· Grccn Sc-~ccn kcy typc 185 

·-' 

Half·scrccn video, outputting 211 

halo cffcct !59 

hand tool (Construction 

\Vindow) 58 

handlcs 243 

around trimmcd clips 32 

hard di!->k 

capturing vtdCo to 230 

spccd for c.tptunng 229 

hard·linkcd clip:- 9X 

han.h•:.trc 

comprcssion 21 O 

rcquircmcnts for capture 227 

Scc alsovideo capture boarJs 

hcight·tn·width ratio. Scraspcct r.ttio 

Honzontal Flip fi!ter 153 

, Horizont.d Hold filtL·r 153 

Hue & S.ltlll.llion filta 15.1 

lmagc M.1~k tr.1mition IJ6 

lmage !Vl.lttl' kl'y typc IX4, 25t1 

1 m.ll;!,l' P.m filtcr 15·1. 2XO 

nn.Jgc rcsolut ](HJ. ddincd 2X·I 

llll.tgc SJZC 

achicv1ng m,J:\illlulll during 

c.1ptmc 229 

sctting JX 

llll.lgc:-. Scc cii_P!-1. ~till·im.1gc clip~ 

Impon command IOX 

lmport Fdl' conlllt;llld 34 

lmport fwm Tcxt File command 2· 

30 

... 



'' 

importing 

clips 33 

fr~m Adobe Photoshop 36, 1 08 

fi'lmstrips 1 OS 

projects 31 

in.po~nt,t9ol (Construction 
window) 58, 79 

in points 

changing in linkcd clip~ 78 

finding in Clip ~viÚdü\V . 78 

setting in·.7liP.s 76-85 

Info windmv 63 

Inscrt at Edit Linc command 93 

inscrt editing 91-94 

inscts 

cn:ating :?.50 

tran~itions within 264 

Intd IrHko ViJc\1 R;t2 comprcssor 

(Qui(kTinu:) 214 

lntd lnd~.·o Vidl·o 1U.2 t:ompre:-.:.or 

(VItko for\V11Hiow:-.) 2U 

1ntcllndl·o Video lbw t:ompn::-.sor 
(Vidt·o for \\'indows) 2\J 

lntcrleave option (audio output) 209 

lnvert filter 155 

Jog control (Chp windowl 70 

Kt·t·p llandle~ option ( pwjt'(! 

trimmi1_1~) 32 

kl'fning toob (T1tk• window) \90, 

197 

K~.·y Fr,ll\lt' optillll 

(l.'(llllflfi.':O.\illlll 21 (l 

k~.·y fr.nne:-. 21h 

k e~· t ~-p~.·:. 

.td_¡usting 1 X6 

Alpha Channd 1 H 1 

Black Alpha Matte 183 

Blue Screen 185 

Chroma 179, 187 

Difference Matte 185, 187 

Green Screen 185 

lmage Mattc 184,254 

Luminancc 181 

Multiply 186 

Nonc 179 

Not Red 186 

RGB Diffcrence 180, 187 

Screen 186 

Track Mattc 186 

White Alpha ~latte 183 

keying. Scc supcrimposing clips 

kcys,inEDLs 112· 

Lediting 9·1 

Labcl hoxc::-., in Projt.:ct wmdow ..J(l 

Len:. Fl.tr~.· liltt.:r 156 

Levcls filier 156 

le\'cb. ,\{liu"'ing .H1d1u lJ':) 

. Libr.1ry window 

ch~mging thL· display of 41 

loclting clips in 40 

libr.try, creating ·Hl 

lightcning imagL'!'> 153 

line too! (Ti tic: wtndow) 190 

Lmc \\\·¡ght s\idL·r (T1tk· 

w111dow) \90, 195 

link o\'erridL· too! (Constru(tion 

window) 5S, ~~ 

linked eh p., 53 

br~..·.1king link:-. 99 

1..Tt'.l\ing W\ 

cutting .tnd pa:-.ting 'JI) 

deleting the audio or video 

portian 53 

disabling audio or video for 

previewing or compiling 57 

·hard links 98 

opening only audio portian in Clip 
windov.• 69 

out of sync 98 

releasing link~ kmporarily 98 

separatit~g a1~d rcjoining 97 

soft links 98 

trimming 78 

virtual clips 101-104 

linking movies 221 

Load Palette command 248 

locking track; 94 

Loop Pl:~yback optlon (Print to 
VJdeo) 220 

losslcss/lnssy cnmprcssion 211 

Luminan(t: kq typc 181,255 

Maóntosh 

importing movi~.·s from 37 

r-.Ltint.tin :hpect lbtio comm:md JS 

Make lvtovie command 204 

for previewing 125 

J'vlakl' Mm·ic dialog box 204 

compre~sion options 215 

output options 204, 205 

m.lp (mapping) funCliun 294, 301 

markers. St.'c phtcr markers 

masking 

clips 1 S 1, 254 

\\'Íth Tro.Kk Matll' kcy 262 

m.1sk:. 

n t rau i ng gr.ly:-.c.tle from dips 152 

im.1gc: m a~ k transition 136 

... 



mattes 

background 189 

Black Alpha 183 

color 189 

color backgrounds 104 

Dtfference 185 

garbage 178, 252 

·1mage 184 

Track 186 

travehng 186, 262 

White Alpha .183 

matting. Scc suPerimposing clips 

mcmory 

availabdtty for capturing 230 

c.tpturing video to 230 

merging projccts 31 

Microsoft RLÉ comprcssor (Video for 
\VindO\VS) 212 

dcletmg points on path 168 
' 

in EDLs 112 

kccping clip stationary 251 

loading 173 

options 169-173 

prCV\eWlllg !68 

·;.saving 17.3 

selccting points on p;,tth 167 

smoothing .172 

speed 169 

supcnmposmg 172 

zooming cffcct, crc<1t10g 263 

Movic Analysis comm<1nd 65 

Movie Capture comm01nd 

b.ttch capturing 242 

capturing W1th d~.·vicc control 239. 

capturing without dcvice 

control 234 

Microsoft VIdeo 1 com¡1ressor (Video- . e . 1 Mov1c ;,tpturr wuh o\v 239 
for\Vtndows) 212 

mini01turcs 

crc;.ttmg 41 

repl.tcing 44 

i'-1miatures command 41 

Minmwm Disk Fn:~.· Spacc option 

(capturtng) 2·16 

l\1irror filtcr 157 

n11x (tmx.turl') function 2t;6, 30~ 

mixing audio clip:. 99-1 O 1 

Motion command 166, 251 

!-. lot10n option ( motion 

scttings) 171 

motwn.sctting:. 166-173 

aJjusting path \ó7, 251 

animating grapl11c:. \\'Íth 274 

copying 160 

defining p.Hh 166 

ddctmg 173 

ll10VIC$ 

360-degrec, crcating 266 

adding tcxture to 25.) 

anal~7.int:, 6) 

CJ.pturntg 227-248 

compatible format~ 36 

compiling 20J-2\I.J 

compi!ing for Cll-RO~t 219 

comprcs:.lng 210-214 

creatin~ from tilrnstrip.s 1 OS 

defint·J 3 

.th:.ahlm¡.: clip:. whcn compiling 57 

importmg from othcr 

pl.ttform:. 22:i 

in:.ct~. crc<lllllg 250 

!.tyl.'ring travding mattcs 262 

linking 221-222· 

nutput optiom ior 205-210 

outputting to videotape 222 

NTSC_-c9mpatible signols 223 

planninS 27 
... ') 

playmg 

i1~ ccntCr of screcn 219 

NTSC:compatible signa!s 224 

prcvicwing Clip wmdow 

contcnts : 124 

sc.lling framc rat_c 216 

split~¿crecn, crcating 252 

supcriinpÜ.sing ovcr tcxturcd 

backgrounds 255 

Thrcc-D, creating 148 

vidcotap1ng, NTSC-compatihlc 

~ignal.s 224 

multicame·r.t cditing 276 

Multiply kcy typc 186,267 

multitrack too! (Co1~struction 
wmdow) 58, 63 

Na m\= Ali;,l.s command 39 

N~w Library command 40 

Ncw Prqjcct command 2H 

nondrop-framc 

numi~cring formal 71 

timccoJc 285 

None kcy typc 179 

nonintcrlcavcd modc, video 2M4 

Not Red kcy type 186 

NTSC video. : ; 

cncodcrs 224 

ficld procc.ssing for 208 

nutputting a movic to 

vi~L·ot.1p_e 223 

.'>ignab 224 

signals and (hgitizing 283, 285 

typc matchmg for prcvicwi1· 127 

NTSC-safc colors 141 

-~ 



:,·. 

numbered bitmappcd files 

opcning 37 

· Object Linking and Embedding 
(OLE) applications, playing 

mo,vies in 224 

,. ob~ects, crcating in Title 

window 195-200 

off-linc _~:dit~ng 108 

_o':11inc editing 108 

Opaoty !l.!ith;rs (Title window) 190, 
199,200 

Open Clip comnJJnd 69 

Op~n Cf?mmand 35 

'· Opcn Fini!->hcd Movic option.(prnjcct 
output) 205 

Optimizc Su lis option 
. (co'n~prcssiun) 217 

out point too.! (Construction 

window) SR, 79 

nlit points 

changing in linkcd chps 7R 

linding in Crip \vindow 7H 

sctting in clips 76-H6 

output ·option:-·. St'c Prog:ct Output 

· Option:. dialog hox 

ov,tl too! (Tith: window} Jl)(} 

"- · Overl.ty .tt Edit l.1nL· cumm.HH.I 93 

Ov~..·rl,ty conut1:111d 2JJ 

OVL'! laymg clqh I.J2 

'0\'L'r~ampk option (~,.-.tptunng) 237 

PA L vidt•o 

. ··.-

cncoda:. 22·1 

fit·ld pron·..,:.ing for 20X 

!>q;n.Jls.and digiti1ing 21-i5 

typ'c ;~lat.Lhing ror J'fl'\'!l'WLng 

P.m fihL·r ¡},3 

pannii1g, crc:.tting l'ffL'CI of 154 

1,­_; 

Pnste Custom commnnd 87, 88 

applying filtcrs with 143 

Paste to Fit command 86 

rrplaéing transiti?ns with 132 

.pj) files, saving and loading 66 

Phase Altcrnating Line. See PAL video 

Pinch filter 157 

pixels 

chailging brightnt.·~s values of ISO 

channd values for 289 

incrcasing contrast in 

adjacen.t. 158 

trimrning from edgrs of c\ips 148, 

151 

place markers'. 

aligning in Cunstruction 

windmv 75 

deleting rrum dips 76 

ddcting from time rukr 74 

findmg in Chp window 76 

sctting in c\ips 72~76 

~ctting i-11 time ruin 73 

~L·tting while prL·viewing 7·1 

Slww f',.L!rka~ optLon 75 

Snap tu Edges a m! 72 

!'la y hutton (Clip wmdow) 70 

pl.1yh:Kk hL·ad {Ctlll~tructitlll 
wuldnw) lJ2 

pl.1yh.tck ratt.'. Sn· fr.tllll' r:Ltl' 

p\.1yin~ ciLP" 

b.11.:lw.mb l)S 

in Clip window 6Y 

p!:Jylllg tllOVIl'\ 21 lJ-22:J 

.pllt lilt::-. . ..,,1\'Lilf. .md opening ·11 

plu¡..:im dirL'Llorie~ I·D 

PoiiHillllt.' lilter 157 

Pol.u Coordin:Jte~ fiher 157 

polrgon too\ (Ti tic wmdow) 190 

Position in Lower Third 

command 198, 201 

Posterize/Postcrizr: Time filters 157 

Preferences 

Audio 56 

Device Control 239 

General 

)og/Shuttlc control and 70 

virtual clip source arcas and 102 

Scrntch Disks 231 

Stilllmagc -38, 86 

Virtual Clips 101, 103, 104 

Pre,miere colo,r pickcr, using 141 

Pre.~Roll Time option 
(capturing) 236 

Presets command 29 

presets, loading and modifying 29 

Previcw command 122 

p rcview files 

crcJting l2S 

ddincd 1 !9 

lindíng 3! 

prt'VIC\\' IllO\'Il'•S 125 

Prcvinv Options comm.tnd 126 

Preview Ratc command 234 

Previcw windnw 

'changing di:.pi:Ly of 121 

rc'illing \2('. 

using with Controllcr 120 

v¡cwing Chp w111Juw content!> 

in 69 

prcvit-wing 119-125 

adiusting tht.· work area h,Lr 121 

.1udio nwdc:-. 130 

Clip window contents 124 

compded 119, 120, 121 

Controllcr, using 120 

creating fHC\'iew movies !25 

... 



disabling clips for 57 · 

draggmg in thc time ruler 123 

filtcrs 127 

moJes 127, 128-1}0 

options for 125 

procc~sing rcsolu_tion 127 

temporary prcvicw files 128 

transitions and effccts 120, 121. 
123 

uncompi!cd l !'9 1 
• 

whilc capturing 23.{ 
Print to Video commai1d 

outputting half-!:>crccn video 211 

outputting to \;idcota'pc 223 

plaring movic.s in ct•ntcr of 

scrccn 2\lJ-22·1 

p!anpg .scqucncc~ 222. .. ' 

prcvicwing:with 124 

Print \\"indow command Mí 

printing 

windm,· contcnts 66 

ProJCCt Output Option:-. dJa!og 
hcn. 205-21 O 

audio op!Jons 206, 209 

Ikcp \Vhcn Fini~hcd opt1on 205 

Opcn Fim~h,:d r.tovll' opt10n 205 

output file t~·pr.:s ·20ú 

vid en opt!Oil'> :2{)(1, 207 

PrilJCCI Trimmcr cnmm.md 32, .JJ 

Projl'ct Wllldow 45-41} ,, 
chang111g Jispl.t~· of 46 

ComnH.'Ili hm. •H1 

ddcting dip-" .1nd fuldc:r:. from ·1H . . . 
fo!dc:r:.in 4:-. ' - . ' :. 

importms dtp:. mto 3·-l 

!.abc!.hm .. c~ ·1(1 

printing. 66-

selccting clips from 52 

thumbnails in 45, 46 

Projcct Window Options 

command 46 

projccts 

crcating 28 

dcfincd 4 

imporqng 31 

mcrging 31 

opcning cxisting 31 

prcscts 29· 

prCVICWlllg ·119-130 

SJ.Vl!lg 30 

trimmin¡;. 31, 43 

vicwin~ l'!liÍll' in ConstnJC[J¡)Jl 

Wllldow 5(1 

Quahty sildcr (comprl·:.:.Jon) 216 

QuickTunc: ~tovn.· opt10n (pro¡cct 

output) ~06 

QuickTimc movic:. 

compiling 203-219 

compiling for prcvicwing 124 

comprt·.ssing 210 

Lonvc:rtm"g fihnstrip:. 111to IOX 

f1.1ttcncd Ji 

importJng (\\,Kinto"h \'Cr:.mn 225 

npcning ~bcint~~:.h vcr."ton 37 

Scc td~o mo\·ic:-. 

ltJdi.d Blur filtn 15K 

prcvicwing t.o ! 2(1, 12H, 12tJ, 130 

r.l!ll;l' ~dccttoo! (Con:-.tructton 

window) S~ 

Ratc optÍ!)fL 
' . l.'· >-·¡·:·. 

for audio output,, ~? 

.for prcvicwing.vidco ):~7 

razor too! (Con:.ttuction 

windov·:) SH,~~~·. 

real-time video !r' ¡ 

. G1pturi1~g , 231 .... 

outputting a movie in 22.2 

. outpt~ttÍJ)g _full,-,scrcen im<1gcs 

in 211 

Rccomprcss option 

( comp.rcssion) :ÍI7 
... 

recomprcs:.ton, av(.~idi.ng 217 

Record Audw con~m,\lld .237 

Rccord1ng Optiom cbmmand 235 

lki:ording Scttin~" dia!og hox 235 

rn:ording. Scc c.1pH11 ing vitko; 
(,lplul ing aw!Jo; vilkotüpL' 

rectangle too! {Titlc winliow) 1 tJO 

rcdigitizing chps ·13 

Rc-Find FileS comm.md ..;..;.: 

rcfraction, simulating ·I 56 

Rcmovc Scttmg~ com~n.md 243 

Rcn~ove UnusCd .::ommand 4H 

rcnaming clip~ JY 

Replacc \Vork Arl'il comma-ild 94 

1\t.:plic.Jtc filler 15~ ·: · 

lkport Drnppcd FramL·~ option 

(c.tptuJmg) 23h. · 

j{c:-,ct tlJliÍ<lll·(;tHliÍI;Ii,\elllll)!,~) 171 

lk:-.itc filler ·15X 

IC:-.izing di p.\ }H 

rc:.olut1on 

,ludio 2H7:· · 

dcfincd ~H4 

rcvcr~c. p!.1ying clip:-. in· 95, 147 

RGB Difl.crcncc: kL'Y typl' ,180, IH7 

RGB formJI, chanlll'l v.tlucs for 2H<J 

. 313 

-~ 



\ 

RGB levcls, controlling in clips 148 

Ripple Delete command 57, 63 

ripple edit too! (Construction 

windów) 58, 81 -

ripple editing, in·Trimming 

window, 84 

Ripple filtcr · !58· 

.rlc rile~. impof-ting 37 

rnd (ranJom) fllliciion 291, 295, 301 

Roll filter !58 

rúlling credits, 
1
crcating 280 

rolling edit tool (C~nstructi~n 
windO\v) . 58, in 

rolling editi~g. '¡O Tri~ming 
. window 84 

Roto.tion option (motion 

settings) 170. 

-rotoscoping filmstrips 259 

rounJcJ rect~mglc: too\ (Title 

window) 190 

1 ,r 1 rulef. Sa time ruler 

-, ',P 1 

S a fe laycrs 102 
' 

s~1mpling r~lte 

·audio 232, 2H7 

audio output optiuns and 209 
.' •• •J 

S;wc: P.tlctte co~nm~tnd 24R 

. S.l~'l' Sctting~ l"omm.md. 2·H 

saving prnjl'Cb 30 

s~aling:im.tgc::. 154, \SH 

scanned im;.tgl'!>, conwrting to 

~Jtmappc:d liJes 36 

scis:.or!'>. Scc fade ~ci~wr~ too! 

scl (scalc:) function 302 

Scratch Disks prcfcrcnct·~ 231 

Scn:cn key typc 1 R6 

scruhbing 

in Clip window 70 

in Construction winduw 120 

sclecting 

linked clips 63 

multiple clips 63 

selection too! 

Construction window ·ss 
Ti tic window 190,201 

Scnd to nack command 201 

Scqucncc window 2.21 

Shadow ·comm'atid 199 

Shadow Offset control (Title 

window) !90, 198 

shadows 

adjusting 257 . 

creating in titles 198 

Sharpcn Edgcs filter !58· 

Sharpen filter !58 

Sharpcn More filter !58 

Shcar filtcr !58 

Show Al! option (motion 

scttings) 172 

Show Outlines option (motion 

scttings)-· 173 

Show Path option (motion 

~t.·ttings) 173 

Shuttlc control (Clip windov·:) 70 

singlc-framt: video capture 2.46 

Sit.t.: (Oilllllillld 197 

Stzt.• option (projt.'ct output) 207 

3IOW-ITHli!Oil vidt.'ü 

crt:atitlg <J5 

Snwoth ,\lotion option (motion 

~ctt(ng..;) 172 

Sinooth Polygon com;n,md llJ6 

SivlPTE timt.'C(}(k 116, 28·1 

in Clip \\'Índow -15 

st:p~lrators in 61 

st:ttin~ a~ fr~Hllt.' munbt.'nng 
formal 5·1, 71 

Scc 11lso timt·codc 

Snap to Edgcs option (Construction 

window) 62, 72, 73 

snap tool (Construction 

window) 62, 73 

Snapshot command 122 

Society of Motion Picture and 
Television Engineers. See 
SMPTE timecode 

sort link too\ (Construction 
window) 58, 9S · 

soft-linked clips 98 

software compression 210,213 

Solarize filter 159 

source files 27, 

CO'!'P,Utible formats 36 ., 

locating 30 

m~kmg trimmcd. copies of 31 

' moving 30 

spatial comprcss10n 212 

special erfccts. Scc tr;.msitions; filté?s; 
motion settings; superimposing 
clips 

Speed C01;1mand 96 

spced of clips 

changing 95 

displ.tying information <tbout 63 

field processing and 208 

Sphcrizc filtn 159 

spljt cdit 25R 

split scr~t:ns, crcating_ 252 

splitting clip3 ~9 

src.(sourcc) function 29\,296,297, 
300 ' .· 

. ,. 
Still lm,Jgt.' prcftTL'nccS 38, 86 

still·imagc clips 

backgrounds 256 

compcitiblc rorniats 36 

crcaling rrom \;idt.'Ó.J96 

gradit.'Ilt ~·ipc traJ~~i.tio~s and 137 

im.1gc ma!->k tr:Jn~itiO!ls and 136 

.. 



opening nurnbered seq~ence 37 

setting duration for 86 

setting image size for 38 

sizc inforr.nation for 45 

Stop button (Clip window) 70 

Stop Motion command 246 

.stop-framc animation 246 

sto'ragc' rcquiremcnt, video · 285 

storyboatds 

dctincd '27 

linking n.10vic.s as 221 

window contcnts :1:. .. 66;_ · 

stretch too! (C~nstructJOn 
window) 58 

supcrimposc (S) track 176 

supcrimposing clips ·-175-1 89 

anti-al!asing 187 

background mattc:. for 189 

color m;lttcs for 189 

faJe control and ¡g¡­

g.lin control and \Ri 

ovcr tcxturl'tl h.JCk!-!rouiHb 255 

previcwing and 12S 

titln .md un 

· ·supcrnnpo:-.tn¡; i:-.oi.Ul'd fl¡.?,urL·:-. 25ú 

su~)him_posing titk:-. \0-1 

synchrmlizm¡; vidC~~ with .llldto 7--l 

Ta~ Clip e:up!C.'..; up~io;d i'rOJL'd 

\\'mJow Option_...) ·17 

T.trg.t Sn¡uL'lh.:c optlt)n.íprojL'CI 

output) 207 
. \' 

tr:lcvi:-.ion 2X4 

Sct: ~~/So. :'\l"SC. ,:idct;. 

tcm¡;oral com¡~;c:-..~J<,Hl 212 

tcx\. :<\ce titk·..,; 'In k· windo,,· 

. texture 

~dding to movies 255 

.tga}iles, ¡mporting 37 

Three- D cffccts 
', 

creating movies 148, 266 

objccts and tcxt 159 

thumbnails · 

changi'1ig 'numbcr of in 

Construction winJow 54 

Jcfincd 28 

in Projcct.window 45, 46 

V1rtu.11 dip!> and 103 

. uffilcs, imponing 37 

TIFF Scqucncc option (projcct 

. output) 207 

Ji les filtcr. 159 

·time base 

crcating EDLs and 109 

for projcct 30. 

tilllL' ba:-.c. Scc '.liso fr.llllL' r.Hc 

tilllL' rulcr (, h 1 

.1h~ning ~llps to 6.':\ 

dclctJllS m.nkn~ from 74 
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